# Table of Contents

Chapter 1: Welcome .......................... 1
   About this Reference .......................... 1
   Other Resources .......................... 2
   PAC Control Commands Quick Reference .................. 4
   Symbols .............................................. 20

Chapter 2: Analog Point Commands .......................... 23
   Calculate & Set Analog Gain .................. 23
   Calculate & Set Analog Offset .................. 25
   Get & Clear Analog Maximum Value .................. 26
   Get & Clear Analog Minimum Value .................. 27
   Get & Clear Analog Totalizer Value .................. 28
   Get Analog Maximum Value .................. 29
   Get Analog Minimum Value .................. 30
   Get Analog Totalizer Value .................. 31
   Get HART Unique Address .................. 32
   Ramp Analog Output .................. 34
   Receive HART Burst Response .................. 36
   Receive HART Response .................. 38
   Send/Receive HART Command .................. 40
   Set Analog Filter Weight .................. 42
   Set Analog Gain .................. 43
   Set Analog Load Cell Fast Settle Level .................. 44
   Set Analog Load Cell Filter Weight .................. 46
   Set Analog Offset .................. 47
   Set Analog Totalizer Rate .................. 48
   Set Analog TPO Period .................. 50

Chapter 3: Chart Commands .......................... 51
Chapter 4: Communication Commands .......................................................... 67

Accept Incoming Communication ................................................................. 67
Clear Communication Receive Buffer .......................................................... 69
Close Communication ..................................................................................... 70
Communication Open? ................................................................................... 71
Get Communication Handle Value ................................................................. 72
Get End-Of-Message Terminator ................................................................. 73
Get Number of Characters Waiting ............................................................... 74
HTTP Get ......................................................................................................... 76
HTTP Post Calculate Content Length ......................................................... 79
HTTP Post from String Table ........................................................................ 80
Listen for Incoming Communication ............................................................. 83
Open Outgoing Communication .................................................................... 85
Receive Character ......................................................................................... 87
Receive N Characters ..................................................................................... 89
Receive Numeric Table ................................................................................ 91
Receive Numeric Table Ex. .......................................................................... 93
Receive Numeric Variable ........................................................................... 95
Receive Pointer Table .................................................................................. 97
Receive String ............................................................................................... 99
Receive String Table ..................................................................................... 102
Send Communication Handle Command .................................................... 105
Send Email ..................................................................................................... 112
Send Email with Attachments ...................................................................... 115
Set Communication Handle Value ................................................. 118
Set End-Of-Message Terminator .................................................. 119
Transfer N Characters ................................................................. 120
Transmit Character .................................................................. 122
Transmit NewLine ...................................................................... 124
Transmit Numeric Table ............................................................... 125
Transmit Pointer Table ............................................................... 127
Transmit String ......................................................................... 129
Transmit String Table ............................................................... 131
Transmit/Receive String ............................................................ 133

Chapter 5: Control Engine Commands ........................................... 135
Calculate Strategy CRC ............................................................... 135
Erase Files in Permanent Storage .................................................. 136
Get Available File Space ........................................................... 137
Get Available File Space Ex ......................................................... 138
Get Control Engine Address ......................................................... 140
Get Control Engine Type ............................................................ 141
Get Firmware Version ............................................................... 142
Get Number of Charts Running ................................................... 143
Get Redundant Controller State ................................................... 144
Get Redundant Controller Status ............................................... 145
Get Strategy Name .................................................................. 146
Load Files From Permanent Storage ............................................ 147
Retrieve Strategy CRC ............................................................... 148
Save Files To Permanent Storage ............................................... 149
Start Alternate Host Task ........................................................... 150

Chapter 6: Digital Point Commands ................................................ 153
Clear All Latches ....................................................................... 153
Clear Counter ........................................................................... 155
Clear Off-Latch ......................................................................... 156
Clear On-Latch ......................................................................... 157
Generate N Pulses ..................................................................... 158
Get & Clear Counter .................................................................. 160
Get & Clear Off-Latch ............................................................... 162
Get & Clear On-Latch ............................................................... 163
Get & Restart Off-Pulse Measurement ....................................... 164
Chapter 7: Error Handling Commands ................................. 199
Add Message to Queue ............................................. 199
Add User Error to Queue ........................................ 200
Add User I/O Unit Error to Queue .......................... 201
Caused a Chart Error? .............................................. 203
Caused an I/O Unit Error? ......................................... 204
Clear All Errors ................................................................. 206
Copy Current Error to String ........................................... 207
Disable I/O Unit Causing Current Error .............................. 208
Enable I/O Unit Causing Current Error ............................... 209
Error on I/O Unit? ............................................................. 210
Error? ............................................................................. 211
Get Error Code of Current Error ........................................ 212
Get Error Count ............................................................... 213
Get ID of Block Causing Current Error ......................... 214
Get Line Causing Current Error ......................................... 215
Get Name of Chart Causing Current Error ...................... 216
Get Name of I/O Unit Causing Current Error ............. 217
Get Severity of Current Error ........................................... 218
Remove Current Error and Point to Next Error ............. 219
Stop Chart on Error ......................................................... 220
Suspend Chart on Error .................................................... 221

Chapter 8: High-Density Digital Module .............................. 223
Clear HDD Module Off-Latches ....................................... 223
Clear HDD Module On-Latches ....................................... 225
Get & Clear All HDD Module Off-Latches ....................... 227
Get & Clear All HDD Module On-Latches ....................... 229
Get & Clear HDD Module Counter .................................. 231
Get & Clear HDD Module Counters .................................. 233
Get & Clear HDD Module Off-Latches ............................... 235
Get & Clear HDD Module On-Latches ............................... 237
Get All HDD Module Off-Latches ..................................... 239
Get All HDD Module On-Latches ..................................... 241
Get All HDD Module States ............................................. 243
Get HDD Module Counters .............................................. 245
Get HDD Module Off-Latches ........................................... 247
Get HDD Module On-Latches ........................................... 249
Get HDD Module States ................................................... 251
Set HDD Module from MOMO Masks ............................ 253
Turn Off HDD Module Point .......................................... 255
Turn On HDD Module Point ............................................. 257

Chapter 9: I/O Quality Commands ....................................... 259
Get I/O Channel Quality .......................................................... 259
Get I/O Unit Quality ............................................................ 262

Chapter 10: I/O Unit Commands .............................................. 263
Clear I/O Unit Configured Flag .............................................. 263
Get I/O Unit as Binary Value ................................................. 265
Get I/O Unit as Binary Value 64 .............................................. 267
Get I/O Unit Module States .................................................. 269
Get Target Address State ..................................................... 271
I/O Unit Ready? ................................................................. 273
IVAL Move Numeric Table to I/O Unit .................................... 275
IVAL Move Numeric Table to I/O Unit Ex ................................ 277
Move I/O Unit to Numeric Table ............................................ 279
Move I/O Unit to Numeric Table Ex ........................................ 281
Move Numeric Table to I/O Unit ............................................. 284
Move Numeric Table to I/O Unit Ex ........................................ 286
Set All Target Address States .............................................. 288
Set I/O Unit Configured Flag ................................................. 290
Set I/O Unit from MOMO Masks .......................................... 292
Set Target Address State .................................................... 294
Write I/O Unit Configuration to EEPROM ............................. 296

Chapter 11: I/O Unit - Event Message Commands .................... 299
Get I/O Unit Event Message State ......................................... 299
Get I/O Unit Event Message Text ......................................... 301
Set I/O Unit Event Message State ......................................... 303
Set I/O Unit Event Message Text ......................................... 305

Chapter 12: I/O Unit - Memory Map Commands ....................... 307
Read Number from I/O Unit Memory Map ............................. 307
Read Numeric Table from I/O Unit Memory Map .................... 309
Read String from I/O Unit Memory Map ................................. 311
Read String Table from I/O Unit Memory Map ....................... 313
Write Number to I/O Unit Memory Map ................................. 316
Write Numeric Table to I/O Unit Memory Map ....................... 318
Write String Table to I/O Unit Memory Map ........................... 320
Write String to I/O Unit Memory Map .................................... 322

Chapter 13: I/O Unit - Scratch Pad Commands ......................... 325
Chapter 14: Logical Commands ................................................................. 353
AND.......................................................... 353
AND?.......................................................... 355
Bit AND....................................................... 357
Bit AND?..................................................... 359
Bit Change.................................................... 360
Bit Clear...................................................... 361
Bit Copy...................................................... 362
Bit NOT...................................................... 364
Bit NOT?..................................................... 366
Bit Off in Numeric Table Element?.................................................. 368
Bit Off?..................................................... 369
Bit On in Numeric Table Element?................................................ 370
Bit On?..................................................... 371
Bit OR....................................................... 372
Bit OR?..................................................... 374
Bit Rotate.................................................... 375
Bit Set....................................................... 376
Bit Shift..................................................... 377
Bit Test...................................................... 379
Bit XOR..................................................... 380
Bit XOR?.................................................... 382
Equal to Numeric Table Element?.................................................. 384
XOR ................................................................. 443
XOR? .............................................................. 445

Chapter 15: Mathematical Commands ............................. 447
  Absolute Value .............................................. 447
  Add .............................................................. 448
  Arccosine .................................................... 449
  Arcsine ......................................................... 450
  Arctangent .................................................... 451
  Clamp Float Table Element ............................... 452
  Clamp Float Variable ..................................... 453
  Clamp Integer 32 Table Element ......................... 454
  Clamp Integer 32 Variable .............................. 455
  Complement .................................................. 456
  Cosine ........................................................ 457
  Decrement Variable ...................................... 459
  Divide ........................................................ 460
  Generate Random Number ................................ 461
  Hyperbolic Cosine ......................................... 462
  Hyperbolic Sine ........................................... 463
  Hyperbolic Tangent ....................................... 464
  Increment Variable ....................................... 465
  Maximum ..................................................... 466
  Minimum ..................................................... 467
  Modulo ......................................................... 468
  Multiply ...................................................... 469
  Natural Log .................................................. 470
  Raise e to Power .......................................... 472
  Raise to Power ............................................ 473
  Round ........................................................ 474
  Seed Random Number .................................... 475
  Sine .......................................................... 476
  Square Root ................................................ 478
  Subtract ...................................................... 479
  Tangent ...................................................... 480
  Truncate ..................................................... 481

Chapter 16: Miscellaneous Commands ............................ 483
Chapter 17: PID - Ethernet Commands

Get PID Configuration Flags ............................................................. 507
Get PID Current Input ................................................................. 508
Get PID Current Setpoint ............................................................. 509
Get PID Feed Forward ................................................................. 510
Get PID Feed Forward Gain ........................................................ 511
Get PID Forced Output When Input Over Range .......................... 512
Get PID Forced Output When Input Under Range ....................... 513
Get PID Gain ............................................................................. 514
Get PID Input ............................................................................. 515
Get PID Input High Range ........................................................... 516
Get PID Input Low Range ............................................................ 517
Get PID Max Output Change ......................................................... 518
Get PID Min Output Change ......................................................... 519
Get PID Mode ........................................................................... 520
Get PID Output ........................................................................ 521
Get PID Output High Clamp ......................................................... 522
Get PID Output Low Clamp ......................................................... 523
Get PID Scan Time .................................................................... 524
Get PID Setpoint ........................................................................ 525
Get PID Scan Time .................................................................... 526
Get PID Status Flags ................................................................. 527
Get PID Tune Derivative ........................................................... 528
Get PID Tune Integral ............................................................... 529
Set PID Configuration Flags ..................................................... 530
Set PID Feed Forward ............................................................. 531
Set PID Feed Forward Gain ...................................................... 532
Set PID Forced Output When Input Over Range ......................... 533
Set PID Forced Output When Input Under Range ........................ 534
Set PID Gain ............................................................................ 535
Set PID Input ........................................................................... 536
Set PID Input High Range .......................................................... 537
Set PID Input Low Range ........................................................... 538
Set PID Max Output Change ...................................................... 539
Set PID Min Output Change ...................................................... 540
Set PID Mode ........................................................................... 541
Set PID Output ......................................................................... 542
Set PID Output High Clamp ....................................................... 543
Set PID Output Low Clamp ....................................................... 544
Set PID Scan Time ................................................................... 545
Set PID Setpoint ....................................................................... 546
Set PID Tune Derivative ............................................................ 547
Set PID Tune Integral ................................................................ 548

Chapter 18: Pointers Commands .............................................. 549
Clear Pointer ............................................................................ 549
Clear Pointer Table Element ...................................................... 550
Get Pointer From Name ............................................................ 551
Move from Pointer Table Element ............................................ 552
Move to Pointer ........................................................................ 553
Move to Pointer Table Element ................................................ 556
Pointer Equal to Null? ............................................................... 559
Pointer Table Element Equal to Null? ....................................... 560

Chapter 19: Simulation Commands ............................................ 561
Communication to All I/O Points Enabled? .............................. 561
Communication to All I/O Units Enabled? ................................. 562
Disable Communication to All I/O Points ................................. 563
Disable Communication to All I/O Units .................................. 564
Append Character to String .................................................. 597
Append String to String ...................................................... 599
Compare Strings .............................................................. 600
Convert Float to String ...................................................... 602
Convert Hex String to Number .......................................... 604
Convert IEEE Hex String to Number ................................. 605
Convert Integer 32 to IP Address String ............................. 606

Chapter 20: String Commands ............................................. 597

DISABLE COMMUNICATION TO I/O UNIT .................................. 565
DISABLE COMMUNICATION TO PID LOOP .............................. 567
DISABLE COMMUNICATION TO POINT .................................. 568
ENABLE COMMUNICATION TO ALL I/O POINTS .................. 569
ENABLE COMMUNICATION TO ALL I/O UNITS ..................... 570
ENABLE COMMUNICATION TO I/O UNIT .............................. 571
ENABLE COMMUNICATION TO PID LOOP .............................. 572
ENABLE COMMUNICATION TO POINT .................................. 573
I/O POINT COMMUNICATION ENABLED? ............................. 574
I/O UNIT COMMUNICATION ENABLED? ................................ 575
IVAL SET ANALOG FILTERED VALUE .................................. 577
IVAL SET ANALOG MAXIMUM VALUE .................................. 578
IVAL SET ANALOG MINIMUM VALUE .................................. 579
IVAL SET ANALOG POINT .................................................. 580
IVAL SET COUNTER .......................................................... 581
IVAL SET FREQUENCY ....................................................... 582
IVAL SET I/O UNIT FROM MOMO MASKS .......................... 583
IVAL SET OFF-LATCH ......................................................... 585
IVAL SET OFF-PULSE .......................................................... 586
IVAL SET OFF-TOTALIZER ................................................. 587
IVAL SET ON-LATCH .......................................................... 588
IVAL SET ON-PULSE ........................................................... 589
IVAL SET ON-TOTALIZER .................................................. 590
IVAL SET PERIOD ............................................................. 591
IVAL SET TPO PERCENT ..................................................... 592
IVAL SET TPO PERIOD ....................................................... 593
IVAL TURN OFF ................................................................. 594
IVAL TURN ON ................................................................. 595
PID LOOP COMMUNICATION ENABLED? .............................. 596
Verify Reverse CCITT on String ................................................................. 659
Verify Reverse CRC-16 on String ............................................................. 660

Chapter 21: Time/Date Commands ............................................................ 661
Convert Date & Time to NTP Timestamp .................................................. 661
Convert NTP Timestamp to Date & Time .................................................. 663
Copy Date to String (DD/MM/YYYY) ....................................................... 664
Copy Date to String (MM/DD/YYYY) ....................................................... 665
Copy Time to String .............................................................................. 666
Get Date & Time ..................................................................................... 667
Get Day .................................................................................................. 668
Get Day of Week ................................................................................... 669
Get Hours ............................................................................................ 670
Get Julian Day ...................................................................................... 671
Get Minutes ........................................................................................ 672
Get Month ............................................................................................ 673
Get Seconds ........................................................................................ 674
Get Seconds Since Midnight ................................................................. 675
Get System Time .................................................................................. 676
Get Time Zone Description .................................................................. 677
Get Time Zone Offset .......................................................................... 678
Get Year ............................................................................................... 679
Set Date ............................................................................................... 680
Set Day ................................................................................................. 681
Set Hours ............................................................................................. 682
Set Minutes ........................................................................................ 683
Set Month ............................................................................................. 684
Set Seconds ........................................................................................ 685
Set Time ............................................................................................... 686
Set Time Zone Configuration ............................................................... 687
Set Year ............................................................................................... 689
Synchronize Clock SNTP ..................................................................... 690

Chapter 22: Timing Commands ................................................................. 693
Continue Timer ..................................................................................... 693
Delay (mSec) ......................................................................................... 694
Delay (Sec) .......................................................................................... 695
Down Timer Expired? .......................................................................... 696
Get & Restart Timer ................................................................. 697
Pause Timer ........................................................................... 698
Set Down Timer Preset Value ................................................... 699
Set Up Timer Target Value ....................................................... 700
Start Timer ............................................................................. 701
Stop Timer .............................................................................. 702
Timer Expired? ........................................................................... 703
Up Timer Target Time Reached? .................................................. 704

Appendix A: High-Speed Digital Function Support ......................... 705

Appendix B: Table Index Offset Examples ..................................... 707
Table Index Offsets .................................................................... 707
Length of Table Required .......................................................... 710

Appendix C: Deprecated Commands ............................................. 713
Clear Receive Buffer ................................................................. 714
IVAL Set Digital Binary .............................................................. 715
IVAL Set Digital-64 I/O Unit from MOMO Masks ......................... 716
IVAL Set Mixed 64 I/O Unit from MOMO Masks ......................... 718
IVAL Set Mixed I/O Unit from MOMO Masks ............................... 720
IVAL Set Simple 64 I/O Unit from MOMO Masks ......................... 722
Set Digital I/O Unit from MOMO Masks ...................................... 724
Set Digital-64 I/O Unit from MOMO Masks ................................. 726
Set Mixed 64 I/O Unit from MOMO Masks ................................. 728
Set Mixed I/O Unit from MOMO Masks ....................................... 730
Set Simple 64 I/O Unit from MOMO Masks ................................. 732

Index ......................................................................................... 735
Welcome to PAC Control™, Opto 22’s visual control language for SNAP PAC I/O™ and other Opto 22 control systems. PAC Control provides a complete and powerful set of commands for all your industrial control needs.

This command reference describes in detail all PAC Control programming commands and instructions. Its purpose is to help you understand what each command can do so that you can fully utilize the power of PAC Control.

This reference assumes that you have some experience using Microsoft® Windows® on personal computers. Programming experience is helpful, but not required.

ABOUT THIS REFERENCE

PAC Control comes in two forms: PAC Control Basic and PAC Control Professional. Commands that are available only in PAC Control Professional are noted with a Pro icon.

There are two types of commands: Actions and Conditions.

**Actions** are commands used in PAC Control Action blocks. They typically perform a control function; for example, the **Turn On** command turns on a digital output point.

**Conditions** are used in PAC Control Condition blocks to determine the flow of logic. Conditions end with a question mark (for example, **On?** and **Greater Than or Equal?**) and ask a question, such as “Is the digital input ON?” The answer determines whether the flow takes the True connection or the False connection to exit the block.

Each Action and Condition also has an equivalent form in **OptoScript™** (PAC Control’s built-in programming language). The equivalents can be used in OptoScript blocks.

Command Groups

Each command is assigned to a group (although many commands could naturally fit into several groups). Commands are listed with their respective group. If you can’t find the command you are looking for in one group, try looking in a related group.

The groups are:

- “Chapter 2: Analog Point Commands” on page 23
- “Chapter 3: Chart Commands” on page 51
- “Chapter 4: Communication Commands” on page 67
- “Chapter 5: Control Engine Commands” on page 135
- “Chapter 6: Digital Point Commands” on page 153
- “Chapter 7: Error Handling Commands” on page 199
CHAPTER 1: WELCOME

If you’re using an electronic version of this reference, you can also use the Find feature (typically, the Ctrl+F key combination) to easily search for commands. If you’re using a printed version of this reference, use the index to locate commands.

Choosing Documentation

This command reference contains the latest information you need to use PAC Control with your SNAP PAC system. However, if you are using Opto 22 “legacy” products designed to work with pre-SNAP PAC systems, see the PAC Control Command Reference, Legacy Edition (form 1711). The legacy version includes references to pre-SNAP PAC devices and commands, which are not included in this document.

For information on what we mean by “legacy” and instructions to migrate from an older system to a SNAP PAC system, see the SNAP PAC System Migration technical note (form 1688).

For information on how to enable legacy functionality in PAC Control, see “Enabling Legacy Options” in the PAC Control User’s Guide (form 1700).

OTHER RESOURCES

For Software Developers: SNAP PAC REST API

If you’re a developer who’d like to use PAC Control strategy tags in communications with other devices, the Opto 22 SNAP PAC REST API is a secure and powerful way to do just that. The API is available in SNAP PAC R-series and S-series controllers with PAC firmware R9.5a and higher. To configure HTTPS access to your PAC’s RESTful server and learn how to call the API, visit developer.opto22.com.

Help, Documents, and Opto22.com Resources

To help you learn, understand, and use PAC Control systems, we offer a wide variety of options:

- Help is available in PAC Control and in all of the applications in the PAC Project™ Software Suite from Opto 22.
  - To see screen and field-level help, click the Help button on any PAC Control screen. While entering commands (instructions), click the Command Help button to see details about the command.
  - In the PAC Control menu bar, click Help to view the list of help topics.
– Click Help > Manuals to open the PDF versions of the documents that are installed when you install PAC Control, including:
  – The PAC Control User’s Guide (form 1700)—Shows how to install and use PAC Control.
  – The PAC Control Command Reference (form 1701)—Contains detailed information about each command available in PAC Control.
  – The PAC Control Commands Quick Reference (form 1703)—Lists all PAC Control commands plus their OptoScript code equivalents and arguments.

• Our website at www.opto22.com offers a broad range of resources—from helpful videos to online blogs, forums, and news to free online self-training. We even offer free hands-on training at our headquarters in Temecula, California.

Product Support

If you have questions about PAC Control and can’t find the help you need in this command reference or in the user’s guide, contact Opto 22 Product Support.

Phone: 800-TEK-OPTO (800-835-6786 toll-free in the U.S. and Canada)
  951-695-3080
  Monday through Friday,
  7 a.m. to 5 p.m. Pacific Time

Fax: 951-695-3017

Email: support@opto22.com

Opto 22 website: www.opto22.com

When calling for technical support, you can help us help you faster if you provide the following information to the Product Support engineer:

• A screen capture of the Help > About dialog box showing software product and version (available by clicking Help > About in the application’s menu bar).
• Opto 22 hardware part numbers or models that you’re working with.
• Firmware version (available in PAC Manager by clicking Tools > Inspect).
• Specific error messages you saw.
• Version of your computer’s operating system.

OptoScript Equivalents

The following tables list both Actions and Conditions—and their OptoScript equivalents—within their respective command groups.

Commands with an asterisk (*) are available only in PAC Control Professional.

The Type column in these tables indicates whether the OptoScript command is a function command (F) or a procedure command (P). Function commands return a value from their action; procedure commands do not. For more information on OptoScript and command types, see Chapter 11 in the PAC Control User’s Guide (form 1700).

For a list of symbols and where to find examples, see “Chapter Symbols” on page 20.

For OptoScript examples, see the individual listings for the commands (beginning on page 23).
### PAC CONTROL COMMANDS QUICK REFERENCE

**Key**
1. Available only in PAC Control™ Professional
2. Ethernet I/O™, Ultimate I/O™, and Simple I/O™ units
3. Original High-Density Digital (HDD) modules
4. mistic™ I/O units (Available only in PAC Control Professional)

To enable commands for Ethernet I/O, Ultimate I/O, Simple I/O, High-Density Digital modules, and mistic I/O units:
1. On PAC Control’s menu bar, click File > Strategy Options.
2. On the Legacy tab, click the option you want to enable, and then click Yes.
3. To enable more than one option, repeat step 2.
4. When finished, click OK.

The Type column shows whether the OptoScript™ command is a function command (f) or a procedure command (p).

Function commands return a value from their action; procedure commands do not.

#### Analog Point

<table>
<thead>
<tr>
<th>PAC Control Command</th>
<th>OptoScript Equivalent (Arguments)</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calculate &amp; Set Analog Gain</td>
<td>CalcSetAnalogGain(On Point)</td>
<td>f</td>
</tr>
<tr>
<td>Calculate &amp; Set Analog Offset</td>
<td>CalcSetAnalogOffset(On Point)</td>
<td>f</td>
</tr>
<tr>
<td>Get &amp; Clear Analog Filtered Value</td>
<td>GetClearAnalogFilteredValue(From)</td>
<td>f</td>
</tr>
<tr>
<td>Get &amp; Clear Analog Maximum Value</td>
<td>GetClearAnalogMaxValue(From)</td>
<td>f</td>
</tr>
<tr>
<td>Get &amp; Clear Analog Minimum Value</td>
<td>GetClearAnalogMinValue(From)</td>
<td>f</td>
</tr>
<tr>
<td>Get &amp; Clear Analog Totalizer Value</td>
<td>GetClearAnalogTotalizerValue(From)</td>
<td>f</td>
</tr>
<tr>
<td>Get Analog Filtered Value</td>
<td>GetAnalogFilteredValue(From)</td>
<td>f</td>
</tr>
<tr>
<td>Get Analog Maximum Value</td>
<td>GetAnalogMaxValue(From)</td>
<td>f</td>
</tr>
<tr>
<td>Get Analog Minimum Value</td>
<td>GetAnalogMinValue(From)</td>
<td>f</td>
</tr>
<tr>
<td>Get Analog Square Root Filtered Value</td>
<td>GetAnalogSquareRootFilteredValue(From)</td>
<td>f</td>
</tr>
<tr>
<td>Get Analog Square Root Value</td>
<td>GetAnalogSquareRootValue(From)</td>
<td>f</td>
</tr>
<tr>
<td>Get Analog Totalizer Value</td>
<td>GetAnalogTotalizerValue(From)</td>
<td>f</td>
</tr>
<tr>
<td>Get HART Unique Address</td>
<td>GetHARTUniqueAddress(Point, Polling Address, Unique Address, Timeout)</td>
<td>f</td>
</tr>
<tr>
<td>Ramp Analog Output</td>
<td>RampAnalogOutput(Ramp Endpoint, Units/Sec, Point to Ramp)</td>
<td>p</td>
</tr>
<tr>
<td>Receive HART Response</td>
<td>ReceiveHARTResponse(Point, Unique Address, Response, Timeout)</td>
<td>f</td>
</tr>
<tr>
<td>Receive HART Burst Response</td>
<td>ReceiveHARTBurstResponse(Point, Unique Address, Response, Timeout)</td>
<td>f</td>
</tr>
<tr>
<td>Send/Receive HART Command</td>
<td>SendReceiveHARTCommand(Point, Unique Address, Command, Parameters, Response, Timeout)</td>
<td>f</td>
</tr>
<tr>
<td>Set Analog Filter Weight</td>
<td>SetAnalogFilterWeight(To, On Point)</td>
<td>p</td>
</tr>
<tr>
<td>Set Analog Gain</td>
<td>SetAnalogGain(To, On Point)</td>
<td>p</td>
</tr>
<tr>
<td>Set Analog Load Cell Fast Settle Level</td>
<td>SetAnalogLoadCellFastSettleLevel(To, On Point)</td>
<td>p</td>
</tr>
<tr>
<td>Set Analog Load Cell Filter Weight</td>
<td>SetAnalogLoadCellFilterWeight(To, On Point)</td>
<td>p</td>
</tr>
<tr>
<td>Set Analog Offset</td>
<td>SetAnalogOffset(To, On Point)</td>
<td>p</td>
</tr>
<tr>
<td>Set Analog Totalizer Rate</td>
<td>SetAnalogTotalizerRate(To Seconds, On Point)</td>
<td>p</td>
</tr>
<tr>
<td>Set Analog TPO Period</td>
<td>SetAnalogTpoPeriod(To, On Point)</td>
<td>p</td>
</tr>
</tbody>
</table>

#### Chart

<table>
<thead>
<tr>
<th>PAC Control Command</th>
<th>OptoScript Equivalent (Arguments)</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Call Chart</td>
<td>CallChart(Chart)</td>
<td>f</td>
</tr>
<tr>
<td>Calling Chart Running?</td>
<td>IsCallingChartRunning()</td>
<td>f</td>
</tr>
<tr>
<td>Calling Chart Stopped?</td>
<td>IsCallingChartStopped()</td>
<td>f</td>
</tr>
<tr>
<td>Calling Chart Suspended?</td>
<td>IsCallingChartSuspended()</td>
<td>f</td>
</tr>
<tr>
<td>Chart Running?</td>
<td>IsChartRunning(Chart)</td>
<td>f</td>
</tr>
<tr>
<td>Chart Stopped?</td>
<td>IsChartStopped(Chart)</td>
<td>f</td>
</tr>
</tbody>
</table>
### CHAP1ER 1: WELCOME

<table>
<thead>
<tr>
<th>PAC Control Command</th>
<th>OptoScript Equivalent (Arguments)</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Suspended?</td>
<td>IsChartSuspended(Chart)</td>
<td>f</td>
</tr>
<tr>
<td>Continue Calling Chart</td>
<td>ContinueCallingChart()</td>
<td>f</td>
</tr>
<tr>
<td>Continue Chart</td>
<td>ContinueChart(Chart)</td>
<td>f</td>
</tr>
<tr>
<td>Get Chart Status</td>
<td>GetChartStatus(Chart)</td>
<td>f</td>
</tr>
<tr>
<td>Start Chart</td>
<td>StartChart(Chart)</td>
<td>f</td>
</tr>
<tr>
<td>Stop Chart</td>
<td>StopChart(Chart)</td>
<td>f</td>
</tr>
<tr>
<td>Suspend Chart</td>
<td>SuspendChart(Chart)</td>
<td>f</td>
</tr>
</tbody>
</table>

### Communication

<table>
<thead>
<tr>
<th>PAC Control Command</th>
<th>OptoScript Equivalent (Arguments)</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accept Incoming Communication</td>
<td>AcceptIncomingCommunication(Communication Handle)</td>
<td>f</td>
</tr>
<tr>
<td>Clear Communication Receive Buffer</td>
<td>ClearCommunicationReceiveBuffer(Communication Handle)</td>
<td>p</td>
</tr>
<tr>
<td>Close Communication</td>
<td>CloseCommunication(Communication Handle)</td>
<td>f</td>
</tr>
<tr>
<td>Communication Open?</td>
<td>IsCommunicationOpen(Communication Handle)</td>
<td>f</td>
</tr>
<tr>
<td>Get Active Interrupt Mask1, 4</td>
<td>GetActiveInterruptMask()</td>
<td>f</td>
</tr>
<tr>
<td>Get Communication Handle Value</td>
<td>GetCommunicationHandleValue(From, To)</td>
<td>f</td>
</tr>
<tr>
<td>Get End-Of-Message Terminator</td>
<td>GetEndOfMessage Terminator(Communication Handle)</td>
<td>f</td>
</tr>
<tr>
<td>Get Number of Characters Waiting</td>
<td>GetNumCharsWaiting(On Communication Handle)</td>
<td>f</td>
</tr>
<tr>
<td>HTTP Get</td>
<td>HttpGet(Response Content, Response Header, Get Header, Security Mode, URL Path, Put HTTP Status In, Port, Hostname)</td>
<td>f</td>
</tr>
<tr>
<td>HTTP Post from String Table</td>
<td>HttpPostFromStringTable(Response Content, Response Header, Post Content, Post Header, Security Mode, URL Path, Put HTTP Status In, Port, Hostname)</td>
<td>f</td>
</tr>
<tr>
<td>HTTP Post Calculate Content Length</td>
<td>HttpPostCalcContentLength(Post Content, Post Header, Length Index)</td>
<td>f</td>
</tr>
<tr>
<td>Listen for Incoming Communication</td>
<td>ListenForIncomingCommunication(Communication Handle)</td>
<td>f</td>
</tr>
<tr>
<td>Open Outgoing Communication</td>
<td>OpenOutgoingCommunication(Communication Handle)</td>
<td>f</td>
</tr>
<tr>
<td>Receive Character</td>
<td>ReceiveChar(Communication Handle)</td>
<td>f</td>
</tr>
<tr>
<td>Receive N Characters</td>
<td>ReceiveNChars(Put In, Number of Characters, Communication Handle)</td>
<td>f</td>
</tr>
<tr>
<td>Receive Numeric Table</td>
<td>ReceiveNumTable(Length, Start at Index, Of Table, Communication Handle)</td>
<td>f</td>
</tr>
<tr>
<td>Receive Numeric Table Ex</td>
<td>ReceiveNumTableEx(Length, Start at Index, Endian Mode, Bytes per Value, Of Table, Communication Handle)</td>
<td>f</td>
</tr>
<tr>
<td>Receive Numeric Variable</td>
<td>ReceivePtrVariable(Endian mode, Number of Bytes, Put in, Communication Handle)</td>
<td>f</td>
</tr>
<tr>
<td>Receive Pointer Table</td>
<td>ReceivePtrTable(Length, Start at Index, Of Table, Communication Handle)</td>
<td>f</td>
</tr>
<tr>
<td>Receive String</td>
<td>ReceiveString(Put In, Communication Handle)</td>
<td>f</td>
</tr>
<tr>
<td>Receive String Table</td>
<td>ReceiveStrTable(Length, Start at Index, Of Table, Communication Handle)</td>
<td>f</td>
</tr>
<tr>
<td>Send Communication Handle Command</td>
<td>SendCommunicationHandleCommand(Communication Handle, Command)</td>
<td>f</td>
</tr>
<tr>
<td>Send Email</td>
<td>SendEmail(Server Information, Recipients, Message Body)</td>
<td>f</td>
</tr>
<tr>
<td>Send Email with Attachments</td>
<td>SendEmailWithAttachments(Server Information, Recipients, Message Body, Attachment File Names)</td>
<td>f</td>
</tr>
<tr>
<td>Set Communication Handle Value</td>
<td>SetCommunicationHandleValue(Value, Communication Handle)</td>
<td>p</td>
</tr>
<tr>
<td>Set End-Of-Message Terminator</td>
<td>SetEndOfMessage Terminator(Communication Handle, To Character)</td>
<td>p</td>
</tr>
</tbody>
</table>
## Control Engine

<table>
<thead>
<tr>
<th>PAC Control Command</th>
<th>OptoScript Equivalent (Arguments)</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calculate Strategy CRC</td>
<td>CalcStrategyCrc()</td>
<td>f</td>
</tr>
<tr>
<td>Erase Files in Permanent Storage</td>
<td>EraseFilesInPermanentStorage()</td>
<td>f</td>
</tr>
<tr>
<td>Get Available File Space</td>
<td>GetAvailableFileSize(File System Type)</td>
<td>f</td>
</tr>
<tr>
<td>Get Available File Space Ex</td>
<td>GetAvailableFileSizeEx(File System Type)</td>
<td>f</td>
</tr>
<tr>
<td>Get Control Engine Address</td>
<td>GetControlEngineAddress()</td>
<td>f</td>
</tr>
<tr>
<td>Get Control Engine Type</td>
<td>GetEngineType()</td>
<td>f</td>
</tr>
<tr>
<td>Get Firmware Version</td>
<td>GetFirmwareVersion(Put in)</td>
<td>p</td>
</tr>
<tr>
<td>Get Number of Charts Running</td>
<td>GetNumChartsRunning(Put in)</td>
<td>f</td>
</tr>
<tr>
<td>Get Redundant Controller State¹</td>
<td>GetRedundantControllerState(State)</td>
<td>f</td>
</tr>
<tr>
<td>Get Redundant Controller Status¹</td>
<td>GetRedundantControllerState(Status)</td>
<td>f</td>
</tr>
<tr>
<td>Get Strategy Name</td>
<td>GetStrategyName(Put in)</td>
<td>p</td>
</tr>
<tr>
<td>Load Files From Permanent Storage</td>
<td>LoadFilesFromPermanentStorage()</td>
<td>f</td>
</tr>
<tr>
<td>Retrieve Strategy CRC</td>
<td>RetrieveStrategyCrc()</td>
<td>f</td>
</tr>
<tr>
<td>Save Files To Permanent Storage</td>
<td>SaveFilesToPermanentStorage()</td>
<td>f</td>
</tr>
<tr>
<td>Start Alternate Host Task</td>
<td>StartAlternateHostTask()</td>
<td>f</td>
</tr>
</tbody>
</table>

## Digital Point

<table>
<thead>
<tr>
<th>PAC Control Command</th>
<th>OptoScript Equivalent (Arguments)</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear All Latches</td>
<td>ClearAllLatches(On I/O Unit)</td>
<td>p</td>
</tr>
<tr>
<td>Clear Counter</td>
<td>ClearCounter(On Point)</td>
<td>p</td>
</tr>
<tr>
<td>Clear Off-Latch</td>
<td>ClearOffLatch(On Point)</td>
<td>p</td>
</tr>
<tr>
<td>Clear On-Latch</td>
<td>ClearOnLatch(On Point)</td>
<td>p</td>
</tr>
<tr>
<td>Generate N Pulses</td>
<td>GenerateNPulses(On Time (Seconds), Off Time (Seconds), Number of Pulses, On Point)</td>
<td>p</td>
</tr>
<tr>
<td>Get &amp; Clear Counter</td>
<td>GetClearCounter(From Point)</td>
<td>f</td>
</tr>
<tr>
<td>Get &amp; Clear Off-Latch</td>
<td>GetClearOffLatch(From Point)</td>
<td>f</td>
</tr>
<tr>
<td>Get &amp; Clear On-Latch</td>
<td>GetClearOnLatch(From Point)</td>
<td>f</td>
</tr>
</tbody>
</table>
## CHAPTER 1: WELCOME

### PAC Control Command Reference

<table>
<thead>
<tr>
<th>PAC Control Command</th>
<th>OptoScript Equivalent (Arguments)</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Get &amp; Restart Off-Pulse Measurement</td>
<td>GetRestartOffPulseMeasurement(From Point)</td>
<td>f</td>
</tr>
<tr>
<td>Get &amp; Restart Off-Time Totalizer</td>
<td>GetRestartOffTimeTotalizer(From Point)</td>
<td>f</td>
</tr>
<tr>
<td>Get &amp; Restart On-Pulse Measurement</td>
<td>GetRestartOnPulseMeasurement(From Point)</td>
<td>f</td>
</tr>
<tr>
<td>Get &amp; Restart On-Time Totalizer</td>
<td>GetRestartOnTimeTotalizer(From Point)</td>
<td>f</td>
</tr>
<tr>
<td>Get &amp; Restart Period</td>
<td>GetRestartPeriod(From Point)</td>
<td>f</td>
</tr>
<tr>
<td>Get Counter</td>
<td>GetCounter(From Point)</td>
<td>f</td>
</tr>
<tr>
<td>Get Frequency</td>
<td>GetFrequency(From Point)</td>
<td>f</td>
</tr>
<tr>
<td>Get Off-Latch</td>
<td>GetOffLatch(From Point)</td>
<td>f</td>
</tr>
<tr>
<td>Get Off-Pulse Measurement</td>
<td>GetOffPulseMeasurement(From Point)</td>
<td>f</td>
</tr>
<tr>
<td>Get Off-Pulse Measurement Complete Status</td>
<td>GetOffPulseMeasurementCompleteStatus(From Point)</td>
<td>f</td>
</tr>
<tr>
<td>Get Off-Time Totalizer</td>
<td>GetOffTimeTotalizer(From Point)</td>
<td>f</td>
</tr>
<tr>
<td>Get On-Latch</td>
<td>GetOnLatch(From Point)</td>
<td>f</td>
</tr>
<tr>
<td>Get On-Pulse Measurement</td>
<td>GetOnPulseMeasurement(From Point)</td>
<td>f</td>
</tr>
<tr>
<td>Get On-Pulse Measurement Complete Status</td>
<td>GetOnPulseMeasurementCompleteStatus(From Point)</td>
<td>f</td>
</tr>
<tr>
<td>Get On-Time Totalizer</td>
<td>GetOnTimeTotalizer(From Point)</td>
<td>f</td>
</tr>
<tr>
<td>Get Period</td>
<td>GetPeriod(From Point)</td>
<td>f</td>
</tr>
<tr>
<td>Get Period Measurement Complete Status</td>
<td>GetPeriodMeasurementCompleteStatus(From Point)</td>
<td>f</td>
</tr>
<tr>
<td>Get TPO Percent</td>
<td>GetTpoPercent(From Point, Put in)</td>
<td>f</td>
</tr>
<tr>
<td>Off-Latch Set?</td>
<td>IsOffLatchSet(On Point)</td>
<td>f</td>
</tr>
<tr>
<td>On-Latch Set?</td>
<td>IsOnLatchSet(On Point)</td>
<td>f</td>
</tr>
<tr>
<td>On?</td>
<td>IsOn(On Point)</td>
<td>f</td>
</tr>
<tr>
<td>Off?</td>
<td>IsOff(Point)</td>
<td>f</td>
</tr>
<tr>
<td>Set TPO Percent</td>
<td>SetTpoPercent(To Percent, On Point)</td>
<td>p</td>
</tr>
<tr>
<td>Set TPO Period</td>
<td>SetTpoPeriod(To Seconds, On Point)</td>
<td>p</td>
</tr>
<tr>
<td>Start Continuous Square Wave</td>
<td>StartContinuousSquareWave(On Time (Seconds), Off Time (Seconds), On Point)</td>
<td>p</td>
</tr>
<tr>
<td>Start Counter</td>
<td>StartCounter(On Point)</td>
<td>p</td>
</tr>
<tr>
<td>Start Off-Pulse</td>
<td>StartOffPulse(Off Time (Seconds), On Point)</td>
<td>p</td>
</tr>
<tr>
<td>Start On-Pulse</td>
<td>StartOnPulse(On Time (Seconds), On Point)</td>
<td>p</td>
</tr>
<tr>
<td>Stop Counter</td>
<td>StopCounter(On Point)</td>
<td>p</td>
</tr>
<tr>
<td>Turn Off</td>
<td>TurnOff(Output)</td>
<td>p</td>
</tr>
<tr>
<td>Turn On</td>
<td>TurnOn(Output)</td>
<td>p</td>
</tr>
</tbody>
</table>

### Error Handling

<table>
<thead>
<tr>
<th>PAC Control Command</th>
<th>OptoScript Equivalent (Arguments)</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Message to Queue</td>
<td>AddMessageToQueue(Severity, Message)</td>
<td>p</td>
</tr>
<tr>
<td>Add User Error to Queue</td>
<td>AddUserErrorToQueue(ErrorCode)</td>
<td>p</td>
</tr>
<tr>
<td>Add User I/O Unit Error to Queue</td>
<td>AddUserIoUnitErrorToQueue(ErrorCode, I/O Unit)</td>
<td>p</td>
</tr>
<tr>
<td>Caused a Chart Error?</td>
<td>HasChartCausedError(Chart)</td>
<td>f</td>
</tr>
<tr>
<td>Caused an I/O Unit Error?</td>
<td>HasIoUnitCausedError(I/O Unit)</td>
<td>f</td>
</tr>
</tbody>
</table>
## PAC Control Command Reference

<table>
<thead>
<tr>
<th>PAC Control Command</th>
<th>OptoScript Equivalent (Arguments)</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear All Errors</td>
<td>ClearAllErrors()</td>
<td>p</td>
</tr>
<tr>
<td>Copy Current Error to String</td>
<td>CurrentErrorToString(Delimiter, String)</td>
<td>p</td>
</tr>
<tr>
<td>Disable I/O Unit Causing Current Error</td>
<td>DisableIoUnitCausingCurrentError()</td>
<td>p</td>
</tr>
<tr>
<td>Enable I/O Unit Causing Current Error</td>
<td>EnableIoUnitCausingCurrentError()</td>
<td>p</td>
</tr>
<tr>
<td>Error?</td>
<td>IsErrorPresent()</td>
<td>f</td>
</tr>
<tr>
<td>Error on I/O Unit?</td>
<td>IsErrorOnIoUnit()</td>
<td>f</td>
</tr>
<tr>
<td>Get Error Code of Current Error</td>
<td>GetErrorCodeOfCurrentError()</td>
<td>f</td>
</tr>
<tr>
<td>Get Error Count</td>
<td>GetErrorCount()</td>
<td>f</td>
</tr>
<tr>
<td>Get ID of Block Causing Current Error</td>
<td>GetIdOfBlockCausingCurrentError()</td>
<td>f</td>
</tr>
<tr>
<td>Get Line Causing Current Error</td>
<td>GetLineCausingCurrentError()</td>
<td>f</td>
</tr>
<tr>
<td>Get Name of Chart Causing Current Error</td>
<td>GetNameOfChartCausingCurrentError(Put in)</td>
<td>p</td>
</tr>
<tr>
<td>Get Name of I/O Unit Causing Current Error</td>
<td>GetNameOfIoUnitCausingCurrentError(Put in)</td>
<td>p</td>
</tr>
<tr>
<td>Get Severity of Current Error</td>
<td>GetSeverityOfCurrentError()</td>
<td>f</td>
</tr>
<tr>
<td>Remove Current Error and Point to Next Error</td>
<td>RemoveCurrentError()</td>
<td>p</td>
</tr>
<tr>
<td>Stop Chart on Error</td>
<td>StopChartOnError()</td>
<td>p</td>
</tr>
<tr>
<td>Suspend Chart on Error</td>
<td>SuspendChartOnError()</td>
<td>f</td>
</tr>
</tbody>
</table>

### Event/Reaction

<table>
<thead>
<tr>
<th>PAC Control Command</th>
<th>OptoScript Equivalent (Arguments)</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear All Event Latches</td>
<td>ClearAllEventLatches(On I/O Unit)</td>
<td>p</td>
</tr>
<tr>
<td>Clear Event Latch</td>
<td>ClearEventLatch(On Event/Reaction)</td>
<td>p</td>
</tr>
<tr>
<td>Clear I/O Unit Interrupt</td>
<td>ClearIoUnitInterrupt(On I/O Unit)</td>
<td>p</td>
</tr>
<tr>
<td>Disable Interrupt on Event</td>
<td>DisableInterruptOnEvent(Event/Reaction)</td>
<td>p</td>
</tr>
<tr>
<td>Disable Scanning for All Events</td>
<td>DisableScanningForAllEvents(On I/O Unit)</td>
<td>p</td>
</tr>
<tr>
<td>Disable Scanning for Event</td>
<td>DisableScanningForEvent(Event/Reaction)</td>
<td>p</td>
</tr>
<tr>
<td>Disable Scanning of Event/Reaction Group</td>
<td>DisableScanningOfEventReactionGroup(E/R Group)</td>
<td>p</td>
</tr>
<tr>
<td>Enable Interrupt on Event</td>
<td>EnableInterruptOnEvent(Event/Reaction)</td>
<td>p</td>
</tr>
<tr>
<td>Enable Scanning for All Events</td>
<td>EnableScanningForAllEvents(On I/O Unit)</td>
<td>p</td>
</tr>
<tr>
<td>Enable Scanning for Event</td>
<td>EnableScanningForEvent(Event/Reaction)</td>
<td>p</td>
</tr>
<tr>
<td>Enable Scanning of Event/Reaction Group</td>
<td>EnableScanningOfEventReactionGroup()</td>
<td>p</td>
</tr>
<tr>
<td>Event Occurred?</td>
<td>HasEventOccurred(Event/Reaction)</td>
<td>f</td>
</tr>
<tr>
<td>Event Occurring?</td>
<td>IsEventOccurring(Event/Reaction)</td>
<td>f</td>
</tr>
<tr>
<td>Event Scanning Disabled?</td>
<td>IsEventScanningDisabled(Event/Reaction)</td>
<td>f</td>
</tr>
<tr>
<td>Event Scanning Enabled?</td>
<td>IsEventScanningEnabled(Event/Reaction)</td>
<td>f</td>
</tr>
<tr>
<td>Get &amp; Clear Event Latches</td>
<td>GetClearEventLatches(E/R Group)</td>
<td>f</td>
</tr>
<tr>
<td>Get Event Latches</td>
<td>GetEventLatches(E/R Group)</td>
<td>f</td>
</tr>
<tr>
<td>Generating Interrupt</td>
<td>IsGeneratingInterrupt(I/O Unit)</td>
<td>f</td>
</tr>
<tr>
<td>Interrupt Disabled for Event</td>
<td>IsInterruptDisabledForEvent(Event/Reaction)</td>
<td>f</td>
</tr>
<tr>
<td>Interrupt Enabled for Event</td>
<td>IsInterruptEnabledForEvent(Event/Reaction)</td>
<td>f</td>
</tr>
<tr>
<td>Read Event/Reaction Hold Buffer</td>
<td>ReadEventReactionHoldBuffer(Event/Reaction)</td>
<td>f</td>
</tr>
</tbody>
</table>
### High Density Digital Module

<table>
<thead>
<tr>
<th>PAC Control Command</th>
<th>OptoScript Equivalent (Arguments)</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear HDD Module Off-Latches&lt;sup&gt;3&lt;/sup&gt;</td>
<td>ClearHddModuleOffLatches(I/O Unit, Module Number, Clear Mask)</td>
<td>f</td>
</tr>
<tr>
<td>Clear HDD Module On-Latches&lt;sup&gt;3&lt;/sup&gt;</td>
<td>ClearHddModuleOnLatches(I/O Unit, Module Number, Clear Mask)</td>
<td>f</td>
</tr>
<tr>
<td>Get &amp; Clear All HDD Module Off-Latches&lt;sup&gt;3&lt;/sup&gt;</td>
<td>GetClearAllHddModuleOffLatches(I/O Unit, Start Index, Put Result In)</td>
<td>f</td>
</tr>
<tr>
<td>Get &amp; Clear All HDD Module On-Latches&lt;sup&gt;3&lt;/sup&gt;</td>
<td>GetClearAllHddModuleOnLatches(I/O Unit, Start Index, Put Result In)</td>
<td>f</td>
</tr>
<tr>
<td>Get &amp; Clear HDD Module Counter&lt;sup&gt;3&lt;/sup&gt;</td>
<td>GetClearHddModuleCounter(I/O Unit, Module Number, Point Number, Put Result In)</td>
<td>f</td>
</tr>
<tr>
<td>Get &amp; Clear HDD Module Counters&lt;sup&gt;3&lt;/sup&gt;</td>
<td>GetClearHddModuleCounters(I/O Unit, Module Number, Start Table Index, Put Result In)</td>
<td>f</td>
</tr>
<tr>
<td>Get &amp; Clear HDD Module Off-Latches&lt;sup&gt;3&lt;/sup&gt;</td>
<td>GetClearHddModuleOffLatches(I/O Unit, Module Number, Put Result In)</td>
<td>f</td>
</tr>
<tr>
<td>Get &amp; Clear HDD Module On-Latches&lt;sup&gt;3&lt;/sup&gt;</td>
<td>GetClearHddModuleOnLatches(I/O Unit, Module Number, Put Result In)</td>
<td>f</td>
</tr>
<tr>
<td>Get All HDD Module Off-Latches&lt;sup&gt;3&lt;/sup&gt;</td>
<td>GetAllHddModuleOffLatches(I/O Unit, Start Index, Put Result In)</td>
<td>f</td>
</tr>
<tr>
<td>Get All HDD Module On-Latches&lt;sup&gt;3&lt;/sup&gt;</td>
<td>GetAllHddModuleOnLatches(I/O Unit, Start Index, Put Result In)</td>
<td>f</td>
</tr>
<tr>
<td>Get All HDD Module States&lt;sup&gt;3&lt;/sup&gt;</td>
<td>GetAllHddModuleStates(I/O Unit, Start Index, Put Result In)</td>
<td>f</td>
</tr>
<tr>
<td>Get HDD Module Counters&lt;sup&gt;3&lt;/sup&gt;</td>
<td>GetHddModuleCounters(I/O Unit, Module Number, Start Table Index, Put Result In)</td>
<td>f</td>
</tr>
<tr>
<td>Get HDD Module Off-Latches&lt;sup&gt;3&lt;/sup&gt;</td>
<td>GetHddModuleOffLatches(I/O Unit, Module Number, Put Result In)</td>
<td>f</td>
</tr>
<tr>
<td>Get HDD Module On-Latches&lt;sup&gt;3&lt;/sup&gt;</td>
<td>GetHddModuleOnLatches(I/O Unit, Module Number, Put Result In)</td>
<td>f</td>
</tr>
<tr>
<td>Get HDD Module States&lt;sup&gt;3&lt;/sup&gt;</td>
<td>GetHddModuleStates(I/O Unit, Module Number, Put Result In)</td>
<td>f</td>
</tr>
<tr>
<td>Set HDD Module from MOMO Masks&lt;sup&gt;3&lt;/sup&gt;</td>
<td>SetHddModuleFromMomomasks(I/O Unit, Module Number, Must-On Mask, Must-Off Mask)</td>
<td>f</td>
</tr>
<tr>
<td>Turn Off HDD Module Point&lt;sup&gt;3&lt;/sup&gt;</td>
<td>TurnOffHddModulePoint(I/O Unit, Module Number, Point Number)</td>
<td>f</td>
</tr>
<tr>
<td>Turn On HDD Module Point&lt;sup&gt;3&lt;/sup&gt;</td>
<td>TurnOnHddModulePoint(I/O Unit, Module Number, Point Number)</td>
<td>f</td>
</tr>
</tbody>
</table>

### I/O Quality

<table>
<thead>
<tr>
<th>PAC Control Command</th>
<th>OptoScript Equivalent (Arguments)</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Get I/O Channel Quality</td>
<td>GetChannelQuality(From Channel, Put in)</td>
<td>f</td>
</tr>
<tr>
<td>Get I/O Unit Quality</td>
<td>GetIoUnitQuality(From I/O Unit, Put in)</td>
<td>f</td>
</tr>
</tbody>
</table>

### I/O Unit

<table>
<thead>
<tr>
<th>PAC Control Command</th>
<th>OptoScript Equivalent (Arguments)</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear I/O Unit Configured Flag</td>
<td>ClearIoUnitConfiguredFlag(I/O Unit)</td>
<td>p</td>
</tr>
<tr>
<td>Get I/O Unit as Binary Value</td>
<td>GetIoUnitAsBinaryValue(I/O Unit)</td>
<td>f</td>
</tr>
<tr>
<td>Get I/O Unit as Binary Value 64</td>
<td>GetIoUnitAsBinaryValue64(I/O Unit)</td>
<td>f</td>
</tr>
<tr>
<td>Get I/O Unit Module States</td>
<td>GetIoUnitModuleStates(From I/O Unit, To Table, With Starting Index)</td>
<td>p</td>
</tr>
<tr>
<td>Get Target Address State&lt;sup&gt;1&lt;/sup&gt;</td>
<td>GetTargetAddressState(Enable Mask, Active Mask, I/O Unit)</td>
<td>p</td>
</tr>
<tr>
<td>I/O Unit Ready&lt;sup&gt;1&lt;/sup&gt;</td>
<td>IsIoUnitReady(I/O Unit)</td>
<td>f</td>
</tr>
<tr>
<td>IVAL Move Numeric Table to I/O Unit</td>
<td>IvalMoveNumTableToIoUnit(Start at Index, Of Table, Move to)</td>
<td>p</td>
</tr>
<tr>
<td>IVAL Move Numeric Table to I/O Unit Ex</td>
<td>IvalMoveNumTableToIoUnitEx(From Table, With Starting Index, To I/O Unit)</td>
<td>p</td>
</tr>
<tr>
<td>Move I/O Unit to Numeric Table</td>
<td>MoveIoUnitToNumTable(I/O Unit, Starting Index, Of Table)</td>
<td>p</td>
</tr>
<tr>
<td>Move I/O Unit to Numeric Table Ex</td>
<td>MoveIoUnitToNumTableEx(From I/O Unit, To Table, With Starting Index)</td>
<td>p</td>
</tr>
</tbody>
</table>
## I/O Unit—Event Message

<table>
<thead>
<tr>
<th>PAC Control Command</th>
<th>OptoScript Equivalent (Arguments)</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Get I/O Unit Event Message State</td>
<td>GetIoUnitEventMsgState(I/O Unit, Event Message #, Put Result in)</td>
<td>f</td>
</tr>
<tr>
<td>Get I/O Unit Event Message Text</td>
<td>GetIoUnitEventMsgText(I/O Unit, Event Message #, Put Result in)</td>
<td>f</td>
</tr>
<tr>
<td>Set I/O Unit Event Message State</td>
<td>SetIoUnitEventMsgState(I/O Unit, Event Message #, State)</td>
<td>f</td>
</tr>
<tr>
<td>Set I/O Unit Event Message Text</td>
<td>SetIoUnitEventMsgText(I/O Unit, Event Message #, Message Text)</td>
<td>f</td>
</tr>
</tbody>
</table>

## I/O Unit—Scratch Pad

<table>
<thead>
<tr>
<th>PAC Control Command</th>
<th>OptoScript Equivalent (Arguments)</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Get I/O Unit Scratch Pad Bits</td>
<td>GetIoUnitScratchPadBits(I/O Unit, Put Result in)</td>
<td>f</td>
</tr>
<tr>
<td>Get I/O Unit Scratch Pad Float Element</td>
<td>GetIoUnitScratchPadFloatElement(I/O Unit, Index, Put Result in)</td>
<td>f</td>
</tr>
<tr>
<td>Get I/O Unit Scratch Pad Float Table</td>
<td>GetIoUnitScratchPadFloatTable(I/O Unit, Length, From Index, To Table)</td>
<td>f</td>
</tr>
<tr>
<td>Get I/O Unit Scratch Pad Integer 32 Element</td>
<td>GetIoUnitScratchPadInt32Element(I/O Unit, Index, Put Result in)</td>
<td>f</td>
</tr>
<tr>
<td>Get I/O Unit Scratch Pad Integer 32 Table</td>
<td>GetIoUnitScratchPadInt32Table(I/O Unit, Length, From Index, To Table)</td>
<td>f</td>
</tr>
<tr>
<td>Get I/O Unit Scratch Pad String Element</td>
<td>GetIoUnitScratchPadStringElement(I/O Unit, Index, Put Result in)</td>
<td>f</td>
</tr>
<tr>
<td>Get I/O Unit Scratch Pad String Table</td>
<td>GetIoUnitScratchPadStringTable(I/O Unit, Length, From Index, To Table)</td>
<td>f</td>
</tr>
</tbody>
</table>
## Logical

<table>
<thead>
<tr>
<th>PAC Control Command</th>
<th>OptoScript Equivalent (Arguments)</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set I/O Unit Scratch Pad Bits from MOMO Mask</td>
<td>SetIoUnitScratchPadBitsFromMomo(I/O Unit, Must-On Mask, Must-Off Mask)</td>
<td>f</td>
</tr>
<tr>
<td>Set I/O Unit Scratch Pad Float Element</td>
<td>SetIoUnitScratchPadFloatElement(I/O Unit, Index, From)</td>
<td>f</td>
</tr>
<tr>
<td>Set I/O Unit Scratch Pad Float Table</td>
<td>SetIoUnitScratchPadFloatTable(I/O Unit, Length, To Index, From Index, From Table)</td>
<td>f</td>
</tr>
<tr>
<td>Set I/O Unit Scratch Pad Integer 32 Element</td>
<td>SetIoUnitScratchPadInt32Element(I/O Unit, Index, From)</td>
<td>f</td>
</tr>
<tr>
<td>Set I/O Unit Scratch Pad Integer 32 Table</td>
<td>SetIoUnitScratchPadInt32Table(I/O Unit, Length, To Index, From Index, From Table)</td>
<td>f</td>
</tr>
<tr>
<td>Set I/O Unit Scratch Pad String Element</td>
<td>SetIoUnitScratchPadStringElement(I/O Unit, Index, From)</td>
<td>f</td>
</tr>
<tr>
<td>Set I/O Unit Scratch Pad String Table</td>
<td>SetIoUnitScratchPadStringTable(I/O Unit, Length, To Index, From Index, From Table)</td>
<td>f</td>
</tr>
</tbody>
</table>

### AND
- **AND**
  - `x and y`  
- **AND?**
  - See AND

### Bit AND
- **Bit AND**
  - `x bitand y`
- **Bit AND?**
  - See Bit AND

### Bit Change
- **Bit Change**
  - `BitChange(Set flag, Bit to Change, Output)`

### Bit Clear
- **Bit Clear**
  - `BitClear(Item, Bit to Clear)`

### Bit Copy
- **Bit Copy**
  - `BitCopy(Server Bit to Set, Destination, Destination Index, Bit to Read, Source, Source Index)`

### Bit NOT
- **Bit NOT**
  - `bitnot x`
- **Bit NOT?**
  - See Bit NOT

### Bit Off in Numeric Table Element?
- **Bit Off in Numeric Table Element?**
  - `IsBitOffInNumTableElement(At Index, Of Table, Bit)`

### Bit Off?
- **Bit Off?**
  - `IsBitOff(In, Bit)`

### Bit On in Numeric Table Element?
- **Bit On in Numeric Table Element?**
  - `IsBitOnInNumTableElement(At Index, Of Table, Bit)`

### Bit On?
- **Bit On?**
  - `IsBitOn(In, Bit)`

### Bit OR
- **Bit OR**
  - `x bitor y`
- **Bit OR?**
  - See Bit OR

### Bit Rotate
- **Bit Rotate**
  - `BitRotate(Item, Count)`

### Bit Set
- **Bit Set**
  - `BitSet(Item, Bit to Set)`

### Bit Shift
- **Bit Shift**
  - `x << nBitsToShift`

### Bit Test
- **Bit Test**
  - `BitTest(Item, Bit to Test)`

### Bit XOR
- **Bit XOR**
  - `x bitxor y`
- **Bit XOR?**
  - See Bit XOR

### Equal to Numeric Table Element?
- **Equal to Numeric Table Element?**
  - `n == nt[0]`

### Equal?
- **Equal?**
  - `x == y`

### Flip Flop JK
- **Flip Flop JK**
  - `FlipFlopJK(Set [J], Reset [K], Output [Q])`

### Float to Int32 Bits
- **Float to Int32 Bits**
  - `FloatToInt32Bits(Server URL)`

### Get High Bits of Integer 64
- **Get High Bits of Integer 64**
  - `GetHighBitsOfInt64(High Bits From)`

### Get Low Bits of Integer 64
- **Get Low Bits of Integer 64**
  - `GetLowBitsOfInt64(Integer 64)`

### Greater Than Numeric Table Element?
- **Greater Than Numeric Table Element?**
  - `x > nt[0]`
### CHAPTER 1: WELCOME

<table>
<thead>
<tr>
<th>PAC Control Command</th>
<th>OptoScript Equivalent (Arguments)</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Greater Than or Equal to Numeric Table Element?</td>
<td>x &gt;= t[0]</td>
<td>f</td>
</tr>
<tr>
<td>Greater Than or Equal?</td>
<td>x &gt;= y</td>
<td>f</td>
</tr>
<tr>
<td>Greater?</td>
<td>x &gt; y</td>
<td>f</td>
</tr>
<tr>
<td>Int32 to Float Bits</td>
<td>Int32ToFloatBits(nInt32)</td>
<td>f</td>
</tr>
<tr>
<td>Less Than Numeric Table Element?</td>
<td>x &lt; nt[0]</td>
<td>f</td>
</tr>
<tr>
<td>Less Than or Equal to Numeric Table Element?</td>
<td>x &lt;= nt[0]</td>
<td>f</td>
</tr>
<tr>
<td>Less Than or Equal?</td>
<td>x &lt;= y</td>
<td>f</td>
</tr>
<tr>
<td>Make Integer 64</td>
<td>MakeInt64(High Integer, Low Integer)</td>
<td>f</td>
</tr>
<tr>
<td>Move 32 Bits</td>
<td>Move32Bits(From, To)</td>
<td>p</td>
</tr>
<tr>
<td>NOT</td>
<td>not x</td>
<td>f</td>
</tr>
<tr>
<td>Not Equal to Numeric Table Element?</td>
<td>n &lt;&gt; nt[0]</td>
<td>f</td>
</tr>
<tr>
<td>Not Equal?</td>
<td>x &lt;&gt; y</td>
<td>f</td>
</tr>
<tr>
<td>NOT?</td>
<td>not x</td>
<td>f</td>
</tr>
<tr>
<td>Numeric Table Element Bit Clear</td>
<td>NumTableElementBitClear(Element Index, Of Integer Table, Bit to Clear)</td>
<td>p</td>
</tr>
<tr>
<td>Numeric Table Element Bit Set</td>
<td>NumTableElementBitSet(Element Index, Of Integer Table, Bit to Set)</td>
<td>p</td>
</tr>
<tr>
<td>Numeric Table Element Bit Test</td>
<td>NumTableElementBitTest(Element Index, Of Integer Table, Bit to Test)</td>
<td>f</td>
</tr>
<tr>
<td>OR</td>
<td>x or y</td>
<td>f</td>
</tr>
<tr>
<td>OR?</td>
<td>See OR</td>
<td>f</td>
</tr>
<tr>
<td>Set Variable False</td>
<td>SetVariableFalse(Variable)</td>
<td>p</td>
</tr>
<tr>
<td>Set Variable True</td>
<td>SetVariableTrue(Variable)</td>
<td>p</td>
</tr>
<tr>
<td>Test Equal</td>
<td>See Equal?</td>
<td>f</td>
</tr>
<tr>
<td>Test Greater</td>
<td>See Greater?</td>
<td>f</td>
</tr>
<tr>
<td>Test Greater or Equal</td>
<td>See Greater Than or Equal?</td>
<td>f</td>
</tr>
<tr>
<td>Test Less</td>
<td>See Less?</td>
<td>f</td>
</tr>
<tr>
<td>Test Less or Equal</td>
<td>See Less Than or Equal?</td>
<td>f</td>
</tr>
<tr>
<td>Test Not Equal</td>
<td>See Not Equal?</td>
<td>f</td>
</tr>
<tr>
<td>Test Within Limits</td>
<td>See Within Limits?</td>
<td>f</td>
</tr>
<tr>
<td>Variable False?</td>
<td>IsVariableFalse(Variable)</td>
<td>f</td>
</tr>
<tr>
<td>Variable True?</td>
<td>IsVariableTrue(Variable)</td>
<td>f</td>
</tr>
<tr>
<td>Within Limits?</td>
<td>IsWithinLimits(Value, Low Limit, High Limit)</td>
<td>f</td>
</tr>
<tr>
<td>XOR</td>
<td>x xor y</td>
<td>f</td>
</tr>
<tr>
<td>XOR?</td>
<td>See XOR</td>
<td>f</td>
</tr>
</tbody>
</table>

#### Mathematical

<table>
<thead>
<tr>
<th>PAC Control Command</th>
<th>OptoScript Equivalent (Arguments)</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Absolute Value</td>
<td>AbsoluteValue(Of)</td>
<td>f</td>
</tr>
<tr>
<td>Add</td>
<td>x + y</td>
<td>f</td>
</tr>
<tr>
<td>Arcosine</td>
<td>Arcosine(Of)</td>
<td>f</td>
</tr>
<tr>
<td>PAC Control Command</td>
<td>OptoScript Equivalent (Arguments)</td>
<td>Type</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Arcsine</td>
<td>Arcsine(Of)</td>
<td>f</td>
</tr>
<tr>
<td>Arctangent</td>
<td>Arctangent(Of)</td>
<td>p</td>
</tr>
<tr>
<td>Clamp Float Table Element</td>
<td>ClampFloatTableElement(High Limit, Low Limit, Element Index, Of Float Table)</td>
<td>p</td>
</tr>
<tr>
<td>Clamp Float Variable</td>
<td>ClampFloatVariable(High Limit, Low Limit, Float Variable)</td>
<td>p</td>
</tr>
<tr>
<td>Clamp Integer 32 Table Element</td>
<td>ClampInt32TableElement(High Limit, Low Limit, Element Index, Of Integer 32 Table)</td>
<td>p</td>
</tr>
<tr>
<td>Clamp Integer 32 Variable</td>
<td>ClampInt32Variable(High Limit, Low Limit, Integer 32 Variable)</td>
<td>p</td>
</tr>
<tr>
<td>Complement</td>
<td>-x</td>
<td>p</td>
</tr>
<tr>
<td>Cosine</td>
<td>Cosine(Of)</td>
<td>f</td>
</tr>
<tr>
<td>Decrement Variable</td>
<td>DecrementVariable(Variable)</td>
<td>p</td>
</tr>
<tr>
<td>Divide</td>
<td>x / y</td>
<td>f</td>
</tr>
<tr>
<td>Generate Random Number</td>
<td>GenerateRandomNumber()</td>
<td>f</td>
</tr>
<tr>
<td>Hyperbolic Cosine</td>
<td>HyperbolicCosine(Of)</td>
<td>f</td>
</tr>
<tr>
<td>Hyperbolic Sine</td>
<td>HyperbolicSine(Of)</td>
<td>f</td>
</tr>
<tr>
<td>Hyperbolic Tangent</td>
<td>HyperbolicTangent(Of)</td>
<td>f</td>
</tr>
<tr>
<td>Increment Variable</td>
<td>IncrementVariable(Variable)</td>
<td>p</td>
</tr>
<tr>
<td>Maximum</td>
<td>Max(Compare, With)</td>
<td>f</td>
</tr>
<tr>
<td>Minimum</td>
<td>Min(Compare, With)</td>
<td>f</td>
</tr>
<tr>
<td>Modulo</td>
<td>x % y</td>
<td>f</td>
</tr>
<tr>
<td>Multiply</td>
<td>x * y</td>
<td>f</td>
</tr>
<tr>
<td>Natural Log</td>
<td>NaturalLog(Of)</td>
<td>f</td>
</tr>
<tr>
<td>Raise e to Power</td>
<td>RaiseEToPower(Exponent)</td>
<td>f</td>
</tr>
<tr>
<td>Raise to Power</td>
<td>Power(Raise, To the)</td>
<td>f</td>
</tr>
<tr>
<td>Round</td>
<td>Round(Value)</td>
<td>f</td>
</tr>
<tr>
<td>Seed Random Number</td>
<td>SeedRandomNumber()</td>
<td>p</td>
</tr>
<tr>
<td>Sine</td>
<td>Sine(Of)</td>
<td>f</td>
</tr>
<tr>
<td>Square Root</td>
<td>SquareRoot(Of)</td>
<td>f</td>
</tr>
<tr>
<td>Subtract</td>
<td>x - y</td>
<td>f</td>
</tr>
<tr>
<td>Tangent</td>
<td>Tangent(Of)</td>
<td>f</td>
</tr>
<tr>
<td>Truncate</td>
<td>Truncate(Value)</td>
<td>f</td>
</tr>
</tbody>
</table>

### Miscellaneous

<table>
<thead>
<tr>
<th>PAC Control Command</th>
<th>OptoScript Equivalent (Arguments)</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comment (Block)</td>
<td>/* block comment */</td>
<td>p</td>
</tr>
<tr>
<td>Comment (Single Line)</td>
<td>// single line comment</td>
<td>f</td>
</tr>
<tr>
<td>Flag Lock</td>
<td>FlagLock(Flag, Timeout)</td>
<td>f</td>
</tr>
<tr>
<td>Flag Unlock</td>
<td>FlagUnlock(Flag, Force unlock)</td>
<td>f</td>
</tr>
<tr>
<td>Float Valid?</td>
<td>IsFloatValid(Float)</td>
<td>f</td>
</tr>
<tr>
<td>Generate Reverse CRC-16 on Table (32 bit)</td>
<td>GenerateReverseCrc16OnTable32(Start Value, Table, Starting Element, Number of Elements)</td>
<td>f</td>
</tr>
<tr>
<td>Get Length of Table</td>
<td>GetLengthOfTable(Table)</td>
<td>f</td>
</tr>
<tr>
<td>Get Type From Name</td>
<td>GetTypeFromName(Name)</td>
<td>f</td>
</tr>
</tbody>
</table>
### PID—Ethernet

<table>
<thead>
<tr>
<th>PAC Control Command</th>
<th>OptoScript Equivalent (Arguments)</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Get Value From Name</td>
<td>GetValueFromName(Name, Put Result In)</td>
<td>f</td>
</tr>
<tr>
<td>Move</td>
<td>x = y;</td>
<td>p</td>
</tr>
<tr>
<td>Move from Numeric Table Element</td>
<td>x = nt[0];</td>
<td>f</td>
</tr>
<tr>
<td>Move Numeric Table Element to Numeric Table</td>
<td>nt1[0] = nt2[5];</td>
<td>p</td>
</tr>
<tr>
<td>Move Numeric Table to Numeric Table</td>
<td>MoveNumTableToNumTable(From Table, From Index, To Table, To Index, Length)</td>
<td>p</td>
</tr>
<tr>
<td>Move to Numeric Table Element</td>
<td>nt[0] = x;</td>
<td>p</td>
</tr>
<tr>
<td>Move to Numeric Table Elements</td>
<td>MoveToNumTableElements(From, Start Index, End Index, Of Table)</td>
<td>p</td>
</tr>
<tr>
<td>Shift Numeric Table Elements</td>
<td>ShiftNumTableElements(Shift Count, Table)</td>
<td>p</td>
</tr>
<tr>
<td>Get PID Configuration Flags</td>
<td>GetPidConfigFlags(PID Loop)</td>
<td>f</td>
</tr>
<tr>
<td>Get PID Current Input</td>
<td>GetPidCurrentInput(PID Loop)</td>
<td>f</td>
</tr>
<tr>
<td>Get PID Current Setpoint</td>
<td>GetPidCurrentSetpoint(PID Loop)</td>
<td>f</td>
</tr>
<tr>
<td>Get PID Feed Forward</td>
<td>GetPidFeedForward(PID Loop)</td>
<td>f</td>
</tr>
<tr>
<td>Get PID Feed Forward Gain</td>
<td>GetPidFeedForwardGain(PID Loop)</td>
<td>f</td>
</tr>
<tr>
<td>Get PID Forced Output When Input Over Range</td>
<td>GetPidForcedOutputWhenInputOverRange(PID Loop)</td>
<td>f</td>
</tr>
<tr>
<td>Get PID Forced Output When Input Under Range</td>
<td>GetPidForcedOutputWhenInputUnderRange(PID Loop)</td>
<td>f</td>
</tr>
<tr>
<td>Get PID Gain</td>
<td>GetPidGain(PID Loop)</td>
<td>f</td>
</tr>
<tr>
<td>Get PID Input</td>
<td>GetPidInput(PID Loop)</td>
<td>f</td>
</tr>
<tr>
<td>Get PID Input High Range</td>
<td>GetPidInputHighRange(PID Loop)</td>
<td>f</td>
</tr>
<tr>
<td>Get PID Input Low Range</td>
<td>GetPidInputLowRange(PID Loop)</td>
<td>f</td>
</tr>
<tr>
<td>Get PID Max Output Change</td>
<td>GetPidMaxOutputChange(PID Loop)</td>
<td>f</td>
</tr>
<tr>
<td>Get PID Min Output Change</td>
<td>GetPidMinOutputChange(PID Loop)</td>
<td>f</td>
</tr>
<tr>
<td>Get PID Mode</td>
<td>GetPidMode(PID Loop)</td>
<td>f</td>
</tr>
<tr>
<td>Get PID Output</td>
<td>GetPidOutput(PID Loop)</td>
<td>f</td>
</tr>
<tr>
<td>Get PID Output High Clamp</td>
<td>GetPidOutputHighClamp(PID Loop)</td>
<td>f</td>
</tr>
<tr>
<td>Get PID Output Low Clamp</td>
<td>GetPidOutputLowClamp(PID Loop)</td>
<td>f</td>
</tr>
<tr>
<td>Get PID Scan Time</td>
<td>GetPidScanTime(PID Loop)</td>
<td>f</td>
</tr>
<tr>
<td>Get PID Setpoint</td>
<td>GetPidSetpoint(PID Loop)</td>
<td>f</td>
</tr>
<tr>
<td>Get PID Status Flags</td>
<td>GetPidStatusFlags(PID Loop)</td>
<td>f</td>
</tr>
<tr>
<td>Get PID Tune Derivative</td>
<td>GetPidTuneDerivative(PID Loop)</td>
<td>f</td>
</tr>
<tr>
<td>Get PID Tune Integral</td>
<td>GetPidTuneIntegral(PID Loop)</td>
<td>f</td>
</tr>
<tr>
<td>Set PID Configuration Flags</td>
<td>SetPidConfigFlags(PID Loop, Configuration Flags)</td>
<td>p</td>
</tr>
<tr>
<td>Set PID Feed Forward</td>
<td>SetPidFeedForward(PID Loop, Feed Forward)</td>
<td>p</td>
</tr>
<tr>
<td>Set PID Feed Forward Gain</td>
<td>SetPidFeedForwardGain(PID Loop, Feed Fwd Gain)</td>
<td>p</td>
</tr>
<tr>
<td>Set PID Forced Output When Input Over Range</td>
<td>SetPidForcedOutputWhenInputOverRange(PID Loop, Forced Output)</td>
<td>p</td>
</tr>
<tr>
<td>Set PID Forced Output When Input Under Range</td>
<td>SetPidForcedOutputWhenInputUnderRange(PID Loop, Forced Output)</td>
<td>p</td>
</tr>
<tr>
<td>Set PID Gain</td>
<td>SetPidGain(PID Loop, Gain)</td>
<td>p</td>
</tr>
<tr>
<td>Set PID Input</td>
<td>SetPidInput(PID Loop, Input)</td>
<td>p</td>
</tr>
</tbody>
</table>
### PAC Control Command Reference

<table>
<thead>
<tr>
<th>PAC Control Command</th>
<th>OptoScript Equivalent (Arguments)</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set PID Input High Range</td>
<td>SetPidInputHighRange(PID Loop, High Range)</td>
<td>p</td>
</tr>
<tr>
<td>Set PID Input Low Range</td>
<td>SetPidInputLowRange(PID Loop, Low Range)</td>
<td>p</td>
</tr>
<tr>
<td>Set PID Max Output Change</td>
<td>SetPidMaxOutputChange(PID Loop, Max Change)</td>
<td>p</td>
</tr>
<tr>
<td>Set PID Min Output Change</td>
<td>SetPidMinOutputChange(PID Loop, Min Change)</td>
<td>p</td>
</tr>
<tr>
<td>Set PID Mode</td>
<td>SetPidMode(PID Loop, Mode)</td>
<td>p</td>
</tr>
<tr>
<td>Set PID Output</td>
<td>SetPidOutput(PID Loop, Output)</td>
<td>p</td>
</tr>
<tr>
<td>Set PID Output High Clamp</td>
<td>SetPidOutputHighClamp(PID Loop, High Clamp)</td>
<td>p</td>
</tr>
<tr>
<td>Set PID Output Low Clamp</td>
<td>SetPidOutputLowClamp(PID Loop, Low Clamp)</td>
<td>p</td>
</tr>
<tr>
<td>Set PID Scan Time</td>
<td>SetPidScanTime(PID Loop, Scan Time)</td>
<td>p</td>
</tr>
<tr>
<td>Set PID Setpoint</td>
<td>SetPidSetpoint(PID Loop, Setpoint)</td>
<td>p</td>
</tr>
<tr>
<td>Set PID Tune Derivative</td>
<td>SetPidTuneDerivative(PID Loop, Derivative)</td>
<td>p</td>
</tr>
<tr>
<td>Set PID Tune Integral</td>
<td>SetPidTuneIntegral(PID Loop, Integral)</td>
<td>p</td>
</tr>
</tbody>
</table>

### PID—Mistic

<table>
<thead>
<tr>
<th>PAC Control Command</th>
<th>OptoScript Equivalent (Arguments)</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clamp Mistic PID Output</td>
<td>ClampMisticPidOutput(High Clamp, Low Clamp, On PID Loop)</td>
<td>p</td>
</tr>
<tr>
<td>Clamp Mistic PID Setpoint</td>
<td>ClampMisticPidSetpoint(High Clamp, Low Clamp, On PID Loop)</td>
<td>p</td>
</tr>
<tr>
<td>Disable Mistic PID Output</td>
<td>DisableMisticPidOutput(Of PID Loop)</td>
<td>p</td>
</tr>
<tr>
<td>Disable Mistic PID Output Tracking in Manual Mode</td>
<td>DisableMisticPidOutputTrackingInManualMode(On PID Loop)</td>
<td>p</td>
</tr>
<tr>
<td>Disable Mistic PID Setpoint Tracking in Manual Mode</td>
<td>DisableMisticPidSetpointTrackingInManualMode(On PID Loop)</td>
<td>p</td>
</tr>
<tr>
<td>Enable Mistic PID Output</td>
<td>EnableMisticPidOutput(On PID Loop)</td>
<td>p</td>
</tr>
<tr>
<td>Enable Mistic PID Output Tracking in Manual Mode</td>
<td>EnableMisticPidOutputTrackingInManualMode(On PID Loop)</td>
<td>p</td>
</tr>
<tr>
<td>Enable Mistic PID Setpoint Tracking in Manual Mode</td>
<td>EnableMisticPidSetpointTrackingInManualMode(On PID Loop)</td>
<td>p</td>
</tr>
<tr>
<td>Get Mistic PID Control Word</td>
<td>GetMisticPidControlWord(From PID Loop)</td>
<td>f</td>
</tr>
<tr>
<td>Get Mistic PID D Term</td>
<td>GetMisticPidDTerm(From PID Loop)</td>
<td>f</td>
</tr>
<tr>
<td>Get Mistic PID I Term</td>
<td>GetMisticPidITerm(From PID Loop)</td>
<td>f</td>
</tr>
<tr>
<td>Get Mistic PID Input</td>
<td>GetMisticPidInput(PID Loop)</td>
<td>f</td>
</tr>
<tr>
<td>Get Mistic PID Mode</td>
<td>GetMisticPidMode(PID Loop)</td>
<td>f</td>
</tr>
<tr>
<td>Get Mistic PID Output</td>
<td>GetMisticPidOutput(PID Loop)</td>
<td>f</td>
</tr>
<tr>
<td>Get Mistic PID Output Rate of Change</td>
<td>GetMisticPidOutputRateOfChange(From PID Loop)</td>
<td>f</td>
</tr>
<tr>
<td>Get Mistic PID P Term</td>
<td>GetMisticPidPTerm(From PID Loop)</td>
<td>f</td>
</tr>
<tr>
<td>Get Mistic PID Scan Rate</td>
<td>GetMisticPidScanRate(From PID Loop)</td>
<td>f</td>
</tr>
<tr>
<td>Get Mistic PID Setpoint</td>
<td>GetMisticPidSetpoint(PID Loop)</td>
<td>f</td>
</tr>
<tr>
<td>Set Mistic PID Control Word</td>
<td>SetMisticPidControlWord(On-Mask, Off-Mask, For PID Loop)</td>
<td>p</td>
</tr>
<tr>
<td>Set Mistic PID D Term</td>
<td>SetMisticPidDTerm(To, On PID Loop)</td>
<td>p</td>
</tr>
<tr>
<td>Set Mistic PID I Term</td>
<td>SetMisticPidITerm(To, On PID Loop)</td>
<td>p</td>
</tr>
<tr>
<td>Set Mistic PID Input</td>
<td>SetMisticPidInput(Input, PID Loop)</td>
<td>p</td>
</tr>
<tr>
<td>Set Mistic PID Mode to Auto</td>
<td>SetMisticPidModeToAuto(On PID Loop)</td>
<td>p</td>
</tr>
<tr>
<td>Set Mistic PID Mode to Manual</td>
<td>SetMisticPidModeToManual(On PID Loop)</td>
<td>p</td>
</tr>
<tr>
<td>Set Mistic PID Output Rate of Change</td>
<td>SetMisticPidOutputRateOfChange(To, On PID Loop)</td>
<td>p</td>
</tr>
</tbody>
</table>
## Set Mistic PID P Term

<table>
<thead>
<tr>
<th>PAC Control Command</th>
<th>OptoScript Equivalent (Arguments)</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set Mistic PID P Term</td>
<td>SetMisticPidPTerm(To, On PID Loop)</td>
<td>p</td>
</tr>
<tr>
<td>Set Mistic PID Scan Rate</td>
<td>SetMisticPidScanRate(To, On PID Loop)</td>
<td>p</td>
</tr>
<tr>
<td>Set Mistic PID Setpoint</td>
<td>SetMisticPidSetpoint(PID Loop, Setpoint)</td>
<td>p</td>
</tr>
</tbody>
</table>

## Pointers

<table>
<thead>
<tr>
<th>PAC Control Command</th>
<th>OptoScript Equivalent (Arguments)</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear Pointer</td>
<td>pn1 = null;</td>
<td>f</td>
</tr>
<tr>
<td>Clear Pointer Table Element</td>
<td>pt[0] = null;</td>
<td>p</td>
</tr>
<tr>
<td>Get Pointer From Name</td>
<td>GetPointerFromName(Name, Pointer)</td>
<td>p</td>
</tr>
<tr>
<td>Move from Pointer Table Element</td>
<td>pn = pt[0];</td>
<td>f</td>
</tr>
<tr>
<td>Move to Pointer</td>
<td>pn = &amp;n;</td>
<td>f</td>
</tr>
<tr>
<td>Move to Pointer Table Element</td>
<td>pt[0] = &amp;n;</td>
<td>f</td>
</tr>
<tr>
<td>Pointer Equal to Null?</td>
<td>pn -- null</td>
<td>f</td>
</tr>
<tr>
<td>Pointer Table Element Equal to Null?</td>
<td>pt[0] -- null</td>
<td>f</td>
</tr>
</tbody>
</table>

## Simulation

<table>
<thead>
<tr>
<th>PAC Control Command</th>
<th>OptoScript Equivalent (Arguments)</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication to All I/O Points Enabled?</td>
<td>IsCommToAllIoPointsEnabled()</td>
<td>f</td>
</tr>
<tr>
<td>Communication To All I/O Units Enabled?</td>
<td>IsCommToAllIoUnitsEnabled()</td>
<td>f</td>
</tr>
<tr>
<td>Disable Communication to All I/O Points</td>
<td>DisableCommunicationToAllIoPoints()</td>
<td>p</td>
</tr>
<tr>
<td>Disable Communication to All I/O Units</td>
<td>DisableCommunicationToAllIoUnits()</td>
<td>p</td>
</tr>
<tr>
<td>Disable Communication to Event/Reaction</td>
<td>DisableCommunicationToEventReaction(Event/Reaction)</td>
<td>p</td>
</tr>
<tr>
<td>Disable Communication to I/O Unit</td>
<td>DisableCommunicationToIoUnit(I/O Unit)</td>
<td>p</td>
</tr>
<tr>
<td>Disable Communication to Mistic PID Loop</td>
<td>DisableCommunicationToMisticPidLoop(PID Loop)</td>
<td>p</td>
</tr>
<tr>
<td>Disable Communication to PID Loop</td>
<td>DisableCommunicationToPidLoop(PID Loop)</td>
<td>p</td>
</tr>
<tr>
<td>Disable Communication to Point</td>
<td>DisableCommunicationToPoint(Point)</td>
<td>p</td>
</tr>
<tr>
<td>Disable Event/Reaction Group</td>
<td>DisableEventReactionGroup(E/R Group)</td>
<td>p</td>
</tr>
<tr>
<td>Enable Communication to All I/O Points</td>
<td>EnableCommunicationToAllIoPoints()</td>
<td>p</td>
</tr>
<tr>
<td>Enable Communication to All I/O Units</td>
<td>EnableCommunicationToAllIoUnits()</td>
<td>p</td>
</tr>
<tr>
<td>Enable Communication to Event/Reaction</td>
<td>EnableCommunicationToEventReaction(Event/Reaction)</td>
<td>p</td>
</tr>
<tr>
<td>Enable Communication to I/O Unit</td>
<td>EnableCommunicationToIoUnit(I/O Unit)</td>
<td>p</td>
</tr>
<tr>
<td>Enable Communication to Mistic PID Loop</td>
<td>EnableCommunicationToMisticPidLoop(PID Loop)</td>
<td>p</td>
</tr>
<tr>
<td>Enable Communication to PID Loop</td>
<td>EnableCommunicationToPidLoop(PID Loop)</td>
<td>p</td>
</tr>
<tr>
<td>Enable Communication to Point</td>
<td>EnableCommunicationToPoint(Point)</td>
<td>p</td>
</tr>
<tr>
<td>Enable Event/Reaction Group</td>
<td>EnableEventReactionGroup(E/R Group)</td>
<td>p</td>
</tr>
<tr>
<td>Event/Reaction Communication Enabled?</td>
<td>IsEventReactionCommEnabled(Event/Reaction)</td>
<td>f</td>
</tr>
<tr>
<td>Event/Reaction Group Communication Enabled?</td>
<td>IsEventReactionGroupEnabled(E/R Group)</td>
<td>f</td>
</tr>
<tr>
<td>I/O Point Communication Enabled?</td>
<td>IsIoPointCommEnabled(I/O Point)</td>
<td>f</td>
</tr>
<tr>
<td>I/O Unit Communication Enabled?</td>
<td>IsIoUnitCommEnabled(I/O Unit)</td>
<td>f</td>
</tr>
<tr>
<td>IVAL Set Analog Filtered Value</td>
<td>IvalSetAnalogFilteredValue(To, On Point)</td>
<td>p</td>
</tr>
<tr>
<td>PAC Control Command</td>
<td>OptoScript Equivalent (Arguments)</td>
<td>Type</td>
</tr>
<tr>
<td>----------------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>IVAL Set Analog Maximum Value</td>
<td>IvalSetAnalogMaxValue(To, On Point)</td>
<td>p</td>
</tr>
<tr>
<td>IVAL Set Analog Minimum Value</td>
<td>IvalSetAnalogMinValue(To, On Point)</td>
<td>p</td>
</tr>
<tr>
<td>IVAL Set Analog Point</td>
<td>IvalSetAnalogPoint(To, On Point)</td>
<td>p</td>
</tr>
<tr>
<td>IVAL Set Counter</td>
<td>IvalSetCounter(To, On Point)</td>
<td>p</td>
</tr>
<tr>
<td>IVAL Set Frequency</td>
<td>IvalSetFrequency(To, On Point)</td>
<td>p</td>
</tr>
<tr>
<td>IVAL Set I/O Unit from MOMO Masks</td>
<td>IvalSetIoUnitfromMOMO(On Mask, Off Mask, On I/O Unit)</td>
<td>p</td>
</tr>
<tr>
<td>IVAL Set Mistic PID Control Word¹, 4</td>
<td>IvalSetPidControlWord(On Mask, Off Mask, For PID Loop)</td>
<td>p</td>
</tr>
<tr>
<td>IVAL Set Mistic PID Process Term¹, 4</td>
<td>IvalSetMisticPidProcessTerm(To, On PID Loop)</td>
<td>p</td>
</tr>
<tr>
<td>IVAL Set Off-Latch</td>
<td>IvalSetOffLatch(To, On Point)</td>
<td>p</td>
</tr>
<tr>
<td>IVAL Set Off-Pulse</td>
<td>IvalSetOffPulse(To, On Point)</td>
<td>p</td>
</tr>
<tr>
<td>IVAL Set Off-Totalizer</td>
<td>IvalSetOffTotalizer(To, On Point)</td>
<td>p</td>
</tr>
<tr>
<td>IVAL Set On-Latch</td>
<td>IvalSetOnLatch(To, On Point)</td>
<td>p</td>
</tr>
<tr>
<td>IVAL Set On-Pulse</td>
<td>IvalSetOnPulse(To, On Point)</td>
<td>p</td>
</tr>
<tr>
<td>IVAL Set On-Totalizer</td>
<td>IvalSetOnTotalizer(To, On Point)</td>
<td>p</td>
</tr>
<tr>
<td>IVAL Set Period</td>
<td>IvalSetPeriod(To, On Point)</td>
<td>p</td>
</tr>
<tr>
<td>IVAL Set TPO Percent</td>
<td>IvalSetTpoPercent(To, On Point)</td>
<td>p</td>
</tr>
<tr>
<td>IVAL Set TPO Period</td>
<td>IvalSetTpoPeriod(Value, On Point)</td>
<td>p</td>
</tr>
<tr>
<td>IVAL Turn Off</td>
<td>IvalTurnOff(Point)</td>
<td>p</td>
</tr>
<tr>
<td>IVAL Turn On</td>
<td>IvalTurnOn(Point)</td>
<td>p</td>
</tr>
<tr>
<td>Mistic PID Loop Communication Enabled¹, 4</td>
<td>IsMisticPidLoopCommEnabled(PID Loop)</td>
<td>p</td>
</tr>
<tr>
<td>PID Loop Communication Enabled?</td>
<td>IsPidLoopCommEnabled(PID Loop)</td>
<td>f</td>
</tr>
</tbody>
</table>

### String

<table>
<thead>
<tr>
<th>PAC Control Command</th>
<th>OptoScript Equivalent (Arguments)</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Append Character to String</td>
<td>s1 = s1 + &quot;a&quot;;</td>
<td>p</td>
</tr>
<tr>
<td>Append String to String</td>
<td>s1 = s1 + s2;</td>
<td>p</td>
</tr>
<tr>
<td>Compare Strings</td>
<td>CompareStrings(String 1, String 2)</td>
<td>f</td>
</tr>
<tr>
<td>Convert Float to String</td>
<td>FloatToString(Convert, Length, Decimals, Put Result in)</td>
<td>p</td>
</tr>
<tr>
<td>Convert Hex String to Number</td>
<td>HexStringToNumber(Convert)</td>
<td>f</td>
</tr>
<tr>
<td>Convert IEEE Hex String to Number</td>
<td>IEEEHexStringToNumber(Convert)</td>
<td>f</td>
</tr>
<tr>
<td>Convert Integer 32 to IP Address String</td>
<td>Int32ToIpAddressString(Convert, Put Result In)</td>
<td>f</td>
</tr>
<tr>
<td>Convert IP Address String to Integer 32</td>
<td>IpAddressStringToInt32(Convert)</td>
<td>f</td>
</tr>
<tr>
<td>Convert Mistic I/O Hex String to Float¹, 4</td>
<td>MisticIoHexToFloat(Convert)</td>
<td>f</td>
</tr>
<tr>
<td>Convert Number to Formatted Hex String</td>
<td>NumberToFormattedHexString(Convert, Length, Put Result in)</td>
<td>p</td>
</tr>
<tr>
<td>Convert Number to Hex String</td>
<td>NumberToHexString(Convert, Put Result in)</td>
<td>p</td>
</tr>
<tr>
<td>Convert Number to Mistic I/O Hex String¹, 4</td>
<td>NumberToMisticIoHex(Convert, Put Result in)</td>
<td>p</td>
</tr>
<tr>
<td>Convert Number to String</td>
<td>NumberToString(Convert, Put Result in)</td>
<td>p</td>
</tr>
<tr>
<td>Convert Number to String Field</td>
<td>NumberToStringField(Convert, Length, Put Result in)</td>
<td>p</td>
</tr>
<tr>
<td>Convert String to Float</td>
<td>StringToFloat(Convert)</td>
<td>f</td>
</tr>
<tr>
<td>Convert String to Integer 32</td>
<td>StringToInt32(Convert)</td>
<td>f</td>
</tr>
</tbody>
</table>
### Time/Date

<table>
<thead>
<tr>
<th>PAC Control Command</th>
<th>OptoScript Equivalent (Arguments)</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy Date to String (DD/MM/YYYY)</td>
<td>DateToStringDDMMYYYY(String)</td>
<td>p</td>
</tr>
<tr>
<td>Copy Date to String (MM/DD/YYYY)</td>
<td>DateToStringMMDDYYYY(String)</td>
<td>p</td>
</tr>
<tr>
<td>Copy Time to String</td>
<td>TimeToString(String)</td>
<td>p</td>
</tr>
</tbody>
</table>
### Timing

<table>
<thead>
<tr>
<th>PAC Control Command</th>
<th>OptoScript Equivalent (Arguments)</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Continue Timer</td>
<td>ContinueTimer(Timer)</td>
<td>p</td>
</tr>
<tr>
<td>Delay (mSec)</td>
<td>DelayMsec(Milliseconds)</td>
<td>p</td>
</tr>
<tr>
<td>Delay (Sec)</td>
<td>DelaySec(Seconds)</td>
<td>p</td>
</tr>
<tr>
<td>Down Timer Expired?</td>
<td>HasDownTimerExpired(Down Timer)</td>
<td>f</td>
</tr>
<tr>
<td>Get &amp; Restart Timer</td>
<td>GetRestartTimer(Timer)</td>
<td>f</td>
</tr>
<tr>
<td>Pause Timer</td>
<td>PauseTimer(Timer)</td>
<td>p</td>
</tr>
<tr>
<td>Set Down Timer Preset Value</td>
<td>SetDownTimerPreset(Target Value, Down Timer)</td>
<td>p</td>
</tr>
<tr>
<td>Set Up Timer Target Value</td>
<td>SetUpTimerTarget(Target Value, Up Timer)</td>
<td>p</td>
</tr>
<tr>
<td>Start Timer</td>
<td>StartTimer(Timer)</td>
<td>p</td>
</tr>
<tr>
<td>Stop Timer</td>
<td>StopTimer(Timer)</td>
<td>p</td>
</tr>
<tr>
<td>Timer Expired?</td>
<td>HasTimerExpired(Timer)</td>
<td>f</td>
</tr>
<tr>
<td>Up Timer Target Time Reached?</td>
<td>HasUpTimerReachedTargetTime(Up Timer)</td>
<td>f</td>
</tr>
</tbody>
</table>
SYMBOLS

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Usage</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>-</td>
<td>(-x)</td>
<td>“Chapter Complement” on page 456</td>
</tr>
<tr>
<td>x - y</td>
<td></td>
<td>“Chapter Subtract” on page 479</td>
</tr>
<tr>
<td>% % y</td>
<td></td>
<td>“Chapter Modulo” on page 468</td>
</tr>
<tr>
<td>+</td>
<td>(x + y)</td>
<td>“Chapter Add” on page 448</td>
</tr>
<tr>
<td>*</td>
<td>(x * y)</td>
<td>“Chapter Multiply” on page 469</td>
</tr>
<tr>
<td>/</td>
<td>(x / y)</td>
<td>“Chapter Divide” on page 460</td>
</tr>
<tr>
<td>+=</td>
<td>(s1 += \text{&quot;a&quot;})</td>
<td>“Chapter Append Character to String” on page 597</td>
</tr>
<tr>
<td>s1 += s2;</td>
<td></td>
<td>“Chapter Append String to String” on page 599</td>
</tr>
<tr>
<td>&lt;</td>
<td>(x &lt; \text{nt}[0])</td>
<td>“Chapter Less Than Numeric Table Element?” on page 401</td>
</tr>
<tr>
<td>&lt;=</td>
<td>(x &lt;= \text{nt}[0])</td>
<td>“Chapter Less Than or Equal to Numeric Table Element?” on page 403</td>
</tr>
<tr>
<td>&lt;&gt;</td>
<td>(n &lt;&gt; \text{nt}[0])</td>
<td>“Chapter Not Equal to Numeric Table Element?” on page 413</td>
</tr>
<tr>
<td>=</td>
<td>(nt[0] = x)</td>
<td>“Chapter Move to Numeric Table Element” on page 503</td>
</tr>
<tr>
<td>n1[0] = nt2[5];</td>
<td></td>
<td>“Chapter Move Numeric Table Element to Numeric Table” on page 501</td>
</tr>
<tr>
<td>&gt;=</td>
<td>(n &gt;= \text{nt}[0])</td>
<td>“Chapter Equal to Numeric Table Element?” on page 384</td>
</tr>
<tr>
<td>pn = &amp;(n);</td>
<td></td>
<td>“Chapter Move to Pointer” on page 553</td>
</tr>
<tr>
<td>pn = pt[0];</td>
<td></td>
<td>“Chapter Move from Pointer Table Element” on page 552</td>
</tr>
<tr>
<td>pn = null;</td>
<td></td>
<td>“Chapter Clear Pointer” on page 549</td>
</tr>
<tr>
<td>pt[0] = &amp;(n);</td>
<td></td>
<td>“Chapter Move to Pointer Table Element” on page 556</td>
</tr>
<tr>
<td>pt[0] = null;</td>
<td></td>
<td>“Chapter Clear Pointer Table Element” on page 550</td>
</tr>
<tr>
<td>s = st[0];</td>
<td></td>
<td>“Chapter Move from String Table Element” on page 634</td>
</tr>
<tr>
<td>s1 = s2;</td>
<td></td>
<td>“Chapter Move String” on page 636</td>
</tr>
<tr>
<td>s[0] = s;</td>
<td></td>
<td>“Chapter Move to String Table Element” on page 637</td>
</tr>
<tr>
<td>x = nt[0];</td>
<td></td>
<td>“Chapter Move from Numeric Table Element” on page 500</td>
</tr>
<tr>
<td>x = y;</td>
<td></td>
<td>“Chapter Move” on page 498</td>
</tr>
<tr>
<td>==</td>
<td>(n == \text{nt}[0])</td>
<td>“Chapter Equal to Numeric Table Element?” on page 384</td>
</tr>
<tr>
<td>pn = null</td>
<td></td>
<td>“Chapter Pointer Equal to Null?” on page 559</td>
</tr>
<tr>
<td>pt[0] = null</td>
<td></td>
<td>“Chapter Pointer Table Element Equal to Null?” on page 560</td>
</tr>
<tr>
<td>s == st[0];</td>
<td></td>
<td>“Chapter String Equal to String Table Element?” on page 648</td>
</tr>
<tr>
<td>s1 == s2</td>
<td></td>
<td>“Chapter String Equal?” on page 650</td>
</tr>
<tr>
<td>x == y</td>
<td></td>
<td>“Chapter Equal?” on page 386</td>
</tr>
<tr>
<td>&gt;</td>
<td>(x &gt; \text{nt}[0])</td>
<td>“Chapter Greater Than Numeric Table Element?” on page 392</td>
</tr>
<tr>
<td>x &gt; y</td>
<td></td>
<td>“Chapter Greater?” on page 398</td>
</tr>
<tr>
<td>Symbol</td>
<td>Usage</td>
<td>See</td>
</tr>
<tr>
<td>--------</td>
<td>-------</td>
<td>-----</td>
</tr>
<tr>
<td>&gt;=</td>
<td>x &gt;= t[0]</td>
<td>“Chapter Greater Than or Equal To Numeric Table Element?” on page 394</td>
</tr>
<tr>
<td></td>
<td>x &gt;= y</td>
<td>“Chapter Greater Than or Equal?” on page 396</td>
</tr>
</tbody>
</table>
2: Analog Point Commands

Calculate & Set Analog Gain

Analog Point Action

Function: To improve the accuracy of an analog input signal.

Typical Uses: To improve calibration on an input.

Details:
- For all SNAP PAC and Ethernet brains, reads the current value of a specified analog input and interprets it as the point’s maximum nominal value.
- Calculates a gain based on the current value that will cause this value to read the point’s maximum nominal value.
- Stores the calculated gain in Put Result in (Argument 1) for subsequent use by Set Analog Gain, if desired.
- Use a calibrator to input the signal corresponding to the point’s maximum nominal value.
- The calculated gain will be used until power is removed from the I/O unit, or it will always be used if it is stored in flash memory at the I/O unit (recommended).
- The default gain value is 1.0.
- The valid range for gain is any floating point number.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>On Point</td>
<td>Put Result in</td>
</tr>
<tr>
<td>Analog Input</td>
<td>Float Variable</td>
</tr>
<tr>
<td></td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

Action Block Example:

<table>
<thead>
<tr>
<th>Calculate &amp; Set Analog Gain</th>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>On Point</td>
<td>Analog Input</td>
<td></td>
<td>Boiler_Temperature</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Float Variable</td>
<td></td>
<td>Gain_Coefficient</td>
</tr>
</tbody>
</table>

OptoScript Example:

```
CalcSetAnalogGain(On_Point)
Gain_Coefficient = CalcSetAnalogGain(Boiler_Temperature);
```

This is a function command; it returns the calculated gain. The returned value can be consumed by a variable (as in the example shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

Notes:
- Ethernet brains only: Instead of using this command, we recommend that you calibrate inputs using PAC Manager. For instructions, see the PAC Manager User’s Guide (form 1704).
• For more information on offset and gain, see the Using Offset and Gain technical note (form 1359).

**Dependencies:**

• Always use Calculate & Set Analog Offset before using this command.
• Always set the analog input to the point’s maximum nominal value before using this command.

**See Also:**

“Calculate & Set Analog Offset” on page 25
“Set Analog Gain” on page 43
“Set Analog Offset” on page 47
Calculate & Set Analog Offset

Analog Point Action

Function: To improve accuracy of an analog input signal.

Typical Uses: To improve calibration on an input.

Details:

- For all SNAP PAC and Ethernet brains, use a calibrator to input the signal corresponding to zero engineering units on the analog input point.
- Stores the calculated offset in *Put Result in* (Argument 1) for subsequent use by *Set Analog Offset*.
- The calculated offset will be used until power is removed from the I/O unit, or it will always be used if it is stored in flash memory at the I/O unit (recommended).

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>On Point</td>
<td>Put Result in</td>
</tr>
<tr>
<td>Analog Input</td>
<td>Float Variable</td>
</tr>
<tr>
<td></td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

Action Block Example:

<table>
<thead>
<tr>
<th>Calculate &amp; Set Analog Offset</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argument Name</td>
</tr>
<tr>
<td>On Point</td>
</tr>
<tr>
<td>Put Result in</td>
</tr>
</tbody>
</table>

OptoScript Example:

```
OFFSET = CalcSetAnalogOffset(On Point, Boiler_Temperature);
```

This is a function command; it returns the calculated offset. The returned value can be consumed by a variable (as in the example shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the *PAC Control User's Guide* (form 1700).

Notes:

- Instead of using this command, we recommend that you calibrate inputs on Ethernet brains using PAC Manager. For instructions, see the *PAC Manager User's Guide* (form 1704).
- This command is intended to be used in conjunction with *Calculate & Set Analog Gain*.
  When using this command, first calculate and set the offset, and then calculate and set the gain. The offset must be calculated at the signal corresponding to zero engineering units (EU), and the gain must be calculated at the signal corresponding to the point's maximum input range value—or, for inverted scaling (also called “negative scaling”), the point's minimum input range value. (In inverted scaling, the lower scaled value is greater than the upper scaled value).
- For more information on offset and gain, see the *Using Offset and Gain* technical note (form 1359).

See Also:

- “Calculate & Set Analog Gain” on page 23
- “Set Analog Gain” on page 43
- “Set Analog Offset” on page 47

or used in an item such as a Condition block, an OptoScript block, or a mathematical expression...
Get & Clear Analog Maximum Value

Analog Point Action

Function: To retrieve the peak value of a specified analog input since its last reading, then reset it to the current value.

Typical Use: To capture the peak value over a given period of time.

Details:
- The current value for each point is regularly read and stored at the I/O unit. Check the specifications for the module and I/O unit to be used if high-speed readings are required.
- Min and max values are recorded at the I/O unit immediately after the current value is updated.
- The value returned will be the highest value recorded on this point since the last time the maximum value was cleared, or since the unit was turned on.
- Points without a module installed or with a thermocouple module that has an open thermocouple will return a value of -32,768 to indicate an error.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>From</td>
<td>Put in</td>
</tr>
<tr>
<td>Analog Input</td>
<td>Float Variable, Integer 32 Variable</td>
</tr>
</tbody>
</table>

Action Block Example:

<table>
<thead>
<tr>
<th>Get &amp; Clear Analog Maximum Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argument Name</td>
</tr>
<tr>
<td>----------------</td>
</tr>
<tr>
<td>From</td>
</tr>
<tr>
<td>Put in</td>
</tr>
</tbody>
</table>

OptoScript Example:

GetClearAnalogMaxValue(From)

MAX_KPA = GetClearAnalogMaxValue(Pres_Sensor);

This is a function command; it returns the maximum value of the input since its last reading. The returned value can be consumed by a variable (as shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

Notes: Use this command to clear the analog max value before actual readings commence.

See Also:
- “Get & Clear Analog Minimum Value” on page 27
- “Get Analog Minimum Value” on page 30
Get & Clear Analog Minimum Value

Analogue Point Action

Function: To retrieve the lowest value of a specified analog input since its last reading, then reset it to the current value.

Typical Use: To capture the lowest value over a given period of time.

Details:
- The current value for each point is regularly read and stored at the I/O unit. Check the specifications for the module and I/O unit to be used if high-speed readings are required.
- Min and max values are recorded at the I/O unit immediately after the current value is updated.

Arguments:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>From</td>
<td>Analog Input</td>
<td>PRES_SENSOR</td>
</tr>
<tr>
<td>Put in</td>
<td>Float Variable</td>
<td>MIN_KPA</td>
</tr>
</tbody>
</table>

OptoScript Example:

MIN_KPA = GetClearAnalogMinValue(PRES_SENSOR);

This is a function command; it returns the minimum value of the input since its last reading. The returned value can be consumed by a variable (as shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

Notes: Use this command to clear the analog min value before actual readings commence.

Result Data:
- The value returned will be the lowest value recorded since the last time the minimum value was reset or since the unit was turned on.
- Points without a module installed or with a thermocouple module that has an open thermocouple will return a value of -32,768 to indicate an error.

See Also: “Get & Clear Analog Maximum Value” on page 26  
“Get Analog Maximum Value” on page 29
CHAPTER 2: ANALOG POINT COMMANDS

Get & Clear Analog Totalizer Value

Analog Point Action

Function: To read and clear the totalized (integrated) value of a specified analog input.

Typical Use: To capture a flow total that has been accumulating at the I/O unit before it reaches its maximum value.

Details:
- Totalizing is performed at the I/O unit by sampling the input point and storing the total value locally on the I/O unit. This command reads the current total, and then clears it to zero.
- The sample rate is set using the Set Analog Totalizer Rate command.
- Totalizing will be bidirectional if the input range is bidirectional, such as -10 to +10.
- Totalizing will stop when the total reaches either limit.
- Totalizing will resume after using Get & Clear Analog Totalizer Value.
- Totalizing will stop if the input goes under range.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>From</td>
<td>Put in</td>
</tr>
<tr>
<td>Analog Input</td>
<td>Float Variable</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>From</td>
<td>Analog Input</td>
<td>Flow_Rate</td>
</tr>
<tr>
<td>Put in</td>
<td>Float Variable</td>
<td>Total_Barrels</td>
</tr>
</tbody>
</table>

Action Block Example:

```
Get & Clear Analog Totalizer Value
```

OptoScript Example:

```
GetClearAnalogTotalizerValue(From)

Total_Barrels = GetClearAnalogTotalizerValue(Flow_Rate);
```

Notes:
- Before using this command, use Set Analog Totalizer Rate once to:
  - (for groov EPIC processors) set the sampling rate.
  - (for all other supported controllers and brains) set the sampling rate and start the totalizer.
  
  Use this command to clear the total before actual readings start.
- See notes for Set Analog Totalizer Rate before using this command.
- Do not use this command frequently when the total is a small value. Doing so may degrade the cumulative accuracy.


See Also: “Get Analog Totalizer Value” on page 31
“Set Analog Totalizer Rate” on page 48

or used in an item such as a Condition block, an OptoScript block, or a mathematical expression
Get Analog Maximum Value

Analog Point Action

**Function:**
To retrieve the peak value of a specified analog input since its last reading.

**Typical Use:**
To capture the peak pressure over a given period of time.

**Details:**
- The current value for each point is regularly read and stored at the I/O unit. Check the specifications for the module and I/O unit to be used if high-speed readings are required.
- Min and max values are recorded at the I/O unit immediately after the current value is updated.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>From</td>
<td>Analog Input</td>
<td>PRES_SENSOR</td>
</tr>
<tr>
<td>Put in</td>
<td>Float Variable</td>
<td>MAX_KPA</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```opto
MAX_KPA = GetAnalogMaxValue(PRES_SENSOR);
```

This is a function command; it returns the maximum value of the analog input. The returned value can be consumed by a variable (as shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the [PAC Control User's Guide](form 1700).

**Notes:**
- Use Get & Clear Analog Maximum Value to clear the max value before actual readings commence.
- The value returned will be the highest value recorded on this point since the last time the maximum value was cleared, or since the unit was turned on.
- Points without a module installed or with a thermocouple module that has an open thermocouple will return a value of -32,768 to indicate an error.

**See Also:**
- “Get & Clear Analog Maximum Value” on page 26
- “Get & Clear Analog Minimum Value” on page 27
- “Get Analog Minimum Value” on page 30
CHAPTER 2: ANALOG POINT COMMANDS

Get Analog Minimum Value

Analog Point Action

Function: To retrieve the lowest value of a specified analog input since its last reading.

Typical Use: To capture the lowest pressure over a given period of time.

Details:
- The current value for each point is regularly read and stored at the I/O unit. Check the specifications for the module and I/O unit to be used if high-speed readings are required.
- Min and max values are recorded at the I/O unit immediately after the current value is updated.

Arguments:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>From</td>
<td>Analog Input</td>
<td>PRES_SENSOR</td>
</tr>
<tr>
<td>Put in</td>
<td>Float Variable</td>
<td>MIN_KPA</td>
</tr>
<tr>
<td></td>
<td>Integer 32 Variable</td>
<td></td>
</tr>
</tbody>
</table>

Action Block Example:

```
Get Analog Minimum Value
```

OptoScript Example:

```
MIN_KPA = GetAnalogMinValue(PRES_SENSOR);
```

This is a function command; it returns the minimum value of the analog input. The returned value can be consumed by a variable (as shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User's Guide (form 1700).

Notes:
- Use Get & Clear Analog Minimum Value to clear the min value before actual readings commence.
- The value returned will be the lowest value recorded since the last time the minimum value was reset or since the unit was turned on.
- Points without a module installed or with a thermocouple module that has an open thermocouple will return a value of -32,768 to indicate an error.

See Also:
- "Get & Clear Analog Maximum Value" on page 26
- "Get & Clear Analog Minimum Value" on page 27
- "Get Analog Maximum Value" on page 29
Get Analog Totalizer Value

Analog Point Action

Function: To read the totalized (integrated) value of a specified analog input.

Typical Use: To examine a flow total that has been accumulating at the I/O unit to determine when to clear it.

Details:
- Totalizing is performed at the I/O unit by sampling the input point and storing the total value locally on
the I/O unit.
- The sample rate is set using the Set Analog Totalizer Rate command.
- Totalizing will be bidirectional if the input range is -10 to +10, for example.
- Totalizing will stop when the total reaches either limit. Totalizing will resume after using Get & Clear
Analog Totalizer Value.
- Totalizing will stop if the input goes under range.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>From</td>
<td>Put in</td>
</tr>
<tr>
<td>Analog Input</td>
<td>Float Variable</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>From</td>
<td>Analog Input</td>
<td>Flow_Rate</td>
</tr>
<tr>
<td>Put in</td>
<td>Float Variable</td>
<td>Total_Barrels</td>
</tr>
</tbody>
</table>

OptoScript Example:

```
Total_Barrels = GetAnalogTotalizerValue(Flow_Rate);
```

This is a function command; it returns the totalized value of the analog input. The returned value can be consumed by a variable (as shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User's Guide (form 1700).

Notes:
- See notes for Set Analog Totalizer Rate before using this command.
- Use Get & Clear Analog Totalizer Value to clear the total before actual readings begin.

Dependencies:
- Available on groov EPIC processors, SNAP PAC R-series controllers, and on SNAP PAC EB- and SB-series brains with firmware 8.2 or later.
- Before using this command, Set Analog Totalizer Rate must be executed.

See Also:
- “Get & Clear Analog Totalizer Value” on page 28
- “Set Analog Totalizer Rate” on page 48
Get HART Unique Address

Analog Point Action

**Function:**
Retrieves the unique address of a HART device.

**Typical Use:**
To get a unique address of a HART device in order to use other HART commands to talk to the device.

**Details:**
This command allows you to supply the polling address, and in return to get back the unique address you need for other HART commands.

The arguments are:
- **Point**: Indicate an input or output point on a HART module.
- **Polling Address**: HART polling address, a value of 0 to 63.
- **Unique Address**: Destination for the unique address retrieved by this command based on the polling address. For example: 11c87c8bcf
- **Timeout (Seconds)**: Timeout in seconds.
- **Put Result in**: Indicates success or failure of the operation.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
<th>Argument 3</th>
<th>Argument 4</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Point</strong></td>
<td>Analog Input</td>
<td>Analog Output</td>
<td><strong>Polling Address</strong></td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td><strong>Unique Address</strong></td>
<td><strong>Timeout (Seconds)</strong></td>
<td><strong>Put Result in</strong></td>
<td>Float Literal</td>
<td>Float Variable</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```plaintext
GetHARTUniqueAddress(Point, Polling Address, Unique Address, Timeout (Seconds))
Result = GetHARTUniqueAddress(HART_0, PollAddress, UniqueAdd, Timeout);
```

This is a function command; it returns a zero (indicating success) or an error (indicating failure). The returned value can be consumed by a variable (as shown in the example) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the *PAC Control User’s Guide* (form 1700).

**Note:**
This command and the other HART-specific PAC Control commands work with HART SNAP I/O modules in a SNAP PAC system with a SNAP PAC programmable automation controller and PAC Control automation software. These HART-specific PAC Control commands make it possible for these modules to communicate any HART command that adheres to the HART request-response model or the burst message model.

In your PAC Control strategy you will need to assemble all request data sent to the module and to parse all response data returned by the module. In this way the modules can communicate with any wired HART device using any HART command.

**Status Codes:**

<table>
<thead>
<tr>
<th>Status Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Success</td>
</tr>
</tbody>
</table>
-2 = Data verification field mismatch.
-3 = Invalid length.
-8 = Invalid data.
-20 = Resource busy. This error is returned if no response is available within the supplied timeout period.
-43 = NACK received.
-93 = I/O unit not enabled. Previous communication failure may have disabled communication to the unit automatically. Reenable communication to the unit and try again.
-107 = I/O unit not enabled. No attempt to read or write was made. Reenable the I/O unit and try again.
-443 = Could not receive on socket.
-444 = Error on socket send.
-8612 = Old response to new command.
-13013 = Operation failed.

See Also:
“Receive HART Response” on page 38
“Send/Receive HART Command” on page 40
“Send/Receive HART Command” on page 40
“Pack Float into String” on page 639
“Pack Integer 32 into String” on page 641
“Pack Integer 64 into String” on page 643
“Pack String into String” on page 645
“Unpack String” on page 654
**Ramp Analog Output**

**Analog Point Action**

**Function:**
To change an analog output value to a new value at a constant rate.

**Typical Use:**
To raise or lower oven temperature from point A to point B at a specified rate.

**Details:**
- When the I/O unit receives this command, it will assume control of the analog output channel.
- This command applies to PAC brains, *mistic* I/O units, and some legacy Ethernet brains. For a detailed comparison of features supported by Ethernet-based SNAP I/O brains and on-the-rack controllers, see Legacy and Current SNAP Product Comparison and Compatibility Charts (form 1693).
- For SNAP I/O units, this command works only on the first four channels (channels 0-3) of a module.
- Ramping starts from the current output value and proceeds toward the specified endpoint value.
- The ramp rate is specified in engineering units per second. This rate should be a positive number. A rate of zero or less will cause error -42 (Invalid limit) to appear in the message queue.
- Updates to the current output value will be made at 50-millisecond intervals.
- If this command is executed while the output is ramping, the ramp rate will be changed. If this command is executed too frequently, the output will not get a chance to ramp at all.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ramp Endpoint</td>
<td>Units/Sec</td>
<td>Point to Ramp</td>
</tr>
<tr>
<td>Float Literal</td>
<td>Float Literal</td>
<td>Analog Output</td>
</tr>
<tr>
<td>Float Variable</td>
<td>Float Variable</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
<td></td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```
RampAnalogOutput(Ramp Endpoint, Units/Sec, Point to Ramp)
```

```
RampAnalogOutput(SOAK_TEMP, RAMP_RATE, TEMP_CONTROL);
```

This is a procedure command; it does not return a value.

**Notes:**
- To stop the ramp on a *mistic* I/O unit at any time, use Move (or an assignment in OptoScript code) to send the desired “static” value to the analog output channel. To achieve the same result on any type of brain, send a new Ramp Analog Output command with the desired “static” value as the endpoint and a very fast rate.
- Use this command only to change or start the ramp.
- Be sure the analog output value is at the desired starting point before using this command.
- If the output value must be changed, wait at least 50 milliseconds before using this command.

**Dependencies**
Available on:
- GRV-EPIC-PR1 processors
- GRV-R7-MM1001-10 I/O units
- SNAP-PAC-R2, -R1, and -R1-B controllers
- SNAP-PAC-SB2, -SB1, -EB2, and -EB1 brains with firmware 8.1 or later
Queue Errors: 
-34 = Invalid I/O command. (The selected channel is out of range.)
-42 = Invalid limit. (The ramp rate was less than or equal to zero.)
CHAPTER 2: ANALOG POINT COMMANDS

Receive HART Burst Response

Analog Point Action

**Function:** Receives a response from a HART command burst—a special mode where periodic data is sent asynchronously from a sensor.

**Typical Use:** To receive responses from a HART command burst in which a sensor sends asynchronous data in response to a trigger, such as a set time period or a particular value.

**Details:**

- **Point:** A point on a HART module.
- **Unique Address:** HART device address (e.g., 11c87c8bcf).
- **Response:** Destination for HART response.
- **Timeout (Seconds):** Timeout, in seconds.
- **Put Result in:** Indicates success or failure of the operation.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
<th>Argument 3</th>
<th>Argument 4</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Point</strong></td>
<td><strong>Unique Address</strong></td>
<td><strong>Response</strong></td>
<td><strong>Timeout (Seconds)</strong></td>
<td><strong>Put Result in</strong></td>
</tr>
<tr>
<td>Analog Input</td>
<td>String Literal</td>
<td>String Variable</td>
<td>Float Literal</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Analog Output</td>
<td></td>
<td></td>
<td>Float Variable</td>
<td></td>
</tr>
</tbody>
</table>

**Action Block Example:**

```
ReceiveHARTBurstResponse(Point, Unique Address, Response, Timeout (Seconds))
```

**OptoScript Example:**

```
Result = ReceiveHARTBurstResponse(HART_0, sUniqueAddr, sRcv, fTimeout);
```

**Notes:**

- The Receive HART Burst Response command receives only burst responses and keeps them separate from standard command responses. The last burst response is buffered until requested by the user; if a new burst response arrives before the buffered response is retrieved, the old response is overwritten by the new one.
- This command and the other HART-specific PAC Control commands work with HART SNAP I/O modules in a SNAP PAC system with a SNAP PAC programmable automation controller and PAC Control automation software. These HART-specific PAC Control commands make it possible for these modules to communicate any HART command that adheres to the HART request-response model or the burst message model.
In your PAC Control strategy you will need to assemble all request data sent to the module and to parse all response data returned by the module. In this way the modules can communicate with any wired HART device using any HART command.

**Status Codes:**

- 0 = Success.
- -2 = Data verification field mismatch.
- -20 = Resource busy. This error is returned if no response is available within the supplied timeout period.
- -23 = String too short.
- -34 = Invalid I/O command.
- -40 = Not enough data returned.
- -43 = NACK received.
- -443 = Could not receive on socket.
- -13013 = Operation failed.

**See Also:**

- “Get HART Unique Address” on page 32
- “Receive HART Response” on page 38
- “Send/Receive HART Command” on page 40
- “Pack Float into String” on page 639
- “Pack Integer 32 into String” on page 641
- “Pack Integer 64 into String” on page 643
- “Pack String into String” on page 645
- “Unpack String” on page 654
### Receive HART Response

#### Analog Point Action

**Function:** Receives the response to a command that was sent previously.

**Typical Use:** If you use **Send/Receive HART Command** and get a -443 (could not receive on socket), you can try again with this instruction. If a response from a previous command is available, this instruction will receive it.

This command might be used in the case where you send a series of commands to multiple HART devices without waiting for a response, then go back to pick up those responses. Because HART is relatively slow, using this method would be much faster than sending a command to one device, waiting for its response, sending a command to another device and waiting for its response, and so on.

**Details:**

- **Point:** A point on a HART module.
- **Unique Address:** HART device address (ex: 11c87c8bcf).
- **Response:** Destination for HART response.
- **Timeout (Seconds):** Timeout, in seconds.
- **Put Result in:** Indicates success or failure of the operation.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Point</td>
<td>Analog Input</td>
<td>HART_0</td>
</tr>
<tr>
<td>Unique Address</td>
<td>String Variable</td>
<td>sUniqueAddr</td>
</tr>
<tr>
<td>Response</td>
<td>String Variable</td>
<td>sRcv</td>
</tr>
<tr>
<td>Timeout (Seconds)</td>
<td>Float Variable</td>
<td>fTimeout</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Integer 32 Variable</td>
<td>Result</td>
</tr>
</tbody>
</table>

**Action Block Example:**

```opto
ReceiveHARTResponse(Point, Unique Address, Response, Timeout (Seconds))
```

This is a function command; it returns a zero (indicating success) or an error (indicating failure). The returned value can be consumed by a variable (as shown in the example) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the **PAC Control User’s Guide** (form 1700).

**Note:** This command and the other HART-specific PAC Control commands work with HART SNAP I/O modules in a SNAP PAC system with a SNAP PAC programmable automation controller and PAC Control automation software. These HART-specific PAC Control commands make it possible for these modules to communicate any HART command that adheres to the HART request-response model or the burst message model.

In your PAC Control strategy you will need to assemble all request data sent to the module and to parse all response data returned by the module. In this way the modules can communicate with any wired HART device using any HART command.
Status Codes:

0 = success

-3 = Invalid length.

-8 = Invalid data.

-20 = Resource busy. This error is returned if no response is available within the supplied timeout period.

-23 = String too short.

-34 = Invalid I/O command.

-40 = Not enough data returned.

-43 = NACK received.

-107 = I/O unit not enabled. No attempt to read or write was made. Reenable the I/O unit and try again.

-443 = Could not receive on socket.

-444 = Error on socket send.

-13013 = Fail.

See Also:

“Get HART Unique Address” on page 32
“Send/Receive HART Command” on page 40
“Send/Receive HART Command” on page 40
“Pack Float into String” on page 639
“Pack Integer 32 into String” on page 641
“Pack Integer 64 into String” on page 643
“Pack String into String” on page 645
“Unpack String” on page 654
Send/Receive HART Command

**Function:** Sends a HART command and receives its response in a single operation.

**Typical Use:** To send a HART command and receive a response in a single operation.

**Details:** The arguments are:

- **Point**: A point on a HART module.
- **Unique Address**: Enter the unique HART device address, for example, 11c87c8bcf. You can use the Get HART Unique Address command to obtain the address.
- **Command**: The HART command number.
- **Parameters**: Parameters needed by the command (created using the string packing commands). Note that HART uses Big-Endian order.
- **Response**: Destination for HART response.
- **Timeout (Seconds)**: Timeout, in seconds.
  - Setting the timeout to zero results in non-blocking behavior. If the response isn’t immediately ready, the command returns with a “resource busy” error (-20). You might want to do this if you’re sending commands to a series of devices and don’t want to wait for each response to complete. A much faster method is to do the sends, and then pick up the responses when you’ve finished.
  - Depending on the value you use, you may or may not get a response within your timeout period. If a response isn’t available before you time out, you’ll get a socket receive error (-443).
- **Put Result in**: Indicates success or failure of the operation.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
<th>Argument 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Point</td>
<td>Unique Address</td>
<td>Command</td>
<td>Parameters</td>
</tr>
<tr>
<td>Analog Input</td>
<td>String Literal</td>
<td>Integer 32 Variable</td>
<td>String Literal</td>
</tr>
<tr>
<td>Analog Output</td>
<td>String Variable</td>
<td>Integer 32 Variable</td>
<td>String Variable</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Argument 4</th>
<th>Argument 5</th>
<th>Argument 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Response</td>
<td>Timeout (Seconds)</td>
<td>Put Result in</td>
</tr>
<tr>
<td>String Variable</td>
<td>Float Literal</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Float Variable</td>
<td>Integer 32 Literal</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

**Action Block Example:**

```plaintext
Send/Receive HART Command
```

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Point</td>
<td>Analog Input</td>
<td>HART_0</td>
</tr>
<tr>
<td>Unique Address</td>
<td>String Variable</td>
<td>UniqueAdd</td>
</tr>
<tr>
<td>Command</td>
<td>Integer 32 Variable</td>
<td>0</td>
</tr>
<tr>
<td>Parameters</td>
<td>String Variable</td>
<td>sParam</td>
</tr>
<tr>
<td>Response</td>
<td>String Variable</td>
<td>sRcv</td>
</tr>
<tr>
<td>Timeout (Seconds)</td>
<td>Float Variable</td>
<td>fTimeout</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Integer 32 Variable</td>
<td>Result</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```plaintext
SendReceiveHARTCommand (Point, Unique Address, Command, Parameters, Response, Timeout (Seconds))
Result = SendReceiveHARTCommand(HART_0, UniqueAdd, 0, sParam, sRcv, fTimeout);
```
This is a function command; it returns a zero (indicating success) or an error (indicating failure). The returned value can be consumed by a variable (as shown in the example) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

Note: HART® SNAP I/O modules for analog current input and output provide communication with other Highway Addressable Remote Transducer (HART) current loop devices. These modules allow you to use any HART command that adheres to the HART request-response model or the burst message model. All request data sent to the module must be put together by the user, and all response data returned by the module must be parsed by the user. This allows the HART SNAP I/O modules to communicate to any wired HART device with any command, provided that the user can construct and parse the data of that command.

Status Codes:

0 = Success.
-3 = Invalid length.
-8 = Invalid data.
-20 = Resource busy. This error is returned if no response is available within the supplied timeout period.
-23 = String too short.
-34 = Invalid I/O command.
-40 = Not enough data returned.
-43 = NACK received.
-107 = I/O unit not enabled. No attempt to read or write was made. Reenable the I/O unit and try again.
-443 = Could not receive on socket.
-444 = Error on socket send.
-8612 = Old response to new command.
-13013 = Operation failed.

See Also:
“Get HART Unique Address” on page 32
“Receive HART Response” on page 38
“Send/Receive HART Command” on page 40
“Pack Float into String” on page 639
“Pack Integer 32 into String” on page 641
“Pack Integer 64 into String” on page 643
“Pack String into String” on page 645
“Unpack String” on page 654
Set Analog Filter Weight

**Function:** To activate digital filtering and set the amount of filtering to use on an analog input point.

**Typical Use:** To smooth noisy or erratic input signals.

**Details:**
- When issued, this command copies the current input value to the filtered value to initialize it. Thereafter, a percentage of the difference between the current input value and the last filtered value is added to the last filtered value each time the brain’s analog I/O scanner scans the analog point. See the “Analog & High-Density Digital Scanner” on the Status Read window in PAC Manager.
- A zero disables filtering. A larger value increases filtering.
- Filtering is applied to the engineering units value as well as the min and max values.
- The digital filtering algorithm is an implementation of a first-order lag filter: New Filtered Value = ( (Current Reading - Old Filter Value) / Filter Weight) + Old Filter Value.
- To calculate the filter weight value that will result in a particular time constant value, use: Filter Weight = (Time Constant + Scan Interval)/Scan Interval. (Time values are in seconds.)
- To calculate the time constant that a particular filter weight will result in, use: Time Constant = (Scan Interval * Filter Weight) – Scan Interval. (Time values are in seconds.)
  A Time Constant is the amount of time it will take to reach 63.21% of the final value. After an amount of time equal to five time constants, the value will be very close to its final value (99.33% of the final value).
- The filter weight will be used until power is removed from the I/O unit, or it will always be used if it is stored in permanent memory at the I/O unit.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>To</strong></td>
<td><strong>On Point</strong></td>
</tr>
<tr>
<td>Float Literal</td>
<td>Analog Input</td>
</tr>
<tr>
<td>Float Variable</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td></td>
</tr>
</tbody>
</table>

**Action Block Example:**

```
Set Analog Filter Weight
```

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>To</td>
<td>Integer 32 Variable</td>
<td>FILTER_WEIGHT</td>
</tr>
<tr>
<td>On Point</td>
<td>Analog Input</td>
<td>TEMP_IN1</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```
SetAnalogFilterWeight(To, On Point)
SetAnalogFilterWeight(FILTER_WEIGHT, TEMP_IN1);
```

This is a procedure command; it does not return a value.

**Notes:**
- To ensure that digital filtering will always be active, store this and other changeable I/O unit values in permanent memory at the I/O unit. (You can do so through Debug mode.)
Set Analog Gain

Analog Point Action

**Function:** To improve accuracy of an analog input signal or to change its range.

**Typical Uses:** To improve calibration on an input.

**Details:**
- Always use Set Analog Offset before using this command.
- The default value is 1.0.
- For all SNAP PAC and Ethernet brains, a setting of 0.0 will cause the brain to use the default value of 1.0.
- The calculated gain will be used until power is removed from the I/O unit, or it will always be used if the gain is stored in permanent memory at the I/O unit.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>To</strong></td>
<td><strong>On Point</strong></td>
</tr>
<tr>
<td>Float Literal</td>
<td>Analog Input</td>
</tr>
<tr>
<td>Float Variable</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td></td>
</tr>
</tbody>
</table>

**Action Block Example:**

```
Set Analog Gain
```

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>To</td>
<td>Float Variable</td>
<td>GAIN_COEFFICIENT</td>
</tr>
<tr>
<td>On Point</td>
<td>Analog Input</td>
<td>PRESS_IN</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```
SetAnalogGain (To, On Point)
```

This is a procedure command; it does not return a value.

**Notes:**
- To ensure that the gain will always be used, store this and other changeable I/O unit values in flash memory at the I/O unit. (You can do so through Debug mode or in PAC Manager.)
- For more information on offset and gain, see the Using Offset and Gain technical note (form 1359).

**Dependencies:** Must use Set Analog Offset first.

**See Also:**
- “Set Analog Offset” on page 47
- “Calculate & Set Analog Gain” on page 23
Set Analog Load Cell Fast Settle Level

**Analog Point Action**

**Function:**
To set the fast settle level on a SNAP-A1C load cell analog input module.

**Typical Use:**
To get filtered readings faster.

**Details:**
- Use with the filter weight command (see Set Analog Load Cell Filter Weight) to get filtered readings faster.
- The effects of this command are greater when there are large changes in the load cell output (such as when you first put something heavy on a scale), and a large filter weight is used. Filtered readings are returned noticeably faster.
- Values for the fast settle level range from 0 to 32767. A value of 0 turns the fast settle feature off. Setting the filter weight value to 0, 1, or 32767 also turns this feature off.
- Setting the fast settle level too low causes this feature to start too soon, and results in no reduction in the time it takes to get the filtered value.
- The filtered reading is on channel 2 of the SNAP-A1C module.

To see how the fast settle level works:
1. Use the Set Analog Load Cell Filter Weight command to set the filter weight to 255.
2. Use the Set Analog Load Cell Fast Settle Level command to set the fast settle level to 0 (shuts off fast settle feature).
3. Use PAC Display to display SuperTrends of the unfiltered channel 1, and the filtered channel 2.
4. Cause a large change in the load cell output, and observe the difference in the unfiltered and filtered trends. Note the time it takes for the filtered reading to settle.
5. Now set the fast settle level to 1 and make a large change to the load cell output. This causes fast settling to be applied too soon, and the trend for the filtered reading will show erratic spikes.
6. As you increase the fast settle level, the trend will smooth out and return readings faster than when the fast settle level is not applied. By experimenting, you will find the ideal fast settle value to use in your application.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>To</strong></td>
<td><strong>On Point</strong></td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Analog Input</td>
</tr>
</tbody>
</table>

**Action Block Example:**
This example sets the fast settle level of the analog point to 5.

```
Set Analog Load Cell Fast Settle Level

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>To</td>
<td>Integer 32 Literal</td>
<td>5</td>
</tr>
<tr>
<td>On Point</td>
<td>Analog Input</td>
<td>Load_Cell_A</td>
</tr>
</tbody>
</table>
```

**OptoScript Example:**
SetAnalogLoadCellFastSettleLevel(To, On Point)

```
SetAnalogLoadCellFastSettleLevel(5, Load_Cell_A);
```

**Note:**
To ensure that the value will always be correct, store this and other changeable I/O unit values in flash memory at the I/O unit. (You can do so through Debug mode or in PAC Manager.)

**Dependencies:**
This command is valid only when used on a properly configured SNAP-A1C module.
See Also:  “Set Analog Load Cell Filter Weight” on page 46
Set Analog Load Cell Filter Weight

Analog Point Action

Function: To set the filter weight on a SNAP-AILC load cell analog input module.

Typical Use: To smooth load cell input signals that are erratic or change suddenly.

Details: • Initially, this command copies the current input value to the filtered value to initialize it. Thereafter, a percentage of the difference between the current input value and the last filtered value is added each time the module scans the load cell point.
• The filter weight range of values is 0 to 255. A 0 or 1 disables filtering. A larger value increases filtering, and the default filter weight value is 128.
• Use with the fast settle level (see Set Analog Load Cell Fast Settle Level) to get the filtered reading faster.
• The filtered reading is on channel 2 of the SNAP-AILC module.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>To</td>
<td>On Point</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Analog Input</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td></td>
</tr>
</tbody>
</table>

Action Block Example: This example sets the filter weight to 25.

```
Set Analog Load Cell Filter Weight

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>To</td>
<td>Integer 32 Literal</td>
<td>25</td>
</tr>
<tr>
<td>On Point</td>
<td>Analog Input</td>
<td>Load_Cell_A</td>
</tr>
</tbody>
</table>
```

OptoScript Example: SetAnalogLoadCellFilterWeight(To, On Point)

```
SetAnalogLoadCellFilterWeight(25, Load_Cell_A);
```

Notes: • To ensure that the value will always be correct, store this and other changeable I/O unit values in flash memory at the I/O unit. (You can do so through Debug mode or in PAC Manager.)
• The filtered weight is reduced when the difference between the unfiltered value and the filtered value is greater than the fast settle level.

Dependencies: This command is valid only when used on a properly configured SNAP-AILC module.

See Also: “Set Analog Load Cell Fast Settle Level” on page 44
**Set Analog Offset**

*Analog Point Action*

**Function:** To improve the accuracy of an analog input signal or to change its range.

**Typical Uses:** To improve calibration on an input.

**Details:**
- Always use Set Analog Gain after using this command.
- The default offset value is 0.
- For all SNAP PAC and Ethernet brains, the offset value is in engineering units.
- The calculated offset will be used until power is removed from the I/O unit, or it will always be used if the offset is stored in permanent memory at the I/O unit.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>To</td>
<td>On Point</td>
</tr>
<tr>
<td>Float Literal</td>
<td>Analog Input</td>
</tr>
<tr>
<td>Float Variable</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td></td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```
SetAnalogOffset (To, On Point)
SetAnalogOffset (OFFSET, PRESS_IN);
```

This is a procedure command; it does not return a value.

**Notes:**
- To ensure that the offset will always be used, store this and other changeable I/O unit values in flash memory at the I/O unit. (You can do so through Debug mode or in PAC Manager.)
- For more information on offset and gain, see the Using Offset and Gain technical note (form 1359).

**See Also:**
- “Set Analog Gain” on page 43
- “Calculate & Set Analog Offset” on page 25
Set Analog Totalizer Rate
Analog Point Action

**Function:** For groov EPIC processors, to set the sampling rate. For all other supported controllers and brains, to start the totalizer and to set the sampling rate.

**Typical Use:** To accumulate total flow based on a varying flow rate signal.

**Details:**
- For groov EPIC processor, this command only sets the sampling rate. To start sampling, you need to run the Get and Clear Analog Totalizer Value command.
- SNAP PAC brains continuously add fractional samples to the totalized value, rather than one full sample at the end of the period.
- The sampled value is added to the previous accumulated total.
- Valid range for the sampling rate is 0.0 to 3276.7 seconds for mistic I/O units.
- SNAP PAC brains stop totalizing when the totalized input goes out of range or offline, and continue totalizing when the input becomes valid again.
- SNAP PAC brains allow totalize rates as slow as every 4294967.295 seconds (49.7 days), where the sampling rate resolution is typically on the order of milliseconds; it depends on the rate of the Analog & High-Density Digital Scanner. For more information, see the OptoMMP Protocol Guide (form 1465).

To see the scanner rate in PAC Control:
- a. Open the strategy in PAC Control in debug mode.
- b. Double-click the I/O unit, and then click the Information tab.

- Setting the sampling rate to 0.0 seconds will discontinue totalizing, but not clear or change the total.
- Setting the sampling rate to a non-zero value will clear any existing total.
- Totalizing will be bi-directional if the input range is bi-directional, such as -10 to +10.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>To (Seconds)</strong></td>
<td><strong>On Point</strong></td>
</tr>
<tr>
<td>Float Literal</td>
<td>Analog Input</td>
</tr>
<tr>
<td>Float Variable</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td></td>
</tr>
</tbody>
</table>
### Action Block
**Example:**

**Set Analog Totalizer Rate**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>To (Seconds)</td>
<td>Float Variable</td>
<td>TOTALIZE_RATE</td>
</tr>
<tr>
<td>On Point</td>
<td>Analog Input</td>
<td>FUEL_FLOW</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```
SetAnalogTotalizerRate(To (Seconds), On Point)
SetAnalogTotalizerRate(TOTALIZE_RATE, FUEL_FLOW);
```

This is a procedure command; it does not return a value.

**Notes:**
- Use `Get Analog Totalizer Value` to “watch” the total accumulate. Wait for a reasonable value, but watch that the total doesn’t overflow the destination variable.
- The following series of commands reads the accumulated total from the I/O unit, scales it, and then adds the result to a float variable representing the total number of liters. The flow signal is scaled 0–1,000 liters per minute.

#### Get & Clear Analog Totalizer Value

<table>
<thead>
<tr>
<th>From</th>
<th>FLOW_RATE</th>
<th>Analog Input</th>
</tr>
</thead>
<tbody>
<tr>
<td>Put in</td>
<td>TEMP_FLOAT1</td>
<td>Float Variable</td>
</tr>
</tbody>
</table>

#### Divide Temp_Float1

<table>
<thead>
<tr>
<th>By</th>
<th>60.0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Put Result in</td>
<td>TEMP_FLOAT1</td>
</tr>
</tbody>
</table>

**Dependencies:**
Available on groov EPIC processors, SNAP PAC R-series controllers and on SNAP PAC EB- and SB-series brains with firmware 8.2 or later.

**See Also:**
- “Get Analog Totalizer Value” on page 31
- “Get & Clear Analog Totalizer Value” on page 28
Set Analog TPO Period

Function: To set the time proportional output period of an analog point where the analog TPO module is used.

Typical Use: To control the duty cycle of resistive heating elements used for temperature control.

Details:
- Analog points will not function as TPOs until this command is issued.
- For a SNAP-AOD-29 module, TPO periods are multiples of 0.251 seconds, ranging from 0.251 to 64.25 seconds. If the value entered is not an exact multiple of the period resolution, it is rounded to the nearest period value.
- For a SNAP-AOD-29-HFi module, TPO periods are multiples of 20.8 nanoseconds, ranging from 0.00001 sec to 64.25 sec. If the value entered is not an exact multiple of the period resolution, it is rounded to the nearest value.
- The time proportion period specifies the total time the output is varied.
- Use Move to set the percent of on time by moving a value from 0–100 to the analog output point.
- Always use 0–100 for the analog TPO scaling.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>To (Seconds)</td>
<td>On Point</td>
</tr>
</tbody>
</table>

Example:
This example sets the period for the TPO point named TPO OUTPUT to 5.02 seconds (the value 5.0 is rounded automatically to the nearest period value, 5.02). If Move is used to set a 50 percent duty cycle (by Moving 50.0 to TPO OUTPUT), then the analog output will repeatedly cycle on for 2.51 seconds and off for 2.51 seconds.

OptoScript Example:
SetAnalogTpoPeriod(To (Seconds), On Point)
SetAnalogTpoPeriod(5.0, TPO_OUTPUT);

This is a procedure command; it does not return a value.

Notes:
- To ensure that the TPO period will always be correct, store this and other changeable I/O unit values in flash memory (EEPROM) at the I/O unit using the Debug mode in PAC Control. For more information, see the PAC Control User’s Guide (form 1700).
- If the TPO period is not stored in permanent memory at the I/O unit, use Set Analog TPO Period immediately before Moving a new value to the TPO every time. This ensures that the TPO period will be configured properly if the I/O unit has experienced loss of power. Do not, however, issue these commands more frequently than necessary since this can be counterproductive.

Dependencies: This command is valid only when used on a properly configured time proportional output module.
Call Chart

Chart Action

**Function:** Starts another chart and immediately suspends the calling chart. Automatically continues the calling chart when the called chart ends.

**Typical Use:** Allows a main or "executive" chart to easily orchestrate the execution of other charts that typically have a dedicated function. Since each called chart ends before the next chart is called, this reduces the total number of charts running concurrently.

**Details:**
- This command is functionally a combination of three other commands: Start Chart, Suspend Chart, and Continue Calling Chart. Keep in mind that the suspended chart still takes up a task in the queue. Call Chart attempts to start the specified chart and if successful, suspends the chart that issued the command. When the called chart finishes, the calling chart automatically continues.
- The status variable indicates success (0) or failure (error code -5 if the chart is already running).

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart</td>
<td>Put Status in</td>
</tr>
<tr>
<td></td>
<td>Float Variable</td>
</tr>
<tr>
<td></td>
<td>Integer 32Variable</td>
</tr>
</tbody>
</table>

**Action Block Example:**

<table>
<thead>
<tr>
<th>Call Chart</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argument Name</td>
</tr>
<tr>
<td>---------------</td>
</tr>
<tr>
<td>Chart</td>
</tr>
<tr>
<td>Put Status in</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```optoscript
CallChart(Chart)
Call_Status = CallChart(Tank_Monitor);
```

This is a function command; it returns a zero (indicating success) or an error (indicating failure). The returned value can be consumed by a variable (as shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User's Guide (form 1700).

**Notes:**
- This command should be used judiciously. It can take up to 100 ms for the called chart to start. Once the called chart has completed its logic, it can take another 100 ms to resume the calling chart. Use this command only when timing is not critical. Otherwise, instead of Call Chart, use a chart that runs continuously and uses subroutines for any kind of repetitive logic.
- Typically used to chain charts so that they run sequentially rather than concurrently.
• Can be used by concurrently running charts calling a sub-chart that performs a common function.
• Make sure to check the STATUS variable to ensure the chart has actually started.

Dependencies: A chart must be available in the task queue.

Status Codes:
0 = success
-5 = Operation Failed. Possible causes on a non-redundant system:
  – The maximum number of charts is already running.
  – The chart is already running.

-36 = Invalid command or feature not implemented. This code will be returned on a redundant system.

See Also:
"Continue Calling Chart" on page 59
"Start Chart" on page 63
"Suspend Chart" on page 65
**Calling Chart Running?**

**Chart Condition**

- **Function:** To check if the calling chart (the one that started this chart) is in the running state.
- **Typical Use:** To determine the status of the chart that started this chart.
- **Details:** If the calling chart is running, the logic will take the True path. If the calling chart is not running, the logic will take the False path.
- **Arguments:** None.

**Condition Block Example:**

```plaintext
Calling Chart Running?
No arguments
```

**OptoScript Example:**

```plaintext
IsCallingChartRunning()
Chart_Status = IsCallingChartRunning();
```

This is a function command; it returns a value of true (non-zero) or false (0). The returned value can be consumed by a variable (as in the example shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the *PAC Control User's Guide* (form 1700).

**Notes:** See “Chart Commands” in the *PAC Control User's Guide* (form 1700).

**See Also:**
- “Continue Calling Chart” on page 59
- “Calling Chart Suspended?” on page 55
- “Calling Chart Stopped?” on page 54
Calling Chart Stopped?

Chart Condition

Function: To check if the calling chart (the one that started this chart) is in the stopped state.

Typical Use: To determine the status of the chart that started this chart.

Details: If the calling chart is stopped, the logic will take the True path. If the calling chart is not stopped, the logic will take the False path.

Arguments: None.

Condition Block Example:

OptoScript Example: `IsCallingChartStopped()`

```
Chart_Status = IsCallingChartStopped();
```

This is a function command; it returns a value of true (non-zero) or false (0). The returned value can be consumed by a variable (as in the example shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

Notes: See “Chart Commands” in the PAC Control User’s Guide (form 1700).

See Also:
- “Continue Calling Chart” on page 59
- “Calling Chart Suspended?” on page 55
- “Calling Chart Running?” on page 53
Calling Chart Suspended?

Chart Condition

**Function:** To check if the calling chart (the one that started this chart) is in the suspended state.

**Typical Use:** Called before Continue Calling Chart to ensure its success.

**Details:** If the calling chart is suspended, the logic will take the True path. If the calling chart is not suspended, the logic will take the False path.

**Arguments:** None.

**Condition Block Example:**

```plaintext
Calling Chart Suspended?
No arguments
```

**OptoScript Example:**

```plaintext
IsCallingChartSuspended()
Chart_Status = IsCallingChartSuspended();
```

This is a function command; it returns a value of true (non-zero) or false (0). The returned value can be consumed by a variable (as in the example shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

**Notes:**
- Always use before Continue Calling Chart to ensure its success. See the Continue Calling Chart action for details.

**See Also:**
- “Continue Calling Chart” on page 59
- “Calling Chart Stopped?” on page 54
- “Calling Chart Running?” on page 53
Chart Running?

Chart Condition

Function: To check if the specified chart is in the running state.

Typical Use: To determine the status of the specified chart.

Details: If the specified chart is running, the logic will take the True path. If the specified chart is not running, the logic will take the False path.

Arguments: 

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is</td>
<td>Chart</td>
<td>Chart_B</td>
</tr>
</tbody>
</table>

Condition Block Example:

OptoScript Example: `IsChartRunning(Chart_B)`

This is a function command; it returns a value of true (non-zero) or false (0). The returned value can be consumed by a variable (as in the example shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

Notes:

- When a chart uses a Start Chart followed immediately by a Suspend Chart to suspend itself, it depends on the target chart to continue it later. Hence, it is imperative that the target chart be started; otherwise the original (calling) chart will remain suspended. This command can determine if the target chart has started.

See Also: 
- “Chart Suspended?” on page 58
- “Chart Stopped?” on page 57
- “Call Chart” on page 51
- “Start Chart” on page 63
- “Stop Chart” on page 64
Chart Stopped?

Chart Condition

Function: To check if the specified chart is in the stopped state.

Typical Use: Used before Start Chart to ensure its success when it is imperative that Start Chart succeeds.

Details: If the specified chart is stopped, the logic will take the True path. If the specified chart is not stopped, the logic will take the False path.

Arguments:

| Argument 0 | Is Chart |

Example: IsChartStopped(Chart)

OptoScript Example: Chart_Status = IsChartStopped(Chart_B);

This is a function command; it returns a value of true (non-zero) or false (0). The returned value can be consumed by a variable (as in the example shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

Notes: See “Chart Commands” in the PAC Control User’s Guide (form 1700).

See Also:
- “Chart Suspended?” on page 58
- “Chart Running?” on page 56
- “Call Chart” on page 51
- “Start Chart” on page 63
- “Stop Chart” on page 64
Chart Suspended?

Chart Condition

Function: To check if the specified chart is in the suspended state.

Typical Use: To determine the status of the specified chart.

Details: If the specified chart is suspended, the logic will take the True path. If the specified chart is not suspended, the logic will take the False path.

Arguments: Argument 0

Is

Chart

Condition Block Example:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is</td>
<td>Chart</td>
<td>CHART_B</td>
</tr>
</tbody>
</table>

OptoScript Example:

IsChartSuspended(Chart)

Chart_Status = IsChartSuspended(Chart_B);

This is a function command; it returns a value of true (non-zero) or false (0). The returned value can be consumed by a variable (as in the example shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

Notes:
- Use before Continue Chart to ensure success.

See Also:
- “Chart Running?” on page 56
- “Chart Stopped?” on page 57
- “Continue Chart” on page 60
- “Suspend Chart” on page 65
Continue Calling Chart

Chart Action

**Function:**
To continue the chart that started the current chart without having to know its name.

**Typical Use:**
To restart a suspended chart.

**Details:**
- This command is not normally needed, since a called chart, when finished, automatically continues the chart that called it. Use this command only if you need to restart the calling chart before the chart it called is finished.
- The only effect this command has is to continue a suspended chart. If the calling chart is in any other state, the calling chart will be unaffected by this command.
- The calling chart will resume execution at its next scheduled time in the task queue.
- The STATUS variable indicates success (0) or failure (non-zero). Since a failure would “break the chain” of execution, care must be taken to ensure success. In this example, it is possible for CHART_A to start SUB_CHART_A, AND then lose its time slice before it suspends itself, leaving it in the running state. Further, it is possible for SUB_CHART_A to complete execution in its allocated time slice(s) and issue the Continue Calling Chart command, which will fail because the calling chart is still in the running state.

To prevent this situation, SUB_CHART_A should be modified to add the condition Calling Chart Suspended? just before the Continue Calling Chart action. The True exit will lead directly to the Continue Calling Chart action, but the False exit will loop back to the Calling Chart Suspended? condition itself to re-evaluate if the chart has been suspended. This ensures proper operation.

For the same reason, the condition Chart Stopped? should preface the Start Chart “SUB_CHART_A” command.

**Arguments:**
- **Argument 0**
  - **Put Status in**
    - Float Variable
    - Integer 32 Variable

**Action Block Example:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Put Status in</td>
<td>Integer 32 Variable</td>
<td>STATUS</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```
ContinueCallingChart();
```

This is a function command; it returns a non-zero (indicating success) or a zero (indicating failure).

**Notes:**
See “Chart Commands” in the *PAC Control User’s Guide* (form 1700).

**See Also:**
- “Call Chart” on page 51
- “Calling Chart Suspended?” on page 55
**CHAPTER 3: CHART COMMANDS**

**Continue Chart**

**Chart Action**

**Function:** To change the state of a specified chart from suspended to running.

**Typical Use:** In conjunction with Suspend Chart, to cause a specified chart to resume execution from where it left off.

**Details:**
- The only effect this command has is to continue a suspended chart. If the specified chart is in any other state, it will be unaffected by this command.
- Upon success, the chart will resume execution at its next scheduled time in the task queue at the point at which it was suspended.
- Suspended charts give up their time slice.
- The STATUS variable indicates success (0) or failure (non-zero).
- It is possible for CHART_A to complete execution of the commands between Suspending Chart B and Continuing Chart B in its allocated time slice(s). If this happens, the Continue Chart "CHART_B" command will fail, because the actual state of Chart B hasn't changed since it hasn't received a time slice yet.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart</td>
<td>Put Status in</td>
</tr>
<tr>
<td>Chart</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```plaintext
ContinueChart(Chart)
STATUS = ContinueChart(CHART_A);
```

This is a function command; it returns a zero (indicating success) or a non-zero (indicating failure).

**Notes:**
- This command should be used judiciously. It can take up to 100 ms for the chart to continue. Use this command only when timing is not critical. Otherwise, instead of Continue Chart, use a chart that runs continuously and uses subroutines for any kind of repetitive logic.
- Loop on Chart Suspended? before this command if success is critical.

**See Also:**
- “Suspend Chart” on page 65
- “Chart Suspended?” on page 58
Get Chart Status

Chart Action

Function: To determine the current status of a specified chart.

Typical Use: To determine in detail the current status of a chart.

Details:
- Status is returned as a 32-bit integer. Applicable bits are 0–3 and 17:
  - Bit 0: Running Mode (0 = chart is stopped; 1 = chart is running)
  - Bit 1: Suspended Mode (0 = chart is not suspended; 1 = chart is suspended)
  - Bit 2: Step Mode (0 = chart is not being stepped through; 1 = chart is being stepped through)
  - Bit 3: Break Mode (0 = chart does not have break points defined; 1 = chart has break points defined)
  - Bit 17: Starting (0 = chart is not in the process of starting; 1 = chart is in the process of starting or is currently running)

- Unused bits from 4-16, 18-31 are reserved for Opto 22 use.
- Running Mode is on whenever a chart is running.
- Suspended Mode is on whenever a chart is suspended from Running Mode.
- Step Mode is on whenever a chart is being automatically or manually stepped through.
- Break Mode is on whenever a chart has a break point defined in one or more of its blocks.
- Starting Mode is on whenever the chart is in the process of starting or is currently running.
- A chart that is paused is considered to be running and in Step Mode.
- A chart that has never been started is considered stopped. A chart that is not suspended is either running or stopped.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart</td>
<td>Put Status in</td>
</tr>
<tr>
<td>Chart</td>
<td>Float Variable</td>
</tr>
<tr>
<td></td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

Action Block Example:

```
Get Chart Status

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart</td>
<td>Chart</td>
<td>CHART_A</td>
</tr>
<tr>
<td>Put Status in</td>
<td>Integer 32 Variable</td>
<td>STATUS</td>
</tr>
</tbody>
</table>
```

OptoScript Example: `GetChartStatus(Chart)`

```
STATUS = GetChartStatus(CHART_A);
```

This is a function command; it returns the status of the chart. The returned value can be consumed by a variable (as shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the *PAC Control User's Guide* (form 1700).

Notes:
- Bit testing (rather than number testing) should be used to determine the current status, since a chart can simultaneously have multiple bits set at once. For example:
  - Break Mode, Bit 3 = 1
  - Step Mode, Bit 2 = 1
  - Running Mode, Bit 0 = 1
  - Reserved Bits, Bits 4-16, 18-31 can have any value
  - Starting Mode, Bit 17 = 1
In order to check the stopped/running state of a chart, it is necessary to check bits 0 and 17. If the chart is stopped and is not in the process of starting, bits 0 and 17 will both be 0. If the chart is in the process of starting, but is not running yet, bit 0 will be 0 and bit 17 will be 1. If the chart is running, bit 0 will be 1 and bit 17 will be 1.

- Avoid putting the returned status into a float variable, since the bits cannot be tested.
- If the strategy is stopped, the status variable is not updated before it is stopped, so the bits are left in their last known state before stopping. For example, if you stop the strategy, Bit 0 is not updated and may incorrectly indicate that a chart is still running when it is not.

See Also:
- "Chart Stopped?" on page 57
- "Chart Running?" on page 56
- "Bit Test" on page 379
**Start Chart**

**Chart Action**

**Function:** To request that a stopped chart begin executing at Block 0.

**Typical Use:** In the Powerup chart, to start all other charts that need to run. Also used by a main chart to start event-driven charts.

**Details:**
- This command is a request only. If the chart is stopped—and fewer than the maximum number of charts are running—then this chart will be added to the task queue and the command will succeed. Otherwise, the command has no effect.
- The maximum number of charts that can be running at any one time is based on the control engine you are using:
  - 32 charts (and Alternate Host Tasks*) on a SNAP PAC S-series controller
  - 16 charts (and Alternate Host Tasks*) on a SNAP PAC R-series
  - 64 charts (and Alternate Host Tasks*) on a SoftPAC controller
  * Each successful call to the command Start Alternate Host Task will reduce the number of charts than can be run simultaneously by one chart.
- Upon success, the chart will start at its next scheduled time in the task queue.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Chart</strong></td>
<td><strong>Put Status in</strong></td>
</tr>
<tr>
<td>Chart</td>
<td>Float Variable</td>
</tr>
<tr>
<td></td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

**Action Block Example:**

```
Start Chart

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart</td>
<td>Chart</td>
<td>CHART_B</td>
</tr>
<tr>
<td>Put Status in</td>
<td>Integer 32 Variable</td>
<td>STATUS</td>
</tr>
</tbody>
</table>
```

**OptoScript Example:**

```
StartChart (Chart)
STATUS = StartChart (CHART_B);
```

This is a function command; it returns one of the status codes listed below.

**Notes:**
- This command should be used judiciously. It can take up to 100 ms for the chart to start. Use this command only when timing is not critical. Otherwise, instead of Start Chart, use a chart that runs continuously and uses subroutines for any kind of repetitive logic.
- See “Chart Commands” in the **PAC Control User’s Guide** (form 1700).
- Make sure to check the STATUS variable to ensure the chart has actually started.
- Use **Continue Chart** if you want to continue a suspended chart.

**Dependencies:**
If the chart is stopped, then a chart must be available in the task queue.

**Status Codes:**
- 0 = success
- -5 = failure

**See Also:**
- “Continue Chart” on page 60
- “Stop Chart” on page 64
Stop Chart
Chart Action

Function: To stop a specified chart.

Typical Use: To stop another chart or the chart in which the command appears.

Details:
- Unconditionally stops any chart that is either running or suspended.
- Removes the stopped chart from the task queue, making another chart available.
- A chart can stop itself or any other chart. A chart that stops itself will immediately give up the remaining time allocated in its time slice(s). Stopping another chart won’t take effect immediately but will take effect at the beginning of that chart’s scheduled time in the queue.
- Charts that are stopped or suspended cannot start or continue themselves (nor can they do anything else).
- Stopped charts cannot be continued; they can only be started again (that is, their execution will begin again at Block 0, not at the point at which they were stopped).

Arguments: Argument 0
Chart

Action Block Example:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart</td>
<td>Chart</td>
<td>CHART_B</td>
</tr>
</tbody>
</table>

OptoScript Example:

StopChart(Chart)

This is a procedure command; it does not return a value.

Notes:
- This command should be used judiciously. It can take up to 100 ms for the chart to stop. Use this command only when timing is not critical. Otherwise, instead of Stop Chart, use a chart that runs continuously and uses subroutines for any kind of repetitive logic.
- Use Suspend Chart if you want to continue a chart from where it left off.

See Also:
- “Start Chart” on page 63
- “Suspend Chart” on page 65
- “Chart Stopped?” on page 57
Suspend Chart

**Chart Action**

**Function:** To suspend a specified chart.

**Typical Use:** To suspend another chart or the chart in which the command appears.

**Details:**
- Unconditionally suspends any chart that is running.
- Does not remove the suspended chart from the task queue.
- A chart can suspend itself or any other chart.
- **IMPORTANT:** A chart that suspends itself may not do so immediately. Depending on activity in the control engine, the chart may continue for another command or two. To start another chart and immediately suspend the first chart, use the command Call Chart instead.
- Suspending another chart won’t take effect immediately but will take effect at the beginning of that chart’s scheduled time in the queue.
- Charts that are suspended cannot start or continue themselves (nor can they do anything else).
- Suspended charts can be continued from the point at which they were suspended (using Continue Chart), or they can be stopped (using Stop Chart).

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Chart</strong></td>
<td><strong>Put Status in</strong></td>
</tr>
<tr>
<td>Chart</td>
<td>Float Variable</td>
</tr>
<tr>
<td></td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

**Action Block Example:**

```
Suspend Chart
```

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart</td>
<td>Chart</td>
<td>CHART_B</td>
</tr>
<tr>
<td>Put Status in</td>
<td>Integer 32 Variable</td>
<td>STATUS</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```
SuspendChart(Chart)
```

```
STATUS = SuspendChart(CHART_B);
```

This is a function command; it returns one of the status codes listed below.

**Notes:**
- This command should be used judiciously. It can take up to 100 ms for the chart to suspend. Use this command only when timing is not critical. Otherwise, instead of Suspend Chart, use a chart that runs continuously and uses subroutines for any kind of repetitive logic.
- See “Chart Commands” in the *PAC Control User’s Guide* (form 1700).

**Status Codes:**

- 0 = success.
- -5 = failure.

**See Also:**
- “Start Chart” on page 63
- “Continue Chart” on page 60
- “Chart Suspended?” on page 58
4: Communication Commands

Accept Incoming Communication

Communication Action

Function: In TCP/IP communication, to establish a connection. (In this case the control engine acts as the server, and the communication is opened by the client.)

Typical Use: To accept an incoming communication.

Details:
- Applies to communication via TCP communication handles only.
- Always use Listen for Incoming Communication once on each port to start the process before using this command to complete it. If you don’t use the listen command first, you’ll receive a -441 (Could not listen on socket) error.

Arguments:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Handle</td>
<td>Communication Handle</td>
<td>SNAP_PAC_A</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Integer 32 Variable</td>
<td>STATUS</td>
</tr>
</tbody>
</table>

Action Block Example:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Handle</td>
<td>Communication Handle</td>
<td>SNAP_PAC_A</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Integer 32 Variable</td>
<td>STATUS</td>
</tr>
</tbody>
</table>

OptoScript Example:

AcceptIncomingCommunication(Communication Handle)
STATUS = AcceptIncomingCommunication(SNAP_PAC_A);

This is a function command; it returns one of the status codes listed below. The returned value can be consumed by a variable (as in the example shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

Notes:
- Ports 22004 and 22005 are assigned specifically to Opto 22 and are the ports we recommend for communication via TCP. You can use other ports, but be aware that other processes may also try to use those ports.
- It is necessary to use the Listen for Incoming Communication command only once per port, even if you use the Accept Incoming Communication command several times.
For those familiar with sockets programming, PAC Control uses a limited sockets implementation. To use this command again, create another communication handle and Accept Incoming Communication on the new handle.

The session may be closed by the master. To determine whether the session is still open, use the commands Get Number of Characters Waiting, Communication Open?, or Receive String. (Get Number of Characters Waiting is the best method.)

If this command returns an error code, the communication handle will close and need to be re-opened. Be sure to check for status codes returned by this command, and handle any errors appropriately.

**Status Codes:**

- 0 = Success
- -10 = Invalid port number. Check format in the communication handle string.
- -36 = Invalid command. Use this command only with a TCP communication handle; for other communication handles, use Open Outgoing Communication instead.
- -47 = Open failed. Handle has already been opened.
- -203 = Unknown driver on communication handle.
- -441 = Could not listen on socket.
- -442 = Could not accept on socket. No devices are currently attempting to connect on this port.

**See Also:**

- “Listen for Incoming Communication” on page 83
- “Get Number of Characters Waiting” on page 74
- “Receive String” on page 99
- “Open Outgoing Communication” on page 85
- “Communication Open?” on page 71
Clear Communication Receive Buffer

Communication Action

**Function:** To clear the receive buffer of a communication handle.

**Typical Use:** To discard any data waiting to be received on a specific communication handle (for TCP and other communication handles that use a receive buffer).

**Details:** This command is the equivalent of a Get Number of Characters Waiting command followed by a Receive N Characters command, when the characters received are discarded.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Handle</td>
</tr>
</tbody>
</table>

**Action Block Example:**

```
ClearCommunicationReceiveBuffer (Communication Handle)
```

**OptoScript Example:**

```
ClearCommunicationReceiveBuffer(PAC_B);
```

This is a procedure command; it does not return a value.

**Notes:**

- If this command is used with a communication handle that cannot receive data (for example, the ftp communication handle), the command will have no effect.
- This command replaces the obsolete Clear Receive Buffer command.
- If this command returns an error code, the communication handle will close and need to be re-opened. Be sure to check for status codes returned by this command, and handle any errors appropriately.

**See Also:**

- “Close Communication” on page 70
- “Get Number of Characters Waiting” on page 74
- “Receive N Characters” on page 89
CHAPTER 4: COMMUNICATION COMMANDS

Close Communication
Communication Action

Function: To disconnect the previously established communication link, or to send the data currently buffered in the temporary FTP file.

Typical Use: To end communication with the other entity (for example, a device on the network or a file) that was specified by a communication handle.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Handle</td>
<td>Put Status in</td>
</tr>
<tr>
<td>Communication Handle</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

Action Block Example:

```
OptoScript Example:

CloseCommunication (Communication Handle)
Ethernet_Status = CloseCommunication (PAC_A);
```

This is a function command; it returns a status code as shown below.

Notes:

- When using an FTP communication handle, the data to be sent via FTP is held in a temporary FTP file until either this command is used or the FTP destination file is changed using Send Communication Handle Command.
- If this command returns an error code, the communication handle will close and need to be re-opened. Be sure to check for status codes returned by this command, and handle any errors appropriately.
- (FTP handles only) After the communication handle is open, you can set the FTP mode by issuing one of the following commands:
  - For Active FTP:
    ```
    i32ResultCode = SendCommunicationHandleCommand(cmh, "active");
    ```
  - For Passive FTP:
    ```
    i32ResultCode = SendCommunicationHandleCommand(cmh, "passive");
    ```

Status Codes:

0 = Success
-37 = Lock port timeout.
-52 = Invalid connection—not opened. The communication handle may have been closed by a previous command that failed. Check status codes returned on other communication handle commands.
-78 = No destination given (FTP destination file).
-437 = No acceptable socket interface found. An Ethernet "accept" or "open" was attempted, but no more sessions are available.

See Also:

“Open Outgoing Communication” on page 85
“Send Communication Handle Command” on page 105
**Communication Open?**

**Communication Condition**

**Function:**
To determine if the specified communication is still online.

**Typical Use:**
To determine if the communication handle was successfully opened or is still open, before attempting to send communication.

**Arguments:**
- Argument 0
  - Communication Handle

**Condition Block Example:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Handle</td>
<td>Communication Handle</td>
<td>PAC_A</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```optoscript
if (IsCommunicationOpen(PAC_A)) then
```

This is a function command; it returns a value of true (non-zero) or false (0). The returned value can be consumed by a control structure (as in the example shown) or by a variable, I/O point, and so forth. For more information, see the *PAC Control User's Guide* (form 1700).

**Notes:**
- This command will return false only if the Close Communication command has been called on the communication handle, or if the handle was closed during another command’s unsuccessful operation. For example, an unrecoverable failure during a Transmit command could cause the handle to be closed.
- Using TCP, this command will return a true (non-zero) even if the other side has closed. This situation is called a “half open” connection. Even though the other side has closed, there may still be characters buffered by the control engine. Make sure the characters are received (and the communication handle closed, if appropriate) so that sessions aren’t used up by a half-open state.
- When using TCP/IP, use this command to evaluate if the command Open Outgoing Communication has been called on this handle. To evaluate the status of the handle later, use the response of the command Get Number of Characters Waiting. This command will indicate if a remote host has issued a message to close the session.

**See Also:**
- “Accept Incoming Communication” on page 67
- “Open Outgoing Communication” on page 85
- “Close Communication” on page 70
Get Communication Handle Value

Communication Action

**Function:**
Returns a string that is the current value (the arguments) of the communication handle.

**Typical Use:**
To find out the current communication arguments for a communication handle.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>From</td>
<td>To</td>
</tr>
<tr>
<td>Communication Handle</td>
<td>String Variable</td>
</tr>
</tbody>
</table>

**Action Block Example:**

<table>
<thead>
<tr>
<th>Get Communication Handle Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argument Name</td>
</tr>
<tr>
<td>----------------</td>
</tr>
<tr>
<td>From</td>
</tr>
<tr>
<td>To</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```opto
GetCommunicationHandleValue(From, To)
GetCommunicationHandleValue(COMM_B, COMM_VALUE);
```

This is a procedure command; it does not return a value.

**Note:**
If this command returns an error code, the communication handle will close and need to be re-opened. Be sure to check for status codes returned by this command, and handle any errors appropriately.

**See Also:**
“Set Communication Handle Value” on page 118
Get End-Of-Message Terminator

Communication Action

**Function:** To find out the end-of-message (EOM) character currently set for a specific communication handle.

**Typical Use:** To make sure the communication handle’s EOM character is set as needed.

**Details:**
- The communication handle must already be opened for the command to take effect. Use the command *Open Outgoing Communication* to open the handle.
- The character is represented by an ASCII value. (See the ASCII table under “String Commands” in the *PAC Control User’s Guide* form 1700.) For example, a space is a character 32 and a “1” is a character 49.
- The default end-of-message character is 13 (carriage return).

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Handle</td>
<td>Put Status In</td>
</tr>
<tr>
<td>Communication Handle</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

**Action Block Example:**

```
Get End-Of-Message Terminator
```

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Handle</td>
<td>Communication Handle</td>
<td>PAC_A</td>
</tr>
<tr>
<td>Put Status In</td>
<td>Integer 32 Variable</td>
<td>EOM_Term</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```
GetEndOfMessageTerminator (Communication Handle)
EOM_Term = GetEndOfMessageTerminator (PAC_A);
```

This is a function command; it returns the current EOM character or a status code of -52, if the communication handle has not been opened. The returned value can be consumed by a variable (as in the example shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the *PAC Control User’s Guide* (form 1700).

**Note:** If this command returns an error code, the communication handle will close and need to be reopened. Be sure to check for status codes returned by this command, and handle any errors appropriately.

**Status Codes:**
- -52 = Invalid connection—not opened. The communication handle may have been closed by a previous command that failed. Check status codes returned on other communication handle commands.

**See Also:**
- “Set End-Of-Message Terminator” on page 119
- “Open Outgoing Communication” on page 85
Get Number of Characters Waiting

Communication Action

Function: To get the number of characters available to be received from a communication handle and put it into a numeric variable.

Typical Use: To determine if there are any characters or a particular number of characters to be received before actually receiving them, or to determine the size of a file that's just been opened.

Details:
- A value of 0 means there are no characters to be received. A negative value indicates an error.
- Each character counts as one regardless of what it is.
- For Ethernet, the maximum number of characters that can be buffered is 8760, and any value greater than zero indicates the actual number of characters waiting in the receive buffer.
- When using the file communication handle, this command returns the size of the file (if just opened) or the number of characters after the current position (if some characters have already been read or received, or the position has been moved).
- This command cannot be used with an FTP communication handle.

Arguments:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Handle</td>
<td>Communication Handle</td>
<td>PAC_A</td>
</tr>
<tr>
<td>Put in</td>
<td>Float Variable</td>
<td>CHAR_COUNT</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Action Block Example:

```
Get Number of Characters Waiting

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Handle</td>
<td>Communication Handle</td>
<td>PAC_A</td>
</tr>
<tr>
<td>Put in</td>
<td>Integer 32 Variable</td>
<td>CHAR_COUNT</td>
</tr>
</tbody>
</table>
```

OptoScript Example:

```
GetNumCharsWaiting(Communication Handle)

CHAR_COUNT = GetNumCharsWaiting(PAC_A);
```

This is a function command; it returns the number of characters available to be received. The returned value can be consumed by a variable (as shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User's Guide (form 1700).

Notes:
- Use to determine if the number of characters expected equals the number of characters actually ready to be received.
- If result > 0, there are characters available to be received.
- If result = 0, there are no characters to be received.
- If result < 0, there was an error executing this command. For example, the communication handle may not be opened (use Open Outgoing Communication).
- If this command returns an error code, the communication handle will close and need to be re-opened. Be sure to check for status codes returned by this command, and handle any errors appropriately.

NOTE: Using TCP, this command will return a true (non-zero) if there are still characters to be received, even if the other side has closed. This situation is called a “half open” connection. Make sure the characters are received so that sessions aren’t used up by a half-open state.

Status Codes:
-36 = Invalid command or feature not implemented. A firmware upgrade may be required to use this feature on this type of communication handle.
-37 = Lock port timeout.
-39 = Receive timeout.

-52 = Invalid connection—not opened. The communication handle may have been closed by a previous command that failed. Check status codes returned on other communication handle commands.

-53 = Connection number not valid.

-443 = Socket receive error. Usually occurs when the connection was closed by the other side.

See Also: “Send Communication Handle Command” on page 105, especially the getpos and setpos commands
CHAPTER 4: COMMUNICATION COMMANDS

HTTP Get
Communication Action

Function: Sends a request to retrieve a web page.

Typical Use: To get HTTP content from a specific file and location.

Details:
- In order for this command to work, the controller must be configured with DNS and Gateway addresses. Make sure that the controller is configured with an IP address and the appropriate Subnet Mask, DNS, and Gateway for the network. For details, see the PAC Manager User’s Guide (form 1704).
- For Response Content (Argument 0) and Response Header (Argument 1), make sure the table is big enough for the response to fit. Each element is filled with as much of the HTTP content as it will hold, then the next element is used.
- To change the timeouts for transmitting, receiving, and connecting, use element [0] of the table in Get Header (Argument 2). The default is 10,000 milliseconds (10 seconds).

To change one or more timeouts from the default, specify the value as follows:

```
<table>
<thead>
<tr>
<th>To do:</th>
<th>Use this command where “nnnn” is the timeout in milliseconds</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set transmit timeout</td>
<td>“to.tx:nnnn”</td>
</tr>
<tr>
<td>Set receive timeout</td>
<td>“to.rx:nnnn”</td>
</tr>
<tr>
<td>Set connect timeout</td>
<td>“to.cx:nnnn”</td>
</tr>
</tbody>
</table>
```

Each timeout command is independent of the others so you can use one, two, or all three of the commands in any order. If you use more than one command, put a space between each one.

The following example sets the transmit timeout to 20 seconds and the receive timeout to 15 seconds. The connect timeout is not changed:

```
HTTP_SrcStrTblBody[0]="to.tx:20000 to.rx:15000"
```

- **Port** (Argument 6) represents the port number. For example, 80 is the standard HTTP port; 443 is the standard for SSL.
- **For Security Mode** (Argument 3), use 0 (zero) for a non-secure connection. Use a number other than zero to use SSL (Secure Socket Layer).
  - Using 0 for Security Mode and 80 for Port (Argument 6) is the equivalent of typing HTTP into your browser.
  - Using a non-zero number for Security Mode and 443 for Port is the equivalent of typing HTTPS into your browser.
- **Hostname** (Argument 7) is the web address **without** the http:// or https://. Example: www.hostaddress.com
URL Path (Argument 4) is the specific sub-page for Hostname (Argument 7). For example, /products specifies the products sub-page. Otherwise, just use a forward slash (/) for the root.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Response Content</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Response Header</td>
<td>String Table</td>
<td>DstStrTblHdr</td>
</tr>
<tr>
<td></td>
<td>Get Header</td>
<td>String Table</td>
<td>GET_SrcStrTblBody</td>
</tr>
<tr>
<td></td>
<td>Security Mode</td>
<td>Integer 32 Literal</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>URL Path</td>
<td>String Literal</td>
<td>StrCmd</td>
</tr>
<tr>
<td></td>
<td>Put HTTP Status in</td>
<td>Integer 32 Variable</td>
<td>nHttpStatus</td>
</tr>
<tr>
<td></td>
<td>Port</td>
<td>Integer 32 Literal</td>
<td>nPort</td>
</tr>
<tr>
<td></td>
<td>Hostname</td>
<td>String Literal</td>
<td>StrHostname</td>
</tr>
<tr>
<td></td>
<td>Put Result in</td>
<td>Integer 32 Variable</td>
<td>nSendStatus</td>
</tr>
</tbody>
</table>

HTTP Get

OptoScript Example:

```
HttpGet (Response Content, Response Header, Get Header, Security Mode, URL Path, Put HTTP Status in, Port, Hostname)
```

```
nSendStatus = HttpGet(DstStrTblBody, DstStrTblHdr, GET_SrcStrTblBody, 0, StrCmd, nHttpStatus, nPort, StrHostname);
```

This is a function command; it returns a status code as shown below.

Notes:

- If result = 0, the HTTP GET request was successfully sent to the server.
- If result < 0, there was an error executing this command.

HTTP Status Codes:

The following standard types of HTTP status codes may be returned.

- 100 series = Informational
- 200 series = Success
- 300 series = Redirection. The client must take additional action to complete the request.
- 400 series = Client error

Status Codes:

- 0 = Success.
- -12 = Invalid table index. Try increasing the length of the string tables passed to this command.
- -20 = Device busy. May be in use by another user or another application.
- -26 = Unknown response. This error is returned if you attempt to do a secure HTTP GET but specify zero rather than one for the Security Mode. The host is expecting an encrypted response, but instead receives plain text, which it attempts to decrypt.
- -34 = Invalid I/O command or invalid memory location.
-38 = Timeout on send.
-39 = Timeout on Receive.
-59 = Could not receive data. PAC Sim returns this error on a secure HTTP Get if 8192 bytes or more are returned.
-443 = Could not receive on socket.
-454 = Unable to connect to DNS server. Check DNS and gateway configuration.
-2000 = SSL: Bad certificate
-2001 = SSL: Certificate revoked
-2002 = SSL: Certificate expired
-2103 = SSL: Handshake failed.
-2104 = SSL: Handshake failed due to invalid or unverifiable certificate.
-2105 = SSL: Unspecified asynchronous platform error.
-2106 = SSL: SSL session is not open.
-2110 = SSL: Server failed to start.
-13019 = An argument in a string is bad.

See Also:
- "HTTP Post from String Table" on page 80
- "HTTP Post Calculate Content Length" on page 79
HTTP Post Calculate Content Length

Communication Action

**Function:** Calculates the length (the number of characters) of the HTTP content stored in a string table.

**Typical Use:** When sending an HTTP Post from String Table, you have to tell the server the total length of the header and body data you’re going to send. This command calculates the size of the data stream for that purpose.

**Details:**
- *Post Content* (Argument 0) and *Post Header* (Argument 1) are the tables you plan on sending with the HTTP Post from String Table command.
- Fill in the header and body tables with their data, and then call this command. The total length of the header and body data you’re going to send is automatically placed in the header table element you specify in *Length Index* (Argument 2).
- In order for this command to work, the controller must be configured with DNS and Gateway addresses. Make sure that the controller is configured with an IP address and the appropriate Subnet Mask, DNS, and Gateway for the network. For details, see the PAC Manager User’s Guide (form 1704).

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
<th>Argument 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Post Content</td>
<td>Post Header</td>
<td>Length Index</td>
<td>Put Result in</td>
</tr>
<tr>
<td>String Table</td>
<td>String Table</td>
<td>Integer 32 Literal</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```
HttpPostCalcContentLength(SrcStrTblBody, SrcStrTblHdr, 2);
```

This is a function command; it returns a status code as shown below.

**Notes:**
- If result = 0, the HTTP content length was calculated successfully.
- If result < 0, there was an error executing this command.

**Status Codes:**

- **0** = Success.
- **-12** = Invalid table index value. Index was negative or greater than or equal to the table size.
- **-20** = Resource busy. May be in use by another user or another application.
- **-59** = Could not receive data. PAC Sim returns this error on a secure HTTP Post Calculate Content Length if 8192 bytes or more are returned.

**See Also:**
- “Get Number of Characters Waiting” on page 74
- “HTTP Post from String Table” on page 80
HTTP Post from String Table

Communication Action

Function: Posts simple form-type HTTP content stored in the strategy to an HTTP server. The response from the server is returned as a string table.

Typical Use: To send values for fields on a webpage and return the webpage with the fields filled in.

Details:
- In order for this command to work, the controller must be configured with DNS and Gateway addresses. Make sure that the controller is configured with an IP address and the appropriate Subnet Mask, DNS, and Gateway for the network. For details, see the PAC Manager User’s Guide (form 1704).
- For Response Content (Argument 0) and Response Header (Argument 1), make sure the table is big enough for the response to fit. Each element is filled with as much of the HTTP content as it will hold, then the next element is used.
- To change the timeouts for transmitting, receiving, and connecting, use element [0] of the table in Get Header (Argument 2). The default is 10,000 milliseconds (10 seconds). To change one or more timeouts from the default, specify the value as follows:
  - Each timeout command is independent of the others so you can use one, two, or all three of the commands in any order. If you use more than one command, put a space between each one. The following example sets the transmit timeout to 20 seconds and the receive timeout to 15 seconds. The connect timeout is not changed:

    HTTP_SrcStrTblBody[0]="to.tx:20000 to.rx:15000"

<table>
<thead>
<tr>
<th>To do this:</th>
<th>Use this command where “nnnn” is the timeout in milliseconds</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set transmit timeout</td>
<td>“to.tx:nnnn”</td>
</tr>
<tr>
<td>Set receive timeout</td>
<td>“to.rx:nnnn”</td>
</tr>
<tr>
<td>Set connect timeout</td>
<td>“to.cx:nnnn”</td>
</tr>
</tbody>
</table>

- **Port** (Argument 6) represents the port number. For example, 80 is the standard HTTP port; 443 is the standard for SSL.
- For **Security Mode** (Argument 3), use 0 (zero) for a non-secure connection. Use a number other than zero to use SSL (Secure Socket Layer).
  - Using 0 for **Security Mode** and 80 for Port (Argument 6) is the equivalent of typing HTTP into your browser.
  - Using a non-zero number for **Security Mode** and 443 for Port is the equivalent of typing HTTPS into your browser.
- **Hostname** (Argument 7) is the web address **without** the http:// or https://. Example: www.hostaddress.com
- **URL Path** (Argument 4) is the specific sub-page for Hostname (Argument 7). For example, /products specifies the products sub-page. Otherwise, just use a forward slash (/) for the root.
Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
<th>Argument 3</th>
<th>Argument 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Response Content</td>
<td>Response Header</td>
<td>Post Content</td>
<td>Post Header</td>
<td>Security Mode</td>
</tr>
<tr>
<td>String Table</td>
<td>String Table</td>
<td>String Table</td>
<td>String Table</td>
<td>Integer 32 Literal</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Argument 5</th>
<th>Argument 6</th>
<th>Argument 7</th>
<th>Argument 8</th>
<th>Argument 9</th>
</tr>
</thead>
<tbody>
<tr>
<td>URL Path</td>
<td>Put HTTP Status in</td>
<td>Port</td>
<td>Hostname</td>
<td>Put Result in</td>
</tr>
<tr>
<td>String Table</td>
<td>Integer 32 Variable</td>
<td>Integer 32 Literal</td>
<td>String Literal</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

Action Block

Example:

HTTP Post from String Table

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Response Content</td>
<td>String Table</td>
<td>DstStrTblBody</td>
</tr>
<tr>
<td>Response Header</td>
<td>String Table</td>
<td>DstStrTblHdr</td>
</tr>
<tr>
<td>Post Content</td>
<td>String Table</td>
<td>SrcStrTblBody</td>
</tr>
<tr>
<td>Post Header</td>
<td>String Table</td>
<td>SrcStrTblHdr</td>
</tr>
<tr>
<td>Security Mode</td>
<td>Integer 32 Literal</td>
<td>0</td>
</tr>
<tr>
<td>URL Path</td>
<td>String Literal</td>
<td>StrUrlPath</td>
</tr>
<tr>
<td>Put HTTP Status in</td>
<td>Integer 32 Variable</td>
<td>nHttpStatus</td>
</tr>
<tr>
<td>Port</td>
<td>Integer 32 Literal</td>
<td>nPort</td>
</tr>
<tr>
<td>Hostname</td>
<td>String Literal</td>
<td>StrHostname</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Integer 32 Variable</td>
<td>nSendStatus</td>
</tr>
</tbody>
</table>

OptoScript Example:

```plaintext
HttpPostFromStringTable (Response Content, Response Header, Post Content, Post Header, Security Mode, URL Path, Put HTTP Status in, Port, Hostname)
nSendStatus = HttpPostFromStringTable(DstStrTblBody, DstStrTblHdr, SrcStrTblBody, SrcStrTblHdr, 0, StrUrlPath, nHttpStatus, nPort, StrHostname);
```

Notes:
- If result = 0, the HTTP content was posted successfully.
- If result < 0, there was an error executing this command.

HTTP Status Codes:
The following standard types of HTTP status codes may be returned.

100 series = Informational
200 series = Success
300 series = Redirection. The client must take additional action to complete the request.
400 series = Client error
500 = Internal server error

Status Codes:
- 0 = Success.
- -20 = Device busy. May be in use by another user or another application.
- -26 = An unknown response was received from the server.
- -34 = Invalid I/O command or invalid memory location.
- -38 = Timeout on send.
- -39 = Timeout on Receive.
-50 = Open connection timeout. Could not establish connection within the timeout period. Make sure that the controller is configured with a DNS and Gateway for the network.

-59 = Could not receive data. PAC Sim returns this error on a secure HTTP Post from String Table if 8192 bytes or more are returned.

-438 = Could not create socket.

-443 = Could not receive on socket.

-454 = Unable to connect to DNS server. Check DNS and gateway configuration.

-450 = DNS could not resolve hostname.

-2000 = SSL: Bad certificate

-2001 = SSL: Certificate revoked

-2002 = SSL: Certificate expired

-2103 = SSL: Handshake failed.

-2104 = SSL: Handshake failed due to invalid or unverifiable certificate.

-2105 = SSL: Unspecified asynchronous platform error.

-2106 = SSL: SSL session is not open.

-2110 = SSL: Server failed to start.

-13019 = An argument in a string is bad.

Queue Error: -12 = Invalid table index value. The destination table is too small to hold the HTTP response. Increase the table’s width or length.

See Also: “Get Number of Characters Waiting” on page 74
“HTTP Post Calculate Content Length” on page 79
Listen for Incoming Communication

Communication Action

**Function:** In TCP/IP communication, to start listening for incoming open communication requests. (In this case the control engine acts as the server, and the session is opened by the client.)

**Typical Use:** To listen for an incoming request to open communication.

**Details:**
- Applies to communication via TCP communication handles only.
- When configuring the communication handle, be careful to choose a port that is not used by other, unrelated devices on the network.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Handle</td>
<td>Put Status In</td>
</tr>
</tbody>
</table>

**Action Block Example:**

Listen for Incoming Communication

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Handle</td>
<td>Communication Handle</td>
<td>SNAP_PAC_A</td>
</tr>
<tr>
<td>Put Status In</td>
<td>Integer 32 Variable</td>
<td>STATUS</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

ListenForIncomingCommunication (Communication Handle)

```plaintext
STATUS = ListenForIncomingCommunication(SNAP_PAC_A);
```

This is a procedure command; it returns one of the status codes listed below. The returned value can be consumed by a variable (as in the example shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the *PAC Control User's Guide* (form 1700).

**Notes:**
- You need to perform Listen for Incoming Communication only once per listening port. Until then, the controller will reject any incoming session requests.
- After performing Listen for Incoming Communication, use Accept Incoming Communication to accept any request for a new incoming connection. Note that Accept Incoming Connection will fail until a request has been received. Therefore, you should periodically perform Accept Incoming Connection so that it can accept any new request.
- To determine whether the connection is still open, use Get Number of Characters Waiting or Communication Open?
- The number of Ethernet sessions available to listen for incoming communications depends in part on the control engine and the number of Ethernet sessions in use. (Ethernet sessions are used for a variety of purposes, such as making connections for FTP, email, Modbus/TCP, Ethernet/IP, and so forth.) If you send this command when there are no more available sessions, a -438 code is returned.

Here's a list of devices and the approximate number of total Ethernet sessions that can manage:

- GRV-EPIC-PR1 ≈ 500 sessions
- SNAP-PAC-S1 ≈ 100
- SNAP-PAC-S2 ≈ 100
- SNAP-PAC-R1 ≈ 75
- SNAP-PAC-R1-B ≈ 75
- SNAP-PAC-R2 ≈ 75
- SoftPAC ≈ 400

- See also “Communication Commands” in the *PAC Control User's Guide* (form 1700).
Status Codes: For more information on the following status codes, see “List of Common Messages” in the PAC Control User’s Guide (form 1700).

0 = Success
-10 = Invalid port.
-36 = Invalid command. Use this command only with a TCP communication handle; for other communication handles, use Open Outgoing Communication instead.
-47 = Open failed. Handle has already been opened.
-49 = No more connections are available. Maximum number of connections already in use.
-203 = Driver not found.
-438 = Could not create socket.
-440 = Could not bind socket.

See Also: “Accept Incoming Communication” on page 67
“Get Number of Characters Waiting” on page 74
“Communication Open?” on page 71
“Open Outgoing Communication” on page 85
Open Outgoing Communication

Communication Action

**Function:** To establish communication with another device or entity. Once the connection is established, communication can go both ways (incoming and outgoing).

**Typical Use:** To communicate with other devices via TCP/IP, UDP/IP, or a serial connection; send FTP data from the brain to a file on another device; or work with files in the brain’s file structure.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Handle</td>
<td>Put Result in</td>
</tr>
<tr>
<td>Communication Handle</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

**Action Block Example:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Handle</td>
<td>Communication Handle</td>
<td>TANK_CONTROL</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Integer 32 Variable</td>
<td>COMM_STATUS</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```
OpenOutgoingCommunication(Communication Handle)

COMM_STATUS = OpenOutgoingCommunication(TANK_CONTROL);
```

This is a function command; it returns a status code as defined below.

**Notes:**

- When using a SNAP PAC controller, Open Outgoing Communication can be used to open either Ethernet (TCP or UDP) or serial communication (using a serial port on the controller). Note: SNAP serial communication modules (SNAP-SCM) use TCP comm handles.
- When using SoftPAC, Open Outgoing Communication cannot be used with a computer’s serial ports or USB serial ports. (SoftPAC doesn’t support PC serial or USB ports.) However, the command can still be used with Ethernet (TCP and UDP) and SNAP-SCM comm handles.
- For TCP communication, depending on network traffic and the network arrangement, you may need to add a delay to the chart to make sure the session is open. The amount of delay needed depends on your network. (Distant connections might even take more than one second.) If you add a delay to the chart, then check the status of the session using Get Number of Characters Waiting.
- If this command returns an error code, the communication handle closes and you’ll need to re-open it. Be sure to check for status codes returned by this command, and handle any errors appropriately. An error typically happens when you’re using the on-board 232 port on a SNAP-PAC-R and you haven’t changed the default settings for that port. (It defaults to PPP.) You can resolve the issue either in your strategy (by using PAC Control) or by using PAC Manager.

**Using PAC Manager:**

- Select Tools > Inspect.
- Click the Communications button and select Communications Port Control.
- In the Values column, click the first drop-down list, and then select None. (This is the value for Control Function for Communication Port 0, memory map address 0xFFFF F031 0400).
- Click Apply.
- Click the Status Write button.
- In the Operation area, click “Store configuration to flash,” and then click the Send Command button. This stores the configuration to flash memory so that it retains the settings when the controller boots up.
Using PAC Control:
– Before using Open Outgoing Communication in your strategy, use the Write Number to I/O Unit Memory Map command to write the value of 0 to the address 0xFFFF F031 0400.

Status Codes:

0 = Success.
-10 = Invalid port number.
-20 = Resource busy. May be in use by another user or application. Use PAC Manager to check communication port control configuration; make sure device is not being used by PPP or M2M.
-46 = Invalid string. Check communication handle value (must have no spaces, be lowercase).
-47 = Open failed. Handle has already been opened.
-49 = No more connections are available. Maximum number of connections of this type already in use.
-50 = Open connection timeout. Could not establish connection within the timeout period.
-78 = No destination given. When sending a file via FTP, use Send Communication Handle Command to specify the name of the file on the remote server.
-203 = Driver could not be found or loaded. Make sure the communication handle designator (tcp, ftp, file, and so forth) is in lowercase letters and correctly spelled.
-412 = TCP/IP: Cannot connect error. Make sure the device is on. If multiple calls to this command are made one right after another, delay at least one second between the back-to-back calls.
-417 = Cannot open file. Check filename; verify that the file exists. If you’re trying to create a new file, make sure there’s enough room on your file system. You’ll get this error if it’s full.
-437 = No acceptable socket interface found. An Ethernet "accept" or "open" was attempted, but no more sessions are available.
-438 = Could not create socket. For more information, see “List of Common Messages” in the PAC Control User’s Guide (form 1700).
-446 = FTP: Login failed. Check user name, password, and maximum number of logins on server.
-447 = FTP: Connection failed. Check IP address and port.
-448 = FTP: Could not create session. Check IP address and port.
-454 = Unable to connect to DNS server. Check DNS and gateway configuration.

See Also:
“Close Communication” on page 70
“Communication Open?” on page 71
Receive Character

Communication Action

Function: To get a single character from a communication handle and move it to a numeric variable.

Typical Use: To get a message from another device or file one character at a time. Use Append Character to String (or a + in OptoScript) to append these characters (selectively if desired) to a string variable.

Details:
- Receives the next character. For example, receives the oldest character from the receive buffer for a TCP communication handle, or receives the next character in a file. Character values will be 0–255.
- If there are no characters to receive, a negative error code number (for example, -58) is returned. To avoid this problem, use Get Number of Characters Waiting before using this command.
- A character 0 (ASCII null) will have a value of zero; a character 48 (ASCII zero) will have a value of 48. These values will appear in the numeric variable. When appending a character 48 to a string variable, the number 0 will appear in the string and a 32 will appear as a space.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Handle</td>
<td>Put in</td>
</tr>
<tr>
<td>Communication Handle</td>
<td>Float Variable</td>
</tr>
<tr>
<td>Communication Handle</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

Action Block Example:

Receive Character

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Handle</td>
<td>Communication Handle</td>
<td>UNIT_2</td>
</tr>
<tr>
<td>Put in</td>
<td>Integer 32 Variable</td>
<td>CHAR</td>
</tr>
</tbody>
</table>

OptoScript Example:

ReceiveChar (Communication Handle)

CHAR = ReceiveChar (UNIT_2);

This is a function command; it returns the next character available for the communication handle. The returned value can be consumed by a variable (as shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User's Guide (form 1700).

Notes:
- See “Communication Commands” in the PAC Control User's Guide (form 1700). For an ASCII table, see “String Commands” in the same chapter.
- Always use command Get Number of Characters Waiting before this command to avoid unnecessary timeout errors.
- For receiving information using FTP communication handles, this command will work only after the Send Communication Handle Command (dir option) to retrieve directory information about the local or a remote FTP server. To retrieve a file from a remote FTP server, use Send Communication handle Command (get option) to bring the file into the local file system, and then use a File communication handle to access the file locally.
- If this command returns an error code (other than -37 or -39), the communication handle will close and need to be re-opened. (-37 and -39 indicate a timeout during the Receive, which could be a normal part of communications.) Be sure to check for status codes returned by this command, and handle any errors appropriately.

Status Codes:
-36 = Invalid command or feature not implemented. A firmware upgrade may be required to use this feature on this type of communication handle.
-52 = Invalid connection—not opened. The communication handle may have been closed by a previous command that failed. Check status codes returned on other communication handle commands.

-58 = Character not found.

-76 = At end of file.

See Also:
- "Append Character to String" on page 597
- "Get Number of Characters Waiting" on page 74
- "Receive N Characters" on page 89
- "Send Communication Handle Command" on page 105
CHAPTER 4: COMMUNICATION COMMANDS

Receive N Characters
Communication Action

**Function:**
Gets a specified number of characters from a communication handle.

**Typical Use:**
Can be used to receive the message a piece at a time, especially when the message is longer than a single string can hold.

**Details:**
- If N is greater than the number of characters ready to be received, all the characters will be returned along with an error, often -39.
- If no characters are in the receive buffer, a -58 error will be returned.
- If N is greater than the string length, as many characters as will fit will be returned along with a String Too Short error (-23).

**Arguments:**
<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
<th>Argument 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Put in</td>
<td>Num. Characters</td>
<td>Communication Handle</td>
<td>Put Status in</td>
</tr>
<tr>
<td>String Variable</td>
<td>Integer 32 Literal</td>
<td>Communication Handle</td>
<td>Float Variable</td>
</tr>
</tbody>
</table>

**Action Block Example:**
```
Receive N Character
```

**OptoScript Example:**
```
ReceiveNChars(Put in, Num. Characters, Communication Handle)
```
```
RECV_STATUS = ReceiveNChars(RECV_MSG, QTY_CHARS, UNIT_2);
```

This is a function command; it returns a zero if successful, or one of the status codes listed below.

**Notes:**
- The length of the string variable should be a few characters greater than the longest expected string.
- Use Receive String to get end-of-message character-delimited pieces of the message in the receive buffer.
- For receiving information using FTP communication handles, this command will work only after the Send Communication Handle Command (dir option) to retrieve directory information about the local or a remote FTP server. To retrieve a file from a remote FTP server, use Send Communication Handle Command (get option) to bring the file into the local file system, and then use a File communication handle to access the file locally.
- If this command returns an error code (other than -37 or -39), the communication handle will close and need to be re-opened. (-37 and -39 indicate a timeout during the Receive, which could be a normal part of communications.) Be sure to check for status codes returned by this command, and handle any errors appropriately.

**Dependencies:**
- Must have previously used Open Outgoing Communication to establish a session, or (for a TCP communication handle) Accept Incoming Communication to accept a session initiated by a TCP/IP peer.
- Before using this command, use Get Number of Characters Waiting to see if there is a message, and to determine an appropriate maximum value for n.

**Status Codes:**
-36 = Invalid command or feature not implemented. A firmware upgrade may be required to use this feature on this type of communication handle.
-37 = Lock port timeout.
-39 = Timeout on receive (if negative value is passed)
-44 = String too short.
-52 = Invalid connection—not opened. The communication handle may have been closed by a previous command that failed. Check status codes returned on other communication handle commands.
-58 = Character not found.
-69 = Invalid parameter (null pointer) passed. Make sure communication handle is open.
-76 = At end of file.

See Also:
“Receive Character” on page 87
“Get Number of Characters Waiting” on page 74
“Set End-Of-Message Terminator” on page 119
“Get End-OF-Message Terminator” on page 73
“Transfer N Characters” on page 120
### Receive Numeric Table

**Communication Action**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Length</strong></td>
<td><strong>Start at Index</strong></td>
<td><strong>Of Table</strong></td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
<td>Float Table</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
<td>Integer 32 Table</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Integer 64 Table</td>
</tr>
</tbody>
</table>

**Argument 3**

<table>
<thead>
<tr>
<th>Argument 3</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Communication Handle</strong></td>
</tr>
<tr>
<td>Communication Handle</td>
</tr>
</tbody>
</table>

**Argument 4**

<table>
<thead>
<tr>
<th>Argument 4</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Put Status in</strong></td>
</tr>
<tr>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

**Action Block Example:**

```plaintext
Receive Numeric Table
```

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length</td>
<td>Integer 32 Literal</td>
<td>64</td>
</tr>
<tr>
<td>Start at Index</td>
<td>Integer 32 Literal</td>
<td>0</td>
</tr>
<tr>
<td>Of Table</td>
<td>Float Table</td>
<td>PEER_DATA_TABLE</td>
</tr>
<tr>
<td>Communication Handle</td>
<td>Communication Handle</td>
<td>UNIT_2</td>
</tr>
<tr>
<td>Put Status in</td>
<td>Integer 32 Variable</td>
<td>RECV_STATUS</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```plaintext
ReceiveNumTable(Length, Start at Index, Of Table, Communication Handle)
```

RECV_STATUS = ReceiveNumTable(64, 0, PEER_DATA_TABLE, UNIT_2);

This is a function command; it returns one of the status codes listed below.

**Notes:**

- For receiving information using FTP communication handles, this command will work only after the Send Communication Handle Command (dir option) to retrieve directory information about the local or a remote FTP server. To retrieve a file from a remote FTP server, use Send Communication Handle Command (get option) to bring the file into the local file system, and then use a File communication handle to access the file locally.
- If this command returns an error code (other than -37 or -39), the communication handle will close and need to be re-opened. (-37 and -39 indicate a timeout during the Receive, which could be a normal part of communications.) Be sure to check for status codes returned by this command, and handle any errors appropriately.

**Dependencies:**

- Must have previously used Open Outgoing Communication, or (for TCP communication handles) Listen for Incoming Communication and Accept Incoming Communication to accept a session initiated by a TCP/IP peer. For details, see "Communication Commands" in the *PAC Control User’s Guide* (form 1700).
- Before using this command, use Get Number of Characters Waiting to see if there is a message.

**Status Codes:**

- 0 = Success.
- -36 = Invalid command or feature not implemented. A firmware upgrade may be required to use this feature on this type of communication handle.
- -37 = Lock port timeout.
-39 = Timeout on receive.
-52 = Invalid connection—not opened. The communication handle may have been closed by a previous command that failed. Check status codes returned on other communication handle commands.
-58 = No data received. Make sure I/O unit has power.
-69 = Invalid parameter (null pointer) passed to command. Make sure communication handle is open.
-76 = At end of file.

Queue Error:
-12 = Invalid table index value. Index was negative or greater than or equal to the table size.

See Also:
“Receive String” on page 99
“Receive String Table” on page 102
“Receive Pointer Table” on page 97
“Transmit Numeric Table” on page 125
“Transmit String Table” on page 131
“Transmit Pointer Table” on page 127
Receive Numeric Table Ex
Communication Action

**Function:** Moves a specific number of elements from the device or file specified in the communication handle to an integer or float numeric table.

**Typical Use:** Efficient method of numeric data transfer from one entity to another.

**Details:** The arguments are:
- **Length:** The number of elements to read.
- **Start at Index:** The start index in the destination table.
- **Endian Mode:** A Boolean value indicating whether the value is to be read as little-endian (true) or big-endian (false).
- **Bytes per Value:** The number of bytes that should be read for each element, (1, 2, 4, or 8).
- **Of Table:** A numeric table descriptor.
- **Communication Handle:** A communications handle descriptor.
- **Put Status in:** The result of the command. See possible Status Codes listed below.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0 (Length)</th>
<th>Argument 1 (Start at Index)</th>
<th>Argument 2 (Endian mode)</th>
<th>Argument 3 (Bytes per value)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
<td>Integer 32 Variable</td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Argument 4 (Of Table)</th>
<th>Argument 5 (Communication Handle)</th>
<th>Argument 6 (Put Status in)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Float Table</td>
<td>Communication Handle</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Integer 32 Table</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Integer 64 Table</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Action Block Example:**

```
Receive Numeric Table Ex
```

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length</td>
<td>Integer 32 Literal</td>
<td>1</td>
</tr>
<tr>
<td>Start at Index</td>
<td>Integer 32 Literal</td>
<td>8</td>
</tr>
<tr>
<td>Endian mode</td>
<td>Integer 32 Variable</td>
<td>endianMode</td>
</tr>
<tr>
<td>Bytes per value</td>
<td>Integer 32 Variable</td>
<td>bytesPerElement</td>
</tr>
<tr>
<td>Of Table</td>
<td>Integer 64 Table</td>
<td>i64Table</td>
</tr>
<tr>
<td>Communication Handle</td>
<td>Communication Handle</td>
<td>chRcv</td>
</tr>
<tr>
<td>Put Status in</td>
<td>Integer 32 Variable</td>
<td>nStatus</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```
ReceiveNumTableEx (Length, Start at Index, Endian mode, Bytes per value, Of Table, Communication Handle)
```

```nStatus= ReceiveNumTableEx(1, 8, endianMode, bytesPerElement, i64Table, chRcv);
```

This is a function command; it returns one of the status codes listed below.

**Notes:**
- For receiving information using FTP communication handles, this command will work only after the Send Communication Handle Command (dir option) to retrieve directory information about the local or a remote FTP server. To retrieve a file from a remote FTP server, use Send Communication Handle.
Command (get option) to bring the file into the local file system, and then use a File communication handle to access the file locally.

- If this command returns an error code (other than -37 or -39), the communication handle will close and need to be re-opened. (-37 and -39 indicate a timeout during the Receive, which could be a normal part of communications.) Be sure to check for status codes returned by this command, and handle any errors appropriately.

Dependencies:
- Must have previously used Open Outgoing Communication, or (for TCP communication handles) Listen for Incoming Communication and Accept Incoming Communication to accept a session initiated by a TCP/IP peer. For details, see “Communication Commands” in the PAC Control User’s Guide (form 1700).
- Before using this command, use Get Number of Characters Waiting to see if there is a message.

Status Codes:
0 = Success.
-12 = Invalid index.
-36 = Invalid command or feature not implemented. A firmware upgrade may be required to use this feature on this type of communication handle.
-37 = Lock port timeout.
-39 = Timeout on receive.
-52 = Invalid connection—not opened. The communication handle may have been closed by a previous command that failed. Check status codes returned on other communication handle commands.
-58 = No data received. Make sure I/O unit has power.
-69 = Invalid parameter (null pointer) passed to command. Make sure communication handle is open.
-76 = At end of file.

Queue Error:
-12 = Invalid table index value. Index was negative or greater than or equal to the table size.

See Also:
- Receive Numeric Variable” on page 95
- “Receive Numeric Table Ex” on page 93
- “Receive String” on page 99
- “Receive String Table” on page 102
- “Receive Pointer Table” on page 97
- “Transmit Numeric Table” on page 125
- “Transmit String Table” on page 131
- “Transmit Pointer Table” on page 127
Receive Numeric Variable

Communication Action

**Function:** Moves a specific value from the device or file specified in the communication handle to an integer 32 variable.

**Typical Use:** Receive numeric (binary string) data directly into a numeric variable.

**Details:** The arguments are:

- **Endian mode:** Either true (non-zero), or false (zero); if true, this command receives in little-endian mode, if false, it receives in big-endian mode.
- **Number of Bytes:** Use 4 for 32-bit integer and floats, 8 for 64-bit integers.
- **Put in:** The variable where the bytes should be placed; it must be at least the size you specify in Number of Bytes. That is, if you specify 8 bytes, it has to be an Int64.
- **Communication Handle:** A communications handle descriptor.
- **Put Status in:** The result of the command. See possible Status Codes listed below.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Endian mode</strong></td>
<td><strong>Number of Bytes</strong></td>
<td><strong>Put in</strong></td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
<td>Float Variable</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
<td>Integer 64 Variable</td>
</tr>
<tr>
<td><strong>Communication Handle</strong></td>
<td><strong>Put Status in</strong></td>
<td></td>
</tr>
<tr>
<td>Communication Handle</td>
<td>Integer 32 Variable</td>
<td></td>
</tr>
</tbody>
</table>

**Action Block Example:**

```
Receive Numeric Variable
```

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Endian mode</td>
<td>Integer 32 Literal</td>
<td>1</td>
</tr>
<tr>
<td>Number of Bytes</td>
<td>Integer 32 Literal</td>
<td>8</td>
</tr>
<tr>
<td>Put in</td>
<td>Integer 64 Variable</td>
<td>i64Temp</td>
</tr>
<tr>
<td>Communication Handle</td>
<td>Communication Handle</td>
<td>chRcv</td>
</tr>
<tr>
<td>Put Status in</td>
<td>Integer 32 Variable</td>
<td>nStatus</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```
ReceiveNumVariable (Endian mode, Number of Bytes, Put in, Communication Handle)
nStatus = ReceiveNumVariable(1, 8, i64Temp, chRcv);
```

This is a function command; it returns one of the status codes listed below.

**Notes:**

- This command makes it easy to directly receive that data into a numerical variable. It is not restricted to serial data; it can be data coming in from any source using a comm handle.
- For receiving information using FTP communication handles, this command will work only after the Send Communication Handle Command (dir option) to retrieve directory information about the local or a remote FTP server. To retrieve a file from a remote FTP server, use Send Communication Handle Command (get option) to bring the file into the local file system, and then use a File communication handle to access the file locally.
- If this command returns an error code (other than -37 or -39), the communication handle will close and need to be re-opened. (-37 and -39 indicate a timeout during the Receive, which could be a normal part of communications.) Be sure to check for status codes returned by this command, and handle any errors appropriately.
CHAPTER 4: COMMUNICATION COMMANDS

- Set **Endian mode** (Argument 0) to reflect the order that bytes are sent to the controller from the sending device. This information should be in the sending device’s documentation. When **Endian mode** is set to 0 (Big Endian), this command stores the first byte received as the most significant byte. When set to Little Endian (non-zero), it stores the first byte received as the least significant byte. For more information about Big/Little Endian, see the *Using Modbus Devices with Opto 22 Products* technical note (form 2011).

- You may have to experiment with **Endian mode** (Argument 0) to figure out which byte order is right for a given application. If your input values are way off from what you expected, try the other Endian order.

**Dependencies:**
- Must have previously used **Open Outgoing Communication**, or (for TCP communication handles) **Listen for Incoming Communication** and **Accept Incoming Communication** to accept a session initiated by a TCP/IP peer. For details, see “Communication Commands” in the *PAC Control User’s Guide* (form 1700).

- Before using this command, use **Get Number of Characters Waiting** to see if there is a message.

**Status Codes:**

- 0 = Success.
- -6 = Invalid data field. Returned if Number of Bytes is anything other than 1, 2, 4, or 8 bytes.
- -29 = Wrong object type.
- -36 = Invalid command or feature not implemented. A firmware upgrade may be required to use this feature on this type of communication handle.
- -37 = Lock port timeout.
- -39 = Timeout on receive.
- -52 = Invalid connection—not opened. The communication handle may have been closed by a previous command that failed. Check status codes returned on other communication handle commands.
- -58 = No data received. Make sure I/O unit has power.
- -69 = Invalid parameter (null pointer) passed to command. Make sure communication handle is open.
- -76 = At end of file.

**Queue Error:**
- -12 = Invalid table index value. Index was negative or greater than or equal to the table size.

**See Also:**
- “Receive Numeric Table” on page 91
- “Receive Numeric Table Ex” on page 93
- “Receive String” on page 99
- “Receive String Table” on page 102
- “Receive Pointer Table” on page 97
- “Transmit Numeric Table” on page 125
- “Transmit String Table” on page 131
- “Transmit Pointer Table” on page 127
Receive Pointer Table

**Function:** Moves data from the device or file specified in the communication handle into the variables pointed to by a pointer table.

**Typical Use:** Efficient method of data transfer from one entity to another (for example, two SNAP PAC I/O systems), especially when transferring both strings and numbers.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length</td>
<td>Start at Index</td>
<td>Of Table</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
<td>Pointer Table</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
<td></td>
</tr>
</tbody>
</table>

**Argument 3**

<table>
<thead>
<tr>
<th>Argument 3</th>
<th>Argument 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Handle</td>
<td>Put Status in</td>
</tr>
<tr>
<td>Communication Handle</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>PEER_DATA_TABLE</td>
<td>RECV_STATUS</td>
</tr>
</tbody>
</table>

**Action Block Example:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length</td>
<td>Integer 32 Literal</td>
<td>64</td>
</tr>
<tr>
<td>Start at Index</td>
<td>Integer 32 Literal</td>
<td>0</td>
</tr>
<tr>
<td>Of Table</td>
<td>Pointer Table</td>
<td>PEER_DATA_TABLE</td>
</tr>
<tr>
<td>Communication Handle</td>
<td>Communication Handle</td>
<td>UNIT_2</td>
</tr>
<tr>
<td>Put Status in</td>
<td>Integer 32 Variable</td>
<td>RECV_STATUS</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```opto
ReceivePtrTable(Length, Start at Index, Of Table, Communication Handle)
```

RECV_STATUS = ReceivePtrTable(64, 0, PEER_DATA_TABLE, UNIT_2);

This is a function command; it returns one of the status codes listed below.

**Dependencies:**

- Must have previously used Open Outgoing Communication, or (for TCP communication handles) Listen for Incoming Communication and Accept Incoming Communication to accept a session initiated by a TCP/IP peer. For details, see “Communication Commands” in the PAC Control User’s Guide (form 1700).
- Pointers in the table cannot point to another table.
- Before using this command, use Get Number of Characters Waiting to see if there is a message.

**Notes:**

- Make sure that the tables used on both ends of the communication point to the same types and sizes of data. For example, if you transmit a table with pointers to a float, an integer, and a string with width 10, the table on the receiving end must be exactly the same.
- Check errors using the status codes returned by these commands. If you are using a communication handle (like TCP) that buffers data and you have an error, use the Clear Communication Receive Buffer command to make sure the buffer does not fill up.
- For receiving information using FTP communication handles, this command will work only after the Send Communication Handle Command (dir option) to retrieve directory information about the local or a remote FTP server. To retrieve a file from a remote FTP server, use Send Communication Handle Command (get option) to bring the file into the local file system, and then use a File communication handle to access the file locally.
- If this command returns an error code (other than -37 or -39), the communication handle will close and need to be re-opened. (-37 and -39 indicate a timeout during the Receive, which could be a normal part
of communications.) Be sure to check for status codes returned by this command, and handle any errors appropriately.

**Status Codes:**

0 = Success.

-29 = Wrong object type. Pointers in the table must point to strings, integers, or floats.

-36 = Invalid command or feature not implemented. A firmware upgrade may be required to use this feature on this type of communication handle.

-37 = Lock port timeout.

-39 = Timeout on receive.

-52 = Invalid connection—not opened. The communication handle may have been closed by a previous command that failed. Check status codes returned on other communication handle commands.

-58 = No data received. Make sure I/O unit has power.

-69 = Invalid parameter (null pointer). Make sure communication handle is open and pointer points to something.

**Queue Error:**

-12 = Invalid table index value. Index was negative or greater than or equal to the table size.

**See Also:**

"Clear Communication Receive Buffer" on page 69

"Receive String" on page 99

"Receive String Table" on page 102

"Receive Numeric Table" on page 91

"Transmit Numeric Table" on page 125

"Transmit String Table" on page 131

"Transmit Pointer Table" on page 127
Receive String

Communication Action

**Function:**
Gets the first end-of-message (EOM) character-delimited string from the device or file specified in the communication handle.

**Typical Use:**
To parse data that contains EOM-delimited strings.

**Details:**
- All characters up to the first EOM are read or moved to the string. The EOM is discarded. If there is no EOM to be received, the control engine waits for the communication handle’s timeout period for an EOM to arrive. The timeout period for a file communication handle is one second. Most other types of communication handles can have their timeout value adjusted using the “set.TO” option with the Send Communication Handle Command. If no EOM is received within the timeout period, error code -39 is put in the status variable, and as many characters as will fit are copied into the string.

- If the EOM-delimited string is longer than the destination string length, a -23 error is returned and as many characters as fit in the destination string are placed there. To see how many characters were received, use a Get Length command for the destination string. The characters remaining, minus the data just received, may be retrieved by a subsequent call to Receive String.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Put in</td>
<td>String Variable</td>
<td>RECV_MSG</td>
</tr>
<tr>
<td>Communication Handle</td>
<td>Communication Handle</td>
<td>UNIT_2</td>
</tr>
<tr>
<td>Put Status in</td>
<td>Integer 32 Variable</td>
<td>RECV_STATUS</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```
ReceiveString (Put in, Communication Handle)
RECV_STATUS = ReceiveString(RECV_MSG, UNIT_2);
```

This is a function command; it returns one of the status codes listed below.

**Notes:**
- This command is not recommended for receiving binary messages, since EOM characters may occur within the binary message. Use Receive N Characters instead.

- The length of the string variable should be a few characters greater than the longest expected string.

- For more information, see “Communication Commands” in the PAC Control User’s Guide (form 1700).

- When using FTP communication handles, you must first use “Send Communication Handle Command” on page 105 to retrieve the information from the FTP server; then, you can use Receive String to access a local copy of the file.

**Example**

1. Open a communication handle to an FTP server.
2. Use Send Communication Handle Command (with the get option) to retrieve a remote file and store it locally.
3. Close the FTP communications handle.
4. Set the arguments for a new communication handle.
5. Open the new communication handle.
6. Use **Receive String** to access the local file.

```c
nResult = OpenOutgoingCommunication(chFtp);
nResult = SendCommunicationHandleCommand(chFtp, "get:/test.txt,/LocalCopy.txt");
nResult = CloseCommunication(chFtp);
SetCommunicationHandleValue("file:r,LocalCopy.txt", chFile);
nResult = OpenOutgoingCommunication(chFile);
nResult = ReceiveString(sRcv, chFile);
```

Other (non-programmatic) ways to access files are discussed in "Tools for Managing Files," in the **PAC Manager User’s Guide** (form 1704).

- FTP communication handle users of this command may find **Receive String Table** more helpful, especially when more than one file is stored on the FTP server. For an example, see "Communication Commands" in the **PAC Control User’s Guide** (form 1700).

Because data should already be ready to receive following the **Send Communication Handle Command** (dir option), FTP handles do not wait for the timeout period.

- See notes for “**Set End-Of-Message Terminator**” on page 119 for issues related to handling special (often invisible) characters like carriage returns.

- If this command returns an error code (other than -37 or -39), the communication handle will close and need to be re-opened. (-37 and -39 indicate a timeout during the Receive, which could be a normal part of communications.) Be sure to check for status codes returned by this command, and handle any errors appropriately.

- If the response arrives slowly due to low baud rates or high latency, insert a reasonable Delay (mSec) before invoking Receive String. This will prevent excess consumption of chart timeslices.

**Dependencies:**
- Must have previously used **Open Outgoing Communication**, or (for TCP communication handles) **Accept Incoming Communication** to accept a session initiated by a TCP/IP peer.
- After using **Open Outgoing Communication**, use the **Get End-Of-Message Terminator** command to change the EOM from the default of 13 (carriage return) if necessary.
- Before using this command, use **Get Number of Characters Waiting** to see if there is a message.

**Status Codes:**

- **0** = Success
- **-23** = Destination string too short.
- **-36** = Invalid command or feature not implemented. A firmware upgrade may be required to use this feature on this type of communication handle.
- **-37** = Lock port timeout.
- **-39** = Timeout on receive.
- **-44** = String too short.
- **-52** = Invalid connection—not opened. The communication handle may have been closed by a previous command that failed. Check status codes returned on other communication handle commands.
- **-57** = String not found. No EOM found.
- **-58** = No data received. Make sure I/O unit has power.
- **-69** = Invalid parameter (null pointer) passed to command. Make sure communication handle is open.
- **-443** = Could not receive on socket. Often an indication that the connection was reset by the other device.

**See Also:**
- “**Get End-Of-Message Terminator**” on page 73
- “**Open Outgoing Communication**” on page 85
“Receive Numeric Table” on page 91
“Receive String Table” on page 102
“Send Communication Handle Command” on page 105
“Set End-Of-Message Terminator” on page 119
“Transmit Numeric Table” on page 125
“Transmit String” on page 129
Receive String Table

Communication Action

Function: Moves a string or specific number of EOM-delimited elements from the device or file specified in the communication handle to a string table.

Typical Use: Efficient method of reading a delimited file into a table.

Details: All characters up to the first EOM are read or moved to the string table element. The EOM is discarded. If there is no EOM to be received, the control engine waits for the communication handle’s timeout period for an EOM to arrive. The timeout period for a file communication handle is one second. Most other types of communication handles can have their timeout value adjusted using the "set.TO" option with the Send Communication Handle Command. If no EOM is received within the timeout period, error code -39 is put in the status variable, and as many characters as will fit are copied into the string table element.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length</td>
<td>Start at Index</td>
<td>Of Table</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
<td>String Table</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
<td>String Table</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Argument 3</th>
<th>Argument 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Handle</td>
<td>Put Status in</td>
</tr>
<tr>
<td>Communication Handle</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

Action Block Example:

Receive String

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length</td>
<td>Integer 32 Literal</td>
<td>6</td>
</tr>
<tr>
<td>Start at Index</td>
<td>Integer 32 Literal</td>
<td>0</td>
</tr>
<tr>
<td>Of Table</td>
<td>String Table</td>
<td>PEER_DATA_TABLE</td>
</tr>
<tr>
<td>Communication Handle</td>
<td>Communication Handle</td>
<td>UNIT_2</td>
</tr>
<tr>
<td>Put Status in</td>
<td>Integer 32 Variable</td>
<td>RECV_STATUS</td>
</tr>
</tbody>
</table>

OptoScript Example: ReceiveStrTable(Length, Start at Index, Of Table, Communication Handle)

RECV_STATUS = ReceiveStrTable(6, 0, PEER_DATA_TABLE, UNIT_2);

This is a function command; it returns one of the status codes listed below.

Notes:

- In the example above, assuming the width of String Table PEER_DATA_TABLE is 5, the EOM character has been set to 44 (a comma), and this is the data coming in via Communication Handle UNIT_2: Figs, Watermelon, Plums, Bananas, the resulting PEER_DATA_TABLE will contain:

| Figs | Watermelon | Plums | Bananas |

- See notes for "Set End-Of-Message Terminator" on page 119 for issues related to handling special (often invisible) characters like carriage returns.
• The Length specifies the number of string table elements to be filled. Use -1 to receive all data available.
• If the incoming data does not include any EOM (End-Of-Message) characters, each string element will be filled and the data will wrap to the next element for the number of elements specified by the Length. (Each string table has a certain user-specified width, up to 1024 characters.)
• For data which does include EOM characters, this command’s behavior is similar to the Receive String command, where all characters up to the first EOM are read or moved to each string element. The EOMs are discarded.
• The default EOM is ASCII 13, the carriage return character. After the communication handle has been opened, use Set End-Of-Message Terminator to change the EOM character.
• For receiving information using FTP communication handles, this command will work only after the Send Communication Handle Command (dir option) to retrieve directory information about the local or a remote FTP server. To retrieve a file from a remote FTP server, use Send Communication Handle Command (get option) to bring the file into the local file system, and then use a File communication handle to access the file locally. For an example, see “Communication Commands” in the PAC Control User's Guide (form 1700).

Because data should already be ready to receive following the Send Communication Handle Command (dir option), FTP handles do not wait for the timeout period.
• If this command returns an error code (other than -37 or -39), the communication handle will close and need to be re-opened. (-37 and -39 indicate a timeout during the Receive, which could be a normal part of communications.) Be sure to check for status codes returned by this command, and handle any errors appropriately.

Dependencies:
• Must have previously used Open Outgoing Communication to establish a session, or (for TCP communication handles) Listen for Incoming Communication and Accept Incoming Communication to accept a session initiated by a TCP/IP peer. For details, see “Communication Commands” in the PAC Control User’s Guide (form 1700).
• Before using this command, use Get Number of Characters Waiting to see if there is a message.

Status Codes:
0 = Success.
-3 = Buffer overrun or invalid length. Length (Argument 0) is greater than the number of elements in the destination table.
-25 = Port or object is not locked. The device you’re receiving data from has closed the connection, so the port cannot be accessed (locked).
-12 = Invalid table index value. Index was negative or greater than or equal to the table size.
-36 = Invalid command or feature not implemented. A firmware upgrade may be required to use this feature on this type of communication handle.
-37 = Lock port timeout.
-39 = Timeout on receive.
-52 = Invalid connection—not opened. The communication handle may have been closed by a previous command that failed. Check status codes returned on other communication handle commands.
-58 = No data received. Make sure I/O unit has power.
-59 = Could not receive data. Command may not apply to the type of communication handle used.
-69 = Invalid parameter (null pointer). Make sure communication handle is open.
See Also:

“Receive String” on page 99
“Receive Numeric Table” on page 91
“Receive Pointer Table” on page 97
“Send Communication Handle Command” on page 105
“Set End-Of-Message Terminator” on page 119

“Transmit Numeric Table” on page 125
“Transmit String Table” on page 131
“Transmit Pointer Table” on page 127
“Transfer N Characters” on page 120
Send Communication Handle Command

**Function:**
To send a command that accomplishes a specific purpose for the type of communication handle you are using.

**Typical Use:**
To work with files on a SNAP PAC controller or brain to change or specify a remote filename when using an FTP communication handle.

You can also use this command to change timeout values for communication handles. (See "Notes:" for default timeout values.)

**Details:**
The following commands are available for the communication handles shown. Before using any of these commands, make sure first to use Open Outgoing Communication to open the handle.

<table>
<thead>
<tr>
<th>Comm Handle Type</th>
<th>Commands Available</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>file</td>
<td>delete</td>
<td>Removes the file named in the communication handle and closes the handle. Before using this command, use Open Outgoing Communication first to open the handle.</td>
</tr>
<tr>
<td></td>
<td>getpos</td>
<td>Returns an integer that indicates the current position in the file.</td>
</tr>
<tr>
<td></td>
<td>setpos:position</td>
<td>Jumps to the specified position within the file.</td>
</tr>
<tr>
<td></td>
<td>find:mystring</td>
<td>(Strings only) Searches for the string within the file and returns its location as an offset from the current position in the file. File must have been opened in r (read) mode.</td>
</tr>
<tr>
<td>ser</td>
<td>get.to</td>
<td>Retrieves the communication timeout value for transmitting and receiving data, rounded to the nearest integer. A timeout value of 0.5 is rounded up to 1. A value of 0.4 is rounded down to 0 (zero).</td>
</tr>
<tr>
<td></td>
<td>set.to:seconds</td>
<td>Sets the communication timeout value for transmitting and receiving data, which you must specify in seconds. For example, use 0.5 to set the timeout to 1/2 second.</td>
</tr>
</tbody>
</table>
### CHAPTER 4: COMMUNICATION COMMANDS

<table>
<thead>
<tr>
<th>Comm Handle Type</th>
<th>Commands Available</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ftp (See &quot;tcp&quot; below for more)</td>
<td>appe:local filename, remote filename</td>
<td>Similar to the send command except that it adds, or appends, the data to the data that already exists in the remote filename.</td>
</tr>
<tr>
<td></td>
<td>cd:directory to go to</td>
<td>Changes the current working directory to the specified directory.</td>
</tr>
<tr>
<td></td>
<td>delete</td>
<td>Removes the file named in the dest: command (below) on the remote ftp server. Before using this command, use Open Outgoing Communication first to open the handle, then use the dest: command, then use this command.</td>
</tr>
<tr>
<td></td>
<td>dest:filename</td>
<td>Used for appending data to an existing file. Specifies the destination (the name of the remote file) on the device (specified in the communication handle) that will be used with a Transfer or Transmit communication handle command, or with the delete command (above).</td>
</tr>
<tr>
<td></td>
<td>dir:optional directory name, optional table name</td>
<td>When used with a directory name, retrieves a directory listing for the specified directory name (or the root, if the directory name is omitted). Returns an integer that indicates the number of entries retrieved. Use commands like Receive String and Receive String Table to read in the listings. When used with a table name, retrieves all the directory listings and inserts them into the provided table. Use this option when the directory has a large number of files. If successful, returns 0 (zero). Note that you do not use the Receive String or Receive String Table command when using this option because the data is stored directly in the table. If the directory name is omitted, a comma (,) must precede the table name; for example: dir:,mytable</td>
</tr>
<tr>
<td></td>
<td>get:remote filename, local filename</td>
<td>Retrieves the specified remote file and places it locally under the name indicated. If the local filename already exists, the file is overwritten.</td>
</tr>
<tr>
<td></td>
<td>mkdir:directory name</td>
<td>Creates (makes) the specified directory. To create multiple layers of directories, depending on the FTP server you’re connected to, you may need to create one layer at a time. For example: mkdir:aaa followed by a second call: mkdir:aaa\bbb and so forth. Depending on the server, you might use a forward slash instead of a backslash.</td>
</tr>
<tr>
<td></td>
<td>rmdir:directory name</td>
<td>Deletes (removes) the specified directory. The directory must be empty for this command to work. (Use the delete command to delete each file in the directory before using rmdir to remove the directory.)</td>
</tr>
<tr>
<td></td>
<td>send:local filename, remote filename</td>
<td>Sends a whole file to the device specified in the communication handle, where it will have the name indicated. If the remote filename already exists, the file is overwritten.</td>
</tr>
</tbody>
</table>
### CHAPTER 4: COMMUNICATION COMMANDS

<table>
<thead>
<tr>
<th>Comm Handle Type</th>
<th>Commands Available</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ftp</strong> (See &quot;tcp&quot; below for more)</td>
<td>**appe:**local filename, remote filename</td>
<td>Similar to the send command except that it adds, or appends, the data to the data that already exists in the remote filename.</td>
</tr>
<tr>
<td></td>
<td>**cd:**directory to go to</td>
<td>Changes the current working directory to the specified directory.</td>
</tr>
<tr>
<td></td>
<td><strong>delete</strong></td>
<td>Removes the file named in the <em>dest:</em> command (below) on the remote ftp server. Before using this command, use Open Outgoing Communication first to open the handle, then use the <em>dest:</em> command, then use this command.</td>
</tr>
<tr>
<td></td>
<td>**dest:**filename</td>
<td>Used for appending data to an existing file. Specifies the destination (the name of the remote file) on the device (specified in the communication handle) that will be used with a Transfer or Transmit communication handle command, or with the delete command (above).</td>
</tr>
<tr>
<td></td>
<td>**dir:**optional directory name, optional table name</td>
<td><strong>dir:</strong> When used with a directory name, retrieves a directory listing for the specified directory name (or the root, if the directory name is omitted). Returns an integer that indicates the number of entries retrieved. Use commands like Receive String and Receive String Table to read in the listings. When used with a table name, retrieves all the directory listings and inserts them into the provided table. Use this option when the directory has a large number of files. If successful, returns 0 (zero). Note that you do not use the Receive String or Receive String Table command when using this option because the data is stored directly in the table. If the directory name is omitted, a comma (,) must precede the table name; for example: dir:,mytable</td>
</tr>
<tr>
<td></td>
<td>**mkdir:**directory name</td>
<td>Creates (makes) the specified directory. To create multiple layers of directories, depending on the FTP server you’re connected to, you may need to create one layer at a time. For example: mkdir:aaa followed by a second call: mkdir:aaa\bbb and so forth. Depending on the server, you might use a forward slash instead of a backslash.</td>
</tr>
<tr>
<td></td>
<td>**rm:**directory name</td>
<td>Deletes (removes) the specified directory. The directory must be empty for this command to work. (Use the <strong>delete</strong> command to delete each file in the directory before using <strong>rm</strong> to remove the directory.)</td>
</tr>
<tr>
<td></td>
<td>**send:**local filename, remote filename</td>
<td>Sends a whole file to the device specified in the communication handle, where it will have the name indicated. If the remote filename already exists, the file is overwritten.</td>
</tr>
</tbody>
</table>
### CHAPTER 4: COMMUNICATION COMMANDS

<table>
<thead>
<tr>
<th>Comm Handle Type</th>
<th>Commands Available</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ftp (See “tcp” below for more)</td>
<td>appe:local filename, remote filename</td>
<td>Similar to the send command except that it adds, or appends, the data to the data that already exists in the remote filename.</td>
</tr>
<tr>
<td></td>
<td>cd:directory to go to</td>
<td>Changes the current working directory to the specified directory.</td>
</tr>
<tr>
<td></td>
<td>delete</td>
<td>Removes the file named in the dest: command (below) on the remote ftp server. Before using this command, use Open Outgoing Communication first to open the handle, then use the dest: command, then use this command.</td>
</tr>
<tr>
<td></td>
<td>dest:filename</td>
<td>Used for appending data to an existing file. Specifies the destination (the name of the remote file) on the device (specified in the communication handle) that will be used with a Transfer or Transmit communication handle command, or with the delete command (above).</td>
</tr>
<tr>
<td></td>
<td>dir:optional directory name, optional table name</td>
<td>When used with a directory name, retrieves a directory listing for the specified directory name (or the root, if the directory name is omitted). Returns an integer that indicates the number of entries retrieved. Use commands like Receive String and Receive String Table to read in the listings. When used with a table name, retrieves all the directory listings and inserts them into the provided table. Use this option when the directory has a large number of files. If successful, returns 0 (zero). Note that you do not use the Receive String or Receive String Table command when using this option because the data is stored directly in the table. If the directory name is omitted, a comma (,) must precede the table name; for example: dir:,mytable</td>
</tr>
<tr>
<td></td>
<td>get:remote filename, local filename</td>
<td>Retrieves the specified remote file and places it locally under the name indicated. If the local filename already exists, the file is overwritten.</td>
</tr>
<tr>
<td></td>
<td>mkdir:directory name</td>
<td>Creates (makes) the specified directory. To create multiple layers of directories, depending on the FTP server you’re connected to, you may need to create one layer at a time. For example: mkdir:aaa followed by a second call: mkdir:aaa\bbb and so forth. Depending on the server, you might use a forward slash instead of a backslash.</td>
</tr>
<tr>
<td></td>
<td>rmdir:directory name</td>
<td>Deletes (removes) the specified directory. The directory must be empty for this command to work. (Use the delete command to delete each file in the directory before using rmdir to remove the directory.)</td>
</tr>
<tr>
<td></td>
<td>send:local filename, remote filename</td>
<td>Sends a whole file to the device specified in the communication handle, where it will have the name indicated. If the remote filename already exists, the file is overwritten.</td>
</tr>
</tbody>
</table>
## Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Handle</td>
<td>Command</td>
<td>Put Status in</td>
</tr>
<tr>
<td>Communication Handle</td>
<td>String Literal</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

### Comm Handle Type

<table>
<thead>
<tr>
<th>Commands Available</th>
<th>Description</th>
</tr>
</thead>
</table>
| get.src | When accepting incoming connections, it is sometimes necessary to determine the IP address from which the connection originated. To accomplish this you would do the following in OptoScript: 

```optoscript
Result = SendCommunicationHandleCommand(chComHandle, "get.src" );
```

Result would be set to the address of the peer. For instance, if the connection originated from 192.168.1.12, the value of Result, in hex, would be:

```
0xC0A8010C
(C0 = 192, A8 = 168, 01 = 1, 0C = 12)
```

| get.srcport | When accepting incoming connections, it is sometimes necessary to determine the IP port from which the connection originated. To accomplish this you would do the following in OptoScript:

```optoscript
Result = SendCommunicationHandleCommand(chComHandle, "get.srcport" );
```

Result would be set to the incoming port of the peer. |

| get.to | Retrieves the communication timeout value for receiving data, rounded to the nearest integer. A timeout value of 0.5 is rounded up to 1. A value of 0.4 is rounded down to 0 (zero). |

| set.to:seconds | Sets the communication timeout value for receiving data, which you must specify in seconds. For example, use 0.5 to set the timeout to 1/2 second. |

| set.to.open.i:n.n | Sets the time to wait for an incoming connection to complete. To do this, use a Listen for Incoming Communication command, and then an Accept Incoming Communication command to open the connection. Unlike most communication handle commands, send the set.to.open command before establishing the connection, since it determines how long the Accept Incoming Communication command should wait before giving up. n.n means the timeout is specified with a decimal number, rather than specifying milliseconds with an integer. If you want 500 mSec, use: set.to.open.i:0.5 |

| set.to.open.o:n.n | Sets the time to wait for an outgoing connection to be established. To do this, use an Open Outgoing Communication to open the connection. Unlike most communication handle commands, send the set.to.open command before establishing the connection, since it determines how long the Open Outgoing Communication command should wait before giving up. n.n means the timeout is specified with a decimal number, rather than specifying milliseconds with an integer. If you want 500 mSec, use: set.to.open.o:0.5 |
### Action Block

**Example:**

**Send Communication Handle Command**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Handle</td>
<td>Communication Handle</td>
<td>Log_File</td>
</tr>
<tr>
<td>Command</td>
<td>String Literal</td>
<td>delete</td>
</tr>
<tr>
<td>Put Status in</td>
<td>Integer 32 Variable</td>
<td>Status_Variable</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```opto
SendCommunicationHandleCommand(Communication Handle, Command)
```

Status_Variable = SendCommunicationHandleCommand(Log_File, "delete");

This is a function command; it returns one of the status codes listed below. Quotes are required for strings in OptoScript.

**Notes:**

- For information on communication handles, see “Communication Commands” in the PAC Control User’s Guide (form 1700).
- If this command returns an error code, the communication handle will close and you’ll need to re-open it. Be sure to check for status codes returned by this command and handle errors appropriately.
- Default timeout values for communication handles are:
  - TCP: 10 seconds
  - FTP: 30 seconds
  - Serial: 1 second
  - File: 1 second

**Status Codes:**

0 = Success.

-11 = Could not send data.

-28 = Object not found. When used with ftp dir:optional table name, indicates the table name was not found. Verify that the table name exists and that its name is spelled correctly.

-36 = Feature not implemented (syntax error in command, or command not supported with the type of communication handle in use).

-44 = String too short. (File communication handle) String looked for was empty.

-46 = Invalid string. Check format of command (missing colon, and so forth).

-52 = Invalid connection—not opened. The communication handle may have been closed by a previous command that failed. Check status codes returned on other communication handle commands.

-57 = String not found.

-58 = No data received. If using a file communication handle find, make sure file was opened in r (read) mode.

-59 = Could not receive data. Make sure you don’t have any extra spaces or tabs in the command.

-74 = Invalid filename. Check length and special characters.

-76 = End of file error. (File communication handle) Didn’t find the string you were looking for.

-408 = Error during file access. (File or FTP communication handle) Possible cause: file is in use or read-only, or error accessing directory.

-446 = FTP: Login failed. Check user name, password, and maximum number of logins on server.

-449 = FTP: Error while setting local port number that incoming data connections should use.

-497 = The remote filename used for an ftp get doesn’t exist.
See Also:

“Open Outgoing Communication” on page 85
“Get Communication Handle Value” on page 72
“Close Communication” on page 70
Send Email

Communication Action

**Function:** Sends a text-only email via SMTP.

**Typical Use:** To create a text-only email and send it to recipients via SMTP.

**Details:**
- This command has many uses including the following:
  - Send an email in case of an alarm condition.
  - Send a daily status report.
  - Have a critical system send hourly status emails; if no email arrives after an hour, it means something is wrong.
- In order for this command to work, you must configure the SNAP PAC controller or groov EPIC processor with the correct DNS and Gateway addresses and proper root certificates. For instructions, see “Sending an Email” in the PAC Control User’s Guide (form 1700).
- You provide information (like email addresses and the message body) through string tables. For each of the string tables, make sure there are enough elements of adequate length for the data you want to enter. See the OptoScript example below.
- It is recommended that you use OptoScript to construct the email. This allows you to see the entire email at the same time. See the OptoScript Example below.
- You can change the transmit, receive, or connect timeout values, as well as indicate whether the control engine should ignore certain SSL errors. For instructions, see “Sending an Email with Attachments Example” in the PAC Control User’s Guide (form 1700).

**Arguments:**
- **Argument 0**
  - **Server Information**
    - String Table
  - **Argument 1**
    - **Recipients**
      - String Table
  - **Argument 2**
    - **Message Body**
      - String Table
  - **Argument 3**
    - **Put Result in**
      - Integer 32 Variable

**Action Block Example:**

```
ArgStr nResult = SendEmail(arrstrServer, arrstrRecipients, arrstrBody);
```

**OptoScript Example:**

```
SendEmail(Server Information, Recipients, Message Body)
```

This is a function command; it returns a zero (0) on success or an error code when it fails. The returned value can be consumed by a variable (as shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

**Server Information** (Argument 0) must have the entries in the order shown in the following example. (If the table contains more elements, they will be ignored.)

```
arrstrServer[0] = "myaccount@speedmail.com"; // User Account
arrstrServer[1] = "mypassword"; // Password
arrstrServer[3] = "587"; // Port#
```
**Recipients:** Argument 1 List the email address for each recipient.

```
arrstrRecipients[0] = "xyz@mymail.com";  // Recipient list
arrstrRecipients[1] = "abc@yourmail.com";
arrstrRecipients[2] = "";                    //This blank ends the
recipient list
arrstrRecipients[3] = "johndoe@hismail.com"; //This recipient will be
 ignored
```

**Message Body** (Argument 2) contains the body of the email. Element zero is always the subject line. The email body starts with element one, and continues to the first empty element or the end of the table, whichever comes first. Each line is entered as a separate string. However, they will be concatenated in the body of the email. Note that a blank line is not the same as an empty element.

```
arrstrBody[0]   = "Email From a Controller";  // Subject line
arrstrBody[1]   = "Hello:"+CRLF+CRLF;         // Body starts here
arrstrBody[2]   = CRLF;                       // Could have been combined
above
arrstrBody[3]   = "This is an example of an email that can be sent from a
PAC ";
arrstrBody[4]   = "controller. Even though these lines are separate
strings, ";
arrstrBody[5]   = "they will be concatenated in the body of the
email."+CRLF+CRLF;
arrstrBody[6]   = "The pair of CR/LFs above create a blank line for the
start ";
arrstrBody[7]   = "of a new paragraph.";
arrstrBody[8]   = CRLF+CRLF;
arrstrBody[10]  = "SMTP-Controller";
end
arrstrBody[12]  = "This is not included in the body.";
```

**Notes:**
- If result = 0, the email was sent successfully.
- If result < 0, there was an error executing this command.
- If multiple emails with the similar subject and body text are sent through the same email account, the emails may be flagged as SPAM by the email service provider and not be delivered. To avoid this, you may need to add code to the subject and body text that changes the text dynamically with each new email.
- Make sure all server information table elements are filled in and that the recipients list contains at least one valid entry.

**Status Codes:**

0 = Success. The email was sent successfully.

-11 = Could not send data. There was an error sending to the mail server.

**NOTE:** If you have firmware R9.1b, -11 could also indicate that a NACK was received. See -43 below.

-20 = Resource busy. May be in use by another user or another application.

-34 = Invalid I/O command or invalid memory location.

-36 = Invalid command. This error may be returned if you are using PAC Sim. Send Email commands are not supported in PAC Sim.

-38 = Timeout on send.
-39 = Timeout on Receive.
-43 = Received NACK (Negative Acknowledgment). The mail server returned an error (other than a 200- or 300-series response).
-50 = Open connection timeout. Could not establish connection within the timeout period.
-58 = No data received. May have timed out if no response in 10 seconds. Check I/O unit power.
-70 = Not enough data supplied. Check Server Information table elements. Make sure all server information table elements are filled in and that the recipients list contains at least one valid entry.
-443 = Could not receive on socket.
-450 = DNS could not resolve host name to an IP address.
-451 = SMTP login failed.
-454 = Cannot connect to the DNS server. Check the gateway and DNS addresses and configuration.
-2000 = SSL: Bad certificate
-2001 = SSL: Certificate revoked
-2002 = SSL: Certificate expired
-2103 = SSL: Handshake failed due to an unmatched certificate.
-2104 = SSL: Handshake failed due to invalid or unverifiable certificate.
-2105 = SSL: Unspecified asynchronous platform error.
-2106 = SSL: SSL session is not open.
-13019 = An argument in a string is incorrect.

See Also:  "Send Email with Attachments" on page 115
Send Email with Attachments

Communication Action

Function: To send an email with text and one or more attachments via SMTP.

Typical Use: This command is similar to Send Email, except that along with the text you can also attach one or more files such as log files, status reports, images, and so on.

Details:
- An example use might be to send a data log file along with the email. The file you want to attach must exist on the controller’s file system, (RAM, flash, or SD card). For more information, see the OptoScript example below.
- In order for this command to work, you must configure the SNAP PAC controller or groov EPIC processor with the correct DNS and Gateway addresses and proper root certificates. For instructions, see “Sending an Email” in the PAC Control User’s Guide (form 1700).
- You provide information (like email addresses and the message body) through string tables. For each of the string tables, make sure there are enough elements of adequate length for the data you want to enter. See the OptoScript example below.
- It is recommended that you use OptoScript to construct the email. This allows you to see the entire email at the same time. See the OptoScript Example below.
- You can change the transmit, receive, or connect timeout values, as well as indicate whether the control engine should ignore certain SSL errors. For instructions, see “Sending an Email with Attachments Example” in the PAC Control User’s Guide (form 1700).

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server Information</td>
<td>Recipients</td>
<td>Message Body</td>
</tr>
<tr>
<td>String Table</td>
<td>String Table</td>
<td>String Table</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Argument 3</th>
<th>Argument 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attachment File Names</td>
<td>Put Result in</td>
</tr>
<tr>
<td>String Table</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

Action Block Example:

```
Send Email with Attachments

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server Information</td>
<td>String Table</td>
<td>arrstrServer</td>
</tr>
<tr>
<td>Recipients</td>
<td>String Table</td>
<td>arrstrRecipients</td>
</tr>
<tr>
<td>Message Body</td>
<td>String Table</td>
<td>arrstrBody</td>
</tr>
<tr>
<td>Attachment File Names</td>
<td>String Table</td>
<td>arrstrAttach</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Integer 32 Variable</td>
<td>nResult</td>
</tr>
</tbody>
</table>
```

OptoScript Example:

```
SendEmailWithAttachments (Server Information, Recipients, Message Body, Attachment File Names)
nResult = SendEmailWithAttachments(arrstrServer, arrstrRecipients, arrstrBody, arrstrAttach);
```

This is a function command; it returns the number of attachments that were sent successfully. The returned value can be consumed by a variable (as shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

Server Information (Argument 0) must have the entries in the order shown in the following example. (If the table contains more elements, they will be ignored.)

```
arrstrServer[0] = "myaccount@speedmail.com"; // User Account
```
CHAPTER 4: COMMUNICATION COMMANDS

```c
arrstrServer[1] = "mypassword"; // Password
arrstrServer[3] = "587"; // Port#
```

**Recipients:** In Argument 1 list the email address for each recipient.
```c
arrstrRecipients[0] = "xyz@mymail.com"; // Recipient list
arrstrRecipients[1] = "abc@yourmail.com";
arrstrRecipients[2] = ""; //This blank ends the recipient list
arrstrRecipients[3] = "johndoe@hismail.com"; //This recipient will be ignored
```

**Message Body** (Argument 2) contains the body of the email. Element zero is always the subject line. The email body starts with element one, and continues to the first empty element or the end of the table, whichever comes first. Each line is entered as a separate string. However, they will be concatenated in the body of the email. Note that a blank line is not the same as an empty element.
```c
arrstrBody[0] = "Opto Email Example"; // Subject line
arrstrBody[1] = "Hello:"+CRLF+CRLF; // The email body starts here
arrstrBody[3] = "This is an example of an email that can be sent from a PAC ";
arrstrBody[7] = "Opto Controller";
arrstrBody[8] = ""; // This blank denotes end of body
arrstrBody[9] = "This is not included in the body.";
```

**Attachment File Names** (Argument 3) specified in the attachments table must exist on the controller's file system, (RAM, flash, or SD card), and must include the full directory specification. For example, if a file is in the root directory, use just the filename. However, if it is in the temp directory of the SD card, you must put /sdcard0/temp/ in front of the filename. Any kind of file may be attached, so long as there is room in the file system. However, be cautious about file size, many ISPs still have a 10 MB attachment limit.
```c
arrstrAttach[0] = "OptoLogo Color.jpg"; // List of files to attach
arrstrAttach[1] = "OptoLogo BW.jpg";
arrstrAttach[2] = "SMTP.zip"
arrstrAttach[3] = ""; // This blank ends the attachment list
arrstrAttach[4] = "Attachment.jpg"; // This attachment will be ignored
```

**Notes:**
- If result > 0, [result] indicates the number of attachments that were sent successfully.
- If result = 0, the text of the email was sent successfully, but no attachments were sent.
- If result < 0, there was an error executing this command.
- If multiple emails with the similar subject and body text are sent through the same email account, the emails may be flagged as SPAM by the email service provider and not be delivered. To avoid this, you may need to add code to the subject and body text that changes the text dynamically with each new email.
- Make sure all server information table elements are filled in and that the recipients list contains at least one valid entry.
- SNAP PAC Simulator should return -36 (unsupported in sim) for SendEmail commands.

**Status Codes:**
If Status Code > 0, it indicates the number of attachments that were sent successfully.
0 = Success sending email with no attachments. This might happen if the attachment table element 0 is empty.

-11 = Could not send data. There was an error sending to the mail server.

NOTE: If you have firmware R9.1b, -11 could also indicate that a NACK was received. See -43 below.

-20 = Resource busy. May be in use by another user or another application.

-34 = Invalid I/O command or invalid memory location.

-36 = Invalid command. This error may be returned if you are using PAC Sim. Send Email commands are not supported in PAC Sim.

-38 = Timeout on send.

-39 = Receive timeout.

-43 = Received NACK (Negative Acknowledgment). The mail server returned an error (other than a 200- or 300-series response).

-50 = Open connection timeout. Could not establish connection within the timeout period.

-70 = Not enough data supplied. Check Server Information table elements. Make sure all server information table elements are filled in and that the recipients list contains at least one valid entry.

-407 = File not found. Make sure any files specified in the attachments table exist on the controller’s file system, (RAM, flash, or SD card) including the full directory specification.

-443 = Could not receive on socket.

-450 = DNS could not resolve host name to an IP address.

-451 = SMTP login failed.

-454 = DNS could not connect.

-2000 = SSL: Bad certificate

-2001 = SSL: Certificate revoked

-2002 = SSL: Certificate expired

-2103 = SSL: Handshake failed due to an unmatched certificate.

-2104 = SSL: Handshake failed due to invalid or unverifiable certificate.

-2105 = SSL: Unspecified asynchronous platform error.

-2106 = SSL: SSL session is not open.

-13019 = An argument in a string is bad.

See Also: “Send Email” on page 112
Set Communication Handle Value

Communication Action

Function: Sends a string to change the current value of the communication handle.

Typical Use: To set the current communication arguments for a communication handle before using an Open Outgoing Communication command.

Arguments:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>From</td>
<td>Communication Handle</td>
<td>tcp:10.22.30.40:22005</td>
</tr>
<tr>
<td>To</td>
<td>Communication Handle</td>
<td>COMM_Y</td>
</tr>
</tbody>
</table>

Example: OptoScript

SetCommunicationHandleValue("tcp:10.22.30.40:22005", COMM_Y);

This is a procedure command; it does not return a value. Quotes are required for strings in OptoScript.

Notes:

- When using a SNAP PAC controller, Set Communication Handle Value can be used for either Ethernet (TCP or UDP) or serial communication (using a serial port on the controller) communication handles. Note: SNAP serial communication modules (SNAP-SCM) use TCP comm handles.
- When using SoftPAC, Set Communication Handle Value cannot be used with a computer’s serial ports or USB serial ports. (SoftPAC doesn’t support PC serial or USB ports.) However, the command can still be used with Ethernet (TCP and UDP) and SNAP-SCM comm handles.
- The example shown above is for outgoing communication using a TCP communication handle. For details about communication handle types and values, see “Communication Commands” in the PAC Control User’s Guide (form 1700).
- If you use a string literal in To (Argument 0), make sure the communication handle type (for example, tcp, ftp, file) is in lowercase letters.
- Do not use this command on a COM handle that is already open. If you do, an “Already Open” (-47) error will be placed in the queue. Before using this command, use Communication Open? to determine whether the handle is already open. If the handle is open, close the handle before changing the value.

Status Codes:

-47 = This command must be called while the communication handle is closed; these settings will take effect during the open.

See Also:
- "Get Communication Handle Value" on page 72
- "Open Outgoing Communication" on page 85
- “Communication Open?” on page 71
Set End-Of-Message Terminator

Communication Action

**Function:** To set the end-of-message (EOM) character for a specific communication handle.

**Typical Use:** To parse delimited strings when using one of the following commands: Receive String, Receive String Table, Transmit/Receive String (on the Receive only), Transmit String Table.

**Details:**
- The EOM character is **not** appended to the transmitted string for the commands Transmit String or Transmit/Receive String. Therefore, before calling those commands, you may first want to call Get End-Of-Message Terminator, and then Append Character to String.
- The communication handle must already be opened for this command to take effect. Use the command Open Outgoing Communication to open the handle.
- The character is represented by an ASCII value. (See the ASCII table under “String Commands” in the PAC Control User’s Guide (form 1700). For example, a space is a character 32 and a “1” is a character 49. Commonly used delimiters include a comma (character 44) and a colon (character 58). If using OptoScript, you may put the character you want to use in single quotes, as shown in the OptoScript example below.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Communication Handle</strong></td>
<td>Communication Handle</td>
<td>PAC_A</td>
</tr>
<tr>
<td><strong>To Character</strong></td>
<td>Integer 32 Variable</td>
<td>EOM_Term</td>
</tr>
</tbody>
</table>

**Action Block Example:**

```
Set End-Of-Message Terminator
```

**OptoScript Example:**

```
SetEndOfMessageTerminator(Communication Handle, To Character)
```

SetEndOfMessageTerminator(PAC_A, ‘:\’);

This is a procedure command; it does not return a value.

**Notes:**
- While debugging your string-parsing strategy, consider using PAC Control’s debugger menu option View > Hex String Display so you will be able to see all your characters, including special formatting characters which may be invisible and are often confusing. For example the CR/LF combination mentioned in the next note will appear in hex as: 0D 0A.
- When you create a text file and finish a line with the Enter key, be aware that most text editors put two invisible characters in the file, ASCII 13 (carriage return or CR) followed by 10 (line feed or LF). When parsing a text file with these CR/LF characters, keep in mind that the end of message terminator is only a single character.
- If this command returns an error code, the communication handle will close and need to be re-opened. Be sure to check for status codes returned by this command, and handle any errors appropriately.

**Queue Errors:**

-52 = Invalid connection—not opened. The communication handle may have been closed by a previous command that failed. Check status codes returned on other communication handle commands.

**See Also:**

- “Get End-Of-Message Terminator” on page 73
- “Open Outgoing Communication” on page 85
- “Receive String Table” on page 102
- “Transmit String Table” on page 131
**Transfer N Characters**

**Communication Action**

**Function:** To send data from one communication handle to another.

**Typical Uses:** To store data from a serial module to a log file, or to take data from a log file and send it via FTP to another device on the network.

**Details:**
- This command essentially receives data on the source communication handle (Argument 1) and transmits it on the destination handle (Argument 0), without any processing. When you use this command, the data sent is not limited to the size of a string. This command is also faster than receiving data, storing it in a variable, and then transmitting it.
- If you need to process the data from the source handle before sending it to the destination handle, do not use this command. Instead, create a variable to receive the data from the source handle, process the data using any of the string commands, and then transmit it to the destination handle.
- To use this command, first use Open Outgoing Communication to both communication handles.
- To transfer as many characters as are available, either enter -1 in `Num Chars` (Argument 2), or use Get Number of Characters Waiting to determine how many bytes of data to transfer, and then enter that number in `Num Chars`.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
<th>Argument 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Destination Handle</td>
<td>Source Handle</td>
<td>Num. Chars</td>
<td>Put Status in</td>
</tr>
<tr>
<td>Communication Handle</td>
<td>Communication Handle</td>
<td>Integer 32 Literal</td>
<td>Float Variable</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

**Action Block Example:**

```plaintext
TransferNChars(Destination Handle, Source Handle, Num Chars)
```

**OptoScript Example:**

```plaintext
ERROR_CODE = TransferNChars(PAC_3, PAC_4, 3000);
```

This is a function command; it returns a zero (indicating success) or an error (indicating failure). The returned value can be consumed by a variable (as shown in the example) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the *PAC Control User’s Guide* (form 1700).

**Notes:**
- The two communication handles must be unique.
- For receiving information using FTP communication handles, this command will work only after the Send Communication Handle Command (dir option) to retrieve directory information about the local or a remote FTP server. To retrieve a file from a remote FTP server, use Send Communication Handle Command (get option) to bring the file into the local file system, and then use a File communication handle to access the file locally.
- When using this command, it is possible to overrun the receiver, so do not send data faster than it can be received. If necessary, break the transfer into multiple transactions to allow the receiver time to process the incoming data.
If this command returns an error code, the communication handle will close and need to be re-opened. Be sure to check for status codes returned by this command, and handle any errors appropriately.

**Status Codes:**

- **0** = Success
- **-3** = Buffer overrun or invalid length. The only negative number valid for `Num Chars` (Argument 2) is -1.
- **-25** = Port not locked. Communication handles in `Destination Handle` (Argument 0) and `Source Handle` (Argument 1) must be different. If trying to transfer characters to a file, the file space may be insufficient.
- **-36** = Invalid command or feature not implemented for this type of communication handle in this version of firmware. To retrieve a file from a remote FTP server, use `Send Communication Handle Command` (get option) to bring the file into the local file system, and then use a File communication handle to access the file locally.
- **-37** = Lock port timeout.
- **-38** = Send timeout.
- **-39** = Timeout on receive.
- **-52** = Invalid connection—not opened. The communication handle may have been closed by a previous command that failed. Check status codes returned on other communication handle commands.
- **-69** = Invalid parameter (null pointer) passed to command.
- **-531** = Buffer full. You may be attempting to send data to the serial port faster than the port can send and buffer data. Try a faster baud rate or a delay between Transfer/Transmit commands.

**See Also:**

- “Open Outgoing Communication” on page 85
- “Get Number of Characters Waiting” on page 74
- “Close Communication” on page 70
Transmit Character
Communication Action

Function: To send a single character to the entity specified by the communication handle.

Typical Uses: • To send a message to another device or file one character at a time.

Details: • Character values sent are 0–255. Only the last eight bits are sent when the value is >255.
• A value of 256 will be sent as a zero. A value of 257 will be sent as a 1.
• To send an ASCII null, use zero. To send an ASCII zero, use 48.
• With a File communication handle, the character is transmitted immediately.
• With any other communication handle, this command does not transmit the character. The character stays in the buffer until you use Transmit NewLine or Transmit String to send it.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>From</td>
<td>Communication Handle</td>
<td>Put Status in</td>
</tr>
<tr>
<td>Float Literal</td>
<td>Communication Handle</td>
<td>Float Variable</td>
</tr>
<tr>
<td>Float Variable</td>
<td>Integer 32 Literal</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Variable</td>
<td>ERROR_CODE</td>
</tr>
</tbody>
</table>

Action Block Example:

Transmit Character

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>From</td>
<td>Integer 32 Literal</td>
<td>10</td>
</tr>
<tr>
<td>Communication Handle</td>
<td>Communication Handle</td>
<td>PAC_4</td>
</tr>
<tr>
<td>Put Status in</td>
<td>Integer 32 Variable</td>
<td>ERROR_CODE</td>
</tr>
</tbody>
</table>

OptoScript Example: TransmitChar(From, Communication Handle)

ERROR_CODE = TransmitChar(10, PAC_4);

This is a function command; it returns one of the status codes listed below.

In OptoScript code, you can also use a character literal for From (Argument 0). For example, you could use TransmitChar('a', PAC_4); rather than having to use TransmitChar(97, PAC_4); making the code more readable. Unprintable character codes would still require a number, however.

Notes: • See “Communication Commands” in the PAC Control User’s Guide (form 1700).
• When there are a lot of characters to send, use Transmit String instead.
• If this command returns an error code, the communication handle will close and need to be re-opened.

Be sure to check for status codes returned by this command, and handle any errors appropriately.

Status Codes:

0 = Success
-36 = Invalid command. Does not apply to the type of communication handle you are using.
-38 = Timeout. If you are using a File communication handle, you may have used a read-only parameter.
-52 = Invalid connection—not opened. The communication handle may have been closed by a previous command that failed. Check status codes returned on other communication handle commands.
-69 = Invalid parameter (null pointer) passed to command.
-531 = Buffer full. You may be attempting to send data to the serial port faster than the port can send and buffer data. Try a faster baud rate or a delay between Transfer/Transmit commands.
See Also:

“Transmit String” on page 129
“Transmit NewLine” on page 124
Transmit NewLine
Communication Action

**Function:**
To send the message in the transmit buffer. No carriage return is appended.

**Typical Use:**
For TCP/IP communication, to send characters that have been placed in the buffer using the Transmit Character command.

**Details:**
*CAUTION: The message could be sent and acknowledged but discarded by the destination with no error if the receiving end’s buffer is full.*

If the communication handle does not use a buffer (for example, a File communication handle), this command has no effect.

**Arguments:**
- **Argument 0**
  - Communication Handle
- **Argument 1**
  - Put Status in

Optionally:
- **Put Status in**
  - Float Variable
  - Integer 32 Variable

**Action Block Example:**
```
Transmit NewLine

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Handle</td>
<td>Communication Handle</td>
<td>PAC_4</td>
</tr>
<tr>
<td>Put Status in</td>
<td>Integer 32 Variable</td>
<td>ERROR_CODE</td>
</tr>
</tbody>
</table>
```

**OptoScript Example:**
```
TransmitNewLine (Communication Handle)
ERROR_CODE = TransmitNewLine (PAC_4);
```

This is a function command; it returns one of the status codes listed below.

**Notes:**
- If this command returns an error code, the communication handle will close and need to be re-opened. Be sure to check for status codes returned by this command, and handle any errors appropriately.
- Characters are transmitted “all at once.” Task switching within PAC Control does not interrupt the transmission of the data.

**Status Codes:**
- 0 = Success
- -36 = Invalid command. Does not apply to the type of communication handle you are using.
- -37 = Lock port timeout.
- -38 = Send timeout.
- -42 = Invalid limit.
- -69 = Invalid parameter (null pointer) passed to command.
- -531 = Buffer full. You may be attempting to send data to the serial port faster than the port can send and buffer data. Try a faster baud rate or a delay between Transfer/Transmit commands.

**See Also:**
“Transmit String” on page 129
TRANSmit Numeric Table
Communication Action

**Function:** Sends a specific number of numeric table values to another entity, such as another control engine or a binary file.

**Typical Use:** Efficient method of writing binary data to a file.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Name</th>
<th>Type</th>
<th>Argument Name</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Length</strong></td>
<td>Integer 32 Literal/Variable</td>
<td></td>
<td><strong>Table_length</strong></td>
</tr>
<tr>
<td><strong>Start at Index</strong></td>
<td>Integer 32 Literal/Variable</td>
<td></td>
<td><strong>0</strong></td>
</tr>
<tr>
<td><strong>Of Table</strong></td>
<td>Float Table/Integer 32/64 Table</td>
<td></td>
<td><strong>Peer_data_table</strong></td>
</tr>
<tr>
<td><strong>Communication Handle</strong></td>
<td>Communication Handle</td>
<td></td>
<td><strong>PAC_5</strong></td>
</tr>
<tr>
<td><strong>Put Status in</strong></td>
<td>Integer 32 Variable</td>
<td></td>
<td><strong>Xmit_status</strong></td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```optoscript
Xmit_status = TransmitNumTable(Table_length, 0, Peer_data_table, PAC_5);
```

This is a function command; it returns one of the status codes listed below.

**Notes:**

- Use Transmit Character first to send a destination index, table ID, and so forth, if desired. These values could be sent as fixed length or carriage return delimited.
- This command does not generate a numeric string equivalent table; it creates a binary table of numeric data.
- If this command returns an error code, the communication handle will close and need to be re-opened. Be sure to check for status codes returned by this command, and handle any errors appropriately.

**Dependencies:**

Must first use Open Outgoing Communication to establish a session, or (for TCP communication handles) Listen for Incoming Communication and Accept Incoming Communication to accept a session initiated by a TCP/IP peer. For details, see “Communication Commands” in the PAC Control User’s Guide (form 1700).

**Status Codes:**

- **0 = Success**
- **-36 = Invalid command. Does not apply to the type of communication handle you are using.**
- **-37 = Lock port timeout.**
- **-38 = Send timeout. If you are using a File communication handle, you may have used a read-only parameter.**
- **-42 = Invalid limit.**
-52 = Invalid connection—not opened. The communication handle may have been closed by a previous command that failed. Check status codes returned on other communication handle commands.

-69 = Invalid parameter (null pointer) passed to command.

**Queue Errors:**

-12 = Invalid table index value. Index was negative or greater than or equal to the table size.

-531 = Buffer full. You may be attempting to send data to the serial port faster than the port can send and buffer data. Try a faster baud rate or a delay between Transfer/Transmit commands.

**See Also:**

- Receive Numeric Table” on page 91
- Receive String Table” on page 102
- Receive Pointer Table” on page 97
- Transmit String” on page 129
- Transmit Character” on page 122
- Transmit String Table” on page 131
- Transmit Pointer Table” on page 127
- Transfer N Characters” on page 120
Transmit Pointer Table

Communication Action

**Function:** Sends a specific number of pointer table values to another entity, such as another control engine or a file. (The values pointed to are transmitted, not the pointers themselves.)

**Typical Use:** Efficient method of data transfer to a file.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Length</strong></td>
<td><strong>Start at Index</strong></td>
<td><strong>Of Table</strong></td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
<td>Pointer Table</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Argument 3</th>
<th>Argument 4</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Communication Handle</strong></td>
<td><strong>Put Status in</strong></td>
</tr>
<tr>
<td>Communication Handle</td>
<td>Float Variable</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td></td>
</tr>
</tbody>
</table>

**Action Block Example:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length</td>
<td>Integer 32 Variable</td>
<td>Table_length</td>
</tr>
<tr>
<td>Start at Index</td>
<td>Integer 32 Literal</td>
<td>0</td>
</tr>
<tr>
<td>Of Table</td>
<td>Pointer Table</td>
<td>Peer_data_table</td>
</tr>
<tr>
<td>Communication Handle</td>
<td>Communication Handle</td>
<td>PAC_5</td>
</tr>
<tr>
<td>Put Status in</td>
<td>Integer 32 Variable</td>
<td>Xmit_status</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```
Xmit_status = TransmitPtrTable(Table_length, 0, Peer_data_table, PAC_5);
```

This is a function command; it returns one of the status codes listed below.

**Notes:**

- Use **Transmit Character** first to send a destination index, table ID, and so forth, if desired. These values could be sent as fixed length or carriage return delimited.
- Pointers in the table must not point to another table.
- Make sure that the tables used on both ends of the communication point to the same types and sizes of data. For example, if you transmit a table with pointers to a float, an integer, and a string with width 10, make sure the table on the receiving end is exactly the same.
- If this command returns an error code, the communication handle will close and need to be re-opened. Be sure to check for status codes returned by this command, and handle any errors appropriately.

**Dependencies:**

Must first use **Open Outgoing Communication** to establish a session, or (for TCP communication handles) **Listen for Incoming Communication** and **Accept Incoming Communication** to accept a session initiated by a TCP/IP peer. For details, see “Communication Commands” in the **PAC Control User’s Guide** (form 1700).

**Status Codes:**

- 0 = Success
- -36 = Invalid command. Does not apply to the type of communication handle you are using.
- -37 = Lock port timeout.
- -38 = Send timeout.
- -42 = Invalid limit.
-52 = Invalid connection—not opened. The communication handle may have been closed by a previous command that failed. Check status codes returned on other communication handle commands.

-69 = Invalid parameter (null pointer) passed to command.

-531 = Buffer full. You may be attempting to send data to the serial port faster than the port can send and buffer data. Try a faster baud rate or a delay between Transfer/Transmit commands.

Queue Errors:

-12 = Invalid table index value. Index was negative or greater than or equal to the table size.

-29 = Wrong object type. Pointers in the table must point to strings, integers, or floats. Tables are not allowed.

See Also:

“Receive Numeric Table” on page 91
“Receive String Table” on page 102
“Receive Pointer Table” on page 97
“Transmit String” on page 129
“Transmit Character” on page 122
“Transmit String Table” on page 131
“Transmit Numeric Table” on page 125
“Transfer N Characters” on page 120
**Transmit String**

**Communication Action**

**Function:** To send a message to another entity.

**Typical Use:** To write a string to a text file.

**Details:**
- For communication handles that use buffers (for example, TCP), if the transmit buffer of the specified handle has any characters in it (previously placed there by Transmit Character), they will be sent first, followed by any characters that may be in the string. If the string is empty, the transmit buffer contents will be sent. If both the string and the transmit buffer are empty, the packet will not be sent.
- When using a file, the string is immediately written to the file.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
</table>
| From
String Literal   | Communication Handle           | Put Status in                     |
| String Variable     | Communication Handle           | Float Variable                    |
|                     |                                 | Integer 32 Variable               |

**Action Block Example:**

```
<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>From</td>
<td>String Variable</td>
<td>XMIT_MSG</td>
</tr>
<tr>
<td>Communication Handle</td>
<td>Communication Handle</td>
<td>PAC_5</td>
</tr>
<tr>
<td>Put Status in</td>
<td>Integer 32 Variable</td>
<td>COMM_STATUS</td>
</tr>
</tbody>
</table>
```

**OptoScript Example:**

```
TransmitString(From, Communication Handle)

COMM_STATUS = TransmitString(XMIT_MSG, PAC_5);
```

This is a function command; it returns one of the status codes listed below.

**Dependencies:**
- Must first use Open Outgoing Communication to establish a session, or (for TCP communication handles) Accept Incoming Communication to accept communication initiated by a TCP/IP peer.
- Characters are transmitted “one at a time.” Task switching within the controller will interrupt the transmission of data. This will cause the transmission to pause momentarily.

**Status Codes:**

- 0 = Success
- -37 = Lock port timeout.
- -38 = Send timeout. For example, attempted to write to a file opened for reading.
- -52 = Invalid connection—not opened. The communication handle may have been closed by a previous command that failed. Check status codes returned on other communication handle commands.
- -69 = Invalid parameter (null pointer) passed to command.
- -408 = Error during file access. For example, attempted to write to a file open for reading.
- -531 = Buffer full. You may be attempting to send data to the serial port faster than the port can send and buffer data. Try a faster baud rate or a delay between Transfer/Transmit commands.

**Notes:**
- This command does not automatically append the current end-of-message (EOM) delimiter for the communication handle to the end of the string. Only the string passed will be transmitted. If the EOM is
needed (for example, to be received on the other end using Receive String), use Append Character to String to append the EOM to the string.

- If this command returns an error code, the communication handle will close and need to be re-opened. Be sure to check for status codes returned by this command, and handle any errors appropriately.

See Also:

- “Receive String” on page 99
- “Transmit/Receive String” on page 133
- “Open Outgoing Communication” on page 85
- “Append Character to String” on page 597
- “Get End-Of-Message Terminator” on page 73
- “Set End-Of-Message Terminator” on page 119
# Transmit String Table

**Communication Action**

**Function:** Sends a specific number of string table values to another entity, such as another control engine or a file.

**Typical Use:** Efficient method of writing delimited data to a file.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length</td>
<td>Integer 32 Variable</td>
<td>Table_length</td>
</tr>
<tr>
<td>Start at Index</td>
<td>Integer 32 Literal</td>
<td>0</td>
</tr>
<tr>
<td>Of Table</td>
<td>String Table</td>
<td>Peer_data_table</td>
</tr>
<tr>
<td>Communication Handle</td>
<td>Communication Handle</td>
<td>PAC_5</td>
</tr>
<tr>
<td>Put Status in</td>
<td>Integer 32 Variable</td>
<td>Xmit_status</td>
</tr>
</tbody>
</table>

**Action Block Example:**

```opcodes
Transmit String Table
```

**OptoScript Example:**

```opcodes
Xmit_status = TransmitStrTable(Table_length, 0, Peer_data_table, PAC_5);
```

This is a function command; it returns one of the status codes listed below.

**Notes:**
- Each string that is transmitted will be followed by the current end-of-message character for this communication handle.
- Use **Set End-Of-Message Terminator** to specify the end-of-message character to use. The default is 13 (carriage return).
- Use **Transmit Character** first to send a destination index, table ID, and so forth, if desired. These values could be sent as fixed length or carriage return delimited.
- If this command returns an error code, the communication handle will close and need to be re-opened. Be sure to check for status codes returned by this command, and handle any errors appropriately.

**Dependencies:**
- Must first use **Open Outgoing Communication** to establish a session, or (for TCP communication handles) **Listen for Incoming Communication** and **Accept Incoming Communication** to accept a session initiated by a TCP/IP peer. For details, see “Communication Commands” in the [PAC Control User’s Guide](form 1700).

**Status Codes:**

- 0 = Success
- 3 = Invalid length. *Length* (Argument 1) is greater than number of elements in the source table.
- 11 = Could not send data. For example, there may not be enough space to write the data.
- 12 = Invalid table index. Index was negative or greater than or equal to the table size.
- 37 = Lock port timeout.
- 38 = Send timeout. For example, attempted to write to a file opened for reading.
-42 = Invalid limit.

-52 = Invalid connection—not opened. The communication handle may have been closed by a previous command that failed. Check status codes returned on other communication handle commands.

-69 = Invalid parameter (null pointer) passed to command.

-408 = Error during file access. For example, attempted to write to a file open for reading.

-531 = Buffer full. You may be attempting to send data to the serial port faster than the port can send and buffer data. Try a faster baud rate or a delay between Transfer/Transmit commands.

Queue Errors:
-12 = Invalid table index value. Index was negative or greater than or equal to the table size.

See Also:
* "Receive String Table" on page 102
* "Receive Numeric Table" on page 91
* "Receive Pointer Table" on page 97
* "Transmit String" on page 129
* "Transmit Character" on page 122
* "Transmit Pointer Table" on page 127
* "Transmit Numeric Table" on page 125
* "Set End-Of-Message Terminator" on page 119
* "Transfer N Characters" on page 120
Transmit/Receive String

Communication Action

**Function:** Sends a message, and then waits for an end-of-message delimited response.

**Typical Use:** Sending and receiving messages and data to/from other devices via TCP/IP.

**Details:**
- The EOM character is not appended to the transmitted string. Therefore, before using this command you may first want to call Get End-Of-Message Terminator, and then Append Character to String.
- See the Details section for Transmit String and Receive String. This command is the equivalent of using Transmit String followed by Receive String.
- If the response has multiple embedded end-of-message (EOM) characters, use Receive String to get each additional EOM-delimited section.
- Do not use this command with FTP or File communication handles.
- If the EOM-delimited string is longer than the destination string length, a -23 error is returned and as many characters as fit in the destination string are placed there. To see how many characters were received, use a Get Length command for the destination string. The characters remaining, minus the data just received, may be retrieved by a subsequent call to Receive String.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
<th>Argument 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>From</td>
<td>Communication Handle</td>
<td>Put Result in</td>
<td>Put Status in</td>
</tr>
<tr>
<td>String Literal</td>
<td>Communication Handle</td>
<td>String Variable</td>
<td>Float Variable</td>
</tr>
<tr>
<td>String Variable</td>
<td>Communication Handle</td>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

**Action Block Example:**

```
TransmitReceiveString (From, Communication Handle, Put Result in)

TR_STATUS = TransmitReceiveString(XMIT_MSG, PAC_4, RECV_MSG);
```

This is a function command; it returns one of the status codes listed below.

**Notes:**
- Use Move String, Append String to String, or Append Character to String to build the string to send.
- Use Receive String or Receive N Characters in the destination device followed by Transmit String for the reply.
- See more details in Transmit String and Receive String.
- If this command returns an error code, the communication handle will close and need to be re-opened. Be sure to check for status codes returned by this command, and handle any errors appropriately.

**Dependencies:**
- Must first use Open Outgoing Communication to establish a session, or (for TCP communication handles) Accept Incoming Communication to accept a session initiated by a TCP/IP peer.
- After using Open Outgoing Communication, use the Set End-Of-Message Terminator command to change the default of 13 (carriage return) if needed.

**Status Codes:**

<table>
<thead>
<tr>
<th>Status Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Success</td>
</tr>
</tbody>
</table>
-23 = Destination string too short.
-25 = Port not locked. This could be an indication that communication was lost between the Transmit and Receive (for example, reset by the other device following the Transmit).
-37 = Lock port timeout.
-38 = Send timeout.
-39 = Timeout on receive.
-52 = Invalid connection—not opened. The communication handle may have been closed by a previous command that failed. Check status codes returned on other communication handle commands.
-58 = No data received. May have timed out if no response in 10 seconds. Check I/O unit power.
-76 = At end of file.
-69 = Invalid parameter (null pointer) passed to command.
-408 = Error during file access. For example, attempted to write to a file opened for reading.
-443 = Could not receive on socket. Often an indication that the connection was reset by the other device.
-521 = Buffer full. You may be attempting to send data to the serial port faster than the port can send and buffer data. Try a faster baud rate or a delay between Transfer/Transmit commands.

Queue Errors:  
-12 = Invalid table index value. Index was negative or greater than or equal to the table size.

See Also:  
"Transmit String" on page 129  
"Receive String" on page 99  
"Open Outgoing Communication" on page 85  
"Get End-Of-Message Terminator" on page 73  
"Set End-Of-Message Terminator" on page 119  
"Transfer N Characters" on page 120
5: Control Engine Commands

Calculate Strategy CRC

Control Engine Action

Function: Calculates and returns a 16-bit CRC on the program in RAM.

Typical Use: Periodically used in an error handler to check the integrity of the running program.

Details: Use the result to compare with the original CRC that was automatically calculated during the last download. The original CRC is obtained by using Retrieve Strategy CRC. These two values should match exactly.

Arguments:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Put Result in</td>
<td>Integer 32 Variable</td>
<td>New_CRC_Calc</td>
</tr>
</tbody>
</table>

Action Block Example:

```
Calculate Strategy CRC
```

OptoScript Example:

```
New_CRC_Calc = CalcStrategyCrc();
```

This is a function command; it returns the 16-bit CRC. The returned value can be consumed by a variable (as shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User's Guide (form 1700).

Notes: This command could take several minutes to execute when several charts are running and the program is very large. Therefore, do not use it in a chart where timing is critical.

See Also: “Retrieve Strategy CRC” on page 148
**Erase Files in Permanent Storage**

**Control Engine Action**

**Function:** To delete the files in flash memory.

**Typical Use:** To delete files in flash memory that are no longer needed.

**Details:**
- This command deletes ALL files in the brain’s or controller’s flash memory. However, firmware files, strategy files, and point configuration data are not affected. Files and folders in the file system in RAM are not deleted.
- It is not possible to delete only selected files in flash memory.
- To determine what files are in flash memory and RAM, use PAC Manager. For instructions, see the PAC Manager User’s Guide (form 1704).

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Put Status in</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

**Action Block Example:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Put Status in</td>
<td>Integer 32 Variable</td>
<td>Flash_Mem_Status</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```
EraseFilesInPermanentStorage()
Flash_Mem_Status = EraseFilesInPermanentStorage()
```

This is a function command; it always returns a zero.

**Notes:**
- This command always returns a zero.

**See Also:**
- “Save Files To Permanent Storage” on page 149
- “Load Files From Permanent Storage” on page 147
Get Available File Space

**Control Engine Action**

**Function:** To determine how much file space is currently available in the file system for a system up to 2 GB capacity.

**Typical Use:** To make sure there is sufficient file space available before writing data to a file.

**Details:**
- In *File System Type* (Argument 0), show whether file space data for RAM, flash, or microSD should be returned in bytes or megabytes:
  - 0 = RAM filesystem bytes
  - 1 = RAM filesystem megabytes
  - 4 = flash filesystem bytes
  - 5 = flash filesystem megabytes
  - 8 = microSD filesystem bytes
  - 9 = microSD filesystem megabytes
- The maximum number of files is limited only by available memory. Each file uses 516 bytes of overhead plus its number of bytes rounded up to the nearest multiple of 516 bytes.
- The maximum amount of memory available in the control engine’s file system is approximately 2 MB on a SNAP-PAC-R controller or 2.5 on a SNAP-PAC-S controller (varies slightly depending on the control engine firmware version). The file storage space available on a SoftPAC controller depends on the computer the software is installed on.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>File System Type</td>
<td>Put Result in</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

**Action Block Example:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>File System Type</td>
<td>Integer 32 Literal</td>
<td>0</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Integer 32 Variable</td>
<td>File_Space</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```optoscript
GetAvailableFileSize(File System Type)
File_Space = GetAvailableFileSize(0);
```

This is a function command; it returns the size of file space available (a positive value, in units specified by *File System Type*), or it returns a status code (a negative value, as shown below). The returned value can be consumed by a variable (as shown in the example) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the *PAC Control User’s Guide* (form 1700).

**Notes:**
- See “Managing and Accessing Files in the Control Engine’s File System” in the Communication Commands section of the *PAC Control User’s Guide* (form 1700).
- For a quick check of the available file space on your device in Debug mode, you don’t need to use this command. Instead, double-click the control engine’s name in the Strategy Tree and look at File Space Avail in the Inspect dialog box.

**Status Codes:**

-36 = Feature not implemented (file system type not supported with the type of hardware in use).

**See Also:**

- “Get Available File Space Ex” on page 138
- “Erase Files in Permanent Storage” on page 136
- “Load Files From Permanent Storage” on page 147
- “Get Number of Characters Waiting” on page 74
Get Available File Space Ex

Control Engine Action

Function: To determine how much file space is currently available in the file system for systems with more than 2 GB capacity. Supports reading free space values greater than 2 GB, using a 64-bit result value.

Typical Use: To make sure there is sufficient file space available before writing data to a file.

Details:
- For SNAP PAC controllers, requires firmware R10.0h or higher. For SNAP PAC brains, requires firmware R9.5g or higher.
- Cannot be used to read file space on a USB flash drive inserted in a groov EPIC processor or groov RIO unit.
- In File System Type (Argument 0), show whether file space data for RAM, flash, or microSD should be returned in bytes, megabytes, or gigabytes:
  - 0 = RAM filesystem bytes
  - 1 = RAM filesystem megabytes
  - 2 = RAM filesystem gigabytes
  - 4 = flash filesystem bytes
  - 5 = flash filesystem megabytes
  - 6 = flash filesystem gigabytes
  - 8 = microSD filesystem bytes
  - 9 = microSD filesystem megabytes
  - 10 = microSDHC filesystem gigabytes
- The maximum number of files is limited only by available memory. Each file uses 516 bytes of overhead plus its number of bytes rounded up to the nearest multiple of 516 bytes.
- The maximum amount of memory available in the control engine’s file system is approximately 2 MB on a SNAP-PAC-R controller or 2.5 MB on a SNAP-PAC-S controller (varies slightly depending on the control engine firmware version). The file storage space available on a SoftPAC controller depends on the computer the software is installed on.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>File System Type</td>
<td>Put Result in</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 64 Variable</td>
</tr>
</tbody>
</table>

Action Block Example:

```
Get Available File Space Ex
```

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>File System Type</td>
<td>Integer 32 Literal</td>
<td>0</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Integer 64 Variable</td>
<td>File_Space</td>
</tr>
</tbody>
</table>

OptoScript Example:

```
GetAvailableFileSizeSpaceEx (File System Type)
```

```
File_Space = GetAvailableFileSizeSpaceEx(0);
```

This is a function command; it returns the size of file space available (a positive value, in units specified by File System Type), or it returns a status code (a negative value, as shown below). The returned value can be consumed by a variable (as shown in the example) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

Notes:
- See “Managing and Accessing Files in the Control Engine’s File System” in the Communication Commands section of the PAC Control User’s Guide (form 1700).
• For a quick check of the available file space on your device in Debug mode, you don’t need to use this command. Instead, double-click the control engine’s name in the Strategy Tree and look at File Space Avail in the Inspect dialog box.

Status Codes: -36 = Feature not implemented (file system type not supported with the type of hardware in use).

See Also: “Get Available File Space” on page 137
“Erase Files in Permanent Storage” on page 136
“Load Files From Permanent Storage” on page 147
“Get Number of Characters Waiting” on page 74
### Get Control Engine Address

#### Control Engine Action

**Function:**
Gets the address of the controller on which the strategy is running. The address will be a string in this format: 10.20.30.40

**Typical Use:**
To identify the IP address of the control engine on which the strategy is running; for example, to display the address in your HMI, or to identify the origin of a message in peer-to-peer communication.

**Details:**
- To convert the IP address to a 4-byte value, use the String Command, "Convert IP Address String to Integer 32" on page 607.
- If the string passed to this command is too short, it will be truncated to fit. To avoid this situation, be sure to use a string configured for a width of at least 15 characters.
- For PAC-R and PAC-S controllers, the address of ETH1 is returned.
- For SoftPAC, your result may vary depending on your SoftPAC version and computer setup.
  - If your computer has more than one NIC with a valid IP address, the command returns the address of the first DHCP-enabled NIC with a valid address that it finds.
  - If your computer does not have any DHCP-enabled NICs with a valid address, the command returns the first NIC with a valid IP address that it finds.
  - If your computer has no NICs with a valid IP address, the command returns: 0.0.0.0

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Put in</td>
<td>String Variable</td>
<td>Address_Code</td>
</tr>
</tbody>
</table>

**Action Block Example:**

Get Control Engine Address

```
<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Put in</td>
<td>String Variable</td>
<td>Address_Code</td>
</tr>
</tbody>
</table>
```

**OptoScript Example:**

```opto
GetControlEngineAddress(Put in)
GetControlEngineAddress(Address_Code);
```

This is a procedure command; it does not return a value.

**See Also:**
- "Get Control Engine Type" on page 141
- "Get Firmware Version" on page 142
- "Convert IP Address String to Integer 32" on page 607
Get Control Engine Type

Control Engine Action

Function: Returns a numeric code indicating the control engine type.

Typical Use: In programs that must configure themselves according to the control engine type in which they are running.

Details:Primarily used in factory QA testing.
Returns 400 for SNAP PAC Simulator.
Returns 401 for a SoftPAC controller.
Returns 512 for all types of SNAP-PAC-S controllers.
Returns 513 for all types of SNAP-PAC-R controllers.

Arguments:Argument 0
Put in
Float Variable
Integer 32 Variable

Action Block Example:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Put in</td>
<td>Integer 32 Variable</td>
<td>TYPE_CODE</td>
</tr>
</tbody>
</table>

OptoScript Example:

GetEngineType();

TYPE_CODE = GetEngineType();

This is a function command; it returns a value indicating the control engine type. The returned value can be consumed by a variable (as shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

Note:To determine the hardware type of any controller or I/O Unit, use the command “Read Number from I/O Unit Memory Map” on page 307 to read the Unit Type at address 0xF030020. For more information, see the OptomMP Protocol Guide (form 1465).

See Also:“Get Control Engine Address” on page 140
“Get Firmware Version” on page 142
### Get Firmware Version

**Control Engine Action**

**Function:** Returns a string containing the firmware (kernel) version.

**Typical Use:** In programs that must configure themselves according to the firmware version under which they are running.

**Details:** The returned string will be in the format `R1.0a`.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Put in</td>
<td>String Variable</td>
<td>REV_CODE</td>
</tr>
</tbody>
</table>

**Action Block Example:**

- Get Firmware Version

**OptoScript Example:**

```optoscript
GetFirmwareVersion(REV_CODE);
```

This is a procedure command; it does not return a value.

**See Also:**

- "Get Control Engine Address" on page 140
- "Get Control Engine Type" on page 141
Get Number of Charts Running

Control Engine Action

Function: Returns the total number of charts that are Running, Starting, or Suspended.

Typical Use: To determine how the approximate number of charts that count toward the maximum number of charts the processor or controller can run simultaneously. You could use this command when optimizing your processes to decide whether you can run additional charts in parallel.

Arguments: Argument 0
Put in Float Variable Integer 32 Variable

Action Block Example:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Put in</td>
<td>Float Variable Integer 32 Variable</td>
<td>Number_Charts_Running</td>
</tr>
</tbody>
</table>

OptoScript Example: GetNumChartsRunning()
Number_Charts_Running = GetNumChartsRunning();

This is a function command; it returns the number of charts running.

Notes: groov EPIC processors and SoftPAC computer-based controllers each can simultaneously run up to 64 charts; SNAP PAC S-series controllers, up to 32 charts; R-series controllers, up to 16 charts.

See Also: “Call Chart” on page 51 “Get Chart Status” on page 61 “Start Chart” on page 63
Get Redundant Controller State

Control Engine Action

Function: Returns a code indicating whether the active controller in a redundant controller system can communicate with all I/O units.

Typical Use: To determine if any I/O units cannot communicate with the controller.

Details: When using redundant controllers (which requires the SNAP PAC Redundancy Option Kit), the active controller periodically tests whether I/O units configured for communication can respond to a “ping” request. If any I/O unit fails to respond to the ping request, then this command sends back a non-zero value (meaning one or more I/O units are “impaired”).

Arguments: Argument 0
Put in
Float Variable
Integer 32 Variable
Integer 64 Variable

Action Block Example:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Put in</td>
<td>Float Variable</td>
<td>State</td>
</tr>
<tr>
<td></td>
<td>Integer 32 Variable</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Integer 64 Variable</td>
<td></td>
</tr>
</tbody>
</table>

OptoScript Example:

GetRedundantControllerState();

State = GetRedundantControllerState();

This is a function command; it returns a value to indicate whether any I/O unit is unable to communicate with the controller.

Notes:
- Applicable only when using PAC Control Professional, SNAP PAC S-series controllers, and the SNAP PAC Redundancy Option Kit (part number SNAP-PAC-ROK).
- The “Enable communications from control engine” check box does not have to be selected for the controller to verify communicates with the I/O units. (Redundant systems check communications to all I/O units, even if communications are not enabled.)

State Codes
- Valid return codes are:
  - 0 = All I/O units are communicating with the active controller.
  - Any number other than 0 (zero) = One or more I/O units is not responding to the controller.

See Also: “Get Redundant Controller Status” on page 145
Get Redundant Controller Status

Control Engine Action

Function: Returns a code indicating whether the active controller is:
- The primary controller
- The secondary controller
- Not operating in redundant mode

Typical Use: To determine which controller is active when using redundant controllers.

Details: Applicable only when using PAC Control Professional, SNAP PAC S-series controllers, and the SNAP PAC Redundancy Option Kit (part number SNAP-PAC-ROK).

Arguments: Argument 0
Put in
Float Variable
Integer 32 Variable
Integer 64 Variable

Action Block Example:

<table>
<thead>
<tr>
<th>Get Redundant Controller Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argument Name</td>
</tr>
<tr>
<td>Put in</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

OptoScript Example:

GetRedundantControllerStatus();

Status = GetRedundantControllerStatus();

This is a function command; it returns a code indicating the controller’s status.

Notes: Valid return codes are:
0 = The controller is not operating in redundant mode.
1 = The active controller is the primary controller.
2 = The active controller is the secondary controller.

See Also: “Get Redundant Controller State” on page 144
Get Strategy Name

Control Engine Action

**Function:**
Returns a string containing the name of the strategy currently running.

**Typical Use:**
To make the strategy name available for other uses; for example, to display the strategy name in your HMI.

**Details:**
The returned string is the strategy’s file name without the file path or the “.idb” extension.

**Arguments:**

- **Argument 0**
  - **Put in**
    - String Variable

**Action Block Example:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Put in</td>
<td>String Variable</td>
<td>Strategy_Name</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```opto
GetStrategyName()
```

```opto
GetStrategyName(Strategy_Name);
```

This is a procedure command; it does not return a value.
Load Files From Permanent Storage

Control Engine Action

Function: To copy the files in a SNAP PAC controller’s flash memory to the file system in RAM.

Typical Use: To retrieve files previously saved to flash memory.

Details:
- Copies all files in flash memory to the controller’s file system in RAM, replacing any files of the same name. (Does not replace other files or folders in the root directory, or files within folders.)
- Does not affect firmware, strategy, point configuration, or other configuration parameters.

Arguments:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Put Status in</td>
<td>Integer 32 Variable</td>
<td>STATUS</td>
</tr>
</tbody>
</table>

Action Block Example:

OptoScript Example:

```go
LoadFilesFromPermanentStorage()
STATUS = LoadFilesFromPermanentStorage();
```

This is a function command; it returns a zero (indicating success) or an error (indicating failure). The returned value can be consumed by a variable (as in the example shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the *PAC Control User’s Guide* (form 1700).

Notes:
- The equivalent of this command happens automatically when the controller is turned on. However, when the controller is turned off or loses power, all files and folders in its RAM file system are deleted; only the files saved to flash memory are loaded back into RAM when the controller is turned on again.
- To determine which files are in flash memory, which are in RAM, and their file sizes, use PAC Manager. For details, see the *PAC Manager User’s Guide* (form 1704).
- For more information, see “Control Engine Commands” in the *PAC Control User’s Guide* (form 1700).

Status Codes:
- 0 = Success
- -408 = Error during file access. No files are currently saved in flash memory.

See Also:
- “Erase Files in Permanent Storage” on page 136
- “Save Files To Permanent Storage” on page 149
**Retrieve Strategy CRC**

**Control Engine Action**

**Function:** Returns the 16-bit CRC originally calculated on the program in RAM during the last download.

**Typical Use:** Periodically used in an error handler to check the integrity of the running program.

**Details:** Use the returned value to compare with a newly calculated CRC that was obtained by using Calculate Strategy CRC. These two values should match exactly.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Put in Integer 32 Variable</td>
</tr>
</tbody>
</table>

**Example:**

```plaintext
OptoScript Example:
RetrieveStrategyCrc()
ORIGINAL_CRC = RetrieveStrategyCrc();
```

This is a function command; it returns the CRC. The returned value can be consumed by a variable (as shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

**See Also:** “Calculate Strategy CRC” on page 135
Save Files To Permanent Storage

Control Engine Action

Function: To save the files that are in the root directory of a SNAP PAC controller’s file system to flash memory.

Typical Use: To avoid losing files if the brain or controller is turned off or loses power.

Details:
- Copies all files in the root directory of the file system to flash memory, replacing files of the same name.
- Each file stored in flash memory requires about 72 bytes of overhead.
  - Maximum flash memory file storage in a SNAP PAC R-series controller is about 384 KB.
  - Maximum flash memory file storage in a SNAP-PAC S-series controller is about 2.5 MB.
- For more information about memory usage in SNAP PAC R- and S-series controllers, see the SNAP PAC Memory Usage technical note (form 1646).
- Does not affect firmware, strategy, point configuration, or other configuration parameters.

Arguments: 

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Put Status in</td>
<td>Integer 32 Variable</td>
<td>STATUS</td>
</tr>
</tbody>
</table>

Action Block Example:

```
<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Put Status in</td>
<td>Integer 32 Variable</td>
<td>STATUS</td>
</tr>
</tbody>
</table>
```

OptoScript Example:

```
STATUS = SaveFilesToPermanentStorage();
```

This is a function command that always returns a zero.

Notes: CAUTION: If you use this command in a strategy, make certain it is not in a loop. You can wear out the flash if you write to flash too many times.

- To save a file to flash, put it in the root directory. Files that are inside folders cannot be saved to flash. (Likewise, folders cannot be saved to flash.)
- For more information, see “Control Engine Commands” in the PAC Control User’s Guide (form 1700).
- This command always returns a zero. However, the command could fail if files in the root directory of the file system are too large for flash memory, or if there are no files in the root.
- To determine the size of a file in the file system, open the file using a File communication handle in read mode, and then use the command Get Number of Characters Waiting. See “Communication Commands” in the PAC Control User’s Guide (form 1700).
- To determine which files are in flash memory, which are in RAM, and their file sizes, use PAC Manager. For details, see the PAC Manager User’s Guide (form 1704).

See Also:
- “Erase Files in Permanent Storage” on page 136
- “Load Files From Permanent Storage” on page 147
- “Get Number of Characters Waiting” on page 74
Start Alternate Host Task

Control Engine Action

Function: To start an alternate host task in PAC Control.

Typical Use: To divide up the host workload.

Details: With an alternate host task, human-machine interface (HMI) communication can be directed to the alternate host port, leaving the default host free for use with the debugger.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection String</td>
<td>Put Result in</td>
</tr>
<tr>
<td>String Literal</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

Example:

OptoScript Example:

```optoscript
StartAlternateHostTask();
```

This is a function command. If invalid arguments are passed, or if all user tasks are in use, an error code is returned. Otherwise, a positive number zero is returned.

The Connection String specifies the protocol and port information. Case is important. Recommended connection strings: tcp:22004 or tcp:22005. You can start more than one host task but each host task started reduces the number of charts that can be run at once.

Notes:

- TCP is the only supported protocol.
- Ports 22000 – 22003 are reserved for use by Opto 22. Do not use them in your strategy.
- Ports 22004 – 22010 are designated as user alternate host ports. Opto 22 will not use these ports, and because they are specifically assigned to Opto 22, they should never used by any other application nor should you use them in your strategy.
- groov EPIC processors only. To use this command, you must first create a new firewall rule to open the alternate host port. (This is because ports in a groov EPIC processor are firewall-protected.) For details, see the “Controlling access to the groov EPIC processor” chapter of the groov EPIC User’s Guide (form 2267).
- A positive return value means only that the task was started. Even though successful, this could still fail—for example, if the newly started host task is unable to open the requested port. This could happen if you try to start a host on a port that is already used for something else, such as a user chart, or if you try to use the 22500 series ports, which are used for serial modules. Note that ports 22004 and 22005 are reserved for you to use; you can use other ports, but they may or may not be available.

Status Codes: Any positive number = probable success (see notes above)

-5 = Operation Failed. Possible causes:

- Maximum number of tasks is already running.
- Start command called on a chart which is in the process of starting, but is not yet running. (It takes roughly 100 mSec for the task to be set up and to actually start running once the command has been received).
- Start command encountered while the strategy is in the process of stopping.
-606 = Redundant Mode Bad. This can be caused by trying to start an alternate host on a backup controller, which is allowed only on the active controller.

**Queue Errors:**

-77 = Host task failed. Possible causes: specified host port is already in use, host attempted to load a non-existent strategy file, or there are no more available tasks.
6: Digital Point Commands

Clear All Latches

Digital Point Action

**Function:** To reset all digital input latches on a digital or mixed I/O unit.

**Typical Use:** To ensure all input on- or off-latches are reset. Usually performed after a powerup sequence.

**Details:**
- Clears all previously set on- or off-latches associated with input points on the specified I/O unit regardless of the on/off status of the inputs.
- All input points automatically have the latch feature.
- An on-latch is set when the input point changes from off to on.
- An off-latch is set when the input point changes from on to off.

**Arguments:**

**Argument 0**

On I/O Unit

- B100*
- B3000 (Digital)*
- E1
- E2
- GRV-EPIC-PR1
- GRV-R7-MM1001-10
- G4D16R*
- G4D32RS*
- G4EB2
- SNAP-B3000-ENET, SNAP-ENET-RTC**
- SNAP-BRS*
- SNAP-ENET-D64**
- SNAP-ENET-S64**
- SNAP-PAC-EB1
- SNAP-PAC-EB2
- SNAP-PAC-R1
- SNAP-PAC-R1-B
- SNAP-PAC-R2
- SNAP-PAC-SB1
- SNAP-PAC-SB2
- SNAP-UP1-ADS**
- SNAP-UP1-D64**
- SNAP-UP1-M64**

* Available only in PAC Control Professional when mistic products are enabled (File > Strategy Options > Legacy tab > Mistic I/O units and commands).
** Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).

** Action Block Example:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>On I/O Unit</td>
<td>SNAP-PAC-EB1</td>
<td>INPUT_BOARD_1</td>
</tr>
</tbody>
</table>

** OptoScript Example:**

```plaintext
ClearAllLatches (On I/O Unit)

ClearAllLatches (INPUT_BOARD_1);
```

This is a procedure command; it does not return a value.

** Queue Errors:**

-52 = Invalid connection—not opened. The connection may have been closed by a previous command that failed. Check status codes returned on other connection commands.

-93 = I/O unit not enabled. Previous communication failure may have disabled communication to the unit automatically. Reenable communication to the unit and try again.

** Notes:**

If using the latching feature on one or more digital inputs, it is a good practice to clear all the latches after powerup or reset.

** See Also:**

“Clear On-Latch” on page 157
“Clear Off-Latch” on page 156
Clear Counter

Digital Point Action

**Function:** To reset a digital input counter or quadrature counter to zero.

**Typical Use:** To reset a digital input configured with a counter or quadrature counter feature.

**Details:**
- Resets the specified counter or quadrature counter input to zero as soon as it is used.
- Does not stop the counter or quadrature counter from continuing to run (as Stop Counter does).
- A quadrature counter occupies two adjacent points, so quadrature modules appear with only points 00 and 02 available.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>On Point</td>
<td>Counter</td>
<td>Bottle.Counter</td>
</tr>
</tbody>
</table>

**Action Block Example:**

```
Clear Counter

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>On Point</td>
<td>Counter</td>
<td>Bottle.Counter</td>
</tr>
</tbody>
</table>
```

**OptoScript Example:**

```
ClearCounter(On Point)
ClearCounter(Bottle.Counter);
```

This is a procedure command; it does not return a value.

**Dependencies:**
Applies only to standard digital inputs configured with the counter or quadrature counter feature. For HDD counters, use the Get & Clear Counter command.

Available on GRV-EPIC processors, SNAP-PAC-R1 and -R1-B controllers, and SNAP-PAC-EB1 and SNAP-PAC-SB1 brains with firmware 8.1 or later.

**See Also:**
- “Get Counter” on page 169
- “Get & Clear Counter” on page 160
- “Start Continuous Square Wave” on page 190
- “Stop Counter” on page 195
Clear Off-Latch
Digital Point Action

Function: To reset a previously set digital input off-latch.

Typical Use: To reset the off-latch associated with a digital input to catch the next transition.

Details:
- Resets the off-latch of a single digital input regardless of the on/off status of the input.
- The next time the input point changes from on to off, the off-latch will be set.
- Off-latches are very useful for catching high-speed on-off-on input transitions.

Arguments:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>On Point Digital Input</td>
<td></td>
<td>BUTTON_1</td>
</tr>
</tbody>
</table>

Action Block Example:

```
ClearOffLatch
```

OptoScript Example:

```
ClearOffLatch (BUTTON_1);
```

This is a procedure command; it does not return a value.

Queue Errors:
- -52 = Invalid connection—not opened. The connection may have been closed by a previous command that failed. Check status codes returned on other connection commands.
- -93 = I/O unit not enabled. Previous communication failure may have disabled communication to the unit automatically. Reenable communication to the unit and try again.

Notes: Clear an off-latch after a Get Off-Latch command to re-arm the latch.

See Also:
- “Get Off-Latch” on page 171
- “Clear All Latches” on page 153
Clear On-Latch
Digital Point Action

Function: To reset a previously set digital input on-latch.

Typical Use: To reset the on-latch associated with a digital input to catch the next transition.

Details:

- Resets the on-latch of a single digital input regardless of the on/off status of the input.
- The next time the input point changes from off to on, the on-latch will be set.
- On-latches are very useful for catching high-speed off-on-off input transitions.

Arguments:

| Argument 0 |
| On Point |
| Digital Input |

Action Block Example:

<p>| Clear On-Latch |</p>
<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>On Point</td>
<td>Digital Input</td>
<td>Button_1</td>
</tr>
</tbody>
</table>

OptoScript Example:

```
ClearOnLatch (On Point);
```

This is a procedure command; it does not return a value.

Queue Errors:

-52 = Invalid connection—not opened. The connection may have been closed by a previous command that failed. Check status codes returned on other connection commands.

-93 = I/O unit not enabled. Previous communication failure may have disabled communication to the unit automatically. Reenable communication to the unit and try again.

Notes:

Clear an on-latch after a Get On-Latch command to re-arm the latch.

See Also:

* “Get On-Latch” on page 175
* “Clear All Latches” on page 153
CHAPTER 6: DIGITAL POINT COMMANDS

Generate N Pulses
Digital Point Action

**Function:** To output a specified number of pulses of configurable on and off times.

**Typical Use:** To drive stepper motor controllers, flash indicator lamps, or increment counters.

**Details:**
- Generates a digital waveform on the specified digital output channel.

  *On Time (Seconds)* (Argument 0) specifies the amount of time in seconds that the channel will remain on during each pulse.

  *Off Time (Seconds)* (Argument 1) specifies the amount of time the channel will remain off.

- Each SNAP PAC brain enforces a minimum period. The period is the On Time plus the Off Time. If you specify an On Time and Off Time that total less than the minimum period, the times are scaled proportionally to the minimum period.

  The minimum periods for SNAP PAC brains are:

  | SNAP-PAC-R1 | 0.006 seconds |
  | SNAP-PAC-R1-B | 0.006 seconds |
  | SNAP-PAC-EB1 | 0.040 seconds |
  | SNAP-PAC-SB1 | 0.050 seconds |
  | SNAP-PAC-R2 | 0.1 seconds |
  | SNAP-PAC-EB2 | 0.1 seconds |
  | SNAP-PAC-SB2 | 0.1 seconds |

  For example, if you specify 0.001 seconds on / 0.002 seconds off for a SNAP-PAC-R1, it will instead produce 0.002 seconds on / 0.004 seconds off, maintaining the On Time’s 33% of the total period. In the same situation, a SNAP-PAC-EB1 would produce 0.013 seconds on / 0.027 seconds off.

- The maximum *On Time (Seconds)* and *Off Time (Seconds)* is 429,496,7000 seconds (4.97 days on, 4.97 days off).

- Valid range for *Number of Pulses* (Argument 2) is 0 to 2,147,483,647 if an integer is used, 0 to 4,294,967,000 if a float is used.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
<th>Argument 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>On Time (Seconds)</td>
<td>Off Time (Seconds)</td>
<td>Number of Pulses</td>
<td>On Point</td>
</tr>
<tr>
<td>Float Literal</td>
<td>Float Literal</td>
<td>Float Literal</td>
<td>Digital Output</td>
</tr>
<tr>
<td>Float Variable</td>
<td>Float Variable</td>
<td>Float Variable</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
<td></td>
</tr>
</tbody>
</table>

**Action Block Example:**

| Generate N Pulses |
|---|---|---|
| Argument Name | Type | Name |
| On Time (Seconds) | Float Literal | 0.250 |
| Off Time (Seconds) | Float Literal | 0.500 |
| Number of Pulses | Float Variable | Number_of_Pulses |
| On Point | Digital Output | DIG_OUTPUT |
**OptoScript Example:**

GenerateNPulses(On Time (Seconds), Off Time (Seconds), Number of Pulses, On Point)

GenerateNPulses(0.250, 0.500, Number_of_Pulses, DIG_OUTPUT);

This is a procedure command; it does not return a value.

**Notes:**

- Pulse trains are canceled when a Turn Off or Turn On is sent to the output.
- Executing a Generate N Pulses command will discontinue any previous Generate N Pulses command.
- The minimum on or off time is 0.001 seconds; however, the digital output module’s minimum turn-on and turn-off times may be greater. Check the specifications for the module to be used.
- Supported on standard 4-channel digital SNAP modules, single channel digital modules on a mistic brick, and high-density digital modules.

**See Also:** “Start Continuous Square Wave” on page 190
Get & Clear Counter

Digital Point Action

**Function:** To read and clear a digital input counter, quadrature counter, or HDD module counter value.

**Typical Use:** To count pulses from turbine flow meters, magnetic pickups, encoders, proximity switches, and so forth. To read incremental encoders for positional or velocity measurement.

**Details:**
- Reads the current value of a digital input counter, quadrature counter, or HDD module counter and places it in Put In (Argument 1).
- Sets the counter or quadrature counter at the I/O unit to zero. Does not stop the counter or quadrature counter from continuing to count.
- Valid range for a counter is 0 to 4,294,967,295 counts. Valid range for a quadrature counter is -2,147,483,647 to 2,147,483,648 counts.
- For a quadrature counter, a positive value indicates forward movement (phase A leads phase B), and a negative value indicates reverse movement (phase B leads phase A).
- A quadrature counter occupies two adjacent points. Input module pairs specifically made for quadrature counting must be used. The first point must be an even point number on the I/O unit. For example, positions 0 and 1, 4 and 5 are valid, but 1 and 2, 3 and 4 are not.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Point</td>
<td>Counter</td>
<td>Bottle_Counter</td>
</tr>
<tr>
<td>Put in</td>
<td>Float Variable</td>
<td>Number_of_Bottles</td>
</tr>
<tr>
<td>Counter</td>
<td>Integer 32 Variable</td>
<td></td>
</tr>
<tr>
<td>Quadrature Counter</td>
<td>Integer 64 Variable</td>
<td></td>
</tr>
</tbody>
</table>

**Action Block Example:**

```plaintext
GetClearCounter(From Point)
Number_of_Bottles = GetClearCounter(Bottle_Counter);
```

This is a function command; it returns the counter or quadrature counter value from the digital input. The returned value can be consumed by a variable (as shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User's Guide (form 1700).

**Notes:**
- The maximum speed at which a counter can operate is limited by the input module's turn-on and turn-off times. Check the specifications for the module to be used.
- For a quadrature counter, the maximum encoder RPM will be related to the number of pulses per revolution that the encoder provides. For details, see the SNAP Quadrature Input Module Data Sheet (form 1053).

**Dependencies:**
- Always use Start Counter once before using this command for the first time. This does not apply to HDD module counters.
- Applies to high-density digital inputs as well as standard digital inputs configured with the counter or quadrature counter feature.
- Available on GRV-EPIC processors, SNAP-PAC-R1 and -R1-B controllers, and SNAP-PAC-EB1 and SNAP-PAC-SB1 brains with firmware 8.1 or later.
See Also:

“Get Counter” on page 169
“Start Continuous Square Wave” on page 190
“Stop Counter” on page 195
“Clear Counter” on page 155
Get & Clear Off-Latch

Digital Point Action

**Function:** To read and re-arm a high-speed off-latch associated with a digital input.

**Typical Use:** To ensure detection of an extremely brief on-to-off transition of a digital input.

**Details:**
- Reads and re-arms the off-latch of a single digital input.
- The next time the input point changes from on to off, the off-latch will be set.
- Off-latches detect on-off-on input transitions that would otherwise occur too fast for the control engine to detect, since they are processed by the I/O unit.
- If *From Point* (Argument 1) is a digital output and the latch is not set, the output will turn off. If the latch is set, the output will turn on.

**Arguments:**

**Argument 0**
- **From Point**
  - Digital Input

**Argument 1**
- **Put in**
  - Digital Output
  - Float Variable
  - Integer 32 Variable

**Action Block Example:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Point</td>
<td>Digital Input</td>
<td>BUTTON_3_LATCH</td>
</tr>
<tr>
<td>Put in</td>
<td>Digital Output</td>
<td>ALARM_HORN</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```
ALARM_HORN = GetClearOffLatch(BUTTON_3_LATCH);
```

This is a function command; it returns a value of true (non-zero) or false (0) indicating whether the off latch has been set. The returned value can be consumed by a digital output (as in the example shown) or by a variable, control structure, and so forth. For more information, see the PAC Control User's Guide (form 1700).

**Notes:** The ability of the I/O units to detect fast input transitions is limited by the input module's turn-on and turn-off times. Check the specifications for the module to be used.

**Dependencies:** Applies only to standard digital inputs.

**See Also:**
- “Get Off-Latch” on page 171
- “Clear Off-Latch” on page 156
- “Clear All Latches” on page 153
CHAPTER 6: DIGITAL POINT COMMANDS

Get & Clear On-Latch

Digital Point Action

Function: To read and re-arm a high-speed on-latch associated with a digital input.

Typical Use: To ensure detection of an extremely brief off-to-on transition of a digital input.

Details:
- Reads and re-arms the on-latch of a single digital input.
- The next time the input point changes from off to on, the on-latch will be set.
- Off-latches detect on-off-on input transitions that would otherwise occur too fast for the control engine to detect, since they are processed by the I/O unit.
- The value read is stored in Put In (Argument 1). If the latch is not set, Put In will contain the value 0 (False). If the latch is set, Put In will be set to non-zero (True).

Arguments:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Point</td>
<td>Digital Input</td>
<td>E_STOP_BUTTON</td>
</tr>
<tr>
<td>Put in</td>
<td>Integer 32 Variable</td>
<td>LATCH_VAR</td>
</tr>
</tbody>
</table>

Action Block Example:

```
Get & Clear On-Latch
```

OptoScript Example:

```
LATCH_VAR = GetClearOffLatch(E_STOP_BUTTON);
```

This is a function command; it returns a value of true (non-zero) or false (0) indicating whether the on latch has been set. The returned value can be consumed by a variable (as in the example shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

Notes: The ability of the I/O unit to detect fast input transitions is limited by the input module’s turn-on and turn-off times. Check the specifications for the module to be used.

 Dependencies: Applies only to standard digital inputs.

See Also: “Get On-Latch” on page 175
“Clear On-Latch” on page 157
“Clear All Latches” on page 153
Get & Restart Off-Pulse Measurement

Digital Point Action

**Function:**
To read and clear the off-time duration of a digital input that has had an on-off-on transition.

**Typical Use:**
To shut down or process interlocking where a momentary pulse of a certain length is required.

**Details:**
- Gets the duration of the first complete off-pulse applied to the digital input.
- Restarts the off-pulse measurement after reading the current value.
- Measurement starts on the first on-to-off transition and stops on the first off-to-on transition.
- Returns a float value representing seconds with a resolution of 100 microseconds.
- Maximum duration is 4.97 days.
- If used while a measurement is in progress, the measurement is terminated, the data is returned, and a new off-pulse measurement is started.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Point</td>
<td>Off Pulse</td>
<td>STANDBY_SWITCH</td>
</tr>
<tr>
<td>Put in</td>
<td>Float Variable</td>
<td>OFF_TIME</td>
</tr>
</tbody>
</table>

**Action Block Example:**

Get & Restart Off-Pulse Measurement

This is a function command; it returns the duration of the first complete off-pulse. The returned value can be consumed by a variable (as shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

**Notes:**
- Use Get Off-Pulse Measurement Complete Status first to see if a complete off-pulse measurement has occurred.
- The accuracy of the value returned is limited by the input module’s turn-on and turn-off times. Check the specifications for the module to be used.

**Dependencies:**
- Applies only to inputs configured with the off-pulse measurement feature.
- Not supported on high-density digital modules.

**See Also:**
- “Get Off-Pulse Measurement” on page 172
- “Get Off-Pulse Measurement Complete Status” on page 173
Get & Restart Off-Time Totalizer

Digital Point Action

**Function:** To read digital input total off time and restart.

**Typical Use:** To accumulate total off time of a device to possibly indicate down-time.

**Details:**
- Reads the accumulated off time of a digital input since it was last reset.
- Returns a float representing seconds with a resolution of 100 microseconds.
- Resets the total to zero after execution.
- Maximum duration is 4.97 days.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Point</td>
<td>Off Totalizer</td>
</tr>
<tr>
<td>Put in</td>
<td>Float Variable</td>
</tr>
<tr>
<td></td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

**Action Block Example:**

Get & Restart Off-Time Totalizer

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Point</td>
<td>Off Totalizer</td>
<td>Power_Status</td>
</tr>
<tr>
<td>Put in</td>
<td>Integer 32 Variable</td>
<td>System_Down_Time</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```
GetRestartOffTimeTotalizer(From Point)
System_Down_Time = GetRestartOffTimeTotalizer(Power_Status);
```

This is a function command; it returns the total off-time of the digital input. The returned value can be consumed by a variable (as shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User's Guide (form 1700).

**Notes:**
- The accuracy of the value returned is limited by the input module's turn-on and turn-off times. Check the specifications for the module to be used.
- Use Get Off-Time Totalizer to read the totalized value without resetting it.
- An event faster than 10 milliseconds (100 Hz with a 50% duty cycle) may introduce an error into your totalized value.
- Digital totalizer commands are supported only on standard 4-channel digital SNAP modules (as well as single channel digital modules on a mystic brick).

**Dependencies:**
- Applies only to inputs configured with the totalize-off feature.
- Available on SNAP PAC R-series controllers, and on SNAP PAC EB- and SB-series brains with firmware 8.2 or later.

**See Also:** "Get Off-Time Totalizer" on page 174
Get & Restart On-Pulse Measurement

Digital Point Action

**Function:**
To read and clear the on-time duration of a digital input that has had an off-on-off transition.

**Typical Use:**
To shut down or process interlocking where a momentary pulse of a certain length is required.

**Details:**
- Gets the duration of the first complete on-pulse applied to the digital input.
- Restarts the on-pulse measurement after reading the current value.
- Measurement starts on the first off-to-on transition and stops on the first on-to-off transition.
- Returns a float value representing seconds with a resolution of 100 microseconds.
- Maximum duration is 4.97 days.
- If used while a measurement is in progress, the measurement is terminated, the data is returned, and a new on-pulse measurement is started.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Point</td>
<td>Off Pulse</td>
<td></td>
</tr>
<tr>
<td>Put in</td>
<td>Float Variable</td>
<td>On_Time</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Action Block Example:**

```
Get & Restart On-Pulse Measurement
```

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Point</td>
<td>On Pulse</td>
<td>Standby_Switch</td>
</tr>
<tr>
<td>Put in</td>
<td>Float Variable</td>
<td>On_Time</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```
GetRestartOnPulseMeasurement(From Point)
On_Time = GetRestartOnPulseMeasurement(Standby_Switch);
```

This is a function command; it returns the duration of the first on-pulse. The returned value can be consumed by a variable (as shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User's Guide (form 1700).

**Notes:**
- Use Get On-Pulse Measurement Complete Status first to see if a complete on-pulse measurement has occurred.
- The accuracy of the value returned is limited by the input module’s turn-on and turn-off times. Check the specifications for the module to be used.

**Dependencies:**
- Applies only to inputs configured with the on-pulse measurement feature.
- Not supported on high-density digital modules.

**See Also:**
- “Get On-Pulse Measurement” on page 176
- “Get On-Pulse Measurement Complete Status” on page 177
Get & Restart On-Time Totalizer

Digital Point Action

**Function:**
To read digital input total on time and restart.

**Typical Use:**
To accumulate total on time of a device.

**Details:**
- Reads the accumulated on time of a digital input since it was last reset.
- Returns a float representing seconds with a resolution of 100 microseconds.
- Resets the total to zero after execution.
- Maximum duration is 4.97 days.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>From Point</td>
<td>On Totalizer</td>
</tr>
<tr>
<td>1</td>
<td>Put in</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

**Action Block Example:**

```plaintext
Get & Restart On-Time Totalizer
```

**OptoScript Example:**

```plaintext
GetRestartOnTimeTotalizer(From Point)
Motor_Runtime = GetRestartOnTimeTotalizer(Circ_Motor_Pwr);
```

This is a function command; it returns the total on-time of the digital input. The returned value can be consumed by a variable (as shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User's Guide (form 1700).

**Notes:**
- The accuracy of the value returned is limited by the input module’s turn-on and turn-off times. Check the specifications for the module to be used.
- Use Get On-Time Totalizer to read the totalized value without resetting it.
- An event faster than 10 milliseconds (100 Hz with a 50% duty cycle) may introduce an error into your totalized value.
- Digital totalizer commands are supported only on standard 4-channel digital SNAP modules (as well as single channel digital modules on a mistic brick).

**Dependencies:**
- Applies only to inputs configured with the totalize-on feature.
- Available on SNAP PAC R-series controllers, and on SNAP PAC EB- and SB-series brains with firmware 8.2 or later.

**See Also:**
“Get On-Time Totalizer” on page 178
Get & Restart Period

Digital Point Action

**Function:** To read and clear the elapsed time during an on-off-on or an off-on-off transition of a digital input.

**Typical Use:** To measure the period of a slow shaft rotation.

**Details:**
- Reads the period value of a digital input and places it in *Put In* (Argument 1).
- Measurement starts on the first transition (either off-to-on or on-to-off) and stops on the next transition of the same type (one complete cycle).
- Restarts the period measurement after reading.
- Returns a float representing seconds with a resolution of 100 microseconds.
- Maximum duration is 4.97 days.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>From Point</td>
<td>Period</td>
</tr>
<tr>
<td>1</td>
<td>Put in</td>
<td>Float Variable</td>
</tr>
</tbody>
</table>

**Action Block Example:**

```
Get & Restart Period

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Point</td>
<td>Period</td>
<td>SHAFT_INPUT</td>
</tr>
<tr>
<td>Put in</td>
<td>Integer 32 Variable</td>
<td>SHAFT_CYCLE</td>
</tr>
</tbody>
</table>
```

**OptoScript Example:**

```
GetRestartPeriod(SHAFT_INPUT);
```

This is a function command; it returns the period. The returned value can be consumed by a variable (as shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the *PAC Control User's Guide* (form 1700).

**Notes:**
- Not available on older SNAP Ethernet brains. In order to use this command, upgrade to a SNAP PAC brain.
- This command should be used to start the period measurement.
- This command measures the first complete period only, and then restarts.
- The accuracy of the value returned is limited by the input module’s turn-on and turn-off times. Check the specifications for the module to be used.
- Period measurement commands are supported only on standard 4-channel digital SNAP modules (as well as single channel digital modules on a *mistic* brick).

**Dependencies:**
- Applies only to inputs configured with the period feature.
- Available on GRV-EPIC processors, SNAP-PAC-R1and -R1-B controllers, SNAP-PAC-EB1 and SNAP-PAC-SB1 brains with firmware 8.1 or later.

**See Also:**
- "Get Period" on page 179
- "Get Period Measurement Complete Status" on page 180
Get Counter
Digital Point Action

Function: To read a standard digital input counter, quadrature counter, or HDD module counter value.

Typical Use: To count pulses from turbine flow meters, magnetic pickups, encoders, proximity switches, and so forth.

Details:
- Reads the current value of a digital input counter, quadrature counter, or HDD module counter and places it in Put In (Argument 1).
- Does not reset the counter or quadrature counter at the I/O unit to zero.
- Does not stop the counter or quadrature counter from continuing to count.
- Valid range for a counter is 0 to 4,294,967,295 counts.
- Valid range for a quadrature counter is -2,147,483,647 to 2,147,483,648 counts.

Arguments:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Point</td>
<td>Counter</td>
<td>Bottle_Counter</td>
</tr>
<tr>
<td>Put in</td>
<td>Float Variable</td>
<td>Number_of_Bottles</td>
</tr>
<tr>
<td>Counter</td>
<td>Integer 32 Variable</td>
<td></td>
</tr>
<tr>
<td>Quadrature Counter</td>
<td>Integer 64 Variable</td>
<td></td>
</tr>
</tbody>
</table>

OptoScript Example:

```optoscript
GetCounter (From Point)

Number_of_Bottles = GetCounter(Bottle_Counter);
```

This is a function command; it returns the counter or quadrature counter value of the digital input. The returned value can be consumed by a variable (as shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

Notes:
- The maximum speed at which the counter can operate is limited by the input module’s turn-on and turn-off times. Check the specifications for the module to be used.
- For a quadrature counter, the maximum encoder RPM will be related to the number of pulses per revolution that the encoder provides. For details, see the SNAP Quadrature Input Module Data Sheet (form 1053).

Dependencies:
- Always use Start Counter once before using this command for the first time. This does not apply to HDD counters.
- Applies to high-density digital inputs as well as standard digital inputs configured with the counter or quadrature counter feature.

See Also:
- “Get & Clear Counter” on page 160
- “Start Continuous Square Wave” on page 190
- “Stop Counter” on page 195
- “Clear Counter” on page 155
Get Frequency
Digital Point Action

**Function:** To read digital input frequency value.

**Typical Use:** To read the speed of rotating machinery, velocity encoders, and so forth.

**Details:**
- Reads the current frequency unit of a digital input and places it in *Put In* (Argument 1).
- The resolution is 1 Hertz (see notes below).

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Point</td>
<td>Put in</td>
</tr>
<tr>
<td>Frequency</td>
<td>Float Variable</td>
</tr>
<tr>
<td></td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

**Action Block Example:**

```
Get Frequency
```

```
Argument Name | Type               | Name
--------------|--------------------|-----------------------
From Point    | Frequency          | SHAFT_PICKUP
Put in        | Integer 32 Variable| MOTOR_SPEED
```

**OptoScript Example:**

```OptoScript
GetFrequency (From Point)
MOTOR_SPEED = GetFrequency (SHAFT_PICKUP);
```

This is a function command; it returns the frequency units value of the digital input. The returned value can be consumed by a variable (as shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the *PAC Control User’s Guide* (form 1700).

**Notes:**
- Not available on older SNAP Ethernet brains. In order to use this command, upgrade to a SNAP PAC brain.
- Since the resolution is 1 Hertz, significant errors may be encountered at frequencies less than 100 Hertz. Use *Get Period*, then divide 1 by the period to get the frequency with resolution to 0.2 Hertz at 60 Hertz.
- The maximum frequency that can be read is limited by the input module’s turn-on and turn-off times. Check the specifications for the module to be used.

**Dependencies:**
Applies only to inputs configured with the frequency feature.

Available on GRV-EPIC processors, SNAP-PAC-R1 and -R1-B controllers, and SNAP-PAC-EB1 and SNAP-PAC-SB1 brains with firmware 8.1 or later.
Get Off-Latch

Digital Point Action

Function: To read the state of an off-latch.

Typical Use: To ensure detection of an extremely brief on-to-off transition of a digital input.

Details:
- Reads an off-latch of a single digital input. Off-latches detect on-to-off input transitions that would otherwise occur too fast for the control engine to detect, since they are processed locally by the I/O unit.
- Places the value read into Put In (Argument 1). Put In will contain a non-zero value (True) if the latch is set, and 0 (False) if the latch is not set.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Point</td>
<td>Put in</td>
</tr>
<tr>
<td>Digital Input</td>
<td>Digital Output</td>
</tr>
</tbody>
</table>

Example:

OptoScript Example:

```
GetOffLatch (From Point)
```

```
if (GetOffLatch(START_BUTTON)) then
```

This is a function command; it returns a value of true (non-zero) or false (0). The returned value can be consumed by a control structure (as in the example shown) or by a variable, I/O point, and so forth. For more information, see the PAC Control User's Guide (form 1700).

Notes: The ability to detect fast input transitions is limited by the input module's turn-on and turn-off times. Check the specifications for the module to be used.

Dependencies: Applies only to standard digital inputs.

See Also: "Get & Clear Off-Latch" on page 162
"Clear Off-Latch" on page 156
"Clear All Latches" on page 153
"Off-Latch Set?" on page 184
Get Off-Pulse Measurement

**Digital Point Action**

**Function:**
To read the off-time duration of a digital input that has had an on-off-on transition.

**Typical Use:**
To shut down or process interlocking where a momentary pulse of a certain length is required.

**Details:**
- Gets the duration of the first complete off-pulse applied to the digital input.
- Measurement starts on the first on-to-off transition and stops on the first off-to-on transition.
- Returns a float value representing seconds with a resolution of 100 microseconds.
- Maximum duration is 4.97 days.

**Arguments:**
- **Argument 0**
  - From Point
  - Off Pulse
- **Argument 1**
  - Put in
  - Float Variable
  - Integer 32 Variable

**Action Block Example:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Point</td>
<td>Off Pulse</td>
<td>Overheat_Switch</td>
</tr>
<tr>
<td>Put in</td>
<td>Float Variable</td>
<td>OFF_TIME</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```plaintext
GetOffPulseMeasurement(From Point)

OFF_TIME = GetOffPulseMeasurement(Overheat_Switch);
```

This is a function command; it returns the duration of the first off-pulse for the digital input. The returned value can be consumed by a variable (as shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the *PAC Control User’s Guide* (form 1700).

**Notes:**
- Use Get Off-Pulse Measurement Complete Status first to see if a complete off-pulse measurement has occurred.
- The accuracy of the value returned is limited by the input module’s turn-on and turn-off times. Check the specifications for the module to be used.

**Dependencies:**
- Applies only to inputs configured with the off-pulse measurement feature.
- Not supported on high-density digital modules.

**See Also:**
- “Get & Restart Off-Pulse Measurement” on page 164
- “Get Off-Pulse Measurement Complete Status” on page 173
Get Off-Pulse Measurement Complete Status

Digital Point Action

Function: To read the completion status of an off-pulse measurement.

Typical Use: To determine that a complete measurement has occurred before reading the measurement.

Details: • Gets the completion status of an off-pulse measurement and stores it in Put In (Argument 1). Put In will contain a non-zero value (True) if the measurement is complete, or a 0 (False) if it is incomplete.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Point</td>
<td>Put In</td>
</tr>
<tr>
<td>Off Pulse</td>
<td>Float Variable</td>
</tr>
<tr>
<td></td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

Action Block Example:

OptoScript Example:

```
Pulse_Complete = GetOffPulseMeasurementCompleteStatus(Overheat_Switch);
```

This is a function command; it returns a value of true (-1) or false (0), indicating whether a complete measurement has occurred. The returned value can be consumed by a variable (as in the example shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

Notes: • Use this command to see if a complete off-pulse measurement has occurred. The command will not interfere with a current off-pulse measurement.
• Once the completion status is True, use Get Off-Pulse Measurement or Get & Restart Off-Pulse Measurement to read the value.

Dependencies: • Applies only to inputs configured with the off-pulse measurement feature.
• Available on SNAP PAC R-series controllers, and some SNAP PAC EB-series brains.
• Not supported on high-density digital modules.

See Also: “Get Off-Pulse Measurement” on page 172
“Get & Restart Off-Pulse Measurement” on page 164
Get Off-Time Totalizer
Digital Point Action

Function: To read digital input total off time.

Typical Use: To accumulate the total off time of a device to possibly indicate downtime.

Details:
- Reads the accumulated off time of a digital input since it was last reset.
- Returns a float representing seconds with a resolution of 100 microseconds.
- Maximum duration is 4.97 days.
- Does not reset the total.

Arguments:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Point</td>
<td>Off Totalizer</td>
<td>Heater_Output</td>
</tr>
<tr>
<td>Put in</td>
<td>Float Variable</td>
<td>Heater_Down_Time</td>
</tr>
</tbody>
</table>

OptoScript Example:
```
GetOffTimeTotalizer(From Point)
Heater_Down_Time = GetOffTimeTotalizer(Heater_Output);
```

This is a function command; it returns the total time the digital input was off. The returned value can be consumed by a variable (as shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

Notes:
- To ensure the totalizer is cleared at start-up, use Get & Restart Off-Time Totalizer once before using this command for the first time.
- The accuracy of the value returned is limited by the input module’s turn-on and turn-off times. Check the specifications for the module to be used.
- An event faster than 10 milliseconds (100 Hz with a 50% duty cycle) may introduce an error into your totalized value.
- Digital totalizer commands are supported only on standard 4-channel digital SNAP modules (as well as single channel digital modules on a mistic brick).

Dependencies:
- Applies only to inputs configured with the totalize-off feature.
- Available on SNAP PAC R-series controllers, and on SNAP PAC EB- and SB-series brains with firmware 8.2 or later.

See Also: “Get & Restart Off-Time Totalizer” on page 165
Get On-Latch

Digital Point Action

Function: To read the state of an on-latch.

Typical Use: To ensure detection of an extremely brief off-to-on transition of a digital input.

Details:
- Reads an on-latch of a single digital input. On-latches detect off-to-on input transitions that would otherwise occur too fast for the control engine to detect, since they are processed locally by the I/O unit.
- Places the value read into Put In (Argument 1). Put In will contain a non-zero value (True) if the latch is set, and 0 (False) if the latch is not set.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Point</td>
<td>Put In</td>
</tr>
<tr>
<td>Digital Input</td>
<td>Digital Output</td>
</tr>
<tr>
<td></td>
<td>Float Variable</td>
</tr>
<tr>
<td></td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

Action Block Example:

```
Get On-Latch
```

OptoScript Example:

```
if (GetOnLatch(ESTOP_BUTTON)) then
```

This is a function command; it returns a value of true (non-zero) or false (0). The returned value can be consumed by a control structure (as in the example shown) or by a variable, I/O point, and so forth. For more information, see the PAC Control User's Guide (form 1700).

Notes: The ability to detect fast input transitions is limited by the input module's turn-on and turn-off times. Check the specifications for the module to be used.

Dependencies: Applies only to standard digital inputs.

See Also: "Get & Clear On-Latch" on page 163
"Clear On-Latch" on page 157
"Clear All Latches" on page 153
"On-Latch Set?" on page 186
CHAPTER 6: DIGITAL POINT COMMANDS

Get On-Pulse Measurement

Digital Point Action

Function: To read the on-time duration of a digital input that has had an off-on-off transition.

Typical Use: To shut down or process interlocking where a momentary pulse of a certain length is required.

Details:
- Gets the duration of the first complete on-pulse applied to the digital input.
- Measurement starts on the first off-to-on transition and stops on the first on-to-off transition.
- Returns a float representing seconds with a resolution of 100 microseconds.
- Maximum duration is 4.97 days.

Arguments:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Point</td>
<td>On Pulse</td>
<td>Overspeed_Switch</td>
</tr>
<tr>
<td>Put in</td>
<td>Float Variable</td>
<td>On_Time</td>
</tr>
</tbody>
</table>

Action Block Example:

Get On-Pulse Measurement

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Point</td>
<td>On Pulse</td>
<td>Overspeed_Switch</td>
</tr>
<tr>
<td>Put in</td>
<td>Float Variable</td>
<td>On_Time</td>
</tr>
</tbody>
</table>

OptoScript Example:

GetOnPulseMeasurement(From Point)

On_Time = GetOnPulseMeasurement(Overspeed_Switch);

This is a function command; it returns the duration of the first on-pulse for the digital input. The returned value can be consumed by a variable (as shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User's Guide (form 1700).

Notes:
- Use Get On-Pulse Measurement Complete Status first to see if a complete on-pulse measurement has occurred.
- The accuracy of the value returned is limited by the input module's turn-on and turn-off times. Check the specifications for the module to be used.

Dependencies:
- Applies only to inputs configured with the on-pulse measurement feature.
- Not supported on high-density digital modules.

See Also: "Get & Restart On-Pulse Measurement" on page 166
"Get On-Pulse Measurement Complete Status" on page 177
Get On-Pulse Measurement Complete Status

Digital Point Action

Function: To read the completion status of an on-pulse measurement.

Typical Use: To determine that a complete measurement has occurred before reading the measurement.

Details:
- Gets the completion status of an on-pulse measurement and stores it in \texttt{Put In} (Argument 1). \texttt{Put In} will contain a non-zero value (True) if the measurement is complete, or a 0 (False) if it is incomplete.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Point</td>
<td>Put in</td>
</tr>
<tr>
<td>On Pulse</td>
<td>Float Variable</td>
</tr>
<tr>
<td></td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

Action Block Example:

\begin{table}[h!]
\centering
\begin{tabular}{|c|c|c|}
\hline
\textbf{Argument Name} & \textbf{Type} & \textbf{Name} \\
\hline
From Point & On Pulse & Pressure\_Switch \\
Put in & Integer 32 Variable & Pulse\_Complete \\
\hline
\end{tabular}
\end{table}

OptoScript Example:

\begin{verbatim}
GetOnPulseMeasurementCompleteStatus(From Point)
\end{verbatim}

This is a function command; it returns a value of true (-1) or false (0), indicating whether a complete measurement has occurred. The returned value can be consumed by a variable (as in the example shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User's Guide (form 1700).

Notes:
- Use this command to see if a complete on-pulse measurement has occurred. The command will not interfere with a current on-pulse measurement.
- Once the completion status is True, use \texttt{Get On-Pulse Measurement} or \texttt{Get & Restart On-Pulse Measurement} to read the value.

Dependencies:
- Applies only to inputs configured with the on-pulse measurement feature.
- Not supported on high-density digital modules.

See Also:
- “Get & Restart On-Pulse Measurement” on page 166
- “Get On-Pulse Measurement” on page 176
Get On-Time Totalizer

Digital Point Action

Function: To read digital input total on time.

Typical Use: To accumulate total on time of a device.

Details: 
- Reads the accumulated on time of a digital input since it was last read.
- Returns a float representing seconds with a resolution of 100 microseconds.
- Maximum duration is 4.97 days.
- Does not reset the total.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Point</td>
<td>Put in</td>
</tr>
<tr>
<td>On Totalizer</td>
<td>Float Variable</td>
</tr>
<tr>
<td>Pump_Power</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

Action Block Example:

Get On-Time Totalizer

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Point</td>
<td>On Totalizer</td>
<td>Pump_Power</td>
</tr>
<tr>
<td>Put in</td>
<td>Float Variable</td>
<td>Pump_Runtime</td>
</tr>
</tbody>
</table>

OptoScript Example:

```
GetOnTimeTotalizer (From Point)  
Pump_Runtime = GetOnTimeTotalizer(Pump_Power);
```

This is a function command; it returns the total time the digital input was on. The returned value can be consumed by a variable (as shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

Notes: 
- To ensure the totalizer is cleared at start-up, use Get & Restart On-Time Totalizer once before using this command for the first time.
- The accuracy of the value returned is limited by the input module’s turn-on and turn-off times. Check the specifications for the module to be used.
- An event faster than 10 milliseconds (100 Hz with a 50% duty cycle) may introduce an error into your totalized value.
- Digital totalizer commands are supported only on standard 4-channel digital SNAP modules (as well as single channel digital modules on a mistic brick).

Dependencies: 
- Applies only to inputs configured with the totalize-on feature.
- Available on SNAP PAC R-series controllers, and on SNAP PAC EB- and SB-series brains with firmware 8.2 or later.

See Also: “Get & Restart On-Time Totalizer” on page 167
Get Period

Digital Point Action

Function: To read the elapsed time during an on-off-on or an off-on-off transition of a digital input.

Typical Use: To measure the period of a slow shaft rotation.

Details:
- Measurement starts on the first transition (either off-to-on or on-to-off) and stops on the next transition of the same type (one complete cycle).
- Does not restart the period measurement.
- Returns a float representing seconds with a resolution of 100 microseconds.
- Maximum duration is 4.97 days.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Point</td>
<td>Put in</td>
</tr>
<tr>
<td>Period</td>
<td>Float Variable</td>
</tr>
</tbody>
</table>

Action Block Example:

```
Get Period
```

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Point</td>
<td>Period</td>
<td>SHAFT_INPUT</td>
</tr>
<tr>
<td>Put in</td>
<td>Float Variable</td>
<td>SHAFT_CYCLE</td>
</tr>
</tbody>
</table>

OptoScript Example:

```
SHAFT_CYCLE = GetPeriod(SHAFT_INPUT);
```

This is a function command; it returns the period for the digital input. The returned value can be consumed by a variable (as shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

Notes:
- Not available on older SNAP Ethernet brains. In order to use this command, upgrade to a SNAP PAC brain.
- This command measures the first complete period only. No period measurement is performed after the first measurement until the Get & Restart Period command is used.
- The accuracy of the value returned is limited by the input module’s turn-on and turn-off times. Check the specifications for the module to be used.
- Period measurement commands are supported only on standard 4-channel digital SNAP modules (as well as single channel digital modules on a mistic brick).

Dependencies:
- The Get & Restart Period command must be used to start the measurement.
- Applies only to inputs configured with the period feature.
- Available on GRV-EPIC processors, SNAP-PAC-R1 and -R1-B controllers, SNAP-PAC-EB1 and SNAP-PAC-SB1 brains with firmware 8.1 or later.

See Also:
- “Get & Restart Period” on page 168
- “Get Period Measurement Complete Status” on page 180
Get Period Measurement Complete Status

Digital Point Action

**Function:** To read the completion status of a period measurement.

**Typical Use:** To determine that a complete measurement has occurred before reading the measurement.

**Details:** Gets the completion status of a period measurement and stores it in *Put In* (Argument 1). *Put In* will contain a non-zero value (True) if the measurement is complete, or a 0 (False) if it is incomplete.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Point</td>
<td>Float Variable</td>
<td>Period</td>
</tr>
<tr>
<td>Put in</td>
<td>Integer 32 Variable</td>
<td>Period_Complete</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```
GetPeriodMeasurementCompleteStatus(From Point)
Period_Complete = GetPeriodMeasurementCompleteStatus(Pressure_Switch);
```

This is a function command; it returns a value of true (non-zero) or false (0), indicating whether a complete measurement has occurred. The returned value can be consumed by a variable (as in the example shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the *PAC Control User’s Guide* (form 1700).

**Notes:**

- Not available on older SNAP Ethernet brains. In order to use this command, upgrade to a SNAP PAC brain.
- Use this command to see if a complete period measurement has occurred. The command will not interfere with a current period measurement.
- Once the completion status is True, use *Get Period* or *Get & Restart Period* to read the value.
- Period measurement commands are supported only on standard 4-channel digital SNAP modules (as well as single channel digital modules on a mistic brick).

**Dependencies:**

- Applies only to inputs configured with the period measurement feature.
- Available on GRV-EPIC processors, SNAP-PAC-R1 and -R1-B controllers, SNAP-PAC-EB1 and SNAP-PAC-SB1 brains with firmware 8.1 or later.

**See Also:**

- “Get & Restart Period” on page 168
- “Get Period” on page 179
Get TPO Percent
Digital Point Action

Function: Reads the current setting of the time proportional output (TPO) percent.

Typical Use: To find out the value of the TPO percent.

Details: • The value returned is the percentage of on time. For example, if the TPO period is 2 seconds and this command returns a value of 10, it means the channel was:
  – On for 0.2 seconds (2 seconds x 10%)
  – Off for 1.8 seconds (2 seconds - on time).
• The TPO percent is set by using the Set TPO Percent command.

Arguments: Argument 0 Argument 1
From Point Put in
TPO Float Variable

Action Block Example:

```
Get TPO Percent

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Point</td>
<td>Time Proportional Output</td>
<td>Heater_Output</td>
</tr>
<tr>
<td>Put in</td>
<td>Float Variable</td>
<td>TPO_Percent</td>
</tr>
</tbody>
</table>
```

OptoScript Example:

```optoscript
GetTpoPercent (From Point)
```

TPO_Percent = GetTpoPercent (Heater_Output);

This is a function command; it returns the value of the TPO percent.

Notes: • Supported on:
  – SNAP PAC I/O units using standard 4-channel digital SNAP modules and SNAP high-density digital (HDD) modules.
  – Ultimate I/O units using standard 4-channel digital SNAP modules. (Ultimate I/O does not support HDD modules.)
• This command is not supported on the 2-channel SNAP-AOD-29 or SNAP-AOD-29-HFi modules.

Dependencies: Applies only to output points configured with the TPO feature.

See Also: “Get TPO Period” on page 182
“Set TPO Percent” on page 187
“Set TPO Period” on page 188
Get TPO Period

Digital Point Action

Function: To read the current setting of the time proportional output (TPO) period.

Typical Use: To find the setting of the TPO period.

Details:
- The TPO period is set by using the Set TPO Period command.
- On groov digital output modules, the minimum TPO period is module-specific. For more information, see the specifications for your groov digital output module.
- This command is not supported on Mistic-protocol devices such as G4 bricks, and B3000 and B3000-B brains.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Point</td>
<td>Put in</td>
</tr>
<tr>
<td>TPO</td>
<td>Float Variable</td>
</tr>
</tbody>
</table>

Action Block Example:

```
Get TPO Period
```

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Point Time Proportional Output Heater_Output</td>
<td>TPO_Period</td>
<td></td>
</tr>
<tr>
<td>Put in Float Variable</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

OptoScript Example:

```
GetTpoPeriod(From Point)
TPO_Period = GetTpoPeriod(Heater_Output);
```

This is a function command; it returns the value of the TPO period.

Notes:
- Supported on:
  - SNAP PAC I/O units using standard 4-channel digital SNAP modules and SNAP high-density digital (HDD) modules.
  - Ultimate I/O units using standard 4-channel digital SNAP modules. (Ultimate I/O does not support HDD modules.)
- This command is not supported on the 2-channel SNAP-AOD-29 or SNAP-AOD-29-HFi modules.

Dependencies: Applies only to output points configured with the TPO feature.

See Also: 
- "Get TPO Percent" on page 181
- "Set TPO Percent" on page 187
- "Set TPO Period" on page 188
**Off?**

**Digital Point Condition**

**Function:** To determine if a digital input or output is off.

**Typical Use:** To determine the status of a digital input or output point.

**Details:**
- If the specified point is off, the logic will take the True path.
- If the specified point is not off, the logic will take the False path.
- Speed Tip: Use Get I/O Unit as Binary Value or Get I/O Unit as Binary Value 64 to get the state of all digital points at once. Then use Bit Test to determine the state of individual points.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is</td>
<td>Digital Input</td>
<td>Safety_Interlock</td>
</tr>
</tbody>
</table>

**Condition Block Example:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is</td>
<td>Digital Input</td>
<td>Safety_Interlock</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```
IsOff (Is)
```

```
if (IsOff(Safety_Interlock)) then
```

This is a function command; it returns a value of true (non-zero) or false (0). The returned value can be consumed by a control structure (as in the example shown) or by a variable, I/O point, and so forth. For more information, see the *PAC Control User’s Guide* (form 1700).

**Notes:**

- May be used with either input or output points.

**Dependencies:**

- Applies to all digital inputs and outputs.

**See Also:**

- “On?” on page 185
Off-Latch Set?
Digital Point Condition

Function: Checks the status of the specified off latch.

Typical Use: To determine if a button was pressed or an object passed by a sensor.

Details: If the off-latch is set, the logic will take the True path.
If the off-latch is not set, the logic will take the False path.

Arguments: Argument 0
On Point
Digital Input

Condition Block Example:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>On Point</td>
<td>Digital Input</td>
<td>PUMP3_STOP_BUTTON</td>
</tr>
</tbody>
</table>

OptoScript Example: IsOffLatchSet(On Point)

if (IsOffLatchSet(PUMP3_STOP_BUTTON)) then

This is a function command; it returns a value of true (non-zero) or false (0). The returned value can be consumed by a control structure (as in the example shown) or by a variable, I/O point, and so forth. For more information, see the PAC Control User’s Guide (form 1700).

Notes: Use Clear Off-Latch if true to reset the latch for next time.

See Also: “On-Latch Set?” on page 186
On?
Digital Point Condition

**Function:**
To determine if a digital input or output is on.

**Typical Use:**
To determine the status of a digital input or output point.

**Details:**
If the specified point is on, the logic will take the True path. If the specified point is not on, the logic will take the False path.

**Arguments:**
- **Argument 0**
  - Is
    - Digital Input
    - Digital Output

**Condition Block Example:**

```
On?
```

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>On Point</td>
<td>Digital Input</td>
<td>Motor_Power</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```
IsOn (Is)
if (IsOn(Motor_Power)) then
```

This is a function command; it returns a value of true (non-zero) or false (0). The returned value can be consumed by a control structure (as in the example shown) or by a variable, I/O point, and so forth. For more information, see the **PAC Control User’s Guide** (form 1700).

**Notes:**
- May be used with either input or output points.
- *Speed Tip:* Use **Get I/O Unit as Binary Value** or **Get I/O Unit as Binary Value 64** to get the state of all digital points at once. Then use **Bit Test** to determine the state of individual points.

**Dependencies:**
Applies to all digital inputs and outputs.

**See Also:**
“Off?” on page 183
On-Latch Set?

Digital Point Condition

**Function:** Checks the status of the specified on latch.

**Typical Use:** To determine if a button was pressed or an object passed by a sensor.

**Details:** If the on-latch is set, the logic will take the True path. If the on-latch is not set, the logic will take the False path.

**Arguments:**

- **Argument 0**
  - **On Point**
  - Digital Input

**Condition Block Example:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>On Point</td>
<td>Digital Input</td>
<td>Clip_Missing_Prox</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```plaintext
IsOnLatchSet(On Point)
if (IsOnLatchSet(Clip_Missing_Prox)) then
```

This is a function command; it returns a value of true (non-zero) or false (0). The returned value can be consumed by a control structure (as in the example shown) or by a variable, I/O point, and so forth. For more information, see the *PAC Control User's Guide* (form 1700).

**Notes:** Use Clear On-Latch if true to reset the latch for next time.

**See Also:** *"Off-Latch Set?" on page 184*
Set TPO Percent
Digital Point Action

Function: To set the on time of an output point as a percentage.

Typical Use: To vary the net output percentage over time. Commonly used to control heater outputs in a pseudo-analog fashion.

Details:
- Sets the percentage of on time for an output configured as a TPO.
- Valid range is 0 (always off) to 100 (always on).
- A TPO period of 10 seconds and an output of 20 percent will cause the output point to go on for 2.0 seconds (10 seconds x .20) and off for 8.0 seconds at 10-second intervals.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>To (Percent)</td>
<td>On Point</td>
</tr>
<tr>
<td>Float Literal</td>
<td>TPO</td>
</tr>
<tr>
<td>Float Variable</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td></td>
</tr>
</tbody>
</table>

Action Block Example:

```
Set TPO Percent
```

OptoScript Example:

```
SetTpoPercent (To (Percent), On Point)
```

This is a procedure command; it does not return a value.

Notes:
- When using the output of a PID to drive a digital TPO, scale the analog output point (for the PID) to 0–100. (This analog point does not have to exist physically, but must be one of the 16 points on the I/O unit.) Use Move to copy the PID analog output value to the digital TPO point periodically.
- At low percentages, the output module’s minimum turn-on and turn-off times may affect the accuracy of control. Check the specifications for the module to be used.
- To ensure that the TPO period will always be correct, store this and other changeable I/O unit values in flash memory (EEPROM) at the I/O unit using the Debug mode in PAC Control. Some older hardware and firmware will not support this feature. For more information, see the PAC Control User’s Guide (form 1700).
- Setting the value of a digital TPO overrides any prior Turn On or Turn Off command for the digital point.
- Supported on standard 4-channel digital SNAP modules, single channel digital modules on a mistic brick, and high-density digital modules.

Dependencies:
- Set TPO Period must be used at least once before this command to define the time period.
- Applies only to output points configured with the TPO feature.

See Also:
- “Get TPO Percent” on page 181
- “Get TPO Period” on page 182
- “Set TPO Period” on page 188
CHAPTER 6: DIGITAL POINT COMMANDS

Set TPO Period
Digital Point Action

Function: To set the time proportional output (TPO) period of an output point.

Typical Use: To vary the percentage of on time (duty cycle). Commonly used to control heater outputs in a pseudo-analog fashion.

Details: • This command must be used before the Set TPO Percent command.
• Sets the period of a TPO to the specified value. Each groov digital output module and SNAP PAC brain enforces a minimum period. The period is the On Time plus the Off Time. If you specify an On Time and Off Time that total less than the minimum period, the times are scaled proportionally to the minimum period.

On groov digital output modules, the minimum TPO period is module-specific. For more information, see the specifications for your groov digital output module.

The minimum periods for SNAP PAC brains are:

- SNAP-PAC-R1 0.006 seconds
- SNAP-PAC-R1-B 0.006 seconds
- SNAP-PAC-EB1 0.040 seconds
- SNAP-PAC-SB1 0.050 seconds
- SNAP-PAC-R2 0.1 seconds
- SNAP-PAC-EB2 0.1 seconds
- SNAP-PAC-SB2 0.1 seconds

For example, if you specify 0.001 seconds on / 0.002 seconds off for a SNAP-PAC-R1, it will instead produce 0.002 seconds on / 0.004 seconds off, maintaining the On Time’s 33% of the total period. In the same situation, a SNAP-PAC-EB1 would produce 0.013 seconds on / 0.027 seconds off.

Arguments: 

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>To (Seconds)</td>
<td>Float Literal</td>
<td>60.0</td>
</tr>
<tr>
<td>On Point</td>
<td>TPO</td>
<td>Heater_Output</td>
</tr>
</tbody>
</table>

Action Block Example: 

```
Set TPO Period 
```

OptoScript Example: 

```
SetTpoPeriod(To (Seconds), On Point)
```

This is a procedure command; it does not return a value.

Notes: • The time proportion period specifies only the total time over which the output is varied. Set TPO Percent sets the on and off time within this period. For example, a TPO period of 30 seconds and an output of 25
percent will cause the output point to go on for 7.5 seconds (30 seconds x 0.25) and off for 22.5 seconds at 30-second intervals.

- Be sure to check the digital output module specifications for the minimum turn-on and turn-off times.
- To ensure that the TPO period will always be correct, store this and other changeable I/O unit values in flash memory (EEPROM) at the I/O unit using the Debug mode in PAC Control. Some older hardware and firmware will not support this feature. For more information, see the PAC Control User’s Guide (form 1700).
- If the TPO period is not stored in flash memory at the I/O unit, use this command immediately before Set TPO Percent every time. This ensures that the TPO period will be configured properly if the I/O unit has experienced loss of power. However, do not issue these commands too frequently, since this can cause unnecessary interruptions in ongoing processes.
- Supported on standard 4-channel digital SNAP modules, single channel digital modules on a mistic brick, and high-density digital modules.

**Dependencies:** Applies only to output points configured with the TPO feature.

**See Also:**
- “Get TPO Percent” on page 181
- “Get TPO Period” on page 182
- “Set TPO Percent” on page 187
Start Continuous Square Wave
Digital Point Action

Function: To generate a square wave on an output point.

Typical Use: To drive stepper motor controllers, pulse indicator lamps, or horns or counters connected to digital outputs.

Details:
- Generates a digital waveform on the specified digital output point.
  
  **On Time (Seconds)** (Argument 0) specifies the amount of time in seconds that the point will remain on during each pulse.
  
  **Off Time (Seconds)** (Argument 1) specifies the amount of time the point will remain off.

- Each SNAP PAC brain enforces a minimum period. The period is the On Time plus the Off Time. If you specify an On Time and Off Time that total less than the minimum period, the times are scaled proportionally to the minimum period.

  The minimum periods for SNAP PAC brains are:

  - SNAP-PAC-R1: 0.006 seconds
  - SNAP-PAC-R1-B: 0.006 seconds
  - SNAP-PAC-EB1: 0.040 seconds
  - SNAP-PAC-SB1: 0.050 seconds
  - SNAP-PAC-R2: 0.1 seconds
  - SNAP-PAC-EB2: 0.1 seconds
  - SNAP-PAC-SB2: 0.1 seconds

  For example, if you specify 0.001 seconds on / 0.002 seconds off for a SNAP-PAC-R1, it will instead produce 0.002 seconds on / 0.004 seconds off, maintaining the On Time’s 33% of the total period. In the same situation, a SNAP-PAC-EB1 would produce 0.013 seconds on / 0.027 seconds off.

- On SNAP PAC brains, the total period must be less than 49.7 days.
- On SNAP PAC brains, if a square wave is already running when this command is used, the new timing becomes effective on the next off-to-on transition.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>On Time (Seconds)</strong></td>
<td><strong>Off Time (Seconds)</strong></td>
<td><strong>On Point</strong></td>
</tr>
<tr>
<td>Float Literal</td>
<td>Float Literal</td>
<td>Digital Output</td>
</tr>
<tr>
<td>Float Variable</td>
<td>Float Variable</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
<td></td>
</tr>
</tbody>
</table>

Action Block Example:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>On Time (Seconds)</strong></td>
<td>Integer 32 Literal</td>
<td>0.100</td>
</tr>
<tr>
<td><strong>Off Time (Seconds)</strong></td>
<td>Integer 32 Literal</td>
<td>0.500</td>
</tr>
<tr>
<td><strong>On Point</strong></td>
<td>Digital Output</td>
<td>BLINKING_LAMP</td>
</tr>
</tbody>
</table>

OptoScript Example:

```plaintext
StartContinuousSquareWave (On Time (Seconds), Off Time (Seconds), On Point)
StartContinuousSquareWave(0.100, 0.500, BLINKING_LAMP);
```
This is a procedure command; it does not return a value.

**Notes:**
- Once the pulse train has started, the digital I/O unit maintains the waveform indefinitely.
- Pulse trains are canceled when a Turn Off or Turn On is sent to the output. To programmatically cancel a pulse train, use this command with both the on times and off times set to 0. Pulse trains will also be canceled if the brain receives a reset command.
- The digital output module’s minimum turn-on and turn-off times may be greater. Check the specifications for the module to be used.
- Supported on standard 4-channel digital SNAP modules, single channel digital modules on a mistic brick, and high-density digital modules.

**Dependencies:**
Applies only to outputs.

**See Also:**
“Generate N Pulses” on page 158
CHAPTER 6: DIGITAL POINT COMMANDS

Start Counter
Digital Point Action

Function: To reactivate a standard digital input counter or quadrature counter.

Typical Use: To restart a digital input counter or quadrature counter after it has been stopped.

Details: • Standard digital only. High-density digital counters cannot be stopped or started. Therefore, this command is not required with HDD counters.
• Counters start as soon as they are configured, and Start Counter is only used after you have used the Stop Counter command.
• Does not reset the counter or quadrature counter to zero.
• Retains any previously accumulated counts.
• A quadrature counter occupies two adjacent points, so SNAP-IDCSQ quadrature modules appear with only points 00 and 02 available.

Arguments: Argument 0
On Point
Counter
Quadrature Counter

Action Block
Example: Start Counter

OptoScript Example: StartCounter (On Point)
StartCounter (BAGGAGE_COUNTER);

This is a procedure command; it does not return a value.

Queue Errors: -36 = Invalid command or feature not implemented. (This command applies only to standard digital points. Digital modules with more than four points are automatically configured as counters and do not need this command.)

-93 = I/O Unit not enabled. Previous communication failure may have disabled communication to the unit automatically. Reenable communication to the unit and try again. (The I/O Unit and point must be enabled for this command to work.)

Notes: Use Clear Counter or Get & Clear Counter to clear a counter or quadrature counter to zero.

Dependencies: • Applies to standard digital inputs configured with the counter or quadrature counter feature. HDD counters do not need this command.
• Available on GRV-EPIC processors, SNAP-PAC-R1 and -R1-B controllers, SNAP-PAC-EB1 and SNAP-PAC-SB1 brains with firmware 8.1 or later.

See Also: • “Clear Counter” on page 155
• “Get & Clear Counter” on page 160
• “Get Counter” on page 169
• “Stop Counter” on page 195
Start Off-Pulse
Digital Point Action

Function: To turn off a digital output for a specified time or to delay turning it on.

Typical Uses:
- To serve as an alternative to the Turn On command.
- To "reset" another device.

Details:
- Same as using Turn Off followed by a delay followed by Turn On, or if the output was off already, same as a delay followed by Turn On.
- After the off time expires, this command leaves the point on.
- The time may be specified from 0.0005 to 429,496.7000 seconds (4.97 days), with a resolution of 100 microseconds. However, the digital output module's minimum turn-on and turn-off times may be greater. Check the specifications for the module to be used.
- During the execution of this command, if another Start Off-Pulse is performed, the current off-pulse is canceled and the new off-pulse is generated.
- The output does not have to be configured with a feature to use this command.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off Time (Seconds)</td>
<td>On Point</td>
</tr>
<tr>
<td>Float Literal</td>
<td>Digital Output</td>
</tr>
<tr>
<td>Float Variable</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td></td>
</tr>
</tbody>
</table>

OptoScript Example:

```
StartOffPulse(RESET_TIME, PUMP_2_STOP);
```

This is a procedure command; it does not return a value.

Notes: CAUTION: If this command is used more frequently than the specified delay, the output will remain off.

- A Turn On command may be used to abort an off-pulse before the end of the off time.
- Supported on standard 4-channel digital SNAP modules, single channel digital modules on a mistic brick, and high-density digital modules.

Dependencies: Applies only to outputs.

See Also:
- "Start On-Pulse" on page 194
- "Turn Off" on page 196
- "Turn On" on page 197
Start On-Pulse

Digital Point Action

**Function:**
To turn on a digital output for a specified period or to delay turning it off.

**Typical Uses:**
- To “reset” another device.
- To increment a counter.
- To latch devices connected to digital outputs that require a minimum pulse duration to latch, such as motor starters and latching relays.

**Details:**
- Same as using Turn On followed by a delay followed by Turn Off, or if the output was on already, same as a delay followed by Turn Off.
- After the on time expires, this command turns the point off.
- The time may be specified from 0.0005 to 429,496.7000 seconds (4.97 days), with a resolution of 100 microseconds. However, the digital output module's minimum turn-on and turn-off times may be greater. Check the specifications for the module to be used.
- During the execution of this command, if another Start On-Pulse is performed, the current on-pulse is canceled and the new On-pulse is generated.
- The output does not have to be configured with a feature to use this command.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>On Time (Seconds)</td>
<td>On Point</td>
</tr>
<tr>
<td>Float Literal</td>
<td>Digital Output</td>
</tr>
<tr>
<td>Float Variable</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td></td>
</tr>
</tbody>
</table>

**Action Block Example:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>On Time (Seconds)</td>
<td>Float Variable</td>
<td>MIN_LATCH_TIME</td>
</tr>
<tr>
<td>On Point</td>
<td>Digital Output</td>
<td>PUMP_2_RUN</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

StartOnPulse(On Time (Seconds), On Point)

StartOnPulse(MIN_LATCH_TIME, PUMP_2_RUN);

This is a procedure command; it does not return a value.

**Notes:**
- **Caution:** If this command is used more frequently than the specified delay, the output will remain on.
- A Turn Off command may be used to abort an on-pulse before the end of the on time.
- Supported on standard 4-channel digital SNAP modules, single channel digital modules on a mystic brick, and SNAP high-density digital modules. For details, see Legacy and Current SNAP Product Comparison and Compatibility Charts (form 1693).

**See Also:**
- “Start Off-Pulse” on page 193
- “Turn Off” on page 196
- “Turn On” on page 197
Stop Counter

Digital Point Action

Function: To deactivate a standard digital input counter or quadrature counter.

Typical Use: To inhibit a counter or quadrature counter until further notice.

Details:
- Standard digital only. High-density digital counters cannot be stopped or started.
- Stops the specified counter or quadrature counter.
- Stops counting incoming quadrature pulses until Start Counter is used.
- Does not reset the counter or quadrature counter to zero.
- Retains any previously accumulated counts.
- A quadrature counter occupies two adjacent points, so quadrature modules appear with only points 00 and 02 available.

Arguments:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>On Point</td>
<td>Counter</td>
<td>BEAN_COUNTER</td>
</tr>
</tbody>
</table>

Action Block Example:

```
StopCounter(On Point)
```

OptoScript Example:

```
StopCounter (On Point)
StopCounter (BEAN_COUNTER);
```

This is a procedure command; it does not return a value.

Queue Errors:

- 36 = Invalid command or feature not implemented. (This command applies only to standard digital points. Digital modules with more than four points are automatically configured as counters and do not need this command.)
- 93 = I/O Unit not enabled. Previous communication failure may have disabled communication to the unit automatically. Reenable communication to the unit and try again. (The I/O Unit and point must be enabled for this command to work.)

Notes: Use Clear Counter or Get & Clear Counter to set counts to zero.

Dependencies:
- Applies to standard digital inputs configured with the counter or quadrature counter feature.
- Available on GRV-EPIC processors, SNAP-PAC-R1 and -R1-B controllers, SNAP-PAC-EB1 and SNAP-PAC-SB1 brains with firmware 8.1 or later.

See Also: “Get Counter” on page 169
“Get & Clear Counter” on page 160
“Clear Counter” on page 155
“Start Continuous Square Wave” on page 190
CHAPTER 6: DIGITAL POINT COMMANDS

Turn Off
Digital Point Action

Function: To turn off a standard digital output point.

Typical Use: To deactivate devices connected to digital outputs, such as motors, pumps, lights, and so forth.

Details:
• Turns off the specified output.
• The output will remain off until directed otherwise.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Value]</td>
</tr>
<tr>
<td>Digital Output</td>
</tr>
</tbody>
</table>

Action Block Example:

```
Turn Off
```

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>(none)</td>
<td>Digital Output</td>
<td>The_Lights</td>
</tr>
</tbody>
</table>

OptoScript Example:

```
TurnOff (Argument 0)
```

```
TurnOff(The_Lights);
```

This is a procedure command; it does not return a value.

In OptoScript code, you could also assign the output a zero value to turn it off:

```
The_Lights = 0;
```

Notes:
• To cause an output on one I/O unit to assume the state of an input on another I/O unit, use Move in standard commands or an assignment in OptoScript code.
• Use NOT to cause an output on one I/O unit to assume the opposite state of an input on another I/O unit.
• Speed Tip: Use Set I/O Unit from MOMO Masks to turn off all outputs at once.

Dependencies: If communication to the specific output point or I/O unit is disabled, no action will occur at the output point (XVAL). The IVAL, however, will be updated.

See Also:
“Set I/O Unit from MOMO Masks” on page 292
“Turn On” on page 197
**Turn On**

**Digital Point Action**

**Function:** To turn on a digital output point.

**Typical Use:** To activate devices connected to digital outputs, such as motors, pumps, lights, and so forth.

**Details:**
- Turns on the specified output.
- The output will remain on until directed otherwise.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argument 0</td>
<td>Value</td>
<td>Digital Output</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```optoscript
TurnOn(INLET_VALVE);
```

This is a procedure command; it does not return a value.

In OptoScript code, you could also assign the output any non-zero value to turn it on:

```c
INLET_VALVE = -1;
```

**Notes:**
- To cause an output on one I/O unit to assume the state of an input on another I/O unit, use Move in standard commands or an assignment in OptoScript code.
- Use NOT to cause an output on one I/O unit to assume the opposite state of an input on another I/O unit.
- Speed Tip: Use Set I/O Unit from MOMO Masks to turn on all outputs at once.

**Dependencies:** If the output point or the I/O unit is disabled, no action will occur at the output point (XVAL). The IVAL, however, will be updated.

**See Also:**
- "Set I/O Unit from MOMO Masks" on page 292
- "Turn Off" on page 196
7: Error Handling Commands

Add Message to Queue
Error Handling Action

Function: To place your own message into the message queue.

Typical Use: To add diagnostic or debugging messages to the queue.

Details:
- Valid severity values are:
  4 = Info
  8 = Warning
  16 = Error
- The queue holds a total of 1000 errors and messages. Message code and error code values are limited to values ranging from -32768 to +32767.
- Quotes (" ") are used in OptoScript code, but not in standard PAC Control code.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Severity</td>
<td>Message</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>String Literal</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>String Variable</td>
</tr>
</tbody>
</table>

Action Block Example:

```
Add Message To Queue
```

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Severity</td>
<td>Integer 32 Literal</td>
<td>16</td>
</tr>
<tr>
<td>Message</td>
<td>String Literal</td>
<td>Pressure Tank Exploded</td>
</tr>
</tbody>
</table>

OptoScript Example:

```
AddMessageToQueue (Severity, Message)

AddMessageToQueue(16, "Pressure Tank Exploded");
```

This is a procedure command; it does not return a value.

Notes: If a message code is passed that is not in the range -32768 to +32767, a -8 (Invalid Data) error will be posted to the queue.

Queue Error: -83 = Invalid severity value

See Also: "Add User Error to Queue" on page 200
Add User Error to Queue

Error Handling Action

Function: Enables the user to force a program error into the message queue.

Typical Use: Simulating errors offline to test a user-written error handler.

Details: 
- Adds a user-defined error number to the message queue. Message code and error code values are limited to values ranging from -32768 to +32767.
- The queue holds a total of 1000 errors and messages.

Arguments: 

<table>
<thead>
<tr>
<th>Argument 0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error Number</td>
</tr>
</tbody>
</table>

Integer 32 Literal
Integer 32 Variable

Action Block Example:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error Number</td>
<td>Integer 32 Literal</td>
<td>-22001</td>
</tr>
</tbody>
</table>

OptoScript Example:

```opto
AddUserErrorToQueue (Error Number)
AddUserErrorToQueue (-22001);
```

This is a procedure command; it does not return a value.

Notes: 
- Also see Add Message to Queue, which is more flexible.
- If a message code is passed that is not in the range -32768 to +32767, a -8 (Invalid Data) error will be posted to the queue.

See Also:
- "Add Message to Queue" on page 199
- "Add User I/O Unit Error to Queue" on page 201
- "Get Error Code of Current Error" on page 212
Add User I/O Unit Error to Queue

Error Handling Action

Function: Enables the user to force an I/O unit error into the message queue.

Typical Use: Simulating I/O unit errors offline to test a user-written error handler.

Details:
- Adds a standard predefined I/O unit error number to the message queue.
- The queue holds a total of 1000 errors and messages. Message code and error code values are limited to values ranging from -32768 to +32767.

Arguments:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error Number</td>
<td>Integer 32 Literal</td>
<td>Error Number</td>
</tr>
<tr>
<td>I/O Unit</td>
<td>SNAP-PAC-R1</td>
<td>I/O Unit</td>
</tr>
</tbody>
</table>

* Available only in PAC Control Professional when Mistic products are enabled (File > Strategy Options > Legacy tab > Mistic I/O units and commands)

** Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units)

Action Block Example:

```
Add User I/O Unit Error to Queue
```

OptoScript Example:

```
AddUserIoUnitErrorToQueue (Error Number, I/O Unit)
AddUserIoUnitErrorToQueue (-52, My_PAC_R);
```

This is a procedure command; it does not return a value.

Notes:
- For a complete list, see the Error Codes appendix in the PAC Control User’s Guide (form 1700).
• If a message code is passed that is not in the range -32768 to +32767, a -8 (Invalid Data) error will be posted to the queue.

See Also:  
“Add User Error to Queue” on page 200  
“Get Error Code of Current Error” on page 212
Caused a Chart Error?

Error Handling Condition

**Function:** To determine if the specified chart caused the current error in the message queue.

(The current error is the oldest one and is always at the top of the message queue.)

**Typical Use:** To determine which chart caused the current error.

**Details:** If the specified chart caused the current error, the logic will take the True path.
If the specified chart did not cause the current error, the logic will take the False path.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Has Chart</td>
<td>Chart</td>
<td>POWERUP</td>
</tr>
</tbody>
</table>

**Condition Block Example:**

```
Caused a Chart Error?

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Has</td>
<td>Chart</td>
<td>POWERUP</td>
</tr>
</tbody>
</table>
```

**OptoScript Example:**

```
if (HasChartCausedError(POWERUP)) then

This is a function command; it returns a value of true (non-zero) or false (0). The returned value can be consumed by a control structure (as in the example shown) or by a variable, I/O point, and so forth. For more information, see the *PAC Control User’s Guide* (form 1700).

**Notes:** Use Debug mode to view the message queue for detailed information.

**Dependencies:** Prior to using this call, you should ensure that the error of interest is pointed to by using the Remove Current Error and Point to Next Error command.

**See Also:**

- “Get Error Code of Current Error” on page 212
- “Remove Current Error and Point to Next Error” on page 219
Caused an I/O Unit Error?

Error Handling Condition

**Function:** To determine if the specified I/O unit caused the **current error** in the message queue.

(The current error is the oldest one and is always at the top of the message queue.)

**Typical Use:** To determine which I/O unit caused an error.

**Details:**
- If the specified I/O unit caused the current error, the logic will take the True path.
  - If the specified I/O unit did not cause the current error, the logic will take the False path.
- You must use **Error on I/O Unit?** before using this command, since this command assumes the current error is an I/O error.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Has</td>
</tr>
<tr>
<td>B100*</td>
</tr>
<tr>
<td>B200*</td>
</tr>
<tr>
<td>B3000 (Analog)*</td>
</tr>
<tr>
<td>B3000 (Digital)*</td>
</tr>
<tr>
<td>E1</td>
</tr>
<tr>
<td>E2</td>
</tr>
<tr>
<td>G4A8R, G4RAX*</td>
</tr>
<tr>
<td>G4D16R*</td>
</tr>
<tr>
<td>G4D32RS*</td>
</tr>
<tr>
<td>G4EB2</td>
</tr>
<tr>
<td>Generic OptoMMP Device</td>
</tr>
<tr>
<td>GRV-EPIC-PR1</td>
</tr>
<tr>
<td>GRV-R7-MM1001-10</td>
</tr>
<tr>
<td>SNAP-B3000-ENET, SNAP-ENET-RTC**</td>
</tr>
<tr>
<td>SNAP-BRS*</td>
</tr>
<tr>
<td>SNAP-ENET-D64**</td>
</tr>
<tr>
<td>SNAP-ENET-S64**</td>
</tr>
<tr>
<td>SNAP-PAC-EB1</td>
</tr>
<tr>
<td>SNAP-PAC-EB2</td>
</tr>
<tr>
<td>SNAP-PAC-R1</td>
</tr>
<tr>
<td>SNAP-PAC-R1-B</td>
</tr>
<tr>
<td>SNAP-PAC-R2</td>
</tr>
<tr>
<td>SNAP-PAC-SB1</td>
</tr>
<tr>
<td>SNAP-PAC-SB2</td>
</tr>
<tr>
<td>SNAP-UP1-ADS**</td>
</tr>
<tr>
<td>SNAP-UP1-D64**</td>
</tr>
<tr>
<td>SNAP-UP1-M64***</td>
</tr>
</tbody>
</table>

* Available only in PAC Control Professional when **mistic** products are enabled (File > Strategy Options > Legacy tab > Mistic I/O units and commands).

** Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).

**Condition Block Example:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Has</td>
<td>SNAP-PAC-EB1</td>
<td>DIG_UNIT_1</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```
HasIoUnitCausedError (Has)
if (HasIoUnitCausedError(DIG_UNIT_1)) then
```
This is a function command; it returns a value of true (non-zero) or false (0). The returned value can be consumed by a control structure (as in the example shown) or by a variable, I/O point, and so forth. For more information, see the PAC Control User’s Guide (form 1700).

Notes:
- Be sure the top error in the queue is an I/O error.
- Use Debug mode to view the message queue for detailed information.

Dependencies: You must use Error on I/O Unit? before using this command.

See Also:
- “Error on I/O Unit?” on page 210
- “Get Error Code of Current Error” on page 212
- “Remove Current Error and Point to Next Error” on page 219
Clear All Errors

Error Handling Action

Function: To clear the message queue.

Typical Use: To clear all errors from a message queue.

Details: This function clears all errors and messages in the queue. Normally this is not necessary. If your program performs error checking, it will eventually clear the message queue. If no error checking is done, simply let the queue fill up. The queue holds a total of 1000 errors and messages.

Arguments: None.

Action Block

Example:

<table>
<thead>
<tr>
<th>Clear All Errors</th>
</tr>
</thead>
<tbody>
<tr>
<td>No arguments</td>
</tr>
</tbody>
</table>

OptoScript Example:

ClearAllErrors();

This is a procedure command; it does not return a value.

Notes: Downloading and running a strategy automatically clears all errors.

Errors can also be cleared when inspecting the control engine in Debug mode or from PAC Terminal (by clicking View > Messages > Clear All Messages).

See Also:
- “Get Error Code of Current Error” on page 212
- “Get Error Count” on page 213
- “Remove Current Error and Point to Next Error” on page 219
- “Get ID of Block Causing Current Error” on page 214
- “Get Name of I/O Unit Causing Current Error” on page 217
Copy Current Error to String

Error Handling Action

Function: To copy information about the current error into a string.
(The current error is the oldest one and is always at the top of the message queue.)

Typical Use: To log errors and other information from the message queue.

Details:
- Columns of information from the message queue are put into a string variable with the delimiter you set in Delimiter (Argument 0). Columns are Error Code, Severity, Chart, Block, Line, Object, Time, and Date. If the information came from a subroutine, the Chart column shows the chart that called the subroutine, and the Block column includes the subroutine name in the format <Sub name>.Block.
- The following sample messages all use a comma as the delimiter:
  -534, Info, _InIT_IO, -1, 0, sio13, 17:19:11, 01/03/05
  -35, Warning, _InIT_IO, -1, 0, ai36_Temp, 17:19:21, 12/03/04
  -12, Error, Process, TableSub.3, 2, strTable, 08:46:11, 09/24/04
  -15, Error, Powerup, 0, 1, (null), 10:44:42, 12/04/04
  User, Warning, Powerup, 0, 1, custom error, 10:39:20, 10/19/04
- If there are no errors in the queue, the string variable will be empty.
- If you are in Minimal Debug rather than Full Debug, the Line column will contain a zero.
- Quotes (“”) are used in OptoScript code, but not in standard PAC Control code.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delimiter</td>
<td>Put Result in</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>String Variable</td>
</tr>
</tbody>
</table>

Action Block Example:

<table>
<thead>
<tr>
<th>Copy Current Error to String</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argument Name</td>
</tr>
<tr>
<td>Delimiter</td>
</tr>
<tr>
<td>Put Result in</td>
</tr>
</tbody>
</table>

OptoScript Example:

CurrentErrorToString(Delimiter, Put Result in)
CurrentErrorToString(44, strError);

This is a procedure command; it does not return a value.

Note that the integer 32 literal, 44, could also be entered in OptoScript as a character constant, ', '.

See Also:
- “Get Error Code of Current Error” on page 212
- “Clear All Errors” on page 206
- “Get Error Count” on page 213
- “Remove Current Error and Point to Next Error” on page 219
Disable I/O Unit Causing Current Error

Error Handling Action

<table>
<thead>
<tr>
<th>Function:</th>
<th>To disable communication between the program in the control engine and all points on the I/O unit if the I/O unit generated the top queue error.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Typical Use:</td>
<td>Most I/O unit errors cause the unit to be automatically disabled if posted. This command can be used in an error handling chart to make sure an I/O unit causing an error is disabled.</td>
</tr>
<tr>
<td>Details:</td>
<td>The control engine generates errors in the message queue whenever an I/O unit does not respond. When this happens, all further communication to the I/O unit is disabled to ensure that communication to other I/O units does not slow down.</td>
</tr>
<tr>
<td>Arguments:</td>
<td>None.</td>
</tr>
</tbody>
</table>

Action Block Example:

Disable I/O Unit Causing Current Error

OptoScript Example:

DisableIoUnitCausingCurrentError()

DisableIoUnitCausingCurrentError();

This is a procedure command; it does not return a value.

Notes:

- This command is typically used in an error handling chart.
- Always use Error on I/O Unit? to determine if the top error in the message queue is an I/O unit error before using this command, since the error could be caused by something else.
- Always use Remove Current Error and Point to Next Error after using this command.

Dependencies: For this command to have any effect, the top error in the queue must be an error generated by an I/O unit.

Queue Errors:

-69 = null object. The current error in the message queue was not caused by an I/O unit. (The current error is the oldest one and is always at the top of the message queue.)

See Also:

- "Enable I/O Unit Causing Current Error" on page 209
- "Error on I/O Unit?" on page 210
Enable I/O Unit Causing Current Error

Error Handling Action

Function: Attempts to bring the I/O Unit back online.

Typical Use: To re-establish communication between the control engine and the I/O unit after it was automatically or manually disabled.

Details: Sends a test message (Powerup Clear command) to the brain. If the test message is successful it will enable communication and configure the I/O if necessary.

Arguments: None.

Action Block Example:

<table>
<thead>
<tr>
<th>Enable I/O Unit Causing Current Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>No arguments</td>
</tr>
</tbody>
</table>

OptoScript Example:

```
EnableIoUnitCausingCurrentError();
```

This is a procedure command; it does not return a value.

Notes:
- This command is typically used in an error handling chart.
- Always use Error on I/O Unit? to determine if the top error in the message queue is an I/O unit error before using this command.
- Always use Remove Current Error and Point to Next Error after using this command.

Dependencies: For this command to have any effect, the top error in the queue must have been caused by an I/O unit.

Queue Errors: -69 = Invalid parameter (null pointer) passed to command.

See Also: “Disable I/O Unit Causing Current Error” on page 208
          “Error on I/O Unit?” on page 210
Error on I/O Unit?

Error Handling Condition

**Function:** To determine if the current error in the message queue is an I/O-related error.

(The current error is the oldest one and is always at the top of the message queue.)

**Typical Use:** To determine if further error handling for I/O units should be performed, for example, in an error handling chart.

**Details:**
- If the current error in the message queue is an I/O unit error, the logic will take the True path.
- If the current error in the message queue is not an I/O unit error, the logic will take the False path.

**Arguments:** None.

**Condition Block Example:**

```opto
iserroroniounit()
```

**OptoScript Example:**

```opto
if (iserroroniounit()) then
```

This is a function command; it returns a value of true (non-zero) or false (0). The returned value can be consumed by a control structure (as in the example shown) or by a variable, I/O point, and so forth. For more information, see the *PAC Control User's Guide* (form 1700).

**Notes:**
- Use *Caused an I/O Unit Error?* to determine which I/O unit caused the error.
- Use Debug mode to view the message queue for detailed information.

**See Also:**

- “Caused an I/O Unit Error?” on page 204
- “Remove Current Error and Point to Next Error” on page 219
- “Error?” on page 211
- “Get ID of Block Causing Current Error” on page 214
- “Get Line Causing Current Error” on page 215
- “Get Name of Chart Causing Current Error” on page 216
- “Get Name of I/O Unit Causing Current Error” on page 217
Error?

Error Handling Condition

Function: To determine if there is an error in the message queue.

Typical Use: To determine if further error handling should be performed, for example, in an error handling chart.

Details: If there is an error in the message queue, the logic will take the True path.
If there is not an error in the message queue, the logic will take the False path.

Arguments: None.

Condition Block Example:

<table>
<thead>
<tr>
<th>Error?</th>
</tr>
</thead>
<tbody>
<tr>
<td>No arguments</td>
</tr>
</tbody>
</table>

OptoScript Example: IsErrorPresent()
if (IsErrorPresent()) then

This is a function command; it returns a value of true (non-zero) or false (0). The returned value can be consumed by a control structure (as in the example shown) or by a variable, I/O point, and so forth. For more information, see the PAC Control User's Guide (form 1700).

Notes:
- Use Error on I/O Unit? to determine if it is an I/O related error.
- Use Debug mode to view the message queue for detailed information.

See Also: “Error on I/O Unit?” on page 210
Get Error Code of Current Error

Error Handling Action

Function:  To return the oldest error code in the message queue.

Typical Use:  To allow a chart to perform error handling.

Details:  
- Returns a zero if the queue is empty.
- The same error code is read each time unless Remove Current Error and Point to Next Error is used first.
- The message queue holds a total of 1000 errors and messages.
- See the Errors appendix in the PAC Control User’s Guide (form 1700), for a list of errors that may appear in the message queue.

Arguments:  
Argument 0  
Put in  
Float Variable  
Integer 32 Variable

Action Block Example:  

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Put in</td>
<td>Integer 32 Variable</td>
<td>ERROR_CODE</td>
</tr>
</tbody>
</table>

OptoScript Example:  

```optoscript
getErrorCodeOfCurrentError()

ERROR_CODE = GetErrorErrorCode();
```

This is a function command; it returns the code for the oldest error in the message queue. The returned value can be consumed by a variable (as shown) or used by an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

Notes:  
- Use Remove Current Error and Point to Next Error to drop the oldest error from the queue so the next error can be evaluated.
- For detailed information, use Control Engine > Inspect in Debug mode to view the message queue.

See Also:  
- “Clear All Errors” on page 206  
- “Get Error Count” on page 213  
- “Remove Current Error and Point to Next Error” on page 219
Get Error Count

Error Handling Action

Function: To determine the number of errors in the message queue.

Typical Use: To allow an error handling chart to determine that there are no more errors to process.

Details:
- The queue holds a total of 1000 errors and messages.
- Returns a zero if the queue is empty.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Put in</td>
</tr>
<tr>
<td>Float Variable</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

Example:

OptoScript Example:

```
GetErrorCount();
```

This is a function command; it returns the number of errors in the message queue. The returned value can be consumed by a variable (as shown) or used by an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

Notes:
- To eliminate all errors from the queue, use Clear All Errors.
- Use Debug mode to view the message queue for detailed information.

See Also:
- “Clear All Errors” on page 206
- “Get Error Code of Current Error” on page 212
- “Remove Current Error and Point to Next Error” on page 219
Get ID of Block Causing Current Error

Error Handling Action

**Function:**
Gets the ID number of the block that caused the top queue error.

**Typical Use:**
In an error handling chart to build a history of errors in a string table.

**Details:**
- Blocks are numbered starting with zero.
- If the error queue is empty, the returned value is -1.

**Arguments:**
- **Argument 0**
  - **Put in**
  - Integer 32 Variable

**Action Block Example:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Put in</td>
<td>Integer 32 Variable</td>
<td>Error_Block_ID</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```optoscript
GetIdOfBlockCausingCurrentError()
Error_Block_ID = GetIdOfBlockCausingCurrentError();
```

This is a function command; it returns the ID number of the block that caused the top error in the message queue. The returned value can be consumed by a variable (as shown) or used by an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User's Guide (form 1700).

**See Also:**
- “Get Name of Chart Causing Current Error” on page 216
- “Get Name of I/O Unit Causing Current Error” on page 217
Get Line Causing Current Error

Error Handling Action

**Function:** Gets the line within a flowchart block that caused the top queue error.

**Typical Use:** In an error-handling chart to build a history of errors.

**Details:**
- The strategy must have been loaded to the control engine in full debug mode for this command to work.
  - If the strategy is in minimal debug mode, the command returns a zero.
- If there are not errors in the queue, the command returns a zero.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argument 0</td>
<td>Put in</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```
OptoScript Example:
GetLineCausingCurrentError()
Error_Block_ID = GetLineCausingCurrentError();
```

This is a function command; it returns the line that caused the top error in the message queue. The returned value can be consumed by a variable (as shown) or used by an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the *PAC Control User's Guide* (form 1700).

**See Also:**
- “Get ID of Block Causing Current Error” on page 214
- “Get Name of Chart Causing Current Error” on page 216
- “Get Name of I/O Unit Causing Current Error” on page 217
Get Name of Chart Causing Current Error

Error Handling Action

Function: Gets the name of the chart that caused the top queue error.

Typical Use: In an error handling chart to build a history of errors.

Details: If there are no errors in the queue, the command returns a null.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Put in</td>
</tr>
<tr>
<td>String Variable</td>
</tr>
</tbody>
</table>

Argument Name | Type       | Name   |
-----------------------------------------------
Put in         | String Variable | CHART_NAME |

Action Block Example:

```
Get Name of Chart Causing Current Error

Argument Name | Type       | Name   |
-----------------------------------------------
Put in         | String Variable | CHART_NAME |
```

OptoScript Example:

```
Get Name of Chart Causing Current Error (Put in)

Get Name of Chart Causing Current Error (CHART_NAME);
```

This is a procedure command; it does not return a value.

Notes: String length for name should be at least 50.

See Also:

“Get ID of Block Causing Current Error” on page 214
“Get Line Causing Current Error” on page 215
“Get Name of I/O Unit Causing Current Error” on page 217
Get Name of I/O Unit Causing Current Error

Error Handling Action

Function: Gets the name of the I/O unit that caused the top queue error.

Typical Use: In an error handling chart to build a history of errors.

Details: Only works when the top queue error is an I/O unit error.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Put in</td>
<td>String Variable</td>
<td>IO_UNIT_NAME</td>
</tr>
</tbody>
</table>

Example:

OptoScript Example:

```
GetNameOfIoUnitCausingCurrentError("Put in")
```

This is a procedure command; it does not return a value.

Notes:

- String length for name should be at least 50.
- If the top queue error is not an I/O unit error, a null is returned.

Dependencies: The top queue error must be an I/O unit error.

See Also:

- "Get Name of Chart Causing Current Error" on page 216
- "Get ID of Block Causing Current Error" on page 214
- "Get Line Causing Current Error" on page 215
Get Severity of Current Error

Error Handling Action

**Function:** To read the severity of the oldest error in the message queue.

**Typical Use:** To allow a chart to perform error handling.

**Details:**
- Valid severity values are:
  - 0 = Queue is empty
  - 4 = Info
  - 8 = Warning
  - 16 = Error
- The same error is read each time unless Remove Current Error and Point to Next Error is used first.
- The message queue can hold up to 1000 errors.

**Arguments:**

- **Argument 0**
  - **Put In**
    - Float Variable
    - Integer 32 Variable

**Action Block Example:**

```
Get Severity of Current Error
```

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Put in</td>
<td>Integer 32 Variable</td>
<td>nCurrentError</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```
GetSeverityOfCurrentError();
```

This is a function command; it returns the severity value of the error. The returned value can be consumed by a variable (as shown) or used by an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

**Notes:** For detailed information on errors, use Control Engine > Inspect in Debug mode to view the message queue.

**See Also:**
- “Get Error Code of Current Error” on page 212
- “Clear All Errors” on page 206
- “Get Error Count” on page 213
- “Remove Current Error and Point to Next Error” on page 219
# Remove Current Error and Point to Next Error

## Error Handling Action

<table>
<thead>
<tr>
<th>Function:</th>
<th>To drop the oldest error from the message queue and bring the next error to the top of the queue.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Typical Use:</td>
<td>To access items in the message queue during error handling within the PAC Control strategy.</td>
</tr>
<tr>
<td>Details:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Must use before the next error in the queue can be evaluated.</td>
</tr>
<tr>
<td></td>
<td>• Once this command is executed, the previous error can no longer be accessed.</td>
</tr>
<tr>
<td></td>
<td>• Commands that have the word Error in their name always evaluate the top (oldest) error in the queue.</td>
</tr>
<tr>
<td>Arguments:</td>
<td>None.</td>
</tr>
</tbody>
</table>

## Action Block Example

<table>
<thead>
<tr>
<th>OptoScript Example:</th>
<th>Remove Current Error and Point to Next Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>RemoveCurrentError()</td>
<td>No arguments</td>
</tr>
</tbody>
</table>

This is a procedure command; it does not return a value.

## Notes:

- You can use the condition Error? to determine if there are errors in the queue before using this command.
- Use Debug mode to view the message queue for detailed information.

## See Also:

- “Error?” on page 211
- “Get Error Count” on page 213
- “Get Error Code of Current Error” on page 212
- “Get Name of Chart Causing Current Error” on page 216
- “Get Name of I/O Unit Causing Current Error” on page 217
Stop Chart on Error

Error Handling Action

**Function:**
To stop the chart that caused the error at the top of the message queue.

**Typical Use:**
To include in an error handler chart that runs with the other charts in a strategy. This chart monitors the message queue and takes appropriate action. Utilizing this command, the error handler chart can stop any chart that causes an error.

**Details:**
- Since PAC Control is a multitasking environment, an error handler chart cannot stop another chart instantaneously with this command, because the error handler chart itself is executed periodically. The actual time required depends on how many charts are running simultaneously.
- See the Errors appendix in the *PAC Control User’s Guide* (form 1700), for a list of errors that may appear in the message queue.

**Arguments:**
None.

**Action Block Example:**

```
Stop Chart on Error
```

This is a procedure command; it does not return a value.

**OptoScript Example:**

```
StopChartOnError()
```

```
StopChartOnError();
```

**Notes:**
- See “Error Handling Commands” and Chart Commands” in the *PAC Control User’s Guide* (form 1700).
- To get to each error in the message queue, the top error must be discarded, bringing the next error to the top. Use `Remove Current Error and Point to Next Error` to do this.
- Add a 500 ms delay following this command in order to detect the correct chart status with the `Get Chart Status` command.

**See Also:**
- “Remove Current Error and Point to Next Error” on page 219
- “Get Error Count” on page 213
- “Suspend Chart on Error” on page 221
Suspend Chart on Error

Error Handling Action

**Function:**
To suspend the chart that caused the error at the top of the message queue.

**Typical Use:**
To include in an error handler chart that runs with the other charts in a strategy. This chart monitors the message queue and takes appropriate action. Utilizing this command, the error handler chart can suspend any chart that causes an error.

**Details:**
- Since PAC Control is a multitasking environment, an error handler chart cannot suspend another chart instantaneously with this command, because the error handler chart itself is executed periodically. The actual time required depends on how many charts are running simultaneously as well as on the priority of each.
- See the Errors appendix in the *PAC Control User’s Guide* (form 1700), for a list of errors that may appear in the message queue.

**Arguments:**
- **Argument 0**
  - **Put Status in**
    - Float Variable
    - Integer 32 Variable

**Action Block Example:**

```
Suspend Chart on Error
```

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Put Status in</td>
<td>Integer 32 Variable</td>
<td>STATUS</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```
SuspendChartOnError()
STATUS = SuspendChartOnError();
```

This is a function command; it returns one of the status codes listed below.

**Notes:**
- See “Error Handling Commands” and “Chart Commands” in the *PAC Control User’s Guide* (form 1700).
- To get to each error in the message queue, the top error must be discarded, which brings the next error to the top. Use *Remove Current Error and Point to Next Error* to do this.
- Add a 500 ms delay following this command in order to detect the correct chart status with the *Get Chart Status* command.

**Status Codes:**
- 0 = success
- -5 = failure

**See Also:**
- “Remove Current Error and Point to Next Error” on page 219
- “Get Error Count” on page 213
- “Stop Chart on Error” on page 220
Clear HDD Module Off-Latches

High-Density Digital Module Action

NOTE: This is a high-density digital (HDD) command. To enable HDD commands, from the PAC Control menu bar, click File > Strategy Options > Legacy tab > Original High Density Digital commands.

Function: To reset specific off-latches on a high-density digital input module.

Typical Use: To clear some off-latches and not clear others on the same module.

Details: • Works only on high-density digital modules, not on standard digital modules.
• Uses a bitmask to indicate the off-latches to clear. The least significant bit corresponds to point zero. To clear the off-latch on a point, set its respective bit to a value of 1. To leave a point unaffected, set its bit to a value of 0.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
<th>Argument 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Unit</td>
<td>Module #</td>
<td>Clear Mask</td>
<td>Put Status in</td>
</tr>
<tr>
<td>GRV-R7-MM1001-10</td>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>SNAP-B3000-ENET, SNAP-ENET-RTC*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-ENET-S64*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1-B</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-ADS*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-M64*</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).
CHAPTER 8: HIGH-DENSITY DIGITAL MODULE

**Action Block**

**Example:**

The effect of this command is illustrated below. Off-latches for point numbers 1, 6, 7, 25, and 26 are cleared.

<table>
<thead>
<tr>
<th>Point Number</th>
<th>31</th>
<th>30</th>
<th>29</th>
<th>28</th>
<th>27</th>
<th>26</th>
<th>25</th>
<th>24</th>
<th>7</th>
<th>6</th>
<th>5</th>
<th>4</th>
<th>3</th>
<th>2</th>
<th>1</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bitmask</td>
<td>Binary</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td></td>
<td>&gt;&gt;</td>
<td></td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>Hex</td>
<td>0</td>
<td></td>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>&gt;&gt;</td>
<td></td>
<td>C</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```plaintext
ClearHddModuleOffLatches(I/O Unit, Module #, Clear Mask)

OffLatch_Status = ClearHddModuleOffLatches(UIO_A, 6, 0x060000C2);
```

This is a function command; it returns one of the status codes shown below.

**Notes:**

- Usually used after Get HDD Module Off-Latches. To read and reset all the off-latches on one module at once, use Get & Clear HDD Module Off-Latches. To read and reset all off-latches on all high-density modules on the I/O unit, use Get & Clear All HDD Module Off-Latches.
- For more information, see “Legacy High-Density Digital Module Commands” in the PAC Control User’s Guide, Legacy Edition (form 1710), and the SNAP High-Density Digital Module User’s Guide (form 1547).

**Status Codes:**

- 0 = Success
- -43 = Received a NACK from the I/O unit.
- -58 = No data received. Make sure I/O unit has power.
- -93 = I/O unit not enabled. Previous communication failure may have disabled communication to the unit automatically. Reenable communication to the unit and try again.

**See Also:**

- “Clear HDD Module On-Latches” on page 225
- “Get & Clear HDD Module Off-Latches” on page 235
- “Get & Clear All HDD Module Off-Latches” on page 227
Clear HDD Module On-Latches

High-Density Digital Module Action

NOTE: This is a high-density digital (HDD) command. To enable HDD commands, from the PAC Control menu bar, click File > Strategy Options > Legacy tab > Original High Density Digital commands.

Function: To reset specific on-latches on a high-density digital input module.

Typical Use: To clear some on-latches and not clear others on the same module.

Details:
- Works only on high-density digital modules, not on standard digital modules.
- Uses a bitmask to indicate the on-latches to clear. The least significant bit corresponds to point zero. To clear the on-latch on a point, set its respective bit to a value of 1. To leave a point unaffected, set its bit to a value of 0.

Arguments:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Unit</td>
<td>SNAP-UP1-ADS</td>
<td>UIO_A</td>
</tr>
<tr>
<td>Module #</td>
<td>Integer 32 Variable</td>
<td>6</td>
</tr>
<tr>
<td>Clear Mask</td>
<td>Integer 32 Literal</td>
<td>0x060000C2</td>
</tr>
<tr>
<td>Put Status in</td>
<td>Integer 32 Variable</td>
<td>OnLatch_Status</td>
</tr>
</tbody>
</table>

* Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).

Action Block Example:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Unit</td>
<td>SNAP-UP1-ADS</td>
<td>UIO_A</td>
</tr>
<tr>
<td>Module #</td>
<td>Integer 32 Variable</td>
<td>6</td>
</tr>
<tr>
<td>Clear Mask</td>
<td>Integer 32 Literal</td>
<td>0x060000C2</td>
</tr>
<tr>
<td>Put Status in</td>
<td>Integer 32 Variable</td>
<td>OnLatch_Status</td>
</tr>
</tbody>
</table>

The effect of this command is illustrated below. On-latches for point numbers 1, 6, 7, 25, and 26 are cleared.

| Point Number | 31 | 30 | 29 | 28 | 27 | 26 | 25 | 24 | > > > | 7 | 6 | 5 | 4 | 3 | 2 | 1 | 0 |
|--------------|----|----|----|----|----|----|----|----|-------|---|---|---|---|---|---|---|---|---|
| Bitmask      | Binary | 0 | 0 | 0 | 0 | 1 | 1 | 0 | > > > | 1 | 1 | 0 | 0 | 0 | 0 | 1 | 0 |
|              | Hex    | 0 | 6 | > > > | C | 2 |
OptoScript Example:  
\[
\text{ClearHddModuleOnLatches} (I/O \text{ Unit, Module #, Clear Mask})
\]

OnLatch_Status = ClearHddModuleOnLatches(UIO_A, 6, 0x060000C2);

This is a function command; it returns one of the status codes shown below.

Notes:  
- Usually used after \text{Get HDD Module On-Latches}. To read and reset all the on-latches on one module at once, use \text{Get & Clear HDD Module On-Latches}.
- For more information, see “Legacy High-Density Digital Module Commands” in the \textit{PAC Control User's Guide, Legacy Edition} (form 1710), and the \textit{SNAP High-Density Digital Module User's Guide} (form 1547).

Status Codes:

- \(0\) = Success  
- \(-43\) = Received a NACK from the I/O unit.  
- \(-58\) = No data received. Make sure I/O unit has power.  
- \(-93\) = I/O unit not enabled. Previous communication failure may have disabled communication to the unit automatically. Reenable communication to the unit and try again.

See Also:
- “Clear HDD Module Off-Latches” on page 223  
- “Get & Clear HDD Module Off-Latches” on page 237  
- “Get & Clear All HDD Module Off-Latches” on page 229
Get & Clear All HDD Module Off-Latches

High-Density Digital Module Action

NOTE: This is a high-density digital (HDD) command. To enable HDD commands, from the PAC Control menu bar, click File > Strategy Options > Legacy tab > Original High Density Digital commands.

Function: To read and reset the off-latches for all points on all high-density digital input modules on one I/O unit.

Typical Use: To read and reset off-latches for all high-density digital points on the I/O unit with a single command.

Details:
- Works only on high-density digital modules, not on standard digital modules.
- Places all off-latch data as bitmasks in an integer 32 table at a designated starting index. Start Index (Argument 1) sets the index number, and Put Result in (Argument 2) indicates the table.
- The table that receives the data must contain at least 16 elements after the starting index. (If the table is not large enough, an error -3 is returned.) Data for point zero is placed in the first specified table element, with other points following in order. If a slot does not contain a high-density digital module, its corresponding table element is zero-filled.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Unit</td>
<td>Start Index</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>GRV-R7-MM1001-10</td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td>SNAP-B3000-ENET, SNAP-ENET-RTC*</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>SNAP-ENET-S64*</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB1</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB2</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1-B</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R2</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB1</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB2</td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-ADS*</td>
<td>Integral 32 Literal</td>
</tr>
<tr>
<td>SNAP-UP1-M64*</td>
<td></td>
</tr>
</tbody>
</table>

* Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).

<table>
<thead>
<tr>
<th>Argument 2</th>
<th>Argument 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Put Result in</td>
<td>Put Status in</td>
</tr>
<tr>
<td>Integer 32 Table</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

Action Block Example:

<table>
<thead>
<tr>
<th>Get &amp; Clear All HDD Module Off-Latches</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argument Name</td>
</tr>
<tr>
<td>---------------</td>
</tr>
<tr>
<td>I/O Unit</td>
</tr>
<tr>
<td>Start Index</td>
</tr>
<tr>
<td>Put Result in</td>
</tr>
<tr>
<td>Put Status in</td>
</tr>
</tbody>
</table>
For example, if the I/O unit UIO_A consists of an 8-module rack with an analog module in slot 0 and HDD modules in slots 1–7, table Bldg_A_OffL might be filled as follows:

<table>
<thead>
<tr>
<th>Index</th>
<th>Value (Bitmask)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>00000000000000000000000000000000 &lt;&lt; &lt;&lt; (This module is not a HDD module.)</td>
</tr>
<tr>
<td>1</td>
<td>01100001010001110000000101010010</td>
</tr>
<tr>
<td>2</td>
<td>00000000001000100000001111</td>
</tr>
<tr>
<td>3</td>
<td>0010000011000000010010010010001000</td>
</tr>
<tr>
<td>4</td>
<td>01100001010001110000001101001110</td>
</tr>
<tr>
<td>5</td>
<td>0000111000010000110000010000001001</td>
</tr>
<tr>
<td>6</td>
<td>10000000110000001110000000000100100</td>
</tr>
<tr>
<td>7</td>
<td>001100000111000001111000000000001</td>
</tr>
<tr>
<td>8</td>
<td>00000000000000000000000000000000</td>
</tr>
<tr>
<td></td>
<td>↓ ↓ The remainder of the table is zero-filled, since there are no more modules.</td>
</tr>
<tr>
<td>15</td>
<td>00000000000000000000000000000000</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```plaintext
GetClearAllHddModuleOffLatches(I/O Unit, Start Index, Put Result in)
```

```plaintext
Status_Code = GetClearAllHddModuleOffLatches(UIO_A, 0, Bldg_A_OffL);
```

This is a function command; it returns one of the status codes shown below.

**Notes:**

- To read and reset the off-latches on only one HDD module, use `Get & Clear HDD Module Off-Latches`. To read off-latches without clearing them, use `Get All HDD Module Off-Latches`.
- You can manipulate bits within the table using commands such as `Numeric Table Element Bit Test`, or move the data in one element to a variable and use commands such as `Bit Test`.
- For more information, see “Legacy High-Density Digital Module Commands” in the *PAC Control User’s Guide, Legacy Edition* (form 1710), and the *SNAP High-Density Digital Module User’s Guide* (form 1547).

**Status Codes:**

- **0** = Success
- **-3** = Invalid table length.
- **-12** = Invalid table index value. Index was negative or greater than the table size.
- **-43** = Received a NACK from the I/O unit.
- **-58** = No data received. Make sure I/O unit has power.
- **-93** = I/O unit not enabled. Previous communication failure may have disabled communication to the unit automatically. Reenable communication to the unit and try again.

**See Also:**

- “Get & Clear HDD Module Off-Latches” on page 235
- “Get All HDD Module Off-Latches” on page 239
- “Numeric Table Element Bit Test” on page 420
- “Bit Test” on page 379 and other Bit commands
Get & Clear All HDD Module On-Latches

High-Density Digital Module Action

NOTE: This is a high-density digital (HDD) command. To enable HDD commands, from the PAC Control menu bar, click File > Strategy Options > Legacy tab > Original High Density Digital commands.

Function: To read and reset on-latches for all points on all high-density digital input modules on an I/O unit.

Typical Use: To read and reset on-latches for all high-density digital points on the I/O unit with a single command.

Details:
- Works only on high-density digital modules, not on standard digital modules.
- Places all on-latch data as bitmasks in an integer 32 table at a designated starting index.
- Start Index (Argument 1) sets the index number, and Put Result in (Argument 2) indicates the table.
- The table that receives the data must contain at least 16 elements after the starting index. (If the table is not large enough, an error -3 is returned.) Data for point zero is placed in the first specified table element, with other points following in order. If a slot does not contain a high-density digital module, its corresponding table element is zero-filled.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>I/O Unit</strong></td>
<td><strong>Start Index</strong></td>
</tr>
<tr>
<td>GRV-R7-MM1001-10</td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td>SNAP-B3000-ENET, SNAP-ENET-RTC*</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>SNAP-ENET-S64*</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB1</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB2</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1-B</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R2</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB1</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB2</td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-ADS*</td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-M64*</td>
<td></td>
</tr>
</tbody>
</table>
* Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).

<table>
<thead>
<tr>
<th>Argument 2</th>
<th>Argument 3</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Put Result in</strong></td>
<td><strong>Put Status in</strong></td>
</tr>
<tr>
<td>Integer 32 Table</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

Action Block Example:

<table>
<thead>
<tr>
<th>Get &amp; Clear All HDD Module On-Latches</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Argument Name</strong></td>
</tr>
<tr>
<td>-------------------</td>
</tr>
<tr>
<td>I/O Unit</td>
</tr>
<tr>
<td>Start Index</td>
</tr>
<tr>
<td>Put Result in</td>
</tr>
<tr>
<td>Put Status in</td>
</tr>
</tbody>
</table>
For example, if the I/O unit UIO_A consists of an 8-module rack with an analog module in slot 0 and HDD modules in slots 1–7, table Bldg_A_OnLatches might be filled as follows:

<table>
<thead>
<tr>
<th>Index</th>
<th>Value (Bitmask)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>00000000000000000000000000000000</td>
</tr>
<tr>
<td>1</td>
<td>01100001010001110000001010000000</td>
</tr>
<tr>
<td>2</td>
<td>0000000000010001000000001111</td>
</tr>
<tr>
<td>3</td>
<td>0010000001100000010000001110</td>
</tr>
<tr>
<td>4</td>
<td>01100001010001110000001010000000</td>
</tr>
<tr>
<td>5</td>
<td>00001110000100011001000000001001</td>
</tr>
<tr>
<td>6</td>
<td>100000011000011100000000100100</td>
</tr>
<tr>
<td>7</td>
<td>001100000111000001111100000001</td>
</tr>
<tr>
<td>8</td>
<td>000000000000000000000000011111</td>
</tr>
<tr>
<td></td>
<td>000000000000000000000000000000</td>
</tr>
<tr>
<td>15</td>
<td>000000000000000000000000000000</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```plaintext
GetClearAllHddModuleOnLatches(I/O Unit, Start Index, Put Result in)
Status_Code = GetClearAllHddModuleOnLatches(UIO_A, 0, Bldg_A_OnLatches);
```

This is a function command; it returns one of the status codes shown below.

**Notes:**

- To read and reset the on-latches on only one HDD module, use `Get & Clear HDD Module On-Latches`. To read on-latches without clearing them, use `Get All HDD Module On-Latches`.
- You can manipulate bits within the table using commands such as `Numeric Table Element Bit Test`, or move the data in one element to a variable and use commands such as `Bit Test`.
- For more information, see "Legacy High-Density Digital Module Commands" in the "PAC Control User's Guide, Legacy Edition" (form 1710), and the "SNAP High-Density Digital Module User's Guide" (form 1547).

**Status Codes:**

- 0 = Success
- -3 = Invalid table length.
- -12 = Invalid table index value. Index was negative or greater than the table size.
- -43 = Received a NACK from the I/O unit.
- -58 = No data received. Make sure I/O unit has power.
- -93 = I/O unit not enabled. Previous communication failure may have disabled communication to the unit automatically. Reenable communication to the unit and try again.

**See Also:**

- "Get & Clear HDD Module On-Latches" on page 237
- "Get All HDD Module On-Latches" on page 241
- "Numeric Table Element Bit Test" on page 420
- "Bit Test" on page 379 and other Bit commands
# Get & Clear HDD Module Counter

## High-Density Digital Module Action

NOTE: This is a high-density digital (HDD) command. To enable HDD commands, from the PAC Control menu bar, click File > Strategy Options > Legacy tab > Original High Density Digital commands.

**Function:** To read and reset the counter for a specific point on a high-density digital input module.

**Typical Use:** To read and reset the counter for one point only.

**Details:**
- Works only on high-density digital input modules, not on standard digital modules.
- Places the counts in an integer 32 variable and then clears the counter.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Unit</td>
<td>Module #</td>
</tr>
<tr>
<td>GRV-R7-MM1001-10</td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td>SNAP-B3000-ENET, SNAP-ENET-RTC*</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>SNAP-ENET-S64*</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB1</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB2</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1-B</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R2</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB1</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB2</td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-ADS*</td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-M64*</td>
<td></td>
</tr>
</tbody>
</table>

* Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).

<table>
<thead>
<tr>
<th>Argument 2</th>
<th>Argument 3</th>
<th>Argument 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Point #</td>
<td>Put Result in</td>
<td>Put Status in</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```
GetClearHddModuleCounter (I/O Unit, Module #, Point Number, Put Result in)
```

Status_Code = GetClearHddModuleCounter(Ins_42, 8, Meter, Meter_8_Counts);

This is a function command; it returns one of the status codes shown below.

**Notes:**
- To read and clear all counters on a module, use Get & Clear HDD Module Counters. To read counters without clearing them, use Get HDD Module Counters.
- For more information, see “Legacy High-Density Digital Module Commands” in the PAC Control User’s Guide, Legacy Edition (form 1710), and the SNAP High-Density Digital Module User’s Guide (form 1547).
- Counters with values of more than 2 billion may appear as negative numbers.
Status Codes:

0 = Success

-43 = Received a NACK from the I/O unit.

-58 = No data received. Make sure I/O unit has power.

-93 = I/O unit not enabled. Previous communication failure may have disabled communication to the unit automatically. Reenable communication to the unit and try again.

See Also:

“Get & Clear HDD Module Counters” on page 233
“Get HDD Module Counters” on page 245
Get & Clear HDD Module Counters
High-Density Digital Module Action

NOTE: This is a high-density digital (HDD) command. To enable HDD commands, from the PAC Control menu bar, click File > Strategy Options > Legacy tab > Original High Density Digital commands.

Function: To read and reset the counters for all points on a high-density digital input module.

Typical Use: To read and reset all counters on a module in one command.

Details:
• Works only on high-density digital modules, not on standard digital modules.
• Places counter data for all points in the module in an integer 32 table at a designated starting index, and then clears all counters. Start Table Index (Argument 2) sets the index number, and Put Result in (Argument 3) indicates the table.
• The table that receives the data must contain at least 32 elements after the starting index. (If the table is not large enough, an error -3 is returned.) Data for point zero is placed in the first specified table element, with other points following in order.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Unit</td>
<td>Module #</td>
</tr>
<tr>
<td>GRV-R7-MM1001-10</td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td>SNAP-B3000-ENET, SNAP-ENET-RTC*</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>SNAP-ENET-S64*</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB1</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1-B</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R2</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB1</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB2</td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-ADS*</td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-M64*</td>
<td></td>
</tr>
</tbody>
</table>

* Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).

<table>
<thead>
<tr>
<th>Argument 2</th>
<th>Argument 3</th>
<th>Argument 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Table Index</td>
<td>Put Result in</td>
<td>Put Status in</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Table</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Action Block Example:

<table>
<thead>
<tr>
<th>Get &amp; Clear HDD Module Counters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argument Name</td>
</tr>
<tr>
<td>I/O Unit</td>
</tr>
<tr>
<td>Module #</td>
</tr>
<tr>
<td>Start Table Index</td>
</tr>
<tr>
<td>Put Result in</td>
</tr>
<tr>
<td>Put Status in</td>
</tr>
</tbody>
</table>
For example, if the value of the variable Index is zero, the first four elements of the Meter_Counts table might be filled as follows:

<table>
<thead>
<tr>
<th>Index</th>
<th>Counter Value</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>&lt; &lt; &lt;</td>
<td>61</td>
<td>Counter data for point 0</td>
</tr>
<tr>
<td>1</td>
<td>&lt; &lt; &lt;</td>
<td>85</td>
<td>Counter data for point 1</td>
</tr>
<tr>
<td>2</td>
<td>&lt; &lt; &lt;</td>
<td>102</td>
<td>Counter data for point 2</td>
</tr>
<tr>
<td>3</td>
<td>&lt; &lt; &lt;</td>
<td>42</td>
<td>Counter data for point 3</td>
</tr>
</tbody>
</table>

OptoScript Example:

```optoscript
GetClearHddModuleCounters (I/O Unit, Module #, Start Index, Put Result in)
```

Status_Code = GetClearHddModuleCounters(In_42, Section, Index, Meter_Ct);

This is a function command; it returns one of the status codes shown below.

Notes:
- To read and clear just one counter on a module, use Get & Clear HDD Module Counter. To read counters without clearing them, use Get HDD Module Counters.
- For more information, see “Legacy High-Density Digital Module Commands” in the PAC Control User’s Guide, Legacy Edition (form 1710), and the SNAP High-Density Digital Module User’s Guide (form 1547).
- Counters with values of more than 2 billion may appear as negative numbers.

Status Codes:

- 0 = Success
- -3 = Invalid table length. Table must contain at least 32 elements.
- -12 = Invalid table index value. Index was negative or greater than the table size.
- -43 = Received a NACK from the I/O unit.
- -58 = No data received. Make sure I/O unit has power.
- -93 = I/O unit not enabled. Previous communication failure may have disabled communication to the unit automatically. Reenable communication to the unit and try again.

See Also:
- “Get & Clear HDD Module Counter” on page 231
- “Get HDD Module Counters” on page 245
Get & Clear HDD Module Off-Latches

High-Density Digital Module Action

NOTE: This is a high-density digital (HDD) command. To enable HDD commands, from the PAC Control menu bar, click File > Strategy Options > Legacy tab > Original High Density Digital commands.

Function: To read and reset the off-latches of all points on a high-density digital input module.

Typical Use: To read and clear off-latches on a module in one command.

Details:
• Works only on high-density digital modules, not on standard digital modules.
• Places a bitmask in an integer 32 variable showing the state of off-latches for all points on the module, and resets the latches. The least significant bit in the mask corresponds to point 0. A value of 1 in a bit means the off-latch is on (set); a value of 0 in the bit means the off-latch is off (not set).

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Unit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>GRV-R7-MM1001-10</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-B3000-ENET, SNAP-ENET-RTC*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-ENET-S64*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1-B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-ADS*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-M64*</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).

<table>
<thead>
<tr>
<th>Argument 1</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module #</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Argument 2</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Put Result in</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Argument 3</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Put Status in</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Action Block Example:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Unit</td>
<td>SNAP-ENET-S64</td>
<td>9</td>
</tr>
<tr>
<td>Module #</td>
<td>Integer 32 Literal</td>
<td>Fan_OffLatches</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Integer 32 Variable</td>
<td>Status_Code</td>
</tr>
<tr>
<td>Put Status in</td>
<td>Integer 32 Variable</td>
<td>9</td>
</tr>
</tbody>
</table>

An example of the result is illustrated below. Only the first 8 and last 8 off-latches are shown.
OptoScript Example: \texttt{GetClearHddModuleOffLatches(I/O Unit, Module \#, Put Result in)}
\begin{verbatim}
Status\_Code = GetClearHddModuleOffLatches(Bldg\_A, 9, Fan\_OffLatches);
\end{verbatim}
This is a function command; it returns one of the status codes shown below.

Notes:
\begin{itemize}
\item To read off-latches without clearing them, use \texttt{Get HDD Module Off-Latches}.
\item For more information, see "Legacy High-Density Digital Module Commands" in the \textit{PAC Control User's Guide, Legacy Edition} (form 1710), and the \textit{SNAP High-Density Digital Module User's Guide} (form 1547).
\end{itemize}

Status Codes:
\begin{itemize}
\item 0 = Success
\item -43 = Received a NACK from the I/O unit.
\item -58 = No data received. Make sure I/O unit has power.
\item -93 = I/O unit not enabled. Previous communication failure may have disabled communication to the unit automatically. Reenable communication to the unit and try again.
\end{itemize}

See Also:
\begin{itemize}
\item "Get HDD Module Off-Latches" on page 247
\item "Get & Clear All HDD Module Off-Latches" on page 227
\item "Get All HDD Module On-Latches" on page 241
\end{itemize}
Get & Clear HDD Module On-Latches

High-Density Digital Module Action

NOTE: This is a high-density digital (HDD) command. To enable HDD commands, from the PAC Control menu bar, click File > Strategy Options > Legacy tab > Original High Density Digital commands.

Function: To read and reset the on-latches of all points on a high-density digital input module.

Typical Use: To read and reset all on-latches on a module in one command.

Details:
- Works only on high-density digital modules, not on standard digital modules.
- Places a bitmask in an integer 32 variable that indicates the state of on-latches for all points on the module, and resets the latches. The least significant bit corresponds to point 0. A value of 1 in a bit means the on-latch is on (set); a value of 0 in the bit means the on-latch is off (not set).

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Unit</td>
<td>Module #</td>
</tr>
<tr>
<td>GRV-R7-MM1010</td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td>SNAP-B3000-ENET, SNAP-ENET-RTC*</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>SNAP-ENET-S64*</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB1</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB2</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1-B</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R2</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB1</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB2</td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-ADS*</td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-M64*</td>
<td></td>
</tr>
</tbody>
</table>

* Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).

Arguments:

<table>
<thead>
<tr>
<th>Argument 2</th>
<th>Argument 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Put Result in</td>
<td>Put Status in</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

Action Block Example:

<table>
<thead>
<tr>
<th>Get &amp; Clear HDD Module On-Latches</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argument Name</td>
</tr>
<tr>
<td>I/O Unit</td>
</tr>
<tr>
<td>Module #</td>
</tr>
<tr>
<td>Put Result in</td>
</tr>
<tr>
<td>Put Status in</td>
</tr>
</tbody>
</table>

An example of the result is illustrated below. Only the first 8 and last 8 on-latches are shown.

<table>
<thead>
<tr>
<th>Bit-mask</th>
<th>Hex</th>
<th>9</th>
<th>3</th>
<th>&gt;&gt; &gt;</th>
<th>B</th>
<th>2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Binary</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>On-latch</td>
<td>on</td>
<td>off</td>
<td>off</td>
<td>on</td>
<td>off</td>
<td>on</td>
</tr>
<tr>
<td>Point Number</td>
<td>31</td>
<td>30</td>
<td>29</td>
<td>28</td>
<td>27</td>
<td>26</td>
</tr>
</tbody>
</table>
**OptoScript Example:**

GetClearHddModuleOnLatches (*I/O Unit, Module #, Put Result in*)

```opto
Status_Code = GetClearHddModuleOnLatches(Bldg_A, 9, Fan_OnLatches);
```

This is a function command; it returns one of the status codes shown below.

**Notes:**
- To read on-latches without clearing them, use Get HDD Module On-Latches.
- For more information, see "Legacy High-Density Digital Module Commands" in the PAC Control User’s Guide, Legacy Edition (form 1710), and the SNAP High-Density Digital Module User’s Guide (form 1547).

**Status Codes:**

- **0 = Success**
- **-43 =** Received a NACK from the I/O unit.
- **-58 =** No data received. Make sure I/O unit has power.
- **-93 =** I/O unit not enabled. Previous communication failure may have disabled communication to the unit automatically. Reenable communication to the unit and try again.

**See Also:**
- *Get HDD Module On-Latches* on page 249
- *Get & Clear All HDD Module On-Latches* on page 229
- *Get All HDD Module Off-Latches* on page 239
Get All HDD Module Off-Latches

High-Density Digital Module Action

**Function:** To read the off-latches for all points on all high-density digital input modules on one I/O unit.

**Typical Use:** To get off-latches for all high-density digital points on the I/O unit with a single command, without clearing the latches.

**Details:**
- Works only on high-density digital modules, not on standard digital modules.
- Places all off-latch data as bitmasks in an integer 32 table at a designated starting index. 
  Start Index (Argument 1) sets the index number, and Put Result in (Argument 2) indicates the table.
- The table that receives the data must contain at least 16 elements after the starting index. (If the table is not large enough, an error -3 is returned.) Data for the module in position zero is placed in the first specified table element, with other modules following in order. If a slot does not contain a high-density digital module, its corresponding table element is zero-filled.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Unit</td>
<td>Start Index</td>
</tr>
<tr>
<td>GRV-R7-MM1001-10</td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td>SNAP-B3000-ENET, SNAP-ENET-RTC*</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>SNAP-ENET-S64*</td>
<td>Start Index</td>
</tr>
<tr>
<td>SNAP-PAC-EB1</td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td>SNAP-PAC-EB2</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>SNAP-PAC-R1</td>
<td>Start Index</td>
</tr>
<tr>
<td>SNAP-PAC-R1-B</td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td>SNAP-PAC-R2</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>SNAP-PAC-SB1</td>
<td>Start Index</td>
</tr>
<tr>
<td>SNAP-PAC-SB2</td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td>SNAP-UP1-ADS*</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>SNAP-UP1-M64*</td>
<td>Start Index</td>
</tr>
</tbody>
</table>

* Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).

**Action Block Example:**

<table>
<thead>
<tr>
<th>Get All HDD Module Off-Latches</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argument Name</td>
</tr>
<tr>
<td>I/O Unit</td>
</tr>
<tr>
<td>Start Index</td>
</tr>
<tr>
<td>Put Result in</td>
</tr>
<tr>
<td>Put Status in</td>
</tr>
</tbody>
</table>
For example, if the I/O unit UIO_A consists of an 8-module rack with an analog module in slot 0 and HDD modules in slots 1–7, table Bldg_A_OffLatches might be filled as follows:

<table>
<thead>
<tr>
<th>Index</th>
<th>Value (Bitmask)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>00000000000000000000000000000000 &lt; &lt;&lt; &lt; (This module is not a HDD module.)</td>
</tr>
<tr>
<td>1</td>
<td>01100001010001110000001010110010</td>
</tr>
<tr>
<td>2</td>
<td>0000000000001000100000000000111</td>
</tr>
<tr>
<td>3</td>
<td>00100000110000000100100001001000</td>
</tr>
<tr>
<td>4</td>
<td>01100001010001110000001010110010</td>
</tr>
<tr>
<td>5</td>
<td>00011110001000110010000000100100</td>
</tr>
<tr>
<td>6</td>
<td>100000011100000111000000000100100</td>
</tr>
<tr>
<td>7</td>
<td>00110000111000011111000000000001</td>
</tr>
<tr>
<td>8</td>
<td>00000000000000000000000000000000</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```
GetAllHddModuleOffLatches(I/O Unit, Start Index, Put Result in)
```

```
Status_Code = GetAllHddModuleOffLatches(UIO_A, 0, Bldg_A_OffLatches);
```

This is a function command; it returns one of the status codes shown below.

**Notes:**

- To read the off-latches on only one HDD module, use **Get HDD Module Off-Latches**. To read and clear off-latches, use **Get & Clear All HDD Module Off-Latches**.
- You can manipulate bits within the table using commands such as **Numeric Table Element Bit Test**, or move the data in one element to a variable and use commands such as **Bit Test**.
- For more information, see “Legacy High-Density Digital Module Commands” in the *PAC Control User’s Guide, Legacy Edition* (form 1710), and the SNAP High-Density Digital Module User’s Guide (form 1547).

**Status Codes:**

- 0 = Success
- -3 = Invalid table length.
- -12 = Invalid table index value. Index was negative or greater than the table size.
- -43 = Received a NACK from the I/O unit.
- -58 = No data received. Make sure I/O unit has power.
- -93 = I/O unit not enabled. Previous communication failure may have disabled communication to the unit automatically. Reenable communication to the unit and try again.

**See Also:**

- “Get HDD Module Off-Latches” on page 247
- “Get & Clear All HDD Module Off-Latches” on page 227
- “Numeric Table Element Bit Test” on page 420
- “Bit Test” on page 379 and other Bit commands
Get All HDD Module On-Latches
High-Density Digital Module Action

NOTE: This is a high-density digital (HDD) command. To enable HDD commands, from the PAC Control menu bar, click File > Strategy Options > Legacy tab > Original High Density Digital commands.

Function: To read the on-latches for all points on all high-density digital input modules on one I/O unit.

Typical Use: To get on-latches for all high-density digital points on the I/O unit with a single command, without clearing the latches.

Details:
- Works only on high-density digital input modules, not on standard digital modules.
- Places all on-latch data as bitmasks in an integer 32 table at a designated starting index. Start Index (Argument 1) sets the index number, and Put Result in (Argument 2) indicates the table.
- The table that receives the data must contain at least 16 elements after the starting index. (If the table is not large enough, an error -3 is returned.) Data for the module in position zero is placed in the first specified table element, with other modules following in order. If a slot does not contain a high-density digital module, its corresponding table element is zero-filled.

Arguments:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Unit</td>
<td></td>
<td>GRV-R7-MM1001-10, SNAP-B3000-ENET, SNAP-ENET-RTC*, SNAP-ENET-S64*, SNAP-PAC-EB1, SNAP-PAC-EB2, SNAP-PAC-R1, SNAP-PAC-R1-B, SNAP-PAC-R2, SNAP-PAC-SB1, SNAP-PAC-SB2, SNAP-UP1-ADS*, SNAP-UP1-M64*</td>
</tr>
<tr>
<td>Start Index</td>
<td>Integer 32 Literal</td>
<td>0</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Integer 32 Table</td>
<td>Bldg_A_OnLatches</td>
</tr>
<tr>
<td>Put Status in</td>
<td>Integer 32 Variable</td>
<td>Status_Code</td>
</tr>
</tbody>
</table>

* Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).

Action Block Example:

<table>
<thead>
<tr>
<th>Get All HDD Module On-Latches</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argument Name</td>
</tr>
<tr>
<td>I/O Unit</td>
</tr>
<tr>
<td>Start Index</td>
</tr>
<tr>
<td>Put Result in</td>
</tr>
<tr>
<td>Put Status in</td>
</tr>
</tbody>
</table>
For example, if the I/O unit UIO_A consists of an 8-module rack with an analog module in slot 0 and HDD modules in slots 1–7, table Bldg_A_OnLatches might be filled as follows:

<table>
<thead>
<tr>
<th>Index</th>
<th>Value (Bitmask)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>00000000000000000000000000000000 &lt;&lt; &lt;&lt; (This module is not a HDD module.)</td>
</tr>
<tr>
<td>1</td>
<td>01100001010001110000000101011010</td>
</tr>
<tr>
<td>2</td>
<td>00000000000010001000000000001111 Each index contains the on-latch data for the HDD module in the corresponding position on the rack. A value of 1 indicates that the on-latch is on (set); a value of 0 indicates that it is off (not set). The least significant bit corresponds to point zero on the module.</td>
</tr>
<tr>
<td>3</td>
<td>00100000110000000100010000001100</td>
</tr>
<tr>
<td>4</td>
<td>01100001010001110000001010110100</td>
</tr>
<tr>
<td>5</td>
<td>00011100001000110010000000100100 In this example, index 2, which contains the on-latch data for all points on the module in slot 2, shows that on-latches for points 0, 1, 2, 10, 14, and 19 are on. All others are off.</td>
</tr>
<tr>
<td>6</td>
<td>10000000110000000110000000001000</td>
</tr>
<tr>
<td>7</td>
<td>00110000011100000111000000000001</td>
</tr>
<tr>
<td>8</td>
<td>00000000000000000000000000000000 The remainder of the table is zero-filled, since there are no more modules.</td>
</tr>
<tr>
<td>9</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>00000000000000000000000000000000</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```plaintext
GetAllHddModuleOnLatches(I/O Unit, Start Index, Put Result in)
```

Status_Code = GetAllHddModuleOnLatches(UIO_A, 0, Bldg_A_OnLatches);

This is a function command; it returns one of the status codes shown below.

**Notes:**
- To read the on-latches on only one HDD module, use Get HDD Module On-Latches. To read and clear on-latches, use Get & Clear All HDD Module On-Latches.
- You can manipulate bits within the table using commands such as Numeric Table Element Bit Test, or move the data in one element to a variable and use commands such as Bit Test.
- For more information, see “Legacy High-Density Digital Module Commands” in the **PAC Control User's Guide, Legacy Edition** (form 1710), and the **SNAP High-Density Digital Module User’s Guide** (form 1547).

**Status Codes:**

- 0 = Success
- -3 = Invalid table length.
- -12 = Invalid table index value. Index was negative or greater than the table size.
- -43 = Received a NACK from the I/O unit.
- -58 = No data received. Make sure I/O unit has power.
- -93 = I/O unit not enabled. Previous communication failure may have disabled communication to the unit automatically. Reenable communication to the unit and try again.

**See Also:**

- “Get HDD Module On-Latches” on page 249
- “Get & Clear All HDD Module On-Latches” on page 229
- “Numeric Table Element Bit Test” on page 420
- “Bit Test” on page 379 and other Bit commands
Get All HDD Module States

High-Density Digital Module Action

NOTE: This is a high-density digital (HDD) command. To enable HDD commands, from the PAC Control menu bar, click File > Strategy Options > Legacy tab > Original High Density Digital commands.

Function: To read the states of all points on all high-density digital input or output modules on one I/O unit.

Typical Use: To get the states for all high-density digital points on the I/O unit with a single command.

Details:
- Works only on high-density digital modules, not on standard digital modules.
- Places all status data as bitmasks in an integer 32 table at a designated starting index. 
  Start Index (Argument 1) sets the index number, and Put Result in (Argument 2) indicates the table.
- The table that receives the data must contain at least 16 elements after the starting index. (If the table is not large enough, an error -3 is returned) Data for the module in position zero is placed in the first specified table element, with other modules following in order. If a slot does not contain a high-density digital module, its corresponding table element is zero-filled.

Arguments:  

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Unit</td>
<td>Argument 0</td>
<td>SNAP-UP1-ADS</td>
</tr>
<tr>
<td>Start Index</td>
<td>Argument 1</td>
<td>UIO_A</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Argument 2</td>
<td>0</td>
</tr>
<tr>
<td>Put Status in</td>
<td>Argument 3</td>
<td>Bldg_A_Status</td>
</tr>
</tbody>
</table>

* Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).

Action Block Example:

<table>
<thead>
<tr>
<th>Get All HDD Module States</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Unit</td>
</tr>
<tr>
<td>Start Index</td>
</tr>
<tr>
<td>Put Result in</td>
</tr>
<tr>
<td>Put Status in</td>
</tr>
</tbody>
</table>
For example, if the I/O unit UIO_A consists of an 8-module rack with an analog module in slot 0 and HDD modules in slots 1–7, table Bldg_A_Status might be filled as follows:

<table>
<thead>
<tr>
<th>Index</th>
<th>Value (Bitmask)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>00000000000000000000000000000000 &lt;&lt;  &lt;&lt; (This module is not a HDD module.)</td>
</tr>
<tr>
<td>1</td>
<td>0110000011100000000010010010110010</td>
</tr>
<tr>
<td>2</td>
<td>00000000000000000000000000000000111</td>
</tr>
<tr>
<td>3</td>
<td>01000000010000000000000000000000100</td>
</tr>
<tr>
<td>4</td>
<td>00000000000000000000000000000000100</td>
</tr>
<tr>
<td>5</td>
<td>00000000000000000000000000000000101</td>
</tr>
<tr>
<td>6</td>
<td>00000000000000000000000000000000100</td>
</tr>
<tr>
<td>7</td>
<td>00000000000000000000000000000000100</td>
</tr>
<tr>
<td>8</td>
<td>00000000000000000000000000000000000</td>
</tr>
<tr>
<td>9</td>
<td>00000000000000000000000000000000000</td>
</tr>
</tbody>
</table>

OptoScript Example:

GetAllHddModuleStates(I/O Unit, Start Index, Put Result in)

Status_Code = GetAllHddModuleStates(UIO_A, 0, Bldg_A_Status);

This is a function command; it returns one of the status codes shown below.

Notes:
- To read the points on only one HDD module, use Get HDD Module States.
- You can manipulate bits within the table using commands such as Numeric Table Element Bit Test, or move the data in one element to a variable and use commands such as Bit Test.
- For more information, see “Legacy High-Density Digital Module Commands” in the PAC Control User’s Guide, Legacy Edition (form 1710), and the SNAP High-Density Digital Module User’s Guide (form 1547).

Status Codes:

0 = Success
-3 = Invalid table length.
-12 = Invalid table index value. Index was negative or greater than the table size.
-43 = Received a NACK from the I/O unit.
-58 = No data received. Make sure I/O unit has power.
-93 = I/O unit not enabled. Previous communication failure may have disabled communication to the unit automatically. Reenable communication to the unit and try again.

See Also:

“Get HDD Module States” on page 251
“Set HDD Module from MOMO Masks” on page 253
“Move I/O Unit to Numeric Table Ex” on page 281
“Numeric Table Element Bit Test” on page 420
“Bit Test” on page 379 and other Bit commands
Get HDD Module Counters

High-Density Digital Module Action

NOTE: This is a high-density digital (HDD) command. To enable HDD commands, from the PAC Control menu bar, click File > Strategy Options > Legacy tab > Original High Density Digital commands.

Function: To read the counters for all points on a high-density digital input module.

Typical Use: To get counts without clearing them.

Details:
- Works only on high-density digital modules, not on standard digital modules.
- Places counter data for all points in the module in an integer 32 table at a designated starting index. Start Index (Argument 1) sets the index number, and Put Result in (Argument 2) indicates the table.
- The table that receives the data must contain at least 32 elements after the starting index. (If the table is not large enough, an error -3 is returned.) Data for point zero is placed in the first specified table element, with other points following in order.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Unit</td>
<td>Module #</td>
</tr>
<tr>
<td>GRV-R7-MM1001-10</td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td>SNAP-B3000-ENET, SNAP-ENET-RTC*</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>SNAP-ENET-S64*</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB1</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB2</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1-B</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R2</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB1</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB2</td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-ADS*</td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-M64*</td>
<td></td>
</tr>
</tbody>
</table>

* Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).

<table>
<thead>
<tr>
<th>Argument 2</th>
<th>Argument 3</th>
<th>Argument 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Table Index</td>
<td>Put Result in</td>
<td>Put Status in</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Table</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

Action Block Example:

<table>
<thead>
<tr>
<th>Get HDD Module Counters</th>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Unit</td>
<td>SNAP-ENET-S64</td>
<td>Installation_42</td>
<td></td>
</tr>
<tr>
<td>Module #</td>
<td>Integer 32 Literal</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>Start Table Index</td>
<td>Integer 32 Literal</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Put Result in</td>
<td>Integer 32 Variable</td>
<td>Rotations</td>
<td></td>
</tr>
<tr>
<td>Put Status in</td>
<td>Integer 32 Variable</td>
<td>Status_Code</td>
<td></td>
</tr>
</tbody>
</table>
For example, the first four elements of the Rotations table might be filled as follows:

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>25678</td>
<td>&lt;&lt; &lt; Counter data for point 0</td>
</tr>
<tr>
<td>1</td>
<td>25678</td>
<td>&lt;&lt; &lt; Counter data for point 1</td>
</tr>
<tr>
<td>2</td>
<td>30946747</td>
<td>&lt;&lt; &lt; Counter data for point 2</td>
</tr>
<tr>
<td>3</td>
<td>42</td>
<td>&lt;&lt; &lt; Counter data for point 3</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```plaintext
GetHddModuleCounters(I/O Unit, Module #, Start Table Index, Put Result in)
```

```
Status_Code = GetHddModuleCounters(Installation_42, 10, 0, Rotations);
```

This is a function command; it returns one of the status codes shown below.

**Notes:**
- To read and clear counters, use Get & Clear HDD Module Counter (one counter) or Get & Clear HDD Module Counters (all counters on a module).
- For more information, see “Legacy High-Density Digital Module Commands” in the PAC Control User’s Guide, Legacy Edition (form 1710), and the SNAP High-Density Digital Module User’s Guide (form 1547).
- Counters with values of more than 2 billion may appear as negative numbers.

**Status Codes:**
- 0 = Success
- -3 = Invalid table length. Table must contain at least 32 elements.
- -12 = Invalid table index value. Index was negative or greater than the table size.
- -43 = Received a NACK from the I/O unit.
- -58 = No data received. Make sure I/O unit has power.
- -93 = I/O unit not enabled. Previous communication failure may have disabled communication to the unit automatically. Reenable communication to the unit and try again.

**See Also:**
- “Get & Clear HDD Module Counter” on page 231
- “Get & Clear HDD Module Counters” on page 233
Get HDD Module Off-Latches

High-Density Digital Module Action

NOTE: This is a high-density digital (HDD) command. To enable HDD commands, from the PAC Control menu bar, click File > Strategy Options > Legacy tab > Original High Density Digital commands.

Function: To read the off-latches of all points on a high-density digital input module.

Typical Use: To read off-latches without clearing latches.

Details:
- Works only on high-density digital modules, not on standard digital modules.
- Uses a bitmask to indicate the state of off-latches for all points on the module. The least significant bit corresponds to point 0. A value of 1 in a bit means the off-latch is on (set); a value of 0 in the bit means the off-latch is off (not set).

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
<th>Argument 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Unit</td>
<td>Module #</td>
<td>Put Result in</td>
<td>Put Status in</td>
</tr>
<tr>
<td>GRV-R7-MM11001-10</td>
<td>Integer 32 Literal</td>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>SNAP-B3000-ENET, SNAP-ENET-RTC*</td>
<td>Integer 32 Literal</td>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>SNAP-ENET-S64*</td>
<td>Integer 32 Literal</td>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>SNAP-PAC-EB1</td>
<td>Integer 32 Literal</td>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>SNAP-PAC-EB2</td>
<td>Integer 32 Literal</td>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>SNAP-PAC-R1</td>
<td>Integer 32 Literal</td>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>SNAP-PAC-R1-B</td>
<td>Integer 32 Literal</td>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>SNAP-PAC-R2</td>
<td>Integer 32 Literal</td>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>SNAP-PAC-SB1</td>
<td>Integer 32 Literal</td>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>SNAP-PAC-SB2</td>
<td>Integer 32 Literal</td>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>SNAP-UP1-ADS*</td>
<td>Integer 32 Literal</td>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>SNAP-UP1-M64*</td>
<td>Integer 32 Literal</td>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

* Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).

Action Block

Example:

Get HDD Module Off-Latches

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Unit</td>
<td>SNAP-ENET-S64</td>
<td>Bldg_A</td>
</tr>
<tr>
<td>Module #</td>
<td>Integer 32 Literal</td>
<td>9</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Integer 32 Variable</td>
<td>Fan_OffLatches</td>
</tr>
<tr>
<td>Put Status in</td>
<td>Integer 32 Variable</td>
<td>Status_Code</td>
</tr>
</tbody>
</table>

An example of the result is illustrated below. Only the first 8 and last 8 off-latches are shown.

<table>
<thead>
<tr>
<th>Bit-mask</th>
<th>Hex</th>
<th>9</th>
<th>3</th>
<th>&gt;&gt;</th>
<th>B</th>
<th>2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Binary</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>Off-latch</td>
<td>on</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>on</td>
<td>off</td>
</tr>
<tr>
<td>Point Number</td>
<td>31</td>
<td>30</td>
<td>29</td>
<td>28</td>
<td>27</td>
<td>26</td>
</tr>
<tr>
<td></td>
<td>7</td>
<td>6</td>
<td>5</td>
<td>4</td>
<td>3</td>
<td>2</td>
</tr>
</tbody>
</table>
OptoScript Example: \texttt{GetHddModuleOffLatches(I/O Unit, Module #, Put Result in)}

\begin{verbatim}
Status_Code = GetHddModuleOffLatches(Bldg_A, 9, Fan_OffLatches);
\end{verbatim}

This is a function command; it returns one of the status codes shown below.

Notes:
- To read all off-latches for all HDD modules on one I/O unit, use \texttt{Get All HDD Module Off-Latches}.
- For more information, see "Legacy High-Density Digital Module Commands" in the \textit{PAC Control User's Guide, Legacy Edition} (form 1710), and the \textit{SNAP High-Density Digital Module User's Guide} (form 1547).

Status Codes:
- 0 = Success
- -43 = Received a NACK from the I/O unit.
- -58 = No data received. Make sure I/O unit has power.
- -93 = I/O unit not enabled. Previous communication failure may have disabled communication to the unit automatically. Reenable communication to the unit and try again.

See Also:
- "Get HDD Module On-Latches" on page 249
- "Get All HDD Module Off-Latches" on page 239
- "Get & Clear HDD Module Off-Latches" on page 235
- "Get & Clear All HDD Module Off-Latches" on page 227
Get HDD Module On-Latches

High-Density Digital Module Action

**NOTE:** This is a high-density digital (HDD) command. To enable HDD commands, from the PAC Control menu bar, click File > Strategy Options > Legacy tab > Original High Density Digital commands.

**Function:**
To read the on-latches of all points on a high-density digital input module.

**Typical Use:**
To read on-latches without clearing latches.

**Details:**
- Works only on high-density digital modules, not on standard digital modules.
- Uses a bitmask to indicate the state of on-latches for all points on the module. The least significant bit corresponds to point 0. A value of 1 in a bit means the on-latch is on (set); a value of 0 in the bit means the on-latch is off (not set).

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>I/O Unit</strong></td>
<td><strong>Module #</strong></td>
</tr>
<tr>
<td>GRV-R7-MM1001-10</td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td>SNAP-B3000-ENET, SNAP-ENET-RTC*</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>SNAP-ENET-S64*</td>
<td>Argument 2</td>
</tr>
<tr>
<td>SNAP-PAC-EB1</td>
<td>Argument 3</td>
</tr>
<tr>
<td>SNAP-PAC-EB2</td>
<td><strong>Put Result in</strong></td>
</tr>
<tr>
<td>SNAP-PAC-R1</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>SNAP-PAC-R1-B</td>
<td><strong>Put Status in</strong></td>
</tr>
<tr>
<td>SNAP-PAC-R2</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>SNAP-PAC-SB1</td>
<td>Argument 2</td>
</tr>
<tr>
<td>SNAP-PAC-SB2</td>
<td><strong>Put Result in</strong></td>
</tr>
<tr>
<td>SNAP-UP1-ADS*</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>SNAP-UP1-M64*</td>
<td><strong>Put Status in</strong></td>
</tr>
</tbody>
</table>

* Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).

**Action Block Example:**

Get HDD Module On-Latches

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Unit</td>
<td>SNAP-ENET-S64</td>
<td>Bldg_A</td>
</tr>
<tr>
<td>Module #</td>
<td>Integer 32 Literal</td>
<td>9</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Integer 32 Variable</td>
<td>Fan_OnLatches</td>
</tr>
<tr>
<td>Put Status in</td>
<td>Integer 32 Variable</td>
<td>Status_Code</td>
</tr>
</tbody>
</table>

An example of the result is illustrated below. Only the first 8 and last 8 on-latches are shown.

<table>
<thead>
<tr>
<th>Bit-mask</th>
<th>Hex</th>
<th>9</th>
<th>3</th>
<th>&gt;&gt;</th>
<th>B</th>
<th>2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Binary</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>On-latch</td>
<td>on</td>
<td>off</td>
<td>off</td>
<td>on</td>
<td>off</td>
<td>on</td>
</tr>
<tr>
<td>Point Number</td>
<td>31</td>
<td>30</td>
<td>29</td>
<td>28</td>
<td>27</td>
<td>26</td>
</tr>
</tbody>
</table>
OptoScript Example: \texttt{GetHddModuleOnLatches(I/O Unit, Module \#, Put Result in)}

\begin{verbatim}
Status_Code = GetHddModuleOnLatches(Bldg_A, 9, Fan_OnLatches);
\end{verbatim}

This is a function command; it returns one of the status codes shown below.

Notes:
- To read all on-latches for all HDD modules on one I/O unit, use \texttt{Get All HDD Module On-Latches}.
- For more information, see “Legacy High-Density Digital Module Commands” in the \textit{PAC Control User’s Guide, Legacy Edition} (form 1710), and the \textit{SNAP High-Density Digital Module User’s Guide} (form 1547).

Status Codes:
- 0 = Success
- -43 = Received a NACK from the I/O unit.
- -58 = No data received. Make sure I/O unit has power.
- -93 = I/O unit not enabled. Previous communication failure may have disabled communication to the unit automatically. Reenable communication to the unit and try again.

See Also:
- “Get HDD Module Off-Latches” on page 247
- “Get All HDD Module On-Latches” on page 241
- “Get & Clear HDD Module On-Latches” on page 237
- “Get & Clear All HDD Module On-Latches” on page 229
Get HDD Module States

High-Density Digital Module Action

NOTE: This is a high-density digital (HDD) command. To enable HDD commands, from the PAC Control menu bar, click File > Strategy Options > Legacy tab > Original High Density Digital commands.

Function: To read the states of all points on a high-density digital input or output module.

Typical Use: To get information about all points on one module in one command.

Details:
- Works only on high-density digital modules, not on standard digital modules.
- Uses a bitmask to indicate the state of each point on the module. The least significant bit corresponds to point 0. A value of 1 in a bit means the point is on; a value of 0 in the bit means the point is off.

Arguments:
- **Argument 0**: I/O Unit
  - GRV-R7-MM1001-10
  - SNAP-B3000-ENET, SNAP-ENET-RTC*
  - SNAP-ENET-S64*
  - SNAP-PAC-EB1
  - SNAP-PAC-EB2
  - SNAP-PAC-R1
  - SNAP-PAC-R1-B
  - SNAP-PAC-R2
  - SNAP-PAC-SB1
  - SNAP-PAC-SB2
  - SNAP-UP1-ADS*
  - SNAP-UP1-M64*

* Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).

- **Argument 1**: Module 
  - Integer 32 Literal
  - Integer 32 Variable

- **Argument 2**: Put Result in
  - Integer 32 Variable

- **Argument 3**: Put Status in
  - Integer 32 Variable

Action Block Example:

<table>
<thead>
<tr>
<th>Get HDD Module States</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Unit</td>
<td>SNAP-UP1-ADS</td>
<td>UIO_A</td>
</tr>
<tr>
<td>Module #</td>
<td>Integer 32 literal</td>
<td>12</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Integer 32 Variable</td>
<td>Fan_Status</td>
</tr>
<tr>
<td>Put Status in</td>
<td>Integer 32 Variable</td>
<td>Status_Code</td>
</tr>
</tbody>
</table>

An example of the result is illustrated below. Only the first 8 and last 8 points are shown.

<table>
<thead>
<tr>
<th>Bit-mask</th>
<th>Hex 9</th>
<th>Hex 3</th>
<th>Hex 2</th>
<th>State</th>
<th>Point Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Binary</td>
<td>1 0 0 1</td>
<td>0 0 1</td>
<td>&gt; &gt; &gt;</td>
<td>1 0 1</td>
<td>1 0 0 1 0</td>
</tr>
<tr>
<td>State</td>
<td>on off on off on off on on</td>
<td>on off on on off</td>
<td>off off on off</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| Point Number | 31 | 30 | 29 | 28 | 27 26 25 24 | > > > | 7 6 5 4 | 3 2 1 0
OptoScript

**Example:**  
\texttt{GetHddModuleStates(I/O Unit, Module #, Put Result in)}

\texttt{Status_Code = GetHddModuleStates(UIO_A, 12, Fan_Status)};

This is a function command; it returns one of the status codes shown below.

**Notes:**
- To read the points on all HDD modules on one I/O unit, use \texttt{Get All HDD Module States}.
- For more information, see “Legacy High-Density Digital Module Commands” in the \textit{PAC Control User's Guide, Legacy Edition} (form 1710), and the \textit{SNAP High-Density Digital Module User's Guide} (form 1547).

**Status Codes:**

- \texttt{0} = Success
- \texttt{-43} = Received a NACK from the I/O unit.
- \texttt{-58} = No data received. Make sure I/O unit has power.
- \texttt{-93} = I/O unit not enabled. Previous communication failure may have disabled communication to the unit automatically. Reenable communication to the unit and try again.

**See Also:**
- "Get All HDD Module States" on page 243
- "Set HDD Module from MOMO Masks" on page 253
- "Turn On HDD Module Point" on page 257
- "Turn Off HDD Module Point" on page 255
Set HDD Module from MOMO Masks

High-Density Digital Module Action

NOTE: This is a high-density digital (HDD) command. To enable HDD commands, from the PAC Control menu bar, click File > Strategy Options > Legacy tab > Original High Density Digital commands.

Function: To control multiple points on the same high-density digital output module simultaneously with a single command.

Typical Use: To efficiently control multiple digital outputs on one module with one command.

Details: • If setting all 32 points, this command is about 32 times faster than using Turn On HDD Module Point or Turn Off HDD Module Point 32 times.
• To turn on a point, set the respective bit in the 32-bit data field of Must On Mask (Argument 2) to a value of 1.
• To turn off a point, set the respective bit in the 32-bit data field of Must Off Mask (Argument 3) to a value of 1.
• To leave a point unaffected, set its bits to a value of 0 in both Must On Mask and Must Off Mask. Check for conflicts; if the same bit is set to 1 in both masks, the point is turned off.
• The least significant bit corresponds to point zero.

Arguments:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Unit</td>
<td></td>
<td>GRV-R7-MM1001-10</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-B3000-ENET, SNAP-ENET-RTC*</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-ENET-564*</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-PAC-EB1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-PAC-EB2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-PAC-R1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-PAC-R1-B</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-PAC-R2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-PAC-SB1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-PAC-SB2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-UP1-ADS*</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-UP1-M64*</td>
</tr>
</tbody>
</table>

* Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module #</td>
<td>Integer 32 Literal</td>
<td>3</td>
</tr>
<tr>
<td>Must On Mask</td>
<td>Integer 32 Variable</td>
<td>0x600000C2</td>
</tr>
<tr>
<td>Must Off Mask</td>
<td>Integer 32 Variable</td>
<td>0xB00000020</td>
</tr>
<tr>
<td>Put Status in</td>
<td>SNAP-UP1-ADS</td>
<td>Status_Code</td>
</tr>
</tbody>
</table>

Action Block Example:

Set HDD Module from MOMO Masks

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Unit</td>
<td>SNAP-UP1-M64</td>
<td>Bldg_A</td>
</tr>
<tr>
<td>Module #</td>
<td>Integer 32 Literal</td>
<td>3</td>
</tr>
<tr>
<td>Must On Mask</td>
<td>Integer 32 Variable</td>
<td>0x600000C2</td>
</tr>
<tr>
<td>Must Off Mask</td>
<td>Integer 32 Literal</td>
<td>0xB00000020</td>
</tr>
<tr>
<td>Put Status in</td>
<td>SNAP-UP1-ADS</td>
<td>Status_Code</td>
</tr>
</tbody>
</table>
The effect of this command is illustrated below:

<table>
<thead>
<tr>
<th>Point Number</th>
<th>31</th>
<th>30</th>
<th>29</th>
<th>28</th>
<th>27</th>
<th>26</th>
<th>25</th>
<th>24</th>
<th>...</th>
<th>7</th>
<th>6</th>
<th>5</th>
<th>4</th>
<th>3</th>
<th>2</th>
<th>1</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Must-on</strong></td>
<td>Binary</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>...</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>Hex</td>
<td></td>
<td></td>
<td></td>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>C</td>
</tr>
<tr>
<td><strong>Must-off</strong></td>
<td>Binary</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>...</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>Hex</td>
<td>B</td>
<td></td>
<td></td>
<td></td>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2</td>
</tr>
</tbody>
</table>

To save space, the example shows only the first eight and the last eight digital points on the rack. For the points shown, points 26, 25, 7, 6, and 1 will be turned on. Points 31, 29, 28, and 5 will be turned off. Other points shown are not changed.

**OptoScript Example:**

\[
\text{SetHddModuleFromMomo} \left( \text{I/O Unit, Module #, Must On Mask, Must Off Mask} \right) \\
\text{Status Code} = \text{SetHDDModuleFromMomo(Bldg}_A, \ 3, \ 0x060000C2, \ 0xB0000020) ;
\]

This is a function command; it returns one of the status codes shown below.

**Status Codes:**

- 0 = Success
- -43 = Received a NACK from the I/O unit.
- -58 = No data received. Make sure I/O unit has power.
- -93 = I/O unit not enabled. Previous communication failure may have disabled communication to the unit automatically. Reenable communication to the unit and try again.

**See Also:**

- “Turn On HDD Module Point” on page 257
- “Turn Off HDD Module Point” on page 255
Turn Off HDD Module Point
High-Density Digital Module Action

NOTE: This is a high-density digital (HDD) command. To enable HDD commands, from the PAC Control menu bar, click File > Strategy Options > Legacy tab > Original High Density Digital commands.

Function: To turn off a specific point on a high-density digital output module.

Typical Use: To turn off one point only.

Details: Works only on high-density digital output modules, not on standard digital output modules.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Unit</td>
<td>Module #</td>
</tr>
<tr>
<td><em>GRV-R7-MM1001-10</em></td>
<td><em>Integer 32 Literal</em></td>
</tr>
<tr>
<td>SNAP-B3000-ENET, SNAP-ENET-RTC*</td>
<td><em>Integer 32 Variable</em></td>
</tr>
<tr>
<td>SNAP-ENET-S64*</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB1</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB2</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1-B</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R2</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB1</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB2</td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-ADS*</td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-M64*</td>
<td></td>
</tr>
</tbody>
</table>

* Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).

<table>
<thead>
<tr>
<th>Argument 2</th>
<th>Argument 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Point #</td>
<td>Put Status in</td>
</tr>
<tr>
<td><em>Integer 32 Literal</em></td>
<td><em>Integer 32 Variable</em></td>
</tr>
<tr>
<td><em>Integer 32 Variable</em></td>
<td></td>
</tr>
</tbody>
</table>

Action Block Example:

```
<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Unit</td>
<td><em>SNAP-ENET-S64</em></td>
<td><em>Installation_42</em></td>
</tr>
<tr>
<td>Module #</td>
<td><em>Integer 32 Literal</em></td>
<td><em>8</em></td>
</tr>
<tr>
<td>Point #</td>
<td><em>Integer 32 Variable</em></td>
<td><em>Meter</em></td>
</tr>
<tr>
<td>Put Status in</td>
<td><em>Integer 32 Variable</em></td>
<td><em>Status_Code</em></td>
</tr>
</tbody>
</table>
```

OptoScript Example:

```
TurnOffHddModulePoint(I/O Unit, Module #, Point #)
Status_Code = TurnOffHddModulePoint(Installation_42, 8, Meter);
```

This is a function command; it returns one of the status codes shown below.

Notes:
- To turn on or off several points at once, use Set HDD Module from MOMO Masks.
- For more information, see “Legacy High-Density Digital Module Commands” in the PAC Control User’s Guide, Legacy Edition (form 1710), and the SNAP High-Density Digital Module User’s Guide (form 1547).

Status Codes:

- 0 = Success
- -43 = Received a NACK from the I/O unit.
-58 = No data received. Make sure I/O unit has power.

-93 = I/O unit not enabled. Previous communication failure may have disabled communication to the unit automatically. Reenable communication to the unit and try again.

See Also:

“Turn On HDD Module Point” on page 257
“Set HDD Module from MOMO Masks” on page 253
CHAPTER 8: HIGH-DENSITY DIGITAL MODULE

Turn On HDD Module Point
High-Density Digital Module Action

NOTE: This is a high-density digital (HDD) command. To enable HDD commands, from the PAC Control menu bar, click File > Strategy Options > Legacy tab > Original High Density Digital commands.

Function: To turn on a specific point on a high-density digital output module.

Typical Use: To turn on one point only.

Details: Works only on high-density digital output modules, not on standard digital output modules.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Unit</td>
<td>Module #</td>
</tr>
<tr>
<td>GRV-R7-MM1001-10</td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td>SNAP-B3000-ENET, SNAP-ENET-RTC*</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>SNAP-ENET-S64*</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB1</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB2</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1-B</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R2</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB1</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB2</td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-ADS*</td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-M64*</td>
<td></td>
</tr>
</tbody>
</table>

* Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).

<table>
<thead>
<tr>
<th>Argument 2</th>
<th>Argument 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Point #</td>
<td>Put Status in</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td></td>
</tr>
</tbody>
</table>

Action Block Example:

```
OptoScript Example: TurnOnHddModulePoint(I/O Unit, Module #, Point #)
Status_Code = TurnOnHddModulePoint(Installation_42, 8, Meter);
```

This is a function command; it returns one of the status codes shown below.

Notes:
- To turn on or off several points at once, use Set HDD Module from MOMO Masks.

Status Codes:
- 0 = Success
- -43 = Received a NACK from the I/O unit.
-58 = No data received. Make sure I/O unit has power.

-93 = I/O unit not enabled. Previous communication failure may have disabled communication to the unit automatically. Reenable communication to the unit and try again.

See Also:

“Turn Off HDD Module Point” on page 255
“Set HDD Module from MOMO Masks” on page 253
9: I/O Quality Commands

Get I/O Channel Quality

I/O Quality

**Function:**
Returns a code indicating the data quality on a specified channel of a groov I/O module.

**Typical Use:**
To determine if an exception condition occurred on the I/O channel.

**Details:**
*NOTE: Applicable only to groov I/O in PAC Control R10.0a and higher only.*

A quality code of 0 (zero) indicates the channel isn’t currently reporting any data quality issues. For details, see Quality Codes.

*groov I/O* modules that report quality continuously poll their channels for current data values and identify deviations between reported and expected values. For example, when a channel on a GRV-IV-24 reports a value greater than 10% above range, the module sets a quality indicator code 15 (Input is more than 10% above the maximum range) on the channel. When the issue is resolved, the quality indicator code returns to 0 (zero).

Not all modules report data quality. The ones that do are:

<table>
<thead>
<tr>
<th>I/O Module</th>
<th>Quality Indicator Codes</th>
</tr>
</thead>
<tbody>
<tr>
<td>GRV-IMA-24</td>
<td>0, 15, 16</td>
</tr>
<tr>
<td>GRV-ITMI-8</td>
<td>0, 15, 16</td>
</tr>
<tr>
<td>GRV-IV-24</td>
<td>0, 15, 16</td>
</tr>
<tr>
<td>GRV-OAC-12</td>
<td>0, 9</td>
</tr>
<tr>
<td>GRV-OACI-12</td>
<td>0, 9</td>
</tr>
<tr>
<td>GRV-OVMALC-8</td>
<td>0, 18, 21, 22</td>
</tr>
</tbody>
</table>

A quality indicator doesn’t always mean a serious problem, but it’s definitely something you should investigate. It may indicate a configuration issue or an issue with a field device or field wiring. For example, if you write a maximum output value that’s higher than a channel’s normal range, the module may report a quality indicator code of 21 (Output is at positive range limit); that is, the output channel is functioning normally at its maximum positive range, despite the fact that your configuration tried to set its maximum range to an out-of-range value.
CHAPTER 9: I/O QUALITY COMMANDS

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Channel</td>
<td>Put in</td>
</tr>
<tr>
<td>Analog Input</td>
<td>Float Variable</td>
</tr>
<tr>
<td>Analog Output</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Digital Input</td>
<td>Integer 64 Variable</td>
</tr>
<tr>
<td>Digital Output</td>
<td></td>
</tr>
</tbody>
</table>

Action Block

Example:

Get I/O Channel Quality

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Channel</td>
<td>Analog Input</td>
<td>Alarm</td>
</tr>
<tr>
<td>Put in</td>
<td>Integer 32 Variable</td>
<td>Data_Quality</td>
</tr>
</tbody>
</table>

OptoScript Example:

GetChannelQuality(From Channel)

Data_Quality = GetChannelQuality(Alarm);

This is a function command; it returns one of the quality codes listed below.

Notes:

- This command works only with groov I/O modules; the “From Channel” must be on a groov I/O module.
- The command is available in PAC Control R10.0a and higher.
- Because the channels are constantly being polled, you may see a different code depending on the state of the channel when the command is sent. For example, if a channel reports a current reading that’s above its positive range limit, the I/O module sets a quality code 21 on the channel. Later, if a wire on the same channel breaks, the current would be extremely small, and the module would change the quality code to 18 (Output fault). But when the field signal comes back into range, the quality will return to Good (0).

Quality Codes:

A brief description of a channel’s quality indicator is visible when you are scanning the channel in PAC Control’s Debug mode. When you use a PAC Control I/O Quality command, a code is returned instead of the description. The following is a list of valid quality indicator codes and their definitions.

0 = Data quality is good. No exception conditions occurred.

9 = Digital output is on, but current is not flowing. May indicate an open circuit or blown fuse in field equipment.

15 = Analog input is above 110% of channel’s range. Applicable to unipolar (zero and positive values only) and bipolar (can include negative and positive values) signal ranges.

16 = Analog input is below -110% of channel’s range. Applicable to unipolar (zero and positive values only) and bipolar (can include negative and positive values) signal ranges.

18 = Analog output fault.
   - When configured for voltage, indicates the load resistance is too low (that is, the load is drawing too much current to maintain the voltage).
   - When configured for current, indicates very high resistance or possible open current loop.

21 = Analog output is at the positive range limit. Applicable only when the value written exceeds the maximum limit. Indicates the module has clamped the output to the limit. Can be caused by a configuration or logic error; for example, the strategy sent a value to the channel that is above the channel’s maximum range.

22 = Analog output is at the minus range limit. Applicable only when the value written exceeds the minimum limit. Indicates the module has clamped the output to the limit. Can be caused by a configuration or logic error; for example, the strategy sent a value to the channel that is below the channel’s minimum range.

30 = Node not found.
Queue Errors:
-39 = Timeout on receive.
-43 = Received a NACK from the I/O unit.
-58 = No data received. Make sure I/O unit has power.
-93 = I/O Unit not enabled. Previous communication failure may have automatically disabled communication to the unit. Reenable communication to the unit and try again. (The I/O unit and channel must be enabled for this command to work.)

See Also: “Get I/O Unit Quality” on page 262
## Get I/O Unit Quality

### I/O Quality

**Function:**
Returns a numerical value representing a bitmask that indicates which groov I/O modules on the specified I/O unit have reported a non-zero quality code. For more about quality codes, see “Get I/O Channel Quality” on page 259.

**Typical Use:**
To determine if any groov I/O module is reporting a data quality issue.

**Details:**
*Note: This command is available in PAC Control R10.0a and higher.*

When the returned value is viewed as a binary number, each bit indicates a position in the chassis. Module positions on the chassis are numbered from left to right (0 - 15) and correspond to bits 0 - 15 in the returned value. A 0 (zero) bit means the position has no quality issues; a 1 (one) bit indicates a module in that position has at least one channel reporting a non-zero quality code.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>From I/O Unit</td>
<td>GRV-EPIC-PR1</td>
<td>Local_IO</td>
</tr>
</tbody>
</table>

**Action Block Example:**

```
Get I/O Unit Quality
```

**OptoScript Example:**

```
GetIoUnitQuality (From I/O Unit)
```

```
Quality_Mask = GetIOUnitQuality (Local_IO);
```

This is a function command; it returns a decimal value representing a bitmask.

**Notes:**
- This command works only with groov I/O modules; the “From I/O Unit” must be a groov I/O module.
- The command is available in PAC Control R10.0a and higher.
- If the returned value is 0, it means no modules are reporting a quality code.
- Any returned value greater than zero should be assessed to determine which modules are reporting quality codes. Then use Get I/O Channel Quality to find out which channel is reporting data outside of the expected values.

**Queue Errors:**
- -39 = Timeout on receive.
- -43 = Received a NACK from the I/O unit.
- -58 = No data received. Make sure I/O unit has power.
- -93 = I/O Unit not enabled. Previous communication failure may have automatically disabled communication to the unit. Reenable communication to the unit and try again. (The I/O unit must be enabled for this command to work.)

**See Also:**
“Get I/O Channel Quality” on page 259
Clear I/O Unit Configured Flag

I/O Unit Action

Function: Clears the flag that the controller uses to indicate that the I/O unit has been initialized by the controller.

Typical Use: Provides a workaround for the issue of Ethernet brains only supporting a single Power Up Clear (PUC).

Details:

- Issue this command immediately before enabling communication to an I/O unit so that the controller will configure the I/O unit and points.
- Using this command followed by Enable Communication to I/O Unit forces all configuration commands to be sent to the I/O unit, regardless of whether they have been previously sent.
- Use this command to force the controller to send all configuration commands to an I/O unit when you enable it. This can be useful if you are concerned that an I/O unit’s PUC might have been appropriated by an HMI or other application.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0 On I/O Unit</th>
<th>(Argument 0 continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>B100*</td>
<td>SNAP-BSR*</td>
</tr>
<tr>
<td>B200*</td>
<td>SNAP-ENET-D64**</td>
</tr>
<tr>
<td>B3000 (Analog)*</td>
<td>SNAP-ENET-S64**</td>
</tr>
<tr>
<td>B3000 (Digital)*</td>
<td>SNAP-PAC-EB1</td>
</tr>
<tr>
<td>E1</td>
<td>SNAP-PAC-EB2</td>
</tr>
<tr>
<td>E2</td>
<td>SNAP-PAC-R1</td>
</tr>
<tr>
<td>G4A8R, G4RAX*</td>
<td>SNAP-PAC-R1-B</td>
</tr>
<tr>
<td>G4D16R*</td>
<td>SNAP-PAC-R2</td>
</tr>
<tr>
<td>G4D32RS*</td>
<td>SNAP-PAC-SB1</td>
</tr>
<tr>
<td>G4EB2</td>
<td>SNAP-PAC-SB2</td>
</tr>
<tr>
<td>Generic OptoMMP Device</td>
<td>SNAP-UP1-ADS**</td>
</tr>
<tr>
<td>GRV-EPIC-PR1</td>
<td>SNAP-UP1-D64**</td>
</tr>
<tr>
<td>GRV-R7-MM1001-10</td>
<td>SNAP-UP1-M64**</td>
</tr>
<tr>
<td>SNAP-B3000-ENET, SNAP-ENET-RTC**</td>
<td></td>
</tr>
</tbody>
</table>

* Available only in PAC Control Professional when mistic products are enabled (File > Strategy Options > Legacy tab > Mistic I/O units and commands).
** Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).
Clear I/O Unit Configured Flag

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>On I/O Unit</td>
<td>SNAP-PAC-EB2</td>
<td>FURNACE_PID</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

ClearIoUnitConfiguredFlag (On I/O Unit)

ClearIoUnitConfiguredFlag (FURNACE_PID);

This is a procedure command; it does not return a value.
## Get I/O Unit as Binary Value

### I/O Unit Action

**Function:** To read the current on/off status of all digital points on the I/O unit.

**Typical Use:** To efficiently read the status of all digital points on a single I/O unit with one command.

**Details:**
- For standard digital points only. (For modules with more than four points, see “Move I/O Unit to Numeric Table Ex” on page 281 or “Get All HDD Module States” on page 243 or “Get I/O Unit Module States” on page 269.)
- Reads the current on/off status of all digital points on the I/O unit specified and updates the IVALs and XVALs for all points. Reads outputs as well as inputs.
- Returns status (a 32-bit or 64-bit integer) to the numeric variable specified.
- SNAP-PAC-R1s and -R1-Bs return 32 bits, even though they can move up to 64 digital points. For an I/O unit with greater than 32 digital points, use “Get I/O Unit as Binary Value 64” on page 267 instead. (Note that groov EPIC processors return 64 bits.)
- Do not move a unit with 64 standard digital points into an integer 32 variable. Use an integer 64 variable instead.
- If a point is on, there will be a “1” in the respective bit. If the point is off, there will be a “0” in the respective bit. The least significant bit corresponds to point zero.
- An analog, serial, or PID point on a mixed I/O unit will appear as a “0”.
- If a specific point is disabled, it will not be read. If the entire I/O unit is disabled, none of the points will be read.

### Arguments:

<table>
<thead>
<tr>
<th>Argument 0 From</th>
<th>Argument 1 Put in</th>
</tr>
</thead>
<tbody>
<tr>
<td>B100*</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>B3000 (Digital)*</td>
<td></td>
</tr>
<tr>
<td>E1</td>
<td>Integer 64 Variable</td>
</tr>
<tr>
<td>G4D16R*</td>
<td></td>
</tr>
<tr>
<td>G4D32RS*</td>
<td></td>
</tr>
<tr>
<td>G4EB2</td>
<td></td>
</tr>
<tr>
<td>GRV-R7-MM1001-10</td>
<td></td>
</tr>
<tr>
<td>SNAP-B3000-ENET, SNAP-ENET-RTC**</td>
<td></td>
</tr>
<tr>
<td>SNAP-BRS*</td>
<td></td>
</tr>
<tr>
<td>SNAP-ENET-D64**</td>
<td></td>
</tr>
<tr>
<td>SNAP-ENET-S64**</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB1</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB2</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1-B</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R2</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB1</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB2</td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-ADS**</td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-D64**</td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-M64**</td>
<td></td>
</tr>
</tbody>
</table>

* Available only in PAC Control Professional when mistic products are enabled (File > Strategy Options > Legacy tab > Mistic I/O units and commands).
** Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).
CHAPTER 10: I/O UNIT COMMANDS

**Get I/O Unit as Binary Value**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>From</td>
<td>SNAP-PAC-EB1</td>
<td>INPUT_BOARD_2</td>
</tr>
<tr>
<td>Put in</td>
<td>Integer 64 Variable</td>
<td>IN_BD2_STATUS</td>
</tr>
</tbody>
</table>

The effect of this command is illustrated below. (To save space, the example shows only the first eight points and the last eight points on the 64-point I/O unit. Points with a value of 1 are on; points with a value of 0 are off.)

<table>
<thead>
<tr>
<th>Point Number</th>
<th>63</th>
<th>62</th>
<th>61</th>
<th>60</th>
<th>59</th>
<th>58</th>
<th>57</th>
<th>56</th>
<th>&gt;&gt;</th>
<th>7</th>
<th>6</th>
<th>5</th>
<th>4</th>
<th>3</th>
<th>2</th>
<th>1</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bitmask</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>&gt;&gt;</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>Binary</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>&gt;&gt;</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>Hex</td>
<td>6</td>
<td>C</td>
<td>&gt;&gt;</td>
<td>4</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td></td>
</tr>
</tbody>
</table>

To save space, the example shows only the first eight points and the last eight points on the 64-point I/O unit. Points with a value of 1 are on; points with a value of 0 are off.

**OptoScript Example:**

```
IN_BD2_STATUS = GetIoUnitAsBinaryValue(From);
```

This is a function command; it returns the current on/off status of all digital points, in the form of a bitmask. The returned value can be consumed by a variable (as shown) or used by an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the *PAC Control User’s Guide* (form 1700).

**Notes:**

- Use **Bit Test** to examine individual bits.
- To understand this command, think of it as a **Move** command for I/O units. Get I/O Unit as Binary Value moves an Int 32 value into an Int 32 or Int 64 variable, and all the associated rules still apply.
  
  Here’s a simple way to get the lower 32-bits using OptoScript:

  ```
nl1 = GetIoUnitAsBinaryValue(paceb1); // nl1 is Int64
nl  = GetLowBitsOfInt64(nl1);        // nl is Int32
  ```

**See Also:**

- “Set I/O Unit from MOMO Masks” on page 292
- “Get I/O Unit as Binary Value 64” on page 267
- “Get Low Bits of Integer 64” on page 391
- “Get High Bits of Integer 64” on page 390
Get I/O Unit as Binary Value 64

I/O Unit Action

**Function:**
To read the current on/off status of all digital points on the I/O unit.

**Typical Use:**
To efficiently read the status of all digital points on a single I/O unit with one command.

**Details:**
- For standard digital points only. (For more than four points, see "Move I/O Unit to Numeric Table Ex" on page 281 or "Get All HDD Module States" on page 243 or "Get I/O Unit Module States" on page 269.)
- Reads the current on/off status of all digital points on the I/O unit specified and updates the IVALs and XVALs for all points. Reads outputs as well as inputs.
- Returns status (64-bit integer) to the numeric variable specified.
- If a point is on, there will be a “1” in the respective bit. If the point is off, there will be a “0” in the respective bit. The least significant bit corresponds to point zero.
- An analog, serial, or PID point on a mixed I/O unit will appear as a “0”.
- If a specific point is disabled, it will not be read. If the entire I/O unit is disabled, none of the points will be read.
- If you only need the upper or lower 32 bits, use "Get Low Bits of Integer 64" on page 391 or "Get High Bits of Integer 64" on page 390.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0 From</th>
<th>Argument 1 Put in</th>
</tr>
</thead>
<tbody>
<tr>
<td>B100*</td>
<td>Integer 64 Variable</td>
</tr>
<tr>
<td>B3000 (Digital)*</td>
<td></td>
</tr>
<tr>
<td>E1</td>
<td></td>
</tr>
<tr>
<td>G4D16R*</td>
<td></td>
</tr>
<tr>
<td>G4D32RS*</td>
<td></td>
</tr>
<tr>
<td>G4EB2</td>
<td></td>
</tr>
<tr>
<td>GRV-R7-MM1001-10</td>
<td></td>
</tr>
<tr>
<td>SNAP-B3000-ENET, SNAP-ENET-RTC**</td>
<td></td>
</tr>
<tr>
<td>SNAP-BRS*</td>
<td></td>
</tr>
<tr>
<td>SNAP-ENET-D64**</td>
<td></td>
</tr>
<tr>
<td>SNAP-ENET-S64**</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB1</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB2</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1-B</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R2</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB1</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB2</td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-ADS**</td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-D64**</td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-M64**</td>
<td></td>
</tr>
</tbody>
</table>

* Available only in PAC Control Professional when mistic products are enabled (File > Strategy Options > Legacy tab > Mistic I/O units and commands).

** Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).

**Action Block Example:**

<table>
<thead>
<tr>
<th>Get I/O Unit as Binary Value 64</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>From</td>
<td>SNAP-PAC-EB1</td>
</tr>
<tr>
<td>Put in</td>
<td>Integer 64 Variable</td>
</tr>
</tbody>
</table>
The effect of this command is illustrated below. (To save space, the example shows only the first eight points and the last eight points on the 64-point I/O unit. Points with a value of 1 are on; points with a value of 0 are off.)

<table>
<thead>
<tr>
<th>Point Number</th>
<th>63</th>
<th>62</th>
<th>61</th>
<th>60</th>
<th>59</th>
<th>58</th>
<th>57</th>
<th>56</th>
<th>&gt; &gt; &gt;</th>
<th>7</th>
<th>6</th>
<th>5</th>
<th>4</th>
<th>3</th>
<th>2</th>
<th>1</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bitmask</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0 1 1 0 1 1 0 0</td>
<td>&gt; &gt; &gt;</td>
<td>0 1 0 0 0 0 1 0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hex</td>
<td>6</td>
<td>C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>4 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**OptoScript Example:**  
GetIoUnitAsBinaryValue64\(_{\text{From}}\)  
`IN_BD2_STATUS = GetIoUnitAsBinaryValue64(INPUT_BOARD_2);`

This is a function command; it returns the current on/off status of all digital points, in the form of a bitmask. The returned value can be consumed by a variable (as shown) or used by an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the *PAC Control User’s Guide* (form 1700).

**Notes:** Use Bit Test to examine individual bits.

**See Also:**  
“Set I/O Unit from MOMO Masks” on page 292  
“Get I/O Unit as Binary Value” on page 265  
“Get Low Bits of Integer 64” on page 391  
“Get High Bits of Integer 64” on page 390
Get I/O Unit Module States

I/O Unit Action

**Function:** To read current on/off status of all digital points on an I/O unit and place them in the elements of a numeric table.

**Typical Use:** To efficiently read all digital points on a single I/O unit with one command.

**Details:**
- This command is much faster than using Move several times.
- Reads both inputs and outputs. Updates the IVALS and XVALS for all points.
- Module zero corresponds to the first specified table element. The command sends point status to the table beginning at the index specified in Starting Index (Argument 1). If there are more modules than table elements from the specified index to the end of the table, no data is written to the table, and a -12 error is placed in the controller’s message queue.
- Least significant bit corresponding to point zero. GRV-IAC-24 and a 12-channel GRV-ODCI-12, the first two elements in the table might show Points that are on are indicated by a 1. Points that are off are indicated by a zero. In this example, channel 0 on module 0 is on; channel 0 on module 1 is off.
- Analog modules, serial modules, and modules that are not configured return a value of 0.0.
- If a specific point is disabled or if the entire I/O unit is disabled, only the internal values (IVALs) are read.
- This command reads from the I/O unit. It updates the IVALS in the controller.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0 From I/O Unit</th>
<th>Argument 1 Starting Index</th>
<th>Argument 2 Of Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>GRV-EPIC-PR1</td>
<td>Integer 32 Literal</td>
<td>Integer 32 Table</td>
</tr>
<tr>
<td>SNAP-B3000-ENET, SNAP-ENET-RTC*</td>
<td>Integer 32 Variable</td>
<td>Integer 64 Table</td>
</tr>
<tr>
<td>SNAP-ENET-D64*</td>
<td></td>
<td>Pointer Table</td>
</tr>
<tr>
<td>SNAP-ENET-564*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1-B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-ADS*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-D64*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-M64*</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).
### Get I/O Unit Module States

**OptoScript Example:**
```
GetIoUnitModuleStates (From I/O Unit, Starting Index, Of Table)
GetIoUnitModuleStates(My_IO_Unit, 0, DATA_TABLE);
```

This is a procedure command; it does not return a value.

**Queue Errors:**
- `-12` = Invalid table index value. Index was negative or greater than or equal to the table size.
- `-69` = Invalid parameter (null pointer) passed to command.

**See Also:**
- "Get All HDD Module States" on page 243
- "Move I/O Unit to Numeric Table" on page 279
- "Move Numeric Table to I/O Unit Ex" on page 286

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>From I/O Unit</td>
<td>GRV-EPIC-PR1</td>
<td>My_IO_Unit</td>
</tr>
<tr>
<td>Starting Index</td>
<td>Integer 32 Literal</td>
<td>0</td>
</tr>
<tr>
<td>Of Table</td>
<td>Integer 32 Table</td>
<td>DATA_TABLE</td>
</tr>
</tbody>
</table>
Get Target Address State

I/O Unit Action

Function: To determine which target addresses on an I/O unit in a redundant system are enabled and which address is active.

Typical Use: To determine which networks in a redundant system are enabled and which network is active.

Details:
- A target address is the IP address of an Ethernet interface on an I/O unit.
- In a redundant network architecture, you can assign two target addresses to an I/O unit. In PAC Control these are called the Primary Address and the Secondary Address. By default, the Primary Address is used, but the server will switch to the Secondary Address if the primary address is not available.
- Each target address has an enabled state and an active state. If a target address is enabled, then it is available to be used. However, only one address can be used at a given time, so there can only be one active address. The active address is the address the controller is currently using. One address is always active. If communication to the active address fails and the control engine is not able to switch to the other address, then communication to the I/O unit will become disabled.
- This command returns an Enable Mask value and an Active Mask value for a given I/O unit.
- The Enable Mask indicates which target addresses are enabled as follows:
  0 = No addresses are enabled
  1 = Only the Primary Address is enabled
  2 = Only the Secondary Address is enabled
  3 = Both addresses are enabled.
- The Active Mask indicates which address is active as follows:
  1 = Primary Address is active
  2 = Secondary Address is active

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Mask</td>
<td>Active Mask</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>I/O Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generic OptoMMP Device</td>
</tr>
<tr>
<td>GRV-EPIC-PR1</td>
</tr>
<tr>
<td>GRV-R7-MM1001-10</td>
</tr>
<tr>
<td>SNAP-B3000-ENET, SNAP-ENET-RTC*</td>
</tr>
<tr>
<td>SNAP-ENET-D64*</td>
</tr>
<tr>
<td>SNAP-ENET-S64*</td>
</tr>
<tr>
<td>SNAP-PAC-E1</td>
</tr>
<tr>
<td>SNAP-PAC-E2</td>
</tr>
<tr>
<td>SNAP-PAC-R1</td>
</tr>
<tr>
<td>SNAP-PAC-R1-B</td>
</tr>
<tr>
<td>SNAP-PAC-R2</td>
</tr>
<tr>
<td>SNAP-PAC-SB1</td>
</tr>
<tr>
<td>SNAP-PAC-SB2</td>
</tr>
<tr>
<td>SNAP-UP1-ADS*</td>
</tr>
<tr>
<td>SNAP-UP1-D64*</td>
</tr>
<tr>
<td>SNAP-UP1-M64*</td>
</tr>
</tbody>
</table>

* Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).
**Action Block**

**Example:**

```
OptoScript Example:

GetTargetAddressState(Enable Mask, Active Mask, I/O Unit);
```

This is a procedure command; it does not return a value.

**Notes:**
- A fully redundant system may also include PAC Display clients and OptoOPC Servers. These commands only deal with the control engine communicating with I/O units. PAC Display and OptoOPCServer have their own mechanism for controlling their use of the network.
- This command does not test communication.

**See Also:**
- “Set All Target Address States” on page 288
- “Set Target Address State” on page 294
I/O Unit Ready?

I/O Unit Condition

Function: Tests communication with the specified I/O unit.

Typical Use: To determine if the controller can physically communicate with the I/O unit.

Details:
- I/O Unit Ready? will test communication to the I/O unit regardless of whether it is enabled or not.
- When constructing a chart to verify I/O unit communications, it is good practice to use I/O Unit Ready? first. Then after getting a True response, use “Enable Communication to I/O Unit” on page 571 to make sure communication to the I/O unit is enabled. Also see the appendix on troubleshooting in the PAC Control User’s Guide (form 1700).
- In order for I/O Unit Ready? to be True, the I/O Unit must respond to the test message (identify type) with the correct I/O Unit type, or with a “PUC Expected” error.

Arguments: 

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B100*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B200*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B3000 (Analog)*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B3000 (Digital)*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>E1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>E2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>G4A8R, G4RAX*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>G4D16R*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>G4D32RS*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>G4EB2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Generic OptoMMP Device</td>
<td></td>
<td></td>
</tr>
<tr>
<td>GRV-EPIC-PR1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>GRV-R7-MM1001-10</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-B3000-ENET, SNAP-ENET-RTC**</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-BRS*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-ENET-D64**</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-ENET-S64**</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1-B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-ADS**</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-D64**</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-M64**</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* Available only in PAC Control Professional when mistic products are enabled (File > Strategy Options > Legacy tab > Mistic I/O units and commands).
** Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).

Condition Block Example:

<table>
<thead>
<tr>
<th>I/O Unit Ready?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argument Name</td>
</tr>
<tr>
<td>Is</td>
</tr>
</tbody>
</table>
OptoScript: `IsIoUnitReady(Is)`

Example:
```plaintext
if (IsIoUnitReady(PUMP_HOUSE)) then
```

This is a function command; it returns a value of true (non-zero) or false (0). The returned value can be consumed by a control structure (as in the example shown) or by a variable, I/O point, and so forth. For more information, see the `PAC Control User's Guide` (form 1700).

Notes: Ideal for determining “System Ready” status.

See Also:
- “I/O Point Communication Enabled?” on page 574
- “I/O Unit Communication Enabled?” on page 575
IVAL Move Numeric Table to I/O Unit

I/O Unit Action

**Function:**
Writes to the internal value (IVAL) of all points on the I/O unit.

**Typical Use:**
Simulation, testing, and certification where communication to the I/O units is disabled.

**Details:**
The program will use IVALS exclusively when communication to the specified point or I/O unit is disabled. This command allows all IVALS to be modified as if they were being changed by real I/O.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start at Index</td>
<td>Integer 32 Variable</td>
<td>4</td>
</tr>
<tr>
<td>Of Table</td>
<td>Integer 32 Table</td>
<td>IO_STATUS_TABLE</td>
</tr>
<tr>
<td>Move to</td>
<td>SNAP-PAC-R1</td>
<td>VALVE_CONTROL</td>
</tr>
</tbody>
</table>

* Available only in PAC Control Professional when **mistic** products are enabled (File > Strategy Options > Legacy tab > Mistic I/O units and commands).

** Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).

** Action Block Example:**

```
IVAL Move Numeric Table to I/O Unit
```

**OptoScript Example:**

```
IvalMoveNumTableToIoUnit(Start at Index, Of Table, Move to)
```

IVAL Move Numeric Table to I/O Unit (4, IO_STATUS_TABLE, VALVE_CONTROL);

This is a procedure command; it does not return a value.
Notes: Primarily used to write to inputs.

Queue Errors: -69 = Invalid parameter (null pointer) passed to command. Received if a null table object pointer is passed.

See Also: "IVAL Set Analog Point" on page 580
"Disable Communication to All I/O Units" on page 564,
"Disable Communication to I/O Unit" on page 565
IVAL Move Numeric Table to I/O Unit Ex

I/O Unit Action

**Function:**  Writes to the internal value (IVAL) of all points on the I/O unit.

**Typical Use:** Simulation, testing, and certification where communication to the I/O units is disabled.

**Details:**
- The program will use IVAls exclusively when communication to the specified point or I/O unit is disabled. This command allows output IVAls to be modified as if they were being changed by real I/O.
- Please see “Table Index Offsets” on page 707 for the length of the table required for values of points-per-module.
- The range of Points per Module (Argument 3) is 1 to 32.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Table</td>
<td>With Starting Index</td>
</tr>
<tr>
<td>Float Table</td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td>Integer 32 Table</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Pointer Table</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Argument 2</th>
<th>Argument 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>To I/O Unit</td>
<td>Points per Module</td>
</tr>
<tr>
<td>B100*</td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td>B200*</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>B3000 (Analog)*</td>
<td></td>
</tr>
<tr>
<td>B3000 (Digital)*</td>
<td></td>
</tr>
<tr>
<td>E1</td>
<td></td>
</tr>
<tr>
<td>E2</td>
<td></td>
</tr>
<tr>
<td>G4A8R, G4RAX**</td>
<td></td>
</tr>
<tr>
<td>G4D16R*</td>
<td></td>
</tr>
<tr>
<td>G4D32RS*</td>
<td></td>
</tr>
<tr>
<td>G4EB2</td>
<td></td>
</tr>
<tr>
<td>GRV-EPIC-PR1</td>
<td></td>
</tr>
<tr>
<td>GRV-R7-MM1001-10</td>
<td></td>
</tr>
<tr>
<td>SNAP-B3000-ENET, SNAP-ENET-RTC**</td>
<td></td>
</tr>
<tr>
<td>SNAP-8RS*</td>
<td></td>
</tr>
<tr>
<td>SNAP-ENET-D64**</td>
<td></td>
</tr>
<tr>
<td>SNAP-ENET-S64**</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB1</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB2</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1-B</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R2</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB1</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB2</td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-ADS**</td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-D64**</td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-M64**</td>
<td></td>
</tr>
</tbody>
</table>

* Available only in PAC Control Professional when mistic products are enabled (File > Strategy Options > Legacy tab > Mistic I/O units and commands).
** Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).
**IVAL Move Numeric Table to I/O Unit Ex**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Table</td>
<td>Integer 32 Table</td>
<td>IO_STATUS_TABLE</td>
</tr>
<tr>
<td>With Starting Index</td>
<td>Integer 32 Variable</td>
<td>4</td>
</tr>
<tr>
<td>To I/O Unit</td>
<td>GRV-EPIC-PR1</td>
<td>VALVE_CONTROL</td>
</tr>
<tr>
<td>Points per Module</td>
<td>Integer 32 Literal</td>
<td>4</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```
IvalMoveNumTableToIoUnitEx(From Table, With Starting Index, To I/O Unit, Points per Module)
IvalMoveNumTableToIoUnitEx(IO_STATUS_TABLE, 4, VALVE_CONTROL, 4);
```

This is a procedure command; it does not return a value.

**Notes:** Primarily used to write to inputs.

**Queue Errors:**
- `3` = Invalid Length. Received if a negative value or a value greater than 32 is passed for `Points per Module` (Argument 3). The MemMap supports a maximum of 32 points per module.
- `12` = Invalid table index value. Index was negative or greater than or equal to the table size.
- `69` = Invalid parameter (null pointer) passed to command. Received if a null table object pointer is passed.

**See Also:**
- "IVAL Set Analog Point" on page 580
- "Disable Communication to All I/O Units" on page 564,
- "Disable Communication to I/O Unit" on page 565
Move I/O Unit to Numeric Table
I/O Unit Action

NOTE: Use this command only for I/O units with modules that have four points or fewer. For modules with more than four points, use “Move I/O Unit to Numeric Table Ex” on page 281 or (for digital states only, by module) “Get I/O Unit Module States” on page 269 instead.

Function: To read the current on/off status or the current values of all points on each standard digital and analog module on an I/O unit and move the returned values to a numeric table.

Typical Use: To efficiently read all the data from all standard module points on a single I/O unit with one command.

Details:
- This command is much faster than using Move several times.
- Reads both inputs and outputs. Updates the IVALs and XVALs for all standard module points.
- This command will populate 4 table elements for each module position on the rack, regardless of whether the module has 1, 2, or 4 points. Because of this and because Opto 22 racks support a maximum of 16 modules, the table needs to be at least 64 elements long (4 elements x 16 modules = 64 elements). If a rack is full of 2-channel analog modules, that would be 32 points total (2 points x 16 modules = 32 points). Since each rack position must be populated, and each position occupies four elements in the table, every four elements will contain the values for a 2-channel module.

Table elements are populated as follows:

<table>
<thead>
<tr>
<th>Module Position</th>
<th>Point</th>
<th>Table Element</th>
<th>Table Values for 2-Channel Modules</th>
<th>Table Values for 1-Channel Modules</th>
<th>Table Values for 4-Channel Modules</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>data</td>
<td>data</td>
<td>data</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>1</td>
<td>data</td>
<td>0.0</td>
<td>data</td>
</tr>
<tr>
<td>0</td>
<td>2</td>
<td>2</td>
<td>0.0</td>
<td>0.0</td>
<td>data</td>
</tr>
<tr>
<td>0</td>
<td>3</td>
<td>3</td>
<td>0.0</td>
<td>0.0</td>
<td>data</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>4</td>
<td>data</td>
<td>data</td>
<td>data</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>5</td>
<td>data</td>
<td>0.0</td>
<td>data</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>6</td>
<td>0.0</td>
<td>0.0</td>
<td>data</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>7</td>
<td>0.0</td>
<td>0.0</td>
<td>data</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
</tbody>
</table>

- Point zero corresponds to the first specified table element. The command returns status to the table beginning at the index specified in Starting Index (Argument 1). If there are more points than table elements from the specified index to the end of the table, no data will be written to the table and a -12 will be placed in the message queue.
- For digital points, if the point is on, there will be a non-zero in the respective table element. If the point is off, there will be a zero in the respective table element.
- For analog points, the current value of the point in engineering units will appear in the respective table element.
- Points that are not configured will return a value of 0.0.
- If a specific point is disabled or if the entire I/O unit is disabled, only the internal values (IVALs) will be read.
CHAPTER 10: I/O UNIT COMMANDS

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>From</td>
<td>Starting Index</td>
<td>Of Table</td>
</tr>
<tr>
<td>B100*</td>
<td>Integer 32 Literal</td>
<td>Float Table</td>
</tr>
<tr>
<td>B200*</td>
<td>Integer 32 Literal</td>
<td>Float Table</td>
</tr>
<tr>
<td>B3000 (Analog)*</td>
<td>Integer 32 Variable</td>
<td>Integer 32 Table</td>
</tr>
<tr>
<td>B3000 (Digital)*</td>
<td>Integer 32 Variable</td>
<td>Integer 32 Table</td>
</tr>
<tr>
<td>E1</td>
<td></td>
<td>Pointer Table</td>
</tr>
<tr>
<td>E2</td>
<td></td>
<td>Pointer Table</td>
</tr>
<tr>
<td>G4A8R, G4RAX*</td>
<td></td>
<td>Pointer Table</td>
</tr>
<tr>
<td>G4D16R*</td>
<td></td>
<td>Pointer Table</td>
</tr>
<tr>
<td>G4D32RS*</td>
<td></td>
<td>Pointer Table</td>
</tr>
<tr>
<td>G4EB2</td>
<td></td>
<td>Pointer Table</td>
</tr>
<tr>
<td>GRV-R7-MM1001-10</td>
<td></td>
<td>Pointer Table</td>
</tr>
<tr>
<td>SNAP-B3000-ENET, SNAP-ENET-RTC**</td>
<td></td>
<td>Pointer Table</td>
</tr>
<tr>
<td>SNAP-BRS*</td>
<td></td>
<td>Pointer Table</td>
</tr>
<tr>
<td>SNAP-ENET-D64**</td>
<td></td>
<td>Pointer Table</td>
</tr>
<tr>
<td>SNAP-ENET-S64**</td>
<td></td>
<td>Pointer Table</td>
</tr>
<tr>
<td>SNAP-PAC-EB1</td>
<td></td>
<td>Pointer Table</td>
</tr>
<tr>
<td>SNAP-PAC-EB2</td>
<td></td>
<td>Pointer Table</td>
</tr>
<tr>
<td>SNAP-PAC-R1</td>
<td></td>
<td>Pointer Table</td>
</tr>
<tr>
<td>SNAP-PAC-R2</td>
<td></td>
<td>Pointer Table</td>
</tr>
<tr>
<td>SNAP-PAC-R1-B</td>
<td></td>
<td>Pointer Table</td>
</tr>
<tr>
<td>SNAP-PAC-R2</td>
<td></td>
<td>Pointer Table</td>
</tr>
<tr>
<td>SNAP-PAC-SB1</td>
<td></td>
<td>Pointer Table</td>
</tr>
<tr>
<td>SNAP-PAC-SB2</td>
<td></td>
<td>Pointer Table</td>
</tr>
<tr>
<td>SNAP-UP1-ADS**</td>
<td></td>
<td>Pointer Table</td>
</tr>
<tr>
<td>SNAP-UP1-D64**</td>
<td></td>
<td>Pointer Table</td>
</tr>
<tr>
<td>SNAP-UP1-M64**</td>
<td></td>
<td>Pointer Table</td>
</tr>
</tbody>
</table>

* Available only in PAC Control Professional when mistic products are enabled (File > Strategy Options > Legacy tab > Mistic I/O units and commands).
** Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).

OptoScript Example:

```
MoveIoUnitToNumTable (From, Starting Index, Of Table)
```

```
MoveIoUnitToNumTable (UNIT_255, 0, DATA_TABLE);
```

This is a procedure command; it does not return a value.

Notes:

For information on how a standard module differs from a high-density module, see the PAC Control User's Guide (form 1700).

Queue Errors:

-12 = Invalid table index value. Index was negative or greater than or equal to the table size.

-69 = Invalid parameter (null pointer) passed to command. Received if a null table object pointer is passed.

See Also:

* "Move Numeric Table to I/O Unit" on page 284
* "Get I/O Unit Module States" on page 269
Move I/O Unit to Numeric Table Ex

I/O Unit Action

**NOTE:** For use with high-density modules. For modules with four points or less, see "Move I/O Unit to Numeric Table" on page 279. To move digital data into elements by module rather than by point, see "Get I/O Unit Module States" on page 269.

**Function:**
To read current on/off status of all digital points and current values of all analog points on an I/O unit and move the returned values to a numeric table.

**Typical Use:**
To efficiently read all points of data on a single I/O unit with one command.

**Details:**
- See "Table Index Offsets" on page 707 for the length of the table required for values of points-per-module.
- Analog inputs that do not exist (for example, channels 2 and 3 of a 2-channel input module) appear as NaN (not a number).
- Analog outputs that do not exist (for example, channel 2 and 3 of a 2-channel output module) appear as 0.0.
- This command is much faster than using Move several times.
- Reads both inputs and outputs. Updates the IVALs and XVALs for all points.
- Point zero corresponds to the first specified table element. The command returns status to the table beginning at the index specified in With Starting Index (Argument 2). If there are more points than table elements from the specified index to the end of the table, no data is written to the table, and a -12 error is placed in the controller’s message queue. For table index offsets for SNAP PAC, see “Table Index Offsets” on page 707.
- For digital points, if the point is on, there will be a 1 in the respective table element. (In a float table, on points are displayed as 1.0.) If the point is off, there will be a zero in the respective table element.
- For analog points, the current value of the point in engineering units will appear in the respective table element.
- Points that are not configured will return a value of 0.0.
- If a specific point is disabled or if the entire I/O unit is disabled, only the internal values (IVALs) will be read.
- If the points per module is less than or equal to 0, or greater than 32, a -3 error is placed in the controller’s message queue.
- The range of Points per Module (Argument 3) is 1 to 32.
- The I/O unit may have modules with different numbers of points. For example, an I/O unit might have 4-channel, 8-channel, and 16-channel modules. In this configuration, Points per Module (Argument 3) determines the maximum number of points on any module. For modules that don’t have the maximum number of points, zeros are stored for both analog and digital points.
- This command reads from the I/O unit. It updates the IVALs in the controller.
Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>From I/O Unit</td>
<td>To Table</td>
</tr>
<tr>
<td>B100*</td>
<td>Float Table</td>
</tr>
<tr>
<td>B200*</td>
<td>Integer 32 Table</td>
</tr>
<tr>
<td>B3000 (Analog)*</td>
<td>Pointer Table</td>
</tr>
<tr>
<td>B3000 (Digital)*</td>
<td></td>
</tr>
<tr>
<td>E1</td>
<td></td>
</tr>
<tr>
<td>E2</td>
<td></td>
</tr>
<tr>
<td>G4A8R, G4RAX*</td>
<td></td>
</tr>
<tr>
<td>G4D16R*</td>
<td></td>
</tr>
<tr>
<td>G4D32RS*</td>
<td></td>
</tr>
<tr>
<td>G4EB2</td>
<td></td>
</tr>
<tr>
<td>GRV-EPIC-PR1</td>
<td></td>
</tr>
<tr>
<td>GRV-R7-MM1001-10</td>
<td></td>
</tr>
<tr>
<td>SNAP-B3000-ENET, SNAP-ENET-RTC**</td>
<td></td>
</tr>
<tr>
<td>SNAP-BR5*</td>
<td></td>
</tr>
<tr>
<td>SNAP-ENET-D64**</td>
<td></td>
</tr>
<tr>
<td>SNAP-ENET-S64**</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB1</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB2</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1-B</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R2</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB1</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB2</td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-ADS**</td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-D64**</td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-M64**</td>
<td></td>
</tr>
</tbody>
</table>

* Available only in PAC Control Professional when mistic products are enabled (File > Strategy Options > Legacy tab > Mistic I/O units and commands).

** Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).

<table>
<thead>
<tr>
<th>Argument 2</th>
<th>Argument 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>With Starting Index</td>
<td>Points per Module</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

Action Block Example:

Move I/O Unit to Numeric Table Ex

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>From I/O Unit</td>
<td>GRV-EPIC-PR1</td>
<td>UNIT_255</td>
</tr>
<tr>
<td>To table</td>
<td>Float table</td>
<td>DATA_TABLE</td>
</tr>
<tr>
<td>With Starting Index</td>
<td>Integer 32 Literal</td>
<td>0</td>
</tr>
<tr>
<td>Points per Module</td>
<td>Integer 32 Literal</td>
<td>4</td>
</tr>
</tbody>
</table>

OptoScript Example: MoveIoUnitToNumTableEx (From I/O Unit, To Table, With Starting Index, Points per Module)

```
MoveIoUnitToNumTableEx(UNIT_255, DATA_TABLE, 0, 4);
```

This is a procedure command; it does not return a value.

Queue Errors:

-3 = Invalid Length. Received if a negative value, a zero, or a value greater than 32 is passed for Points per Module (Argument 3). The MemMap supports values of 1 through 32.

-12 = Invalid table index value. Index was negative or greater than or equal to the table size.

-69 = Invalid parameter (null pointer) passed to command.
See Also:
“Get All HDD Module States” on page 243
“Get I/O Unit Module States” on page 269
“Move I/O Unit to Numeric Table” on page 279
“Move Numeric Table to I/O Unit Ex” on page 286
NOTE: Use this command for I/O units with modules that have only four points. For modules with more than four points, use “Move Numeric Table to I/O Unit Ex” on page 286 instead.

Function: To control multiple analog and digital output points on the same I/O unit simultaneously with a single command.

Typical Use: To efficiently control a selected group of analog and digital outputs with one command.

Details:
- This command is much faster than using Turn On, Turn On, or Move for each point.
- Updates the IVALs and XVALs for all 64 points.
- Affects all output points. Does not affect input points.
- The first specified table element corresponds to point zero.
- A digital point is turned off by setting the respective table element to 0. A digital point is turned on by setting the respective table element to non-zero.
- An analog point is set by the value in the respective table element.
- If a specific point is disabled, only its internal value (IVAL) will be written to. If the entire I/O unit is disabled, only the internal values (IVALS) on all 64 points will be written to.
- (PAC firmware R9.4d and higher.) This command does not write to discrete or analog points when either:
  - The float table value is set to a floating point NaN (not a number), or
  - An integer table element is set to 0x7fc00000 (the floating point representation of +NaN).
You can use a NaN to prevent modifications to discrete and analog points. For details, see Notes.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start at Index</td>
<td>Of Table</td>
<td>Move to</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Table</td>
<td>B100*</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Pointer Table</td>
<td>B200*</td>
</tr>
<tr>
<td></td>
<td>Float Table</td>
<td>B3000 (Analog)*</td>
</tr>
<tr>
<td></td>
<td></td>
<td>B3000 (Digital)*</td>
</tr>
<tr>
<td></td>
<td>Integer 32 Table</td>
<td>E1</td>
</tr>
<tr>
<td></td>
<td>Pointer Table</td>
<td>E2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>G4A8R, G4RAX*</td>
</tr>
<tr>
<td></td>
<td></td>
<td>G4D16R*</td>
</tr>
<tr>
<td></td>
<td></td>
<td>G4D32RS*</td>
</tr>
<tr>
<td></td>
<td></td>
<td>G4EB2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>GRV-R7-MM1001-10</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-B3000-ENET, SNAP-ENET-RTC**</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-BRS*</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-ENET-D64**</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-ENET-S64**</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-PAC-EB1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-PAC-EB2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-PAC-R1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-PAC-R16</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-PAC-R2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-PAC-R2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-PAC-SB1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-PAC-SB2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-UP1-ADS**</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-UP1-D64**</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-UP1-M64**</td>
</tr>
</tbody>
</table>
**Example:**

In this example, index 4 of the table will map to point 0 of the I/O unit, index 5 will map to point 1 of the I/O unit, and so on.

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start at Index</td>
<td>Integer 32 Variable</td>
<td>4</td>
</tr>
<tr>
<td>Of Table</td>
<td>Integer 32 Table</td>
<td>IO_STATUS_TABLE</td>
</tr>
<tr>
<td>Move to</td>
<td>GRV-EPIC-PR1</td>
<td>VALVE_CONTROL</td>
</tr>
</tbody>
</table>

**Notes:** To prevent modifications to discrete and analog points, you can create a floating point variable that contains a NaN, and then assign it as a constant to table locations. For example, this OptoScript sample creates `i32Temp`, a 32-bit floating point variable that contains a NaN:

```optoscript
i32Temp = 0x7fc00000;
Move32Bits(i32Temp, f32FloatNan);
```

**Queue Errors:**

-12 = Invalid table index value. Index was negative or greater than or equal to the table size.
-69 = Invalid parameter (null pointer) passed to command. Received if a null table object pointer is passed.

**See Also:** “Move I/O Unit to Numeric Table” on page 279
Move Numeric Table to I/O Unit Ex

I/O Unit Action

NOTE: Use this command for I/O units with modules that have more than four points. For modules with four points, use “Move Numeric Table to I/O Unit” on page 284 instead.

**Function:**
To control multiple analog and digital output points on the same I/O unit simultaneously with a single command.

**Typical Use:**
To efficiently control a selected group of analog and digital outputs with one command.

**Details:**
- Please see “Table Index Offsets” on page 707 for the length of the table required for values of points-per-module.
- This command is much faster than using Turn On, Turn Off, or Move for each point.
- Updates the IVALs and XVALs for specified points. Affects all output points. Does not affect input points.
- The first specified table element corresponds to point zero.
- A digital point is turned off by setting the respective table element to 0. A digital point is turned on by setting the respective table element to non-zero.
- An analog point is set by the value in the respective table element.
- If a specific point is disabled, only its internal value (IVAL) will be written to. If the entire I/O unit is disabled, only the internal values (IVALS) on all specified points will be written to.
- The range of Points per Module (Argument 3) is 1 to 32.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Table</td>
<td>With Starting Index</td>
</tr>
<tr>
<td>Float Table</td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td>Integer 32 Table</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Pointer Table</td>
<td></td>
</tr>
</tbody>
</table>
**CHAPTER 10: I/O UNIT COMMANDS**

**Available only in PAC Control Professional when mistic products are enabled (File > Strategy Options > Legacy tab > Mistic I/O units and commands).**

**Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).**

### Action Block Example:

In this example, index 4 of the table will map to point 0 of the I/O unit, index 5 will map to point 1 of the I/O unit, and so on. For each module on the rack, four points per module are read.

**Move Numeric Table to I/O Unit Ex**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>From Table</strong></td>
<td>Integer 32 Table</td>
<td>IO_STATUS_TABLE</td>
</tr>
<tr>
<td><strong>With Starting Index</strong></td>
<td>Integer 32 Variable</td>
<td>4</td>
</tr>
<tr>
<td><strong>To I/O Unit</strong></td>
<td>SNAP-PAC-R1</td>
<td>VALVE_CONTROL</td>
</tr>
<tr>
<td><strong>Points per Module</strong></td>
<td>Integer 32 Literal</td>
<td>4</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```text
MoveNumTableToIoUnitEx("From Table, With Starting Index, To I/O Unit, Points per Module")
MoveNumTableToIoUnitEx(IO_STATUS_TABLE, 4, VALVE_CONTROL, 4);
```

This is a procedure command; it does not return a value.

**Queue Errors:**

-3 = Invalid Length. Received if a negative value or a value greater than 32 is passed for Points per Module (Argument 3). The MemMap supports a maximum of 32 points per module.

-12 = Invalid table index value. Index was negative or greater than or equal to the table size.

-69 = Invalid parameter (null pointer) passed to command. Received if a null table object pointer is passed.

**See Also:**  
“Move I/O Unit to Numeric Table Ex” on page 281
Set All Target Address States

I/O Unit Action

**Function:**
To control which target addresses in a redundant system should be enabled on all I/O units.

**Typical Use:**
To control which network is used in a redundant system.

**Details:**
- A target address is the IP address of an Ethernet interface on an I/O unit.
- In a redundant network architecture, you can assign two target addresses to an I/O unit. In PAC Control these are called the Primary Address and the Secondary Address. By default, the Primary Address is used, but the server will switch to the Secondary Address if the primary address is not available.
- Each target address has an **enabled** state and an **active** state. If a target address is enabled, it is available to be used. However, only one address can be used at a given time, so there can only be one active address. The active address is the address the controller is currently using. One address is always active. If communication to the active address fails and the control engine is not able to switch to the other address, then communication to the I/O unit will become disabled.
- Use **Must On Mask** (Argument 0) to enable one or both addresses.
- Use **Must Off Mask** (Argument 1) to disable one or both addresses.
- Use **Active Mask** (Argument 2) to make one address active.
- Only the last 2 bits of the 32-bit data field are used. Therefore, for Arguments 0, 1, and 2, you can use the integers 0, 1, 2, and 3 to indicate:
  - 0=No change.
  - 1=Primary Target Address.
  - 2=Secondary Target Address.
  - 3=Primary and Secondary Target Addresses. Not valid for **Active Mask** (Argument 2).

**Arguments:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Must On Mask</td>
<td>Integer 32 Literal</td>
<td>2</td>
</tr>
<tr>
<td>Must Off Mask</td>
<td>Integer 32 Literal</td>
<td>1</td>
</tr>
<tr>
<td>Active Mask</td>
<td>Integer 32 Literal</td>
<td>2</td>
</tr>
</tbody>
</table>

**Action Block Example:**
This example assumes that there are redundant networks. It enables the secondary network, disables the primary network, and makes the secondary network active.

**OptoScript Example:**

```
SetAllTargetAddressStates(Must On Mask, Must Off Mask, Active Mask)
SetAllTargetAddressStates(2, 1, 2);
```

This is a procedure command; it does not return a value.

**Notes:**
- See “I/O Unit Commands” in the PAC Control User’s Guide (form 1700).
- Together, **Must On Mask** (Argument 0) and **Must Off Mask** (Argument 1) comprise the enable mask. You can use the enable mask in the following combinations:

| Enable both addresses | 3 | 0 |
Enable Primary  | 1 | 0  
Enable Secondary | 2 | 0  
Enable only Primary | 1 | 2  
Enable only Secondary | 2 | 1  
Disable Primary | 0 | 1  
Disable Secondary | 0 | 2  
Disable both addresses | 0 | 3  

- Argument 2 makes one address active or both addresses inactive as follows:

<table>
<thead>
<tr>
<th>Activate Primary</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activate Secondary</td>
<td>2</td>
</tr>
</tbody>
</table>

- A fully redundant system may also include PAC Display clients and OptoOPC Servers. These commands only deal with the control engine communicating with I/O units. PAC Display and OptoOPC Server have their own mechanism for controlling their use of the network.

See Also:  
“Set Target Address State” on page 294  
“Get Target Address State” on page 271
CHAPTER 10: I/O UNIT COMMANDS

Set I/O Unit Configured Flag

I/O Unit Action

Function: Sets an internal flag to indicate that the I/O unit has been initialized by the controller.

Typical Use: Where there is a standby controller configured to take over communication to the I/O units in the event of a primary controller failure.

Details:
- This command should be issued for each I/O unit, preferably in the Powerup chart. Use it in both the primary and standby controller programs to keep them the same.
- By default, the controller assumes it is the only controller attached to the I/O and therefore must configure each I/O unit. This command makes the standby controller think it has already configured all the I/O units, which allows it to begin communicating with the I/O units immediately and without disrupting any control being performed by the I/O units (assuming it has just taken over as the primary). This command has no effect in a controller that has already established communication with the I/O units.

Arguments:

<table>
<thead>
<tr>
<th>Argument</th>
<th>For I/O Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>B100*</td>
<td></td>
</tr>
<tr>
<td>B200*</td>
<td></td>
</tr>
<tr>
<td>B3000 (Analog)*</td>
<td></td>
</tr>
<tr>
<td>B3000 (Digital)*</td>
<td></td>
</tr>
<tr>
<td>E1</td>
<td></td>
</tr>
<tr>
<td>E2</td>
<td></td>
</tr>
<tr>
<td>G4A8R, G4RAX*</td>
<td></td>
</tr>
<tr>
<td>G4D16R*</td>
<td></td>
</tr>
<tr>
<td>G4D32RS*</td>
<td></td>
</tr>
<tr>
<td>G4EB2</td>
<td></td>
</tr>
<tr>
<td>GRV-EPIC-PR1</td>
<td></td>
</tr>
<tr>
<td>GRV-R7-MM1001-10</td>
<td></td>
</tr>
<tr>
<td>SNAP-B3000-ENET, SNAP-ENET-RTC**</td>
<td></td>
</tr>
<tr>
<td>SNAP-BRS*</td>
<td></td>
</tr>
<tr>
<td>SNAP-ENET-D64**</td>
<td></td>
</tr>
<tr>
<td>SNAP-ENET-S64**</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB1</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB2</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R2</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-S1</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB2</td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-ADS**</td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-D64**</td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-M64**</td>
<td></td>
</tr>
</tbody>
</table>

* Available only in PAC Control Professional when mistic products are enabled (File > Strategy Options > Legacy tab > Mistic I/O units and commands).

** Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).

Action Block Example:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>For I/O Unit</td>
<td>SNAP-PAC-EB2</td>
<td>FURNACE_PID</td>
</tr>
</tbody>
</table>
OptoScript Example:  
SetIoUnitConfiguredFlag(For I/O Unit)
SetIOUnitConfiguredFlag(FURNACE_PID);
This is a procedure command; it does not return a value.
Set I/O Unit from MOMO Masks

I/O Unit Action

**Function:**  
To control multiple 4-channel digital output points on the same digital I/O unit simultaneously with a single command.

**Typical Use:**  
To efficiently control a selected group of 4-channel digital outputs with one command.

**Details:**
- Updates the IVAls and XValS for all selected output points. Does not affect input points. Does not affect analog or high-density digital points in any position on the rack.
- To turn on a point, set the respective bit in the 32-bit data field of Must On Mask (Argument 0) to a value of 1.
- To turn off a point, set the respective bit in the 32-bit data field of Must Off Mask (Argument 1) to a value of 1.
- To leave a point unaffected, set its bits to a value of 0 in both Must On Mask and Must Off Mask. Check for conflicts; if the same bit is set to 1 in both masks, the point is turned off.
- If a specific point is disabled or if the entire I/O unit is disabled, only the internal values (IVAls) will be written.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Must On Mask</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td>Name</td>
<td>Must On Mask</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Argument 1</th>
<th>Must Off Mask</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td>Name</td>
<td>Must Off Mask</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Argument 2</th>
<th>I/O Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Integer 64 Literal</td>
</tr>
<tr>
<td>Name</td>
<td>I/O Unit</td>
</tr>
</tbody>
</table>

**Action Block Example:**

<table>
<thead>
<tr>
<th>Set I/O Unit from MOMO Masks</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Must On Mask</td>
<td>Integer 64 Literal</td>
<td>0x060003C0000000C2</td>
</tr>
<tr>
<td>Must Off Mask</td>
<td>Integer 64 Literal</td>
<td>0x80F24010308A020</td>
</tr>
<tr>
<td>I/O Unit</td>
<td>SNAP-PAC-R1</td>
<td>PUMP_CTRL_UNIT</td>
</tr>
</tbody>
</table>

* Available only in PAC Control Professional when mystic products are enabled (File > Strategy Options > Legacy tab > Mistic I/O units and commands).
** Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).
The effect of this command is illustrated below. (To save space, the example shows only the first eight points and the last eight points on the rack. For the points shown, points 58, 57, 7, 6, and 1 will be turned on. Points 63, 61, 60, and 5 will be turned off. Other points shown are not changed.)

<table>
<thead>
<tr>
<th>Point Number</th>
<th>63</th>
<th>62</th>
<th>61</th>
<th>60</th>
<th>59</th>
<th>58</th>
<th>57</th>
<th>56</th>
<th>7</th>
<th>6</th>
<th>5</th>
<th>4</th>
<th>3</th>
<th>2</th>
<th>1</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Must-on</strong></td>
<td>Binary</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>Hex</td>
<td>0</td>
<td>6</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td><strong>Must-off</strong></td>
<td>Binary</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>Hex</td>
<td>B</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```opto
SetIoUnitFromMomo(Must On Mask, Must Off Mask, I/O Unit)
```

```opto
SetIoUnitFromMomo(0x060003C000000C2i64, 0xB0F240010308A020i64, PUMP_CTRL_UNIT);
```

This is a procedure command; it does not return a value.

**Notes:**
- The I/O unit must be a digital I/O unit.
- Use Bit Set or Bit Clear to change individual bits in an integer variable.
## Set Target Address State

**I/O Unit Action**

**Function:** To control which target addresses in a redundant system should be enabled on an I/O unit.

**Typical Use:** To control which network is used for a specific I/O unit in a redundant system.

**Details:**
- A target address is the IP address of an Ethernet interface on an I/O unit.
- In a redundant network architecture, you can assign two target addresses to an I/O unit. In PAC Control these are called the Primary Address and the Secondary Address.
  - An enabled address is one that has been configured to be used. An active address is the address the controller is currently using. Only one address can be active at a given time.
  - By default, the controller uses the Primary Address. If the Primary Address is unavailable and the Secondary Address has been enabled, the controller will switch communication to the Secondary Address. At that point, the Secondary Address becomes the active address.
  - If communication to the active address fails and the control engine is not able to switch to the other address, then communication to the I/O unit will become disabled.
- Use **Must On Mask** (Argument 0) to enable one or both addresses.
- Use **Must Off Mask** (Argument 1) to disable one or both addresses.
- Use **Active Mask** (Argument 2) to make one address active.
- Use **I/O Unit** (Argument 3) to designate the I/O unit type.
- Only the last two bits of the 32-bit data field are used. Therefore, for Arguments 0, 1, and 2 you can use the integers 0, 1, 2, and 3 to indicate:
  - 0 = No change.
  - 1 = Primary Target Address.
  - 2 = Secondary Target Address.
  - 3 = Primary and Secondary Target Addresses. Not valid for **Active Mask** (Argument 2).

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Must On Mask</td>
<td>Must Off Mask</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Argument 2</th>
<th>Argument 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active Mask</td>
<td>I/O Unit</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Generic OptoMMP Device</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>GRV-EPIC-PR1</td>
</tr>
<tr>
<td></td>
<td>GRV-R7-MM1001-10</td>
</tr>
<tr>
<td></td>
<td>SNAP-B3000-ENET, SNAP-ENET-RTC*</td>
</tr>
<tr>
<td></td>
<td>SNAP-ENET-D64*</td>
</tr>
<tr>
<td></td>
<td>SNAP-ENET-S64*</td>
</tr>
<tr>
<td></td>
<td>SNAP-PAC-EB1</td>
</tr>
<tr>
<td></td>
<td>SNAP-PAC-EB2</td>
</tr>
<tr>
<td></td>
<td>SNAP-PAC-R1</td>
</tr>
<tr>
<td></td>
<td>SNAP-PAC-R1-B</td>
</tr>
<tr>
<td></td>
<td>SNAP-PAC-R2</td>
</tr>
<tr>
<td></td>
<td>SNAP-UP1-ADS*</td>
</tr>
<tr>
<td></td>
<td>SNAP-UP1-D64*</td>
</tr>
<tr>
<td></td>
<td>SNAP-UP1-M64*</td>
</tr>
</tbody>
</table>

*A available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).*
CHAPTER 10: I/O UNIT COMMANDS

**Action Block Example:** This example assumes that there are redundant networks. It enables the secondary address, disables the primary address, and makes the secondary address active.

**OptoScript Example:**

```
SetTargetAddressState(Must On Mask, Must Off Mask, Active Mask, I/O Unit);
```

This is a procedure command; it does not return a value.

**Notes:**
- See “I/O Unit Commands” in the PAC Control User’s Guide (form 1700).
- `Must On Mask` (Argument 0) and `Must Off Mask` (Argument 1) together comprise the enable mask. You can use the enable mask in the following combinations:

| Enable both addresses | 3 | 0 |
| Enable Primary | 1 | 0 |
| Enable Secondary | 2 | 0 |
| Enable only Primary | 1 | 2 |
| Enable only Secondary | 2 | 1 |
| Disable Primary | 0 | 1 |
| Disable Secondary | 0 | 2 |
| Disable both addresses | 0 | 3 |

- Argument 2 makes one address active or both addresses inactive as follows:

| Activate Primary | 1 |
| Activate Secondary | 2 |

- A fully redundant system may also include PAC Display clients and OptoOPCServers. These commands only deal with the control engine communicating with I/O units. PAC Display and OptoOPCServer have their own mechanism for controlling their use of the network.
- This command does not test communication.

**See Also:**
- “Set All Target Address States” on page 288
- “Get Target Address State” on page 271
CHAPTER 10: I/O UNIT COMMANDS

Write I/O Unit Configuration to EEPROM

I/O Unit Action

**Function:** Stores all point features, watchdog settings, and other configurations to flash memory (EEPROM) at the I/O unit.

**Typical Use:** Allows the I/O unit to be fully functional at powerup. No further configuration by a control engine is needed.

**Details:**
- Instead of using this command in the strategy, it is better to store configurations to flash by using PAC Manager (see the *PAC Manager User’s Guide* (form 1704) for instructions) or by using PAC Control in Debug mode (see the *PAC Control User’s Guide*, (form 1700) for instructions).
- This command takes about two seconds to complete and causes the connection to the I/O unit to be closed. If this command is used in the strategy, it should be placed where it will execute just once each time the program runs—typically in the Powerup chart after all special configuration commands are sent to the I/O unit. After a delay, use Enable Communication to I/O Unit to open the connection again.

**CAUTION:** If you use this command in a strategy, make certain it is not in a loop. You can literally wear out the hardware if you write to flash too many times.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0 On I/O Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>B100*</td>
</tr>
<tr>
<td>B200*</td>
</tr>
<tr>
<td>B3000 (Analog)*</td>
</tr>
<tr>
<td>B3000 (Digital)*</td>
</tr>
<tr>
<td>E1</td>
</tr>
<tr>
<td>E2</td>
</tr>
<tr>
<td>G4A8R, G4RAX*</td>
</tr>
<tr>
<td>G4D16R*</td>
</tr>
<tr>
<td>G4D32RS*</td>
</tr>
<tr>
<td>G4EB2</td>
</tr>
<tr>
<td>GRV-EPIC-PR1</td>
</tr>
<tr>
<td>GRV-R7-MM1001-10</td>
</tr>
<tr>
<td>SNAP-B3000-ENET, SNAP-ENET-RTC**</td>
</tr>
<tr>
<td>SNAP-BRS*</td>
</tr>
<tr>
<td>SNAP-ENET-D64**</td>
</tr>
<tr>
<td>SNAP-ENET-S64**</td>
</tr>
<tr>
<td>SNAP-PAC-EB1</td>
</tr>
<tr>
<td>SNAP-PAC-EB2</td>
</tr>
<tr>
<td>SNAP-PAC-R1</td>
</tr>
<tr>
<td>SNAP-PAC-R1-B</td>
</tr>
<tr>
<td>SNAP-PAC-R2</td>
</tr>
<tr>
<td>SNAP-PAC-SB1</td>
</tr>
<tr>
<td>SNAP-PAC-SB2</td>
</tr>
<tr>
<td>SNAP-UP1-ADS**</td>
</tr>
<tr>
<td>SNAP-UP1-D64**</td>
</tr>
<tr>
<td>SNAP-UP1-M64**</td>
</tr>
</tbody>
</table>

* Available only in PAC Control Professional when mistic products are enabled (File > Strategy Options > Legacy tab > Mistic I/O units and commands).

** Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).
**OptoScript Example:**

```opto
WriteIoUnitConfigToEeprom(FURNACE_CONTROL);
```

This is a procedure command; it does not return a value.

**Queue Errors:**

- `-52 = Invalid connection—not opened. The connection may have been closed by a previous command that failed. Check status codes returned on other connection commands.`
- `-534 = Attempts to communicate with I/O unit failed. Make sure I/O unit is turned on.`
11: I/O Unit - Event Message Commands

Get I/O Unit Event Message State

I/O Unit—Event Message Action

Function: To determine the current state of an event message on a SNAP PAC I/O unit.

Typical Use: To find out whether an e-mail, SNMP, or other kind of event message has been sent.

Details: Possible states are: 0 = Inactive, 1 = Active, or 2 = Acknowledged.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Unit</td>
<td>Event Message #</td>
</tr>
<tr>
<td>G4EB2</td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td>Generic OptoMMP Device</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>GRV-EPIC-PR1</td>
<td></td>
</tr>
<tr>
<td>GRV-R7-MM1001-10</td>
<td></td>
</tr>
<tr>
<td>SNAP-B3000-ENET, SNAP-ENET-RTC*</td>
<td></td>
</tr>
<tr>
<td>SNAP-ENET-D64*</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB1</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB2</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1-B</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R2</td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-ADS*</td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-D64*</td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-M64*</td>
<td></td>
</tr>
</tbody>
</table>

* Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).

<table>
<thead>
<tr>
<th>Argument 2</th>
<th>Argument 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Put Result in</td>
<td>Put Status in</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

Action Block Example:

<table>
<thead>
<tr>
<th>Get I/O Unit Event Message State</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argument Name</td>
</tr>
<tr>
<td>----------------</td>
</tr>
<tr>
<td>I/O Unit</td>
</tr>
<tr>
<td>Event Message #</td>
</tr>
<tr>
<td>Put Result in</td>
</tr>
<tr>
<td>Put Status in</td>
</tr>
</tbody>
</table>
**OptoScript Example:**  
`GetIoUnitEventMsgState(I/O Unit, Event Message #, Put Result in)`  
`Status = GetIoUnitEventMsgState(PAC_A, 0, State);`

This is a function command; it returns one of the status codes listed below.

**Notes:**
- Use PAC Manager to configure the types, intervals, and text of event messages. You can configure up to 128 messages for each I/O unit.
- To find out the text of the message, use Get I/O Unit Event Message Text.
- To send the message, use Set I/O Unit Event Message State.

**Status Codes:**
- 0 = success
- -43 = Received a NACK from the I/O unit.
- -52 = Invalid connection—not opened. The connection may have been closed by a previous command that failed. Check status codes returned on other connection commands.
- -93 = I/O unit not enabled. Previous communication failure may have disabled communication to the unit automatically. Reenable communication to the unit and try again.

**See Also:**
- “Get I/O Unit Event Message Text” on page 301
- “Set I/O Unit Event Message State” on page 303
- “Set I/O Unit Event Message Text” on page 305
Get I/O Unit Event Message Text

I/O Unit—Event Message Action

**Function:** To read the text of an event message on a SNAP PAC I/O unit.

**Typical Use:** To read the text of an e-mail, SNMP, or other kind of message sent as a response to an event that occurs within strategy logic.

**Details:** The message text is returned in Put Result in (Argument 2). The string variable for Put Result in should be 128 characters long to hold the message text.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Unit</td>
<td></td>
<td>G4EB2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Generic OptoMMP Device</td>
</tr>
<tr>
<td></td>
<td></td>
<td>GRV-EPIC-PR1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>GRV-R7-MM1001-10</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-B3000-ENET, SNAP-ENET-RTC*</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-ENET-D64*</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-PAC-EB1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-PAC-EB2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-PAC-R1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-PAC-R1-B</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-PAC-R2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-UP1-ADS*</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-UP1-D64*</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-UP1-M64*</td>
</tr>
</tbody>
</table>

* Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event Message #</td>
<td>Integer 32 Literal</td>
<td>0</td>
</tr>
<tr>
<td>Put Result in</td>
<td>String Variable</td>
<td>Msg_0</td>
</tr>
<tr>
<td>Put Status in</td>
<td>Integer 32 Variable</td>
<td>Status</td>
</tr>
</tbody>
</table>

**Action Block Example:**

Get I/O Unit Event Message Text

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Unit</td>
<td></td>
<td>G4EB2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Generic OptoMMP Device</td>
</tr>
<tr>
<td></td>
<td></td>
<td>GRV-EPIC-PR1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>GRV-R7-MM1001-10</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-B3000-ENET, SNAP-ENET-RTC*</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-ENET-D64*</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-PAC-EB1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-PAC-EB2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-PAC-R1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-PAC-R1-B</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-PAC-R2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-UP1-ADS*</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-UP1-D64*</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-UP1-M64*</td>
</tr>
</tbody>
</table>

OptoScript Example:

```pascal
GetIoUnitEventMsgText(I/O Unit, Event Message #, Put Result in)
```

Status = GetIoUnitEventMsgText(PAC_A, 0, Msg_0);

This is a function command; it returns one of the status codes listed below.

**Notes:**

- Use PAC Manager to configure the types, intervals, and text of event messages. You can configure up to 128 messages for each I/O unit.
- If the variable in Put Result in (Argument 2) is shorter than 128 characters, as many characters as fit are placed in it and an error -23 is returned.

**Status Codes:**

0 = success
-12 = Invalid index. Event message number is less than 0 or greater than 127.

-23 = String too short. String variable in Put Result in (Argument 2) must be 128 characters long.

-43 = Received a NACK from the I/O unit.

-52 = Invalid connection—not opened. The connection may have been closed by a previous command that failed. Check status codes returned on other connection commands.

-93 = I/O unit not enabled. Previous communication failure may have disabled communication to the unit automatically. Reenable communication to the unit and try again.

See Also:
- “Get I/O Unit Event Message State” on page 299
- “Set I/O Unit Event Message State” on page 303
- “Set I/O Unit Event Message Text” on page 305
Set I/O Unit Event Message State

I/O Unit—Event Message Action

Function: To activate or deactivate a SNAP PAC I/O unit event message, or to acknowledge an SNMP message.

Typical Use: To send an email, SNMP, or other kind of event message.

Details:
- Use PAC Manager to configure the types, intervals, and text of event messages. You can configure up to 128 messages for each I/O unit.
- To start sending the message as it is configured, set the state to 1 = Active.
- SNMP messages must be acknowledged in order to inactivate them. To do so, set the state to 2 = Acknowledged.
- To stop sending the message or return it to a non-triggered state, set it to 0 = Inactive. A delay is not needed between activating and inactivating the message, as the commands are put into a queue and processed in order.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
<th>Argument 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Unit</td>
<td>Event Message #</td>
<td>State</td>
<td>Put Status in</td>
</tr>
<tr>
<td>G4EB2</td>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Generic OptoMMP Device</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GRV-EPIC-PR1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GRV-R7-MM1001-10</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-B3000-ENET, SNAP-ENET-RTC*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-ENET-D64*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1-B</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-ADS*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-D64*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-M64*</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).

Action Block Example:

<table>
<thead>
<tr>
<th>Set I/O Unit Event Message State</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argument Name</td>
</tr>
<tr>
<td>I/O Unit</td>
</tr>
<tr>
<td>Event Message #</td>
</tr>
<tr>
<td>State</td>
</tr>
<tr>
<td>Put Status in</td>
</tr>
</tbody>
</table>

OptoScript Example:

```optoscript
SetIoUnitEventMsgState(I/O Unit, Event Message #, State)
Status = SetIoUnitEventMsgState(PAC_A, 5, 1);
```

This is a function command; it returns one of the status codes listed below.

Notes:
• Use Get I/O Unit Event Message State to check the current state of the message, for example, to see if the message is already active before activating it.
• If you are using one event message for several situations, use Set I/O Unit Event Message Text to change the text of the message being sent.

Status Codes:

0 = success
-43 = Received a NACK from the I/O unit.
-52 = Invalid connection—not opened. The connection may have been closed by a previous command that failed. Check status codes returned on other connection commands.
-93 = I/O unit not enabled. Previous communication failure may have disabled communication to the unit automatically. Reenable communication to the unit and try again.

See Also:
“Set I/O Unit Event Message Text” on page 305
“Get I/O Unit Event Message State” on page 299
“Get I/O Unit Event Message Text” on page 301
Set I/O Unit Event Message Text

I/O Unit—Event Message Action

**Function:**
To change the text of an event message on a SNAP PAC I/O unit.

**Typical Use:**
To "recycle" a message if all 128 messages on an I/O unit are already used, to create dynamic message content.

**Details:**
- Use PAC Manager to configure the types, intervals, and text of event messages. You can configure up to 128 messages for each I/O unit.
- Use caution with this command. Change text only when necessary, and use Get I/O Unit Event Message State to check the state of the message before changing it.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>I/O Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>G4EB2</td>
</tr>
<tr>
<td></td>
<td>Generic OptoMMP Device</td>
</tr>
<tr>
<td></td>
<td>GRV-EPIC-PR1</td>
</tr>
<tr>
<td></td>
<td>GRV-R7-MM1001-10</td>
</tr>
<tr>
<td></td>
<td>SNAP-B3000-ENET, SNAP-ENET-RTC*</td>
</tr>
<tr>
<td></td>
<td>SNAP-ENET-D64*</td>
</tr>
<tr>
<td></td>
<td>SNAP-PAC-EB1</td>
</tr>
<tr>
<td></td>
<td>SNAP-PAC-EB2</td>
</tr>
<tr>
<td></td>
<td>SNAP-PAC-R1</td>
</tr>
<tr>
<td></td>
<td>SNAP-PAC-R1-B</td>
</tr>
<tr>
<td></td>
<td>SNAP-PAC-R2</td>
</tr>
<tr>
<td></td>
<td>SNAP-UP1-ADS*</td>
</tr>
<tr>
<td></td>
<td>SNAP-UP1-D64*</td>
</tr>
<tr>
<td></td>
<td>SNAP-UP1-M64*</td>
</tr>
<tr>
<td>* Available only when Legacy products are enabled (File &gt; Strategy Options &gt; Legacy tab &gt; Ethernet, Ultimate, and Simple I/O units).</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Argument 1</th>
<th>Event Message #</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td></td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Argument 2</th>
<th>Message Text</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>String Literal</td>
</tr>
<tr>
<td></td>
<td>String Variable</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Argument 3</th>
<th>Put Status in</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

**Action Block Example:**
Set I/O Unit Event Message Text

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Unit</td>
<td>SNAP-PAC-R1</td>
<td>PAC_A</td>
</tr>
<tr>
<td>Event Message #</td>
<td>Integer 32 Literal</td>
<td>5</td>
</tr>
<tr>
<td>Message Text</td>
<td>String Literal</td>
<td>Machine failure</td>
</tr>
<tr>
<td>Put Status in</td>
<td>Integer 32 Variable</td>
<td>STATUS</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```optoscript
SetIoUnitEventMsgText(I/O Unit, Event Message #, Message Text)
STATUS = SetIoUnitEventMsgText(PAC_A, 5, "Machine failure");
```

This is a function command; it returns one of the status codes listed below. Note that quotes must be used for strings in OptoScript.

**Notes:**
- This command should be used when all 128 messages are already in use. If you need to use the same message with different text, it is best to double up on messages that are mutually exclusive, for example, "Tank level too high" and "Tank level too low".
This command can also be used to create dynamic message content, for example to send a message reporting a changing pressure level.

Before using this command, check the current state of the message using Get I/O Unit Event Message State, to avoid sending the wrong message.

Message text is limited to 127 characters. If it is longer than 127 characters, the first 127 characters are sent and an error -23 is returned.

**Status Codes:**

0 = success

-12 = Invalid index. Event message number is less than 0 or greater than 127.

-23 = Destination string too short. Message text is longer than 127 characters. The first 127 characters are sent.

-43 = Received a NACK from the I/O unit.

-52 = Invalid connection—-not opened. The connection may have been closed by a previous command that failed. Check status codes returned on other connection commands.

-93 = I/O unit not enabled. Previous communication failure may have disabled communication to the unit automatically. Reenable communication to the unit and try again.

**See Also:**

“Set I/O Unit Event Message State” on page 303
“Get I/O Unit Event Message State” on page 299
“Get I/O Unit Event Message Text” on page 301
12: I/O Unit - Memory Map Commands

Read Number from I/O Unit Memory Map

I/O Unit—Memory Map Action

**Function:** Read a value from a SNAP PAC I/O memory map and store that value in an integer or float variable.

**Typical Use:** To access areas of the memory map not directly supported by PAC Control.

**Details:**
- To use this command with a SNAP PAC S-series or SoftPAC controller, create an I/O Unit of the type Generic OptoMMP Device with the loopback address (127.0.0.1).
- This command works with GRV-EPIC processors, SNAP PAC I/O units that have been configured in PAC Control or PAC Manager. The control engine must be on the I/O unit or connected to another I/O unit for this command to work.
- If you are reading the Scratch Pad area of the memory map, use 13: I/O Unit - Scratch Pad Commands instead (Get I/O Unit Scratch Pad Float Element and related commands).
- **Mem address** (Argument 1) includes only the last eight digits of the memory map address (the lower 32 bits).

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>I/O Unit</strong></td>
<td><strong>Mem address</strong></td>
</tr>
<tr>
<td>E1</td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td>E2</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>G4EB2</td>
<td></td>
</tr>
</tbody>
</table>
* Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).

**Action Block Example:**

**OptoScript Example:**

```
ReadNumFromIoUnitMemMap(I/O Unit, Mem address, Put Result in)
STATUS = ReadNumFromIoUnitMemMap(MYIOUNIT, 0xFFFFFFFF, MYINTVAR);
```

**Notes:**
- In Action blocks, use hex integer display for easy entering of memory map addresses.
- The control engine does not convert the variable type to match the area of memory map being read. The control engine has no knowledge of which memory map areas are integers and which are floats. You must write the correct type of data to the specified memory map address.
  - For example, unpredictable results would occur if you try to read an integer 32 variable from the analog point area of the memory map. A float variable should be used instead. See the OptoMMP Protocol Guide (form 1465) to determine the data types for specific areas of the memory map.
- If `Put Result in` (Argument 2) is an Integer 64 variable, 64 bits of data will be read. For example, if you read the address 0xF0300020 (the first integer for unit type in the Status Read area), you will also receive the I/O unit hardware revision (month), which starts at 0xF0300024.

**Status Codes:**

- 0 = success
- -43 = Received a NACK from the I/O unit.
- -52 = Invalid connection—not opened. The connection may have been closed by a previous command that failed. Check status codes returned on other connection commands.
- -56 = Invalid memory map address.
- -69 = Invalid parameter (null pointer) passed to command.
- -58 = No data received. Make sure I/O unit has power.
- -81 = Error writing to memory map. Invalid memory map address.
- -93 = I/O unit not enabled. Previous communication failure may have disabled communication to the unit automatically. Reenable communication to the unit and try again.

**See Also:**

- "Read Numeric Table from I/O Unit Memory Map" on page 309
- "Write Numeric Table to I/O Unit Memory Map" on page 318
- "Write Number to I/O Unit Memory Map" on page 316
- "Get I/O Unit Scratch Pad Integer 32 Element" on page 331
- "Get I/O Unit Scratch Pad Integer 32 Table" on page 333
- "Get I/O Unit Scratch Pad Float Element" on page 327
- "Get I/O Unit Scratch Pad Float Table" on page 329
Read Numeric Table from I/O Unit Memory Map

I/O Unit—Memory Map Action

**Function:**
Read a range of values from a SNAP PAC I/O memory map and store them into an integer 32 or float table.

**Typical Use:**
To access areas of the memory map not directly supported by PAC Control.

**Details:**
- To use this command with a SNAP PAC S-series or SoftPAC controller, create an I/O Unit of the type Generic OptoMMP Device with the loopback address (127.0.0.1).
- This command works with SNAP PAC I/O units that have been configured in PAC Control or PAC Manager. The control engine must be on the I/O unit or connected to another I/O unit for this command to work.
- If you are reading the Scratch Pad area of the memory map, use 13: I/O Unit - Scratch Pad Commands instead (Get I/O Unit Scratch Pad Integer 32 Table and related commands).
- **Length** (Argument 0) is the length of data in the memory map in quads (groups of four bytes) and also the number of table elements. Maximum length is 300.
- **Mem address** (Argument 3) includes only the last eight digits of the memory map address (the lower 32 bits).

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length</td>
<td>Start Index</td>
<td>I/O Unit</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
<td>E1</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
<td>E2</td>
</tr>
<tr>
<td>Generic OptoMMP Device</td>
<td>Generic OptoMMP Device</td>
<td>G4EB2</td>
</tr>
<tr>
<td>GRV-EPIC-PR1</td>
<td>GRV-EPIC-PR1</td>
<td>SNAP-B3000-ENET, SNAP-ENET-RTC*</td>
</tr>
<tr>
<td>GRV-R7-MM1001-10</td>
<td>GRV-R7-MM1001-10</td>
<td>SNAP-ENET-D64*</td>
</tr>
<tr>
<td>SNAP-ENET-564*</td>
<td>SNAP-ENET-564*</td>
<td>SNAP-PAC-EB1</td>
</tr>
<tr>
<td>SNAP-PAC-EB2</td>
<td>SNAP-PAC-EB2</td>
<td>SNAP-PAC-R1</td>
</tr>
<tr>
<td>SNAP-PAC-R1-B</td>
<td>SNAP-PAC-R1-B</td>
<td>SNAP-PAC-R2</td>
</tr>
<tr>
<td>SNAP-PAC-SB1</td>
<td>SNAP-PAC-SB1</td>
<td>SNAP-PAC-SB2</td>
</tr>
<tr>
<td>SNAP-PAC-SB2</td>
<td>SNAP-PAC-SB2</td>
<td>SNAP-UP1-ADS*</td>
</tr>
<tr>
<td>SNAP-UP1-D64*</td>
<td>SNAP-UP1-D64*</td>
<td>SNAP-UP1-M64*</td>
</tr>
</tbody>
</table>

* Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).

<table>
<thead>
<tr>
<th>Argument 3</th>
<th>Argument 4</th>
<th>Argument 5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mem address</td>
<td>Put Result in</td>
<td>Put Status in</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Float Table</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Table</td>
<td></td>
</tr>
</tbody>
</table>
### Read Numeric Table from I/O Unit Memory Map

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length</td>
<td>Integer 32 Literal</td>
<td>0x10</td>
</tr>
<tr>
<td>Start Index</td>
<td>Integer 32 Literal</td>
<td>0x5</td>
</tr>
<tr>
<td>I/O Unit</td>
<td>SNAP-PAC-EB1</td>
<td>MYIOUNIT</td>
</tr>
<tr>
<td>Mem address</td>
<td>Integer 32 Literal</td>
<td>0xFFFFFFFF</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Integer 32 Table</td>
<td>MYINTTABLE</td>
</tr>
</tbody>
</table>

**Example:**

```plaintext
STATUS = ReadNumTableFromIoUnitMemMap(0x10, 0x5, MYIOUNIT, 0xFFFFFFFF, MYINTTABLE);
```

This is a function command; it returns a status code as listed below.

Using this command in OptoScript code, you can use hex in some arguments and a different format in others. For example:

```plaintext
STATUS = ReadNumTableFromIoUnitMemMap(16, 5, MYIOUNIT, 0xFFFFFFFF, MYINTTABLE);
```

**Notes:**

- In Action blocks, use hex integer display for easy entering of memory map addresses. When you display integers in hex, note that Length (Argument 0) and Start Index (Argument 1) are also in hex.
- The control engine does not convert the table type to match the area of the memory map being read. The control engine has no knowledge of which memory map areas are integers and which are floats. You must write the correct type of data to the specified memory map address. For example, unpredictable results would occur if you try to read an integer 32 variable from the analog point area of the memory map. A float variable should be used instead. See the OptoMMP Protocol Guide (form 1465) to determine the data types for specific areas of the memory map.

**Status Codes:**

- **0** = success
- **-3** = Buffer overrun or invalid length error. A value > 300 was passed for the Length.
- **-12** = Invalid table index value. Index was negative or greater than the table size.
- **-43** = Received a NACK from the I/O unit.
- **-52** = Invalid connection—not opened. The connection may have been closed by a previous command that failed. Check status codes returned on other connection commands.
- **-56** = Invalid memory map address.
- **-69** = Invalid parameter (null pointer) passed to command.
- **-81** = Error writing to memory map. Invalid memory map address.
- **-93** = I/O unit not enabled. Previous communication failure may have disabled communication to the unit automatically. Reenable communication to the unit and try again.

**See Also:**

- "Read Number from I/O Unit Memory Map" on page 307
- "Write Numeric Table to I/O Unit Memory Map" on page 318
- "Write Number to I/O Unit Memory Map" on page 316
- "Get I/O Unit Scratch Pad Integer 32 Table" on page 333
- "Get I/O Unit Scratch Pad Float Table" on page 329
**Read String from I/O Unit Memory Map**

**I/O Unit—Memory Map Action**

**Function:** Read a string from a SNAP PAC I/O memory map and store that value in a string variable.

**Typical Use:** To access areas of the memory map not directly supported by PAC Control.

**Details:**
- To use this command with a SNAP PAC S-series or SoftPAC controller, create an I/O Unit of the type Generic OptoMMP Device with the loopback address (127.0.0.1).
- This command works with SNAP PAC I/O units that have been configured in PAC Control or PAC Manager. The control engine must be on the I/O unit or connected to another I/O unit for this command to work.
- If you are reading the Scratch Pad area of the memory map, use 13: I/O Unit - Scratch Pad Commands instead (Get I/O Unit Scratch Pad String Element and related commands).
- `Mem address` (Argument 2) includes only the last eight digits of the memory map address (the lower 32 bits).

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
<th>Argument 3</th>
<th>Argument 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length</td>
<td>I/O Unit</td>
<td>Mem address</td>
<td>Put Result in</td>
<td>Put Status in</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>E1</td>
<td>Integer 32 Literal</td>
<td>String Variable</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>G4EB2</td>
<td>Integer 32 Literal</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Generic OptoMMP Device</td>
<td>Integer 32 Literal</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>GRV-EPIC-PR1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>GRV-R7-MM1001-10</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>SNAP-B3000-ENET, SNAP-ENET-RTC*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>SNAP-ENET-D64*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>SNAP-ENET-S64*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>SNAP-PAC-EB1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>SNAP-PAC-EB2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>SNAP-PAC-R1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>SNAP-PAC-R1-B</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>SNAP-PAC-R2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>SNAP-PAC-SB1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>SNAP-PAC-SB2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>SNAP-UP1-ADS*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>SNAP-UP1-D64*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>SNAP-UP1-M64*</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).

**Action Block Example:**

```
Read String from I/O Unit Memory Map

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length</td>
<td>Integer 32 Literal</td>
<td>20</td>
</tr>
<tr>
<td>I/O Unit</td>
<td>SNAP-PAC-EB1</td>
<td>MYIOUNIT</td>
</tr>
<tr>
<td>Mem address</td>
<td>Integer 32 Literal</td>
<td>OxFFFFFFFF</td>
</tr>
<tr>
<td>Put Result in</td>
<td>String Variable</td>
<td>MYSTRINGVAR</td>
</tr>
<tr>
<td>Put Status In</td>
<td>Integer 32 Variable</td>
<td>STATUS</td>
</tr>
</tbody>
</table>
```
OptoScript Example: \texttt{ReadStrFromIoUnitMemMap(Length, I/O Unit, Mem address, Put Result in)}

\begin{verbatim}
STATUS = ReadStrFromIoUnitMemMap(20, MYIOUNIT, 0xFFFFFFFF, MYSTRINGVAR);
\end{verbatim}

This is a function command; it returns a status code as listed below.

Notes:
- In Action blocks, use hex integer display for easy entering of memory map addresses.
- The control engine does not convert the variable type to match the area of memory map being read. The control engine doesn't know which memory map areas are strings and which are other formats. You must read the correct type of data from the specified memory map address.
- For example, unpredictable results would occur if you try to read a string variable from the analog point area of the memory map. A float variable should be used instead. See the OptoMMP Protocol Guide (form 1465) to determine the data types for specific areas of the memory map.

Status Codes:
- \texttt{0 = Success}
- \texttt{-3 = Invalid length. Length (Argument 0) must be greater than zero.}
- \texttt{-12 = Invalid table index value. Index was negative or greater than the table size.}
- \texttt{-23 = Destination string too short.}
- \texttt{-43 = Received a NACK from the I/O unit.}
- \texttt{-52 = Invalid connection—not opened. The connection may have been closed by a previous command that failed. Check status codes returned on other connection commands.}
- \texttt{-69 = Invalid parameter (null pointer) passed to command.}
- \texttt{-56 = Invalid memory map address.}
- \texttt{-81 = Error writing to memory map. Invalid memory map address.}
- \texttt{-93 = I/O unit not enabled. Previous communication failure may have disabled communication to the unit automatically. Reenable communication to the unit and try again.}

See Also:
- “Read String Table from I/O Unit Memory Map” on page 313
- “Write String Table to I/O Unit Memory Map” on page 320
- “Write String to I/O Unit Memory Map” on page 322
- “Get I/O Unit Scratch Pad String Element” on page 335
- “Get I/O Unit Scratch Pad String Table” on page 337
Read String Table from I/O Unit Memory Map

I/O Unit—Memory Map Action

**Function:**
Read a range of values from a SNAP PAC I/O memory map and store them in a string table.

**Typical Use:**
To access areas of the memory map not directly supported by PAC Control.

**Details:**
- To use this command with a SNAP PAC S-series or SoftPAC controller, create an I/O Unit of the type Generic OptoMMP Device with the loopback address (127.0.0.1).
- This command works with SNAP PAC I/O units that have been configured in PAC Control or PAC Manager. The control engine must be on the I/O unit or connected to another I/O unit for this command to work.
- If you are reading the Scratch Pad area of the memory map, use 13: I/O Unit - Scratch Pad Commands instead (Get I/O Unit Scratch Pad String Table and related commands). If you read using the string command, you might get more than one string, along with whatever length bytes are there. Using the Scratch Pad commands, you get just the requested string data.
- If you’re reading a string of characters from a memory map location, the length is limited by the length of your destination string, which can be up to 1024 characters long.
- **Argument 0,** Length, is the number of bytes to read in the memory map. Data is read in block sizes that are multiples of four.
- **Argument 3,** Mem address, includes only the last eight digits of the memory map address (the lower 32 bits).
- There is a limit of 64 table elements.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length</td>
<td>Start Index</td>
<td>I/O Unit</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
<td>E1</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
<td>E2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>G4EB2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Generic OptoMMP Device</td>
</tr>
<tr>
<td></td>
<td></td>
<td>GRV-EPIC-PR1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>GRV-R7-MM1001-10</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-B3000-ENET, SNAP-ENET-RTC*</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-ENET-D64*</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-ENET-S64*</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-PAC-EB1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-PAC-EB2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-PAC-R1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-PAC-R1-B</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-PAC-R2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-PAC-SB1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-PAC-SB2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-UP1-ADS*</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-UP1-D64*</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-UP1-M64*</td>
</tr>
</tbody>
</table>

* Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).

<table>
<thead>
<tr>
<th>Argument 3</th>
<th>Argument 4</th>
<th>Argument 5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mem address</td>
<td>Put Result in</td>
<td>Put Status in</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>String Table</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>
CHAPTER 12: I/O UNIT - MEMORY MAP COMMANDS

Action Block Example:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length</td>
<td>Integer 32 Literal</td>
<td>0x10</td>
</tr>
<tr>
<td>Start Index</td>
<td>Integer 32 Literal</td>
<td>0x5</td>
</tr>
<tr>
<td>I/O Unit</td>
<td>SNAP-PAC-R1</td>
<td>MYIOUNIT</td>
</tr>
<tr>
<td>Mem address</td>
<td>Integer 32 Literal</td>
<td>0xFFFFFFFF</td>
</tr>
<tr>
<td>Put Result in</td>
<td>String Table</td>
<td>MYSTRINGTABLE</td>
</tr>
<tr>
<td>Put Status in</td>
<td>Integer 32 Variable</td>
<td>STATUS</td>
</tr>
</tbody>
</table>

OptoScript Example:

```cpp
ReadStrTableFromIoUnitMemMap(Length, Start Index, I/O Unit, Mem address, Put Result in)
```

STATUS = ReadStrTableFromIoUnitMemMap(0x10, 0x5, MYIOUNIT, 0xFFFFFFFF, MYSTRINGTABLE);

This is a function command; it returns a status code as listed below.

Using this command in OptoScript, you can use hex in one argument but not in others.

Example:

```cpp
STATUS = ReadStrTableFromIoUnitMemMap(16, 5, MYIOUNIT, 0xFFFFFFFF, MYSTRINGTABLE);
```

Notes:

- In Action blocks, use hex integer display for easy entering of memory map addresses. When you display integers in hex, note that Length (Argument 0) and Start Index (Argument 1) are also in hex.
- The control engine does not convert the table type to match the area of the memory map being read. The control engine has no knowledge of which memory map areas are strings and which are other formats. You must read the correct type of data from the specified memory map address.
  For example, unpredictable results would occur if you try to read a string table from the analog bank area of the memory map. A float table should be used instead. See the OptoMMP Protocol Guide (form 1465) to determine the data types for specific areas of the memory map.
- The string table width needs to be at least 4. If not, a -23 error is returned.

Status Codes:

- 0 = Success
- -3 = Invalid length. Length (Argument 0) must be greater than zero.
- -12 = Invalid table index value. Index was negative or greater than the table size.
- -23 = Destination string too short.
- -43 = Received a NACK from the I/O unit.
- -52 = Invalid connection—not opened. The connection may have been closed by a previous command that failed. Check status codes returned on other connection commands.
- -56 = Invalid memory map address.
- -69 = Invalid parameter (null pointer) passed to command.
- -81 = Error writing to memory map. Invalid memory map address.
- -93 = I/O unit not enabled. Previous communication failure may have disabled communication to the unit automatically. Reenable communication to the unit and try again.

See Also:

- "Read String from I/O Unit Memory Map" on page 311
- "Write String Table to I/O Unit Memory Map" on page 320
- "Write String to I/O Unit Memory Map" on page 322
“Get I/O Unit Scratch Pad String Element” on page 335
“Get I/O Unit Scratch Pad String Table” on page 337
Write Number to I/O Unit Memory Map

**I/O Unit—Memory Map Action**

**Function:** Write a value from an integer 32 or float variable into a SNAP PAC I/O memory map address.

**Typical Use:** To access areas of the memory map not directly supported by PAC Control.

**Details:**
- To use this command with a SNAP PAC S-series or SoftPAC controller, create an I/O Unit of the type Generic OptoMMP Device with the loopback address (127.0.0.1).
- This command works with SNAP PAC I/O units that have been configured in PAC Manager or PAC Control. The control engine must be on the I/O unit or connected to another I/O unit for this command to work.
- If you are writing to the Scratch Pad area of the memory map, use 13: I/O Unit - Scratch Pad Commands instead (Set I/O Unit Scratch Pad Integer 32 Element and related commands).

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Unit</td>
<td>Mem Address</td>
</tr>
<tr>
<td>E1</td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td>E2</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>G4EB2</td>
<td></td>
</tr>
<tr>
<td>Generic OptoMMP Device</td>
<td></td>
</tr>
<tr>
<td>GRV-EPIC-PR1</td>
<td></td>
</tr>
<tr>
<td>GRV-R7-MM1001-10</td>
<td></td>
</tr>
<tr>
<td>SNAP-B3000-ENET, SNAP-ENET-RTC*</td>
<td></td>
</tr>
<tr>
<td>SNAP-ENET-D64*</td>
<td></td>
</tr>
<tr>
<td>SNAP-ENET-S64*</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB1</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB2</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1-B</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R2</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB1</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB2</td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-ADS*</td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-D64*</td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-M64*</td>
<td></td>
</tr>
</tbody>
</table>

* Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).

<table>
<thead>
<tr>
<th>Argument 2</th>
<th>Argument 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>From</td>
<td>Put Status in</td>
</tr>
<tr>
<td>Float Literal</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Float Variable</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td></td>
</tr>
<tr>
<td>Integer 64 Literal</td>
<td></td>
</tr>
<tr>
<td>Integer 64 Variable</td>
<td></td>
</tr>
</tbody>
</table>

**Action Block Example:**

```
Write Number to I/O Unit Memory Map

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Unit</td>
<td>GRV-EPIC-PR1</td>
<td>MYIOUNIT</td>
</tr>
<tr>
<td>Mem Address</td>
<td>Integer 32 Literal</td>
<td>0xFFFFFFFF</td>
</tr>
<tr>
<td>From</td>
<td>Integer 32 Variable</td>
<td>MYINTVAR</td>
</tr>
<tr>
<td>Put Status in</td>
<td>Integer 32 Variable</td>
<td>STATUS</td>
</tr>
</tbody>
</table>
```
OptoScript Example: WriteNumToIoUnitMemMap(I/O Unit, Mem Address, From)
STATUS = WriteNumToIoUnitMemMap(MYIOUNIT, 0xFFFFFFFF, MYINTVAR);

This is a function command; it returns one of the status codes listed below.

Notes:
- Use hex integer display in PAC Control for easy entering of memory map addresses. Be sure there are no spaces within the memory map address.
- The control engine does not convert the variable type to match the area of memory map being written to. The control engine has no knowledge of which memory map areas are integers and which are floats. You must write the correct type of data to the specified memory map address.
  For example, if you are using the SNAP PID module (SNAP-PID-V), use an integer to write the setpoint, which is in counts, and use a float to write the analog output. As another example, unpredictable results would occur if you try to write an integer 32 variable to the analog point area of the memory map. Use a float variable instead. See the OptoMMP Protocol Guide (form 1465) to determine the data types for specific areas of the memory map.

Status Codes:
- 0 = Success
- -36 = Tried to write a float value to a memory map address that takes only integer values.
- -43 = Received a NACK from the I/O unit.
- -52 = Invalid connection—not opened. The connection may have been closed by a previous command that failed. Check status codes returned on other connection commands.
- -56 = Invalid memory map address or read-only address.
- -69 = Invalid parameter (null pointer) passed to command.
- -81 = Error writing to memory map. Invalid memory map address.
- -93 = I/O unit not enabled. Previous communication failure may have disabled communication to the unit automatically. Reenable communication to the unit and try again.

See Also:
- “Write Numeric Table to I/O Unit Memory Map” on page 318
- “Read Numeric Table from I/O Unit Memory Map” on page 309
- “Read Number from I/O Unit Memory Map” on page 307
- “Set I/O Unit Scratch Pad Float Element” on page 341
- “Set I/O Unit Scratch Pad Integer 32 Element” on page 345
Write Numeric Table to I/O Unit Memory Map

I/O Unit—Memory Map Action

**Function:** Write a range of values from an integer 32 or float table into a SNAP PAC I/O memory map address.

**Typical Use:** To access areas of the memory map not directly supported by PAC Control.

**Details:**
- To use this command with a SNAP PAC S-series or SoftPAC controller, create an I/O Unit of the type Generic OptoMMP Device with the loopback address (127.0.0.1).
- This command works with SNAP PAC I/O units that have been configured in PAC Manager or PAC Control. The control engine must be on the I/O unit or connected to another I/O unit for this command to work.
- If you are writing to the Scratch Pad area of the memory map, use 13: I/O Unit - Scratch Pad Commands instead (Set I/O Unit Scratch Pad Integer 32 Table and related commands).
- **Argument 0**, Length, is the number of table elements and also the length of data in the memory map in quads (groups of four bytes). Maximum length is 300.
- **Argument 3**, Mem address, includes only the last eight hex digits (four bytes) of the memory map address (the lower 32 bits).

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Length</strong></td>
<td><strong>Start Index</strong></td>
<td><strong>I/O Unit</strong></td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
<td>E1, E2, G4EB2, Generic OptoMMP Device, GRV-EPIC-PR1, GRV-R7-MM1001-10, SNAP-B3000-ENET, SNAP-ENET-RTC*, SNAP-ENET-D64*, SNAP-ENET-S64*, SNAP-PAC-EB1, SNAP-PAC-EB2, SNAP-PAC-R1, SNAP-PAC-R1-B, SNAP-PAC-R2, SNAP-PAC-SB1, SNAP-PAC-SB2, SNAP-UP1-ADS*, SNAP-UP1-D64*, SNAP-UP1-M64*</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Argument 3</th>
<th>Argument 4</th>
<th>Argument 5</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Mem Address</strong></td>
<td><strong>From</strong></td>
<td><strong>Put Status in</strong></td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Float Table</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Table</td>
<td></td>
</tr>
</tbody>
</table>

* Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).
Write Numeric Table to I/O Unit Memory Map

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length</td>
<td>Integer 32 Literal</td>
<td>0x10</td>
</tr>
<tr>
<td>Start Index</td>
<td>Integer 32 Literal</td>
<td>0x5</td>
</tr>
<tr>
<td>I/O Unit</td>
<td>GRV-EPIC-PR1</td>
<td>MYIOUNIT</td>
</tr>
<tr>
<td>Mem Address</td>
<td>Integer 32 Literal</td>
<td>0xFFFFFFFF</td>
</tr>
<tr>
<td>From</td>
<td>Integer 32 Table</td>
<td>MYINTTABLE</td>
</tr>
<tr>
<td>Put Status in</td>
<td>Integer 32 Variable</td>
<td>STATUS</td>
</tr>
</tbody>
</table>

OptoScript Example:

```optoscript
WriteNumTableToIoUnitMemMap(Length, Start Index, I/O Unit, Mem Address, From)
STATUS = WriteNumTableToIoUnitMemMap(0x10, 0x5, MYIOUNIT, 0xFFFFFFFF, MYINTTABLE);
```

This is a function command; it returns one of the status codes listed below.

Using this command in OptoScript, you can use hex in some arguments and decimal in others.

Example:

```optoscript
STATUS = WriteNumTableToIoUnitMemMap(16, 5, MYIOUNIT, 0xFFFFFFFF, MYINTTABLE);
```

Notes:

- Use hex integer display for easy entering of memory map addresses. When you display integers in hex, note that Length (Argument 0) and Start Index (Argument 1) are also in hex.
- The control engine does not convert the table type to match the area of the memory map being written to. The control engine has no knowledge of which memory map areas are integers and which are floats. You must write the correct type of data to the specified memory map address.
- For example, unpredictable results would occur if you try to write an integer 32 table to the analog bank area of the memory map. A float table should be used instead. See the OptoMMP Protocol Guide (form 1465) to determine the data types for specific areas of the memory map.

Status Codes:

- 0 = Success
- -3 = Buffer overrun or invalid length error. A value > 300 was passed for the Length.
- -12 = Invalid table index value. Index was negative or greater than the table size.
- -43 = Received a NACK from the I/O unit.
- -52 = Invalid connection—not opened. The connection may have been closed by a previous command that failed. Check status codes returned on other connection commands.
- -56 = Invalid memory map address or read-only address.
- -69 = Invalid parameter (null pointer) passed to command.
- -81 = Error writing to memory map. Invalid memory map address.
- -93 = I/O unit not enabled. Previous communication failure may have disabled communication to the unit automatically. Reenable communication to the unit and try again.

See Also:

- “Read Number from I/O Unit Memory Map” on page 307
- “Read Numeric Table from I/O Unit Memory Map” on page 309
- “Write Number to I/O Unit Memory Map” on page 316
- “Set I/O Unit Scratch Pad Float Table” on page 343
- “Set I/O Unit Scratch Pad Integer 32 Table” on page 347
Write String Table to I/O Unit Memory Map

I/O Unit—Memory Map Action

Function: Write a range of values from a string table into the SNAP PAC I/O memory map.

Typical Use: To access areas of the memory map not directly supported by PAC Control.

Details:
- To use this command with a SNAP PAC S-series or SoftPAC controller, create an I/O Unit of the type Generic OptoMMP Device with the loopback address (127.0.0.1).
- This command works with SNAP PAC I/O units that have been configured in PAC Manager or PAC Control. The control engine must be on the I/O unit or connected to another I/O unit for this command to work.
- If you are writing to the Scratch Pad area of the memory map, use 13: I/O Unit - Scratch Pad Commands instead (Set I/O Unit Scratch Pad String Table and related commands).
- Length (Argument 0) is the number of table elements.
- Mem address (Argument 3) includes only the last eight digits of the memory map address (the lower 32 bits).
- There is a limit of 64 table elements.
- This command treats strings like chunks of binary data. Each string must be divisible by 4, or you receive a -70 error. Strings are simply appended together and written to the memory map location specified in Mem Address (Argument 3).

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length</td>
<td>Start Index</td>
<td>I/O Unit</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
<td>E1</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
<td>E2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>G4EB2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Generic OptoMMP Device</td>
</tr>
<tr>
<td></td>
<td></td>
<td>GRV-EPIC-PR1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>GRV-R7-MM1001-10</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-B3000-ENET, SNAP-ENET-RTC*</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-ENET-D64*</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-ENET-S64*</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-PAC-E81</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-PAC-E82</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-PAC-R1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-PAC-R1-B</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-PAC-R2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-PAC-S81</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-PAC-S82</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-UP1-ADS*</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-UP1-D64*</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-UP1-M64*</td>
</tr>
</tbody>
</table>

* Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).

<table>
<thead>
<tr>
<th>Argument 3</th>
<th>Argument 4</th>
<th>Argument 5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mem Address</td>
<td>From</td>
<td>Put Status in</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>String Table</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>
**Action Block Example:**

**Write String Table to I/O Unit Memory Map**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length</td>
<td>Integer 32 Literal</td>
<td>0x10</td>
</tr>
<tr>
<td>Start Index</td>
<td>Integer 32 Literal</td>
<td>0x5</td>
</tr>
<tr>
<td>I/O Unit</td>
<td>GRV-EPIC-PR1</td>
<td>MYIOUNIT</td>
</tr>
<tr>
<td>Mem Address</td>
<td>Integer 32 Literal</td>
<td>0xFFFFFFFF</td>
</tr>
<tr>
<td>From</td>
<td>String Table</td>
<td>MYSTRINGTABLE</td>
</tr>
<tr>
<td>Put Status in</td>
<td>Integer 32 Variable</td>
<td>STATUS</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```optoscript
WriteStrTableToIoUnitMemMap (Length, Start Index, I/O Unit, Mem Address, From)
STATUS = WriteStrTableToIoUnitMemMap (0x10, 0x5, MYIOUNIT, 0xFFFFFFFF, MYSTRINGTABLE);
```

This is a function command; it returns one of the status codes listed below.

Using this command in OptoScript, you can use hex in some arguments and decimal in others.

Example:

```optoscript
STATUS = WriteStrTableToIoUnitMemMap (16, 5, MYIOUNIT, 0xFFFFFFFF, MYSTRINGTABLE);
```

**Notes:**

- Use hex integer display for easy entering of memory map addresses. When you display integers in hex, note that Length (Argument 0) and Start Index (Argument 1) are also in hex.

- The control engine does not convert the table type to match the area of the memory map being written to. The control engine has no knowledge of which memory map areas are strings and which are other formats. You must write the correct type of data to the specified memory map address. For example, unpredictable results would occur if you try to write a string table to the analog bank area of the memory map. A float table should be used instead. See the OptoMMP Protocol Guide (form 1465) to determine the data types for specific areas of the memory map.

**Status Codes:**

- **0** = Success
- **-3** = Invalid length. Length (Argument 0) must be greater than zero.
- **-12** = Invalid table index value. Index was negative or greater than the table size.
- **-43** = Received a NACK from the I/O unit.
- **-52** = Invalid connection—not opened. The connection may have been closed by a previous command that failed. Check status codes returned on other connection commands.
- **-56** = Invalid memory map address or read-only address.
- **-69** = Invalid parameter (null pointer) passed to command.
- **-70** = not enough data supplied. Each string must be divisible by 4.
- **-81** = Error writing to memory map. Invalid memory map address.
- **-93** = I/O unit not enabled. Previous communication failure may have disabled communication to the unit automatically. Reenable communication to the unit and try again.

**See Also:**

- "Read String from I/O Unit Memory Map" on page 311
- "Read String Table from I/O Unit Memory Map" on page 313
- "Write String to I/O Unit Memory Map" on page 322
- "Set I/O Unit Scratch Pad String Element" on page 349
- "Set I/O Unit Scratch Pad String Table" on page 351
Write String to I/O Unit Memory Map

I/O Unit—Memory Map Action

**Function:** Write a string variable into a SNAP PAC I/O memory map address.

**Typical Use:** To access areas of the memory map not directly supported by PAC Control.

**Details:**
- To use this command with a SNAP PAC S-series or SoftPAC controller, create an I/O Unit of the type Generic OptoMMP Device with the loopback address (127.0.0.1).
- This command works with SNAP PAC I/O units that have been configured in PAC Manager or PAC Control. The control engine must be on the I/O unit or connected to another I/O unit for this command to work.
- If you are writing to the Scratch Pad area of the memory map, use 13: I/O Unit - Scratch Pad Commands instead (Set I/O Unit Scratch Pad String Element and related commands).

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Unit</td>
<td>Mem Address</td>
</tr>
<tr>
<td>E1</td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td>E2</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>G4EB2</td>
<td>Generic OptoMMP Device</td>
</tr>
<tr>
<td>GRV-EPIC-PR1</td>
<td>GRV-R7-MM1001-10</td>
</tr>
<tr>
<td>SNAP-B3000-ENET, SNAP-ENET-RTC*</td>
<td>SNAP-ENET-D64*</td>
</tr>
<tr>
<td>SNAP-ENET-S64*</td>
<td>SNAP-PAC-EB1</td>
</tr>
<tr>
<td>SNAP-PAC-EB2</td>
<td>SNAP-PAC-R1</td>
</tr>
<tr>
<td>SNAP-PAC-R1-B</td>
<td>SNAP-PAC-R2</td>
</tr>
<tr>
<td>SNAP-PAC-SB1</td>
<td>SNAP-PAC-SB2</td>
</tr>
<tr>
<td>SNAP-UP1-ADS*</td>
<td>SNAP-UP1-D64*</td>
</tr>
<tr>
<td>SNAP-UP1-M64*</td>
<td></td>
</tr>
</tbody>
</table>

* Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).

<table>
<thead>
<tr>
<th>Argument 2</th>
<th>Argument 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>From</td>
<td>Put Status in</td>
</tr>
<tr>
<td>String Literal</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

**Action Block Example:**

```plaintext
Write String to I/O Unit Memory Map

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Unit</td>
<td>GRV-EPIC-PR1</td>
<td>MYIOUNIT</td>
</tr>
<tr>
<td>Mem Address</td>
<td>Integer 32 Literal</td>
<td>0xFFFFFFFF</td>
</tr>
<tr>
<td>From</td>
<td>String Variable</td>
<td>MYSTRINGVAR</td>
</tr>
<tr>
<td>Put Status in</td>
<td>Integer 32 Variable</td>
<td>STATUS</td>
</tr>
</tbody>
</table>
```

**OptoScript Example:**

```plaintext
WriteStrToIoUnitMemMap (I/O Unit, Mem Address, From)

STATUS = WriteStrToIoUnitMemMap(MYIOUNIT, 0xFFFFFFFF, MYSTRINGVAR);
```

This is a function command; it returns a status code as listed below.
Notes:
- Use hex integer display for easy entering of memory map addresses.
- The control engine does not convert the variable type to match the area of memory map being written to. The control engine has no knowledge of which memory map areas are strings and which are other formats. You must write the correct type of data to the specified memory map address.
For example, unpredictable results would occur if you try to write a string variable to the analog point area of the memory map. A float variable should be used instead. See the OptoMMP Protocol Guide (form 1465) to determine the data types for specific areas of the memory map.

Status Codes:
- 0 = Success
- -3 = Invalid length. Length must be greater than zero.
- -12 = Invalid table index value. Index was negative or greater than the table size.
- -43 = Received a NACK from the I/O unit.
- -52 = Invalid connection—not opened. The connection may have been closed by a previous command that failed. Check status codes returned on other connection commands.
- -56 = Invalid memory map address or read-only address.
- -69 = Invalid parameter (null pointer) passed to command.
- -81 = Error writing to memory map. Invalid memory map address.
- -93 = I/O unit not enabled. Previous communication failure may have disabled communication to the unit automatically. Reenable communication to the unit and try again.

See Also:
- “Write String Table to I/O Unit Memory Map” on page 320
- “Read String from I/O Unit Memory Map” on page 311
- “Read String Table from I/O Unit Memory Map” on page 313
- “Set I/O Unit Scratch Pad String Element” on page 349
- “Set I/O Unit Scratch Pad String Table” on page 351
13: I/O Unit - Scratch Pad Commands

Get I/O Unit Scratch Pad Bits

I/O Unit—Scratch Pad Action

**Function:**
To read a bit in the Scratch Pad area of a SNAP PAC controller or brain.

**Typical Use:**
For peer-to-peer communication. Strategy data can be stored in the brain's Scratch Pad area and retrieved by a peer on the network.

**Details:**
- To use this command with a SNAP PAC S-series or SoftPAC controller, create an I/O Unit of the type Generic OptoMMP Device with the loopback address (127.0.0.1).
- Use Set I/O Unit Scratch Pad Bits from MOMO Mask to store the data in the Scratch Pad area, and then use this command to retrieve it.
- The entire Scratch Pad Bits area is returned to the variable named in **Put Result in** (Argument 1).

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
</table>
| **I/O Unit**
G4EB2
Generic OptoMMP Device
GRV-EPIC-PR1
GRV-R7-MM1001-10
SNAP-B3000-ENET, SNAP-ENET-RTC*
SNAP-ENET-D64*
SNAP-PAC-EB1
SNAP-PAC-EB2
SNAP-PAC-R1
SNAP-PAC-R1-B
SNAP-PAC-R2
SNAP-PAC-SB1
SNAP-PAC-SB2
SNAP-UP1-ADS**
SNAP-UP1-D64**
SNAP-UP1-M64**|
| **Put Result in**
Integer 64 Variable|
| **Put Status in**
Integer 32 Variable|

* Not intended for use with these brains, because they don't have the integer scratch pad area.
** Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).
**Get I/O Unit Scratch Pad Bits**

**Argument Name** | **Type** | **Name**
--- | --- | ---
I/O Unit | GRV-EPIC-PR1 | PR1
Put Result in | Integer 64 Variable | MyInt64Var
Put Status in | Integer 32 Variable | Status

**OptoScript Example:**

```opto
GetIoUnitScratchPadBits(I/O Unit, Put Result in)
```

```opto
Status = GetIoUnitScratchPadBits(PR1, MyInt64Var);
```

This is a function command; it returns one of the status codes listed below.

**Notes:**

- To find out the value of a specific bit in the returned data, use `Bit Test`. See other 14: Logical Commands for other ways to work with the returned data.
- The I/O Unit Scratch Pad area is for general-purpose use and is accessible to any network device (for example, another PAC R-series I/O unit or an application running on a PC) that can connect to the I/O unit’s command processor port (usually port 2001). Be aware of all devices that have access to the area, and make sure that their reads and writes are synchronized so that correct data is available to all devices when needed.
- See “I/O Unit—Scratch Pad Commands” in the [PAC Control User’s Guide](#) (form 1700).

**Status Codes:**

- 0 = success
- -43 = Received a NACK from the I/O unit.
- -52 = Invalid connection—not opened. The connection may have been closed by a previous command that failed. Check status codes returned on other connection commands.
- -93 = I/O unit not enabled. Previous communication failure may have disabled communication to the unit automatically. Reenable communication to the unit and try again.

**See Also:**

- “Set I/O Unit Scratch Pad Bits from MOMO Mask” on page 339
- “Get I/O Unit Scratch Pad Float Element” on page 327
- “Get I/O Unit Scratch Pad Float Table” on page 329
- “Get I/O Unit Scratch Pad Integer 32 Element” on page 331
- “Get I/O Unit Scratch Pad Integer 32 Table” on page 333
- “Get I/O Unit Scratch Pad String Element” on page 335
- “Get I/O Unit Scratch Pad String Table” on page 337
Get I/O Unit Scratch Pad Float Element

I/O Unit—Scratch Pad Action

**Function:** To read a float in the Scratch Pad area of a remote or local SNAP PAC R-series controller or SNAP PAC brain.

**Typical Use:** For peer-to-peer communication. Strategy variable data can be stored in the brain’s Scratch Pad area and retrieved by a peer on the network.

**Details:**
- To use this command with a SNAP PAC S-series or SoftPAC controller, create an I/O Unit of the type Generic OptoMMP Device with the loopback address (127.0.0.1).
- You can use Set I/O Unit Scratch Pad Float Element to store the variable data in the Scratch Pad area, and then use this command to retrieve it.
- The float area of the Scratch Pad is a table containing 10240 elements (index numbers 0–10,239). Enter the index number of the element you want to read in Index (Argument 1). The float value is returned to the float variable named in Put Result in (Argument 2).

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Unit</td>
<td>Index</td>
</tr>
<tr>
<td>G4EB2</td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td>Generic OptoMMP Device</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>GRV-EPIC-PR1</td>
<td></td>
</tr>
<tr>
<td>GRV-R7-MM1001-10</td>
<td></td>
</tr>
<tr>
<td>SNAP-B3000-ENET, SNAP-ENET-RTC*</td>
<td></td>
</tr>
<tr>
<td>SNAP-ENET-D64*</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB1</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB2</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1-B</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R2</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB1</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB2</td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-ADS**</td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-D64**</td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-M64**</td>
<td></td>
</tr>
</tbody>
</table>

* Not intended for use with these brains, because they don’t have the integer scratch pad area.

**Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).**

| Argument 2 | Argument 3 |
| Put Result in | Put Status in |
| Float Variable | Integer 32 Variable |

**Action Block Example:**

```
Get I/O Unit Scratch Pad Float Element

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Unit</td>
<td>SNAP-PAC-R1</td>
<td>R1</td>
</tr>
<tr>
<td>Index</td>
<td>Integer 32 Literal</td>
<td>26</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Float Variable</td>
<td>MyFloatVar</td>
</tr>
<tr>
<td>Put Status in</td>
<td>Integer 32 Variable</td>
<td>Status</td>
</tr>
</tbody>
</table>
```

**OptoScript Example:**

```
GetI0UnitScratchPadFloatElement(I/O Unit, Index, Put Result in)
Status = GetI0UnitScratchPadFloatElement(R1, 26, MyFloatVar);
```

This is a function command; it returns one of the status codes listed below.
Notes:

- To retrieve more than one float value in a single command, use Get I/O Unit Scratch Pad Float Table.
- The I/O unit Scratch Pad area is for general-purpose use and is accessible to any network device (for example, another PAC R-series I/O unit or an application running on a PC) that can connect to the I/O unit’s command processor port (usually port 2001). Be aware of all devices that have access to the area, and make sure that their reads and writes are synchronized so that correct data is available to all devices when needed.
- Since this command accesses a table on an I/O unit, it requires communication to that unit, so it will take more time than just moving data between tables in a strategy.

Status Codes:

- 0 = success
- -12 = Invalid table index value. Index was negative or greater than the table size.
- -43 = Received a NACK from the I/O unit.
- -52 = Invalid connection—not opened. The connection may have been closed by a previous command that failed. Check status codes returned on other connection commands.
- -93 = I/O unit not enabled. Previous communication failure may have disabled communication to the unit automatically. Reenable communication to the unit and try again.

See Also:

- “Set I/O Unit Scratch Pad Float Element” on page 341
- “Get I/O Unit Scratch Pad Bits” on page 325
- “Get I/O Unit Scratch Pad Float Table” on page 329
- “Get I/O Unit Scratch Pad Integer 32 Element” on page 331
- “Get I/O Unit Scratch Pad Integer 32 Table” on page 333
- “Get I/O Unit Scratch Pad String Element” on page 335
- “Get I/O Unit Scratch Pad String Table” on page 337
**Get I/O Unit Scratch Pad Float Table**

**I/O Unit—Scratch Pad Action**

**Function:**
To read a series of float values in the Scratch Pad area of a local or remote SNAP PAC R-series controller or SNAP PAC brain.

**Typical Use:**
For peer-to-peer communication. Strategy variable data can be stored in the brain’s Scratch Pad area and retrieved by a peer on the network.

**Details:**
- To use this command with a SNAP PAC S-series or SoftPAC controller, create an I/O Unit of the type Generic OptoMMP Device with the loopback address (127.0.0.1).
- You can use Set I/O Unit Scratch Pad Float Element more than once, or use Set I/O Unit Scratch Pad Float Table, to store the variable data in the Scratch Pad area. Use this command to retrieve the float values and place them in a table defined in the peer’s strategy.
- The float area of the Scratch Pad is a table containing 10,240 elements (index numbers 0–10,239). Enter the number of elements you want to read in Length (Argument 1) and the index number of the starting element in From Index (Argument 2).
- The float values are returned to the float table named in To Table (Argument 4), starting at the index shown in To Index (Argument 3).
- From Index (Argument 2) is the start index of the source table.
- To Index (Argument 3) is the start index of the destination table that data will be written to.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>I/O Unit</strong></td>
<td><strong>Length</strong></td>
<td><strong>From Index</strong></td>
</tr>
<tr>
<td>G4EB2</td>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td>Generic OptoMMP Device</td>
<td></td>
<td></td>
</tr>
<tr>
<td>GRV-R7-MM1001-10</td>
<td>Integer 32 Variable</td>
<td></td>
</tr>
<tr>
<td>SNAP-B3000-ENET, SNAP-ENET-RTC*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-ENET-D64*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1-B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-ADS**</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-D64**</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-M64**</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* *Not intended for use with these brains*, because they don't have the integer scratch pad area.

**Argument 3**

<table>
<thead>
<tr>
<th><strong>To Index</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

**Argument 4**

<table>
<thead>
<tr>
<th><strong>To Table</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Float Table</td>
</tr>
</tbody>
</table>

**Argument 5**

<table>
<thead>
<tr>
<th><strong>Put Status in</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>
CHAPTER 13: I/O UNIT – SCRATCH PAD COMMANDS

Action Block Example:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Unit</td>
<td>GRV-EPIC-PR1</td>
<td>PR1</td>
</tr>
<tr>
<td>Length</td>
<td>Integer 32</td>
<td>Literal</td>
</tr>
<tr>
<td>From Index</td>
<td>Integer 32</td>
<td>Literal</td>
</tr>
<tr>
<td>To Index</td>
<td>Integer 32</td>
<td>Literal</td>
</tr>
<tr>
<td>To Table</td>
<td>MyFloatTable</td>
<td>Float Table</td>
</tr>
<tr>
<td>Put Status in</td>
<td>Status</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

Example:

OptoScript Example:

GetIoUnitScratchPadFloatTable(I/O Unit, Length, From Index, To Index, To Table)

Status = GetIoUnitScratchPadFloatTable(PR1, 64, 0, 0, MyFloatTable);

Notes:
- To retrieve a single float value, use Get I/O Unit Scratch Pad Float Element.
- The I/O unit Scratch Pad area is for general-purpose use and is accessible to any network device (for example, another PAC R-series I/O unit or an application running on a PC) that can connect to the I/O unit’s command processor port (usually port 2001). Be aware of all devices that have access to the area, and make sure that their reads and writes are synchronized so that correct data is available to all devices when needed.
- Since this command accesses a table on an I/O unit, it requires communication to that unit, so it will take more time than just moving data between tables in a strategy.

Status Codes:

0 = success
-3 = Invalid length. Length (Argument 1) is less than 0 or greater than 10240.
-12 = Invalid table index value. Index was negative or greater than the table size.
-43 = Received a NACK from the I/O unit.
-52 = Invalid connection—not opened. The connection may have been closed by a previous command that failed. Check status codes returned on other connection commands.
-93 = I/O unit not enabled. Previous communication failure may have disabled communication to the unit automatically. Reenable communication to the unit and try again.

See Also:

“Set I/O Unit Scratch Pad Float Table” on page 343
“Get I/O Unit Scratch Pad Float Element” on page 327
“Get I/O Unit Scratch Pad Bits” on page 325
“Get I/O Unit Scratch Pad Integer 32 Element” on page 331
“Get I/O Unit Scratch Pad Integer 32 Table” on page 333
“Get I/O Unit Scratch Pad String Element” on page 335
“Get I/O Unit Scratch Pad String Table” on page 337
Get I/O Unit Scratch Pad Integer 32 Element
I/O Unit—Scratch Pad Action

**Function:** To read an integer 32 in the Scratch Pad area of a local or remote SNAP PAC R-series controller or SNAP PAC brain.

**Typical Use:** For peer-to-peer communication. Strategy variable data can be stored in the brain’s Scratch Pad area and retrieved by a peer on the network.

**Details:**
- To use this command with a SNAP PAC S-series or SoftPAC controller, create an I/O Unit of the type Generic OptoMMP Device with the loopback address (127.0.0.1).
- You can use Set I/O Unit Scratch Pad Integer 32 Element to store the variable data in the Scratch Pad area, and then use this command to retrieve it.
- The integer 32 area of the Scratch Pad is a table containing 10,240 elements (index numbers 0–10,239). Enter the index number of the element you want to read in **Index** (Argument 1).
- The integer 32 value is returned to the integer 32 variable in **Put Result in** (Argument 2).

**Arguments:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Unit</td>
<td>SNAP-PAC-R1</td>
<td>R1</td>
</tr>
<tr>
<td>Index</td>
<td>Integer 32 Literal</td>
<td>26</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Integer 32 Variable</td>
<td>MyInt32Var</td>
</tr>
<tr>
<td>Put Status in</td>
<td>Integer 32 Variable</td>
<td>Status</td>
</tr>
</tbody>
</table>

*Not intended for use with these brains*, because they don’t have the integer scratch pad area.

**OptoScript Example:**

```optoscript
GetIoUnitScratchPadInt32Element(I/O Unit, Index, Put Result in)
```

```
Status = GetIoUnitScratchPadInt32Element(R1, 26, MyInt32Var);
```
This is a function command; it returns one of the status codes listed below.

**Notes:**
- To retrieve more than one integer 32 value in a single command, use Set I/O Unit Scratch Pad Integer 32 Table.
- The I/O unit Scratch Pad area is for general-purpose use and is accessible to any network device (for example, another PAC R-series I/O unit or an application running on a PC) that can connect to the I/O unit’s command processor port (usually port 2001). Be aware of all devices that have access to the area, and make sure that their reads and writes are synchronized so that correct data is available to all devices when needed.
- Since this command accesses a table on an I/O unit, it requires communication to that unit, so it will take more time than just moving data between tables in a strategy.

**Status Codes:**

0 = success

-12 = Invalid table index value. Index was negative or greater than the table size.

-43 = Received a NACK from the I/O unit.

-52 = Invalid connection—not opened. The connection may have been closed by a previous command that failed. Check status codes returned on other connection commands.

-93 = I/O unit not enabled. Previous communication failure may have disabled communication to the unit automatically. Reenable communication to the unit and try again.

**See Also:**
- “Set I/O Unit Scratch Pad Integer 32 Element” on page 345
- “Get I/O Unit Scratch Pad Bits” on page 325
- “Get I/O Unit Scratch Pad Float Element” on page 327
- “Get I/O Unit Scratch Pad Float Table” on page 329
- “Get I/O Unit Scratch Pad Integer 32 Table” on page 333
- “Get I/O Unit Scratch Pad String Element” on page 335
- “Get I/O Unit Scratch Pad String Table” on page 337
Get I/O Unit Scratch Pad Integer 32 Table

I/O Unit—Scratch Pad Action

Function: To read a series of integer 32 values in the Scratch Pad area of a local or remote SNAP PAC R-series controller or SNAP PAC brain.

Typical Use: For peer-to-peer communication. Strategy variable data can be stored in the brain’s Scratch Pad area and retrieved by a peer on the network.

Details:
- To use this command with a SNAP PAC S-series or SoftPAC controller, create an I/O Unit of the type Generic OptoMMP Device with the loopback address (127.0.0.1).
- You can use Set I/O Unit Scratch Pad Integer 32 Element more than once, or use Set I/O Unit Scratch Pad Integer 32 Table, to store the variable data in the Scratch Pad area. Use this command to retrieve the integer values in one step and place them in a table defined in the peer’s strategy.
- The integer 32 area of the Scratch Pad is a table containing 10,240 elements (index numbers 0–10,239). Enter the number of elements you want to read in Length (Argument 1), and the index number of the starting element in From Index (Argument 2).
- The integer values are returned to the integer 32 table in To Table (Argument 4), starting at the index shown in To Index (Argument 3).

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Unit</td>
<td>Length</td>
<td>From Index</td>
</tr>
<tr>
<td>G4EB2</td>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td>Generic OptoMMP Device</td>
<td></td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>GRV-EPIC-PR1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>GRV-R7-MM1001-10</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-B3000-ENET, SNAP-ENET-RTC*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-ENET-D64*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1-B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-ADS**</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-D64**</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-M64**</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* Not intended for use with these brains, because they don’t have the integer scratch pad area.

** Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).

<table>
<thead>
<tr>
<th>Argument 3</th>
<th>Argument 4</th>
<th>Argument 5</th>
</tr>
</thead>
<tbody>
<tr>
<td>To Index</td>
<td>To Table</td>
<td>Put Status in</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Table</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
CHAPTER 13: I/O UNIT - SCRATCH PAD COMMANDS

**Action Block Example:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Unit</td>
<td>SNAP-PAC-R1-B</td>
<td>PAC_B</td>
</tr>
<tr>
<td>Length</td>
<td>Integer 32 Literal</td>
<td>64</td>
</tr>
<tr>
<td>From Index</td>
<td>Integer 32 Literal</td>
<td>0</td>
</tr>
<tr>
<td>To Index</td>
<td>Integer 32 Literal</td>
<td>0</td>
</tr>
<tr>
<td>To Table</td>
<td>Integer 32 Table</td>
<td>MyInt32Table</td>
</tr>
<tr>
<td>Put Status in</td>
<td>Integer 32 Variable</td>
<td>Status</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

GetIoUnitScratchPadInt32Table(I/O Unit, Length, From Index, To Index, To Table)

Status = GetIoUnitScratchPadInt32Table(PAC_B, 64, 0, 0, MyInt32Table);

This is a function command; it returns one of the status codes listed below.

**Notes:**

- To retrieve a single integer 32 value, use Get I/O Unit Scratch Pad Integer 32 Element.
- The I/O unit Scratch Pad area is for general-purpose use and is accessible to any network device (for example, another PAC R-series I/O unit or an application running on a PC) that can connect to the I/O unit's command processor port (usually port 2001). Be aware of all devices that have access to the area, and make sure that their reads and writes are synchronized so that correct data is available to all devices when needed.
- Since this command accesses a table on an I/O unit, it requires communication to that unit, so it will take more time than just moving data between tables in a strategy.

**Status Codes:**

-0 = success

-3 = Invalid length. Length (Argument 1) is less than 0 or greater than 3072.

-12 = Invalid table index value. Index was negative or greater than the table size.

-43 = Received a NACK from the I/O unit.

-52 = Invalid connection—not opened. The connection may have been closed by a previous command that failed. Check status codes returned on other connection commands.

-93 = I/O unit not enabled. Previous communication failure may have disabled communication to the unit automatically. Reenable communication to the unit and try again.

**See Also:**

“Set I/O Unit Scratch Pad Integer 32 Table” on page 347
“Get I/O Unit Scratch Pad Integer 32 Element” on page 331
“Get I/O Unit Scratch Pad Integer 32 Table” on page 339
“Get I/O Unit Scratch Pad Float Table” on page 339
“Get I/O Unit Scratch Pad Float Element” on page 327
“Get I/O Unit Scratch Pad String Element” on page 335
“Get I/O Unit Scratch Pad String Table” on page 337

334 PAC Control Command Reference
Get I/O Unit Scratch Pad String Element

I/O Unit—Scratch Pad Action

Function: To read a string in the Scratch Pad area of a local or remote SNAP PAC R-series controller or SNAP PAC brain.

Typical Use: For peer-to-peer communication. Strategy variable data can be stored in the brain’s Scratch Pad area and retrieved by a peer on the network.

Details:
- To use this command with a SNAP PAC S-series or SoftPAC controller, create an I/O unit of the type Generic OptoMMP Device with the loopback address (127.0.0.1).
- You can use Set I/O Unit Scratch Pad String Element to store the variable data in the Scratch Pad area, and then use this command to retrieve it.
- The string area of the Scratch Pad is a table containing 64 elements (index numbers 0–63). Each string element can hold 128 characters or 128 bytes of binary data. Enter the index number of the element you want to read in Index (Argument 1). The string is returned to the string variable in Put Result in (Argument 2).

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Unit</td>
<td>Index</td>
</tr>
<tr>
<td>G4EB2</td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td>Generic OptoMMP Device</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>GRV-EPIC-PR1</td>
<td></td>
</tr>
<tr>
<td>GRV-R7-MM100-10</td>
<td></td>
</tr>
<tr>
<td>SNAP-B3000-ENET, SNAP-ENET-RTC*</td>
<td></td>
</tr>
<tr>
<td>SNAP-ENET-D64*</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB1</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R2</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1-B</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R2</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB1</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R2</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB2</td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-ADS**</td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-D64**</td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-M64**</td>
<td></td>
</tr>
</tbody>
</table>

* Not intended for use with these brains, because they don’t have the integer scratch pad area.
** Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).

<table>
<thead>
<tr>
<th>Argument 2</th>
<th>Argument 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Put Result in</td>
<td>Put Status in</td>
</tr>
<tr>
<td>String Variable</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

Action Block Example:

Get I/O Unit Scratch Pad String Element

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Unit</td>
<td></td>
<td>PR1</td>
</tr>
<tr>
<td>Index</td>
<td>Integer 32 Literal</td>
<td>26</td>
</tr>
<tr>
<td>Put Result in</td>
<td>String Variable</td>
<td>MyStringVar</td>
</tr>
<tr>
<td>Put Status in</td>
<td>Integer 32 Variable</td>
<td>Status</td>
</tr>
</tbody>
</table>

OptoScript Example:

```plaintext
GetIoUnitScratchPadStringElement(I/O Unit, Index, Put Result in)
Status = GetIoUnitScratchPadStringElement(PR1, 26, MyStringVar);
```
This is a function command; it returns one of the status codes listed below.

Notes:
- To retrieve more than one string in a single command, use Get I/O Unit Scratch Pad String Table.
- If the destination string width is smaller than the received string, as many characters as possible are placed in the string and a -23 error is returned.
- The I/O unit Scratch Pad area is for general-purpose use and is accessible to any network device (for example, another PAC R-series I/O unit or an application running on a PC) that can connect to the I/O unit’s command processor port (usually port 2001). Be aware of all devices that have access to the area, and make sure that their reads and writes are synchronized so that correct data is available to all devices when needed.
- Since this command accesses a table on an I/O unit, it requires communication to that unit, so it will take more time than just moving data between tables in a strategy.

Status Codes:

0 = success
-12 = Invalid table index value. Index was negative or greater than the table size.
-23 = String too short. Destination string width is smaller than received string. (As many characters as possible are placed in the string.)
-43 = Received a NACK from the I/O unit.
-52 = Invalid connection—not opened. The connection may have been closed by a previous command that failed. Check status codes returned on other connection commands.
-93 = I/O unit not enabled. Previous communication failure may have disabled communication to the unit automatically. Reenable communication to the unit and try again.

See Also:
"Set I/O Unit Scratch Pad String Element” on page 349
"Get I/O Unit Scratch Pad Float Element” on page 327
"Get I/O Unit Scratch Pad Float Table” on page 329
"Get I/O Unit Scratch Pad Integer 32 Element” on page 331
"Get I/O Unit Scratch Pad Integer 32 Table” on page 333
"Get I/O Unit Scratch Pad Bits” on page 325
"Get I/O Unit Scratch Pad String Table” on page 337
Get I/O Unit Scratch Pad String Table

I/O Unit—Scratch Pad Action

**Function:** To read a series of strings in the Scratch Pad area of a local or remote SNAP PAC R-series controller or SNAP PAC brain.

**Typical Use:** For peer-to-peer communication. Strategy variable data can be stored in the brain’s Scratch Pad area and retrieved by a peer on the network.

**Details:**

- To use this command with a SNAP PAC S-series or SoftPAC controller, create an I/O Unit of the type Generic OptoMMP Device with the loopback address (127.0.0.1).
- You can use Set I/O Unit Scratch Pad String Element or Set I/O Unit Scratch Pad String Table to store the variable data in the Scratch Pad area, and then use this command to retrieve it.
- The string area of the Scratch Pad is a table containing 64 elements (index numbers 0–63). Each string element can hold 128 characters or 128 bytes of binary data. Enter the number of elements you want to read in **Length** (Argument 1), and the index number of the starting element in **From Index** (Argument 2).
- The string values are returned to the string table in **To Table** (Argument 4), starting at the index shown in **To Index** (Argument 3).

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>I/O Unit</strong></td>
<td><strong>Length</strong></td>
<td><strong>From Index</strong></td>
</tr>
<tr>
<td>G4EB2</td>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td>Generic OptoMMP Device</td>
<td></td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>GRV-EPIC-PR1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>GRV-R7-MM1001-10</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-B3000-ENET, SNAP-ENET-RTC*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-ENET-D64*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1-B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-ADS**</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-D64**</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-M64**</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* Not intended for use with these brains, because they don’t have the integer scratch pad area.

**Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).**

<table>
<thead>
<tr>
<th>Argument 3</th>
<th>Argument 4</th>
<th>Argument 5</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>To Index</strong></td>
<td><strong>To Table</strong></td>
<td><strong>Put Status in</strong></td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>String Table</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
CHAPTER 13: I/O UNIT - SCRATCH PAD COMMANDS

**Get I/O Unit Scratch Pad String Table**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Unit</td>
<td>SNAP-PAC-R1-B</td>
<td>PAC_B</td>
</tr>
<tr>
<td>Length</td>
<td>Integer 32 Literal</td>
<td>8</td>
</tr>
<tr>
<td>From Index</td>
<td>Integer 32 Literal</td>
<td>0</td>
</tr>
<tr>
<td>To Index</td>
<td>Integer 32 Literal</td>
<td>0</td>
</tr>
<tr>
<td>To Table</td>
<td>String Table</td>
<td>MyStringTable</td>
</tr>
<tr>
<td>Put Status in</td>
<td>Integer 32 Variable</td>
<td>Status</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```plaintext
GetIoUnitScratchPadStringTable(I/O Unit, Length, From Index, To Index, To Table)
```

Status = GetIoUnitScratchPadStringTable(PAC_B, 8, 0, 0, MyStringTable);

This is a function command; it returns one of the status codes listed below.

**Notes:**

- To retrieve a single string, use Get I/O Unit Scratch Pad String Element.
- The I/O unit Scratch Pad area is for general-purpose use and is accessible to any network device (for example, another PAC R-series I/O unit or an application running on a PC) that can connect to the I/O unit's command processor port (usually port 2001). Be aware of all devices that have access to the area, and make sure that their reads and writes are synchronized so that correct data is available to all devices when needed.
- Since this command accesses a table on an I/O unit, it requires communication to that unit, so it will take more time than just moving data between tables in a strategy.

**Status Codes:**

- 0 = success
- -3 = Invalid length. Length (Argument 1) is less than 0 or greater than 63.
- -12 = Invalid table index value. Index was negative or greater than the table size.
- -23 = String too short. Destination string width is smaller than received string. (As many characters as possible are placed in the string.)
- -43 = Received a NACK from the I/O unit.
- -52 = Invalid connection—not opened. The connection may have been closed by a previous command that failed. Check status codes returned on other connection commands.
- -93 = I/O unit not enabled. Previous communication failure may have disabled communication to the unit automatically. Reenable communication to the unit and try again.

**See Also:**

- “Set I/O Unit Scratch Pad String Table” on page 351
- “Get I/O Unit Scratch Pad Float Element” on page 327
- “Get I/O Unit Scratch Pad Float Table” on page 329
- “Get I/O Unit Scratch Pad Integer 32 Element” on page 331
- “Get I/O Unit Scratch Pad Integer 32 Table” on page 333
- “Get I/O Unit Scratch Pad String Element” on page 335
- “Get I/O Unit Scratch Pad Bits” on page 325
Set I/O Unit Scratch Pad Bits from MOMO Mask

I/O Unit—Scratch Pad Action

**Function:** To write bits to the Scratch Pad area of a local or remote SNAP PAC R-series controller or SNAP PAC brain.

**Typical Use:** For peer-to-peer communication. Strategy data can be stored in the Scratch Pad area and retrieved by a peer on the network.

**Details:**
- Use this command to store the data in the Scratch Pad area, and then use Get I/O Unit Scratch Pad Bits to retrieve it.
- To use this command with a SNAP PAC S-series or SoftPAC controller, create an I/O Unit of the type Generic OptoMMP Device with the loopback address (127.0.0.1).

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>I/O Unit</strong></td>
<td><strong>Must On Mask</strong></td>
</tr>
<tr>
<td>G4EB2</td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td>Generic OptoMMP Device</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>GRV-EPIC-PR1</td>
<td>Integer 64 Literal</td>
</tr>
<tr>
<td>GRV-R7-MM1001-10</td>
<td>Integer 64 Variable</td>
</tr>
<tr>
<td>SNAP-B3000-ENET, SNAP-ENET-RTC*</td>
<td></td>
</tr>
<tr>
<td>SNAP-ENET-D64*</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB1</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB2</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1-B</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R2</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB1</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB2</td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-ADS**</td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-D64**</td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-M64**</td>
<td></td>
</tr>
</tbody>
</table>

* Not intended for use with these brains, because they don’t have the integer scratch pad area.

**Argument 2 | Argument 3**

<table>
<thead>
<tr>
<th><strong>Must Off Mask</strong></th>
<th><strong>Put Status in</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td></td>
</tr>
<tr>
<td>Integer 64 Literal</td>
<td></td>
</tr>
<tr>
<td>Integer 64 Variable</td>
<td></td>
</tr>
</tbody>
</table>

**Action Block Example:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Unit</td>
<td>G4EB2</td>
<td>PR1</td>
</tr>
<tr>
<td>Must On Mask</td>
<td>Integer 64 Variable</td>
<td>MyOnMask</td>
</tr>
<tr>
<td>Must Off Mask</td>
<td>Integer 64 Variable</td>
<td>MyOffMask</td>
</tr>
<tr>
<td>Put Status in</td>
<td>Integer 32 Variable</td>
<td>Status</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```optoscript
SetIoUnitScratchPadBitsFromMomo(I/O Unit, Must On Mask, Must Off Mask)
Status = SetIoUnitScratchPadBitsFromMomo(PR1, MyOnMask, MyOffMask);
```

This is a function command; it returns one of the status codes listed below.
Notes:

- It is best to use 64-bit values for Must-on Mask (Argument 1) and Must-off Mask (Argument 2). PAC Control and OptoScript will convert a 32-bit value to 64 bits, and then use the 64-bit value. Because both integer 32 and integer 64 values are signed integers, an integer 32 value of 0xAAAAAAAA will be converted to 0xFFFFFFFFAAAAAAAA.

- The I/O unit Scratch Pad area is for general-purpose use and is accessible to any network device (for example, another PAC R-series I/O unit or an application running on a PC) that can connect to the I/O unit’s command processor port (usually port 2001). Be aware of all devices that have access to the area, and make sure that their reads and writes are synchronized so that correct data is available to all devices when needed.


Status Codes:

0 = success
-43 = Received a NACK from the I/O unit.
-52 = Invalid connection—not opened. The connection may have been closed by a previous command that failed. Check status codes returned on other connection commands.
-58 = No data received. I/O unit may be turned off or unreachable.
-93 = I/O unit not enabled. Previous communication failure may have disabled communication to the unit automatically. Reenable communication to the unit and try again.

See Also:

"Get I/O Unit Scratch Pad Bits" on page 325
"Set I/O Unit Scratch Pad Float Element" on page 341
"Set I/O Unit Scratch Pad Float Table" on page 343
"Set I/O Unit Scratch Pad Integer 32 Element" on page 345
"Set I/O Unit Scratch Pad Integer 32 Table" on page 347
"Set I/O Unit Scratch Pad String Element" on page 349
"Set I/O Unit Scratch Pad String Table" on page 351
Set I/O Unit Scratch Pad Float Element

I/O Unit—Scratch Pad Action

Function: To write a float to the Scratch Pad area of a local or remote SNAP PAC R-series controller or SNAP PAC brain.

Typical Use: For peer-to-peer communication. Strategy variable data can be stored in the brain’s Scratch Pad area and retrieved by a peer on the network.

Details:
- To use this command with a SNAP PAC S-series or SoftPAC controller, create an I/O Unit of the type Generic OptoMMP Device with the loopback address (127.0.0.1).
- You can use this command to store the variable data in the Scratch Pad area, and then use Get I/O Unit Scratch Pad Float Element or Get I/O Unit Scratch Pad Float Table to retrieve it.
- The float area of the Scratch Pad is a table containing 10,240 elements (index numbers 0–10,239). Enter the index number of the element you want to set in Index (Argument 1).

Arguments: 

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
<th>Argument 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Unit</td>
<td>Index</td>
<td>From</td>
<td>Put Status in</td>
</tr>
<tr>
<td>SNAP-PAC-SB1</td>
<td>Integer 32 Literal</td>
<td>Float Literal</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

Note: * Not intended for use with these brains, because they don’t have
** Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).

Action Block Example:

```
Set I/O Unit Scratch Pad Float Element

Argument Name | Type | Name
--------------|------|------
I/O Unit      | SNAP-PAC-SB1 | PAC_SB
Index         | Integer 32 Literal | 26
From          | Float Literal | 1.2
Put Status in | Integer 32 Variable | Status
```

OptoScript Example:

```
SetIoUnitScratchPadFloatElement(I/O Unit, Index, From)
Status = SetIoUnitScratchPadFloatElement(PAC_SB, 26, 1.2);
```

This is a function command; it returns one of the status codes listed below.
Notes:

- To write more than one float value to the Scratch Pad area in a single command, use Set I/O Unit Scratch Pad Float Table.
- The I/O unit Scratch Pad area is for general-purpose use and is accessible to any network device (for example, another PAC R-series I/O unit or an application running on a PC) that can connect to the I/O unit’s command processor port (usually port 2001). Be aware of all devices that have access to the area, and make sure that their reads and writes are synchronized so that correct data is available to all devices when needed.
- Since this command accesses a table on an I/O unit, it requires communication to that unit, so it will take more time than just moving data between tables in a strategy.

Status Codes:

0 = success
-12 = Invalid table index value. Index was negative or greater than the table size.
-43 = Received a NACK from the I/O unit.
-52 = Invalid connection—not opened. The connection may have been closed by a previous command that failed. Check status codes returned on other connection commands.
-58 = No data received. I/O unit may be turned off or unreachable.
-93 = I/O unit not enabled. Previous communication failure may have disabled communication to the unit automatically. Reenable communication to the unit and try again.

See Also:

- “Get I/O Unit Scratch Pad Float Element” on page 327
- “Set I/O Unit Scratch Pad Float Table” on page 343
- “Set I/O Unit Scratch Pad Integer 32 Element” on page 345
- “Set I/O Unit Scratch Pad Integer 32 Table” on page 347
- “Set I/O Unit Scratch Pad String Element” on page 349
- “Set I/O Unit Scratch Pad String Table” on page 351
- “Set I/O Unit Scratch Pad Bits from MOMO Mask” on page 339
Set I/O Unit Scratch Pad Float Table

I/O Unit—Scratch Pad Action

**Function:**  
To write a series of float values to the Scratch Pad area of a local or remote SNAP PAC R-series controller or SNAP PAC brain.

**Typical Use:**  
For peer-to-peer communication. Strategy variable data can be stored in the brain’s Scratch Pad area and retrieved by a peer on the network.

**Details:**
- To use this command with a SNAP PAC S-series or SoftPAC controller, create an I/O Unit of the type Generic OptoMMP Device with the loopback address (127.0.0.1).
- You can use this command to place variable data in the Scratch Pad area, and then use Get I/O Unit Scratch Pad Float Element or Get I/O Unit Scratch Pad Float Table to retrieve it.
- The float area of the Scratch Pad is a table containing 10,240 elements (index numbers 0–10,239).
- Enter the number of elements you want to set in the Scratch Pad area in Length (Argument 1), and the index number of the starting element in To Index (Argument 2).
- In From Index (Argument 3), enter the starting index of the table you are writing from. In From Table (Argument 4), enter the name of the table.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>I/O Unit</strong></td>
<td><strong>Length</strong></td>
<td><strong>To Index</strong></td>
</tr>
<tr>
<td>G4EB2</td>
<td>Integer 32 Literal</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Generic OptoMMP Device</td>
<td></td>
<td></td>
</tr>
<tr>
<td>GRV-EPIC-PR1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>GRV-R7-MM1001-10</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-B3000-ENET, SNAP-ENET-RTC*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-ENET-D64*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1-B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-ADS**</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-D64**</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-M64**</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* Not intended for use with these brains, because they don’t have the integer scratch pad area.
** Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).

<table>
<thead>
<tr>
<th>Argument 3</th>
<th>Argument 4</th>
<th>Argument 5</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>From Index</strong></td>
<td><strong>From Table</strong></td>
<td><strong>Put Status in</strong></td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Float Table</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>
CHAPTER 13: I/O UNIT - SCRATCH PAD COMMANDS

**Action Block Example:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Unit</td>
<td>SNAP-PAC-EB1</td>
<td>PAC_EB</td>
</tr>
<tr>
<td>Length</td>
<td>Integer 32 Literal</td>
<td>64</td>
</tr>
<tr>
<td>To Index</td>
<td>Integer 32 Literal</td>
<td>0</td>
</tr>
<tr>
<td>From Index</td>
<td>Integer 32 Literal</td>
<td>0</td>
</tr>
<tr>
<td>From Table</td>
<td>Float Table</td>
<td>MyFloatTable</td>
</tr>
<tr>
<td>Put Status in</td>
<td>Integer 32 Variable</td>
<td>Status</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

SetIoUnitScratchPadFloatTable(I/O Unit, Length, To Index, From Index, From Table)

Status = SetIoUnitScratchPadFloatTable(PAC_EB, 64, 0, 0, MyFloatTable);

This is a function command; it returns one of the status codes listed below.

**Notes:**
- To write a single float value to the Scratch Pad area, use Set I/O Unit Scratch Pad Float Element.
- The I/O unit Scratch Pad area is for general-purpose use and is accessible to any network device (for example, another PAC R-series I/O unit or an application running on a PC) that can connect to the I/O unit’s command processor port (usually port 2001). Be aware of all devices that have access to the area, and make sure that their reads and writes are synchronized so that correct data is available to all devices when needed.
- Since this command accesses a table on an I/O unit, it requires communication to that unit, so it will take more time than just moving data between tables in a strategy.

**Status Codes:**
- 0 = success
- -3 = Invalid length. Length (Argument 2) is less than 0 or greater than 3072.
- -12 = Invalid table index value. Index was negative or greater than the table size.
- -43 = Received a NACK from the I/O unit.
- -52 = Invalid connection—not opened. The connection may have been closed by a previous command that failed. Check status codes returned on other connection commands.
- -58 = No data received. I/O unit may be turned off or unreachable.
- -93 = I/O unit not enabled. Previous communication failure may have disabled communication to the unit automatically. Reenable communication to the unit and try again.

**See Also:**
- “Get I/O Unit Scratch Pad Float Table” on page 329
- “Set I/O Unit Scratch Pad Float Element” on page 341
- “Set I/O Unit Scratch Pad Bits from MOMO Mask” on page 339
- “Set I/O Unit Scratch Pad Integer 32 Element” on page 345
- “Set I/O Unit Scratch Pad Integer 32 Table” on page 347
- “Set I/O Unit Scratch Pad String Element” on page 349
- “Set I/O Unit Scratch Pad String Table” on page 351
**Set I/O Unit Scratch Pad Integer 32 Element**

**I/O Unit—Scratch Pad Action**

**Function:**
To write an integer 32 to the Scratch Pad area of a local or remote SNAP PAC R-series controller or SNAP PAC brain.

**Typical Use:**
For peer-to-peer communication. Strategy variable data can be stored in the brain’s Scratch Pad area and retrieved by a peer on the network.

**Details:**
- To use this command with a SNAP PAC S-series or SoftPAC controller, create an I/O Unit of the type Generic OptoMMP Device with the loopback address (127.0.0.1).
- You can use this command to store the variable data in the Scratch Pad area, and then use Get I/O Unit Scratch Pad Integer 32 Element to retrieve it.
- The integer 32 area of the Scratch Pad is a table containing 10,240 elements (index numbers 0–10,239). Enter the index number of the element you want to set in `Index` (Argument 1).

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Unit</td>
<td>Index</td>
<td>From</td>
</tr>
<tr>
<td>SNAP-PAC-SB1</td>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td>SNAP-PAC-SB2</td>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

* Not intended for use with these brains, because they don’t have the integer scratch pad area.

**Action Block Example:**

```
SetI0UnitScratchPadInt32Element(I/O Unit, Index, From)
```

```
Status = SetI0UnitScratchPadInt32Element(PAC_SB, 26, 99);
```

This is a function command; it returns one of the status codes listed below.
Notes:

- To write more than one integer 32 value to the Scratch Pad area in a single command, use Set I/O Unit Scratch Pad Integer 32 Table.
- The I/O unit Scratch Pad area is for general-purpose use and is accessible to any network device (for example, another PAC R-series I/O unit or an application running on a PC) that can connect to the I/O unit’s command processor port (usually port 2001). Be aware of all devices that have access to the area, and make sure that their reads and writes are synchronized so that correct data is available to all devices when needed.
- Since this command accesses a table on an I/O unit, it requires communication to that unit, so it will take more time than just moving data between tables in a strategy.

Status Codes:

0 = success
-12 = Invalid table index value. Index was negative or greater than the table size.
-43 = Received a NACK from the I/O unit.
-52 = Invalid connection—not opened. The connection may have been closed by a previous command that failed. Check status codes returned on other connection commands.
-58 = No data received. I/O unit may be turned off or unreachable.
-93 = I/O unit not enabled. Previous communication failure may have disabled communication to the unit automatically. Reenable communication to the unit and try again.

See Also:

“Get I/O Unit Scratch Pad Integer 32 Element” on page 331
“Set I/O Unit Scratch Pad Integer 32 Table” on page 347
“Set I/O Unit Scratch Pad Float Element” on page 341
“Set I/O Unit Scratch Pad Float Table” on page 343
“Set I/O Unit Scratch Pad String Element” on page 349
“Set I/O Unit Scratch Pad String Table” on page 351
“Set I/O Unit Scratch Pad Bits from MOMO Mask” on page 339
Set I/O Unit Scratch Pad Integer 32 Table

I/O Unit—Scratch Pad Action

Function: To write a series of integer 32 values to the Scratch Pad area of a local or remote SNAP PAC R-series controller or SNAP PAC brain.

Typical Use: For peer-to-peer communication. Strategy variable data can be stored in the brain’s Scratch Pad area and retrieved by a peer on the network.

Details:
- To use this command with a SNAP PAC S-series or SoftPAC controller, create an I/O Unit of the type Generic OptoMMP Device with the loopback address (127.0.0.1).
- You can use this command to store the variable data in the Scratch Pad area, and then use Get I/O Unit Scratch Pad Integer 32 Element or Get I/O Unit Scratch Pad Integer 32 Table to retrieve it.
- The integer 32 area of the Scratch Pad is a table containing 10,240 elements (index numbers 0–10,239). Enter the number of elements you want to set in Length (Argument 1), and the index number of the starting element in To Index (Argument 2).

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>I/O Unit</strong></td>
<td><strong>Length</strong></td>
<td><strong>To Index</strong></td>
</tr>
<tr>
<td>G4EB2</td>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td>Generic OptoMMP Device</td>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>GRV-EPIC-PR1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>GRV-R7-MM1001-10</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-B3000-ENET, SNAP-ENET-RTC*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-ENET-D64*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1-B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-ADS**</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-D64**</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-M64**</td>
<td></td>
<td></td>
</tr>
<tr>
<td>* Not intended for use with these brains, because they don’t have the integer scratch pad area.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>** Available only when Legacy products are enabled (File &gt; Strategy Options &gt; Legacy tab &gt; Ethernet, Ultimate, and Simple I/O units).</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Argument 3</th>
<th>Argument 4</th>
<th>Argument 5</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>From Index</strong></td>
<td><strong>From Table</strong></td>
<td><strong>Put Status in</strong></td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Table</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Action Block Example:

<table>
<thead>
<tr>
<th>Set I/O Unit Scratch Pad Integer 32 Table</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Argument Name</strong></td>
</tr>
<tr>
<td>I/O Unit</td>
</tr>
<tr>
<td>Length</td>
</tr>
<tr>
<td>To Index</td>
</tr>
<tr>
<td>From Index</td>
</tr>
<tr>
<td>From Table</td>
</tr>
<tr>
<td>Put Status in</td>
</tr>
</tbody>
</table>
OptoScript Example:  
**SetIoUnitScratchPadInt32Table** (*I/O Unit, Length, To Index, From Index, From Table*)

Status = SetIoUnitScratchPadInt32Table(PAC_SB, 64, 0, 0, MyInt32Table);

This is a function command; it returns one of the status codes listed below.

**Notes:**
- To write a single integer 32 value to the Scratch Pad area, use **Set I/O Unit Scratch Pad Integer 32 Element**.
- The I/O unit Scratch Pad area is for general-purpose use and is accessible to any network device (for example, another PAC R-series I/O unit or an application running on a PC) that can connect to the I/O unit’s command processor port (usually port 2001). Be aware of all devices that have access to the area, and make sure that their reads and writes are synchronized so that correct data is available to all devices when needed.
- Since this command accesses a table on an I/O unit, it requires communication to that unit, so it will take more time than just moving data between tables in a strategy.
- See “I/O Unit—Scratch Pad Commands” in the *PAC Control User’s Guide* (form 1700).

**Status Codes:**
- **0** = success
- **-3** = Invalid length. *Length* (Argument 2) is less than 0 or greater than 3072.
- **-12** = Invalid table index value. Index was negative or greater than the table size.
- **-43** = Received a NACK from the I/O unit.
- **-52** = Invalid connection—not opened. The connection may have been closed by a previous command that failed. Check status codes returned on other connection commands.
- **-58** = No data received. I/O unit may be turned off or unreachable.
- **-93** = I/O unit not enabled. Previous communication failure may have disabled communication to the unit automatically. Reenable communication to the unit and try again.

**See Also:**
- “Get I/O Unit Scratch Pad Integer 32 Table” on page 333
- “Set I/O Unit Scratch Pad Integer 32 Element” on page 345
- “Set I/O Unit Scratch Pad Float Element” on page 341
- “Set I/O Unit Scratch Pad Float Table” on page 343
- “Set I/O Unit Scratch Pad String Element” on page 349
- “Set I/O Unit Scratch Pad String Table” on page 351
- “Set I/O Unit Scratch Pad Bits from MOMO Mask” on page 339
Set I/O Unit Scratch Pad String Element

I/O Unit—Scratch Pad Action

**Function:** To write a string to the Scratch Pad area of a local or remote SNAP PAC R-series controller or SNAP PAC brain.

**Typical Use:** For peer-to-peer communication. Strategy variable data can be stored in the brain’s Scratch Pad area and retrieved by a peer on the network.

**Details:**
- To use this command with a SNAP PAC S-series or SoftPAC controller, create an I/O Unit of the type Generic OptoMMP Device with the loopback address (127.0.0.1).
- You can use this command to store the variable data in the Scratch Pad area, and then use Get I/O Unit Scratch Pad String Element to retrieve it.
- The string area of the Scratch Pad is a table containing 64 elements (index numbers 0–63). Enter the index number of the element you want to set in `Index` (Argument 1).
- Each string element can hold 128 characters or 128 bytes of binary data.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
<th>Argument 3</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>I/O Unit</strong></td>
<td><strong>Index</strong></td>
<td><strong>From</strong></td>
<td><strong>Put Status in</strong></td>
</tr>
<tr>
<td>G4EB2</td>
<td>Integer 32 Literal</td>
<td>String Literal</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Generic OptoMMP Device</td>
<td>Integer 32 Variable</td>
<td>String Variable</td>
<td></td>
</tr>
<tr>
<td>GRV-EPIC-PR1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GRV-R7-MM1001-10</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-B3000-ENET, SNAP-ENET-RTC*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-ENET-D64*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1-B</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-ADS**</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-D64**</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-M64**</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* Not intended for use with these brains, because they don’t have the integer scratch pad area.

**OptoScript Example:**

```optoscript
Status = SetIoUnitScratchPadStringElement(PAC_EB, 26, MyStringVar);
```
This is a function command; it returns one of the status codes listed below.

**Notes:**
- To write more than one string value to the Scratch Pad area in a single command, use **Set I/O Unit Scratch Pad String Table**.
- The I/O unit Scratch Pad area is for general-purpose use and is accessible to any network device (for example, another PAC R-series I/O unit or an application running on a PC) that can connect to the I/O unit’s command processor port (usually port 2001). Be aware of all devices that have access to the area, and make sure that their reads and writes are synchronized so that correct data is available to all devices when needed.
- Since this command accesses a table on an I/O unit, it requires communication to that unit, so it will take more time than just moving data between tables in a strategy.
- See “I/O Unit—Scratch Pad Commands” in the **PAC Control User’s Guide** (form 1700).

**Status Codes:**
- **0** = success
- **-12** = Invalid table index value. Index was negative or greater than the table size.
- **-43** = Received a NACK from the I/O unit.
- **-52** = Invalid connection—not opened. The connection may have been closed by a previous command that failed. Check status codes returned on other connection commands.
- **-58** = No data received. I/O unit may be turned off or unreachable.
- **-93** = I/O unit not enabled. Previous communication failure may have disabled communication to the unit automatically. Reenable communication to the unit and try again.

**See Also:**
- "Get I/O Unit Scratch Pad String Element" on page 335
- "Set I/O Unit Scratch Pad String Table" on page 351
- "Set I/O Unit Scratch Pad Float Element" on page 341
- "Set I/O Unit Scratch Pad Float Table" on page 343
- "Set I/O Unit Scratch Pad Integer 32 Element" on page 345
- "Set I/O Unit Scratch Pad Integer 32 Table" on page 347
- "Set I/O Unit Scratch Pad Bits from MOMO Mask" on page 339
### Set I/O Unit Scratch Pad String Table

**I/O Unit—Scratch Pad Action**

**Function:**
To write series of strings to the Scratch Pad area of a local or remote SNAP PAC R-series controller or SNAP PAC brain.

**Typical Use:**
For peer-to-peer communication. Strategy variable data can be stored in the brain’s Scratch Pad area and retrieved by a peer on the network.

**Details:**
- To use this command with a SNAP PAC S-series or SoftPAC controller, create an I/O Unit of the type Generic OptoMMP Device with the loopback address (127.0.0.1).
- You can use this command to store the variable data in the Scratch Pad area, and then use Get I/O Unit Scratch Pad String Table to retrieve it.
- The string area of the Scratch Pad is a table containing 64 elements (index numbers 0–63). Enter the number of elements you want to set in \textit{Length} (Argument 1), and the index number of the starting element in \textit{To Index} (Argument 2).
- Each string element can hold 128 characters or 128 bytes of binary data.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Unit</td>
<td>\textit{Length}</td>
<td>\textit{To Index}</td>
</tr>
<tr>
<td>G4EB2</td>
<td>Integer 32 Literal</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Generic OptoMMP Device</td>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>GRV-EPIC-PR1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>GRV-R7-MM1001-10</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-B3000-ENET, SNAP-ENET-RTC*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-ENET-D64*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1-B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-ADS**</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-D64**</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-M64**</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* \textit{Not intended for use with these brains}, because they don’t have the integer scratch pad area.

**Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).**

<table>
<thead>
<tr>
<th>Argument 3</th>
<th>Argument 4</th>
<th>Argument 5</th>
</tr>
</thead>
<tbody>
<tr>
<td>\textit{From Index}</td>
<td>\textit{From Table}</td>
<td>\textit{Put Status in}</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>String Table</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
CHAPTER 13: I/O UNIT — SCRATCH PAD COMMANDS

Action Block Example:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Unit</td>
<td>GRV-EPIC-PR1</td>
<td>PR1</td>
</tr>
<tr>
<td>Length</td>
<td>Integer 32 Literal</td>
<td>8</td>
</tr>
<tr>
<td>To Index</td>
<td>Integer 32 Literal</td>
<td>0</td>
</tr>
<tr>
<td>From Index</td>
<td>Integer 32 Literal</td>
<td>0</td>
</tr>
<tr>
<td>From Table</td>
<td>String Table</td>
<td>MyStringTable</td>
</tr>
<tr>
<td>Put Status in</td>
<td>Integer 32 Variable</td>
<td>Status</td>
</tr>
</tbody>
</table>

OptoScript Example: `SetIoUnitScratchPadStringTable(I/O Unit, Length, To Index, From Index, From Table)`

Status = SetIoUnitScratchPadStringTable(PR1, 8, 0, 0, MyStringTable);

This is a function command; it returns one of the status codes listed below.

Notes:
- To write a single string value to the Scratch Pad area, use `Set I/O Unit Scratch Pad String Element`.
- The I/O unit Scratch Pad area is for general-purpose use and is accessible to any network device (for example, another PAC R-series I/O unit or an application running on a PC) that can connect to the I/O unit's command processor port (usually port 2001). Be aware of all devices that have access to the area, and make sure that their reads and writes are synchronized so that correct data is available to all devices when needed.
- Since this command accesses a table on an I/O unit, it requires communication to that unit, so it will take more time than just moving data between tables in a strategy.

Status Codes:
- 0 = success
- -3 = Invalid length. Length (Argument 2) is less than 0 or greater than 63.
- -12 = Invalid table index value. Index was negative or greater than the table size.
- -43 = Received a NACK from the I/O unit.
- -52 = Invalid connection—not opened. The connection may have been closed by a previous command that failed. Check status codes returned on other connection commands.
- -58 = No data received. I/O unit may be turned off or unreachable.
- -93 = I/O unit not enabled. Previous communication failure may have disabled communication to the unit automatically. Reenable communication to the unit and try again.

See Also:
- “Get I/O Unit Scratch Pad String Table” on page 337
- “Set I/O Unit Scratch Pad String Element” on page 349
- “Set I/O Unit Scratch Pad Float Element” on page 341
- “Set I/O Unit Scratch Pad Float Table” on page 343
- “Set I/O Unit Scratch Pad Integer 32 Element” on page 345
- “Set I/O Unit Scratch Pad Integer 32 Table” on page 347
- “Set I/O Unit Scratch Pad Bits from MOMO Mask” on page 339
14: Logical Commands

AND

Logical Action

Function: To perform a logical AND on any two allowable values.

Typical Use: To determine if each of a pair of values is non-zero (True).

Details:

- Performs a logical AND on the value of Argument 0 and the value of With (Argument 1), and then stores either a non-zero value (meaning True) or a 0 (meaning False) in Put Result in (Argument 2).
  - If neither Argument 0 nor With are 0 (zero), Put Result in will be a non-zero value (meaning True).
  - Otherwise, the result will be 0 (zero, meaning False).

  NOTE: In programming logic, 0 represents False and any non-zero number represents True.

- The result can be sent directly to a digital output if desired.

Examples:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>With</th>
<th>Put Result in</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>67</td>
<td>-32</td>
<td>1</td>
</tr>
<tr>
<td>0</td>
<td>60</td>
<td>0</td>
</tr>
<tr>
<td>46</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

Arguments:

Argument 0
- [Value]
  - Digital Input
  - Digital Output
  - Float Literal
  - Float Variable
  - Integer 32 Literal
  - Integer 32 Variable
  - Integer 64 Literal
  - Integer 64 Variable

Argument 1
- With
  - Digital Input
  - Digital Output
  - Float Literal
  - Float Variable
  - Integer 32 Literal
  - Integer 32 Variable
  - Integer 64 Literal
  - Integer 64 Variable

Argument 2
- Put Result in
  - Digital Output
  - Float Variable
  - Integer 32 Variable
  - Integer 64 Variable
**AND**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>(none)</td>
<td>Digital Input</td>
<td>Limit_Switch1</td>
</tr>
<tr>
<td>With</td>
<td>Digital Input</td>
<td>Limit_Switch2</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Integer Variable</td>
<td>Both_Switches_Closed</td>
</tr>
</tbody>
</table>

OptoScript doesn’t use a command; the function is built in. Use the `and` operator.

*Both_Switches_Closed = Limit_Switch1 and Limit_Switch2;*

**Notes:**
- The example shown is only one of many ways to use the `and` operator. For more information, see “Logical Commands” and “Using OptoScript” in the PAC Control User’s Guide (form 1700).
- It is advisable to use only integers or digital points with this command.
- In OptoScript code, you can combine logical operators and AND multiple variables, for example: \( x = a \) and \( b \) and \( c \) and \( d \);
- In standard PAC Control code, to AND multiple variables (such as \( A, B, C, \) and \( D \)) into one variable (such as \( \text{ANSWER} \)), do the following:
  1. AND \( A \) with \( B \), Put Result in \( \text{ANSWER} \).
  2. AND \( C \) with \( \text{ANSWER} \), Put Result in \( \text{ANSWER} \).
  3. AND \( D \) with \( \text{ANSWER} \), Put Result in \( \text{ANSWER} \).
- To test for individual bits, use `Bit Test` or `Bit AND`.

**See Also:**
- “Bit Test” on page 379
- “Bit AND” on page 357
- “AND?” on page 355
CHAPTER 14: LOGICAL COMMANDS

AND?

Logical Condition

Function: To perform a logical AND? on any two allowable values.

Typical Use: Used in place of calling Variable True? twice.

Details: • Performs a logical AND? on the value of Is (Argument 0) and the value of Argument 1.
  – If neither Is nor Argument 1 are 0 (zero), the logic will take the True path.
  – Otherwise, the logic will take the False path.
  NOTE: In programming logic, 0 represents False and any non-zero number represents True.
• The result can be sent directly to a digital output if desired.

Examples:

<table>
<thead>
<tr>
<th>Is</th>
<th>Argument 1</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>True</td>
</tr>
<tr>
<td>67</td>
<td>-32</td>
<td>True</td>
</tr>
<tr>
<td>0</td>
<td>60</td>
<td>False</td>
</tr>
<tr>
<td>46</td>
<td>0</td>
<td>False</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>False</td>
</tr>
</tbody>
</table>

Arguments: Argument 0 Is Digital Input Digital Output Float Literal Float Variable Integer 32 Literal Integer 32 Variable Integer 64 Literal Integer 64 Variable [Value]

Condition Block Example:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is</td>
<td>Digital Input</td>
<td>Limit_Switch1</td>
</tr>
<tr>
<td>(none)</td>
<td>Digital Input</td>
<td>Limit_Switch2</td>
</tr>
</tbody>
</table>

OptoScript Example: OptoScript doesn’t use a command; the function is built in. Use the and operator.

if (Limit_Switch1 and Limit_Switch2) then

Notes: • The example shown is only one of many ways to use the and operator. For more information, see “Logical Commands” and “Using OptoScript” in the PAC Control User’s Guide (form 1700).
• It is advisable to use only integers or digital points with this command.
• In OptoScript code, you can combine logical operators and AND multiple variables, for example: if (a and b and c and d) then
• In standard PAC Control code, multiple values can be ANDed by repeating this condition or the Variable True condition several times in the same block.
• Use Bit AND if the objective is to test for individual bits.
• Executes faster than using Variable True twice.

See Also:
- "Bit AND?" on page 359
- "Variable True?" on page 440
- "Variable False?" on page 439
Bit AND

Logical Action

Function: To perform a bitwise AND on any two allowable values.

Typical Use: To clear one or more bits as specified by a mask. Bits set to 0 (zero) will clear.

Details:
- Performs a bitwise AND on the value of Argument 0 and With (Argument 1), and then stores the result in Put Result in (Argument 2).
- Note that With is the mask for selecting specific bits in Argument 0.
- Acts on all bits.

Examples:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>With</th>
<th>Put Result in</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>8</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>8</td>
<td>0</td>
</tr>
<tr>
<td>8</td>
<td>8</td>
<td>8</td>
</tr>
</tbody>
</table>

Arguments:
- **Argument 0**: Value
  - Integer 32 Literal
  - Integer 32 Variable
  - Integer 64 Literal
  - Integer 64 Variable

- **Argument 1**: With
  - Integer 32 Literal
  - Integer 32 Variable
  - Integer 64 Literal
  - Integer 64 Variable

- **Argument 2**: Put Result in
  - Digital Output
  - Integer 32 Variable
  - Integer 64 Variable

Action Block Example:
This example copies the four least significant bits from VALUE to RESULT and sets all remaining bits in RESULT to zero.

**Bit AND**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>(none)</td>
<td>Integer 32 Variable</td>
<td>VALUE</td>
</tr>
<tr>
<td>With</td>
<td>Integer 32 Literal</td>
<td>15</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Integer 32 Variable</td>
<td>RESULT</td>
</tr>
</tbody>
</table>

OptoScript Example:
OptoScript doesn’t use a command; the function is built in. Use the `bitand` operator.

```
RESULT = VALUE bitand 15;
```

Note that for this command, I/O units cannot be used the same way as in the standard command. However, you can accomplish the same thing using OptoScript code. The following example ANDs the bits from two variables, and then writes the inverted result to an I/O unit:

```
SetDigital64IoUnitFromMomo(nnTemp1 bitand nnTemp2, bitnot (nnTemp1 bitand nnTemp2), Dig_IO_Unit);
```

This example moves a value from an I/O unit, ANDs the bits with a variable, and then writes the inverted result to the same I/O unit:

```
nnTemp1 = GetIoUnitAsBinaryValue(Dig_IO_Unit);
nnTemp1 = nnTemp1 bitand nnVariable;
SetDigital64IoUnitFromMomo(nnTemp1, bitnot nnTemp1, Dig_IO_Unit);
```
Notes:

- For more information, see “Logical Commands” and “Using OptoScript” in the *PAC Control User’s Guide* (form 1700).
- To clear bits in Argument 0, set a zero for each bit to clear in the mask (all remaining bits must be 1), and then make the value of Argument 0 and *Put Result in* (Argument 2) the same.
- You may prefer to set a 1 for each bit to clear in the mask, and then use *Bit NOT* to invert all bits.
- Use 255 as the mask to keep the lower eight bits.
- To clear only one bit, use *Bit Clear*.
- To test for non-zero values, use *AND*.

See Also:

- “Bit Clear” on page 361
- “Bit NOT” on page 364
- “AND” on page 353
- “AND?” on page 355
- “Bit AND?” on page 359
**Bit AND?**

**Logical Condition**

**Function:** To perform a bitwise AND? on any two allowable values.

**Typical Use:** To determine if the individual bits of one value match the On bits of a mask value.

**Details:**
- Performs a bitwise AND? on Is (Argument 0) and Argument 1 (the mask).
  - If any bit set to 1 in Argument 1 is also set to 1 in Is, the logic will take the True path.
  - If any bit set to 1 in Argument 1 is not set to 1 in Is, the logic will take the False path.
- Acts on all bits.

**Examples:**

<table>
<thead>
<tr>
<th>Is</th>
<th>Argument 1</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>True</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>False</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>False</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>False</td>
</tr>
</tbody>
</table>

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is</td>
<td>[Value]</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Integer 64 Literal</td>
<td>Integer 64 Literal</td>
</tr>
<tr>
<td>Integer 64 Variable</td>
<td>Integer 64 Variable</td>
</tr>
</tbody>
</table>

**Condition Block Example:**
This example performs a bitwise AND? on the variable nMask with the constant 33,280 (1000 0010 0000 0000 binary). In this example, if either bit 15 or 9 is on, the logic takes the True path. Otherwise, the logic takes the False path.

**OptoScript Example:**
OptoScript doesn’t use a command; the function is built in. Use the `bitand` operator.

**Notes:**
- For more information, see “Logical Commands” and “Using OptoScript” in the PAC Control User’s Guide (form 1700).
- Use 255 as the constant to check the lower eight points.

**See Also:**
- “AND?” on page 355
- “Bit OR?” on page 374
**Bit Change**

**Logical Action**

**Function:** Change a bit based on a true/false control variable.

**Typical Use:** Useful for selection and deselection logic.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set flag</td>
<td>Integer 32 Variable</td>
<td>SET_FLAG</td>
</tr>
<tr>
<td>Bit to Change</td>
<td>Integer 32 Variable</td>
<td>Bit</td>
</tr>
<tr>
<td>Output</td>
<td>Integer 32 Variable</td>
<td>Output_Value</td>
</tr>
</tbody>
</table>

**Action Block Example:**

```
BitChange(Set flag, Bit to Change, Output)
```

```
BitChange(SE_SFLAG, Bit, Output_Value);
```

This is a procedure command; it does not return a value.
Bit Clear

Logical Action

Function: To clear a specified bit (set it to zero) in an allowable value.

Typical Use: To clear one bit of a particular integer variable.

Details:
- Performs this action on a copy of the value of Argument 0, and then moves the copy to Put Result in (Argument 2).
- For integer 32 variables, the valid range for the bit to clear is 0–31. For SNAP digital 64 I/O units and integer 64 variables, the valid range is 0–63.
- Note that the types for Bit to Clear (Argument 1) are 32-bit integers, because an integer 32 provides enough range to handle either a 32-bit or a 64-bit number.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Value]</td>
<td>Bit to Clear</td>
<td>Put Result in</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Literal</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Integer 64 Variable</td>
<td>Integer 32 Variable</td>
<td>Integer 64 Variable</td>
</tr>
</tbody>
</table>

Action Block Example:

This example does a binary read of the variable nMask, clears bit 0, and does a binary write of the data back out to nMask.

```
Bit Clear
```

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argument 0</td>
<td>Integer 32 Variable</td>
<td>nMask</td>
</tr>
<tr>
<td>Bit to Clear</td>
<td>Integer 32 Literal</td>
<td>0</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Integer 32 Variable</td>
<td>nMask</td>
</tr>
</tbody>
</table>

OptoScript Example:

```
BitClear(Argument 0, Bit to Clear)
nMask = BitClear(nMask, 0);
```

This is a function command; it returns the value with the specified bit cleared.

Notes:
- For more information, see “Logical Commands” and “Using OptoScript” in the PAC Control User’s Guide (form 1700).
- Although this command can be used to turn off digital points, it is primarily used to manipulate bits in an integer variable. These bits can be used as flags to carry information such as status, control, or fault (real-time or latch).
- To clear bits in Argument 0, make the value of Argument 0 and Put Result in (Argument 2) the same.
- To clear several bits at once, use Bit AND.

See Also:
- “Bit AND” on page 357
- “Bit Test” on page 379
- “Bit Set” on page 376
Bit Copy

Logical Action

Function: Atomically copy a bit from one variable or table element into another variable or table element.

Typical Use: To copy flag or status bits from one variable or table to another (or from variable to table or table to variable).

Details:
- The Source Index (Argument 0) and Destination Index (Argument 3) are only valid for table types. They will be ignored for integer types.
- The arguments are:
  - Source Index: If a table, the source element number
  - Source: Table or variable whose bit is going to be copied FROM
  - Bit to Read: The source bit (bit that we’re copying)
  - Destination Index: If a table, the destination element number
  - Destination: Table or variable whose bit is going to be copied TO
  - Bit to Set: The destination bit number (0 to 31 for Int32, 0 to 63 for Int64)
- Put Result in: See possible Status Codes listed below.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
<th>Argument 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source Index</td>
<td>Source</td>
<td>Bit to Read</td>
<td>Destination Index</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Float Variable</td>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Float Table</td>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Table</td>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Integer 64 Variable</td>
<td>Integer 64 Table</td>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Argument 4</th>
<th>Argument 5</th>
<th>Argument 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Destination</td>
<td>Bit to Set</td>
<td>Put Status in</td>
</tr>
<tr>
<td>Float Variable</td>
<td>Integer 32 Literal</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Float Table</td>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Table</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Integer 32 Table</td>
<td>Integer 64 Variable</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Integer 64 Variable</td>
<td>Integer 64 Table</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Integer 64 Table</td>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

Action Block Example:

```
<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source Index</td>
<td>Integer 32 Literal</td>
<td>10</td>
</tr>
<tr>
<td>Source</td>
<td>Integer 32 Table</td>
<td>arrnSrcTable</td>
</tr>
<tr>
<td>Bit to Read</td>
<td>Integer 32 Literal</td>
<td>6</td>
</tr>
<tr>
<td>Destination Index</td>
<td>Integer 32 Literal</td>
<td>5</td>
</tr>
<tr>
<td>Destination</td>
<td>Integer 32 Table</td>
<td>arrnDstTable</td>
</tr>
<tr>
<td>Bit to Set</td>
<td>Integer 32 Literal</td>
<td>1</td>
</tr>
<tr>
<td>Put Status in</td>
<td>Integer 32 Variable</td>
<td>nStatus</td>
</tr>
</tbody>
</table>
```

OptoScript Example:
```
BitCopy( Source Index, Source, Bit to Read, Destination Index, Destination, Bit to Set)
nStatus = BitCopy(10, arrnSrcTable, 6, 5, arrnDstTable, 1);
```

This is a function command; it atomically copies a bit from one variable or table element into another variable or table element and returns the status code for success (0) or one of the other status codes listed below.
returned value can be consumed by a variable (as shown) or used by an item such as a Condition block, an
OptoScript block, or a mathematical expression. For more information, see “Logical Commands” and “Using

**Status Codes:**

- **0** = Success.
- **-29** = Wrong object type.
- **-42** = Invalid limit. Bit to Set is out of range.
Bit NOT

Logical Action

**Function:** To invert all bits of a 32-bit or 64-bit value.

**Typical Use:** To invert bits.

**Details:**
- Inverts the value of Argument 0. For example:
  
  10100011110100011110010100001111
  Inverted, its value would be:
  01011100101110000110101111000

- Acts on all bits in the value.
- You can choose whether to leave the original value in Argument 0 and store the inverted value in `Put Result in` (Argument 1), or you can replace the original value with the inverted value.
  - To keep the original value in Argument 0, use the Name field to select different objects for Argument 0 and `Put Result in`.
  - To replace the original value with the inverted bits, select the same Name for Argument 0 and `Put Result in`.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>[Value]</strong></td>
<td><strong>Put Result in</strong></td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Digital Output</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Integer 64 Literal</td>
<td>Integer 64 Variable</td>
</tr>
<tr>
<td>Integer 64 Variable</td>
<td></td>
</tr>
</tbody>
</table>

**Action Block Example:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>(none)</td>
<td>Integer 32 Variable</td>
<td>DATA</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Integer 32 Variable</td>
<td>DATA</td>
</tr>
</tbody>
</table>
OptoScript doesn’t use a command; the function is built in. Use the `bitnot` operator.

**Example:**

```plaintext
DATA = bitnot DATA;
```

Note that for this command, I/O units cannot be used the same way as in the standard command. However, you can accomplish the same thing using OptoScript code. This example moves a value from an I/O unit, `bitnot`s the value, and writes the result to the same I/O unit:

```plaintext
nnTemp1 = GetIoUnitAsBinaryValue(Dig_IO_Unit);
SetDigital64IoUnitFromMomo(bitnot nnTemp1, nnTemp1, Dig_IO_Unit);
```

**Notes:**

- To clear one or more specific bits, use this command to invert a mask set with the bits to be cleared. Then, `Bit AND` the mask with the value to clear those bits.
  
  For example, suppose you want to clear bits 0, 1, and 2.

  ```plaintext
  Create a mask with those bits set: 0000 0111
  Do a `bitnot` on the mask, giving: 1111 1000
  `Bit AND` this value with the value to be cleared: 0110 1001
  Those bits are cleared: 0110 1000
  ```

- To toggle True/False, use `NOT`.

- For more information, see “Logical Commands” and “Using OptoScript” in the *PAC Control User’s Guide* (form 1700).

**See Also:**

- “NOT” on page 411
- “Bit XOR” on page 380
- “XOR” on page 443
- “Bit Set” on page 376
- “Bit NOT?” on page 366
Bit NOT?

Logical Condition

Function: To invert all 32 or 64 bits of an allowable value and determine if the result is True or False.

Typical Use: To determine if any bit is off.

Details:
- Evaluates the value of /Is (Argument 0), and inverts its binary equivalent.
  - If any bit in /Is is 0 (zero, meaning False or off), the logic will take the True path.
  - If any bit in /Is is 1 (meaning True or on), the logic will take the False path.
- Acts on all bits.

Examples:

<table>
<thead>
<tr>
<th>Data type and value of /Is</th>
<th>Is, converted to binary</th>
<th>Inverted</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>decimal -1</td>
<td>1111 1111 1111 1111 1111 1111 1111 1111 1111 1111</td>
<td>0</td>
<td>True</td>
</tr>
<tr>
<td>hex 14A</td>
<td>0001 0100 1010</td>
<td></td>
<td>True</td>
</tr>
<tr>
<td>decimal 0</td>
<td>0</td>
<td>1111 1111 1111 1111 1111 1111 1111 1111 1111 1111</td>
<td>False</td>
</tr>
</tbody>
</table>

Bits are numbered from right to left, starting at 0.

Arguments:
- **Argument 0**
  - /Is

Condition Block Example:
This example reads the bits of nMask, and then inverts them. If any bit is 0 (zero, off) the logic will take the True path. Otherwise, the logic will take the False path.

<table>
<thead>
<tr>
<th>Bit NOT?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argument Name</td>
</tr>
<tr>
<td>/Is</td>
</tr>
</tbody>
</table>

OptoScript Example:
OptoScript doesn’t use a command; the function is built in. Use the bitnot operator.

Notes:
- For more information, see “Logical Commands” and “Using OptoScript” in the PAC Control User’s Guide (form 1700).
- Use NOT if the objective is to toggle the value between True and False.
See Also:  
“Bit On?” on page 371  
“Bit Off?” on page 369
Bit Off in Numeric Table Element?

Logical Condition

Function: To test the False status of a specific bit in an allowable value in a numeric table.

Typical Use: To test a bit used as a flag in an integer element in a numeric table.

Details: • Evaluates the specified bit (Bit, Argument 2) in the value located in the specified table (Of Table, Argument 1) and index (At Index, Argument 0).
  − If the bit is 0 (zero, meaning False or off), the logic will take the True path.
  − If the bit is 1 (meaning True or on), the logic will take the False path.
• Note that Bit is a 32-bit integer because the top of the valid range is 63.

Examples:

<table>
<thead>
<tr>
<th>Data type and value in Of Table[At Index]</th>
<th>Value converted to binary</th>
<th>Bit</th>
<th>Result1</th>
</tr>
</thead>
<tbody>
<tr>
<td>decimal 195</td>
<td>1100 0011</td>
<td>2</td>
<td>True</td>
</tr>
<tr>
<td>hex 20</td>
<td>0010 0000</td>
<td>2</td>
<td>True</td>
</tr>
<tr>
<td>decimal 114</td>
<td>0111 0010</td>
<td>1</td>
<td>False</td>
</tr>
<tr>
<td>hex 14A</td>
<td>0001 0100 1010</td>
<td>1</td>
<td>False</td>
</tr>
</tbody>
</table>

1Bits are numbered from right to left, starting at 0.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>At Index</td>
<td>Of Table</td>
<td>Bit</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Table</td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 64 Table</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

Condition Block Example: This example evaluates to True if point 15 of I/O UNIT 1 is off, False otherwise.

OptoScript Example: `IsBitOffInNumTableElement (At Index, Of Table, Bit)`

if (IsBitOffInNumTableElement(TABLE_INDEX, NUMERIC_TABLE_1, 15) then

This is a function command; it returns a value of true (non-zero) or false (0). The returned value can be consumed by a control structure (as in the example shown) or by a variable, I/O point, and so forth. For more information, see “Logical Commands” and “Using OptoScript” in the PAC Control User’s Guide (form 1700).

See Also: "Bit On in Numeric Table Element?" on page 370
Bit Off?

Logical Condition

**Function:** To test the False status of a specific bit in an allowable value.

**Typical Use:** To test a bit used as a flag in an integer variable.

**Details:**
- Evaluates the bit specified in `Bit` (Argument 1) in the value of `In` (Argument 0).
  - If the bit in `In` is 0 (zero, meaning False or off), the logic will take the True path.
  - If the bit in `In` is 1 (meaning True or on), the logic will take the False path.
- Note that `Bit` is a 32-bit integer because the top of the valid range is 63.

**Examples:**

<table>
<thead>
<tr>
<th>Data type and value of <code>In</code></th>
<th>In, converted to binary</th>
<th><code>Bit</code></th>
<th>Result1</th>
</tr>
</thead>
<tbody>
<tr>
<td>decimal 195</td>
<td>1100 0011</td>
<td>2</td>
<td>True</td>
</tr>
<tr>
<td>hex 20</td>
<td>0010 0000</td>
<td>2</td>
<td>True</td>
</tr>
<tr>
<td>decimal 114</td>
<td>0111 0010</td>
<td>1</td>
<td>False</td>
</tr>
<tr>
<td>hex 14A</td>
<td>0001 0100 1010</td>
<td>1</td>
<td>False</td>
</tr>
</tbody>
</table>

*Bits are numbered from right to left, starting at 0.*

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>In</code></td>
<td><code>Bit</code></td>
</tr>
</tbody>
</table>

- `In`: Integer 32 Variable
- `Bit`: Integer 32 Literal
- Integer 64 Variable
- Integer 32 Variable

**Condition Block Example:** In this example, if bit 15 of `nMask` is off, the logic will take the True path. Otherwise, the logic will take the False path.

<table>
<thead>
<tr>
<th>Bit Off</th>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>In</td>
<td>Integer 32 Variable</td>
<td><code>nMask</code></td>
<td></td>
</tr>
<tr>
<td>Bit</td>
<td>Integer 32 Literal</td>
<td>15</td>
<td></td>
</tr>
</tbody>
</table>

**OptoScript Example:** `IsBitOff(In, Bit)`

if (IsBitOff(nMask, 15) then

This is a function command; it returns a value of true (non-zero) or false (0). The returned value can be consumed by a control structure (as in the example shown) or by a variable, I/O point, and so forth. For more information, see “Logical Commands” and “Using OptoScript” in the *PAC Control User’s Guide* (form 1700).

**Notes:**
- Although this command can be used to determine the status of digital points, it is primarily used to test bits in an integer variable. These bits can be used as flags to carry information such as status, control, or fault (real-time or latch).
- Use `Bit AND?` if the objective is to test several bits at once.

**See Also:**
- “Bit On?” on page 371
- “Bit AND?” on page 359
- “Bit Test” on page 379
Bit On in Numeric Table Element?

Logical Condition

**Function:** To test the True status of a specific bit in an allowable value in a numeric table.

**Typical Use:** To test a bit used as a flag in an integer element in a numeric table.

**Details:**
- Evaluates the specified bit (Bit, Argument 2) in the value located in the specified table (Of Table, Argument 1) and index (At Index, Argument 0).
  - If the bit is 1 (meaning True or on), the logic will take the True path.
  - If the bit is 0 (zero, meaning False or off), the logic will take the False path.
- Note that Bit is a 32-bit integer because the top of the valid range is 63.

**Examples:**

<table>
<thead>
<tr>
<th>Data type and value in Of Table[At Index]</th>
<th>Value converted to binary</th>
<th>Bit</th>
<th>Result1</th>
</tr>
</thead>
<tbody>
<tr>
<td>decimal 114</td>
<td>0111 0010</td>
<td>1</td>
<td>True</td>
</tr>
<tr>
<td>hex 14A</td>
<td>0001 0100 1010</td>
<td>1</td>
<td>True</td>
</tr>
<tr>
<td>decimal 195</td>
<td>1100 0011</td>
<td>2</td>
<td>False</td>
</tr>
<tr>
<td>hex 20</td>
<td>0010 0000</td>
<td>2</td>
<td>False</td>
</tr>
</tbody>
</table>

1Bits are numbered from right to left, starting at 0.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argument 0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>At Index</td>
<td>Integer 32 Literal</td>
<td>TABLE_INDEX</td>
</tr>
<tr>
<td></td>
<td>Integer 32 Variable</td>
<td>NUMERIC_TABLE_1</td>
</tr>
<tr>
<td>Argument 1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Of Table</td>
<td>Integer 32 Table</td>
<td>TABLE_INDEX</td>
</tr>
<tr>
<td></td>
<td>Integer 64 Table</td>
<td>NUMERIC_TABLE_1</td>
</tr>
<tr>
<td>Argument 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bit</td>
<td>Integer 32 Literal</td>
<td>TABLE_INDEX</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```opto
if (IsBitOnInNumTableElement(TABLE_INDEX, NUMERIC_TABLE_1, 0) then
```

This is a function command; it returns a value of true (non-zero) or false (0). The returned value can be consumed by a control structure (as in the example shown) or by a variable, I/O point, and so forth. For more information, see “Logical Commands” and “Using OptoScript” in the PAC Control User’s Guide (form 1700).

**See Also:** “Bit Off in Numeric Table Element?” on page 368
**Bit On?**

**Logical Condition**

**Function:** To test the True status of a specific bit in an allowable value.

**Typical Use:** To test a bit used as a flag in an integer variable.

**Details:**
- Evaluates the bit specified in `Bit` (Argument 1) in the value of `In` (Argument 0).
  - If the bit in `In` is 1 (meaning True or on), the logic will take the True path.
  - If the bit in `In` is 0 (zero, meaning False or off), the logic will take the False path.
- Note that `Bit` is a 32-bit integer because the top of the valid range is 63.

**Examples:**

<table>
<thead>
<tr>
<th>Data type and value of <code>In</code></th>
<th>In, converted to binary</th>
<th><code>Bit</code></th>
<th>Result1</th>
</tr>
</thead>
<tbody>
<tr>
<td>decimal 114</td>
<td>0111 0010</td>
<td>1</td>
<td>True</td>
</tr>
<tr>
<td>hex 14A</td>
<td>0001 0100 1010</td>
<td>1</td>
<td>True</td>
</tr>
<tr>
<td>decimal 195</td>
<td>1100 0011</td>
<td>2</td>
<td>False</td>
</tr>
<tr>
<td>hex 20</td>
<td>0010 0000</td>
<td>2</td>
<td>False</td>
</tr>
</tbody>
</table>

Bits are numbered from right to left, starting at 0.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>In</code></td>
<td><code>Bit</code></td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td>Integer 64 Variable</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

**Condition Block Example:**

In this example, if bit 0 of `nMask` is on, the logic will take the True path. Otherwise, the logic will take the False path.

**OptoScript Example:**

```optoscript
IsBitOn (In, Bit)
```

```optoscript
if (IsBitOn(nMask, 0) then
```

This is a function command; it returns a value of true (non-zero) or false (0). The returned value can be consumed by a control structure (as in the example shown) or by a variable, I/O point, and so forth. For more information, see “Logical Commands” and “Using OptoScript” in the *PAC Control User’s Guide* (form 1700).

**Notes:**
- Although this command can be used to determine the status of digital points, it is primarily used to test bits in an integer variable. These bits can be used as flags to carry information such as status, control, or fault (real-time or latch).
- Use `Bit AND?` if the objective is to test several bits at once.

**See Also:**
- “Bit Off?” on page 369
- “Bit AND?” on page 359
- “Bit Test” on page 379
Bit OR

Logical Action

Function: To perform a bitwise OR on two values.

Typical Use: To set one or more bits as specified by a mask.

Details:
- Performs a bitwise OR on the value of Argument 0 and With (Argument 1) (that is, it combines all bits set to 1 in Argument 0 and With), and stores the result in Put Result in (Argument 2). You can also choose to store the result in a different parameter.
- Acts on all bits.

Examples:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>With</th>
<th>Put Result in</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0xF</td>
<td>0</td>
<td>0xF</td>
</tr>
<tr>
<td>0</td>
<td>0xF</td>
<td>0xF</td>
</tr>
<tr>
<td>0xF</td>
<td>0xF</td>
<td>0xF</td>
</tr>
</tbody>
</table>

Arguments:
- **Argument 0** [Value]:
  - Integer 32 Literal
  - Integer 32 Variable
  - Integer 64 Literal
  - Integer 64 Variable
- **Argument 1** [With]:
  - Integer 32 Literal
  - Integer 32 Variable
  - Integer 64 Literal
  - Integer 64 Variable
- **Argument 2** [Put Result in]:
  - Digital Output
  - Integer 32 Variable
  - Integer 64 Variable

Action Block Example:

This example sets bit 2 in a copy of Argument 0 and stores the result in Put Result in (Argument 2).

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>(none)</td>
<td>Integer 32 Variable</td>
<td>VALUE</td>
</tr>
<tr>
<td>With</td>
<td>Integer 32 Literal</td>
<td>4</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Integer 32 Variable</td>
<td>RESULT</td>
</tr>
</tbody>
</table>

OptoScript Example:

OptoScript doesn’t use a command; the function is built in. Use the `bitor` operator.

```
RESULT = VALUE bitor 4;
```

Note that for this command, I/O units cannot be used the same way as in the standard command. However, you can accomplish the same thing using OptoScript code. The following example ORs the bits from two variables and writes the result to an I/O unit:

```
SetDigital64IoUnitFromMomo(nnTemp1 bitor nnTemp2, bitnot (nnTemp1 bitor nnTemp2), Dig_IO_Unit);
```

This example moves a value from an I/O unit, ORs the bits with a variable, and writes the value to the same I/O unit:

```
nnTemp1 = GetIoUnitAsBinaryValue(Dig_IO_Unit);
nnTemp1 = nnTemp1 bitor nVariable;
SetDigital64IoUnitFromMomo(nnTemp1, bitnot nnTemp1, Dig_IO_Unit);
```
Notes:

- For more information, see “Logical Commands” and “Using OptoScript” in the PAC Control User’s Guide (form 1700).
- Although this command can be used to turn on digital points, it is used primarily to manipulate bits in an integer variable. These bits can be used as flags to carry information such as status, control, or fault (real-time or latch).
- To set bits in Argument 0, make the value of Argument 0 and Put Result in (Argument 2) the same.
- To set only one bit, use Bit Set.
- To test if either of two values is True, use OR.

See Also:

“Bit Set” on page 376
“OR” on page 421
“Bit XOR” on page 380
“XOR” on page 443
Bit OR?

Logical Condition

Function: To perform a bitwise OR? on any two allowable values.

Typical Use: To determine if any bit is set to 1 in either of two values.

Details: • Performs a bitwise OR? on Is (Argument 0) and the value of Argument 1.
  – If any bit is set to 1 in either Is or Argument 1, the logic will take the True path.
  – If neither argument has a bit set to 1, the logic will take the False path.
  • Acts on all bits.

Examples:

<table>
<thead>
<tr>
<th>Is</th>
<th>Argument 1</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0</td>
<td>True</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>True</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>True</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>False</td>
</tr>
</tbody>
</table>

Arguments:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is</td>
<td>Integer 32 Variable</td>
<td>Fault_Bits_1</td>
</tr>
<tr>
<td>(none)</td>
<td>Integer 32 Variable</td>
<td>Fault_Bits_2</td>
</tr>
</tbody>
</table>

Condition Block Example:

<table>
<thead>
<tr>
<th>Bit OR?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argument Name</td>
</tr>
<tr>
<td>Is</td>
</tr>
<tr>
<td>(none)</td>
</tr>
</tbody>
</table>

OptoScript Example:

OptoScript doesn’t use a command; the function is built in. Use the `bitor` operator.

```opto
if (Fault_Bits_1 bitor Fault_Bits_2) then
```

Note that for this command, I/O units cannot be used the same way as in the standard command. However, you can accomplish the same thing using OptoScript code.

```opto
if (GetIoUnitAsBinaryValue(Dig_IO_Unit) bitor nInteger) then
```

Notes: • For more information, see “Logical Commands” and “Using OptoScript” in the PAC Control User’s Guide (form 1700).
  • Although this condition can be used to determine the status of digital points, it is primarily used to test bits in an integer variable. These bits can be used as flags to carry information such as status, control, or fault (real-time or latch).
  • Use Bit On? or Bit Off? if the objective is to test only one bit.

See Also: *Bit On?” on page 371
  *Bit Off?” on page 369
  *OR?” on page 423
Bit Rotate

Logical Action

**Function:** To rotate all 32 or 64 bits of an allowable value to the left or right.

**Typical Use:** To shift bits left or right with wraparound.

**Details:**
- Acts on all bits. All bits rotated past one end reappear at the other end. If `Count` (Argument 1) is positive, bits rotate left. If it is negative, bits rotate right. If it is zero, no rotation occurs.
- Note that the types for `Count` are 32-bit integers, because an integer 32 provides enough range to handle either a 32-bit or a 64-bit shift.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argument 0</td>
<td>[Value]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Integer 32 Literal</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Integer 32 Variable</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Integer 64 Literal</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Integer 64 Variable</td>
<td></td>
</tr>
<tr>
<td>Argument 1</td>
<td>Count</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Integer 32 Literal</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Integer 32 Variable</td>
<td></td>
</tr>
<tr>
<td>Argument 2</td>
<td>Put Result in</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Digital Output</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Integer 32 Variable</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Integer 64 Variable</td>
<td></td>
</tr>
</tbody>
</table>

**Action Block Example:**
This example shows the bits of a copy of `Mask_Variable` rotated to the left by 4, with the result placed in `Result_Variable`. If `Mask_Variable` is -2,147,483,904 (10000000 00000000 00000000 00000000 binary), then after the rotation `Result_Variable` would be 8 (00000000 00000000 00000000 00001000 binary).

**OptoScript Example:**

```optoscript
BitRotate (Argument 0, Count)
Result_Variable = BitRotate (Mask_Variable, 4);
```

This is a function command; it returns the result of the bit rotation. The returned value can be consumed by a variable (as shown) or used by an item such as a Condition block, an OptoScript block, or a mathematical expression. In OptoScript code it cannot be consumed by an I/O unit, however. For more information, see “Logical Commands” and “Using OptoScript” in the PAC Control User’s Guide (form 1700).

Although the returned value cannot be consumed by an I/O unit, you can accomplish the same thing by using OptoScript code such as the following:

```optoscript
nnTemp1 = BitRotate (Dig_IO_Unit, nCount);
SetDigital64IoUnitFromMomo (nnTemp1, bitnot nnTemp1, Dig_IO_Unit);
```

**Notes:**
- To rotate bits in Argument 0, make the value of Argument 0 and `Move To` (Argument 2) the same.
- To get rid of all bits that move past either end, use `Bit Shift`.

**See Also:** “Bit Shift” on page 377
Bit Set

Logical Action

**Function:**
To set a specified bit (set it to 1) in an allowable value.

**Typical Use:**
To set a bit in an integer variable.

**Details:**
- Performs this action on a copy of the value of Argument 0, and then moves the copy to Put Result in (Argument 2).
- Note that the types for Bit to Set (Argument 1) are 32-bit integers, because an integer 32 provides enough range to handle either a 32-bit or a 64-bit number.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0 [Value]</th>
<th>Argument 1 Bit to Set</th>
<th>Argument 2 Put Result in</th>
</tr>
</thead>
<tbody>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Literal</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Integer 64 Variable</td>
<td>Integer 32 Variable</td>
<td>Integer 64 Variable</td>
</tr>
</tbody>
</table>

**Action Block Example:**
In this example, if Pump3_Ctrl_Bits is 8 (00000000 00000000 00000000 00001000 binary), then after the Bit Set, Pump3_Ctrl_Bits would be 32776 (00000000 00000000 10000000 00001000 binary).

**OptoScript Example:**

```plaintext
BitSet (Argument 0, Bit to Set)
Pump3_Ctrl_Bits = BitSet(Pump3_Ctrl_Bits, 15);
```

This is a function command; it returns the value with the specified bit set. The returned value can be consumed by a variable (as shown) or used by an item such as a Condition block, an OptoScript block, or a mathematical expression. It cannot be consumed by an I/O unit, however. For more information, see "Logical Commands" and "Using OptoScript" in the PAC Control User's Guide (form 1700).

Although the returned value cannot be consumed by an I/O unit, you can accomplish the same thing by using OptoScript code such as the following:

```plaintext
SetDigital64IoUnitFromMomo(1i64 << nPointToSet, 0, Dig_IO_Unit);
```

**Notes:**
- Although this command can be used to turn on digital points, it is primarily used to manipulate bits in an integer variable. These bits can be used as flags to carry information such as status, control, or fault (real-time or latch).
- To set bits in Argument 0, make the value of Argument 0 and Put Result in (Argument 2) the same.
- To set several bits at once, use Bit OR.

**See Also:**
- "Bit OR" on page 372
- "Bit Test" on page 379
- "Bit Clear" on page 361
Bit Shift

Logical Action

**Function:** To shift the bits of a value to the right or left.

**Typical Use:** To evaluate the four bytes of a 32-bit integer or the eight bytes of a 64-bit integer one at a time. A way to multiply or divide integers by a base 2 number.

**Details:**
- Functionally equivalent to integer multiplication or division by powers of two. Bit Shift with a **Count** (Argument 1) of 2 is the same as multiplying by 4. Bit Shift with a **Count** of -3 is the same as dividing by 8.
- In the standard PAC Control command, if **Count** is positive, bits will shift left. If it is negative, bits will shift right. If it is zero, no shifting will occur.
- Acts on all bits. All bit positions vacated by the shift are filled with zeros.
- Note that the types for **Count** are 32-bit integers, because an integer 32 provides enough range to handle either a 32-bit or a 64-bit shift.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Value]</td>
<td>Count</td>
<td>Put Result in</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
<td>Digital Output</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Integer 64 Literal</td>
<td>Integer 64 Variable</td>
<td>Integer 64 Variable</td>
</tr>
<tr>
<td>Integer 64 Variable</td>
<td>Integer 64 Variable</td>
<td>Integer 64 Variable</td>
</tr>
</tbody>
</table>

**Action Block Example:**
This example shows the bits of a copy of Mask_Variable shifted to the right by 8, with the result placed in Result_Variable.

If Mask_Variable is $-2,147,483,648 (10000000 00000000 00000000 00000000$ binary), then after the shift Result_Variable would be $8,388,608 (00000000 10000000 00000000 00000000$ binary).

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>(none)</td>
<td>Integer 32 Variable</td>
<td>Mask_Variable</td>
</tr>
<tr>
<td>Count</td>
<td>Integer 32 Literal</td>
<td>-8</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Integer 32 Variable</td>
<td>Result_Variable</td>
</tr>
</tbody>
</table>

**OptoScript Example:** OptoScript doesn’t use a command; the function is built in. Use the `<<` (left shift) or `>>` (right shift) operators. Note that the result of the bit shift cannot be put into an I/O unit.

```OptoScript
Result_Variable = Mask_Variable >> 8;
```

Although the result of the bit shift cannot be put into an I/O unit, you can accomplish the same thing by using OptoScript code. The following example shifts bits in a variable and writes the result to an I/O unit:

```OptoScript
nnTemp1 = nnTemp1 >> 8;
SetDigital64IoUnitFromMomo(nnTemp1, bitnot nnTemp1, Dig_IO_Unit);
```

This example moves a value from an I/O unit, shifts bits, and writes to the same I/O unit:

```OptoScript
nnTemp1 = GetIoUnitAsBinaryValue(Dig_IO_Unit);
nnTemp1 = nnTemp1 >> 8;
SetDigital64IoUnitFromMomo(nnTemp1, bitnot nnTemp1, Dig_IO_Unit);
```

**Notes:**
- For more information, see “Logical Commands” and “Using OptoScript” in the PAC Control User’s Guide (form 1700).
- To shift bits in Argument 0, make the value of Argument 0 and Put Result in (Argument 2) the same.
- To retain all bits that move past either end, use Bit Rotate.
See Also: “Bit Rotate” on page 375
Bit Test

Logical Action

**Function:** To determine the status of a specific bit.

**Typical Use:** To test a flag bit in an integer variable.

**Details:**
- If the bit is clear (0), False (0) is moved to Put Result in (Argument 2).
- If the bit is set (1), True (non-zero) is moved to Put Result in.
- The result can also be sent directly to a digital output.
- Note that Bit to Test (Argument 2) is a 32-bit integer because the top of the valid range is 63.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argument 0</td>
<td>Integer 32 Variable</td>
<td>Pump3_Ctrl_Bits</td>
</tr>
<tr>
<td>Argument 1</td>
<td>Integer 32 Literal</td>
<td>15</td>
</tr>
<tr>
<td>Argument 2</td>
<td>Integer 32 Variable</td>
<td>Put Result in</td>
</tr>
</tbody>
</table>

**Action Block Example:**

If Pump3_Ctrl_Bits is 00000000 00000000 10000000 00001000, the result would be set to True.

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>(none)</td>
<td>Integer 32 Variable</td>
<td>Pump3_Ctrl_Bits</td>
</tr>
<tr>
<td>Bit to Test</td>
<td>Integer 32 Literal</td>
<td>15</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Integer 32 Variable</td>
<td>Put Result in</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```plaintext
BitTest(Argument 0, Bit to Test)
Pump3_Ctrl_Bits = BitTest(Pump3_Ctrl_Bits, 15);
```

This is a function command; it returns a value of False (0, bit is clear) or True (non-zero, bit is set). The returned value can be consumed by a variable (as shown) or used by an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see “Logical Commands” and “Using OptoScript” in the PAC Control User’s Guide (form 1700).

**Notes:**
- Although this command can be used to determine the status of digital points, it is primarily used to test bits in an integer variable. These bits can be used as flags to carry information such as status, control, or fault (real-time or latch).
- To test several bits at once, use Bit AND.

**See Also:**
- “Bit Clear” on page 361
- “Bit Set” on page 376
- “Bit On?” on page 371
Bit XOR

Logical Action

Function: To perform a bitwise EXCLUSIVE OR (XOR) on any two allowable values.

Typical Uses:
- To toggle one or more bits as specified by a mask.
- To toggle an integer between zero and any other value.

Details:
- Performs a bitwise EXCLUSIVE OR on the value of Argument 0 and With (Argument 1), and then stores the result in Put Result in (Argument 2).
  
  *NOTE: In programming logic, 0 represents False and any non-zero number represents True.*
- Acts on all bits. One value is the mask for selecting specific bits in the other value.

Examples:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>With</th>
<th>Put Result in</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>0</td>
</tr>
</tbody>
</table>

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Value]</td>
<td>With</td>
<td>Put Result in</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
<td>Digital Output</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Integer 64 Literal</td>
<td>Integer 64 Literal</td>
<td>Integer 64 Variable</td>
</tr>
<tr>
<td>Integer 64 Variable</td>
<td>Integer 64 Variable</td>
<td>Integer 64 Variable</td>
</tr>
</tbody>
</table>

Action Block Example:
This example performs a Bit XOR on a copy of Data with the constant 22 (binary 10110). The result (Data_new) has bits 1, 2, and 4 inverted. If Data = 0, Data_New = 22. If Data = 22, Data_New = 0.

OptoScript Example:

OptoScript doesn’t use a command; the function is built in. Use the `bitxor` operator.

```opto
Data_New = Data bitxor 22;
```

Note that for this command, I/O units cannot be used the same way as in the standard command. However, you can accomplish the same thing using OptoScript code. The following example xors the bits from two variables and writes the result to an I/O unit:

```opto
SetDigital64IoUnitFromMomo(nnTemp1 bitxor nnTemp2, bitnot(nnTemp1 bitxor nnTemp2), Dig_IO_Unit);
```

This example moves a value from an I/O unit, xors the bits with a variable, and writes to the same I/O unit:

```opto
nnTemp1 = GetIoUnitAsBinaryValue(Dig_IO_Unit);
nnTemp1 = nnTemp1 bitxor nnVariable;
SetDigital64IoUnitFromMomo(nnTemp1, bitnot nnTemp1, Dig_IO_Unit);
```
Notes:  
- For more information, see “Logical Commands” and “Using OptoScript” in the *PAC Control User’s Guide* (form 1700).
- This command can be used to toggle digital outputs as well as bits in an integer variable. These bits can be used as flags to carry information such as status, control, or fault (real-time or latch).
- To toggle bits in Argument 0, make the value of Argument 0 and Put Result in (Argument 2) the same.
- To toggle a bit, Bit XOR with 1. (Zero leaves the bit unchanged.)

See Also:  
- “XOR” on page 443
- “Bit NOT” on page 364
- “NOT” on page 411
- “Bit XOR?” on page 382
Bit XOR?

Logical Condition

**Function:** To determine the bitwise difference of any two allowable values.

**Typical Use:** To detect a change of state of any bit in either of two values.

**Details:**
- Performs a bitwise XOR on `Is` (Argument 0) and the value of Argument 1.
  - If `Is` and Argument 1 are not equal, the logic will take the True path.
  - If `Is` and the value of Argument 1 are equal, the logic will take the False path.
- Acts on all bits.
- When used with integer data types, is functionally equivalent to Not Equal?

**Examples:**

<table>
<thead>
<tr>
<th>Is</th>
<th>Argument 1</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>1</td>
<td>True</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>True</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>False</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>False</td>
</tr>
</tbody>
</table>

**Arguments:**

- **Argument 0**
  - Is
    - Integer 32 Literal
    - Integer 32 Variable
    - Integer 64 Literal
    - Integer 64 Variable

- **Argument 1**
  - [Value]
    - Integer 32 Literal
    - Integer 32 Variable
    - Integer 64 Literal
    - Integer 64 Variable

**Condition Block Example:**

Bit XOR?

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>Is</code></td>
<td>Integer 32 Variable</td>
<td><code>nMask_1</code></td>
</tr>
<tr>
<td>(none)</td>
<td>Integer 32 Variable</td>
<td><code>nMask_2</code></td>
</tr>
</tbody>
</table>

**OptoScript Example:**

OptoScript doesn’t use a command; the function is built in. Use the bit xor operator.

**Notes:**
- For more information, see “Logical Commands” and “Using OptoScript” in the PAC Control User’s Guide (form 1700).
- Although this condition can be used to determine the status of digital points, it is primarily used to test bits in an integer variable. These bits can be used as flags to carry information such as status, control, or fault (real-time or latch).
- Use the False exit if the objective is to test for an exact match, or use the Equal? condition if using numeric values.

**See Also:**
- *“Bit AND?” on page 359*
- *“Bit NOT” on page 364*
“Bit OR?” on page 374
“Bit XOR” on page 380
“Equal?” on page 386
Equal to Numeric Table Element?

Logical Condition

**Function:**
To determine if a numeric value is exactly equal to the specified value in a float or integer table.

**Typical Use:**
To perform lookup table matching.

**Details:**
- If the value of `Is` (Argument 0) is the same as the value at the specified table (`Of Table`, Argument 2) and index (`At Index`, Argument 1), the logic will take the True path.
- If `Is` is not the same as the value at the specified table and index, the logic will take the False path.

**Examples:**

<table>
<thead>
<tr>
<th><code>Is</code></th>
<th><code>Value at Of Table[At Index]</code></th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.0</td>
<td>0.0</td>
<td>True</td>
</tr>
<tr>
<td>-98.765</td>
<td>-98.765</td>
<td>True</td>
</tr>
<tr>
<td>-32768</td>
<td>-32768</td>
<td>True</td>
</tr>
<tr>
<td>2222</td>
<td>2222</td>
<td>True</td>
</tr>
<tr>
<td>0.0001</td>
<td>0.0</td>
<td>False</td>
</tr>
</tbody>
</table>

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>Is</code></td>
<td><code>At Index</code></td>
<td><code>Of Table</code></td>
</tr>
<tr>
<td>Analog Input</td>
<td>Integer 32 Literal</td>
<td>Float Table</td>
</tr>
<tr>
<td>Analog Output</td>
<td>Integer 32 Variable</td>
<td>Integer 32 Table</td>
</tr>
<tr>
<td>Digital Input</td>
<td>Integer 64 Literal</td>
<td>Integer 64 Table</td>
</tr>
<tr>
<td>Digital Output</td>
<td>Integer 64 Variable</td>
<td>Up Timer Variable</td>
</tr>
<tr>
<td>Float Literal</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Float Variable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Integer 64 Literal</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Integer 64 Variable</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Condition Block Example:**

```
Equal to Numeric Table Element?

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>Is</code></td>
<td>Float Variable</td>
<td><code>THIS_READING</code></td>
</tr>
<tr>
<td><code>At Index</code></td>
<td>Integer 32 Variable</td>
<td><code>TABLE_INDEX</code></td>
</tr>
<tr>
<td><code>Of Table</code></td>
<td>Float Table</td>
<td><code>TABLE_OF_READINGS</code></td>
</tr>
</tbody>
</table>
```

**OptoScript Example:**

```
if (THIS_READING == TABLE_OF_READINGS[TABLE_INDEX]) then
```

**Notes:**
- In OptoScript code, the `==` operator has many uses. For more information, see “Logical Commands” and “Using OptoScript” in the *PAC Control User’s Guide* (form 1700).
- When testing floats or analog values, use either `Greater Than or Equal To Numeric Table Element?` or `Less Than or Equal to Numeric Table Element?` since exact matches are rare.
To test for inequality, use either Not Equal to Numeric Table Element? or the False exit.

Queue Errors:
-12 = Invalid table index value. Index was negative or greater than the table size.

See Also:
“Greater Than or Equal To Numeric Table Element?” on page 394
“Less Than or Equal to Numeric Table Element?” on page 403
Equal?
Logical Condition

Function: To determine the equality of two values.

Typical Use: To branch program logic based on the sequence number of the process.

Details:
- If Is (Argument 0) and To (Argument 1) are equal, the logic will take the True path.
- If Is and To are not equal, the logic will take the False path.

Examples:

<table>
<thead>
<tr>
<th>Is</th>
<th>To</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>-1</td>
<td>-1</td>
<td>True</td>
</tr>
<tr>
<td>22.22</td>
<td>22.22</td>
<td>True</td>
</tr>
<tr>
<td>-1</td>
<td>1</td>
<td>False</td>
</tr>
<tr>
<td>22.22</td>
<td>22.221</td>
<td>False</td>
</tr>
</tbody>
</table>

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is</td>
<td>To</td>
</tr>
<tr>
<td>Analog Input</td>
<td>Analog Input</td>
</tr>
<tr>
<td>Analog Output</td>
<td>Analog Output</td>
</tr>
<tr>
<td>Digital Input</td>
<td>Digital Input</td>
</tr>
<tr>
<td>Digital Output</td>
<td>Digital Output</td>
</tr>
<tr>
<td>Down Timer Variable</td>
<td>Down Timer Variable</td>
</tr>
<tr>
<td>Float Literal</td>
<td>Float Literal</td>
</tr>
<tr>
<td>Float Variable</td>
<td>Float Variable</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Integer 64 Literal</td>
<td>Integer 64 Literal</td>
</tr>
<tr>
<td>Integer 64 Variable</td>
<td>Integer 64 Variable</td>
</tr>
<tr>
<td>Up Timer Variable</td>
<td>Up Timer Variable</td>
</tr>
</tbody>
</table>

Condition Block Example:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is</td>
<td>Integer 32 Variable</td>
<td>BATCH_STEP</td>
</tr>
<tr>
<td>To</td>
<td>Integer 32 Literal</td>
<td>4</td>
</tr>
</tbody>
</table>

OptoScript Example:

OptoScript doesn’t use a command; the function is built in. Use the == operator.

if (BATCH_STEP == 4) then

Notes:
- In OptoScript code, the == operator has many uses. For more information, see “Logical Commands” and “Using OptoScript” in the PAC Control User’s Guide (form 1700).
- When testing floats or analog values, use either Greater Than or Equal? or Less Than or Equal? since exact matches are rare.
- Use Within Limits? to test for an approximate match.
- To test for inequality, use either Not Equal? or the False exit.
See Also:

“Greater Than Numeric Table Element?” on page 392  
“Not Equal to Numeric Table Element?” on page 413  
“Less Than or Equal to Numeric Table Element?” on page 403  
“Greater Than or Equal?” on page 396  
“Less?” on page 407  
“Within Limits?” on page 441
Flip Flop JK

Logical Action

**Function:** Control the Output variable according to the JK Flip Flop rules.

**Details:** Implements a standard JK Flip Flop.

Output Rules:

<table>
<thead>
<tr>
<th>J</th>
<th>K</th>
<th>Q</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>Hold (no change)</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>Toggle</td>
</tr>
</tbody>
</table>

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set [J]</td>
<td>Reset [K]</td>
<td>Output [Q]</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

**Action Block Example:**

```
FlipFlopJK
```

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set [J]</td>
<td>Integer 32 Variable</td>
<td>J_Flag</td>
</tr>
<tr>
<td>Reset [K]</td>
<td>Integer 32 Variable</td>
<td>K_Flag</td>
</tr>
<tr>
<td>Output [Q]</td>
<td>Integer 32 Variable</td>
<td>Q_Flag</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```
FlipFlopJK(Set [J], Reset [K], Output [Q])
```

```
FlipFlopJK(J_FLAG, K_FLAG, Q_FLAG);
```

This is a procedure command; it does not return a value.
Float to Int32 Bits

Function: To move the internal bit pattern of a float into an integer 32.

Typical Use: To help parse or create binary data when communicating with other devices.

Details: This command is similar to Move 32 Bits, but is more flexible in OptoScript blocks. It can be used inside another expression, which can reduce the need for temporary variables compared to Move 32 Bits.

Arguments:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>From</td>
<td>Float Variable</td>
<td>nFloat</td>
</tr>
<tr>
<td>To</td>
<td>Integer 32 Variable</td>
<td>nInt32</td>
</tr>
</tbody>
</table>

Action Block Example:

OptoScript Example:

```
FloatToInt32Bits(From)
```

```
nInt32 = FloatToInt32Bits(nFloat);
```

This is a function command; it returns an integer 32 value. The returned value can be consumed by a variable (as in the example shown) or used by an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).
Get High Bits of Integer 64

Logical Action

Function: To read only the upper 32 bits of a 64-bit integer and place them in a 32-bit integer.

Typical Use: To convert half of a 64-bit integer into a 32-bit integer for faster manipulation. Often used when only part of a 64-point digital rack is populated with points.

Details:
- Returns the upper 32 bits, which represent the upper 32 points on a 64-point digital-only rack, to the numeric variable specified.
- The least significant bit corresponds to point 32; the most significant bit corresponds to point 63.

Arguments:

| Argument 0 | Argument 1 |
| High Bits From | Put in |
| Integer 64 Variable | Integer 32 Variable |

Action Block Example:

**Get High Bits of Integer 64**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>High Bits From</td>
<td>Integer 64 Variable</td>
<td>INPUT_BOARD_2</td>
</tr>
<tr>
<td>Put in</td>
<td>Integer 32 Variable</td>
<td>IN_BD2_HIGH</td>
</tr>
</tbody>
</table>

OptoScript Example:

```plaintext
IN_BD2_HIGH = GetHighBitsOfInt64(INPUT_BOARD_2);
```

This is a function command; it returns the upper 32 bits of a 64-bit integer. The returned value can be consumed by a variable (as shown) or used by an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see “Logical Commands” and “Using OptoScript” in the PAC Control User's Guide (form 1700).

See Also:
- “Get Low Bits of Integer 64” on page 391
- “Make Integer 64” on page 409
Get Low Bits of Integer 64

Logical Action

**Function:** To read only the lower 32 bits of a 64-bit integer and place them in a 32-bit integer.

**Typical Use:** To convert half of a 64-bit integer into a 32-bit integer for faster manipulation. Often used when only part of a 64-point digital rack is populated with points.

**Details:**
- Returns the lower 32 bits, which represent the lower 32 points on a 64-point digital-only rack, to the numeric variable specified.
- The least significant bit corresponds to point zero; the most significant bit corresponds to point 32.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low Bits From</td>
<td>Put in</td>
</tr>
<tr>
<td>Integer 64 Variable</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

**Action Block Example:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low Bits From</td>
<td>Integer 64 Variable</td>
<td>INPUT_BOARD_2</td>
</tr>
<tr>
<td>Put in</td>
<td>Integer 32 Variable</td>
<td>IN_BD2_LOW</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```optoscript
IN_BD2_LOW = GetLowBitsOfInt64(INPUT_BOARD_2);
```

This is a function command; it returns the lower 32 bits of a 64-bit integer. The returned value can be consumed by a variable (as shown) or used by an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the *PAC Control User’s Guide* (form 1700).

**See Also:**
- “Get High Bits of Integer 64” on page 390
- “Make Integer 64” on page 409
CHAPTER 14: LOGICAL COMMANDS

Greater Than Numeric Table Element?

Logical Condition

Function: To determine if a numeric value is greater than a specified value in a float or integer table.

Typical Use: To store peak values.

Details:
- If the value of Is (Argument 0) is greater than the value at the specified table (Of Table, Argument 2) and index (At Index, Argument 1), the logic will take the True path.
- If the value of Is is not greater than the value at the specified table and index, the logic will take the False path.

Examples:

<table>
<thead>
<tr>
<th>Is</th>
<th>Value at Of Table[At Index]</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.0001</td>
<td>0.0</td>
<td>True</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>True</td>
</tr>
<tr>
<td>22221</td>
<td>2222</td>
<td>True</td>
</tr>
<tr>
<td>0.0</td>
<td>0.0</td>
<td>False</td>
</tr>
<tr>
<td>-98.765</td>
<td>-98.765</td>
<td>False</td>
</tr>
</tbody>
</table>

Arguments:
- Argument 0 Is
  - Analog Input
  - Analog Output
  - Digital Input
  - Digital Output
  - Down Timer Variable
  - Float Literal
  - Float Variable
  - Integer 32 Literal
  - Integer 32 Variable
  - Integer 64 Literal
  - Integer 64 Variable
  - Up Timer Variable
- Argument 1 At Index
  - Integer 32 Literal
  - Integer 32 Variable
- Argument 2 Of Table
  - Float Table
  - Integer 32 Table
  - Integer 64 Table

Condition Block Example:

Greater Than Numeric Table Element?

OptoScript Example: OptoScript doesn’t use a command; the function is built in. Use the > operator.

```opto
if (THIS_READING > TABLE_OF_READINGS[TABLE_INDEX]) then
```

Notes:
- For more information, see “Logical Commands” and “Using OptoScript” in the PAC Control User’s Guide (form 1700).
- To test for less than or equal to, use either Less Than or Equal to Numeric Table Element? or the False exit.
Queue Errors: -12 = Invalid table index.

See Also:
“Less Than Numeric Table Element?” on page 401
“Not Equal to Numeric Table Element?” on page 413
“Greater Than or Equal To Numeric Table Element?” on page 394
“Less Than or Equal to Numeric Table Element?” on page 403
**Greater Than or Equal To Numeric Table Element?**

**Logical Condition**

**Function:** To determine if a numeric value is greater than or equal to a specified value in a float or integer table.

**Typical Use:** To store peak values.

**Details:**
- If the value of *Is* (Argument 0) is greater than or equal to the value at the specified table (*Of Table*, Argument 2) and index (*At Index*, Argument 1), the logic will take the True path.
- If the value of *Is* is not greater than or equal to the value at the specified table and index, the logic will take the False path.

**Examples:**

<table>
<thead>
<tr>
<th><em>Is</em></th>
<th>Value at <em>Of Table</em>[<em>At Index</em>]</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.0</td>
<td>0.0</td>
<td>True</td>
</tr>
<tr>
<td>0.0001</td>
<td>0.0</td>
<td>True</td>
</tr>
<tr>
<td>22221</td>
<td>2222</td>
<td>True</td>
</tr>
<tr>
<td>22.22</td>
<td>22.222</td>
<td>False</td>
</tr>
<tr>
<td>-32768</td>
<td>-32767</td>
<td>False</td>
</tr>
</tbody>
</table>

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0 <em>Is</em></th>
<th>Argument 1 <em>At Index</em></th>
<th>Argument 2 <em>Of Table</em></th>
</tr>
</thead>
<tbody>
<tr>
<td>Analog Input</td>
<td>Integer 32 Literal</td>
<td>Float Table</td>
</tr>
<tr>
<td>Analog Output</td>
<td>Integer 32 Variable</td>
<td>Integer 32 Table</td>
</tr>
<tr>
<td>Digital Input</td>
<td>Float Literal</td>
<td>Integer 64 Table</td>
</tr>
<tr>
<td>Digital Output</td>
<td>Float Variable</td>
<td></td>
</tr>
<tr>
<td>Down Timer Variable</td>
<td>Integer 32 Literal</td>
<td></td>
</tr>
<tr>
<td>Float Literal</td>
<td>Integer 32 Variable</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Variable</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 64 Table</td>
<td></td>
</tr>
<tr>
<td>Integer 64 Literal</td>
<td>Integer 64 Variable</td>
<td></td>
</tr>
<tr>
<td>Integer 64 Variable</td>
<td>Up Timer Variable</td>
<td></td>
</tr>
</tbody>
</table>

**Condition Block Example:**

Greater Than or Equal to Numeric Table Element?

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Is</em></td>
<td>Float Variable</td>
<td><em>THIS_READING</em></td>
</tr>
<tr>
<td><em>At Index</em></td>
<td>Integer 32 Variable</td>
<td><em>TABLE_INDEX</em></td>
</tr>
<tr>
<td><em>Of Table</em></td>
<td>Float Table</td>
<td><em>TABLE_OF_READINGS</em></td>
</tr>
</tbody>
</table>

**OptoScript Example:**

OptoScript doesn’t use a command; the function is built in. Use the `>=` operator.

```optoscript
if (THIS_READING >= TABLE_OF_READINGS[TABLE_INDEX]) then
```

**Notes:**

- For more information, see “Logical Commands” and "Using OptoScript" in the PAC Control User's Guide (form 1700).
- To test for less than, use either Less Than Numeric Table Element? or the False exit.
Queue Errors: -12 = Invalid table index.

See Also:
“Less Than Numeric Table Element?” on page 401
“Not Equal to Numeric Table Element?” on page 413
“Greater Than Numeric Table Element?” on page 392
“Less Than or Equal to Numeric Table Element?” on page 403
Greater Than or Equal?

Logical Condition

**Function:**
To determine if one numeric value is greater than or equal to another.

**Typical Use:**
To determine if a value has reached an upper limit.

**Details:**
- If *Is* (Argument 0) is greater than or equal to *To* (Argument 1), the logic will take the True path.
- If *Is* (Argument 0) is *not* greater than or equal to *To* (Argument 1), the logic will take the False path.

**Examples:**

<table>
<thead>
<tr>
<th><em>Is</em></th>
<th><em>To</em></th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>True</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>True</td>
</tr>
<tr>
<td>22221</td>
<td>2222</td>
<td>True</td>
</tr>
<tr>
<td>-32768</td>
<td>-32767</td>
<td>False</td>
</tr>
</tbody>
</table>

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Is</em></td>
<td><em>To</em></td>
</tr>
<tr>
<td>Analog Input</td>
<td>Analog Input</td>
</tr>
<tr>
<td>Analog Output</td>
<td>Analog Output</td>
</tr>
<tr>
<td>Digital Input</td>
<td>Digital Input</td>
</tr>
<tr>
<td>Digital Output</td>
<td>Digital Output</td>
</tr>
<tr>
<td>Down Timer Variable</td>
<td>Down Timer Variable</td>
</tr>
<tr>
<td>Float Literal</td>
<td>Float Literal</td>
</tr>
<tr>
<td>Float Variable</td>
<td>Float Variable</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Integer 64 Literal</td>
<td>Integer 64 Literal</td>
</tr>
<tr>
<td>Integer 64 Variable</td>
<td>Integer 64 Variable</td>
</tr>
<tr>
<td>Up Timer Variable</td>
<td>Up Timer Variable</td>
</tr>
</tbody>
</table>

**OptoScript Example:**
OptoScript doesn't use a command; the function is built in. Use the `>=` operator.

```plaintext
if (ROOM_TEMP >= 78.5000) then
```

**Notes:**
- For more information, see “Logical Commands” and “Using OptoScript” in the PAC Control User’s Guide (form 1700).
- Use *Within Limits?* to test for an approximate match. To test for less than, use either *Less?* or the False exit.
- When using analog values or digital features in this command, be sure to take into consideration the units that the value is read in and adjust the test values accordingly.

**See Also:**
- “Less?” on page 407
- “Less Than or Equal to Numeric Table Element?” on page 403
“Not Equal to Numeric Table Element?” on page 413
“Within Limits?” on page 441
Greater?
Logical Condition

**Function:** To determine if one numeric value is greater than another.

**Typical Use:** To determine if a timer has reached a limit.

**Details:**
- If Is (Argument 0) is greater than Than (Argument 1), the logic will take the True path.
- If Is is *not* greater than Than, the logic will take the False path.

**Examples:**

<table>
<thead>
<tr>
<th>Is</th>
<th>Than</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>-1</td>
<td>-3</td>
<td>True</td>
</tr>
<tr>
<td>22.221</td>
<td>22.220</td>
<td>True</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>False</td>
</tr>
<tr>
<td>-1</td>
<td>0</td>
<td>False</td>
</tr>
</tbody>
</table>

**Arguments:**
- **Is** (Argument 0)
  - Analog Input
  - Analog Output
  - Digital Input
  - Digital Output
  - Down Timer Variable
  - Float Literal
  - Float Variable
  - Integer 32 Literal
  - Integer 32 Variable
  - Integer 64 Literal
  - Integer 64 Variable
  - Up Timer Variable

- **Than** (Argument 1)
  - Analog Input
  - Analog Output
  - Digital Input
  - Digital Output
  - Down Timer Variable
  - Float Literal
  - Float Variable
  - Integer 32 Literal
  - Integer 32 Variable
  - Integer 64 Literal
  - Integer 64 Variable
  - Up Timer Variable

**Condition Block Example:**

```plaintext
Greater?
```

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is</td>
<td>Integer 32 Variable</td>
<td>CALCULATED_VALUE</td>
</tr>
<tr>
<td>Than</td>
<td>Integer 32 Literal</td>
<td>1000</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```plaintext
OptoScript doesn't use a command; the function is built in. Use the > operator.
```

```plaintext
if (CALCULATED_VALUE > 1000) then
```

**Notes:**
- For more information, see “Logical Commands” and “Using OptoScript” in the PAC Control User’s Guide (form 1700).
- Use Within Limits? to test for an approximate match. To test for less than or equal, use either Less Than or Equal? or the false exit.

**See Also:**
- “Less?” on page 407
- “Not Equal to Numeric Table Element?” on page 413
- “Greater Than or Equal?” on page 396
“Less Than or Equal to Numeric Table Element?” on page 403
“Within Limits?” on page 441
Int32 to Float Bits

Logical Action

Function: To move the internal bit pattern of an integer 32 into a float.

Typical Use: To help parse or create binary data when communicating with other devices.

Details: This command is similar to Move 32 Bits, but is more flexible in OptoScript blocks. It can be used inside another expression, which can reduce the need for temporary variables compared to Move 32 Bits.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0 From</th>
<th>Argument 1 To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Integer 32 Literal</td>
<td>Float Variable</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td></td>
</tr>
</tbody>
</table>

Action Block Example:

```
Int32 to Float Bits
```

OptoScript Example:

```
Int32ToFloatBits (From)
nFloat = Int32ToFloatBits (nInt32);
```

This is a function command; it returns a float value. The returned value can be consumed by a variable (as in the example shown) or used by an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).
### Less Than Numeric Table Element?

**Logical Condition**

**Function:** To determine if a numeric value is less than a specified value in a float or integer table.

**Typical Use:** To store low values.

**Details:**
- If the value of Is (Argument 0) is less than the value at the specified table (Of Table, Argument 2) and index (At Index, Argument 1), the logic will take the True path.
- If Is is greater than or equal to the value at the specified table and index, the logic will take the False path.

**Examples:**

<table>
<thead>
<tr>
<th>Is</th>
<th>Value at Of Table[At Index]</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>-98.766</td>
<td>-98.765</td>
<td>True</td>
</tr>
<tr>
<td>-32768</td>
<td>-32767</td>
<td>True</td>
</tr>
<tr>
<td>0.0</td>
<td>0.0</td>
<td>False</td>
</tr>
<tr>
<td>0.0001</td>
<td>0.0</td>
<td>False</td>
</tr>
<tr>
<td>22221</td>
<td>2222</td>
<td>False</td>
</tr>
</tbody>
</table>

**Arguments:**

- **Argument 0**
  - Is
  - Analog Input
  - Analog Output
  - Digital Input
  - Digital Output
  - Down Timer Variable
  - Float Literal
  - Float Variable
  - Integer 32 Literal
  - Integer 32 Variable
  - Integer 64 Literal
  - Integer 64 Variable
  - Up Timer Variable

- **Argument 1**
  - At Index
  - Integer 32 Literal
  - Integer 32 Variable

- **Argument 2**
  - Of Table
  - Float Table
  - Integer 32 Table
  - Integer 64 Table

**Condition Block Example:**

```
Less Than Numeric Table Element?
```

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is</td>
<td>Float Variable</td>
<td>THIS_READING</td>
</tr>
<tr>
<td>At Index</td>
<td>Integer 32 Variable</td>
<td>TABLE_INDEX</td>
</tr>
<tr>
<td>Of Table</td>
<td>Float Table</td>
<td>TABLE_OF_READINGS</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```
if (THIS_READING < TABLE_OF_READINGS[TABLE_INDEX]) then
```

**Notes:**
- The example shown is only one of many ways to use the `<` operator. For more information, see “Logical Commands” and “Using OptoScript” in the PAC Control User's Guide (form 1700).
- To test for greater than or equal to, use either Greater Than or Equal To Numeric Table Element? or the False exit.
Queue Errors: -12 = Invalid table index value. Index was negative or greater than or equal to table size.

See Also: “Greater Than or Equal To Numeric Table Element?” on page 394
Less Than or Equal to Numeric Table Element?

Logical Condition

**Function:**
To determine if a numeric value is less than or equal to a specified value in a float or integer table.

**Typical Use:**
To store low values.

**Details:**
- If the value of `Is` (Argument 0) is less than or equal to the value at the specified table (Of Table, Argument 2) and index (At Index, Argument 1), the logic will take the True path.
- If `Is` is greater than the value in the specified table and index, the logic will take the False path.

**Examples:**

<table>
<thead>
<tr>
<th><code>Is</code></th>
<th>Value at Of Table[At Index]</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.0</td>
<td>0.0</td>
<td>True</td>
</tr>
<tr>
<td>22.22</td>
<td>22.222</td>
<td>True</td>
</tr>
<tr>
<td>-32768</td>
<td>-32767</td>
<td>True</td>
</tr>
<tr>
<td>0.0001</td>
<td>0.0</td>
<td>False</td>
</tr>
<tr>
<td>22221</td>
<td>2222</td>
<td>False</td>
</tr>
</tbody>
</table>

**Arguments:**

- **Argument 0**
  - `Is`
    - Analog Input
    - Analog Output
    - Digital Input
    - Digital Output
    - Down Timer Variable
    - Float Literal
    - Float Variable
    - Integer 32 Literal
    - Integer 32 Variable
    - Integer 64 Literal
    - Integer 64 Variable
    - Up Timer Variable

- **Argument 1**
  - `At Index`
    - Integer 32 Literal
    - Integer 32 Variable

- **Argument 2**
  - `Of Table`
    - Float Table
    - Integer 32 Table
    - Integer 64 Table

**Condition Block Example:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>Is</code></td>
<td>Float Variable</td>
<td>THIS_READING</td>
</tr>
<tr>
<td><code>At Index</code></td>
<td>Integer 32 Variable</td>
<td>TABLE_INDEX</td>
</tr>
<tr>
<td><code>Of Table</code></td>
<td>Float Table</td>
<td>TABLE_OF_READINGS</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

OptoScript doesn’t use a command; the function is built in. Use the `<=` operator.

```opto
if (THIS_READING <= TABLE_OF_READINGS[TABLE_INDEX]) then
```

**Notes:**

- The example shown is only one of many ways to use the `<=` operator. For more information, see “Logical Commands” and “Using OptoScript” in the PAC Control User’s Guide (form 1700).
- To test for greater than, use either Greater Than Numeric Table Element? or the False exit.
Queue Errors: -12 = Invalid table index value. Index was negative or greater than or equal to the table size.

See Also: “Greater Than Numeric Table Element?” on page 392
“Not Equal to Numeric Table Element?” on page 413
“Equal to Numeric Table Element?” on page 384
“Greater Than or Equal To Numeric Table Element?” on page 394
CHAPTER 14: LOGICAL COMMANDS

Less Than or Equal?
Logical Condition

**Function:** To determine if one numeric value is less than or equal to another.

**Typical Use:** To determine if a value is too low.

**Details:**
- If the value of `Is` (Argument 0) is less than or equal to the value of `To` (Argument 1), the logic will take the True path.
- If the value of `Is` is greater than `To`, the logic will take the False path.

**Examples:**

<table>
<thead>
<tr>
<th>Is</th>
<th>To</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>True</td>
</tr>
<tr>
<td>-1</td>
<td>0</td>
<td>True</td>
</tr>
<tr>
<td>-1</td>
<td>-3</td>
<td>False</td>
</tr>
<tr>
<td>22.221</td>
<td>22.220</td>
<td>False</td>
</tr>
</tbody>
</table>

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is</td>
<td>To</td>
</tr>
<tr>
<td>Analog Input</td>
<td>Analog Input</td>
</tr>
<tr>
<td>Analog Output</td>
<td>Analog Output</td>
</tr>
<tr>
<td>Digital Input</td>
<td>Digital Input</td>
</tr>
<tr>
<td>Digital Output</td>
<td>Digital Output</td>
</tr>
<tr>
<td>Down Timer Variable</td>
<td>Down Timer Variable</td>
</tr>
<tr>
<td>Float Literal</td>
<td>Float Literal</td>
</tr>
<tr>
<td>Float Variable</td>
<td>Float Variable</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Integer 64 Literal</td>
<td>Integer 64 Literal</td>
</tr>
<tr>
<td>Integer 64 Variable</td>
<td>Integer 64 Variable</td>
</tr>
<tr>
<td>Up Timer Variable</td>
<td>Up Timer Variable</td>
</tr>
</tbody>
</table>

**Condition Block Example:**

```
Less Than or Equal?
```

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is</td>
<td>Float Variable</td>
<td>TEMPERATURE</td>
</tr>
<tr>
<td>To</td>
<td>Float Literal</td>
<td>98.60</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```
OptoScript doesn't use a command; the function is built in. Use the <= operator.

if (TEMPERATURE <= 98.60) then
```

**Notes:**
- The example shown is only one of many ways to use the <= operator. For more information, see "Logical Commands" and "Using OptoScript" in the PAC Control User's Guide (form 1700).
- Use Within Limits? to test for an approximate match.
- To test for greater than, use either the Greater? condition or the False exit.
See Also:  “Greater Than Numeric Table Element?” on page 392
“Not Equal to Numeric Table Element?” on page 413
“Greater Than or Equal?” on page 396
Less?
Logical Condition

Function: To determine if one numeric value is less than another.

Typical Use: To determine if a value is too low.

Details:
- If *Is* (Argument 0) is less than *Than* (Argument 1), the logic will take the True path.
- If *Is* is greater than or equal to *Than*, the logic will take the False path.

Examples:

<table>
<thead>
<tr>
<th>Is</th>
<th>Than</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>-1</td>
<td>0</td>
<td>True</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>False</td>
</tr>
<tr>
<td>-1</td>
<td>-3</td>
<td>False</td>
</tr>
<tr>
<td>22.221</td>
<td>22.220</td>
<td>False</td>
</tr>
</tbody>
</table>

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is</td>
<td>Than</td>
</tr>
<tr>
<td>Analog Input</td>
<td>Analog Input</td>
</tr>
<tr>
<td>Analog Output</td>
<td>Analog Output</td>
</tr>
<tr>
<td>Digital Input</td>
<td>Digital Input</td>
</tr>
<tr>
<td>Digital Output</td>
<td>Digital Output</td>
</tr>
<tr>
<td>Down Timer Variable</td>
<td>Down Timer Variable</td>
</tr>
<tr>
<td>Float Literal</td>
<td>Float Literal</td>
</tr>
<tr>
<td>Float Variable</td>
<td>Float Variable</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Integer 64 Literal</td>
<td>Integer 64 Literal</td>
</tr>
<tr>
<td>Integer 64 Variable</td>
<td>Integer 64 Variable</td>
</tr>
<tr>
<td>Up Timer Variable</td>
<td>Up Timer Variable</td>
</tr>
</tbody>
</table>

Condition Block Example:

```
<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is</td>
<td>Analog Input</td>
<td>TANK_LEVEL</td>
</tr>
<tr>
<td>Than</td>
<td>Float Variable</td>
<td>FILE_SETPOINT</td>
</tr>
</tbody>
</table>
```

OptoScript Example:

OptoScript doesn’t use a command; the function is built in. Use the `<` operator.

```
if (TANK_LEVEL < FILE_SETPOINT) then
```

Notes:
- The example shown is only one of many ways to use the `<` operator. For more information, see “Logical Commands” and “Using OptoScript” in the PAC Control User’s Guide (form 1700).
- Use Within Limits? to test for an approximate match.
- To test for greater than or equal to, use either Greater Than or Equal? or the False exit.

See Also:
- “Greater Than Numeric Table Element?” on page 392
- “Not Equal to Numeric Table Element?” on page 413
“Equal?” on page 386
“Greater Than or Equal?” on page 396
Make Integer 64

Logical Action

**Function:**
To combine two 32-bit integers into a single 64-bit integer.

**Typical Use:**
To put the two halves of a 64-bit integer back together after separating them for faster individual manipulation.

**Details:**
- Places one 32-bit integer in the upper half of a 64-bit integer and the other 32-bit integer in the lower half.
- When the integer 64 is made, the least significant bit corresponds to point zero and the most significant bit corresponds to point 64 on a 64-point digital rack, when *Put in* (Argument 2) is an I/O unit.

**Arguments:**
- **Argument 0**
  - **High Integer**
    - Integer 32 Literal
    - Integer 32 Variable
  - **Low Integer**
    - Integer 32 Literal
    - Integer 32 Variable
- **Argument 1**
  - Integer 64 Variable
- **Argument 2**
  - Integer 64 Variable

**Action Block Example:**
```
Make Integer 64
```

**OptoScript Example:**
```
MakeInt64(High Integer, Low Integer)
```

This is a function command; it returns the 64-bit integer. The returned value can be consumed by a variable (as shown) or used by an item such as a Condition block, an OptoScript block, or a mathematical expression. It cannot be consumed by an I/O unit, however. For more information, see "Logical Commands" and "Using OptoScript" in the *PAC Control User's Guide* (form 1700).

Although the returned value cannot be consumed by an I/O unit, you can accomplish the same thing by using OptoScript code such as the following:
```
nnTemp1 = MakeInt64(nHiPart, nLoPart);
SetDigital64IoUnitFromMomo(nnTemp1, bitnot nnTemp1, MyDig64);
```

**Notes:**
This command is useful to get information from a program that doesn’t directly support 64-bit integers, such as PAC Display and third-party products.

**See Also:**
- “Get High Bits of Integer 64” on page 390
- “Get Low Bits of Integer 64” on page 391
Move 32 Bits

Logical Action

Function: To move the internal bit pattern of an integer 32 into a float, or to move a float into an integer 32.

Typical Use: To help parse or create binary data when communicating with other devices.

Arguments:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>From</td>
<td>Integer 32 Variable</td>
<td>Source_Data</td>
</tr>
<tr>
<td>To</td>
<td>Float Variable</td>
<td>Float</td>
</tr>
</tbody>
</table>

Action Block Example:

OptoScript Example:

```optoshell
Move32Bits(Source_Data, Float);
```

This is a procedure command; it does not return a value.

Notes: For more information, see “Logical Commands” and “Using OptoScript” in the PAC Control User’s Guide (form 1700).
NOT

Logical Action

**Function:** To perform a logical NOT (True/False toggle) on any allowable value.

**Typical Uses:**
- To invert the logical state of an integer variable.
- To toggle the state of a digital output.
- To have a digital output assume the inverse state of a digital input.

**Details:**
Performs a logical NOT on a copy of the value of Argument 0 and stores the result in *Put Result in* (Argument 1).

- If Argument 0 is False (0, off), the result will be a non-zero value (meaning True).
- If Argument 0 is True (non-zero, on), the result will be 0 (zero, meaning False).

*NOTE: In programming logic, 0 represents False and any non-zero number represents True.*

**Examples:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Put Result in</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>-1</td>
<td>0</td>
</tr>
<tr>
<td>22</td>
<td>0</td>
</tr>
</tbody>
</table>

**Arguments:**

- **Argument 0**
  - Logical Action
  - Function: To perform a logical NOT (True/False toggle) on any allowable value.
  - Typical Uses: To invert the logical state of an integer variable.
  - To toggle the state of a digital output.
  - To have a digital output assume the inverse state of a digital input.
  - Details: Performs a logical NOT on a copy of the value of Argument 0 and stores the result in *Put Result in* (Argument 1).
  - If Argument 0 is False (0, off), the result will be a non-zero value (meaning True).
  - If Argument 0 is True (non-zero, on), the result will be 0 (zero, meaning False).
  - *NOTE: In programming logic, 0 represents False and any non-zero number represents True.*

- **Argument 1**
  - Logical Action
  - Function: To perform a logical NOT (True/False toggle) on any allowable value.
  - Typical Uses: To invert the logical state of an integer variable.
  - To toggle the state of a digital output.
  - To have a digital output assume the inverse state of a digital input.
  - Details: Performs a logical NOT on a copy of the value of Argument 0 and stores the result in *Put Result in* (Argument 1).
  - If Argument 0 is False (0, off), the result will be a non-zero value (meaning True).
  - If Argument 0 is True (non-zero, on), the result will be 0 (zero, meaning False).
  - *NOTE: In programming logic, 0 represents False and any non-zero number represents True.*

**Examples:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Put Result in</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>-1</td>
<td>0</td>
</tr>
<tr>
<td>22</td>
<td>0</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

OptoScript doesn’t use a command; the function is built in. Use the **not** operator.

```
DOUT1 = not Current_State;
```

**Notes:**

- The example shown is only one of many ways to use the **not** operator. For more information, see “Logical Commands” and “Using OptoScript” in the **PAC Control User’s Guide** (form 1700).
- Integers or digital points are best for this command. For other types, consider using Test Within Limits, Test Greater, and Test Less.
- To invert the True/False state of Argument 0, make the value of Argument 0 and *Put Result in* (Argument 1) the same.
- To toggle all 32 or 64 bits of an integer, use Bit NOT.
See Also:

- “Bit NOT” on page 364
- “Test Greater” on page 428
- “Test Less” on page 432
- “Test Within Limits” on page 438
Not Equal to Numeric Table Element?

Logical Condition

**Function:** To determine if a numeric value is different from a specified value in a float or integer table.

**Typical Use:** To perform reverse logic.

**Details:**
- If the value of *Is* (Argument 0) is different than the value at the specified table (*Of Table*, Argument 2) and index (*At Index*, Argument 1), the logic will take the True path.
- If the value of *Is* is the same as the value at the specified table and index, the logic will take the False path.

**Examples:**

<table>
<thead>
<tr>
<th>Is</th>
<th>Value at Of Table[At Index]</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.0001</td>
<td>0.0</td>
<td>True</td>
</tr>
<tr>
<td>0.0</td>
<td>0.0</td>
<td>False</td>
</tr>
<tr>
<td>-98.765</td>
<td>-98.765</td>
<td>False</td>
</tr>
<tr>
<td>-32768</td>
<td>-32768</td>
<td>False</td>
</tr>
</tbody>
</table>

**Arguments:**

- **Argument 0**
  - *Is*
    - Analog Input
    - Analog Output
    - Digital Input
    - Digital Output
    - Down Timer Variable
    - Float Literal
    - Float Variable
    - Integer 32 Literal
    - Integer 32 Variable
    - Integer 64 Literal
    - Integer 64 Variable
    - Up Timer Variable

- **Argument 1**
  - *At Index*
    - Integer 32 Literal
    - Integer 32 Variable

- **Argument 2**
  - *Of Table*
    - Float Table
    - Integer 32 Table
    - Integer 64 Table

**Condition Block Example:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Is</em></td>
<td>Float Variable</td>
<td>This_Reading</td>
</tr>
<tr>
<td><em>At Index</em></td>
<td>Integer 32 Variable</td>
<td>Table_Index</td>
</tr>
<tr>
<td><em>Of Table</em></td>
<td>Float Table</td>
<td>Table_of_Readings</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

OptoScript doesn’t use a command; the function is built in. Use the <> operator.

```optoscript
if (This_Reading <> Table_of_Readings[Table_Index]) then
```

**Notes:**

- In OptoScript code, the <> operator can be used in several ways. For more information, see "Logical Commands" and "Using OptoScript" in the **PAC Control User's Guide** (form 1700).
- To test for equality, use either Equal to Numeric Table Element? or the False exit.

**Queue Errors:**

-12 = Invalid table index value. Index was negative or greater than or equal to table size.
See Also:
“Equal to Numeric Table Element?” on page 384
“Greater Than Numeric Table Element?” on page 392
“Greater Than or Equal To Numeric Table Element?” on page 394
“Less Than Numeric Table Element?” on page 401
“Less Than or Equal to Numeric Table Element?” on page 403
Not Equal?
Logical Condition

Function: To determine if two values are different.

Typical Use: To perform reverse logic.

Details: • If Is (Argument 0) and To (Argument 1) are not the same, the logic will take the True path.
• If Is and To are the same, the logic will take the False path.

Examples:

<table>
<thead>
<tr>
<th>Is</th>
<th>To</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>65280</td>
<td>True</td>
</tr>
<tr>
<td>65280</td>
<td>22.2</td>
<td>True</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>False</td>
</tr>
<tr>
<td>22.22</td>
<td>22.22</td>
<td>False</td>
</tr>
</tbody>
</table>

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is</td>
<td>To</td>
</tr>
<tr>
<td>Analog Input</td>
<td>Analog Input</td>
</tr>
<tr>
<td>Analog Output</td>
<td>Analog Output</td>
</tr>
<tr>
<td>Digital Input</td>
<td>Digital Input</td>
</tr>
<tr>
<td>Digital Output</td>
<td>Digital Output</td>
</tr>
<tr>
<td>Down Timer Variable</td>
<td>Down Timer Variable</td>
</tr>
<tr>
<td>Float Literal</td>
<td>Float Literal</td>
</tr>
<tr>
<td>Float Variable</td>
<td>Float Variable</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Integer 64 Literal</td>
<td>Integer 64 Literal</td>
</tr>
<tr>
<td>Integer 64 Variable</td>
<td>Integer 64 Variable</td>
</tr>
<tr>
<td>Up Timer Variable</td>
<td>Up Timer Variable</td>
</tr>
</tbody>
</table>

Condition Block Example:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is</td>
<td>Integer 32 Variable</td>
<td>BATCH_STEP</td>
</tr>
<tr>
<td>To</td>
<td>Integer 32 Literal</td>
<td>4</td>
</tr>
</tbody>
</table>

OptoScript Example: OptoScript doesn’t use a command; the function is built in. Use the <> operator.

if (BATCH_STEP <> 4) then

Notes: • In OptoScript code, the <> operator can be used in several ways. For more information, see “Logical Commands” and “Using OptoScript” in the PAC Control User’s Guide (form 1700).
• Use Within Limits? to test for an approximate match (recommended for non-integers). To test for equality, use either Equal? or the False exit.

See Also: “Greater Than Numeric Table Element?” on page 392
“Less?” on page 407
“Less Than or Equal to Numeric Table Element?” on page 403
“Greater Than or Equal?” on page 396
“Equal?” on page 386
“Within Limits?” on page 441
NOT?

Logical Condition

**Function:** To determine if a value is False (zero, off).

**Typical Use:** To perform False testing.

**Details:**
- If `Is` (Argument 0) is False (0, off), the logic will take the True path.
- If `Is` is True (non-zero, on), the logic will take the False path.

  **NOTE:** In programming logic, 0 (zero) represents False and any non-zero number represents True.

- Functionally equivalent to Variable False?

**Examples:**

<table>
<thead>
<tr>
<th><code>Is</code></th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>True</td>
</tr>
<tr>
<td>-1</td>
<td>False</td>
</tr>
<tr>
<td>22</td>
<td>False</td>
</tr>
</tbody>
</table>

**Arguments:**

- **Argument 0**
  - Digital Input
  - Digital Output
  - Float Literal
  - Float Variable
  - Integer 32 Literal
  - Integer 32 Variable
  - Integer 64 Literal
  - Integer 64 Variable

**Condition Block Example:**

<table>
<thead>
<tr>
<th>NOT?</th>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><code>Is</code></td>
<td>Integer 32 Variable</td>
<td><strong>CURRENT_STATE</strong></td>
</tr>
</tbody>
</table>

**OptoScript Example:**

OptoScript doesn’t use a command; the function is built in. Use the `not` operator.

```plaintext
if (not Current_State) then
```

**Notes:**
- Integers or digital points are best for this command. For other types, consider using Within Limits?, Greater?, or Less?
- To determine whether a value is True (non-zero), use either Variable True? or the False exit.
- The example shown is only one of many ways to use the `not` operator. For more information, see “Logical Commands” and “Using OptoScript” in the PAC Control User’s Guide (form 1700).

**See Also:**

- “AND?” on page 355
- “OR?” on page 423
- “XOR?” on page 445
- “Variable True?” on page 440
- “Within Limits?” on page 441
- “Greater Than Numeric Table Element?” on page 392
- “Less?” on page 407
**Numeric Table Element Bit Clear**

**Logical Action**

**Function:** To clear a specific bit (set it to 0) at the specified index in an integer table.

**Typical Use:** To clear a bit in an integer table that is used as a flag.

**Details:**
- Valid range for the bit to clear is 0–31.
- Table indexes are zero through table length minus one.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Element Index</td>
<td>Of Integer Table</td>
<td>Bit To Clear</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Table</td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 64 Table</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

**Action Block Example:**

```
Numeric Table Element Bit Clear
```

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Element Index</td>
<td>Integer 32 Literal</td>
<td>4</td>
</tr>
<tr>
<td>Of Integer Table</td>
<td>Integer 32 Table</td>
<td>PUMP_CTRL_BITS</td>
</tr>
<tr>
<td>Bit To Clear</td>
<td>Integer 32 Literal</td>
<td>15</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```
NumTableElementBitClear(Element Index, Of Integer Table, Bit to Clear)
```

```
NumTableElementBitClear(4, PUMP_CTRL_BITS, 15);
```

This is a procedure command; it does not return a value.

**Queue Errors:**

-12 = Invalid table index value. Index was negative or greater than the table size.

**See Also:**

- "Bit Clear" on page 361
- "Numeric Table Element Bit Set" on page 419
- "Numeric Table Element Bit Test" on page 420
**Numeric Table Element Bit Set**

**Logical Action**

**Function:** To set a specific bit (set it to 1) at the specified index in an integer table.

**Typical Use:** To set a bit in an integer table that is used as a flag.

**Details:**
- Valid range for the bit to set is 0–31.
- Table indexes are zero through table length minus one.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Element Index</strong></td>
<td><strong>Of Integer Table</strong></td>
<td><strong>Bit to Set</strong></td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Table</td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 64 Table</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

**Action Block Example:**

```
NumTableElementBitSet(4, PUMP_CTRL_BITS, 15);
```

This is a procedure command; it does not return a value.

**Queue Errors:**

-12 = Invalid table index value. Index was negative or greater than the table size.

**See Also:**

“Bit Set” on page 376
“Numeric Table Element Bit Clear” on page 418
“Numeric Table Element Bit Test” on page 420
Numeric Table Element Bit Test

Logical Action

Function: To test a specific bit at the specified index in an integer table to see if it is set or not.

Typical Use: To test a bit in an integer table that is used as a flag.

Details:
- A logical True (non-zero) is returned if the bit is set, otherwise a logical False (0) is returned.
- Valid range for the bit to test is 0–31 for Integer 32 tables, or 0–63 for Integer 64 tables.
- Table indexes are zero through table length minus one.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
<th>Argument 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Element Index</td>
<td>Of Integer Table</td>
<td>Bit to Test</td>
<td>Put Result in</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Table</td>
<td>Integer 32 Literal</td>
<td>Digital Output</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 64 Table</td>
<td>Integer 32 Variable</td>
<td>Float Variable</td>
</tr>
</tbody>
</table>

Action Block Example:

```plaintext
<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Element Index</td>
<td>Integer 32 Literal</td>
<td>4</td>
</tr>
<tr>
<td>Of Integer Table</td>
<td>Integer 32 Table</td>
<td>Pump_Ctrl_Bits</td>
</tr>
<tr>
<td>Bit to Test</td>
<td>Integer 32 Literal</td>
<td>15</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Integer 32 Variable</td>
<td>Result</td>
</tr>
</tbody>
</table>
```

OptoScript Example:

```plaintext
Result = NumTableElementBitTest(4, Pump_Ctrl_Bits, 15);
```

This is a function command; it returns the status of the bit, either set (non-zero) or not set (0). The returned value can be consumed by a variable (as in the example shown) or used by an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see "Logical Commands" and "Using OptoScript" in the PAC Control User's Guide (form 1700).

Notes: The value returned is the bit status.

Queue Errors: -12 = Invalid table index value. Index was negative or greater than the table size.

See Also:
- "Numeric Table Element Bit Set" on page 419
- "Numeric Table Element Bit Clear" on page 418
### OR

**Logical Action**

**Function:** To perform a logical OR on any two allowable values.

**Typical Use:** To use the true state of either value to control an output or set an alarm.

**Details:**
- Performs a logical OR on the value of Argument 0 and *With* (Argument 1), and then stores the result in *Put Result in* (Argument 2).
  - If both Argument 0 and *With* are True (non-zero, on), the result will be a non-zero value (meaning True).
  - If Argument 0 is True but *With* is False (0, off), the result will be a non-zero value (meaning True).
  - If Argument 0 is False but *With* is True, the result will be a non-zero value (meaning True).
  - If both Argument 0 and *With* are False (0, off), the result will be 0 (meaning False).

*NOTE:* In programming logic, 0 represents False and any non-zero number represents True.

- The result can be sent directly to a digital output if desired.

**Examples:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>With</th>
<th>Put Result in</th>
</tr>
</thead>
<tbody>
<tr>
<td>-1</td>
<td>-1</td>
<td>1</td>
</tr>
<tr>
<td>-1</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>0</td>
<td>-1</td>
<td>1</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

**Arguments:**
- **Argument 0**
  - [Value]
  - Digital Input
  - Digital Output
  - Float Literal
  - Float Variable
  - Integer 32 Literal
  - Integer 32 Variable
  - Integer 64 Literal
  - Integer 64 Variable

- **Argument 1**
  - *With*
  - Digital Input
  - Digital Output
  - Float Literal
  - Float Variable
  - Integer 32 Literal
  - Integer 32 Variable
  - Integer 64 Literal
  - Integer 64 Variable

- **Argument 2**
  - *Put Result in*
  - Digital Output
  - Float Variable
  - Integer 32 Variable
  - Integer 64 Variable

**Action Block Example:**

<table>
<thead>
<tr>
<th>OR</th>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>(none)</td>
<td>Digital Input</td>
<td>LIMIT_SWITCH1</td>
</tr>
<tr>
<td>With</td>
<td>Digital Output</td>
<td>LIMIT_SWITCH2</td>
<td></td>
</tr>
<tr>
<td>Put Result in</td>
<td>Digital Output</td>
<td>MOTOR1_OUTPUT</td>
<td></td>
</tr>
</tbody>
</table>

**OptoScript Example:**

OptoScript doesn't use a command; the function is built in. Use the `or` operator.

```
MOTOR1_OUTPUT = LIMIT_SWITCH1 or LIMIT_SWITCH2;
```

**Notes:**
- The example shown is only one of many ways to use the `or` operator. For more information, see “Logical Commands” and “Using OptoScript” in the *PAC Control User’s Guide* (form 1700).
- You should use only integers or digital points with this command.
In OptoScript code, you can combine logical operators and OR multiple variables, for example: \( x = a \lor b \lor c \lor d; \)

In standard PAC Control code, to OR multiple variables (such as A, B, C, and D) into one variable (such as RESULT), do the following:

1. OR A with B, Move To RESULT.
2. OR C with RESULT, Move To RESULT.
3. OR D with RESULT, Move To RESULT.

To test or manipulate individual bits, use Bit OR.

See Also: “Bit OR” on page 372
OR?
Logical Condition

Function: To determine if either or both of two values are True (non-zero, on).

Typical Use: To OR two values within an AND? type condition block.

Details:
- If both arguments are True (non-zero, on), the logic will take the True path.
- If either argument is True (non-zero, on), the logic will take the True path.
- If both arguments are False (0, off), the logic will take the False path.

NOTE: In programming logic, 0 represents False and any non-zero number represents True.

Examples:

<table>
<thead>
<tr>
<th>Is</th>
<th>Argument 1</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>-1</td>
<td>-1</td>
<td>True</td>
</tr>
<tr>
<td>-1</td>
<td>0</td>
<td>True</td>
</tr>
<tr>
<td>0</td>
<td>-1</td>
<td>True</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>False</td>
</tr>
</tbody>
</table>

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is</td>
<td>[Value]</td>
</tr>
<tr>
<td>Is Digital Input</td>
<td>Digital Input</td>
</tr>
<tr>
<td>Is Digital Output</td>
<td>Digital Output</td>
</tr>
<tr>
<td>Float Literal</td>
<td>Float Literal</td>
</tr>
<tr>
<td>Float Variable</td>
<td>Float Variable</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Integer 64 Literal</td>
<td>Integer 64 Literal</td>
</tr>
<tr>
<td>Integer 64 Variable</td>
<td>Integer 64 Variable</td>
</tr>
</tbody>
</table>

Condition Block Example:

```
if (LIMIT_SWITCH1 or LIMIT_SWITCH2) then
```

OptoScript Example: OptoScript doesn’t use a command; the function is built in. Use the or operator.

```
if (LIMIT_SWITCH1 or LIMIT_SWITCH2) then
```

Notes:
- The example shown is only one of many ways to use the or operator. For more information, see “Logical Commands” and “Using OptoScript” in the PAC Control User's Guide (form 1700).
- It is advisable to use only integers or digital points with this command.
- To determine whether both values are False (zero, off), use either Variable False? or the False exit.
- Multiple uses of OR? within a condition block result in the OR? pairs being AND?ed.

See Also: *NOT* on page 411
*AND?* on page 355
*XOR?* on page 445
Set Variable False

Logical Action

Function: To move a 0 (zero, meaning False) value into a variable. 

NOTE: In programming logic, 0 represents False and any non-zero number represents True.

Typical Use: To clear a variable after it has been used for program logic.

Details: All numeric variables are False by default unless initialized by the user to a non-zero value.

Arguments: Argument 0
[Value] 
Float Variable
Integer 32 Variable

Action Block
Example:

Set Variable False
<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>(none)</td>
<td>Integer 32 Variable</td>
<td>Flag_Hopper_Full</td>
</tr>
</tbody>
</table>

OptoScript
Example: SetVariableFalse(Argument 0)

SetVariableFalse(Flag_Hopper_Full);

This is a procedure command; it does not return a value.

Notes: • For more information, see “Logical Commands” and “Using OptoScript” in the PAC Control User’s Guide (form 1700).
• Speed Tip: This command is faster than Move for moving a zero to a variable.

See Also: “Set Variable True” on page 425
Set Variable True

Logical Action

Function: To move a 1 (one, meaning True) value into a variable.

NOTE: In programming logic, 0 represents False and any non-zero number represents True.

Typical Use: To set a variable to true.

Details: All numeric variables are False by default unless initialized to a non-zero value.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Float Variable</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td></td>
</tr>
</tbody>
</table>

Action Block Example:

Set Variable True

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>(none)</td>
<td>Integer 32 Variable</td>
<td>FLAG_JOB_DONE</td>
</tr>
</tbody>
</table>

OptoScript Example:

SetVariableTrue(FLAG_JOB_DONE);

This is a procedure command; it does not return a value.

Notes:

- For more information, see “Logical Commands” and “Using OptoScript” in the PAC Control User’s Guide (form 1700).
- Speed Tip: This command is faster than Move for moving a +1 value to a variable.

See Also: “Set Variable False” on page 424
Test Equal

Logical Action

Function: To determine if two values are equal.

Typical Use: To perform logic branching based on whether an argument equals a set value.

Details:
- Determines if the value of Argument 0 is equal to the value of With (Argument 1), and stores the result in Put Result in (Argument 2).
  - If the values are the same, the result will be a non-zero value (meaning True).
  - If the values are not the same, the result will be 0 (meaning False).

  NOTE: In programming logic, 0 represents False and any non-zero number represents True.

- The result can be sent directly to a digital output if desired.

Examples:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>With</th>
<th>Put Result in</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>22.22</td>
<td>22.22</td>
<td>1</td>
</tr>
<tr>
<td>-1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>255</td>
<td>65280</td>
<td>0</td>
</tr>
</tbody>
</table>

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Value]</td>
<td>With</td>
<td>Put Result in</td>
</tr>
<tr>
<td>Analog Input</td>
<td>Analog Input</td>
<td>Digital Output</td>
</tr>
<tr>
<td>Analog Output</td>
<td>Analog Output</td>
<td>Float Variable</td>
</tr>
<tr>
<td>Digital Input</td>
<td>Digital Input</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Digital Output</td>
<td>Digital Output</td>
<td>Up Timer Variable</td>
</tr>
<tr>
<td>Down Timer Variable</td>
<td>Down Timer Variable</td>
<td></td>
</tr>
<tr>
<td>Float Literal</td>
<td>Float Literal</td>
<td></td>
</tr>
<tr>
<td>Float Variable</td>
<td>Float Variable</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
<td></td>
</tr>
<tr>
<td>Integer 64 Literal</td>
<td>Integer 64 Literal</td>
<td></td>
</tr>
<tr>
<td>Integer 64 Variable</td>
<td>Integer 64 Variable</td>
<td></td>
</tr>
<tr>
<td>Up Timer Variable</td>
<td>Up Timer Variable</td>
<td></td>
</tr>
</tbody>
</table>

Action Block Example:

Test Equal

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>(none)</td>
<td>Integer 32 Variable</td>
<td>TOP_LEVEL</td>
</tr>
<tr>
<td>With</td>
<td>Integer 32 Literal</td>
<td>1000</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Integer 32 Variable</td>
<td>FLAG_AT_THE_TOP</td>
</tr>
</tbody>
</table>

OptoScript Example:

For an OptoScript equivalent, see the Equal? command.

Notes:
- For more information, see “Logical Commands” and “Using OptoScript” in the PAC Control User’s Guide (form 1700).
In many cases it may be safer to use Test Greater or Equal or Test Less or Equal instead, since exact matches of non-integer types are rare. Be careful when testing equality of floating point values, since the values must be exactly identical for a true result to occur. Consider using the following test:

\[ \text{AbsolutedValue(test\_float - compare\_float)} < \text{zero\_tolerance} \]

See Also:

“Test Greater” on page 428
“Test Less” on page 432
“Test Greater or Equal” on page 430
“Test Less or Equal” on page 434
“Test Not Equal” on page 436
Test Greater

**Logical Action**

**Function:** To determine if one value is greater than another.

**Typical Use:** To determine if an analog value is too high.

**Details:**
- Determines if Is (Argument 0) is greater than Greater Than (Argument 1), and stores the result in Put Result in (Argument 2).
  - If Is is greater than Greater Than, the result will be a non-zero value (meaning True).
  - If Is is less than or equal to Greater Than, the result will be 0 (zero, meaning False).

*NOTE: In programming logic, 0 represents False and any non-zero number represents True.*
- The result can be sent directly to a digital output if desired.

**Examples:**

<table>
<thead>
<tr>
<th>Is</th>
<th>Greater than</th>
<th>Put Result in</th>
</tr>
</thead>
<tbody>
<tr>
<td>-1</td>
<td>-3</td>
<td>1</td>
</tr>
<tr>
<td>22.221</td>
<td>22.220</td>
<td>1</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>-1</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

**Arguments:**

- **Argument 0**
  - Is
  - Analog Input
  - Analog Output
  - Digital Input
  - Digital Output
  - Down Timer Variable
  - Float Literal
  - Float Variable
  - Integer 32 Literal
  - Integer 32 Variable
  - Integer 64 Literal
  - Integer 64 Variable
  - Up Timer Variable

- **Argument 1**
  - Greater than
  - Analog Input
  - Analog Output
  - Digital Input
  - Digital Output
  - Down Timer Variable
  - Float Literal
  - Float Variable
  - Integer 32 Literal
  - Integer 32 Variable
  - Integer 64 Literal
  - Integer 64 Variable
  - Up Timer Variable

- **Argument 2**
  - Put Result in
  - Digital Output
  - Float Variable
  - Integer 32 Variable
  - Up Timer Variable

**Action Block Example:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is</td>
<td>Analog Input</td>
<td>TEMP</td>
</tr>
<tr>
<td>Greater than</td>
<td>Integer 32 Literal</td>
<td>1000</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Integer 32 Variable</td>
<td>TEMP_COMPARISON</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

For an OptoScript equivalent, see the Greater? command.

**Notes:**
- For more information, see “Logical Commands” and “Using OptoScript” in the *PAC Control User’s Guide* (form 1700).
• Consider using Test Greater or Equal instead.

See Also:
“Test Equal” on page 426
“Test Less” on page 432
“Test Greater or Equal” on page 430
“Test Less or Equal” on page 434
“Test Not Equal” on page 436
CHAPTER 14: LOGICAL COMMANDS

Test Greater or Equal

Logical Action

Function: To determine if one value is greater than or equal to another.

Typical Use: To determine if an analog value has reached a maximum allowable value.

Details:
- Determines if Is (Argument 0) is greater than or equal to the value of > or = (Argument 1), and stores the result in Put Result in (Argument 2).
  - If Is is greater than or equal to > or =, the result will be a non-zero value (meaning True).
  - If Is is less than > or =, the result will be 0 (zero, meaning False).

  NOTE: In programming logic, 0 represents False and any non-zero number represents True.

- The result can be sent directly to a digital output if desired.

Examples:

<table>
<thead>
<tr>
<th>Is</th>
<th>&gt; or =</th>
<th>Put Result in</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>-1</td>
<td>-3</td>
<td>1</td>
</tr>
<tr>
<td>0.000</td>
<td>22.220</td>
<td>1</td>
</tr>
</tbody>
</table>

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is</td>
<td>&gt; or =</td>
<td>Put Result in</td>
</tr>
<tr>
<td>Analog Input</td>
<td>Analog Input</td>
<td>Digital Output</td>
</tr>
<tr>
<td>Analog Output</td>
<td>Analog Output</td>
<td>Float Variable</td>
</tr>
<tr>
<td>Digital Input</td>
<td>Digital Input</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Digital Output</td>
<td>Digital Output</td>
<td>Up Timer Variable</td>
</tr>
<tr>
<td>Down Timer Variable</td>
<td>Down Timer Variable</td>
<td></td>
</tr>
<tr>
<td>Float Literal</td>
<td>Float Literal</td>
<td></td>
</tr>
<tr>
<td>Float Variable</td>
<td>Float Variable</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
<td></td>
</tr>
<tr>
<td>Integer 64 Literal</td>
<td>Integer 64 Literal</td>
<td></td>
</tr>
<tr>
<td>Integer 64 Variable</td>
<td>Integer 64 Variable</td>
<td></td>
</tr>
<tr>
<td>Up Timer Variable</td>
<td>Up Timer Variable</td>
<td></td>
</tr>
</tbody>
</table>

Action Block Example:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is</td>
<td>Analog Input</td>
<td>ROOM_TEMP</td>
</tr>
<tr>
<td>&gt; or =</td>
<td>Float Literal</td>
<td>78.5000</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Integer 32 Variable</td>
<td>FLAG_ROOM_TEMP_OK</td>
</tr>
</tbody>
</table>

OptoScript Example:

For an OptoScript equivalent, see the Greater Than or Equal? command.

Notes:
- For more information, see “Logical Commands” and “Using OptoScript” in the PAC Control User’s Guide (form 1700).
When using analog values or digital features in this command, be sure to take into consideration the units that the value is read in and adjust the test values accordingly.

See Also:
- “Test Equal” on page 426
- “Test Less” on page 432
- “Test Greater” on page 428
- “Test Less or Equal” on page 434
- “Test Not Equal” on page 436
CHAPTER 14: LOGICAL COMMANDS

Test Less
Logical Action

Function: To determine if one value is less than another.

Typical Use: To determine if a tank needs to be filled.

Details:
- Determines if Is (Argument 0) is less than Less than (Argument 1), and stores the result in Put Result in (Argument 2).
  - If Is is less than Less than, the result will be a non-zero value (meaning True).
  - If Is is greater than or equal to Less than, the result will be 0 (zero, meaning False).

NOTE: In programming logic, 0 represents False and any non-zero number represents True.
- The result can be sent directly to a digital output if desired.

Examples:

<table>
<thead>
<tr>
<th>Is</th>
<th>Less than</th>
<th>Put Result in</th>
</tr>
</thead>
<tbody>
<tr>
<td>-1</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>22.221</td>
<td>22.220</td>
<td>0</td>
</tr>
<tr>
<td>-1</td>
<td>-3</td>
<td>0</td>
</tr>
</tbody>
</table>

Arguments:
- **Argument 0** Is
- **Argument 1** Less than
- **Argument 2** Put Result in

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is</td>
<td>Analog Input</td>
<td>TANK_LEVEL</td>
</tr>
<tr>
<td>Less than</td>
<td>Integer 32 Variable</td>
<td>FULL_TANK_LEVEL</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Digital Output</td>
<td>FLAG_TANK_FILL_VALVE</td>
</tr>
</tbody>
</table>

Action Block Example:

<table>
<thead>
<tr>
<th>Test Less</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argument Name</td>
</tr>
<tr>
<td>Is</td>
</tr>
<tr>
<td>Less than</td>
</tr>
<tr>
<td>Put Result in</td>
</tr>
</tbody>
</table>

OptoScript Example:

For an OptoScript equivalent, see the Less? command.

Notes:
- For more information, see “Logical Commands” and “Using OptoScript” in the PAC Control User’s Guide (form 1700).
Consider using Test Less or Equal instead, since exact matches of non-integer types are rare.

See Also:
“Test Greater” on page 428
“Test Equal” on page 426
“Test Greater or Equal” on page 430
“Test Less or Equal” on page 434
“Test Not Equal” on page 436
Test Less or Equal

Logical Action

**Function:** To determine if one value is less than or equal to another.

**Typical Use:** To determine if a temperature is below or the same as a certain value.

**Details:**
- Determines if \( Is \) (Argument 0) is less than or equal to the value of \(<\ or\ =\) (Argument 1), and stores the result in \( Put\ Result\ in\) (Argument 2).
  - If \( Is \) is less than or equal to the value of \(<\ or\ =\), the result will be a non-zero value (meaning True).
  - If \( Is \) is greater than \( >\ or\ =\), the result will be a 0 (meaning False).
  
  **NOTE:** In programming logic, 0 represents False and any non-zero number represents True.
- The result can be sent directly to a digital output if desired.

**Examples:**

<table>
<thead>
<tr>
<th>( Is )</th>
<th>(&lt;\ or\ =)</th>
<th>( Put\ Result\ in)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>-1</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>22.221</td>
<td>22.220</td>
<td>0</td>
</tr>
<tr>
<td>-1</td>
<td>-3</td>
<td>0</td>
</tr>
</tbody>
</table>

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is</td>
<td>(&lt;\ or\ =)</td>
<td>( Put\ Result\ in)</td>
</tr>
<tr>
<td>Analog Input</td>
<td>Analog Input</td>
<td>Digital Output</td>
</tr>
<tr>
<td>Analog Output</td>
<td>Analog Output</td>
<td>Float Variable</td>
</tr>
<tr>
<td>Digital Input</td>
<td>Digital Input</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Digital Output</td>
<td>Digital Output</td>
<td>Up Timer Variable</td>
</tr>
<tr>
<td>Down Timer Variable</td>
<td>Down Timer Variable</td>
<td></td>
</tr>
<tr>
<td>Float Literal</td>
<td>Float Literal</td>
<td></td>
</tr>
<tr>
<td>Float Variable</td>
<td>Float Variable</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
<td></td>
</tr>
<tr>
<td>Integer 64 Literal</td>
<td>Integer 64 Literal</td>
<td></td>
</tr>
<tr>
<td>Integer 64 Variable</td>
<td>Integer 64 Variable</td>
<td></td>
</tr>
<tr>
<td>Up Timer Variable</td>
<td>Up Timer Variable</td>
<td></td>
</tr>
</tbody>
</table>

**Action Block Example:**

```
Test Less or Equal
```

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>( Is )</td>
<td>Float Variable</td>
<td>TEMPERATURE</td>
</tr>
<tr>
<td>(&lt;\ or\ =)</td>
<td>Float Literal</td>
<td>98.6</td>
</tr>
<tr>
<td>( Put\ Result\ in)</td>
<td>Integer 32 Variable</td>
<td>FLAG_TEMP_OK</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

For an OptoScript equivalent, see the **Less Than or Equal?** command.

**Notes:**
- For more information, see “Logical Commands” and “Using OptoScript” in the **PAC Control User’s Guide** (form 1700).
When using analog values or digital features in this command, be sure to take into consideration the units that the value is read in and adjust the test values accordingly.

See Also:

- “Test Greater” on page 428
- “Test Less” on page 432
- “Test Greater or Equal” on page 430
- “Test Equal” on page 426
- “Test Not Equal” on page 436
Test Not Equal

Logical Action

Function: To determine if two values are different.

Typical Use: To check a variable against a standard.

Details:

- Determines if Is (Argument 0) is different than Not Equal to (Argument 1), and stores the result in Put Result in (Argument 2).
  - If Is is not the same as Not Equal to, the result will be a non-zero value (meaning True).
  - If Is and Not Equal to are the same, the result will be 0 (meaning False).

NOTE: In programming logic, 0 represents False and any non-zero number represents True.

- The result can be sent directly to a digital output if desired.

Examples:

<table>
<thead>
<tr>
<th>Is</th>
<th>Not Equal to</th>
<th>Put Result in</th>
</tr>
</thead>
<tbody>
<tr>
<td>-1</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>255</td>
<td>65280</td>
<td>1</td>
</tr>
<tr>
<td>22.22</td>
<td>22.22</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

Arguments:

- Argument 0: Is
  - Analog Input
  - Analog Output
  - Digital Input
  - Digital Output
  - Down Timer Variable
  - Float Literal
  - Float Variable
  - Integer 32 Literal
  - Integer 32 Variable
  - Integer 64 Literal
  - Integer 64 Variable
  - Up Timer Variable

- Argument 1: Not Equal to
  - Analog Input
  - Analog Output
  - Digital Input
  - Digital Output
  - Down Timer Variable
  - Float Literal
  - Float Variable
  - Integer 32 Literal
  - Integer 32 Variable
  - Integer 64 Literal
  - Integer 64 Variable
  - Up Timer Variable

- Argument 2: Put Result in
  - Digital Output
  - Float Variable
  - Integer 32 Variable
  - Up Timer Variable

Action Block Example:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is</td>
<td>Integer 32 Variable</td>
<td>COUNTER_VALUE</td>
</tr>
<tr>
<td>Not Equal to</td>
<td>Integer 32 Literal</td>
<td>100</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Integer 32 Variable</td>
<td>FLAG_NOT_DONE</td>
</tr>
</tbody>
</table>

OptoScript Example:

For an OptoScript equivalent, see the Not Equal? command.

Notes:

- For more information, see “Logical Commands” and “Using OptoScript” in the PAC Control User’s Guide (form 1700).
Be careful when testing equality of floating point values, since the values must be exactly identical for a false result to occur. Consider using the following test:

\[
\text{AbsolutedValue(test\_float - compare\_float)} > \text{float\_tolerance}
\]

See Also:
- “Test Equal” on page 426
- “Test Greater” on page 428
- “Test Greater or Equal” on page 430
- “Test Less” on page 432
- “Test Less or Equal” on page 434
Test Within Limits

Logical Action

**Function:**
To determine if a value is greater than or equal to a low limit and less than or equal to a high limit.

**Typical Use:**
To check if a temperature is within an acceptable range.

**Details:**
A logical True (non-zero) is returned if within limits, otherwise a logical False (0) is returned.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
<th>Argument 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is</td>
<td>&gt;=</td>
<td>And &lt;=</td>
<td>Put Result in</td>
</tr>
<tr>
<td>Analog Input</td>
<td>Float Literal</td>
<td>Float Literal</td>
<td>Float Variable</td>
</tr>
<tr>
<td>Analog Output</td>
<td>Float Variable</td>
<td>Float Variable</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Down Timer Variable</td>
<td>Integer 32 Literal</td>
<td>Integer 32 Variable</td>
<td>Integer 64 Variable</td>
</tr>
<tr>
<td>Float Literal</td>
<td>Integer 64 Literal</td>
<td>Integer 64 Variable</td>
<td></td>
</tr>
<tr>
<td>Float Variable</td>
<td>Integer 64 Variable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 64 Variable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 64 Variable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Integer 64 Literal</td>
<td>Integer 64 Variable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Integer 64 Variable</td>
<td>Integer 64 Variable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Up Timer Variable</td>
<td>Integer 64 Variable</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Action Block Example:**

```
Test Within Limits

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is</td>
<td>Float Variable</td>
<td>CURRENT_TEMP</td>
</tr>
<tr>
<td>&gt;=</td>
<td>Float Variable</td>
<td>COLDEST_TEMP</td>
</tr>
<tr>
<td>And &lt;=</td>
<td>Float Variable</td>
<td>HOTTEST_TEMP</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Integer 32 Variable</td>
<td>RESULT</td>
</tr>
</tbody>
</table>
```

**OptoScript Example:**

For an OptoScript equivalent, see the Within Limits? command.

**See Also:**
- "Test Greater" on page 428
- "Test Less" on page 432
- "Test Greater or Equal" on page 430
- "Test Less or Equal" on page 434
- "Test Equal" on page 426
- "Test Not Equal" on page 436
Variable False?

Logical Condition

**Function:**
To determine if the specified variable is 0 (zero, meaning False).

**Typical Use:**
To determine if further processing should take place.

**Details:**
If the value of Is (Argument 0) is 0 (zero, meaning False), the logic will take the True path.
If the value of Is is not 0, the logic will take the False path.

*NOTE: In programming logic, 0 represents False and any non-zero number represents True.*

**Arguments:**
Argument 0
Is
Float Variable
Integer 32 Variable
Integer 64 Variable

**Condition Block Example:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is</td>
<td>Integer 32 Variable</td>
<td>Pressure_Difference</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```opto
IsVariableFalse(Is)
if (IsVariableFalse(Pressure_Difference)) then
```

This is a function command; it returns a value of true (non-zero) or false (0). The returned value can be consumed by a control structure (as in the example shown) or by a variable, I/O point, and so forth. For more information, see “Logical Commands” and “Using OptoScript” in the PAC Control User’s Guide (form 1700).

A shorter way to achieve the same result in OptoScript code is to use the following:

```opto
if (not Pressure_Difference) then
```

**See Also:**
“Variable True?” on page 440
Variable True?

Logical Condition

Function: To determine if the specified variable is non-zero (meaning True)

Typical Use: To determine if further processing should take place.

Details: If the value of the variable is a non-zero number, the logic will take the True path.
If the value of the variable is 0 (zero, meaning False), the logic will take the False path.

NOTE: In programming logic, 0 represents False and any non-zero number represents True.

Arguments: Argument 0
Is
Float Variable
Integer 32 Variable
Integer 64 Variable

Condition Block Example:

OptoScript Example: IsVariableTrue(Is)

This is a function command; it returns a value of true (non-zero) or false (0). The returned value can be consumed by a control structure (as in the example shown) or by a variable, I/O point, and so forth.

A shorter way to achieve the same result in OptoScript code is to use the following:

if (Pressure_Difference) then

For more information, see “Logical Commands” and “Using OptoScript” in the PAC Control User’s Guide (form 1700).

See Also: “Variable False?” on page 439
## Within Limits?

**Logical Condition**

**Function:**
To determine if a value is greater than or equal to a low limit and less than or equal to a high limit.

**Typical Use:**
To check if a temperature is within an acceptable range.

**Details:**
- If Is (Argument 0) is greater than or equal to > or = (Argument 1) and less than or equal to And <= (Argument 2), the logic will take the True path.
- If Is is less than > or =, the logic will take the False path.
- If Is is greater than And <=, the logic will take the False path.

**Examples:**

<table>
<thead>
<tr>
<th>Is</th>
<th>&gt;=</th>
<th>And &lt;=</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.0</td>
<td>0.0</td>
<td>100.0</td>
<td>True</td>
</tr>
<tr>
<td>-1.0</td>
<td>-45.0</td>
<td>45.0</td>
<td>True</td>
</tr>
<tr>
<td>-32768</td>
<td>0.0</td>
<td>100.0</td>
<td>False</td>
</tr>
<tr>
<td>75.1</td>
<td>68.0</td>
<td>72.0</td>
<td>False</td>
</tr>
</tbody>
</table>

**Arguments:**

- **Argument 0**
  - Is
  - Analog Input
  - Analog Output
  - Down Timer Variable
  - Float Literal
  - Float Variable
  - Integer 32 Literal
  - Integer 32 Variable
  - Integer 64 Literal
  - Integer 64 Variable
  - Up Timer Variable

- **Argument 1**
  - >=
  - Float Literal
  - Float Variable
  - Integer 32 Literal
  - Integer 32 Variable
  - Integer 64 Literal
  - Integer 64 Variable

- **Argument 2**
  - And <=
  - Float Literal
  - Float Variable
  - Integer 32 Literal
  - Integer 32 Variable
  - Integer 64 Literal
  - Integer 64 Variable

**Condition Block Example:**
This example evaluates True if Current_Temp is greater than or equal to Coldest_Temp and less than or equal to Hottest_Temp. It evaluates False, otherwise.

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is</td>
<td>Float Variable</td>
<td>Current_Temp</td>
</tr>
<tr>
<td>&gt;=</td>
<td>Float Variable</td>
<td>Coldest_Temp</td>
</tr>
<tr>
<td>And &lt;=</td>
<td>Float Variable</td>
<td>Hottest_Temp</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```plaintext
IsWithinLimits(Is, >=, And <=)
if (IsWithinLimits(Current_Temp, Coldest_Temp, Hottest_Temp)) then
```

This is a function command; it returns a value of true (non-zero) or false (0). The returned value can be consumed by a control structure (as in the example shown) or by a variable, I/O point, and so forth. For more information, see “Logical Commands” and “Using OptoScript” in the PAC Control User’s Guide (form 1700).

**Notes:**
- Use to replace two conditions: Less Than or Equal? and Greater Than or Equal?
See Also:  
“Less Than or Equal to Numeric Table Element?” on page 403  
“Greater Than or Equal?” on page 396
**XOR**

**Logical Action**

**Function:** To perform a logical EXCLUSIVE OR (XOR) on any two allowable values.

**Typical Use:** To toggle a logic state such as a digital output from True to False or False to True, or to compare two logic states to see if they are different.

**Details:**
- Performs a logical EXCLUSIVE OR on the value of Argument 0 and With (Argument 1), and stores the result in Put Result in (Argument 2).
  - If Argument 0 is True (non-zero, on) but With is False (0), the result will be a non-zero value (meaning True).
  - If Argument 0 is False but With is True, the result will be a non-zero value (meaning True).
  - If both Argument 0 and With are True (non-zero, on), the result will be 0 (meaning False).
  - If both Argument 0 and With are False (0, off), the result will be 0 (meaning False).

*NOTE: In programming logic, 0 represents False and any non-zero number represents True.*

- The result can be sent directly to a digital output if desired.

**Examples:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>With</th>
<th>Put Result in</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>22</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>-1</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>0</td>
<td>-1</td>
<td>1</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>-1</td>
<td>-1</td>
<td>0</td>
</tr>
<tr>
<td>22</td>
<td>-4</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

**Arguments:**

- **Argument 0**
  - [Value]
  - Digital Input
  - Digital Output
  - Float Literal
  - Float Variable
  - Integer 32 Literal
  - Integer 32 Variable
  - Integer 64 Literal
  - Integer 64 Variable

- **Argument 1**
  - With
  - Digital Input
  - Digital Output
  - Float Literal
  - Float Variable
  - Integer 32 Literal
  - Integer 32 Variable
  - Integer 64 Literal
  - Integer 64 Variable

- **Argument 2**
  - Put Result in
  - Digital Output
  - Float Variable
  - Integer 32 Variable
  - Integer 64 Variable
CHAPTER 14: LOGICAL COMMANDS

**Action Block Example:**

In this example, if SUPPLY_FAN is on, it will turn off and vice versa.

<table>
<thead>
<tr>
<th>XOR</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argument Name</td>
</tr>
<tr>
<td>(none)</td>
</tr>
<tr>
<td>With</td>
</tr>
<tr>
<td>Put Result in</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

OptoScript doesn’t use a command; the function is built in. Use the `xor` operator.

```
SUPPLY_FAN = SUPPLY_FAN xor 1;
```

**Notes:**

- The example shown is only one of many ways to use the `xor` operator. For more information, see “Logical Commands” and “Using OptoScript” in the PAC Control User’s Guide (form 1700).
- It is best to use only integers or digital points with this command.
- To manipulate individual bits or toggle a value between zero and another value, use Bit XOR.

**See Also:**

- “Bit XOR” on page 380
- “Not Equal to Numeric Table Element?” on page 413
- “Turn On” on page 197
- “Turn Off” on page 196
- “On?” on page 185
- “Off?” on page 183
XOR?

Logical Condition

**Function:** To determine if two values are at opposite True/False states.

**Typical Use:** To determine if a logic value has changed state.

**Details:**
- Determines if Argument 0 and Argument 1 have different True/False states.
  - If one argument is True (non-zero, on) and the other is False (0), the logic will take the True path.
  - If both arguments are True (non-zero, on), the logic will take the False path.
  - If both arguments are False (0, off), the logic will take the False path.
  
  *NOTE: In programming logic, 0 represents False and any non-zero number represents True.*
- Functionally equivalent to the Not Equal? condition when using allowable values.

**Examples:**

<table>
<thead>
<tr>
<th>Is (Argument 0)</th>
<th>Is (Argument 1)</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0</td>
<td>True</td>
</tr>
<tr>
<td>22</td>
<td>0</td>
<td>True</td>
</tr>
<tr>
<td>-1</td>
<td>0</td>
<td>True</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>True</td>
</tr>
<tr>
<td>0</td>
<td>-1</td>
<td>True</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>False</td>
</tr>
<tr>
<td>-1</td>
<td>-1</td>
<td>False</td>
</tr>
<tr>
<td>22</td>
<td>-4</td>
<td>False</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>False</td>
</tr>
</tbody>
</table>

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is</td>
<td>Is</td>
</tr>
<tr>
<td>Digital Input</td>
<td>Digital Input</td>
</tr>
<tr>
<td>Digital Output</td>
<td>Digital Output</td>
</tr>
<tr>
<td>Float Literal</td>
<td>Float Literal</td>
</tr>
<tr>
<td>Float Variable</td>
<td>Float Variable</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Integer 64 Literal</td>
<td>Integer 64 Literal</td>
</tr>
<tr>
<td>Integer 64 Variable</td>
<td>Integer 64 Variable</td>
</tr>
</tbody>
</table>

**Condition Block Example:**

<table>
<thead>
<tr>
<th>XOR?</th>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is</td>
<td>Integer 32 Variable</td>
<td>Limit_Switch1_Prev</td>
<td></td>
</tr>
<tr>
<td>Is</td>
<td>Digital Input</td>
<td>Limit_Switch1</td>
<td></td>
</tr>
</tbody>
</table>

**OptoScript Example:**

OptoScript doesn’t use a command; the function is built in. Use the xor operator.

```plaintext
if (Limit_Switch_Prev xor Limit_Switch) then
```
Notes:

- The example shown is only one of many ways to use the $\oplus$ operator. For more information, see “Logical Commands” and “Using OptoScript” in the PAC Control User’s Guide (form 1700).
- It is best to use only integers or digital points with this command.
- To test two values for equivalent True/False states, use the False exit.

See Also:

- “NOT” on page 411
- “AND?” on page 355
- “OR?” on page 423
15: Mathematical Commands

Absolute Value

**Mathematical Action**

**Function:** To ensure that a value is positive.

**Typical Use:** To ensure a positive value when the result of a computation may be negative.

**Details:** Copies Of (Argument 0), drops the minus sign if one exists, and stores the results in Put Result in (Argument 1).

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Of Float Variable</td>
<td>Put Result in Float Variable</td>
</tr>
<tr>
<td>Analog Input</td>
<td>Analog Output</td>
</tr>
<tr>
<td>Analog Output</td>
<td>Float Variable</td>
</tr>
<tr>
<td>Float Variable</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 64 Variable</td>
</tr>
<tr>
<td>Integer 64 Variable</td>
<td></td>
</tr>
</tbody>
</table>

**Action Block Example:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Of</td>
<td>Float Variable</td>
<td>Negative_Value</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Float Variable</td>
<td>Positive_Value</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```
Positive_Value = AbsoluteValue(Negative_Value);
```

This is a function command; it returns the positive value. The returned value can be consumed by a variable (as in the example shown) or used by an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the *PAC Control User's Guide* (form 1700).

**Notes:**

- To change a negative value to a positive value, make the values of Of and Put Result in the same.

**See Also:** “Complement” on page 456
**Add**

Mathematical Action

**Function:** To add two numeric values.

**Typical Use:** To add two numbers to get a third number, or to add one number to a running total.

**Details:**
- The standard PAC Control command adds the value of Argument 0 to the value of Plus (Argument 1), and stores the result in Put Result in (Argument 2).
- Put Result in (Argument 2) can be the same as either of the first two arguments (unless they are read-only, such as analog inputs), or it can be a completely different argument.
- Accommodates different item types such as float, integer, and analog without restriction.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0 [Value]</th>
<th>Argument 1 Plus</th>
<th>Argument 2 Put Result in</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analog Input</td>
<td>Analog Input</td>
<td>Analog Output</td>
</tr>
<tr>
<td>Analog Output</td>
<td>Analog Output</td>
<td>Down Timer Variable</td>
</tr>
<tr>
<td>Down Timer Variable</td>
<td>Down Timer Variable</td>
<td>Float Variable</td>
</tr>
<tr>
<td>Float Literal</td>
<td>Float Literal</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Float Variable</td>
<td>Float Variable</td>
<td>Integer 64 Variable</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
<td>Up Timer Variable</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 64 Literal</td>
<td>Integer 64 Variable</td>
</tr>
<tr>
<td>Integer 64 Variable</td>
<td></td>
<td>Up Timer Variable</td>
</tr>
</tbody>
</table>

**Action Block Example:**

```
Add
```

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>(none)</td>
<td>Analog Input</td>
<td>Ingredient_1_Weight</td>
</tr>
<tr>
<td>Plus</td>
<td>Analog Input</td>
<td>Ingredient_2_Weight</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Analog Output</td>
<td>Total_Weight</td>
</tr>
</tbody>
</table>

**OptoScript Example:** OptoScript doesn’t use a command; the function is built in. Use the + operator.

```
Total_Weight = Ingredient_1_Weight + Ingredient_2_Weight;
```

**Notes:**
- For more information, see “Mathematical Commands” and “Using OptoScript” in the *PAC Control User’s Guide* (form 1700).

**Queue Errors:**
- -13 = Overflow error—result too large.

**See Also:**
- “Increment Variable” on page 465
- “Subtract” on page 479
Arccosine
Mathematical Action

Function: To derive the angular value from a cosine value.

Typical Use: To solve trigonometric calculations.

Details:
- Calculates the arccosine of \( \text{Of} \) (Argument 0) and stores the result in \( \text{Put Result in} \) (Argument 1).
- \( \text{Of} \) (which is the operand) must be a cosine value with a range of –1.0 to 1.0.
- The angular value returned is in radians with a range of 0 to \( \pi \). (To convert radians to degrees, multiply by \( \frac{180}{\pi} \).)

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>( \text{Of} )</td>
<td>( \text{Put Result in} )</td>
</tr>
<tr>
<td>Analog Input</td>
<td>Analog Output</td>
</tr>
<tr>
<td>Analog Output</td>
<td>Down Timer Variable</td>
</tr>
<tr>
<td>Float Literal</td>
<td>Float Variable</td>
</tr>
<tr>
<td>Float Variable</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Up Timer Variable</td>
</tr>
</tbody>
</table>

Action Block Example:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>( \text{Of} )</td>
<td>Float Variable</td>
<td>( X )</td>
</tr>
<tr>
<td>( \text{Put Result in} )</td>
<td>Float Variable</td>
<td>( \text{RADIANS} )</td>
</tr>
</tbody>
</table>

OptoScript Example:

```
Arccosine(Of)
RADIANS = Arccosine(X);
```

This is a function command, it returns the angular value. The returned value can be consumed by a variable (as shown) or used by an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User's Guide (form 1700).

Notes:
- Use Cosine if the angle is known and the cosine is desired.

Queue Errors:
- 13 = Overflow error—result too large.
- 14 = not a number—result invalid.

See Also:
- “Cosine” on page 457
- “Arccosine” on page 450
- “Arctangent” on page 451
Arccsine

Mathematical Action

Function: To derive the angular value from a sine value.

Typical Use: To solve trigonometric calculations.

Details: • Calculates the arccsine of Of (Argument 0) and stores the result in Put Result in (Argument 1).
• Of (which is the operand) must be a sine value with a range of –1.0 to 1.0.
• The angular value returned is in radians with a range of –π/2 to π/2. (To convert radians to degrees, multiply by 180/π.)

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Of</td>
<td>Put Result in</td>
</tr>
<tr>
<td>Analog Input</td>
<td>Analog Output</td>
</tr>
<tr>
<td>Analog Output</td>
<td>Down Timer Variable</td>
</tr>
<tr>
<td>Down Timer Variable</td>
<td>Float Variable</td>
</tr>
<tr>
<td>Float Literal</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Float Variable</td>
<td>Up Timer Variable</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td></td>
</tr>
<tr>
<td>Up Timer Variable</td>
<td></td>
</tr>
</tbody>
</table>

Action Block Example:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Of</td>
<td>Float Variable</td>
<td>X</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Float Variable</td>
<td>RADIANS</td>
</tr>
</tbody>
</table>

OptoScript Example:

Arcsine(Of)

```
RADIANS = Arcsine(X);
```

This is a function command, it returns the angular value. The returned value can be consumed by a variable (as shown) or used by an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User's Guide (form 1700).

Notes: • See “Mathematical Commands” in the PAC Control User's Guide (form 1700)
• Use Sine if the angle is known and the sine is desired.

Queue Errors: -13 = Overflow error—result too large.
-14 = not a number—result invalid.

See Also: “Sine” on page 476
“Arccosine” on page 449
“Arctangent” on page 451
**Arctangent**

**Mathematical Action**

**Function:** To derive the angular value from a tangent value.

**Typical Use:** To solve trigonometric calculations.

**Details:**
- Calculates the arctangent of \( \text{Of} \) (Argument 0) and stores the result in \( \text{Put Result in} \) (Argument 1).
- \( \text{Of} \) (which is the operand) must be a tangent value.
- The angular value returned is in radians with a range of \(-\pi/2\) to \(\pi/2\). (To convert radians to degrees, multiply by 180/\(\pi\)).

**Arguments:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>( \text{Of} )</td>
<td>Analog Input, Analog Output, Down Timer Variable, Float Literal, Float Variable, Integer 32 Literal, Integer 32 Variable, Up Timer Variable</td>
<td></td>
</tr>
<tr>
<td>( \text{Put Result in} )</td>
<td>Analog Output, Down Timer Variable, Float Variable, Integer 32 Variable, Up Timer Variable</td>
<td></td>
</tr>
</tbody>
</table>

**Action Block Example:**

```
<table>
<thead>
<tr>
<th>Arctangent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argument Name</td>
</tr>
<tr>
<td>( \text{Of} )</td>
</tr>
<tr>
<td>( \text{Put Result in} )</td>
</tr>
</tbody>
</table>
```

**OptoScript Example:**

```
\text{RADIANS} = \text{Arctangent}(X);
```

This is a function command, it returns the angular value. The returned value can be consumed by a variable (as shown) or used by an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User's Guide (form 1700).

**Notes:**
- Use Tangent if the angle is known and the tangent is desired.

**Queue Errors:**
- 13 = Overflow error—result too large.
- 14 = not a number—result invalid.

**See Also:**
- “Arccosine” on page 449
- “Arcsin” on page 450
- “Tangent” on page 480


**Clamp Float Table Element**

**Mathematical Action**

**Function:**
To force a table element value to be greater than or equal to a low limit and less than or equal to a high limit.

**Typical Use:**
To keep values within a desired range. Very useful on analog input signals to prevent out-of-range values from being evaluated as real values.

**Details:**
- A table element value greater than the high limit will be set to the high limit. A table element value less than the low limit will be set to the low limit. Any other value is left unchanged.
- Use this command before evaluating the table value each time.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
<th>Argument 3</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>High Limit</strong></td>
<td><strong>Low Limit</strong></td>
<td><strong>Element Index</strong></td>
<td><strong>Of Float Table</strong></td>
</tr>
<tr>
<td>Float Literal</td>
<td>Float Literal</td>
<td>Integer 32 Literal</td>
<td>Float Table</td>
</tr>
<tr>
<td>Float Variable</td>
<td>Float Variable</td>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Action Block Example:**

```
ClampFloatTableElement(High Limit, Low Limit, Element Index, Of Float Table)
```

OptoScript Example:

```
ClampFloatTableElement(Max_Flow_Rate, Low_Flow_Cutoff, 4, Flow_Data);
```

This is a procedure command; it does not return a value.

**Queue Errors:**

-12  =  Invalid table index value. Index was negative or greater than or equal to the table size.

**See Also:**

- "Clamp Integer 32 Table Element" on page 454
- "Clamp Float Variable" on page 453
- "Clamp Integer 32 Variable" on page 455
Clamp Float Variable

**Mathematical Action**

**Function:** To force a variable value to be greater than or equal to a low limit and less than or equal to a high limit.

**Typical Use:** To keep values within a desired range. Very useful on analog input signals to prevent out-of-range values from being evaluated as real values.

**Details:**
- A variable value greater than the high limit will be set to the high limit. A variable value less than the low limit will be set to the low limit. Any other value is left unchanged.
- Use this command before evaluating the variable value each time.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>High Limit</strong></td>
<td><strong>Low Limit</strong></td>
<td><strong>Float Variable</strong></td>
</tr>
<tr>
<td>Float Literal</td>
<td>Float Literal</td>
<td>Float Variable</td>
</tr>
<tr>
<td>Float Variable</td>
<td>Float Variable</td>
<td>Float Variable</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

**Action Block Example:**

```
Clamp Float Variable
```

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>High Limit</td>
<td>Float Variable</td>
<td>Max_Flow_Rate</td>
</tr>
<tr>
<td>Low Limit</td>
<td>Float Variable</td>
<td>Low_Flow_Cutoff</td>
</tr>
<tr>
<td>Float Variable</td>
<td>Float Variable</td>
<td>Flow_Var</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```
ClampFloatVariable(Max_Flow_Rate, Low_Flow_Cutoff, Flow_Var);
```

This is a procedure command; it does not return a value.

**See Also:**
- “Clamp Integer 32 Variable” on page 455
- “Clamp Float Table Element” on page 452
- “Clamp Integer 32 Table Element” on page 454
CHAPTER 15: MATHEMATICAL COMMANDS

Clamp Integer 32 Table Element

Mathematical Action

**Function:** To force a table element value to be greater than or equal to a low limit and less than or equal to a high limit.

**Typical Use:** To keep values within a desired range. Very useful to prevent out-of-range values from being evaluated as real values.

**Details:**
- A table element value greater than the high limit will be set to the high limit. A table element value less than the low limit will be set to the low limit. Any other value is left unchanged.
- Use this command before evaluating the table value each time.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>High Limit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Float Literal</td>
<td></td>
</tr>
<tr>
<td>Float Variable</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Argument 1</th>
<th>Low Limit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Float Literal</td>
<td></td>
</tr>
<tr>
<td>Float Variable</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Argument 2</th>
<th>Element Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>Integer 32 Literal</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Argument 3</th>
<th>Of Integer 32 Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Integer 32 Table</td>
<td></td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```optoscript
ClampInt32TableElement(Max_Flow_Rate, Low_Flow_Cutoff, 4, Flow_Data);
```

This is a procedure command; it does not return a value.

**Queue Errors:**

-12 = Invalid table index value. Index was negative or greater than or equal to the table size.

**See Also:**

- "Clamp Float Table Element" on page 452
- "Clamp Integer 32 Variable" on page 455
- "Clamp Float Variable" on page 453
**Clamp Integer 32 Variable**

**Mathematical Action**

**Function:** To force a variable value to be greater than or equal to a low limit and less than or equal to a high limit.

**Typical Use:** To keep values within a desired range. Very useful to prevent out-of-range values from being evaluated as real values.

**Details:**
- A variable value greater than the high limit will be set to the high limit. A variable value less than the low limit will be set to the low limit. Any other value is left unchanged.
- Use this command before evaluating the variable value each time.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>High Limit</td>
<td>Low Limit</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

- Float Literal
- Float Variable
- Integer 32 Literal
- Integer 32 Variable

**Action Block Example:**

```
Clamp Integer 32 Variable

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>High Limit</td>
<td>Float Variable</td>
<td>Max_Flow_Rate</td>
</tr>
<tr>
<td>Low Limit</td>
<td>Float Variable</td>
<td>Low_Flow_Cutoff</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
<td>Flow_Var</td>
</tr>
</tbody>
</table>
```

**OptoScript Example:**

```opto
ClampInt32Variable(Max_Flow_Rate, Low_Flow_Cutoff, Flow_Var);
```

This is a procedure command; it does not return a value.

**See Also:**

- “Clamp Float Variable” on page 453
- “Clamp Integer 32 Table Element” on page 454
- “Clamp Float Table Element” on page 452
Complement
Mathematical Action

Function: To change the sign of a number from positive to negative or from negative to positive.

Typical Use: To make a result positive after subtracting a large number from a small number.
NOTE: The command Absolute Value is a better way to accomplish the same thing.

Details: Same as Multiplying by -1, but executes faster. Thus, -1 becomes 1, 1 becomes -1, and so forth.

Arguments: Argument 0
[Value]
Float Variable
Integer 32 Variable
Integer 64 Variable

Action Block
Example: | Complement |
<table>
<thead>
<tr>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Argument Name</td>
</tr>
<tr>
<td>(none)</td>
</tr>
</tbody>
</table>

OptoScript
Example: OptoScript doesn’t use a command; the function is built in. Use the minus sign:
Temperature_Difference = -Temperature_Difference

Notes:
- The complement of zero is zero.

See Also:
- "Bit NOT" on page 364
- "NOT" on page 411
- "Absolute Value" on page 447
Cosine

Mathematical Action

Function: To derive the cosine of an angle.

Typical Use: Trigonometric function for computing triangular base of the angle.

Details:
- Calculates the cosine of Of (Argument 0) and stores the result in Put Result in (Argument 1).
- Of (Argument 0) has a theoretical range of -infinity to +infinity, but is limited by the size of the argument you pass.
- The range of Put Result in (Argument 1) is -1.0 to 1.0, inclusive.

Examples of cosine calculations (rounded to four decimal places):

<table>
<thead>
<tr>
<th>Radians</th>
<th>Degrees</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.0</td>
<td>0.0</td>
<td>1.0</td>
</tr>
<tr>
<td>0.7854</td>
<td>45</td>
<td>0.7071</td>
</tr>
<tr>
<td>1.5708</td>
<td>90</td>
<td>0.0</td>
</tr>
<tr>
<td>2.3562</td>
<td>135</td>
<td>0.7071</td>
</tr>
<tr>
<td>3.1416</td>
<td>180</td>
<td>-1.0</td>
</tr>
<tr>
<td>3.9270</td>
<td>225</td>
<td>-0.7071</td>
</tr>
<tr>
<td>4.7124</td>
<td>270</td>
<td>0.0</td>
</tr>
<tr>
<td>5.4978</td>
<td>315</td>
<td>0.7071</td>
</tr>
<tr>
<td>6.2832</td>
<td>360</td>
<td>1.0</td>
</tr>
</tbody>
</table>

Arguments:
- Argument 0: Of
  - Analog Input
  - Analog Output
  - Down Timer Variable
  - Float Literal
  - Float Variable
  - Integer 32 Literal
  - Integer 32 Variable
  - Up Timer Variable
- Argument 1: Put Result in
  - Analog Output
  - Down Timer Variable
  - Float Variable
  - Integer 32 Variable
  - Up Timer Variable

Action Block Example:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Of</td>
<td>Float Variable</td>
<td>RADIANS</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Float Variable</td>
<td>COSINE</td>
</tr>
</tbody>
</table>

OptoScript Example:

```
Cosine(Of)
```

This is a function command; it returns the cosine. The returned value can be consumed by a variable (as shown) or used by an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User's Guide (form 1700).
Notes:

- To convert units of degrees to units of radians, divide degrees by 57.29578.
- Use Arccosine if the cosine is known and the angle is desired.

See Also:

- “Arccosine” on page 449
- “Sine” on page 476
- “Tangent” on page 480
Decrement Variable

Mathematical Action

Function: To decrease the value specified by 1.

Typical Use: To control countdown loops and other counting applications.

Details: Same as Subtracting 1: 9 becomes 8, 0 becomes -1, 22.22 becomes 21.22, and so forth.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
</tr>
<tr>
<td>Float Variable</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Integer 64 Variable</td>
</tr>
</tbody>
</table>

Action Block Example:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>(none)</td>
<td>Integer 32 Variable</td>
<td>Num_Holes_Left_to_Punch</td>
</tr>
</tbody>
</table>

OptoScript Example:

DecrementVariable(Argument 0)

This is a procedure command; it does not return a value. This command is equivalent to the following math expression in OptoScript:

Num_Holes_Left_to_Punch = Num_Holes_Left_to_Punch - 1;

Notes:
- Executes faster than subtracting 1, both in standard commands and in OptoScript code.

See Also: “Increment Variable” on page 465
## Divide

**Mathematical Action**

**Function:** To divide two numerical values.

**Typical Use:** To perform a standard division action.

**Details:**
- Divides the value of Argument 0 by By (Argument 1), and stores the result in Put Result in (Argument 2).
- Put Result in (Argument 2) can be the same as either of the first two arguments (unless they are read-only, such as analog inputs), or it can be a completely different argument.
- If By (Argument 1) is 0, an error -15 (divide by zero) is added to the message queue.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analog Input</td>
<td>Analog Input</td>
<td>Analog Output</td>
</tr>
<tr>
<td>Analog Output</td>
<td>Analog Output</td>
<td>Down Timer Variable</td>
</tr>
<tr>
<td>Down Timer Variable</td>
<td>Down Timer Variable</td>
<td>Float Variable</td>
</tr>
<tr>
<td>Float Literal</td>
<td>Float Literal</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Float Variable</td>
<td>Float Variable</td>
<td>Integer 64 Variable</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
<td>Integer 64 Variable</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
<td>Up Timer Variable</td>
</tr>
<tr>
<td>Integer 64 Literal</td>
<td>Integer 64 Literal</td>
<td></td>
</tr>
<tr>
<td>Integer 64 Variable</td>
<td>Integer 64 Variable</td>
<td></td>
</tr>
<tr>
<td>Up Timer Variable</td>
<td>Up Timer Variable</td>
<td></td>
</tr>
</tbody>
</table>

**Action Block Example:**

<table>
<thead>
<tr>
<th>Divide</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argument Name</td>
</tr>
<tr>
<td>(none)</td>
</tr>
<tr>
<td>By</td>
</tr>
<tr>
<td>Put Result in</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

OptoScript doesn’t use a command; the function is built in. Use the / operator.

```
Half_Distance = Total_Distance / 2.0;
```

**Notes:**
- For more information, see “Mathematical Commands” and “Using OptoScript” in the PAC Control User’s Guide (form 1700).
- Avoid divide-by-zero errors by checking By (Argument 1) before doing the division to be sure it does not equal zero. Use Variable True? (if it’s True, the result will be a non-zero value) or Test Not Equal (to zero).
- **Speed Tip:** Use Bit Shift instead of Divide for integer math when the divisor is 2, 4, 8, 16, 32, 64, and so forth.

**Queue Errors:** -15 = Divide by zero.

**See Also:**
- “Modulo” on page 468
- “Multiply” on page 469
- “Bit Shift” on page 377
Generate Random Number
Mathematical Action

Function: To get a random value between zero and one.

Typical Use: To generate random delay values for retries when multiple clients are requesting the same resource.

Details: Use Seed Random Number before using this command to give the random number generator a random value to start with. Since the sequence of “random” numbers generated for any given seed value is always the same, it is imperative that a random seed value be used to avoid generating the same sequence of numbers every time.

Arguments: Argument 0
Put in
Float Variable

Action Block Example:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Put in</td>
<td>Float Variable</td>
<td>LOTTO_SEED</td>
</tr>
</tbody>
</table>

OptoScript Example: GenerateRandomNumber()

LOTTO_SEED = GenerateRandomNumber();

This is a function command; it returns the random number. The returned value can be consumed by a variable (as shown) or used by an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

Notes: To get a random integer between zero and 99, for example, Multiply the float value returned by 99.0 and put the result in an integer.

Dependencies: Use Seed Random Number first.

See Also: “Seed Random Number” on page 475
Hyperbolic Cosine

Mathematical Action

**Function:**
To derive the hyperbolic cosine of a value.

**Typical Use:**
To solve hyperbolic calculations.

**Details:**
Calculates the hyperbolic cosine of Of (Argument 0) and stores the result in Put Result in (Argument 1).

**Arguments:**
- **Argument 0**
  - Of
  - Analog Input
  - Analog Output
  - Down Timer Variable
  - Float Literal
  - Float Variable
  - Integer 32 Literal
  - Integer 32 Variable
  - Up Timer Variable
- **Argument 1**
  - Put Result in
  - Analog Output
  - Down Timer Variable
  - Float Variable
  - Integer 32 Variable
  - Up Timer Variable

**Action Block Example:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Of</td>
<td>Float Literal</td>
<td>2.0</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Float Variable</td>
<td>ANSWER</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```
HyperbolicCosine(Of)
```

```
ANSWER = HyperbolicCosine(2.0);
```

This is a function command; it returns the hyperbolic cosine of the value. The returned value can be consumed by a variable (as in the example shown) or used by an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

**Queue Errors:**
-13 = Overflow error—result too large.

**See Also:**
- “Hyperbolic Sine” on page 463
- “Hyperbolic Tangent” on page 464
Hyperbolic Sine

Mathematical Action

Function: To derive the hyperbolic sine of a value.
Typical Use: To solve hyperbolic calculations.
Details: Calculates the hyperbolic sine of $\text{Of}$ (Argument 0) and stores the result in $\text{Put Result in}$ (Argument 1).

Arguments:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Of</td>
<td>Analog Input</td>
<td>Analog Output</td>
</tr>
<tr>
<td></td>
<td>Analog Output</td>
<td>Down Timer Variable</td>
</tr>
<tr>
<td></td>
<td>Float Literal</td>
<td>Float Variable</td>
</tr>
<tr>
<td></td>
<td>Float Variable</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td></td>
<td>Integer 32 Literal</td>
<td>Up Timer Variable</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>$\text{Of}$</td>
<td>Float Literal</td>
<td>2.0</td>
</tr>
<tr>
<td>$\text{Put Result in}$</td>
<td>Float Variable</td>
<td>ANSWER</td>
</tr>
</tbody>
</table>

OptoScript Example:

```
HyperbolicSine(Of)
ANSWER = HyperbolicSine(2.0);
```

This is a function command; it returns the hyperbolic sine of the value. The returned value can be consumed by a variable (as in the example shown) or used by an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

Queue Errors:

-13 = Overflow error—result too large.

See Also:

"Hyperbolic Cosine" on page 462
"Hyperbolic Tangent" on page 464
Hyperbolic Tangent

**Mathematical Action**

**Function:**
To derive the hyperbolic tangent of a value.

**Typical Use:**
To solve hyperbolic calculations.

**Details:**
- Calculates the hyperbolic tangent of Of (Argument 0) and stores the result in Put Result in (Argument 1).
- The result is a value ranging from -1.0 to 1.0.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Of</td>
<td>Put Result in</td>
</tr>
<tr>
<td>Analog Input</td>
<td>Analog Output</td>
</tr>
<tr>
<td>Analog Output</td>
<td>Down Timer Variable</td>
</tr>
<tr>
<td>Down Timer Variable</td>
<td>Float Variable</td>
</tr>
<tr>
<td>Float Literal</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Float Variable</td>
<td>Up Timer Variable</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td></td>
</tr>
<tr>
<td>Up Timer Variable</td>
<td></td>
</tr>
</tbody>
</table>

**Action Block Example:**

<table>
<thead>
<tr>
<th>Hyperbolic Tangent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argument Name</td>
</tr>
<tr>
<td>Of</td>
</tr>
<tr>
<td>Put Result in</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```
HyperbolicTangent(Of)
```

ANSWER = HyperbolicTangent(2.0);

This is a function command; it returns the hyperbolic tangent of the value. The returned value can be consumed by a variable (as in the example shown) or used by an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

**Queue Errors:**
-13 = Overflow error—result too large.

**See Also:**
“Hyperbolic Cosine” on page 462
“Hyperbolic Sine” on page 463
Increment Variable

**Mathematical Action**

**Function:** To increase the value specified by 1.

**Typical Use:** To control loop counters and other counting applications.

**Details:** Same as adding 1: 8 becomes 9, -1 becomes 0, 12.33 becomes 13.33, and so forth.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Value]</td>
</tr>
<tr>
<td>Float Variable</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Integer 64 Variable</td>
</tr>
</tbody>
</table>

**Action Block Example:**

```
IncrementVariable();
```

**OptoScript Example:**

```
IncrementVariable(LOOP_COUNTER);
```

This is a procedure command; it does not return a value.

**Notes:**

- Executes faster than adding 1.

**See Also:** “Decrement Variable” on page 459
CHAPTER 15: MATHEMATICAL COMMANDS

Maximum
Mathematical Action

Function:  To select the greater of two values.

Typical Use:  To select the higher pressure or temperature reading.

Details:  The greater of the two values is selected.

Arguments:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compare</td>
<td>Analog Input</td>
<td>Pressure_A</td>
</tr>
<tr>
<td>With</td>
<td>Analog Input</td>
<td>Pressure_B</td>
</tr>
<tr>
<td>Put Maximum in</td>
<td>Float Variable</td>
<td>Highest_Pressure</td>
</tr>
</tbody>
</table>

Action Block Example:

```
Max (Compare, With)
```

OptoScript Example:

```
Highest_Pressure = Max(Pressure_A, Pressure_B);
```

This is a function command; it returns the greater of the two values. The returned value can be consumed by a variable (as shown) or used by an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

See Also:  “Minimum” on page 467
**Minimum**

**Mathematical Action**

**Function:** To select the lesser of two values.

**Typical Use:** To select the lower pressure or temperature reading.

**Details:** The lesser of the two values is selected.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Compare</strong></td>
<td><strong>With</strong></td>
<td><strong>Put Minimum in</strong></td>
</tr>
<tr>
<td>Analog Input</td>
<td>Analog Input</td>
<td>Analog Output</td>
</tr>
<tr>
<td>Analog Output</td>
<td>Analog Output</td>
<td>Down Timer Variable</td>
</tr>
<tr>
<td>Down Timer Variable</td>
<td>Down Timer Variable</td>
<td>Float Variable</td>
</tr>
<tr>
<td>Float Literal</td>
<td>Float Literal</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Float Variable</td>
<td>Float Variable</td>
<td>Integer 64 Variable</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
<td>Integer 64 Variable</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
<td>Up Timer Variable</td>
</tr>
<tr>
<td>Integer 64 Literal</td>
<td>Integer 64 Literal</td>
<td></td>
</tr>
<tr>
<td>Integer 64 Variable</td>
<td>Integer 64 Variable</td>
<td></td>
</tr>
<tr>
<td>Up Timer Variable</td>
<td>Up Timer Variable</td>
<td></td>
</tr>
</tbody>
</table>

**Action Block Example:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Compare</strong></td>
<td>Analog Input</td>
<td>Pressure_A</td>
</tr>
<tr>
<td><strong>With</strong></td>
<td>Analog Input</td>
<td>Pressure_B</td>
</tr>
<tr>
<td><strong>Put Minimum in</strong></td>
<td>Float Variable</td>
<td>Lowest_Pressure</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

Min(Compare, With)

Lowest_Pressure = Min(Pressure_A, Pressure_B);

This is a function command; it returns the lesser value. The returned value can be consumed by a variable (as shown) or used by an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

**See Also:** “Maximum” on page 466
**Modulo**

**Mathematical Action**

**Function:** To generate the remainder resulting from integer division.

**Typical Use:** To capture the remainder whenever integer modulo calculations are needed.

**Details:**
- Always results in an integer value.
  Examples: $40 \mod 16 = 8$, $8 \mod 8 = 0$.
- If any arguments are floats, they are rounded to integers before the division occurs.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0 [Value]</th>
<th>Argument 1 By</th>
<th>Argument 2 Put Result in</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analog Input</td>
<td>Analog Input</td>
<td>Analog Output</td>
</tr>
<tr>
<td>Analog Output</td>
<td>Analog Output</td>
<td>Down Timer Variable</td>
</tr>
<tr>
<td>Down Timer Variable</td>
<td>Down Timer Variable</td>
<td>Float Variable</td>
</tr>
<tr>
<td>Float Literal</td>
<td>Float Literal</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Float Variable</td>
<td>Float Variable</td>
<td>Integer 64 Variable</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
<td>Integer 64 Variable</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 64 Literal</td>
<td>Integer 64 Variable</td>
</tr>
<tr>
<td>Integer 64 Literal</td>
<td>Integer 64 Variable</td>
<td>Up Timer Variable</td>
</tr>
<tr>
<td>Up Timer Variable</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Action Block Example:**

```
Modulo

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>(none)</td>
<td>Integer 32 Variable</td>
<td>Num_Parts_Produced</td>
</tr>
<tr>
<td>By</td>
<td>Integer 32 Variable</td>
<td>Minutes_Elapsed</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Integer 32 Variable</td>
<td>Productivity_Remainder</td>
</tr>
</tbody>
</table>
```

**OptoScript Example:**

OptoScript doesn’t use a command; the function is built in. Use the `%` operator.

```
Productivity_Remainder = Num_Parts_Produced % Minutes_Elapsed;
```

**Notes:**
- For more information, see “Mathematical Commands” and “Using OptoScript” in the *PAC Control User’s Guide* (form 1700).

**See Also:**
- “Divide” on page 460
- “Multiply” on page 469
**Multiply**

**Mathematical Action**

- **Function:** To multiply two numeric values.
- **Typical Use:** To multiply two numbers to get a third number or to modify one of the original numbers.
- **Details:**
  - Multiplies the value of Argument 0 and the value of *Times* (Argument 1), and stores the result in *Put Result in* (Argument 2).
  - *Put Result in* can be the same as either of the first two arguments (unless they are read-only, such as analog inputs), or it can be a completely different argument.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Value]</td>
<td><em>Times</em></td>
<td><em>Put Result in</em></td>
</tr>
<tr>
<td>Analog Input</td>
<td>Analog Input</td>
<td>Analog Output</td>
</tr>
<tr>
<td>Analog Output</td>
<td>Analog Output</td>
<td>Analog Output</td>
</tr>
<tr>
<td>Down Timer Variable</td>
<td>Down Timer Variable</td>
<td>Down Timer Variable</td>
</tr>
<tr>
<td>Float Literal</td>
<td>Float Literal</td>
<td>Float Variable</td>
</tr>
<tr>
<td>Float Variable</td>
<td>Float Variable</td>
<td>Float Variable</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Integer 64 Literal</td>
<td>Integer 64 Literal</td>
<td>Integer 64 Variable</td>
</tr>
<tr>
<td>Integer 64 Variable</td>
<td>Integer 64 Variable</td>
<td>Integer 64 Variable</td>
</tr>
<tr>
<td>Up Timer Variable</td>
<td>Up Timer Variable</td>
<td>Up Timer Variable</td>
</tr>
</tbody>
</table>

**Action Block Example:**

<table>
<thead>
<tr>
<th>Multiply</th>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>(none)</td>
<td>Analog Input</td>
<td>Ingredient_1_Weight</td>
<td></td>
</tr>
<tr>
<td>Times</td>
<td>Float Variable</td>
<td>Temperature_Adjust</td>
<td></td>
</tr>
<tr>
<td>Put Result in</td>
<td>Analog Output</td>
<td>Corrected_Weight</td>
<td></td>
</tr>
</tbody>
</table>

**OptoScript Example:**

OptoScript doesn’t use a command; the function is built in. Use the * operator.

```
Corrected_Weight = Ingredient_1_Weight * Temperature_Adjust;
```

**Notes:**

- For more information, see “Mathematical Commands” and “Using OptoScript” in the *PAC Control User’s Guide* (form 1700).
- **Speed Tip:** Use *Bit Shift* instead for integer math where the multiplier is 2, 4, 8, 16, 32, 64, and so on.

**Queue Errors:**

-13 = Overflow error—result too large.

**See Also:**

“Divide” on page 460
“Bit Shift” on page 377
Natural Log
Mathematical Action

**Function:** To calculate the natural log (base e) of a value.

**Typical Use:** To solve natural log calculations.

**Details:** Takes the natural log of Of (Argument 0), and stores the result in Put Result in (Argument 1).

**Arguments:**
- **Argument 0**
  - Of
  - Analog Input
  - Analog Output
  - Down Timer Variable
  - Float Literal
  - Float Variable
  - Integer 32 Literal
  - Integer 32 Variable
  - Up Timer Variable

- **Argument 1**
  - Put Result in
  - Analog Output
  - Down Timer Variable
  - Float Variable
  - Integer 32 Variable
  - Up Timer Variable

**Action Block Example:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Of</td>
<td>Float Variable</td>
<td>Fermentation_Rate</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```
NaturalLog(Of) = NaturalLog(Fermentation_Rate);
```

This is a function command; it returns the natural log of the value. The returned value can be consumed by a variable (as shown) or used by an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

**Notes:**

PAC Control only implements a natural logarithm command. However, there is a simple way to compute logarithms for bases other than base e. Divide the natural log of the number by the natural log of the base:

\[
\log_{\text{BASE}}(\text{number}) = \frac{\ln(\text{number})}{\ln(\text{base})}
\]

For example:

\[
\log_{10}(100) = \frac{\ln(100)}{\ln(10)} = 2
\]

Just remember that the range of the logarithm argument is a number greater than zero. A control engine error will be flagged if the argument is less than or equal to zero.

To get a \(\log_{10}\), divide the result of this command by 2.302585, which is \(\ln(10)\).

<table>
<thead>
<tr>
<th>number</th>
<th>LOGe</th>
<th>LOG10</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>10</td>
<td>2.302585</td>
<td>1</td>
</tr>
</tbody>
</table>
Queue Errors:
-13 = Overflow error—result too large.
-14 = Invalid number.

See Also: “Raise to Power” on page 473
Raise e to Power

Mathematical Action

**Function:**
To raise the constant e to a specified power.

**Typical Use:**
To solve mathematical equations where the constant e is required.

**Details:**
- Raises e to the power specified in \( \text{Exponent} \) (Argument 0).
- The constant e, the base of the natural system of logarithms, has a value of 2.7182818.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exponent</td>
<td>Analog Input</td>
<td>Gas_Pressure</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Float Variable</td>
<td>Pressure_Calculation</td>
</tr>
</tbody>
</table>

**Action Block Example:**

```plaintext
RaiseEToPower(Exponent)
Pressure_Calculation = RaiseEToPower(Gas_Pressure);
```

This is a function command; it returns the result of the mathematical computation. The returned value can be consumed by a variable (as shown) or used by an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the *PAC Control User’s Guide* (form 1700).

**Notes:**

**Queue Errors:**
-13 = Overflow error—result too large.

**See Also:**
- “Natural Log” on page 470
- “Raise to Power” on page 473
Raise to Power

Mathematical Action

Function: To raise a value to a specified power.

Typical Use: To solve exponentiation calculations.

Details: • Raises \textit{Raise} (Argument 0) to the power specified by \textit{To the} (Argument 1), and stores the result in \textit{Put Result in} (Argument 2).

Arguments:

\begin{tabular}{|l|l|l|}
\hline
Argument 0 & Argument 1 & Argument 2 \\
\hline
Raise & To the & Put Result in \\
Analog Input & Analog Input & Analog Output \\
Analog Output & Analog Output & Down Timer Variable \\
Down Timer Variable & Down Timer Variable & Float Variable \\
Float Literal & Float Literal & Integer 32 Variable \\
Float Variable & Float Variable & Up Timer Variable \\
Integer 32 Literal & Integer 32 Literal & Integer 32 Variable \\
Integer 32 Variable & Integer 32 Variable & \\
Up Timer Variable & Up Timer Variable & \\
\hline
\end{tabular}

Action Block Example:

\begin{center}
\begin{tabular}{|l|l|l|}
\hline
Argument Name & Type & Name \\
\hline
Raise & Integer 32 Literal & 10 \\
To the & Integer 32 Literal & 2 \\
Put Result in & Integer 32 Variable & TEN_SQUARED \\
\hline
\end{tabular}
\end{center}

OptoScript Example: \texttt{Power \textit{(Raise, To the)}}

\begin{center}
\texttt{TEN\_SQUARED = Power(10, 2);}
\end{center}

This is a function command; it returns the result of the mathematical computation. The returned value can be consumed by a variable (as shown) or used by an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the \textit{PAC Control User's Guide} (form 1700).

Notes: • See "Mathematical Commands" in the \textit{PAC Control User's Guide} (form 1700).
• Multiplying a number by itself is faster than raising a number to the power of 2.

Queue Errors: 
-13 = Overflow error—result too large.
-14 = Invalid number.

See Also: 
• "Raise e to Power" on page 472
• "Square Root" on page 478
### Round

**Mathematical Action**

**Function:** To round up or down to the nearest integer value.

**Typical Use:** To discard a fractional part of a number that isn’t meaningful while still keeping the number as a float type.

**Details:** Fractional values less than 0.5 cause no change to the whole number. Fractional values of 0.5 and greater cause the whole number to be incremented by 1. Note that 1.50 rounds up to 2.0, and 1.49 rounds down to 1.0.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Value]</td>
<td>Put Result in</td>
</tr>
<tr>
<td>Float Literal</td>
<td>Float Variable</td>
</tr>
<tr>
<td>Float Variable</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td></td>
</tr>
</tbody>
</table>

**Action Block Example:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>(none)</td>
<td>Float Variable</td>
<td>Boiler_Avg_Temp</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Float Variable</td>
<td>Boiler_Working_Temp</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```opto
Round (Argument 0)
Boiler_Working_Temp = Round(Boiler_Avg_Temp);
```

This is a function command; it returns the rounded integer value. The returned value can be consumed by a variable (as shown) or used by an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

**Notes:** Using Move (or an assignment in OptoScript code) to copy a float value to an integer variable will round automatically.

**See Also:** “Truncate” on page 481
Seed Random Number
Mathematical Action

Function: To set a random starting point for the random number generator.

Typical Use:
- To ensure the random number generator does not generate the same sequence of numbers each time it is started.
- To switch random number sequences on-the-fly by "re-seeding" the random number generator.

Details:
- This command seeds the random number generator with a value that should be unique each time the command is issued.
- This command is typically used once at the beginning of a strategy, or occasionally within a strategy. Do not use it too often, as very frequent use could cause the numbers generated to be less random.

Arguments: None.

Action Block
Example:
```
SeedRandomNumber()
```

OptoScript
Example:
```
SeedRandomNumber();
```
This is a procedure command; it does not return a value.

See Also: “Generate Random Number” on page 461
### Sine

#### Mathematical Action

- **Function:** To derive the sine of an angle.
- **Typical Use:** Trigonometric function for computing triangular height of the angle.
- **Details:**
  - Calculates the sine of Of (Argument 0) and stores the result in Put Result in (Argument 1).
  - Of has a theoretical range of -infinity to +infinity, but is limited by the type of variable used.
  - The range of Put Result in is -1.0 to 1.0, inclusive.

Examples of sine calculations to four decimal places:

<table>
<thead>
<tr>
<th>Radians</th>
<th>Degrees</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.0</td>
<td>0</td>
<td>0.0</td>
</tr>
<tr>
<td>0.7854</td>
<td>45</td>
<td>0.7071</td>
</tr>
<tr>
<td>1.5708</td>
<td>90</td>
<td>1.0000</td>
</tr>
<tr>
<td>2.3562</td>
<td>135</td>
<td>0.7071</td>
</tr>
<tr>
<td>3.1416</td>
<td>180</td>
<td>0.0000</td>
</tr>
<tr>
<td>3.9270</td>
<td>225</td>
<td>-0.7071</td>
</tr>
<tr>
<td>4.7124</td>
<td>270</td>
<td>-1.0000</td>
</tr>
<tr>
<td>5.4978</td>
<td>315</td>
<td>-0.7071</td>
</tr>
<tr>
<td>6.2832</td>
<td>360</td>
<td>0.0000</td>
</tr>
</tbody>
</table>

#### Arguments:

- **Argument 0:** Of
  - Analog Input
  - Analog Output
  - Down Timer Variable
  - Float Literal
  - Float Variable
  - Integer 32 Literal
  - Integer 32 Variable
  - Up Timer Variable

- **Argument 1:** Put Result in
  - Analog Output
  - Down Timer Variable
  - Float Variable
  - Integer 32 Variable
  - Up Timer Variable

#### Action Block Example:

**Sine**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Of</td>
<td>Float Variable</td>
<td>Radians</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Float Variable</td>
<td>SINE</td>
</tr>
</tbody>
</table>

#### OptoScript Example:

**Sine (Of)**

SINE = Sine(Radians);

This is a function command; it returns the sine of the angle. The returned value can be consumed by a variable (as in the example shown) or used by an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User's Guide (form 1700).
Notes:  
- To convert units of degrees to units of radians, divide degrees by 57.29578 (or 180 / π).
- Use Arcsine if the sine is known and the angle is desired.

See Also:  
- “Arcsine” on page 450
- “Cosine” on page 457
- “Tangent” on page 480
### Square Root

**Mathematical Action**

<table>
<thead>
<tr>
<th>Function:</th>
<th>To calculate the square root of a value.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Typical Use:</td>
<td>To solve square root calculations.</td>
</tr>
<tr>
<td>Details:</td>
<td>Takes the square root of ( \text{Of} ) (Argument 0) and stores the result in ( \text{Put Result in} ) (Argument 1).</td>
</tr>
</tbody>
</table>

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Of</td>
<td>Put Result in</td>
</tr>
<tr>
<td>Analog Input</td>
<td>Analog Output</td>
</tr>
<tr>
<td>Analog Output</td>
<td>Down Timer Variable</td>
</tr>
<tr>
<td>Down Timer Variable</td>
<td>Float Variable</td>
</tr>
<tr>
<td>Float Literal</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Float Variable</td>
<td>Up Timer Variable</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Up Timer Variable</td>
</tr>
</tbody>
</table>

**Action Block Example:**

```plaintext
Square Root
```

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Of</td>
<td>Integer 32 Variable</td>
<td>Area_of_Square</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Integer 32 Variable</td>
<td>Height_of_Square</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```plaintext
Height_of_Square = SquareRoot(Area_of_Square);
```

This is a function command; it returns square root of the value. The returned value can be consumed by a variable (as in the example shown) or used by an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the [PAC Control User's Guide](form 1700).

**Notes:**

- See “Mathematical Commands” in the [PAC Control User's Guide](form 1700).
- Executes faster than raising a number to the 0.5 power.
- Taking the square root of zero or of a negative value will result in zero, and a queue error. Use > or Greater? to check the value before using the command.
- To convert a differential pressure value representing flow to the proper engineering units, convert its current value to a number between 0 and 1, take the square root of this number, then convert it to the desired engineering units. For example: A 0–100” flow signal that represents 0–50,000 CFH has a value of 50. 50/100 = 0.5. The square root of 0.5 is 0.7071. 0.7071 times 50,000 = 35355 CFH.

**Queue Errors:**

-14 = Invalid number.

**See Also:**

“Raise to Power” on page 473
“Greater Than Numeric Table Element?” on page 392
Subtract
Mathematical Action

Function: To find the difference between two numeric values.

Typical Use: To subtract two numbers to get a third number, or to reduce the first number by the amount of the second.

Details:
- Subtracts the value of Minus (Argument 1) from the value of Argument 0, and stores the result in Put Result in (Argument 2).
- Put Result in can be the same as either of the first two arguments (unless they are read-only, such as analog inputs), or it can be a completely different argument.

Arguments:
- Argument 0: [Value]
  - Analog Input
  - Analog Output
  - Down Timer Variable
  - Float Literal
  - Float Variable
  - Integer 32 Literal
  - Integer 32 Variable
  - Integer 64 Literal
  - Integer 64 Variable
  - Up Timer Variable
- Argument 1: Minus
  - Analog Input
  - Analog Output
  - Down Timer Variable
  - Float Literal
  - Float Variable
  - Integer 32 Literal
  - Integer 32 Variable
  - Integer 64 Literal
  - Integer 64 Variable
  - Up Timer Variable
- Argument 2: Put Result in
  - Analog Output
  - Down Timer Variable
  - Float Variable
  - Integer 32 Variable
  - Integer 64 Variable
  - Up Timer Variable

Action Block Example:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>(none)</td>
<td>Integer 32 Variable</td>
<td>Num_to_Produce</td>
</tr>
<tr>
<td>Minus</td>
<td>Integer 32 Variable</td>
<td>Num_Produced</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Integer 32 Variable</td>
<td>Num_Left_to_Make</td>
</tr>
</tbody>
</table>

OptoScript Example: OptoScript doesn’t use a command; the function is built in. Use the – operator.

Num_Left_to_Make = Num_to_Produce – Num_Produced;

Notes:
- In OptoScript code, the – operator has many uses. For more information on mathematical expressions in OptoScript code, see the PAC Control User’s Guide (form 1700).

Queue Errors: -13 = Overflow error—result too large.

See Also:
- “Decrement Variable” on page 459
- “Add” on page 448
Tangent
Mathematical Action

Function: To derive the tangent of an angle.

Typical Use: Trigonometric function for computing angular rise.

Details:
- Computes the tangent (in radians) of Of (Argument 0), and stores the result in Put Result in (Argument 1).
- Tangent produces a result that theoretically ranges from -infinity to +infinity, but is limited by the type of the argument.
- Computing a tangent at (pi / 2) ± (n * pi) yields unpredictable results, since ± infinity cannot be represented. Use Within Limits? to check for a valid value for Of (Argument 0) before calling the Tangent command.
- Tangent is sin (angle) / cos (angle).

Arguments:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Of</td>
<td>Analog Input</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Analog Output</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Down Timer Variable</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Float Literal</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Float Variable</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Integer 32 Literal</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Integer 32 Variable</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Up Timer Variable</td>
<td></td>
</tr>
<tr>
<td>Put Result in</td>
<td>Analog Output</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Down Timer Variable</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Float Variable</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Integer 32 Variable</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Up Timer Variable</td>
<td></td>
</tr>
</tbody>
</table>

Action Block Example:

```
Tangent
```

OptoScript Example:

```
Tangent (Of)
TANGENT = Tangent (RADIANS);
```

This is a function command; it returns the tangent of the angle. The returned value can be consumed by a control structure (as in the example shown) or by a variable, I/O point, and so forth. For more information, see the PAC Control User's Guide (form 1700).

Notes:
- To convert units of degrees to units of radians, divide degrees by 57.29578 (or 180 / pi).
- Use Arctangent if the tangent is known and the angle is desired.

See Also:
- "Arctangent" on page 451
- "Cosine" on page 457
- "Sine" on page 476
Truncate

Mathematical Action

**Function:** Discards the fractional part of a number without changing the whole part.

**Typical Use:** To separate the whole part of a number from the fractional part.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argument 0</td>
<td>Value</td>
<td>Flow_Total_Raw</td>
</tr>
<tr>
<td>Argument 1</td>
<td>Put Result in</td>
<td>Flow_Total_Integer</td>
</tr>
</tbody>
</table>

**Argument 0**
- [Value]
- Down Timer Variable
- Float Literal
- Float Variable
- Up Timer Variable

**Argument 1**
- Down Timer Variable
- Float Variable
- Integer 32 Variable
- Integer 64 Variable
- Up Timer Variable

**Action Block Example:**

<table>
<thead>
<tr>
<th>Truncate</th>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>(none)</td>
<td>Float Variable</td>
<td>Flow_Total_Raw</td>
<td></td>
</tr>
<tr>
<td>Put Result in</td>
<td>Integer 32 Variable</td>
<td>Flow_Total_Integer</td>
<td></td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```
Truncate (Argument 0)
Flow_Total_Integer = Truncate (Flow_Total_Raw);
```

This is a function command; it returns the whole part of the truncated number.

**Notes:** Subtracting the resulting integer from the float will remove the whole part from the fractional part.

**See Also:** “Round” on page 474
16: Miscellaneous Commands

Comment (Block)

Function: To disable one or more commands in an action or condition block.

Typical Use: To temporarily disable commands within an action or condition block during debugging.

Details:

- This command is normally used in pairs. Everything between the pair of Comment (Block) commands is considered a comment and is ignored when the strategy is compiled and downloaded. In the Instructions dialog box, commands that are commented out appear in gray.
- This command is useful for temporarily disabling a group of commands within an action block while debugging a program.
- If the second Comment (Block) is omitted, everything from the first Comment (Block) to the end of the action block is considered a comment.

Arguments: None.

Example:

<table>
<thead>
<tr>
<th>Comment (Block)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Chart</td>
</tr>
<tr>
<td>Chart</td>
</tr>
<tr>
<td>Put Status In</td>
</tr>
<tr>
<td>Log_Data</td>
</tr>
<tr>
<td>nChartStatus</td>
</tr>
</tbody>
</table>

OptoScript Example:

OptoScript doesn’t use a command; the functionality is built in. Use a slash and an asterisk before the block comment, and an asterisk and a slash after the block comment:

/* block comment */

See Also: “Comment (Single Line)” on page 485
Comment (Opto Control Conversion Issue)

Function: A comment is inserted automatically when a command does not automatically convert from Opto Control to PAC Control. This command is not added to a strategy by a user.

Typical Use: To locate areas in a strategy where a command did not convert.

Details: To find comments in a strategy:
1. In the Configure Mode, choose Edit > Find. The Find dialog box appears.
2. Under Search Scope, select Global.
3. Under Search For, select Instruction and Action.
4. Under Instruction, select Comment (Opto Control Conversion Issue), and then click Find. A list appears that identifies each comment.
Comment (Single Line)

Function: To add a comment to an action or condition block.

Typical Use: To document commands within a block.

Arguments:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>(none)</td>
<td>String Literal</td>
<td>Remember to test this block</td>
</tr>
</tbody>
</table>

Example:

```optoscript
// Remember to test this block
```

OptoScript doesn’t use a command; the functionality is built in. Use two slashes before the comment.

Example: `// Remember to test this block`

See Also: “Comment (Block)” on page 483
Flag Lock

Miscellaneous Action

**Function:** Flag Lock and “Flag Unlock” on page 488 use an integer 32 variable as a synchronization object. These commands allow a strategy to give a chart exclusive access to one or more objects (for example, a table, integer, or I/O unit) while the chart has the synchronization object locked.

**Typical Use:** To successfully perform multiple operations on one or more objects such that each operation can completely finish before another chart gains access to the objects.

**Details:**
- For a chart to store multiple values to an object—for example, a table—without interference from another chart, you associate a 32-bit integer variable (called a “flag”) with the table. Then, you construct logic so that no chart writes to the table without first locking the associated flag. Using this kind of logic, while the flag is locked, no other chart can access the table.
- For **Flag** (Argument 0), specify the integer 32 variable to be used as the flag. If you try to use anything other than an integer 32 variable, a -29 (Wrong Object Type) status code is returned.
- For **Timeout** (Argument 1), use one of the following timeout values:

<table>
<thead>
<tr>
<th>Value</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
</table>
| -1    | Blocking | • If the flag is **unlocked** when a blocking timeout is sent, the system locks the flag immediately.  
• If the flag is **locked** when the blocking timeout is sent, the system tries to acquire the flag until it succeeds (or until the chart requesting the blocking lock is stopped).  
Chart logic doesn’t proceed to the next command until the Flag Lock command is able to acquire the flag.  
A blocking timeout always returns 0 (Success) status code. |
| Number of milliseconds to wait, from +1 (1 millisecond) to +2147483647 (about 25 days) | Timed | • If the flag is **unlocked** when a timed timeout is sent, the system locks the flag immediately and returns a 0 (Success) status code.  
• If the flag is **locked** when the timed timeout is sent, the system tries to acquire the flag until it succeeds (in which case it returns a 0 (Success) status code) or until the time specified for **Timeout** expires (in which case the system returns a -37 (Timeout on lock) status code).  
Chart logic doesn’t proceed to the next command until either the Flag Lock command is able to acquire the flag or the timeout expires. |
| 0 | Non-blocking | With a non-blocking timeout, the system attempts to acquire the flag only once.  
• If the flag is **unlocked**, the system locks the flag immediately and returns a 0 status code.  
• If the flag is already **locked**, the system returns a -17 (Port or object is already locked) status code. |

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0 Flag</th>
<th>Argument 1 Timeout</th>
<th>Argument 2 Put Result in</th>
</tr>
</thead>
<tbody>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Literal</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>
### Action Block Example:

<table>
<thead>
<tr>
<th><strong>Flag Lock</strong></th>
<th><strong>Argument Name</strong></th>
<th><strong>Type</strong></th>
<th><strong>Name</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Flag</td>
<td>Integer 32 Variable</td>
<td>Flag_1</td>
</tr>
<tr>
<td></td>
<td>Timeout</td>
<td>Integer 32 Variable</td>
<td>nTimeout</td>
</tr>
<tr>
<td></td>
<td>Put Result in</td>
<td>Integer 32 Variable</td>
<td>nResult1</td>
</tr>
</tbody>
</table>

#### OptoScript Example:

```plaintext
FlagLock(Flag, Timeout)
```

nResult1 = FlagLock(Flag_1, nTimeout);

This is a function command; it returns a value of 0 (Success) or one of the status codes listed below.

### Status Codes:

-8 = Invalid data. Verify that Timeout (Argument 1) is not a negative number other than -1.
(The only acceptable negative value is -1, which is the value for a blocking timeout.)

-17 = Port or object is already locked.

-29 = Wrong object type.

-37 = Timeout on lock.

### Notes:

Here are tips for working with flag locks:

- For best performance, you should hold a flag lock only as long as necessary. Remember—any other charts that need access to the flag are going to be held up until the flag is unlocked.
- If you use a Flag Lock in a chart, you must also include a Flag Unlock in the same chart.
- If you use a Flag Unlock to unlock a flag in a different chart, the Flag Unlock command must include the Force Unlock option (any non-zero value).
- Don’t use flag variables for anything other than Flag Lock and Flag Unlock commands. To make it obvious that a variable is being used as a flag, assign it a meaningful name; for example, FlagForInterProcessLock.
- Don’t set the value of the flag variable using any methods or commands other than Flag Lock and Flag Unlock.
- In systems without redundant controllers, you should use initialize-on-run variables only. Don’t use persistent or initialize-on-download variables.
- In systems with redundant controllers only:
  - Configure flag variables to be persistent.
  - At the start of the strategy, initialize them using Flag Unlock with the Force unlock option (to prevent issues in case the strategy was previously interrupted).
  - To prevent the flag from staying locked, make sure to clear it (using the Flag Unlock command) later in the same chart.
- In PAC firmware R9.5c and lower, if a chart is stopped while it is holding a lock on a flag, the lock isn’t released, preventing other charts from accessing the flag. This may also result in losing communication to the controller’s Host task until the controller is rebooted.

In PAC firmware R9.5d and higher, if you attempt to stop a chart, the chart will continue to run until the flag is unlocked.

### See Also:

“Flag Unlock” on page 488
Flag Unlock

Miscellaneous Action

Function: Flag Unlock and "Flag Lock" on page 486 use an integer 32 variable as a synchronization object. These commands allow a strategy to give a chart exclusive access to one or more objects (for example, a table, integer, or I/O unit) while the chart has the synchronization object locked.

Typical Use: To successfully perform multiple operations on one or more objects such that each operation can completely finish with the objects before another chart gains access to the objects.

Details: • For Flag (Argument 0), specify the integer 32 variable that is locked (by having been issued a Flag Lock command).
• Use Force unlock (Argument 1 with a non-zero value) to handle what could otherwise be an unrecoverable situation—such as when you’re unable to unlock a flag by normal means. A non-zero value (True) forces the flag variable to be unlocked and returns a 0 (Success) status code.
• When the flag variable is locked, a Flag Unlock command (with a Force unlock parameter value of zero) will fail unless the chart that is asking for the unlock is the same chart that locked it. In other words, if Chart 1 locks a flag, only Chart 1 can unlock it (with a Force unlock parameter value of zero).

EXCEPTION: When the Force unlock parameter is set to a non-zero value, any chart can unlock the flag.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flag</td>
<td>Force unlock</td>
<td>Put Result in</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Literal</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

Action Block Example:

<table>
<thead>
<tr>
<th>Flag Unlock</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argument Name</td>
</tr>
<tr>
<td>Flag</td>
</tr>
<tr>
<td>Force unlock</td>
</tr>
<tr>
<td>Put Result in</td>
</tr>
</tbody>
</table>

OptoScript Example: FlagUnlock (Flag, Force unlock)
nResult2 = FlagUnlock(Flag_2, nForce_Unlock);

This is a function command; it returns a value of 0 (Success) or one of the status codes listed below.

Status Codes: -25 = Port or object is not locked. Indicates the flag is not locked.
-29 = Wrong object type. Indicates the variable you are trying to unlock is not flag. (In other words, it contains a non-zero value that was not put there by a Flag Lock command.)
-103 = Wrong task. If the Force Unlock parameter value was zero, indicates that the chart requesting the Unlock is not the chart that set the Lock.

Notes: • For best performance, you should hold a flag lock only as long as necessary. Remember—any other charts that need access to the flag are going to be held up until the flag is unlocked.
• If you use a Flag Lock in a chart, you must also include a Flag Unlock in the same chart.
• If you use a Flag Unlock to unlock a flag in a different chart, the Flag Unlock command must include the Force Unlock option (any non-zero value).
• Don’t use flag variables for anything other than Flag Lock and Flag Unlock commands. To make it obvious that a variable is being used as a flag, assign it a meaningful name; for example, FlagForInterProcessLock.
• Don’t set the value of the flag variable using any methods or commands other than Flag Lock and Flag Unlock.
• In systems without redundant controllers, you should use initialize-on-run variables only. Don’t use persistent or initialize-on-download variables.
• In systems with redundant controllers only:
  – Configure flag variables to be persistent.
  – At the start of the strategy, initialize them using Flag Unlock with the Force unlock option (to prevent issues in case the strategy was previously interrupted).
  – To prevent the flag from staying locked, make sure to clear it (using the Flag Unlock command) later in the same chart.

See Also: “Flag Lock” on page 486
Float Valid?

Miscellaneous Condition

**Function:**
To verify that a float variable contains a valid value.

**Typical Use:**
To check float validity after reading a float from an external device, such as a communication handle, a scratch pad location, or an analog point.

**Details:**
This command performs a simple test on the float variable to see if it contains a valid IEEE format float number. If the bit pattern of the float value has at least these bits set, 0x7F800000 (01111111100000000000000000000000), then it is considered invalid and the command returns a false (0).

**Arguments:**
- **Argument 0**
  - Is
  - Float Variable

**Condition Block Example:**
```
<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is</td>
<td>Float Variable</td>
<td>Oil_Pressure</td>
</tr>
</tbody>
</table>
```

**OptoScript Example:**
```
IsFloatValid(Float)
if (IsFloatValid(Oil_Pressure)) then
```

This is a function command; it returns a value of true (non-zero) or false (0). The returned value can be consumed by a control structure (as in the example shown) or by a variable, I/O point, and so forth. For more information, see the *PAC Control User's Guide* (form 1700).

**Notes:**
Analog points on an unplugged module return a value of NaN (not a number).

**See Also:**
- "Move 32 Bits" on page 410
- "Get I/O Unit Scratch Pad Float Element" on page 327
- "Read Number from I/O Unit Memory Map" on page 307
Generate Reverse CRC-16 on Table (32 bit)

Miscellaneous Action

Function: Calculate a 16-bit CRC value.

Typical Use: Communication that requires CRC error checking. The command is a quick and convenient way to verify the integrity of table data transferred serially.

Details:
- CRC type is 16-bit reverse.
- The Start Value is also known as the “seed.” It is usually zero or -1.
- The table can contain as little as one element.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Start Value</strong></td>
<td><strong>Table</strong></td>
<td><strong>Starting Element</strong></td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Float Table</td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Table</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Argument 2</th>
<th>Argument 3</th>
<th>Argument 4</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Starting Element</strong></td>
<td><strong>Number of Elements</strong></td>
<td><strong>Put Result in</strong></td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
<td></td>
</tr>
</tbody>
</table>

Action Block Example:

```
Generate Reverse CRC-16 on Table (32 bit)
```

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Value</td>
<td>Integer 32 Literal</td>
<td>0</td>
</tr>
<tr>
<td>Table</td>
<td>Float Table</td>
<td>VALUES_TO_SEND</td>
</tr>
<tr>
<td>Starting Element</td>
<td>Integer 32 Literal</td>
<td>1</td>
</tr>
<tr>
<td>Number of Elements</td>
<td>Integer 32 Literal</td>
<td>31</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Integer 32 Variable</td>
<td>RESULT</td>
</tr>
</tbody>
</table>

OptoScript Example:
```
GenerateReverseCrc16OnTable32 (Start Value, Table, Starting Element, Number of Elements)
```

RESULT = GenerateReverseCrc16OnTable32(0, VALUES_TO_SEND, 1, 31);

This is a function command; it returns the CRC. The returned value can be consumed by a variable (as shown) or used by an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

Notes:
- This command is only useful once the data in the table is static.
- The easiest way to check data is to make the table one element longer than necessary, then generate the CRC and move its result to the extra table element. The command Transmit Numeric Table is typically used to transfer table elements, including the CRC value. When the data is received, use this command at the receiving end to generate the CRC again and compare it to the first CRC value. For example, on the control engine sending the data:
  1. Generate Reverse CRC-16 on Table (32 bit) on table elements 1–31.
  2. Use Move to Numeric Table Element to move the CRC value to table element 0.
  3. Use Transmit Numeric Table to send all 32 table elements (0–31).
Then, on the control engine receiving the data:
  4. Receive Numeric Table.
  5. Generate Reverse CRC-16 on Table (32 bit) on table elements 1–31.
6. Compare the calculated CRC against the value stored in element 0.

See Also:  
“Generate Forward CRC-16 on String” on page 627  
“Generate Reverse CCITT on String” on page 628  
“Generate Forward CCITT on String” on page 626
Get Length of Table

Miscellaneous Action

**Function:** To obtain the declared length (size) of a float, integer, string, or pointer table.

**Typical Use:** To determine the last index when reading or writing to a table.

**Details:** A size of 10, for example, means there are 10 elements numbered 0–9.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Table</strong></td>
<td><strong>Put in</strong></td>
</tr>
<tr>
<td>Float Table</td>
<td>Float Variable</td>
</tr>
<tr>
<td>Integer 32 Table</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Integer 64 Table</td>
<td></td>
</tr>
<tr>
<td>Pointer Table</td>
<td></td>
</tr>
<tr>
<td>String Table</td>
<td></td>
</tr>
</tbody>
</table>

**Action Block Example:**

```plaintext
Get Length of Table
```

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Integer 32 Table</td>
<td>Config_Data</td>
</tr>
<tr>
<td>Put in</td>
<td>Integer 32 Variable</td>
<td>Config_Data_Size</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```plaintext
Config_Data_Size = GetLengthOfTable(Config_Data);
```

This is a function command; it returns the length of the table. The returned value can be consumed by a variable (as shown) or used by an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the *PAC Control User’s Guide* (form 1700).

**Notes:** Always use to determine table size when program logic must act on all elements of a table. Then if the size of the table is later changed, the program will automatically adjust to the new size.
### Get Type From Name

**Miscellaneous Action**

**Function:** To find out the data type (string, floating point, and so forth) of a variable in the strategy.

**Typical Use:** Used with the command Get Value From Name, to find out the data type of a variable and pass it to another software application or device that knows only the variable’s name.

**Details:**
- This command does not handle pointers. If the variable is a pointer, a zero will be returned.
- Reads the data type of *Name* (Argument 0) and places a bitmask in *Put In* (Argument 1), representing the data type. Possible values (in hex) are as follows:

<table>
<thead>
<tr>
<th>Value in Hex</th>
<th>Data Type</th>
<th>Value in Hex</th>
<th>Data Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>00020002</td>
<td>Digital I/O Point</td>
<td>00800003</td>
<td>Down Timer</td>
</tr>
<tr>
<td>00020010</td>
<td>Analog I/O Point</td>
<td>00800004</td>
<td>Up Timer</td>
</tr>
<tr>
<td>00200000</td>
<td>PID</td>
<td>00810000</td>
<td>Integer 32 Table</td>
</tr>
<tr>
<td>00400003</td>
<td>Mistic Digital</td>
<td>00810001</td>
<td>Integer 64 Table</td>
</tr>
<tr>
<td>00400004</td>
<td>Mistic Analog</td>
<td>00810002</td>
<td>Float Table</td>
</tr>
<tr>
<td>00402000*</td>
<td>Generic MMP Device</td>
<td>01000000</td>
<td>String</td>
</tr>
<tr>
<td>00402005</td>
<td>Mixed I/O Unit</td>
<td>01010000</td>
<td>String Table</td>
</tr>
<tr>
<td>00402006</td>
<td>Digital 64 I/O Unit</td>
<td>02000000</td>
<td>Chart</td>
</tr>
<tr>
<td>00402007</td>
<td>Mixed 64 I/O Unit</td>
<td>02000001</td>
<td>Subroutine</td>
</tr>
<tr>
<td>00800000</td>
<td>Integer 32</td>
<td>09000000</td>
<td>Communication Handle</td>
</tr>
<tr>
<td>00800001</td>
<td>Integer 64</td>
<td>20000000</td>
<td>Pointer</td>
</tr>
<tr>
<td>00800002</td>
<td>Float</td>
<td>20010000</td>
<td>Pointer Table</td>
</tr>
</tbody>
</table>

* This value might represent a GRV-EPIC-PR1, R1, R1-B, or R2 I/O Unit data type.

If a variable is persistent, the first digit in hex will be a 4 (bit 30 is set).

**Examples:**

<table>
<thead>
<tr>
<th>00800001</th>
<th>Integer 64</th>
<th>01010000</th>
<th>String Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>40800001</td>
<td>Persistent Integer 64</td>
<td>41010000</td>
<td>Persistent String Table</td>
</tr>
</tbody>
</table>

If a variable is local to a subroutine, the first digit in hex will be a 1 (bit 28 is set).

**Examples:**

<table>
<thead>
<tr>
<th>10800000</th>
<th>Local Integer 23</th>
</tr>
</thead>
<tbody>
<tr>
<td>10800001</td>
<td>Local Integer 64</td>
</tr>
</tbody>
</table>

**Arguments:**

- **Argument 0**
  - **Name**
    - String Literal
    - String Variable

- **Argument 1**
  - **Put In**
    - Integer 32 Variable
**Get Type From Name**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>String Literal</td>
<td>Variable_Name</td>
</tr>
<tr>
<td>Put in</td>
<td>Integer 32 Variable</td>
<td>DATA_TYPE</td>
</tr>
</tbody>
</table>

**Example:**

**OptoScript**

```
DataType = OptoScript(GetTypeFromName(Variable_Name));
```

This is a function command; it returns the data type of the variable in the form of a bitmask. The returned value can be consumed by a variable (as in the example shown) or used by an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the *PAC Control User's Guide* (form 1700).

**Note:** The data type values returned by this command are set by Opto 22 and may be changed in future releases.

**See Also:** *Get Value From Name* on page 496
Get Value From Name

Miscellaneous Action

Function: To find out the value of a variable named in the strategy.

Typical Use: To pass the value of a variable to another software application or device that knows the variable’s name. In a subroutine, to find out the current value of a global variable whose name is known.

Details:
- Gets the value of Name (Argument 0) and places it in the form of a string in Put Result in (Argument 1).
- The value of Name (Argument 0) can be of various types; it will automatically be converted into a string.
- The string variable in Put Result in (Argument 1) must be wide enough to fit any value (converted into a string) that may go there.
- This command can be used with most non-pointer types. It won’t work with arguments passed into a subroutine, but can be used with local subroutine variables.
- Types supported include: string and numeric table elements, strings, communication handles, numeric variables, points, and boards.
- If used in a subroutine to find out the current value of a global variable, the subroutine must know the variable’s name. The name can be passed in via a string or a string table.
- To get the value of an element in a table, follow the name of the variable with the desired index in square brackets. For example, MyTable[2] would return the value of the third element in MyTable as a string (Argument 1).

Arguments: Argument 0 Name String Literal String Variable Argument 1 Put Result in String Variable Argument 2 Put Status in Integer 32 Variable

Action Block Example:

```
Get Value From Name
```

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>String Variable</td>
<td>Item_Count</td>
</tr>
<tr>
<td>Put Result in</td>
<td>String Variable</td>
<td>Production</td>
</tr>
<tr>
<td>Put Status in</td>
<td>Integer 32 Variable</td>
<td>Status</td>
</tr>
</tbody>
</table>

OptoScript Example:

```
GetValueFromName (Name, Put Result in)
```

```OptoScript
Status = GetValueFromName(Item_Count, Production);
```

This is a function command; it returns the value of the variable in the form of a string. The returned value can be consumed by a variable (as shown in Status Codes below) or used by an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

Notes:
- See “Miscellaneous Commands” in For more information, see the PAC Control User’s Guide.
- If you need to know the data type of Name (Argument 0), use the command Get Type From Name.
- If you need to use the variable’s value in a mathematical computation, convert the string to the data type you need using one of the Convert commands.

Status Codes:

<table>
<thead>
<tr>
<th>Status Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Success</td>
</tr>
<tr>
<td>-12</td>
<td>Invalid table index. Check the index of the named table element and the size of that table.</td>
</tr>
<tr>
<td>-28</td>
<td>Object not found. Variable doesn’t exist or is spelled incorrectly (name is case-sensitive), or the variable is a pointer or other unsupported type.</td>
</tr>
</tbody>
</table>
-36 = Feature not implemented. The type of the object passed is not yet supported.
-69 = Variable named in Argument 0 not found. Check the name and case.

See Also:
“Get Type From Name” on page 494
“Convert String to Float” on page 613
“Convert String to Integer 32” on page 615
“Convert String to Integer 64” on page 617
Move

Function: To copy a digital, analog, or numeric value to another location.

Typical Use: To copy values between objects, even if they are dissimilar types.

Details: PAC Control automatically converts the type of From (Argument 0) to match that of To (Argument 1). The following rules are employed when copying values between objects of different types:

- From Float to Integer: Floats are rounded up for fractions of 0.5 or greater, otherwise they are rounded down.
- From Integer to Float: Integer values are converted directly to floats.
- From Digital Input or Output: A value of non-zero is returned for on, 0 for off.
- From Latch: A value of non-zero is returned for set latches, 0 for latches that are not set.
- To Digital Output: A value of 0 turns the output off. Any non-zero value turns the output on.
- To Analog Output: Values are sent as is. Expect some rounding consistent with the analog resolution of the I/O unit. If the value sent is outside the allowable range for the point, the output will go to the nearest range limit, either zero or full scale.
- From Integer 32 to Integer 64: Integer values are moved into the high or upper half. For conversions from integer 32 to integer 64 (or vice versa), use the commands Make Integer 64, Get High Bits of Integer 64, and Get Low Bits of Integer 64.

Arguments:

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analog Input</td>
<td>Analog Output</td>
</tr>
<tr>
<td>Analog Output</td>
<td>Digital Output</td>
</tr>
<tr>
<td>Digital Input</td>
<td>Down Timer Variable</td>
</tr>
<tr>
<td>Digital Output</td>
<td>Float Variable</td>
</tr>
<tr>
<td>Down Timer Variable</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Float Literal</td>
<td>Integer 64 Variable</td>
</tr>
<tr>
<td>Float Variable</td>
<td>Up Timer Variable</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td></td>
</tr>
<tr>
<td>Integer 64 Literal</td>
<td></td>
</tr>
<tr>
<td>Integer 64 Variable</td>
<td></td>
</tr>
<tr>
<td>Up Timer Variable</td>
<td></td>
</tr>
</tbody>
</table>

Action Block Example:

```
Move

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>From</td>
<td>Digital Input</td>
<td>DIG1</td>
</tr>
<tr>
<td>To</td>
<td>Integer 32 Variable</td>
<td>DIG1_STATUS</td>
</tr>
</tbody>
</table>
```

OptoScript Example:

```
DIG1_STATUS = DIG1;
```

Notes:

- In OptoScript code, simply make assignments where you would use the Move command.
- In standard commands, you can use Move with timers as the equivalent of two other commands (in OptoScript code, the = operator has the same effect):
– With up timers, Move is the same as using Set Up Timer Target Value and Start Timer. The value moved is the target value, and it overwrites any target value already in place. The up timer starts immediately from zero.
– With down timers, Move is the same as using Set Down Timer Preset Value and Start Timer. The value moved is the preset value the timer will start from, and it overwrites any preset value previously set. The timer starts immediately from the preset value.

Queue Errors: -13 = Overflow error—integer or float value was too large.

See Also: “Move String” on page 636
“Move to Numeric Table Element” on page 503 and other Move to Table commands
“Move from Numeric Table Element” on page 500 and other Move from Table commands.
Move from Numeric Table Element

**Miscellaneous Action**

**Function:** To copy one value from either an integer or float table.

**Typical Use:** To copy a numeric table value to an I/O point or another numeric variable.

**Details:**
- PAC Control automatically converts the type of `Of Table` (Argument 1) to match that of `To` (Argument 2).
  - **From Float to Integer:** Floats are rounded up for fractions of 0.5 or greater, otherwise they are rounded down.
  - **From Integer to Float:** Integer values are converted directly to floats.
  - **To Digital Output:** A value of 0 turns the output off. Any non-zero value turns the output on.
  - **To Analog Output:** Values are sent as is. Expect some rounding consistent with the analog resolution of the I/O unit. If the value sent is outside the allowable range for the point, the output will go to the nearest range limit, either zero or full scale.
  - **From Integer 32 to Integer 64:** Integer values are moved into the high or upper half. For conversions from integer 32 to integer 64 (or vice versa), use the commands Make Integer 64, Get High Bits of Integer 64, and Get Low Bits of Integer 64.
- The valid range for the index is 0 (zero) to the table length minus 1 (size – 1).

**Arguments:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Index</td>
<td>Integer 32 Literal</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>Integer 32 Variable</td>
<td></td>
</tr>
<tr>
<td>Of Table</td>
<td>Float Table</td>
<td>LOOK_UP_TABLE</td>
</tr>
<tr>
<td></td>
<td>Integer 32 Table</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Integer 64 Table</td>
<td></td>
</tr>
<tr>
<td>To</td>
<td>Analog Output</td>
<td>PRESS_OUT</td>
</tr>
<tr>
<td></td>
<td>Digital Output</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Float Variable</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Integer 32 Variable</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Integer 64 Variable</td>
<td></td>
</tr>
</tbody>
</table>

**OptoScript Example:**

OptoScript doesn’t use a command; the function is built in. Use the `=` operator.

```
PRESS_OUT = LOOK_UP_TABLE[0];
```

**Notes:**
In OptoScript code, simply make an assignment from the table element.

**Queue Errors:**
-12 = Invalid table index value. Index was negative or greater than or equal to the table size.
-13 = Overflow—integer or float value was too large.

**See Also:**
- "Move Numeric Table Element to Numeric Table" on page 501
- "Move to Numeric Table Element" on page 503
- "Shift Numeric Table Elements" on page 506
Move Numeric Table Element to Numeric Table

Function: To copy a single value from one table to another or from one table element to another table element within the same table.

Typical Use: To reorder the way data are arranged or to copy temporary values to a final location.

Details:
- The two tables can be the same table, different types, or the same type.
- PAC Control automatically converts the type of of Table (Argument 1) to match that of Of Table (Argument 3).
- The following rules are employed when copying values between objects of different types:
  - From Float to Integer: Floats are rounded up for fractions of 0.5 or greater, otherwise they are rounded down.
  - From Integer to Float: Integer values are converted directly to floats.
  - From Integer 32 to Integer 64: Integer values are moved into the high or upper half. For conversions from integer 32 to integer 64 (or vice versa), use the commands Make Integer 64, Get High Bits of Integer 64, and Get Low Bits of Integer 64.
- Any value sent to an invalid index is discarded, and a -12 (Invalid table index value) status code is added to the message queue.
- The valid range for each index is 0 (zero) to the table length minus 1 (size – 1).

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
<th>Argument 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Index</td>
<td>Of Table</td>
<td>To Index</td>
<td>Of Table</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Float Table</td>
<td>Integer 32 Literal</td>
<td>Integer 32 Table</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Table</td>
<td>Integer 32 Literal</td>
<td>Integer 64 Table</td>
</tr>
</tbody>
</table>

Action Block Example:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Index</td>
<td>Integer 32 Literal</td>
<td>17</td>
</tr>
<tr>
<td>Of Table</td>
<td>Integer 32 Table</td>
<td>I/O_STATUS_TABLE</td>
</tr>
<tr>
<td>To Index</td>
<td>Integer 32 Literal</td>
<td>27</td>
</tr>
<tr>
<td>Of Table</td>
<td>Integer 32 Table</td>
<td>I/O_STATUS_TABLE</td>
</tr>
</tbody>
</table>

OptoScript Example: OptoScript doesn’t use a command; the function is built in. Use the = operator.

```
I/O_STATUS_TABLE[27] = I/O_STATUS_TABLE[17];
```

Notes:
- In OptoScript code, simply make an assignment to the table element.
- To move several values, put this command in a loop using variables for both indexes.

Queue Errors:
-12 = Invalid table index value. Index was negative or greater than or equal to the table size.
-13 = Overflow—integer or float value was too large.

See Also: “Move to Numeric Table Element” on page 503
Move Numeric Table to Numeric Table

Miscellaneous Action

**Function:** To copy values from one table to another.

**Typical Use:** To copy temporary values to a final location.

**Details:**
- The two tables must be of the same width (for example, Integer 64 Tables can only be copied to other Integer 64 Tables) and must be different tables. They can be different sizes, but make sure *Length* (Argument 4) is not too long for either table. Also, one or both tables can be pointer tables. The pointers in those tables must point to variables of the same width, as described above. A null pointer will be skipped with a -69 (Invalid parameter) status code in the queue, and a pointer to something of mismatched size will give a -29 (Wrong object type) status code in the queue mentioned below.
- The valid range for each table index is 0 (zero) to the table length - 1 (size - 1).

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>From Table</strong></td>
<td><strong>From Index</strong></td>
<td><strong>To Table</strong></td>
</tr>
<tr>
<td>Float Table</td>
<td>Integer 32 Literal</td>
<td>Float Table</td>
</tr>
<tr>
<td>Integer 32 Table</td>
<td>Integer 32 Variable</td>
<td>Integer 32 Table</td>
</tr>
<tr>
<td>Integer 64 Table</td>
<td></td>
<td>Integer 64 Table</td>
</tr>
<tr>
<td>Pointer Table</td>
<td></td>
<td>Pointer Table</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Argument 3</th>
<th>Argument 4</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>To Index</strong></td>
<td><strong>Length</strong></td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

**Action Block Example:**

```optoscript
MoveNumericTableToNumTable
```

**Move Numeric Table to Numeric Table**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Table</td>
<td>Integer 32 Table</td>
<td>Temp_Table</td>
</tr>
<tr>
<td>From Index</td>
<td>Integer 32 Literal</td>
<td>0</td>
</tr>
<tr>
<td>To Table</td>
<td>Integer 32 Table</td>
<td>Status_Table</td>
</tr>
<tr>
<td>To Index</td>
<td>Integer 32 Literal</td>
<td>16</td>
</tr>
<tr>
<td>Length</td>
<td>Integer 32 Literal</td>
<td>8</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```
MoveNumTableToNumTable(From Table, From Index, To Table, To Index, Length)
```

```optoscript
MoveNumTableToNumTable(Temp_Table, 0, Status_Table, 16, 8);
```

This is a procedure command; it does not return a value.

**Queue Errors:**
- -6 = Data field error. Source and destination tables must be different.
- -12 = Invalid table index or length.
- -13 = Overflow—integer or float value was too large.
- -29 = Wrong object type. *From Table* (Argument 0) and *To Table* (Argument 2) must have the same width.
- -69 = Invalid parameter (null pointer) passed to command. Received if a null table object pointer is passed.

**See Also:** “Move to Numeric Table Element” on page 503
Move to Numeric Table Element

Function: To copy a value from virtually any source to a table element.

Typical Use: To create a list of various values in a table.

Details: PAC Control automatically converts the type of From (Argument 0) to match that of Of Table (Argument 2).

- From Float to Integer: Floats are rounded up for fractions of 0.5 or greater, otherwise they are rounded down.
- From Integer to Float: Integer values are converted directly to floats.
- From Digital Input or Output: A value of non-zero is returned for on, 0 for off.
- From Latch: A value of non-zero is returned for set latches, 0 for latches that are not set.
- From Integer 32 to Integer 64: Integer values are moved into the high or upper half. For conversions from integer 32 to integer 64 (or vice versa), use the commands Make Integer 64, Get High Bits of Integer 64, and Get Low Bits of Integer 64.

- Any value sent to an invalid index is discarded, and a -12 (Invalid table index value) status code is added to the message queue.
- The valid range for each index is 0 (zero) to the table length minus 1 (size – 1).

Arguments:

<table>
<thead>
<tr>
<th>Argument 0 From</th>
<th>Argument 1 To Index</th>
<th>Argument 2 Of Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analog Input</td>
<td>Integer 32 Literal</td>
<td>Float Table</td>
</tr>
<tr>
<td>Analog Output</td>
<td>Integer 32 Literal</td>
<td>Integer 32 Table</td>
</tr>
<tr>
<td>Digital Input</td>
<td>Integer 32 Variable</td>
<td>Integer 64 Table</td>
</tr>
<tr>
<td>Digital Output</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Float Literal</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Float Variable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Integer 64 Literal</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Integer 64 Variable</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Action Block Example:

```
Move to Numeric Table Element

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>From</td>
<td>Integer 32 Literal</td>
<td>0</td>
</tr>
<tr>
<td>To Index</td>
<td>Integer 32 Literal</td>
<td>27</td>
</tr>
<tr>
<td>Of Table</td>
<td>Integer 32 Table</td>
<td>IO_STATUS_TABLE</td>
</tr>
</tbody>
</table>
```

OptoScript Example:

OptoScript doesn’t use a command; the function is built in. Use the = operator.

```
IO_STATUS_TABLE[27] = 0;
```

Notes:
- In OptoScript code, simply make an assignment to the table element.
- To move the same value to several table elements, put this command in a loop using a variable for the index.

Queue Errors:
- -12 = Invalid table index value. Index was negative or greater than or equal to the table size.
- -13 = Overflow—integer or float value was too large.
See Also:  “Move from Numeric Table Element” on page 500
         “Move to Numeric Table Elements” on page 505
Move to Numeric Table Elements

**Miscellaneous Action**

**Function:** To set a given value to a range of table elements within the same table.

**Typical Use:** To initialize elements within a table to the same value.

**Details:**
- Any value sent to an invalid index is discarded, and a -12 (Invalid table index value) status code is added to the message queue.
- The valid range for each index is 0 (zero) to the table length minus 1 (size – 1). However, if you need to set a value to the entire table and don’t know the table’s size, you can use a starting index of 0 and an ending index of -1.

**Arguments:**
- **Argument 0**
  - From
  - Float Literal
  - Float Variable
  - Integer 32 Literal
  - Integer 32 Variable
  - Integer 64 Literal
  - Integer 64 Variable

- **Argument 1**
  - Start Index
  - Integer 32 Literal
  - Integer 32 Variable

- **Argument 2**
  - End Index
  - Integer 32 Literal
  - Integer 32 Variable

- **Argument 3**
  - Of Table
  - Float Table
  - Integer 32 Table
  - Integer 64 Table

**Action Block Example:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>From</td>
<td>Integer 32 Literal</td>
<td>0</td>
</tr>
<tr>
<td>Start Index</td>
<td>Integer 32 Literal</td>
<td>4</td>
</tr>
<tr>
<td>End Index</td>
<td>Integer 32 Literal</td>
<td>10</td>
</tr>
<tr>
<td>Of Table</td>
<td>Integer 32 Table</td>
<td>IO_STATUS_TABLE</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

MoveToNumTableElements(From, Start Index, End Index, Of Table)

MoveToNumTableElements(0, 4, 10, IO_STATUS_TABLE);

This is a procedure command; it does not return a value.

**Notes:** Compared to other methods such as loops, this command initializes table elements very quickly.

**Queue Errors:**
- -12 = Invalid table index value. Index was negative or greater than or equal to the table size.
- -13 = Overflow—integer or float value was too large.

**See Also:**
- “Move from Numeric Table Element” on page 500
- “Move to Numeric Table Element” on page 503
Shift Numeric Table Elements

Miscellaneous Action

**Function:**
To shift numeric table elements up or down.

**Typical Use:**
To follow items on a conveyor.

**Details:**
- For positive shift counts, entries shift toward the end of the table. For negative shift counts, entries shift toward the beginning (index zero) of the table.
- Entries at the beginning or end of the table are lost when shifted beyond those limits.
- Zeros are written to entries left empty by shifting.

**Arguments:**
<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shift Count</td>
<td>Table</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Float Table</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Table</td>
</tr>
</tbody>
</table>

**Action Block Example:**

```
Shift Numeric Table Elements
```

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shift Count</td>
<td>Integer 32 Literal</td>
<td>-5</td>
</tr>
<tr>
<td>Table</td>
<td>Float Table</td>
<td>MY_TABLE</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```OptoScript
ShiftNumTableElements(-5, MY_TABLE);
```

This is a procedure command; it does not return a value.

**Notes:**
- Use Move from Numeric Table Element before this command to capture values that will be shifted out of the table, if they need to be used.
- If desired, use Move to Numeric Table Element after this command, for example, to fill vacated entries.

**See Also:**
- “Move Numeric Table Element to Numeric Table” on page 501
- “Move from Numeric Table Element” on page 500
- “Move to Numeric Table Element” on page 503
Get PID Configuration Flags

**PID—Ethernet Action**

**NOTE:** This command is used for PID loops in PAC Control; it is not for use with the SNAP-PID-V module.

**Function:**
To read the current PID configuration options.

**Typical Use:**
To find out current configuration options.

**Details:**
PID configuration options can be set when you initially configure the PID loop in PAC Manager or PAC Control, or in strategy logic using the command `Set PID Configuration Flags`.

Configuration options are returned as a 32-bit integer. One or multiple options can be chosen. Possible values (in hex) are:
- `0x00000000 = Standard; no special flags.`
- `0x00000001 = Square root of input is enabled.`
- `0x00000002 = If input goes out of range, output will be forced to a predetermined value.`
- `0x00000004 = If input goes out of range, PID will switch to manual; if input returns to normal range, PID will switch back to automatic.`

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>PID Loop</td>
<td>Configuration Flags</td>
</tr>
<tr>
<td>PID Loop</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

**Action Block Example:**

```
Get PID Configuration Flags
```

**OptoScript Example:**

```
GetPidConfigFlags(PID Loop)
```

This is a function command; it returns an integer 32 containing the PID configuration flags from the SNAP PAC I/O brain's memory map. (See Details, above). The returned value can be consumed by a variable (as in the example shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User's Guide (form 1700).

**Notes:**
Dependencies: Communication to the PID must be enabled for this command to read the actual value from the PID.

See Also: “Enable Communication to PID Loop” on page 572
“Set PID Configuration Flags” on page 530
CHAPTER 17: PID - ETHERNET COMMANDS

Get PID Current Input

**PID—Ethernet Action**

*NOTE: This command is not for use with the SNAP-PID-V module.*

**Function:**
To read the current input value (also known as the process variable) of a PID whose input is determined by an analog point or a PID output (for cascaded PIDs).

*NOTE: To get the input of a PID that was set from Host, use “Get PID Input” on page 516*

**Typical Use:**
To read the current value of a PID input.

**Details:**
- The input must be from an analog point or a PID output (for cascaded PIDs). The command returns zero (0) if the input is configured to be from Host.
- Get PID Current Input retrieves the value of the input right now, independent of scan time.
- The value read has the same engineering units as the specified PID input.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>PID Loop</td>
<td>Input</td>
</tr>
<tr>
<td>PID Loop</td>
<td>Analog Output</td>
</tr>
<tr>
<td>PID Loop</td>
<td>Float Variable</td>
</tr>
<tr>
<td>PID Loop</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

**Action Block Example:**

```
example_code
```

**OptoScript Example:**

```
OptoScript Code: GetPidCurrentInput (PID Loop)
```

This is a function command; it returns the current input value of the PID loop. The returned value can be consumed by a variable (as in the example shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

**Notes:**
- Use to detect bad or out-of-range PID input values. When such a value is found, use the Set PID Output command to change the PID output as required.

**Dependencies:**
Communication to the PID must be enabled for this command to read the actual value from the PID.

**See Also:**
“Disable Communication to PID Loop” on page 567
“Get PID Input” on page 516
“Set PID Input” on page 536
Get PID Current Setpoint

PID—Ethernet Action

NOTE: This command is not for use with SNAP-PID-V modules.

Function: To read the current setpoint value of a PID whose setpoint is determined by an analog point or a PID output (for cascaded PIDs).

NOTE: To get the setpoint of a PID that was set from Host, use Get PID Setpoint.

Typical Use: To read the current value of a PID setpoint.

Details:
- The setpoint must be from an analog point or a PID output (for cascaded PIDs).
- The command returns zero (0) if the setpoint is configured to be from Host.
- Get PID Current Setpoint retrieves the value of the setpoint right now, independent of scan time.
- The value read has the same engineering units as the specified PID setpoint.

Arguments:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>PID Loop</td>
<td>PID Loop</td>
<td>Heater_3</td>
</tr>
<tr>
<td>Setpoint</td>
<td>Float Variable</td>
<td>Pid_Setpoint_Value</td>
</tr>
</tbody>
</table>

Action Block Example:

```
Get PID Current Setpoint
```

OptoScript Example:

```
GetPidCurrentSetpoint (PID Loop)
PID_Setpoint_Value = GetPidCurrentSetpoint(Heater_3);
```

Notes:
- Can be used to detect and log changes made to the PID setpoint.

Dependencies: Communication to the PID must be enabled for this command to read the actual value from the PID.

See Also:
- “Enable Communication to PID Loop” on page 572
- “Get PID Setpoint” on page 526
- “Set PID Setpoint” on page 546
Get PID Feed Forward

PID—Ethernet Action

NOTE: This command is used for PID loops in PAC Control; it is not for use with the SNAP-PID-V module.

Function: To read the PID feed forward value for applications requiring feed forward control.

Typical Use: To determine current PID values.

Details: For all PID algorithms, Feed Forward and Feed Forward Gain values are multiplied and then added to the output; therefore, a value of 0 in either field results in no change to the output.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>PID Loop</td>
<td>Feed Forward</td>
</tr>
</tbody>
</table>

Example:

OptoScript Example:

```
GetPidFeedForward(PID Loop)
```

This is a function command; it returns the feed forward value for the PID loop. The returned value can be consumed by a variable (as in the example shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

Notes: See “PID Commands” in the PAC Control User’s Guide (form 1700).

Dependencies: Communication to the PID must be enabled for this command to read the actual value from the PID.

See Also: “Enable Communication to PID Loop” on page 572
“Set PID Feed Forward” on page 531
Get PID Feed Forward Gain

**PID—Ethernet Action**

*NOTE: This command is used for PID loops in PAC Control; it is not for use with the SNAP-PID-V module.*

**Function:**
To read the feed forward gain value of the PID output for applications requiring feed forward control.

**Typical Use:**
To determine current PID values.

**Details:**
For all PID algorithms, Feed Forward and Feed Forward Gain values are multiplied and then added to the output; therefore, a value of 0 in either field results in no change to the output.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>PID Loop</td>
<td>PID Loop</td>
<td>HEATER_3</td>
</tr>
<tr>
<td>Feed Fwd Gain</td>
<td>Analog Output</td>
<td>Float Variable</td>
</tr>
<tr>
<td></td>
<td>Integer 32 Variable</td>
<td></td>
</tr>
</tbody>
</table>

**Action Block Example:**

```plaintext
Get PID Feed Forward Gain
```

**OptoScript Example:**

```plaintext
GetPidFeedForwardGain(PID Loop)
```

This is a function command; it returns the feed forward gain value of the PID loop. The returned value can be consumed by a variable (as in the example shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the [PAC Control User’s Guide](form 1700).

**Notes:**
See “PID Commands” in the [PAC Control User’s Guide](form 1700).

**Dependencies:**
Communication to the PID must be enabled for this command to read the actual value from the PID.

**See Also:**
*“Enable Communication to PID Loop” on page 572*
*“Set PID Feed Forward Gain” on page 532*
Get PID Forced Output When Input Over Range

NOTE: This command is used for PID loops in PAC Control; it is not for use with the SNAP-PID-V module.

Function: To read the forced value that will be sent to the PID output when the input is over the established range.

Typical Use: To determine current PID values.

Arguments: | Argument 0 | Argument 1 |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>PID Loop</td>
<td>Forced Output</td>
</tr>
<tr>
<td>PID Loop</td>
<td>Analog Output</td>
</tr>
<tr>
<td></td>
<td>Float Variable</td>
</tr>
<tr>
<td></td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

Example:

OptoScript Example:

```
GetPidForcedOutputWhenInputOverRange(PID Loop)
```

This is a function command; it returns the output that will be forced if the input is over the normal range. The returned value can be consumed by a variable (as in the example shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

Notes: See “PID Commands” in the PAC Control User’s Guide (form 1700).

Dependencies: Communication to the PID must be enabled for this command to read the actual value from the PID.

See Also:  
“Get PID Forced Output When Input Under Range” on page 514  
“Set PID Forced Output When Input Over Range” on page 533
Get PID Forced Output When Input Under Range

PID—Ethernet Action

NOTE: This command is used for PID loops in PAC Control; it is not for use with the SNAP-PID-V module.

Function: To read the forced value that will be sent to the PID output when the input is under the established range.

Typical Use: To determine current PID values.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>PID Loop</td>
<td>Forced Output</td>
</tr>
<tr>
<td>PID Loop</td>
<td>Analog Output</td>
</tr>
<tr>
<td></td>
<td>Float Variable</td>
</tr>
<tr>
<td></td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

Action Block Example:

```
Get PID Forced Output When Input Under Range
```

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>PID Loop</td>
<td>PID Loop</td>
<td>HEATER_3</td>
</tr>
<tr>
<td>Forced Output</td>
<td>Float Variable</td>
<td>PID_OUTPUT_UNDER_RANGE</td>
</tr>
</tbody>
</table>

OptoScript Example:

```python
PID_OUTPUT_UNDER_RANGE = GetPidForcedOutputWhenInputUnderRange(PID Loop)
```

This is a function command; it returns the output that will be forced if the input is under the normal range. The returned value can be consumed by a variable (as in the example shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

Notes: See “PID Commands” in the PAC Control User’s Guide (form 1700).

Dependencies: Communication to the PID must be enabled for this command to read the actual value from the PID.

See Also:  
“Get PID Forced Output When Input Over Range” on page 513  
“Set PID Forced Output When Input Under Range” on page 534
Get PID Gain

**PID—Ethernet Action**

---

**Function:**
Reads the gain value from the PID.

**Typical Use:**
To store PID arguments for later use.

**Details:**
Reads the gain value from the PID in the I/O unit. If the PID is disabled or the I/O unit is disabled, the last known value will be returned instead (the IVAL).

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>PID Loop</td>
<td>Gain</td>
</tr>
</tbody>
</table>

- PID Loop: PID Loop
- Gain: Analog Output, Float Variable, Integer 32 Variable

**OptoScript Example:**

```
Zone08_Gain = GetPidGain(Extruder_Zone08);
```

This is a function command; it returns the gain value from the PID. The returned value can be consumed by a variable (as in the example shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the *PAC Control User's Guide* (form 1700).

**Notes:**
- To store the result, always use a float variable.

**Dependencies:**
Communication to the PID must be enabled for this command to read the actual value from the PID.

**See Also:**
“Set PID Gain” on page 535
NOTE: This command is used for PID loops in PAC Control; it is not for use with the SNAP-PID-V module.

**Function:** To read the input value (also known as the process variable) of a PID.

**Typical Use:** To find out the PID input value at the time of the most recent scan.

**Details:**
- The value read has the same engineering units as the specified PID input channel.
- This command retrieves the input value from the most recent scan. To find out the value right now, independent of scan time, use Get PID Current Input.
- The input can be an analog point or a PID output (for cascaded PIDs), or it can be determined by the strategy in the control engine using Set PID Input.

**Arguments:**
- **Action Block**
  - **Argument 0**
    - PID Loop
  - **Argument 1**
    - Input
- **OptoScript Example:**

  ```optoscript
  GetPidInput(PID Loop)
  ```

  ```optoscript
  PID_INPUT_VALUE = GetPidInput(HEATER_3);
  ```

  This is a function command; it returns the input value of the PID loop. The returned value can be consumed by a variable (as in the example shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the **PAC Control User's Guide** (form 1700).

**Notes:**
- Use to detect bad or out-of-range PID input values. When such a value is found, use the Set PID Output command to change the PID output as required.

**Dependencies:** Communication to the PID must be enabled for this command to read the actual value from the PID.

**See Also:**
- "Enable Communication to PID Loop" on page 572
- "Get PID Current Input" on page 509
- "Set PID Input" on page 536
Get PID Input High Range

NOTE: This command is used for PID loops in PAC Control; it is not for use with the SNAP-PID-V module.

Function: To read the highest expected value from the PID's input.

Typical Use: To determine current PID configuration.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>PID Loop</td>
<td>High Range</td>
</tr>
<tr>
<td>PID Loop</td>
<td>Analog Output</td>
</tr>
<tr>
<td></td>
<td>Float Variable</td>
</tr>
<tr>
<td></td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

Action Block Example:

```
Get PID Input High Range
```

OptoScript Example:

```
GetPidInputHighRange(PID Loop)
```

This is a function command; it returns the highest valid input of the PID loop. The returned value can be consumed by a variable (as in the example shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the *PAC Control User's Guide* (form 1700).

Notes: See “PID Commands” in the *PAC Control User’s Guide* (form 1700).

Dependencies: Communication to the PID must be enabled for this command to read the actual value from the PID.

See Also:  
“Enable Communication to PID Loop” on page 572  
“Get PID Input Low Range” on page 518  
“Set PID Input High Range” on page 537
Get PID Input Low Range
PID—Ethernet Action

NOTE: This command is used for PID loops in PAC Control; it is not for use with the SNAP-PID-V module.

Function: To read the lowest expected value from the PID’s input.

Typical Use: To determine current PID configuration.

Arguments:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>PID Loop</td>
<td>PID Loop</td>
<td>HEATER_3</td>
</tr>
<tr>
<td>Low Range</td>
<td>Analog Output</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Float Variable</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Integer 32 Variable</td>
<td></td>
</tr>
</tbody>
</table>

Action Block Example:

```
Get PID Input Low Range
```

OptoScript Example:

```
GetPidInputLowRange(PID Loop)
```

This is a function command; it returns the lowest valid input of the PID loop. The returned value can be consumed by a variable (as in the example shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User's Guide (form 1700).

Notes: See “PID Commands” in the PAC Control User’s Guide (form 1700).

Dependencies: Communication to the PID must be enabled for this command to read the actual value from the PID.

See Also: “Enable Communication to PID Loop” on page 572
          “Get PID Input High Range” on page 517
          “Set PID Input Low Range” on page 538
CHAPTER 17: PID - ETHERNET COMMANDS

Get PID Max Output Change

**PID—Ethernet Action**

*NOTE: This command is used for PID loops in PAC Control; it is not for use with the SNAP-PID-V module.*

**Function:**
To read the maximum output change limit of the PID.

**Typical Use:**
To find out current PID arguments and save them for future use.

**Details:**
- The max output change value defines the maximum amount that the PID output is allowed to change per scan period. This value makes sure the output will ramp up, for example, rather than increasing too quickly. The units are the same as those defined for the PID output point.
- The default value is the range of the output point. This allows the PID output to move as much as 100 percent per scan period. For example, if the PID output point is 4–20 mA, 16.00 would be returned by default, representing 100 percent of the range.
- Note that the max output change limits the PID algorithm and may slow it down.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>PID Loop</td>
<td>PID Loop</td>
<td>HEATER_3</td>
</tr>
<tr>
<td>Max Change</td>
<td>Analog Output</td>
<td>PID_MAX_LIMIT</td>
</tr>
<tr>
<td></td>
<td>Float Variable</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Integer 32 Variable</td>
<td></td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```
GetPidMaxOutputChange(PID Loop)
```

```
PID_MAX_LIMIT = GetPidMaxOutputChange(HEATER_3);
```

This is a function command; it returns the maximum possible change in the output of the PID loop. The returned value can be consumed by a variable (as in the example shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the *PAC Control User’s Guide* (form 1700).

**Notes:**

**Dependencies:**
Communication to the PID must be enabled for this command to read the actual value from the PID.

**See Also:**
- “Enable Communication to PID Loop” on page 572
- “Get PID Max Output Change” on page 519
- “Set PID Scan Time” on page 545
**Get PID Min Output Change**  
**PID—Ethernet Action**

*NOTE: This command is used for PID loops in PAC Control; it is not for use with the SNAP-PID-V module.*

**Function:** To read the minimum amount of change that must occur before the PID output will change.

**Typical Use:** To find out current PID arguments and save them for future use.

**Details:**
- The min output change value defines how much the PID output must change for the change to be applied. A minimum value avoids constant changing, which might wear out valve linkage, for example. The units are the same as those defined for the PID output channel.
- The default value is zero (no minimum). The value must be a positive number.
- The change is applied when it exceeds the minimum in either direction (up or down).

**Arguments:**
- **Argument 0**
  - PID Loop
  - PID Loop
- **Argument 1**
  - Min Change
  - Analog Output
  - Float Variable
  - Integer 32 Variable

**Action Block Example:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>PID Loop</td>
<td>PID Loop</td>
<td>HEATER_3</td>
</tr>
<tr>
<td>Min Change</td>
<td>Float Variable</td>
<td>PID_MIN_LIMIT</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

GetPidMinOutputChange(PID Loop)

PID_MIN_LIMIT = GetPidMinOutputChange(HEATER_3);

This is a function command; it returns the minimum possible change in the output of the PID loop. The returned value can be consumed by a variable (as in the example shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the **PAC Control User’s Guide** (form 1700).

**Notes:** See “PID Commands” in the **PAC Control User’s Guide** (form 1700).

**Dependencies:** Communication to the PID must be enabled for this command to read the actual value from the PID.

**See Also:**
- “Enable Communication to PID Loop” on page 572
- “Get PID Max Output Change” on page 519
- “Set PID Min Output Change” on page 540
- “Set PID Scan Time” on page 545
Get PID Mode

PID—Ethernet Action

NOTE: This command is used for PID loops in PAC Control; it is not for use with the SNAP-PID-V module.

Function: To read whether the PID is in auto or manual mode.

Typical Use: To store current PID arguments for later use.

Details:
- Reads auto/manual mode from the PID in the I/O unit. If the PID is disabled or the I/O unit is disabled, the last known value will be returned instead (the IVAL).
- Returns a zero if in auto mode or a 1 if in manual mode.

Arguments:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>PID Loop</td>
<td>PID Loop</td>
<td>Extruder_Zone08</td>
</tr>
<tr>
<td>Mode</td>
<td>Integer 32 Variable</td>
<td>ZONE08_MODE</td>
</tr>
</tbody>
</table>

Action Block Example:

```
Get PID Mode
```

OptoScript Example:

```
GetPidMode(PID Loop)
ZONE08_MODE = GetPidMode(Extruder_Zone08);
```

This is a function command; it returns a zero (auto mode) or a 1 (manual mode). The returned value can be consumed by a variable (as in the example shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).


See Also: “Set PID Mode” on page 541
Get PID Output
PID—Ethernet Action

NOTE: This command is used for PID loops in PAC Control; it is not for use with the SNAP-PID-V module.

Function: To read the output value of the PID.

Typical Use: To read the current PID output and store it for future use.

Details: The value read has the same engineering units as the specified PID output channel.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>PID Loop</td>
<td>Output</td>
</tr>
</tbody>
</table>

Example:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>PID Loop</td>
<td>PID Loop</td>
<td>HEATER_3</td>
</tr>
<tr>
<td>Output</td>
<td>Analog Output</td>
<td>TPO_OUTPUT</td>
</tr>
</tbody>
</table>

OptoScript Example:

GetPidOutput(PID Loop)

TPO_OUTPUT = GetPidOutput(HEATER_3);

This is a function command; it returns the output value of the PID loop. The returned value can be consumed by an analog output (as in the example shown) or by a variable, a mathematical expression, and so forth. For more information, see the PAC Control User’s Guide (form 1700).

Notes:

- This command can also be used to detect when the PID output is updated (which is always at the end of the scan period).

Dependencies: Communication to the PID must be enabled for this command to read the actual value from the PID.

See Also:

*Enable Communication to PID Loop* on page 572
*Set PID Output* on page 542
Get PID Output High Clamp

**PID—Ethernet Action**

**NOTE:** This command is used for PID loops in PAC Control; it is not for use with the SNAP-PID-V module.

**Function:**
To read the high clamp value currently set for the PID output.

**Typical Use:**
To determine current PID values.

**Details:**
The output low clamp and high clamp values define the range of output for this PID loop.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>PID Loop</td>
<td>High Clamp</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```plaintext
GetPidOutputHighClamp(PID Loop)
```

This is a function command; it returns the highest possible value for the output of the PID loop. The returned value can be consumed by a variable (as in the example shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the *PAC Control User’s Guide* (form 1700).

**Notes:**

**Dependencies:**
Communication to the PID must be enabled for this command to read the actual value from the PID.

**See Also:**
- “Enable Communication to PID Loop” on page 572
- “Get PID Output Low Clamp” on page 524
- “Set PID Output High Clamp” on page 543
Get PID Output Low Clamp

PID—Ethernet Action

NOTE: This command is used for PID loops in PAC Control; it is not for use with the SNAP-PID-V module.

Function: To read the low clamp value currently set for the PID output.

Typical Use: To determine current PID values.

Details: The output low clamp and high clamp values define the range of output for this PID loop.

Arguments:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>PID Loop</td>
<td>PID Loop</td>
<td>HEATER_3</td>
</tr>
</tbody>
</table>

OptoScript Example:

```
GetPidOutputLowClamp (PID Loop)

PID_LOW_CLAMP = GetPidOutputLowClamp (HEATER_3);
```

This is a function command; it returns the lowest possible value for the output of the PID loop. The returned value can be consumed by a variable (as in the example shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User's Guide (form 1700).

Notes: See “PID Commands” in the PAC Control User’s Guide (form 1700).

Dependencies: Communication to the PID must be enabled for this command to read the actual value from the PID.

See Also:
- "Enable Communication to PID Loop" on page 572
- "Get PID Output High Clamp" on page 523
- "Set PID Output Low Clamp" on page 544
Get PID Scan Time

PID—Ethernet Action

NOTE: This command is used for PID loops in PAC Control; it is not for use with the SNAP-PID-V module.

Function: Gets the PID calculation interval (the scan time).

Typical Use: To store current PID arguments for later use.

Details: Reads the Scan Time value from the PID in the I/O unit. If the PID is disabled or the I/O unit is disabled, the last known value will be returned instead (the IVAL).

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>PID Loop</td>
<td>Scan Time (sec)</td>
</tr>
</tbody>
</table>

Example: GetPIDScanTime(PID Loop)

Zone08_Scan_Time = GetPidScanTime(Extruder_Zone08);

This is a function command; it returns the PID calculation interval (scan time) for the PID loop. The returned value can be consumed by a variable (as in the example shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

Notes:
- To store the result, always use a float variable.

See Also: “Set PID Scan Time” on page 545
Get PID Setpoint

PID—Ethernet Action

NOTE: This command is used for PID loops in PAC Control; it is not for use with the SNAP-PID-V module.

**Function:**
To read the setpoint value of a PID.

**Typical Uses:**
- To verify that the setpoint of the PID is as expected.
- To store the setpoint for later use.

**Details:**
- The value read has the same engineering units as the specified PID setpoint.
- This command retrieves the setpoint value from the most recent scan. To find out the value right now, independent of scan time, use Get PID Current Setpoint.
- The setpoint can be an analog point or a PID output (for cascaded PIDs), or it can be determined by the strategy in the control engine using Set PID Setpoint.

**Arguments:**
- **Argument 0**
  - PID Loop
  - **Argument 1**
  - Setpoint

**Action Block Example:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>PID Loop</td>
<td>PID Loop</td>
<td>Heater_3</td>
</tr>
<tr>
<td>Setpoint</td>
<td>Float Variable</td>
<td>Pid_Setpoint_Value</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```
GetPidSetpoint(PID Loop)
Pid_Setpoint_Value = GetPidSetpoint(Heater_3);
```

This is a function command; it returns the setpoint value of the PID loop. The returned value can be consumed by a variable (as in the example shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the *PAC Control User's Guide* (form 1700).

**Notes:**
- Can be used to detect and log changes made to the PID setpoint.

**Dependencies:**
Communication to the PID must be enabled for this command to read the actual value from the PID.

**See Also:**
- "Enable Communication to PID Loop" on page 572
- "Get PID Current Setpoint" on page 510
- "Set PID Setpoint" on page 546
**Get PID Status Flags**

**PID—Ethernet Action**

*NOTE: This command is used for PID loops in PAC Control; it is not for use with the SNAP-PID-V module.*

**Function:** To read the current state of PID flags.

**Typical Use:** To determine whether input is below or above normal range and whether the output is being forced.

**Details:** Returns a bitmask that indicates current PID status data. More than one flag can be set at a time. Use bitwise commands to get each flag. Flag values are:

- 0x00000001 = Input is below input low range
- 0x00000002 = Input is above input high range
- 0x00000004 = Input was out of range and output is being forced to a predetermined value set during PID configuration

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>PID Loop</td>
<td>Status Flags</td>
</tr>
<tr>
<td>PID Loop</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```
GetPidStatusFlags(PID Loop)
```

```
PID_STATUS_FLAGS = GetPidStatusFlags(HEATER_3);
```

This is a function command; it returns an integer 32 containing the PID status flags from the SNAP PAC I/O brain's memory map. Possible values are listed above.

The returned value can be consumed by a variable (as in the example shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the *PAC Control User's Guide* (form 1700).

**Notes:** See “PID Commands” in the *PAC Control User’s Guide* (form 1700).

**Dependencies:** Communication to the PID must be enabled for this command to read the actual value from the PID.

**See Also:**

- “Enable Communication to PID Loop” on page 572
- “Get PID Configuration Flags” on page 507
- “Set PID Configuration Flags” on page 530
Get PID Tune Derivative

PID—Ethernet Action

NOTE: This command is used for PID loops in PAC Control; it is not for use with the SNAP-PID-V module.

Function: Reads the derivative tuning value from the PID.

Typical Use: To store current PID arguments for later use.

Details: Reads the derivative value from the PID in the I/O unit. If the PID is disabled or the I/O unit is disabled, the last known value will be returned instead (the IVAL).

Arguments:

<table>
<thead>
<tr>
<th>Argument</th>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>PID Loop</td>
<td>PID Loop</td>
<td>Extruder_Zone08</td>
</tr>
<tr>
<td>1</td>
<td>Tune Derivative</td>
<td>Float Variable</td>
<td>Zone08_Derivative</td>
</tr>
</tbody>
</table>

Action Block Example:

```
Get PID Tune Derivative
```

OptoScript Example:

```
Zone08_Derivative = GetPidTuneDerivative(Extruder_Zone08);
```

This is a function command; it returns the derivative value from the PID loop. The returned value can be consumed by a variable (as in the example shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

Notes:

- To store the result, always use a float variable.

See Also: “Set PID Tune Derivative” on page 547
Get PID Tune Integral

PID—Ethernet Action

NOTE: This command is used for PID loops in PAC Control; it is not for use with the SNAP-PID-V module.

**Function:**
Reads the Integral tuning value from the PID.

**Typical Use:**
To store current PID arguments for later use.

**Details:**
Reads the Integral value from the PID in the I/O unit. If the PID is disabled or the I/O unit is disabled, the last known value will be returned instead (the IVAL).

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>PID Loop</td>
<td>Tune Integral</td>
</tr>
<tr>
<td>PID Loop</td>
<td>Analog Output</td>
</tr>
<tr>
<td>PID Loop</td>
<td>Float Variable</td>
</tr>
<tr>
<td>PID Loop</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

**Action Block Example:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>PID Loop</td>
<td>PID Loop</td>
<td>Extruder_Zone08</td>
</tr>
<tr>
<td>Tune Integral</td>
<td>Float Variable</td>
<td>Zone08_Integral</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

GetPidTuneIntegral(PID Loop)

Zone08_Integral = GetPidTuneIntegral(Extruder_Zone08);

This is a function command; it returns the integral value from the PID loop. The returned value can be consumed by a variable (as in the example shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

**Notes:**

- To store the result, always use a float variable.

**See Also:**

“Set PID Tune Integral” on page 548
Set PID Configuration Flags

NOTE: This command is used for PID loops in PAC Control; it is not for use with the SNAP-PID-V module.

Function: To set or change PID configuration options within strategy logic.

Typical Use: To force output to a predetermined value or change it to manual if input goes out of range.

Details:
- PID configuration options can be set using this command or when you initially configure the PID loop in PAC Manager or PAC Control.
- Configuration options are sent as a 32-bit integer (a mask). One or multiple options can be chosen.
  Option values (in hex) are:
  - 0x00000000 = Standard; no special flags.
  - 0x00000001 = Enable square root of input.
  - 0x00000002 = If input goes out of range, force output to a predetermined value. (Set the predetermined value when you initially configure the PID loop.)
  - 0x00000004 = If input goes out of range, switch PID to manual; if input returns to normal range, PID will switch back to automatic.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>PID Loop</td>
<td>Configuration Flags</td>
</tr>
<tr>
<td>PID Loop</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

Action Block

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>PID Loop</td>
<td>PID Loop</td>
<td>HEATER_3</td>
</tr>
<tr>
<td>Configuration Flags</td>
<td>Integer 32 Variable</td>
<td>PID_CONFIG_FLAGS</td>
</tr>
</tbody>
</table>

OptoScript Example:

```OptoScript
SetPidConfigFlags(PID Loop, Configuration Flags)
```

SetPidConfigFlags(HEATER_3, PID_CONFIG_FLAGS);

This is a procedure command; it does not return a value.

Notes: See “PID Commands” in the PAC Control User’s Guide (form 1700).

Dependencies: Communication to the PID must be enabled for this command to take effect.

See Also:
- “Enable Communication to PID Loop” on page 572
- “Get PID Configuration Flags” on page 507
Set PID Feed Forward

PID—Ethernet Action

NOTE: This command is used for PID loops in PAC Control; it is not for use with the SNAP-PID-V module.

Function: To set or change the feed forward value for the PID loop.

Typical Use: To set the value of the PID feed forward for applications requiring feed forward control.

Details:
- The initial value is normally set when the PID is configured and tuned.
- For all PID algorithms, the Feed Forward and the Feed Forward Gain values are multiplied and then added to the output; therefore, a value of 0 for either results in no change to the output.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>PID Loop</td>
<td>Feed Forward</td>
</tr>
</tbody>
</table>

Action Block Example:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>PID Loop</td>
<td>PID Loop</td>
<td>HEATER_3</td>
</tr>
<tr>
<td>Feed Forward</td>
<td>Float Variable</td>
<td>PID_FEED_FORWARD</td>
</tr>
</tbody>
</table>

OptoScript Example:

```
SetPidFeedForward(PID Loop, Feed Forward)
SetPidFeedForward(HEATER_3, PID_FEED_FORWARD);
```

Notes:
- Feed forward is added before output clamping and has a tuning factor.

Dependencies: Communication to the PID must be enabled for this command to send the value to the PID.

See Also:
- "Enable Communication to PID Loop" on page 572
- "Get PID Feed Forward" on page 511
Set PID Feed Forward Gain

PID—Ethernet Action

NOTE: This command is used for PID loops in PAC Control; it is not for use with the SNAP-PID-V module.

Function: To set or change the feed forward gain of the PID output.

Typical Use: To set the value of the feed forward gain of the PID loop for applications requiring feed forward control.

Details:
- The initial value is normally set when the PID is configured and tuned.
- For all PID algorithms, the Feed Forward and the Feed Forward Gain values are multiplied and then added to the output; therefore, a value of 0 for either results in no change to the output.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>PID Loop</td>
<td>Feed Fwd Gain</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>PID Loop</td>
<td>HEATER_3</td>
</tr>
<tr>
<td>Float Variable</td>
<td>PID_FEED_FD_GAIN</td>
</tr>
</tbody>
</table>

Action Block Example:

Set PID Feed Forward Gain

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>PID Loop</td>
<td>PID Loop</td>
<td>HEATER_3</td>
</tr>
<tr>
<td>Feed Fwd Gain</td>
<td>Float Variable</td>
<td>PID_FEED_FD_GAIN</td>
</tr>
</tbody>
</table>

OptoScript Example:

```
SetPidFeedForwardGain(HEATER_3, PID_FEED_FD_GAIN);
```

This is a procedure command; it does not return a value.

Notes: See “PID Commands” in the PAC Control User’s Guide (form 1700).

Dependencies: Communication to the PID must be enabled for this command to send the value to the PID.

See Also:  
*Enable Communication to PID Loop* on page 572  
*Get PID Feed Forward Gain* on page 512
Set PID Forced Output When Input Over Range

**PID—Ethernet Action**

*NOTE: This command is used for PID loops in PAC Control; it is not for use with the SNAP-PID-V module.*

**Function:** To set or change the forced value that will be sent to the PID output if the input is over the established range.

**Typical Use:** To set the PID output to a known value if the input goes higher than its normal range.

**Details:** The PID must be in auto mode for this command to take effect.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>PID Loop</strong></td>
<td><strong>Forced Output</strong></td>
</tr>
<tr>
<td>PID Loop</td>
<td>Analog Input</td>
</tr>
<tr>
<td>Analog Input</td>
<td>Analog Output</td>
</tr>
<tr>
<td>Float Literal</td>
<td>Float Variable</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```optoscript
SetPidForcedOutputWhenInputOverRange(PID Loop, Forced Output)
SetPidForcedOutputWhenInputOverRange(HEATER_3, PID_OUTPUT_OVER_RANGE);
```

This is a procedure command; it does not return a value.

**Notes:**

- A forced output when the input is out of range (either over or under) can also be set when you configure the PID loop.

**See Also:**

- “Get PID Forced Output When Input Over Range” on page 513
- “Set PID Forced Output When Input Under Range” on page 534
Set PID Forced Output When Input Under Range

**PID—Ethernet Action**

*N O T E : This command is used for PID loops in PAC Control; it is not for use with the SNAP-PID-V module.*

**Function:**
To set or change the forced value that will be sent to the PID output if the input is under the established range.

**Typical Use:**
To set the PID output to a known value if the input goes lower than its normal range.

**Details:**
The PID must be in auto mode for this command to take effect.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>PID Loop</td>
<td>Forced Output</td>
</tr>
</tbody>
</table>

- **Typical Use:**
  - Analog Input
  - Analog Output
  - Float Literal
  - Float Variable
  - Integer 32 Literal
  - Integer 32 Variable

**Action Block Example:**

```
Set PID Forced Output When Input Under Range
```

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>PID Loop</td>
<td>PID Loop</td>
<td>HEATER_3</td>
</tr>
<tr>
<td>Forced Output</td>
<td>Float Variable</td>
<td>PID_OUTPUT_UNDER_RANGE</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```
SetPidForcedOutputWhenInputUnderRange(PID Loop, Forced Output)
```

```
SetPidForcedOutputWhenInputUnderRange(HEATER_3, PID_OUTPUT_UNDER_RANGE);
```

This is a procedure command; it does not return a value.

**Notes:**
- A forced output when the input is out of range (either over or under) can also be set when you configure the PID loop.

**See Also:**
- “Get PID Forced Output When Input Under Range” on page 514
- “Set PID Forced Output When Input Over Range” on page 533
Set PID Gain

NOTE: This command is used for PID loops in PAC Control; it is not for use with the SNAP-PID-V module.

Function: To set or change the gain value of the PID.

Typical Use: To tune the PID for more or less aggressive performance.

Details:
- Gain is the inverse of "proportional band," a term used in many PID applications. Gain is used to determine the amount of PID output response to a change in PID input or setpoint.
- Always use a non-zero gain value.
- Use a negative gain to reverse the direction of the PID output (typical for heating applications).
- Gain has a direct multiplying effect on the integral and derivative values. Too much gain results in excessive amounts of PID output change; too little gain results in long-lasting errors between the PID input and the PID setpoint.

Arguments: | Argument 0 | Argument 1 |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>PID Loop</td>
<td>Gain</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>PID Loop</td>
<td>Extruder_Zone08</td>
</tr>
<tr>
<td>Gain</td>
<td>Zone08_Gain</td>
</tr>
</tbody>
</table>

Action Block Example:

Set PID Gain

OptoScript Example:

SetPidGain(PID Loop, Gain)

SetPidGain(Extruder_Zone08, Zone08_Gain);

Notes:
- Use an initial value of 1.0 or -1.0 until a better value is determined. Typical gain values range from 1 to 40 and from -1 to -40.
- Use more gain to improve response to step changes; use less gain to improve stability.

Dependencies: Communication to the PID must be enabled for this command to send the value to the PID.

See Also:
- “Enable Communication to PID Loop” on page 572
- “Get PID Gain” on page 515
Set PID Input

PID—Ethernet Action

NOTE: This command is used for PID loops in PAC Control; it is not for use with the SNAP-PID-V module.

**Function:**
To send an input value (also known as the process variable) to the PID when its input does not come from an analog input point on the same I/O unit.

**Typical Use:**
To get an input from another I/O unit and forward it to the PID.

**Details:**
Use this command based on a timed interval. For example, if the PID scan rate is 1 second, send the input value to the PID approximately every second (anywhere from 0.8 seconds to 1.0 seconds should be adequate).

**Arguments:**
- **Argument 0**
  - **PID Loop**
  - **Input**
- **Argument 1**
  - Analog Input
  - Analog Output
  - Float Literal
  - Float Variable
  - Integer 32 Literal
  - Integer 32 Variable

**Action Block Example:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>PID Loop</td>
<td>PID Loop</td>
<td>HEATER_3</td>
</tr>
<tr>
<td>Input</td>
<td>Float Variable</td>
<td>PID_INPUT_VALUE</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```
SetPidInput(PID Loop, Input)
```

```
SetPidInput(HEATER_3, PID_INPUT_VALUE);
```

This is a procedure command; it does not return a value.

**Notes:**
- Do not send the input value to the PID less frequently than the PID scan rate, as it will adversely affect the PID performance.

**Dependencies:**
- You must configure the PID input to be from Host.
- Communication to the PID must be enabled for this command to send the value to the PID.

**See Also:**
- “Enable Communication to PID Loop” on page 572
- “Get PID Input” on page 516
Set PID Input High Range

PID—Ethernet Action

NOTE: This command is used for PID loops in PAC Control; it is not for use with the SNAP-PID-V module.

Function: To set or change the highest expected value from the PID’s input.

Typical Use: To set the highest valid input from the PID.

Details: Input high range is normally set when the PID is configured, but it can be changed from a running strategy using this command.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>PID Loop</td>
<td>High Range</td>
</tr>
<tr>
<td>PID Loop</td>
<td>Analog Input</td>
</tr>
<tr>
<td>PID Loop</td>
<td>Analog Output</td>
</tr>
<tr>
<td>PID Loop</td>
<td>Float Literal</td>
</tr>
<tr>
<td>PID Loop</td>
<td>Float Variable</td>
</tr>
<tr>
<td>PID Loop</td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td>PID Loop</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>PID Loop</td>
<td>PID Loop</td>
<td>HEATER_3</td>
</tr>
<tr>
<td>High Range</td>
<td>Float Variable</td>
<td>PID_High_Range</td>
</tr>
</tbody>
</table>

OptoScript Example: `SetPidInputHighRange(PID Loop, High Range)`

Example: `SetPidInputHighRange(HEATER_3, PID_High_Range);`

Notes:
- Input range affects the span used in the PID algorithm. It is also used in output options when the input is out of range. See Set PID Configuration Flags.

Dependencies: Communication to the PID must be enabled for this command to send the value to the PID.

See Also:
- “Get PID Input High Range” on page 517
- “Set PID Input Low Range” on page 538
Set PID Input Low Range
PID—Ethernet Action

NOTE: This command is used for PID loops in PAC Control; it is not for use with the SNAP-PID-V module.

Function:  To set or change the lowest expected value from the PID’s input.

Typical Use:  To set the lowest valid input for the PID.

Details:  Input low range is normally set when the PID is configured, but it can be changed from a running strategy using this command.

Arguments:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>PID Loop</td>
<td>PID Loop</td>
<td>HEATER_3</td>
</tr>
<tr>
<td>Low Range</td>
<td>Float Variable</td>
<td>PID_LOW_RANGE</td>
</tr>
</tbody>
</table>

This is a procedure command; it does not return a value.

Notes:

- Input range affects the span used in the PID algorithm. It is also used in output options when the input is out of range. See Set PID Configuration Flags.

Dependencies:  Communication to the PID must be enabled for this command to send the value to the PID.

See Also:  “Get PID Input Low Range” on page 518
          “Set PID Input High Range” on page 537
**Set PID Max Output Change**

**PID—Ethernet Action**

*NOTE: This command is used for PID loops in PAC Control; it is not for use with the SNAP-PID-V module.*

**Function:**
To set or change the maximum output change limit of the PID.

**Typical Use:**
To define the maximum amount that the PID output is allowed to change per scan period, to make sure the output ramps up (or down) rather than increasing or decreasing too quickly.

**Details:**
- Maximum output change is normally set when the PID is configured, but it can be changed from a running strategy using this command.
- Units are the same as those defined for the PID output point.
- The default value is the range of the output point. This setting allows the PID output to move as much as 100 percent per scan period. For example, if the PID output point is 4–20 mA, 16.00 would be the default, representing 100 percent of the range.
- Note that the max output change limits the PID algorithm and may slow it down.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>PID Loop</td>
<td>Max Change</td>
</tr>
</tbody>
</table>

- PID Loop: PID Loop
- Max Change: Analog Input, Analog Output, Float Literal, Float Variable, Integer 32 Literal, Integer 32 Variable

**Action Block Example:**
```
Set PID Max Output Change
```

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>PID Loop</td>
<td>PID Loop</td>
<td>HEATER_3</td>
</tr>
<tr>
<td>Max Change</td>
<td>Float Variable</td>
<td>PID_MAX_LIMIT</td>
</tr>
</tbody>
</table>

**OptoScript Example:**
```
SetPidMaxOutputChange (PID Loop, Max Change)
```
```
SetPidMaxOutputChange (HEATER_3, PID_MAX_LIMIT);
```

This is a procedure command; it does not return a value.

**Notes:**

**Dependencies:**
Communication to the PID must be enabled for this command to send the value to the PID.

**See Also:**
- “Enable Communication to PID Loop” on page 572
- “Get PID Max Output Change” on page 519
- “Set PID Scan Time” on page 545
Set PID Min Output Change

PID—Ethernet Action

NOTE: This command is used for PID loops in PAC Control; it is not for use with the SNAP-PID-V module.

**Function:** To set the minimum amount of change that must occur before the PID output will change.

**Typical Use:** To define how much change must occur before the PID output changes, in order to avoid constant changes that might wear out parts (such as valve linkage).

**Details:**
- Minimum output change is normally set when the PID is configured, but it can be changed from a running strategy using this command.
- Units are the same as those defined for the PID output channel.
- The default value is zero (no minimum). The value must be a positive number.
- The change is applied when it exceeds the minimum in either direction (up or down).

**Arguments:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>PID Loop</td>
<td>PID Loop</td>
<td>HEATER_3</td>
</tr>
<tr>
<td>Min Change</td>
<td>Float Variable</td>
<td>PID_MIN_LIMIT</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```
SetPIDMinOutputChange(PID Loop, Min Change)
```

SetPIDMinOutputChange(HEATER_3, PID_MIN_LIMIT);

This is a procedure command; it does not return a value.

**Notes:** See “PID Commands” in the PAC Control User’s Guide (form 1700).

**Dependencies:** Communication to the PID must be enabled for this command to send the value to the PID.

**See Also:**
- “Enable Communication to PID Loop” on page 572
- “Get PID Max Output Change” on page 519
- “Set PID Scan Time” on page 545
Set PID Mode

PID—Ethernet Action

NOTE: This command is used for PID loops on PAC brains in PAC Control; it is not for use with the SNAP-PID-V module.

For mistic PID loops, see “19: PID - Mistic” on page 585.

Function: Sets the auto/manual mode of the PID.

Typical Use: To change the PID from automatic to manual mode or return it to auto.

Details:
- Use these values to set auto and manual modes: auto = 0, manual = 1.
  - In auto mode, the PID output functions normally.
  - In manual mode, the PID output register (which is part of the PID loop structure) is not updated by the PID calculation. However, the PID loop will continue to update the analog output point from the PID output register at the configured PID scan rate.

To use two PID loops for the same analog output point, configure the output for both loops to be "Host" (PAC Control > Configure > I/O > PID Loops). Then, use logic to read the appropriate PID output, and then move it to the analog point.
- To change the PID output value while in manual mode, use Set PID Output; if using Debug mode, PAC Manager, or PAC Display, write to the PID output instead of to the analog point.

Arguments:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>PID Loop</td>
<td></td>
<td>Extruder_Zone08</td>
</tr>
<tr>
<td>Mode</td>
<td>Integer 32</td>
<td>ZONE08_MODE</td>
</tr>
</tbody>
</table>

Action Block Example:

<table>
<thead>
<tr>
<th>PID Loop</th>
<th>PID Loop</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Extruder_Zone08</td>
</tr>
<tr>
<td>Mode</td>
<td>Integer 32 Variable</td>
<td>ZONE08_MODE</td>
</tr>
</tbody>
</table>

OptoScript Example: `SetPidMode(PID Loop, Mode)`

```
SetPidMode(Extruder_Zone08, ZONE08_MODE);
```

This is a procedure command; it does not return a value.

Notes: See “PID Commands” in the PAC Control User’s Guide (form 1700).

See Also: “Get PID Mode” on page 521
“Set PID Output” on page 542
Set PID Output
PID—Ethernet Action

**NOTE:** This command is used for PID loops in PAC Control; it is not for use with the SNAP-PID-V module.

**Function:** To set or change the output value of the PID.

**Typical Use:** To adjust the PID output when the PID is in manual mode.

**Details:** The value sent must have the same engineering units as the specified PID output channel.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>PID Loop</td>
<td>PID Loop</td>
<td>HEATER_3</td>
</tr>
<tr>
<td>Output</td>
<td>Analog Output</td>
<td>TPO_OUTPUT</td>
</tr>
</tbody>
</table>

**Action Block Example:**

```
Set PID Output
```

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>PID Loop</td>
<td>PID Loop</td>
<td>HEATER_3</td>
</tr>
<tr>
<td>Output</td>
<td>Analog Output</td>
<td>TPO_OUTPUT</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```SetPidOutput (PID Loop, Output)`
```

SetPidOutput (HEATER_3, TPO_OUTPUT);

This is a procedure command; it does not return a value.

**Notes:** See “PID Commands” in the PAC Control User's Guide (form 1700).

**Dependencies:** Communication to the PID must be enabled for this command to send the value to the PID.

**See Also:**

- "Enable Communication to PID Loop" on page 572
- "Get PID Output" on page 522
- "Set PID Mode" on page 541
- "Get PID Mode" on page 521
Set PID Output High Clamp

**PID—Ethernet Action**

NOTE: This command is used for PID loops in PAC Control; it is not for use with the SNAP-PID-V module.

**Function:**
To set or change the high clamp value for the PID output.

**Typical Use:**
To change the high clamp value while the strategy is running.

**Details:**
The output low clamp and high clamp values define the range of output for this PID loop. They are normally set when the PID is configured but can be changed from within a running strategy using this command.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>PID Loop</strong></td>
<td><strong>High Clamp</strong></td>
</tr>
<tr>
<td>Analog Input</td>
<td>Analog Input</td>
</tr>
<tr>
<td>Analog Output</td>
<td>Analog Output</td>
</tr>
<tr>
<td>Float Literal</td>
<td>Float Literal</td>
</tr>
<tr>
<td>Float Variable</td>
<td>Float Variable</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

**Action Block Example:**

Set PID Output High Clamp

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>PID Loop</td>
<td>PID Loop</td>
<td>HEATER_3</td>
</tr>
<tr>
<td>High Clamp</td>
<td>Float Variable</td>
<td>PID_HIGH_CLAMP</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

SetPidOutputHighClamp (PID Loop, High Clamp)

SetPidOutputHighClamp(HEATER_3, PID_HIGH_CLAMP);  

This is a procedure command; it does not return a value.

**Notes:**

**Dependencies:**
Communication to the PID must be enabled for this command to send the value to the PID.

**See Also:**
“Enable Communication to PID Loop” on page 572
“Get PID Output High Clamp” on page 523
“Set PID Output Low Clamp” on page 544
**Set PID Output Low Clamp**

*PID—Ethernet Action*

*NOTE: This command is used for PID loops in PAC Control; it is not for use with the SNAP-PID-V module.*

**Function:**
To set or change the low clamp value for the PID output.

**Typical Use:**
To change the PID output’s low clamp value while a strategy is running.

**Details:**
The output low clamp and high clamp values define the range of output for this PID loop. They are normally set when the PID is configured but can be changed from within a running strategy using this command.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>PID Loop</td>
<td>Low Clamp</td>
</tr>
</tbody>
</table>

- PID Loop: PID Loop
- Low Clamp: Analog Input, Analog Output, Float Literal, Float Variable, Integer 32 Literal, Integer 32 Variable

**Action Block Example:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>PID Loop</td>
<td>PID Loop</td>
<td>HEATER_3</td>
</tr>
<tr>
<td>Low Clamp</td>
<td>Float Variable</td>
<td>PID_LOW_CLAMP</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

SetPidOutputLowClamp(*PID Loop, Low Clamp*)

```
SetPidOutputLowClamp(HEATER_3, PID_LOW_CLAMP);
```

This is a procedure command; it does not return a value.

**Notes:**

**Dependencies:**
Communication to the PID must be enabled for this command to send the value to the PID.

**See Also:**
*“Enable Communication to PID Loop” on page 572*
*“Get PID Output Low Clamp” on page 524*
*“Set PID Output High Clamp” on page 543*
Set PID Scan Time

**PID—Ethernet Action**

*NOTE: This command is used for PID loops in PAC Control; it is not for use with the SNAP-PID-V module.*

**Function:**
To set or change the PID calculation interval (the update period or scan rate).

**Typical Use:**
To adapt a PID to the characteristics of the closed-loop control system under program control.

**Details:**
- This is the most important parameter of all the configurable PID parameters. In order to tune the PID, scan time should be greater than system lag (the time it takes for the controller output to have a measurable effect on the system). Also consider other PIDs and tasks on the brain competing for processing power.
- The value to send is in seconds. The default is 0.1 seconds.
- This command is useful for adapting a PID to work for either heating or cooling when the heating mode has a different dead time than the cooling mode.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>PID Loop</td>
<td>Scan Time (sec)</td>
</tr>
<tr>
<td>PID Loop</td>
<td>Analog Input</td>
</tr>
<tr>
<td></td>
<td>Analog Output</td>
</tr>
<tr>
<td></td>
<td>Float Literal</td>
</tr>
<tr>
<td></td>
<td>Float Variable</td>
</tr>
<tr>
<td></td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td></td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```
SetPidScanTime(PID Loop, Scan Time (sec))
SetPidScanTime(Extruder_Zone08, Zone08_Scan_Time);
```

This is a procedure command; it does not return a value.

**Notes:**
- See “PID Commands” in the **PAC Control User’s Guide** (form 1700).
- Frequent use of this command can adversely affect the PID performance.

**Dependencies:**
Communication to the PID must be enabled for this command to send the value to the PID.

**See Also:**
“Enable Communication to PID Loop” on page 572
“Get PID Scan Time” on page 525,
Set PID Setpoint
PID—Ethernet Action

NOTE: This command is used for PID loops in PAC Control; it is not for use with the SNAP-PID-V module.

Function: To change the setpoint value of the PID.

Typical Use: To raise or lower the setpoint or to restore it to its original value.

Details:
- To use this command, the setpoint must be configured to come from Host.
- The value you send has the same engineering units as the PID input.
- The setpoint can be an analog point, even from another I/O unit.

Arguments:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>PID Loop</td>
<td>PID Loop</td>
<td>Heater_3</td>
</tr>
<tr>
<td>Setpoint</td>
<td>Float Variable</td>
<td>Pid_Setpoint_Value</td>
</tr>
</tbody>
</table>

Action Block Example:

```
Set PID Setpoint

Set PID Setpoint(PID Loop, Setpoint)
```

OptoScript Example:

```
SetPidSetpoint(PID Loop, Setpoint)
SetPidSetpoint(Heater_3, Pid_Setpoint_Value);
```

This is a procedure command; it does not return a value.

Notes:
- Send a new setpoint value to the PID only when necessary.

Dependencies: Communication to the PID must be enabled for this command to send the value to the PID.

See Also:  
“Enable Communication to PID Loop” on page 572  
“Get PID Setpoint” on page 526
Set PID Tune Derivative

PID—Ethernet Action

NOTE: This command is used for PID loops in PAC Control; it is not for use with the SNAP-PID-V module.

Function: To change the derivative value of the PID.

Typical Use: To improve performance in systems with long delays between when the PID output changes and when the PID input responds to the change.

Details:
- The derivative is used to determine how much effect the change-in-slope of the PID input should have on the PID output. It is useful in predicting the future value of the PID input based on the change in trend of the PID input as recorded during the last three scan periods.
- Too high a derivative value results in excessive amounts of PID output change. In systems with long delays, too low a derivative value results in a PID output that is always out of phase with the PID input.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>PID Loop</td>
<td>Tune Derivative</td>
</tr>
<tr>
<td>PID Loop</td>
<td>Analog Input</td>
</tr>
<tr>
<td></td>
<td>Analog Output</td>
</tr>
<tr>
<td></td>
<td>Float Literal</td>
</tr>
<tr>
<td></td>
<td>Float Variable</td>
</tr>
<tr>
<td></td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td></td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

Action Block Example:

```
Set PID Tune Derivative

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>PID Loop</td>
<td>PID Loop</td>
<td>Extruder_Zone08</td>
</tr>
<tr>
<td>Tune Derivative</td>
<td>Float Variable</td>
<td>Zone08_Derivative</td>
</tr>
</tbody>
</table>
```

OptoScript Example: `SetPidTuneDerivative(PID Loop, Tune Derivative)`

```
SetPidTuneDerivative(Extruder_Zone08, Zone08_Derivative);
```

This is a procedure command; it does not return a value.

Notes:
- Leave the derivative at zero unless you are sure you need it and until the gain and integral have been determined. Use sparingly; a little derivative goes a long way.
- Since derivative is applied only to the process variable, not to the setpoint, the setpoint can be changed without causing spikes in the derivative term.

Dependencies: Communication to the PID must be enabled for this command to send the value to the PID.

See Also: “Enable Communication to PID Loop” on page 572
“Get PID Tune Derivative” on page 528
**Set PID Tune Integral**

**PID—Ethernet Action**

*NOTE: This command is used for PID loops in PAC Control; it is not for use with the SNAP-PID-V module.*

**Function:**
To change the Integral value of the PID.

**Typical Use:**
To improve PID performance in systems with steady-state errors.

**Details:**
- The integral is used to reduce the error between the PID setpoint and the PID input to zero under steady-state conditions. Its value determines how much the error affects the PID output.
- Too high an integral value results in excessive PID output change; too low an integral value results in long-lasting errors between the PID input and the PID setpoint.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>PID Loop</strong></td>
<td><strong>Tune Integral</strong></td>
</tr>
<tr>
<td>PID Loop</td>
<td>Analog Input</td>
</tr>
<tr>
<td></td>
<td>Analog Output</td>
</tr>
<tr>
<td></td>
<td>Float Literal</td>
</tr>
<tr>
<td></td>
<td>Float Variable</td>
</tr>
<tr>
<td></td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td></td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

**Action Block Example:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>PID Loop</td>
<td>PID Loop</td>
<td>Extruder_Zone08</td>
</tr>
<tr>
<td>Tune Integral</td>
<td>Float Variable</td>
<td>Zone08_Integral</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```optoscript
SetPidTuneIntegral(PID Loop, Tune Integral);
```

This is a procedure command; it does not return a value.

**Notes:**
- Use an initial value of 1.0 until a better value is determined. Typical integral values range from 0.1 to 20.
- This PID prevents integral windup by back calculating the integral without the derivative term.

**Dependencies:**
Communication to the PID must be enabled for this command to send the value to the PID.

**See Also:**
- *Enable Communication to PID Loop* on page 572
- *Get PID Tune Integral* on page 529
18: Pointers Commands

Clear Pointer

Function: To NULL out a pointer.

Typical Use: To clear a pointer so that it no longer points to an object.

Arguments:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pointer</td>
<td>Pointer Variable</td>
<td>IO_Pointer</td>
</tr>
</tbody>
</table>

Action Block Example:

```
OptoScript doesn’t use a command; the functionality is built in. Assign null to the pointer:
IO_Pointer = null;
```

Notes: Operations cannot be performed on NULL pointers. NULL pointers do not point to any object.

See Also: “Move to Pointer” on page 553
“Clear Pointer Table Element” on page 550
Clear Pointer Table Element

**Pointers Action**

**Function:** To NULL out the specified element of a pointer table.

**Typical Use:** To clear an element in a pointer table so that it no longer points to any object.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index</td>
<td>Integer 32 Literal</td>
<td>17</td>
</tr>
<tr>
<td>Of Table</td>
<td>Pointer Table</td>
<td>IO_POINTER_TABLE</td>
</tr>
</tbody>
</table>

**Action Block Example:**

```
<table>
<thead>
<tr>
<th>Clear Pointer Table Element</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argument Name</td>
</tr>
<tr>
<td>---------------</td>
</tr>
<tr>
<td>Index</td>
</tr>
<tr>
<td>Of Table</td>
</tr>
</tbody>
</table>
```

**OptoScript Example:**

OptoScript doesn’t use a command; the functionality is built in. Assign \texttt{null} to the pointer:

```
IO POINTER TABLE[17] = null;
```

**Notes:** Operations cannot be performed on a NULL pointer.

**Queue Errors:** -12 = Invalid table index value. Index was negative or greater than the table size.

**See Also:** “Move to Pointer Table Element” on page 556
Get Pointer From Name

Pointers Action

Function: To assign an object to a pointer variable based on the object’s name.

Typical Use: To help process requests from peers when the object needed may change dynamically.

Details:
- If a variable of the specified name is not found, the pointer is set to null.
- The variable name must match the pointer’s type. For example, if the pointer variable is a float pointer, the variable name must be for a float variable.
- The variable name is case sensitive.
- If a string variable is used in Name (Argument 0), the command assigns a pointer to the object whose name is contained within the string variable (that is, the contents of the string variable), not to the string variable itself.
  The type of the pointer must match the type of the object whose name is contained within the string variable.
  In the example
  \[
  \text{My\_String} = "\text{My\_Integer}" ;
  \text{GetPointerFromName(My\_String, pInteger);}
  \]
  The variable \text{My\_String} is a string variable containing the name of an integer variable (\text{My\_Integer}) that must exist in the strategy. This command then moves the pointer for \text{My\_Integer} into the pointer variable \text{pInteger}.

Arguments: 

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Pointer</td>
</tr>
<tr>
<td>String Literal</td>
<td>Pointer Variable</td>
</tr>
</tbody>
</table>

Action Block Example:

<table>
<thead>
<tr>
<th>Get Pointer From Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argument Name</td>
</tr>
<tr>
<td>----------------</td>
</tr>
<tr>
<td>Name</td>
</tr>
<tr>
<td>Pointer</td>
</tr>
</tbody>
</table>

OptoScript Example:

\[
\text{GetPointerFromName(\text{Name}, \text{Pointer})} \]

\[
\text{GetPointerFromName("My\_Integer", pInteger);}
\]
This is a procedure command; it does not return a value.

Notes: For more information on peer-to-peer communication, see “Communication Commands” in the PAC Control User’s Guide (form 1700).

See Also: “Move to Pointer” on page 553
Move from Pointer Table Element

Pointers Action

**Function:**
To move an object from a pointer table to a pointer variable.

**Typical Use:**
To retrieve objects from pointer tables.

**Details:**
This command allows you to retrieve objects from a pointer table and place them into pointer variables of the same type.

**Arguments:**
- **Argument 0**
  - Name: Index
  - Type: Integer 32 Literal
  - Name: CURRENT_INDEX
  - Type: Integer 32 Variable

- **Argument 1**
  - Name: Of Table
  - Type: Pointer Table
  - Name: IO_POINTERS

- **Argument 2**
  - Name: To Pointer
  - Type: Pointer Variable
  - Name: TANK_SWITCH_POINTER

**Action Block Example:**

```
Move From Pointer Table Element

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index</td>
<td>Integer 32 Variable</td>
<td>CURRENT_INDEX</td>
</tr>
<tr>
<td>Of Table</td>
<td>Pointer Table</td>
<td>IO_POINTERS</td>
</tr>
<tr>
<td>To Pointer</td>
<td>Pointer Variable</td>
<td>TANK_SWITCH_POINTER</td>
</tr>
</tbody>
</table>
```

**OptoScript Example:**

```
TANK_SWITCH_POINTER = IO_POINTERS[CURRENT_INDEX];
```

**Notes:**
- In OptoScript code, simply make an assignment from the table element.
- Be sure to move the object from the table into a pointer of the same type. If the types are different, an error will be posted to the message queue.

**Queue Errors:**
- `-29 = Wrong object type. Most likely caused by moving a pointer table element to a pointer of the wrong type.`
- `-69 = Invalid parameter (null pointer) passed to driver. Use Move to Pointer Table Element to initialize the table entry.`

**See Also:**
- "Move to Pointer" on page 553
- "Move to Pointer Table Element" on page 556,
Move to Pointer

Pointers Action

**Function:**
To assign an object to a pointer.

**Typical Use:**
To initialize a pointer.

**Details:**
The pointer will point to the object specified. Any operation that can be performed on the object can likewise be performed on the pointer. When you perform an operation on a pointer, you are actually performing the operation on the object.

For Arguments, see next page.
<table>
<thead>
<tr>
<th>Argument 0</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Object</strong></td>
</tr>
<tr>
<td>Analog Event/Reaction*</td>
</tr>
<tr>
<td>Analog Input</td>
</tr>
<tr>
<td>Analog Output</td>
</tr>
<tr>
<td>B100*</td>
</tr>
<tr>
<td>B200*</td>
</tr>
<tr>
<td>B3000 (Analog)*</td>
</tr>
<tr>
<td>B3000 (Digital)*</td>
</tr>
<tr>
<td>Chart</td>
</tr>
<tr>
<td>Communication Handle</td>
</tr>
<tr>
<td>Digital Event/Reaction*</td>
</tr>
<tr>
<td>Digital Input</td>
</tr>
<tr>
<td>Digital Output</td>
</tr>
<tr>
<td>Down Timer Variable</td>
</tr>
<tr>
<td>E1</td>
</tr>
<tr>
<td>E2</td>
</tr>
<tr>
<td>Event/Reaction Group*</td>
</tr>
<tr>
<td>Float Table</td>
</tr>
<tr>
<td>Float Variable</td>
</tr>
<tr>
<td>G4A8R, G4RAX*</td>
</tr>
<tr>
<td>G4D16R*</td>
</tr>
<tr>
<td>G4D32RS*</td>
</tr>
<tr>
<td>G4EB2</td>
</tr>
<tr>
<td>Generic OptoMMP Device</td>
</tr>
<tr>
<td>GRV-EPIC-PR1</td>
</tr>
<tr>
<td>GRV-R7-MM1001-10</td>
</tr>
<tr>
<td>Integer 32 Table</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Integer 64 Table</td>
</tr>
<tr>
<td>Integer 64 Variable</td>
</tr>
<tr>
<td>Mistic PID Loop*</td>
</tr>
<tr>
<td>PID Loop</td>
</tr>
<tr>
<td>Pointer Variable</td>
</tr>
<tr>
<td>SNAP-B3000-ENET, SNAP-ENET-RTC**</td>
</tr>
<tr>
<td>SNAP-BRS*</td>
</tr>
<tr>
<td>SNAP-ENET-D64***</td>
</tr>
<tr>
<td>SNAP-ENET-S64***</td>
</tr>
<tr>
<td>SNAP-PAC-EB1</td>
</tr>
<tr>
<td>SNAP-PAC-EB2</td>
</tr>
<tr>
<td>SNAP-PAC-R1</td>
</tr>
<tr>
<td>SNAP-PAC-R1-B</td>
</tr>
<tr>
<td>SNAP-PAC-R2</td>
</tr>
<tr>
<td>SNAP-PAC-SB1</td>
</tr>
<tr>
<td>SNAP-PAC-SB2</td>
</tr>
<tr>
<td>SNAP-UP1-ADS**</td>
</tr>
<tr>
<td>SNAP-UP1-D64**</td>
</tr>
<tr>
<td>SNAP-UP1-M64**</td>
</tr>
<tr>
<td>String Table</td>
</tr>
<tr>
<td>String Variable</td>
</tr>
<tr>
<td>Up Timer Variable</td>
</tr>
</tbody>
</table>

* Available only in PAC Control Professional when mistic products are enabled (File > Strategy Options > Legacy tab > Mistic I/O units and commands).

** Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).
### Action Block

**Example:**

**OptoScript** doesn’t use a command; the function is built in. Use the `&` operator to get the address of the object and use the `=` operator to make the assignment:

```
IO_POINTER = &PUMP_VALVE;
```

**Notes:**

- In OptoScript code, simply make an assignment to the pointer.
- For standard commands, the Move To Pointer command will be validated when the OK button in the Add Instruction dialog box is pressed. For OptoScript code, the type will be validated by the compiler.

**See Also:**

- “Clear Pointer” on page 549
- “Pointer Equal to Null?” on page 559

---

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object</td>
<td>Digital Output</td>
<td>PUMP_VALVE</td>
</tr>
<tr>
<td>Pointer</td>
<td>Pointer Variable</td>
<td>IO_POINTER</td>
</tr>
</tbody>
</table>
Move to Pointer Table Element

Pointers Action

Function: To assign an object to a pointer table element.

Typical Use: To initialize a pointer table with objects of various types.

Details: This command takes the pointer for the object being pointed to and moves it to the table element.

For Arguments, see next page.
### Arguments:

<table>
<thead>
<tr>
<th>Argument 0: Object</th>
<th>Argument 1: Index</th>
<th>Argument 2: Of Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analog Event/Reaction*</td>
<td>Integer 32 Literal</td>
<td>Pointer Table</td>
</tr>
<tr>
<td>Analog Input</td>
<td>Integer 32 Variable</td>
<td></td>
</tr>
<tr>
<td>Analog Output</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B100*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B200*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B3000 (Analog)*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B3000 (Digital)*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Chart</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Communication Handle</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Digital Event/Reaction*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Digital Input</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Digital Output</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Down Timer Variable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>E1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>E2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Event/Reaction Group*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Float Table</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Float Variable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>G4A8R, G4RAX*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>G4D16R*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>G4D32RS*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>G4EB2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Generic OptoMMP Device</td>
<td></td>
<td></td>
</tr>
<tr>
<td>GRV-EPIC-PR1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>GRV-R7-MM1001-10</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Integer 32 Table</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Integer 64 Table</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Integer 64 Variable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mistic PID Loop*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PID Loop</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pointer Variable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-B3000-ENET, SNAP-ENET-RTC**</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-BRS*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-ENET-D64***</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-ENET-S64***</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1-B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-ADS**</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-D64***</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-M64***</td>
<td></td>
<td></td>
</tr>
<tr>
<td>String Table</td>
<td></td>
<td></td>
</tr>
<tr>
<td>String Variable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Up Timer Variable</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* Available only in PAC Control Professional when *mistic* products are enabled (File > Strategy Options > Legacy tab > Mistic I/O units and commands).

** Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).
**Action Block Example:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object</td>
<td>Integer 32 Variable</td>
<td>Valve_One</td>
</tr>
<tr>
<td>Index</td>
<td>Integer 32 Variable</td>
<td>Current_Index</td>
</tr>
<tr>
<td>Of Table</td>
<td>Pointer Table</td>
<td>Digital_Outputs</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

OptoScript doesn’t use a command; the function is built in. Use the `&` operator to get the address of the object and use the `=` operator to make the assignment:

```
Digital_Outputs[Current_Index] = &Valve_One;
```

**Notes:** In OptoScript code, simply make an assignment to the pointer table.

**See Also:**

*“Move from Pointer Table Element” on page 552*

*“Pointer Table Element Equal to Null?” on page 560*
Pointer Equal to NULL?

Pointers Condition

Function: To determine if a pointer is pointing to an object.

Typical Use: To verify that a pointer is pointing to an object (to prevent an undefined pointer).

Details: Evaluates False if the pointer is pointing to an object, True otherwise.

Arguments: Argument 0
Point - Pointer Variable

Condition Block

Example:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pointer</td>
<td>Pointer</td>
<td>IO_Pointer</td>
</tr>
</tbody>
</table>

OptoScript

Example: OptoScript doesn’t use a command; the function is built in. Use the == and null operators.

if (IO_Pointer == null) then

Notes:

- The example shown is only one way to use these operators. For more information on operators in OptoScript code, see the PAC Control User’s Guide (form 1700).
- If you try to perform an operation on a NULL pointer, an error will be posted in the message queue.

See Also:

“Clear Pointer” on page 549
“Move to Pointer” on page 553
Chapter 18: Pointers Commands

Pointer Table Element Equal to Null?

Pointers Condition

**Function:** To determine if a specific element of a pointer table points to an object.

**Typical Use:** To verify that an element in a pointer table is pointing to an object (to prevent an undefined pointer).

**Details:** Evaluates False if the specified element is pointing to an object, True otherwise.

**Arguments:**
- **Argument 0**
  - Index
  - Integer 32 Literal
  - Integer 32 Variable

- **Argument 1**
  - Of Table
  - Pointer Table

**Condition Block Example:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index</td>
<td>Integer 32 Variable</td>
<td>Current_Index</td>
</tr>
<tr>
<td>Of Table</td>
<td>Pointer Table</td>
<td>IO_Table</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

OptoScript doesn’t use a command; the function is built in. Use the == and null operators.

if (IO_Table[Current_Index] == null) then

**Notes:**
- The example shown is only one way to use these operators. For more information on operators in OptoScript code, see the PAC Control User’s Guide (form 1700).
- If you try to perform an operation on a NULL pointer, an error will be posted in the message queue.

**See Also:**
- “Clear Pointer Table Element” on page 550
- “Move to Pointer Table Element” on page 556
19: Simulation Commands

Communication to All I/O Points Enabled?

Simulation Condition

**Function:** To determine whether communication between the program in the control engine and all analog and digital points is enabled.

**Typical Use:** For simulation and testing. An I/O point might be disabled if you do not want to communicate with it during testing.

**Details:** All analog and digital point communication is enabled by default. It can be turned off for individual points in the configuration dialog box or by using the command Disable Communication to Point. Use this command to find out if communication has been disabled.

**Arguments:** None.

**Condition Block Example:**

```
isCommToAllIoPointsEnabled()
```

**OptoScript Example:**

```
if (isCommToAllIoPointsEnabled()) then
```

This is a function command; it returns a value of true (non-zero) or false (0). The returned value can be consumed by a control structure (as in the example shown) or by a variable, I/O point, and so forth. For more information, see the PAC Control User's Guide (form 1700).

**Notes:**

- This command is much faster than checking points individually.
- Be aware that I/O points may not be reachable even if communication is enabled. For example, the I/O unit may be turned off or unplugged, but its points may still be enabled. To determine whether an I/O unit is reachable, use I/O Unit Ready?

**See Also:**

- “Disable Communication to All I/O Points” on page 563
- “Enable Communication to All I/O Points” on page 569
- “Disable Communication to Point” on page 568
- “I/O Point Communication Enabled?” on page 574
Communication to All I/O Units Enabled?

Simulation Condition

Function: To determine whether communication between the program in the control engine and all I/O units is enabled.

Typical Use: For simulation and testing. An I/O unit might be disabled if you do not want to communicate with it during testing.

Arguments: None.

Condition Block

Example:

OptoScript:  
IsCommToAllIoUnitsEnabled()
if (IsCommToAllIoUnitsEnabled()) then

This is a function command; it returns a value of true (non-zero) or false (0). The returned value can be consumed by a control structure (as in the example shown) or by a variable, I/O point, and so forth. For more information, see the PAC Control User’s Guide (form 1700).

Notes:

- This command is much faster than checking I/O units individually.
- Be aware that the I/O unit may not be reachable even if communication is enabled. For example, the I/O unit may be turned off or unplugged, but its points and the unit itself may still be enabled. To determine whether an I/O unit is reachable, use I/O Unit Ready?

See Also:

“Disable Communication to All I/O Units” on page 564
“Enable Communication to All I/O Units” on page 570
“Disable Communication to I/O Unit” on page 565
“I/O Unit Communication Enabled?” on page 575
Disable Communication to All I/O Points

Simulation Action

**Function:**
To disable communication between the program in the control engine and all analog and digital points.

**Typical Use:**
To disconnect the program from all analog and digital points for simulation and testing.

To force the program in the control engine to read/write internal values (IVALs) rather than reading/writing to I/O units (XVALs). This command can be used for simulation and for faster processing of program logic in speed-sensitive applications.

**Details:**
- All analog and digital point communication is enabled by default.
- This command does not affect the points in any way. It only disconnects the program in the control engine from the points.
- When communication to I/O points is disabled, program actions have no effect.
- When a program reads the value of a disabled point, the last value before the point was disabled (IVAL) will be returned. Likewise, any attempts by the program to change the value of an output point will affect only the IVAL, not the actual output point (XVAL). Disabling a point while a program is running has no effect on the program.

**Arguments:** None.

**Action Block Example:**

<table>
<thead>
<tr>
<th>Disable Communication to All I/O Points</th>
</tr>
</thead>
<tbody>
<tr>
<td>No arguments</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

`DisableCommunicationToAllIoPoints();`

This is a procedure command; it does not return a value.

**See Also:**
“Enable Communication to All I/O Points” on page 569
### Disable Communication to All I/O Units

**Simulation Action**

**Function:** Changes a flag in the control engine to indicate that all the I/O units are offline. This stops communication from the program to the I/O units.

**Typical Use:** To force the program in the control engine to read/write internal values (IVALs) rather than reading/writing to I/O units (XVALs). This command can be used for simulation and for faster processing of program logic in speed-sensitive applications.

**Details:**
- No I/O unit communication errors will be generated by the program while communication to the I/O units is disabled.
- In Debug mode PAC Control can still communicate to the I/O units, since it ignores the disabled flag.

**Arguments:** None.

**Action Block Example:**

```plaintext
Disable Communication to All I/O Units
No arguments
```

**OptoScript Example:**

```plaintext
DisableCommunicationToAllIoUnits() 0
```

This is a procedure command; it does not return a value.

**See Also:** “Enable Communication to All I/O Units” on page 570
Disable Communication to I/O Unit

Simulation Action

**Function:**
To disable communication between the program in the control engine and all points on the I/O unit.

**Typical Uses:**
- To prohibit the program in the control engine from reading or writing to the I/O unit for simulation and program testing.
- To gain fast I/O processing. With communication disabled, all logic is executed using values within the control engine.

**Details:**
- All program references to I/O will be restricted to the use of internal I/O values (IVAL).
- Input IVALs will remain in their current state (unless you change them using Debug mode or special simulation commands).
- Output IVALs will reflect what the program is instructing the outputs to do.

*CAUTION: Any outputs that are on may remain on.*

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>B100*</td>
<td></td>
</tr>
<tr>
<td>B200*</td>
<td></td>
</tr>
<tr>
<td>B3000 (Analog)*</td>
<td></td>
</tr>
<tr>
<td>B3000 (Digital)*</td>
<td></td>
</tr>
<tr>
<td>E1</td>
<td></td>
</tr>
<tr>
<td>E2</td>
<td></td>
</tr>
<tr>
<td>G4A8R, G4RAX**</td>
<td></td>
</tr>
<tr>
<td>G4D16R*</td>
<td></td>
</tr>
<tr>
<td>G4D32RS*</td>
<td></td>
</tr>
<tr>
<td>G4EB2</td>
<td></td>
</tr>
<tr>
<td>Generic OptoMMP Device</td>
<td></td>
</tr>
<tr>
<td>GRV-EPIC-PR1</td>
<td></td>
</tr>
<tr>
<td>GRV-R7-MM1001-10</td>
<td></td>
</tr>
<tr>
<td>SNAP-B3000-ENET, SNAP-ENET-RTC**</td>
<td></td>
</tr>
<tr>
<td>SNAP-BSR*</td>
<td></td>
</tr>
<tr>
<td>SNAP-ENET-D64**</td>
<td></td>
</tr>
<tr>
<td>SNAP-ENET-S64**</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB1</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-EB2</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R1-B</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-R2</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB1</td>
<td></td>
</tr>
<tr>
<td>SNAP-PAC-SB2</td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-ADS**</td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-D64**</td>
<td></td>
</tr>
<tr>
<td>SNAP-UP1-M64**</td>
<td></td>
</tr>
</tbody>
</table>

* Available only in PAC Control Professional when mistic products are enabled (File > Strategy Options > Legacy tab > Mistic I/O units and commands).
** Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).

**Action Block Example:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>(none)</td>
<td>GRV-EPIC-PR1</td>
<td>Vapor_Extraction</td>
</tr>
</tbody>
</table>
**OptoScript Example:**

```
DisableCommunicationToIoUnit(Vapor_Extraction);
```

This is a procedure command; it does not return a value.

**Notes:**

- Communication to I/O units is normally disabled using PAC Control.
- If I/O units are disabled to speed logic execution, use the following commands in the order shown:
  1. **Move I/O Unit to Numeric Table** (with I/O unit still disabled): Copies analog output IVALs updated by program.
  2. **Get I/O Unit as Binary Value** (with I/O unit still disabled): Copies digital output IVALs updated by program.
  3. **Enable Communication to I/O Unit**: Re-establishes communications.
  4. **Move Numeric Table to I/O Unit**: Writes to the table Moved to above. Updates analog outputs.
  5. **Set I/O Unit from MOMO Masks**: writes to the value read above. Updates digital outputs.
  6. **Move I/O Unit to Numeric Table**: Updates analog input IVALs.
  7. **Get I/O Unit as Binary Value 64**: Updates digital input IVALs.
  8. **Disable Communication to I/O Unit**: Disconnects communications.
  9. Program logic . . . (not for use with commands that access MIN, MAX, AVERAGE, COUNTS, and so forth.)

Repeat 1 through 9.

**See Also:** "Enable Communication to I/O Unit" on page 571
Disable Communication to PID Loop

Simulation Action

Function: To disable communication between the program in the control engine and the PID.

Typical Use: To disconnect the program from a specified PID for simulation and program testing.

Details: • All PID communication is enabled by default.
• Because the PID loop runs on the I/O unit, independently of the control engine, this command does not affect the PID in any way. Even on a SNAP PAC R-series controller, the PID runs on the I/O side, not the control side. While communication to the PID is disabled, any PAC Control command that refers to it by name will not affect it, because the command will have access only to the IVAL.
• No changes can be made to the PID by the program in the control engine while the PID is disabled.

Arguments: Argument 0

<table>
<thead>
<tr>
<th>Value</th>
<th>PID Loop</th>
</tr>
</thead>
</table>

Action Block Example:

<table>
<thead>
<tr>
<th>Disable Communication to PID Loop</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argument Name</td>
</tr>
<tr>
<td>(none)</td>
</tr>
</tbody>
</table>

OptoScript Example:

```
DisableCommunicationToPidLoop(HEATER_3);
```

This is a procedure command; it does not return a value.

Notes: To stop updating the PID output, do not use this command. Instead, use Set PID Mode to set the mode to manual.

See Also: “Enable Communication to PID Loop” on page 572
 “Set PID Mode” on page 541
Disable Communication to Point

**Simulation Action**

**Function:** To disable communication between the program in the control engine and an individual analog or digital point.

**Typical Use:** To disconnect the program from a specified analog or digital point for simulation and testing.

**Details:**
- All analog and digital point communication is enabled by default.
- This command does not affect the point in any way. It only disconnects the program in the control engine from the point.
- When communication to a point is disabled, program actions have no effect.
- When a program reads the value of a disabled point, the last value before the point was disabled (IVAL) will be returned. Likewise, any attempts by the program to change the value of an output point will affect only the IVAL, not the actual output point (XVAL). Disabling a point while a program is running has no effect on the program.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argument 0</td>
<td>[Value]</td>
<td>Analog Input</td>
</tr>
<tr>
<td></td>
<td>Analog Output</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Digital Input</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Digital Output</td>
<td></td>
</tr>
</tbody>
</table>

**Action Block Example:**

Disable Communication to Point

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>(none)</td>
<td>Analog Input</td>
<td>TANK_LEVEL</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```
DisableCommunicationToPoint (Argument 0)
DisableCommunicationToPoint (TANK_LEVEL);
```

This is a procedure command; it does not return a value.

**Notes:**
- Use Turn Off instead if the objective is to shut off a digital output.
- Disabling a point is ideal for a startup situation, since the program thinks it is reading an input or updating an output as it normally would.
- Use the IVAL field in Debug mode to change the value of an input.
- Use the XVAL field in Debug mode to change the value of an output.

**See Also:**
- “Enable Communication to Point” on page 573
- “I/O Point Communication Enabled?” on page 574
Enable Communication to All I/O Points

**Simulation Action**

**Function:** To enable communication between the program in the control engine and all analog and digital points.

**Typical Use:** To re-connect the program to all analog and digital points after simulation and testing.

**Details:** All analog and digital point communication is enabled by default.

**Arguments:** None.

**Action Block Example:**

```
Enable Communication to All I/O Points
```

**OptoScript Example:**

```
EnableCommunicationToAllIoPoints()
EnableCommunicationToAllIoPoints();
```

This is a procedure command; it does not return a value.

**See Also:**

“Disable Communication to All I/O Points” on page 563
“IO Point Communication Enabled?” on page 574
Enable Communication to All I/O Units

Simulation Action

Function: Attempts to bring the I/O Units back online.

Typical Use: To cause the program in the control engine to attempt to read/write to I/O units (XVALs) rather than use internal values (IVALs). Very useful to re-establish communication with all I/O units that have just been turned on without having to specify their name.

Details: Sends a test message (Powerup Clear command) to the brains. If the test message is successful it will enable communication and configure the I/O if necessary.

Arguments: None.

Action Block Example:

OptoScript Example:

EnableCommunicationToAllIoUnits();

This is a procedure command; it does not return a value.

Notes:

- Can be used in a chart that executes periodically to automatically bring I/O units that have just been turned on back online.
- Use of this command periodically within a program will prevent the disabling of communication to any point or any I/O unit by any means.

See Also: “Disable Communication to All I/O Units” on page 564
**Enable Communication to I/O Unit**

**Simulation Action**

**Function:** Attempts to bring the I/O Unit back online.

**Typical Use:** To re-establish communication between the control engine and the I/O unit after it was automatically or manually disabled.

**Details:** Sends a test message (Powerup Clear command) to the brain. If the test message is successful, it will enable communication and configure the I/O if necessary.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0 (Value)</th>
<th>Argument 0 (continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>B100*</td>
<td>SNAP-B3000-ENET, SNAP-ENET-RTC**</td>
</tr>
<tr>
<td>B200*</td>
<td>SNAP-BR5*</td>
</tr>
<tr>
<td>B3000 (Analog)*</td>
<td>SNAP-ENET-D64**</td>
</tr>
<tr>
<td>B3000 (Digital)*</td>
<td>SNAP-ENET-S64**</td>
</tr>
<tr>
<td>E1</td>
<td>SNAP-PAC-EB1</td>
</tr>
<tr>
<td>E2</td>
<td>SNAP-PAC-EB2</td>
</tr>
<tr>
<td>G4A8R, G4RAX*</td>
<td>SNAP-PAC-R1-B</td>
</tr>
<tr>
<td>G4D16R*</td>
<td>SNAP-PAC-R2</td>
</tr>
<tr>
<td>G4D32RS*</td>
<td>SNAP-PAC-SB1</td>
</tr>
<tr>
<td>G4EB2</td>
<td>SNAP-PAC-SB2</td>
</tr>
<tr>
<td>Generic OptoMMP Device</td>
<td>SNAP-UP1-ADS**</td>
</tr>
<tr>
<td>GRV-EPIC-PR1</td>
<td>SNAP-UP1-D64**</td>
</tr>
<tr>
<td>GRV-R7-MM1001-10</td>
<td>SNAP-UP1-M64**</td>
</tr>
</tbody>
</table>

* Available only in PAC Control Professional when mistic products are enabled (File > Strategy Options > Legacy tab > Mistic I/O units and commands).

** Notes:**

This command is sometimes useful for debugging and/or system startup.

**Queue Errors:**

-37 = Timeout on lock.

-58 = No data received.

**See Also:** "Disable Communication to I/O Unit" on page 565
Enable Communication to PID Loop

Simulation Action

NOTE: This command is used for PID loops in PAC Control; it is not for use with the SNAP-PID-V module.

Function: To enable communication between the program in the control engine and the PID.

Typical Use: To reconnect the program to a specified PID after simulation or program testing.

Details:
- All PID communication is enabled by default.
- Because the PID loop runs on the I/O unit, independently of the control engine, this command does not affect the PID in any way. Even on a SNAP PAC R-series controller, the PID runs on the I/O side, not the control side. While communication to the PID is enabled, any PAC Control command that refers to it by name will have full access.

Arguments:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Value</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argument 0</td>
<td>(none)</td>
<td>PID Loop</td>
<td>HEATER_3</td>
</tr>
</tbody>
</table>

Action Block Example:

```
EnableCommunicationToPidLoop(Argument 0)
```

OptoScript Example:

```
EnableCommunicationToPidLoop(HEATER_3);
```

This is a procedure command; it does not return a value.
Enable Communication to Point
Simulation Action

**Function:** To enable communication between the program in the control engine and an individual analog or digital point.

**Typical Use:** To reconnect the program to a specified analog or digital point after simulation or testing.

**Details:**
- All analog and digital point communication is enabled by default.
- This command does not affect the point in any way. It only connects the program in the control engine with the point.
- When communication to a point is enabled, program actions again take effect.
- When a program reads the value of an enabled input point, the current value of the point (XVAL) will be returned to the program (IVAL). Likewise, an enabled output point will be updated when the program writes a value. The XVAL and IVAL will match at this time.

**Arguments:**
- **Argument 0**
  - [Value]
  - Analog Input
  - Analog Output
  - Digital Input
  - Digital Output

**Action Block Example:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>(none)</td>
<td>Analog Input</td>
<td>TANK_LEVEL</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```optoscript
EnableCommunicationToPoint(Argument 0)
```

This is a procedure command; it does not return a value.

**Notes:**
- Use Turn On instead to turn on digital output.
- Use this command to enable an analog or digital point previously disabled by the Disable Communication to Point command.

**See Also:**
- “Disable Communication to Point” on page 568
- “I/O Point Communication Enabled?” on page 574
I/O Point Communication Enabled?

Simulation Condition

**Function:** Checks a flag internal to the control engine to determine if communication to the specified I/O point is enabled.

**Typical Use:** Primarily used in factory QA testing and simulation.

**Details:** If communication is enabled, the logic will take the True path. If communication is not enabled, the logic will take the False path.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Point</td>
</tr>
<tr>
<td>Analog Input</td>
</tr>
<tr>
<td>Analog Output</td>
</tr>
<tr>
<td>Digital Input</td>
</tr>
<tr>
<td>Digital Output</td>
</tr>
</tbody>
</table>

**Condition Block Example:**

<p>| I/O Point Communication Enabled? |
|-------------------|-----------------|-------------------|</p>
<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Point</td>
<td>Analog Input</td>
<td>PUMP_3_STATUS</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```optoscript
IsIoPointCommEnabled(I/O Point)
if (IsIoPointCommEnabled(PUMP_3_STATUS)) then
```

This is a function command; it returns a value of true (non-zero) or false (0). The returned value can be consumed by a control structure (as in the example shown) or by a variable, I/O point, and so forth. For more information, see the *PAC Control User’s Guide* (form 1700).

**See Also:**

"Enable Communication to Point" on page 573
"Disable Communication to Point" on page 568
"I/O Unit Communication Enabled?" on page 575
I/O Unit Communication Enabled?

Simulation Condition

Function: Checks a flag internal to the control engine to determine if communication to the specified I/O unit is enabled.

Typical Use: Primarily used in factory QA testing and simulation, and in error handling charts.

Details: If communication is enabled, the logic will take the True path. If communication is not enabled, the logic will take the False path.

Arguments:

<p>| Argument 0 |</p>
<table>
<thead>
<tr>
<th>I/O Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>B100*</td>
</tr>
<tr>
<td>B200*</td>
</tr>
<tr>
<td>B3000 (Analog)*</td>
</tr>
<tr>
<td>B3000 (Digital)*</td>
</tr>
<tr>
<td>E1</td>
</tr>
<tr>
<td>E2</td>
</tr>
<tr>
<td>G4A8R, G4RAX*</td>
</tr>
<tr>
<td>G4D16R*</td>
</tr>
<tr>
<td>G4D32RS*</td>
</tr>
<tr>
<td>G4EB2</td>
</tr>
<tr>
<td>Generic OptoMMP Device</td>
</tr>
<tr>
<td>GRV-EPIC-PR1</td>
</tr>
<tr>
<td>GRV-R7-MM1001-10</td>
</tr>
<tr>
<td>SNAP-B3000-ENET, SNAP-ENET-RTC**</td>
</tr>
<tr>
<td>SNAP-BRS*</td>
</tr>
<tr>
<td>SNAP-ENET-D64**</td>
</tr>
<tr>
<td>SNAP-ENET-S64**</td>
</tr>
<tr>
<td>SNAP-PAC-EB1</td>
</tr>
<tr>
<td>SNAP-PAC-EB2</td>
</tr>
<tr>
<td>SNAP-PAC-R1</td>
</tr>
<tr>
<td>SNAP-PAC-R1-B</td>
</tr>
<tr>
<td>SNAP-PAC-R2</td>
</tr>
<tr>
<td>SNAP-PAC-S81</td>
</tr>
<tr>
<td>SNAP-PAC-SB2</td>
</tr>
<tr>
<td>SNAP-UP1-M6S*</td>
</tr>
<tr>
<td>SNAP-UP1-D64**</td>
</tr>
<tr>
<td>SNAP-UP1-M64***</td>
</tr>
</tbody>
</table>

* Available only in PAC Control Professional when mistic products are enabled (File > Strategy Options > Legacy tab > Mistic I/O units and commands).
** Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).

Condition Block Example:

<table>
<thead>
<tr>
<th>I/O Unit Communication Enabled?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argument Name</td>
</tr>
<tr>
<td>----------------</td>
</tr>
<tr>
<td>I/O Unit</td>
</tr>
</tbody>
</table>

OptoScript Example:

```optoscript
IsIoUnitCommEnabled(I/O Unit)
if (IsIoUnitCommEnabled(PUMP_HOUSE)) then
```

This is a function command; it returns a value of true (non-zero) or false (0). The returned value can be consumed by a control structure (as in the example shown) or by a variable, I/O point, and so forth. For more information, see the PAC Control User’s Guide (form 1700).
See Also:  “Enable Communication to I/O Unit” on page 571
         “Disable Communication to I/O Unit” on page 565
         “I/O Point Communication Enabled?” on page 574
         “I/O Unit Ready?” on page 273
IVAL Set Analog Filtered Value

Simulation Action

**NOTE:** This command is for mistic I/O units only.

**Function:**
Used with a mistic I/O unit, this command writes to the internal value (IVAL) of a filtered analog input. Filtering is activated by the command, Set Analog Filter Weight.

**Typical Use:**
Simulation, testing, and certification where communication to the I/O point or I/O unit is disabled.

**Details:**
- The strategy will use IVALS exclusively when communication to the specified point or I/O unit is disabled. This command allows the IVAL to be modified as if it were being changed by a real field signal.
- When analog input filtering is implemented with mistic brains, the analog input value is not affected. This command allows the filtered analog input value to be read.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>To</strong></td>
<td><strong>On Point</strong></td>
</tr>
<tr>
<td>Float Literal</td>
<td>Analog Input</td>
</tr>
<tr>
<td>Float Variable</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td></td>
</tr>
</tbody>
</table>

**Action Block Example:**

```
IVAL Set Analog Filter Value

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>To</td>
<td>Float Literal</td>
<td>5.63</td>
</tr>
<tr>
<td>On Point</td>
<td>Analog Input</td>
<td>PROCESS_PH</td>
</tr>
</tbody>
</table>
```

**OptoScript Example:**

```
IvalSetAnalogFilteredValue(To, On Point)
IvalSetAnalogFilteredValue(5.63, PROCESS_PH);
```

This is a procedure command; it does not return a value.

**Notes:**
- For an explanation of the use of IVALS (internal values) and XVALS (external values), see the PAC Control User's Guide (form 1700).
- This command does not set the IVAL of the filter weight.

**See Also:**
- “Disable Communication to Point” on page 568
- “Set Analog Filter Weight” on page 42
- “Disable Communication to I/O Unit” on page 565
- “Disable Communication to All I/O Units” on page 564
IVAL Set Analog Maximum Value

Simulation Action

Function: Writes to the internal value (IVAL) of the maximum value register of an analog input.

Typical Use: Simulation, testing, and certification where communication to the I/O point or I/O unit is disabled.

Details: The strategy will use IVALS exclusively when communication to the specified point or I/O unit is disabled. This command allows the IVAL to be modified as if it were being changed by a real field signal.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>To</td>
<td>On Point</td>
</tr>
<tr>
<td>Float Literal</td>
<td>Analog Input</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>PROCESS_PH</td>
</tr>
</tbody>
</table>

Action Block Example:

```
IVAL Set Analog Max Value

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>To</td>
<td>Float Literal</td>
<td>5.63</td>
</tr>
<tr>
<td>On Point</td>
<td>Analog Input</td>
<td>PROCESS_PH</td>
</tr>
</tbody>
</table>
```

OptoScript Example:

```
IVAL Set Analog Max Value (To, On Point);
IVAL Set Analog Max Value (5.63, PROCESS_PH);
```

Notes: This is a procedure command; it does not return a value.

For an explanation of the use of IVALS (internal values) and XVALs (external values), see the PAC Control User’s Guide (form 1700).

“Disable Communication to All I/O Units” on page 564
“Disable Communication to I/O Unit” on page 565
“Disable Communication to Point” on page 568
IVAL Set Analog Minimum Value

Simulation Action

**Function:** Writes to the internal value (IVAL) of the minimum value register of an analog input.

**Typical Use:** Simulation, testing, and certification where communication to the I/O point or I/O unit is disabled.

**Details:** The strategy will use IVALs exclusively when communication to the specified point or I/O unit is disabled. This command allows the IVAL to be modified as if it were being changed by a real field signal.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>To</td>
<td>Float Literal</td>
<td>5.63</td>
</tr>
<tr>
<td>On Point</td>
<td>Analog Input</td>
<td>PROCESS_PH</td>
</tr>
</tbody>
</table>

**Action Block Example:**

```plaintext
IVAL Set Analog Min Value
```

**OptoScript Example:**

```plaintext
IVALSetAnalogMinValue(To, On Point)
IVALSetAnalogMinValue(5.63, PROCESS_PH);
```

This is a procedure command; it does not return a value.

**Notes:** For an explanation of the use of IVALs (internal values) and XVALs (external values), see the PAC Control User's Guide (form 1700).

**See Also:**
- “Disable Communication to All I/O Points” on page 563
- “Disable Communication to All I/O Units” on page 564
- “Disable Communication to I/O Unit” on page 565
IVAL Set Analog Point

Simulation Action

Function: Writes to the internal value (IVAL) of an analog input or output.

Typical Use: Simulation, testing, and certification where communication to the I/O units is disabled.

Details: The program will use IVAls exclusively when communication to the specified point or I/O unit is disabled. This command allows the IVAL to be modified as if it were being changed by real I/O.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>To</strong></td>
<td><strong>On Point</strong></td>
</tr>
<tr>
<td>Float Literal</td>
<td>Analog Input</td>
</tr>
<tr>
<td>Float Variable</td>
<td>Analog Output</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td></td>
</tr>
</tbody>
</table>

Action Block Example:

```
IVAL Set Analog Point
```

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>To</td>
<td>Float Literal</td>
<td>5.63</td>
</tr>
<tr>
<td>On Point</td>
<td>Analog Input</td>
<td>PROCESS_PH</td>
</tr>
</tbody>
</table>

OptoScript Example:

```
IvalSetAnalogPoint (To, On Point)
IvalSetAnalogPoint (5.63, PROCESS_PH);
```

This is a procedure command; it does not return a value.

Notes: Primarily used to write to inputs. May be used to test when an output is updated by a change of value.

See Also: *Disable Communication to All I/O Units* on page 564
          *Disable Communication to I/O Unit* on page 565
IVAL Set Counter

Simulation Action

Function: Writes to the internal value (IVAL) of a counter or quadrature counter digital input.

Typical Use: Simulation, testing, and certification where either there are no I/O units or communication to the I/O units is disabled.

Details:
- The program will use IVALs exclusively when communication to the specified point or I/O unit is disabled. This command allows the IVAL to be modified as if it were being changed by real I/O.
- Valid range for a counter is 0 to 4,294,967,295 counts.
- Valid range for a quadrature counter is -2,147,483,647 to 2,147,483,648 counts.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>To</td>
<td>On Point</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Counter</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Quadrature Counter</td>
</tr>
<tr>
<td>Integer 64 Literal</td>
<td></td>
</tr>
<tr>
<td>Integer 64 Variable</td>
<td></td>
</tr>
</tbody>
</table>

Action Block Example:

```
IVAL Set Counter
```

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>To</td>
<td>Integer 32 Literal</td>
<td>2484</td>
</tr>
<tr>
<td>On Point</td>
<td>Counter</td>
<td>PROCESS_FLOW_TOTAL</td>
</tr>
</tbody>
</table>

OptoScript Example:

```
IvalSetCounter(To, On Point)
```

```
IvalSetCounter(2484, PROCESS_FLOW_TOTAL);
```

This is a procedure command; it does not return a value.

See Also:
- “Disable Communication to All I/O Units” on page 564
- “Disable Communication to I/O Unit” on page 565
IVAL Set Frequency

Simulation Action

Function: Writes to the internal value (IVAL) of a digital frequency input.

Typical Use: Simulation, testing, and certification where either there are no I/O units or communication to the I/O units is disabled.

Details: The program will use IVALS exclusively when communication to the specified point or I/O unit is disabled. This command allows the IVAL to be modified as if it were being changed by real I/O.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>To</td>
<td>On Point</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Frequency</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td></td>
</tr>
</tbody>
</table>

Action Block Example:

<table>
<thead>
<tr>
<th>IVAL Set Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argument Name</td>
</tr>
<tr>
<td>To</td>
</tr>
<tr>
<td>On Point</td>
</tr>
</tbody>
</table>

OptoScript Example:

ivalSetFrequency(To, On Point)

IvalSetFrequency(400, Process_Flow_Rate);

This is a procedure command; it does not return a value.

Dependencies: Available on GRV-EPIC processors, SNAP-PAC-R1 and -R1-B controllers, and on SNAP-PAC-EB1 and SNAP-PAC-SB1 brains with firmware 8.1 or later.

See Also:

“Disable Communication to All I/O Units” on page 564
“Disable Communication to I/O Unit” on page 565
IVAL Set I/O Unit from MOMO Masks

Simulation Action

Function: Writes to the internal value (IVAL) of multiple 4-channel digital input and output points for the specified I/O unit, simultaneously with a single command.

Typical Use: Simulation, testing, and certification of a selected group of 4-channel digital inputs and outputs where either there are no I/O units or communication to the I/O units is disabled.

Details:
- The program will use IVALs exclusively when communication to the specified I/O unit is disabled. This command allows the IVAL to be modified as if it were being changed by real I/O.
- This command updates the IVALs for all selected input and output points.
- To turn a point on, set the respective bit in On Mask (Argument 0)—which is the on bitmask—to a value of 1, and set the same bit of Off Mask (Argument 1) to a value of 0.
- To turn a point off, set the respective bit in Off Mask (Argument 1)—which is the off bitmask—to a value of 1, and set the same bit of On Mask to a value of 0.
- To leave a point unaffected, set its bits to a value of 0 in both On Mask and Off Mask.
- The least significant bit corresponds to point zero.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>On Mask</strong></td>
<td><strong>Off Mask</strong></td>
<td><strong>On I/O Unit</strong></td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
<td>B100*</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
<td>B3000 (Digital)*</td>
</tr>
<tr>
<td>Integer 64 Literal</td>
<td>Integer 64 Literal</td>
<td>E1</td>
</tr>
<tr>
<td>Integer 64 Variable</td>
<td>Integer 64 Variable</td>
<td>G4A8R, G4RAX*</td>
</tr>
<tr>
<td></td>
<td></td>
<td>G4D16R*</td>
</tr>
<tr>
<td></td>
<td></td>
<td>G4D32RS*</td>
</tr>
<tr>
<td></td>
<td></td>
<td>G4EB2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>GRV-EPIC-PR1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>GRV-R7-MM1001-10</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-B3000-ENET, SNAP-ENET-RTC**</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-BRS*</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-ENET-D64**</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-ENET-S64**</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-PAC-EB1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-PAC-EB2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-PAC-R1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-PAC-R1-B</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-PAC-R2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-PAC-SB1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-PAC-SB2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-UP1-ADS**</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-UP1-D64**</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-UP1-M64**</td>
</tr>
</tbody>
</table>

* Available only in PAC Control Professional when mystic products are enabled (File > Strategy Options > Legacy tab > Mistic I/O units and commands).

** Available only when Legacy products are enabled (File > Strategy Options > Legacy tab > Ethernet, Ultimate, and Simple I/O units).
The effect of this command is illustrated below:

<table>
<thead>
<tr>
<th>Point Number</th>
<th>63</th>
<th>62</th>
<th>61</th>
<th>60</th>
<th>59</th>
<th>58</th>
<th>57</th>
<th>56</th>
<th>&gt;</th>
<th>&gt;</th>
<th>7</th>
<th>6</th>
<th>5</th>
<th>4</th>
<th>3</th>
<th>2</th>
<th>1</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Must-on Bitmask</td>
<td>Binary</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>&gt;&gt;</td>
<td>&gt;&gt;</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>Hex</td>
<td>0</td>
<td></td>
<td></td>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td>&gt;&gt;</td>
<td>&gt;&gt;</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>C</td>
<td></td>
</tr>
<tr>
<td>Must-off Bitmask</td>
<td>Binary</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>&gt;&gt;</td>
<td>&gt;&gt;</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>Hex</td>
<td>B</td>
<td></td>
<td></td>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td>&gt;&gt;</td>
<td>&gt;&gt;</td>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0</td>
</tr>
</tbody>
</table>

To save space, the example shows only the first eight points and the last eight points on the rack. For the points shown, points 58, 57, 6, and 1 will be turned on. Points 63, 61, 60, and 5 will be turned off. Other points shown are not changed.

**OptoScript Example:**

```opcodes
IVALSetIoUnitfromMOMO(On Mask, Off Mask, On I/O Unit)
IVALSetIoUnitfromMOMO(0x060003C0000000C2i64, 0xB0F240010308A020i64, PUMP_CTRL_UNIT);
```

This is a procedure command; it does not return a value.

**See Also:**

- “Disable Communication to All I/O Units” on page 564
- “Disable Communication to I/O Unit” on page 565
IVAL Set Off-Latch

Simulation Action

Function: Writes to the internal value (IVAL) of a digital latch input.

Typical Use: Simulation, testing, and certification where either there are no I/O units or communication to the I/O units is disabled.

Details:
- The program will use IVALS exclusively when communication to the specified point or I/O unit is disabled. This command allows the IVAL to be modified as if it were being changed by real I/O.
- Any non-zero value sets the latch; zero clears the latch.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>To</strong></td>
<td><strong>On Point</strong></td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Digital Input</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Process_Stop/Button</td>
</tr>
</tbody>
</table>

Action Block Example:

```
IVAL Set Off-Latch
```

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>To</td>
<td>Integer 32 Literal</td>
<td>-1</td>
</tr>
<tr>
<td>On Point</td>
<td>Digital Input</td>
<td>Process_Stop/Button</td>
</tr>
</tbody>
</table>

OptoScript Example:

```
IvalSetOffLatch (To, On Point)
```

IvalSetOffLatch(-1, Process_Stop_Button);

This is a procedure command; it does not return a value.

See Also:

* “Disable Communication to All I/O Units” on page 564
* “Disable Communication to I/O Unit” on page 565
IVAL Set Off-Pulse

Simulation Action

Function: Writes to the internal value (IVAL) of a digital pulse input.

Typical Use: Simulation, testing, and certification where either there are no I/O units or communication to the I/O units is disabled.

Details: • The program will use IVALs exclusively when communication to the specified point or I/O unit is disabled. This command allows the IVAL to be modified as if it were being changed by real I/O.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>To</td>
<td>On Point</td>
</tr>
<tr>
<td>Float Literal</td>
<td>Off Pulse</td>
</tr>
<tr>
<td>Float Variable</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td></td>
</tr>
</tbody>
</table>

Action Block Example:

IVAL Set Off-Pulse

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>To</td>
<td>Integer 32 Literal</td>
<td>150000</td>
</tr>
<tr>
<td>On Point</td>
<td>Off Pulse</td>
<td>TIME_PULSE_INPUT</td>
</tr>
</tbody>
</table>

OptoScript Example:

IVALSetOffPulse(To, On Point)

IVALSetOffPulse(150000, TIME_PULSE_INPUT);

This is a procedure command; it does not return a value.

Notes: Valid range is 0–2 billion in units of 100 microseconds.

See Also: “Disable Communication to All I/O Units” on page 564
“Disable Communication to I/O Unit” on page 565
IVAL Set Off-Totalizer

Simulation Action

**Function:** Writes to the internal value (IVAL) of a digital totalizer input.

**Typical Use:** Simulation, testing, and certification where either there are no I/O units or communication to the I/O units is disabled.

**Details:** The program will use IVAls exclusively when communication to the specified point or I/O unit is disabled. This command allows the IVAL to be modified as if it were being changed by real I/O.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>To</strong></td>
<td><strong>On Point</strong></td>
</tr>
<tr>
<td>Float Literal</td>
<td>Off Totalizer</td>
</tr>
<tr>
<td>Float Variable</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td></td>
</tr>
</tbody>
</table>

**Action Block Example:**

```
IVAL Set Off-Totalizer
```

```
<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>To</td>
<td>Integer 32 Literal</td>
<td>36000000</td>
</tr>
<tr>
<td>On Point</td>
<td>Totalizer Off</td>
<td>PUMP_OFF_TIME</td>
</tr>
</tbody>
</table>
```

**OptoScript Example:**

```
IvalSetOffTotalizer(To, On Point)
IvalSetOffTotalizer(36000000, PUMP_OFF_TIME);
```

This is a procedure command; it does not return a value.

**Dependencies:** Available on SNAP PAC R-series controllers, and on SNAP PAC EB- and SB-series brains with firmware 8.2 or later.

**See Also:**

- “Get Off-Time Totalizer” on page 174
- “Disable Communication to All I/O Units” on page 564
- “Disable Communication to I/O Unit” on page 565
IVAL Set On-Latch

Simulation Action

Function:  Writes to the internal value (IVAL) of a digital latch input.

Typical Use:  Simulation, testing, and certification where either there are no I/O units or communication to the I/O units is disabled.

Details:
- The program will use IVAls exclusively when communication to the specified point or I/O unit is disabled. This command allows the IVAL to be modified as if it were being changed by real I/O.
- Any non-zero value sets the latch; zero clears the latch.

Arguments:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>To</td>
<td>Integer 32 Literal</td>
<td>0</td>
</tr>
<tr>
<td>On Point</td>
<td>Digital Input</td>
<td>Process_Start_Button</td>
</tr>
</tbody>
</table>

Action Block Example:

```
IVAL Set On-Latch
```

OptoScript Example:

```
IvalSetOnLatch(To, On Point)
IvalSetOnLatch(0, Process_Start_Button);
```

This is a procedure command; it does not return a value.

See Also:
- "Disable Communication to All I/O Units" on page 564
- "Disable Communication to I/O Unit" on page 565
IVAL Set On-Pulse

Simulation Action

**Function:** Writes to the internal value (IVAL) of a digital pulse input.

**Typical Use:** Simulation, testing, and certification where either there are no I/O units or communication to the I/O units is disabled.

**Details:** The program will use IVALs exclusively when communication to the specified point or I/O unit is disabled. This command allows the IVAL to be modified as if it were being changed by real I/O.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>To</strong></td>
<td><strong>On Point</strong></td>
</tr>
<tr>
<td>Float Literal</td>
<td>On Pulse</td>
</tr>
<tr>
<td>Float Variable</td>
<td>On Pulse</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>On Pulse</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>On Pulse</td>
</tr>
</tbody>
</table>

**Action Block Example:**

```
IVAL Set On-Pulse

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>To</td>
<td>Integer 32 Literal</td>
<td>133300</td>
</tr>
<tr>
<td>On Point</td>
<td>On Pulse</td>
<td>TIME_PULSE_INPUT</td>
</tr>
</tbody>
</table>
```

**OptoScript Example:**

```
IvalSetOnPulse(To, On Point)
IvalSetOnPulse(133300, TIME_PULSE_INPUT);
```

This is a procedure command; it does not return a value.

**Notes:** Valid range is 0–2 billion in units of 100 microseconds.

**See Also:**

- “Disable Communication to All I/O Units” on page 564
- “Disable Communication to I/O Unit” on page 565
IVAL Set On-Totalizer

**Simulation Action**

**Function:** Writes to the internal value (IVAL) of a digital totalizer input.

**Typical Use:** Simulation, testing, and certification where either there are no I/O units or communication to the I/O units is disabled.

**Details:** The program will use IVALs exclusively when communication to the specified point or I/O unit is disabled. This command allows the IVAL to be modified as if it were being changed by real I/O.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>To</strong></td>
<td><strong>On Point</strong></td>
</tr>
<tr>
<td>Float Literal</td>
<td>On Totalizer</td>
</tr>
<tr>
<td>Float Variable</td>
<td>On Totalizer</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>On Totalizer</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>On Totalizer</td>
</tr>
</tbody>
</table>

**Action Block Example:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>To</strong></td>
<td>Integer 32 Literal</td>
<td>72000000</td>
</tr>
<tr>
<td><strong>On Point</strong></td>
<td>On Totalizer</td>
<td>PUMP_ON_TIME</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

IvalSetOnTotalizer(72000000, PUMP_ON_TIME);

This is a procedure command; it does not return a value.

**Dependencies:** Available on SNAP PAC R-series controllers, and on SNAP PAC EB- and SB-series brains with firmware 8.2 or later.

**See Also:**

*“Get On-Time Totalizer” on page 178*
*“Disable Communication to All I/O Units” on page 564*
*“Disable Communication to I/O Unit” on page 565*
IVAL Set Period

Function: Writes to the internal value (IVAL) of a digital input configured to measure a time period.

Typical Use: Simulation, testing, and certification where either there are no I/O units or communication to the I/O units is disabled.

Details: The program will use IVALs exclusively when communication to the specified point or I/O unit is disabled. This command allows the IVAL to be modified as if it were being changed by real I/O.

Arguments: Table:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>To</td>
<td>On Point</td>
</tr>
<tr>
<td>Float Literal</td>
<td>Period</td>
</tr>
<tr>
<td>Float Variable</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td></td>
</tr>
</tbody>
</table>

Action Block Example:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>To</td>
<td>Float Literal</td>
<td>5.63</td>
</tr>
<tr>
<td>On Point</td>
<td>Period</td>
<td>Pump_On_Time</td>
</tr>
</tbody>
</table>

OptoScript Example:

IvalSetPeriod(To, On Point)

IvalSetPeriod(5.63, Pump_On_Time);

This is a procedure command; it does not return a value.

Notes: Value to write is in seconds.

Dependencies: Available on GRV-EPIC processors, SNAP-PAC-R1 and -R1-B controllers, and on SNAP-PAC-EB1 and SNAP-PAC-SB1 brains with firmware 8.1 or later.

See Also:

*Get Period* on page 179
*“Disable Communication to All I/O Units” on page 564
*“Disable Communication to I/O Unit” on page 565
IVAL Set TPO Percent

Simulation Action

Function: Writes to the internal value (IVAL) of a digital TPO output.

Typical Use: Simulation, testing, and certification where either there are no I/O units or communication to the I/O units is disabled.

Details: The program will use IVALS exclusively when communication to the specified point or I/O unit is disabled. This command allows the IVAL to be modified as if it were being changed by real I/O.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>To</td>
<td>On Point</td>
</tr>
<tr>
<td>Float Literal</td>
<td>TPO</td>
</tr>
<tr>
<td>Float Variable</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td></td>
</tr>
</tbody>
</table>

Action Block Example:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>To</td>
<td>Float Literal</td>
<td>43.66</td>
</tr>
<tr>
<td>On Point</td>
<td>TPO</td>
<td>ZONE_3_HEATER</td>
</tr>
</tbody>
</table>

OptoScript Example: `IvalSetTpoPercent(To, On Point)`

IvalSetTpoPercent(43.66, ZONE_3_HEATER);

This is a procedure command; it does not return a value.

Notes: Valid range is 0.0 to 100.0.

See Also: *Disable Communication to All I/O Units* on page 564  
*Disable Communication to I/O Unit* on page 565
IVAL Set TPO Period

Simulation Action

Function: Writes to the internal value (IVAL) of a digital TPO period.

Typical Use: Simulation, testing, and certification where either there are no I/O units or communication to the I/O units is disabled.

Details: The program will use IVALs exclusively when communication to the specified point or I/O unit is disabled. This command allows the IVAL to be modified as if it were being changed by real I/O.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>To</td>
<td>On Point</td>
</tr>
<tr>
<td>Float Literal</td>
<td>TPO</td>
</tr>
<tr>
<td>Float Variable</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td></td>
</tr>
</tbody>
</table>

Action Block Example:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>To</td>
<td>Float Literal</td>
<td>1.00</td>
</tr>
<tr>
<td>On Point</td>
<td>TPO</td>
<td>ZONE_3_HEATER</td>
</tr>
</tbody>
</table>

OptoScript Example:

IvalSetTpoPeriod(To, On Point)

IvalSetTpoPeriod(1.00, ZONE_3_HEATER);

This is a procedure command; it does not return a value.

Notes: Valid range is 0.1 to 429,496.7 seconds with resolution to 100 microseconds.

See Also:

“Disable Communication to All I/O Units” on page 564
“Disable Communication to I/O Unit” on page 565
IVAL Turn Off
Simulation Action

**Function:** Writes to the internal value (IVAL) of a digital point.

**Typical Use:** Simulation, testing, and certification where either there are no I/O units or communication to the I/O units is disabled.

**Details:** The program will use IVALS exclusively when communication to the specified point or I/O unit is disabled. This command allows the IVAL to be modified as if it were being changed by real I/O.

**Arguments:**

- **Argument 0**
  - [Value]
  - Digital Input
  - Digital Output

**Action Block Example:**

```
IVAL Turn Off
```

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>(none)</td>
<td>Digital Input</td>
<td>Process_Start_Button</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```
IVALTurnOff (Argument 0)
IVALTurnOff(Process_Start_Button);
```

This is a procedure command; it does not return a value.

**Notes:**

Turns Off the IVAL for the specified point.

**See Also:**

- "Disable Communication to All I/O Units" on page 564
- "Disable Communication to I/O Unit" on page 565
IVAL Turn On

Simulation Action

Function: Writes to the internal value (IVAL) of a digital point.

Typical Use: Simulation, testing, and certification where either there are no I/O units or communication to the I/O units is disabled.

Details: The program will use IVALs exclusively when communication to the specified point or I/O unit is disabled. This command allows the IVAL to be modified as if it were being changed by real I/O.

Arguments: Argument 0
[Value]
Digital Input
Digital Output

Action Block Example:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>(none)</td>
<td>Digital Input</td>
<td>PROCESS_START_BUTTON</td>
</tr>
</tbody>
</table>

OptoScript Example:

IvalTurnOn (Argument 0)
IvalTurnOn (PROCESS_START_BUTTON);

This is a procedure command; it does not return a value.

Notes: Turns On the IVAL for the specified point.
CHAPTER 19: SIMULATION COMMANDS

PID Loop Communication Enabled?

Simulation Condition

NOTE: This command is used for PID loops in PAC Control; it is not for use with the SNAP-PID-V module.

Function: Checks a flag in the control engine to determine whether communication to the specified PID loop is enabled.

Typical Use: Primarily used in factory QA testing and simulation.

Details:
- If communication is enabled, the logic will take the True path.
- If communication is not enabled, the logic will take the False path.
- Because the PID runs on the I/O unit, not in the control engine, any PAC Control command referring to a PID loop by name will not affect the PID while communication to it is disabled. Even on a SNAP PAC R-series controller, the PID loop runs on the I/O side, not the control side.
- No changes can be made to the PID by the program in the control engine while the PID is disabled.

Arguments:

<table>
<thead>
<tr>
<th>Argument Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>PID Loop</td>
</tr>
</tbody>
</table>

Example:

**OptoScript Example:**

```optoscript
IsPidLoopCommEnabled(PID Loop)

if (IsPidLoopCommEnabled(FACTORY_HEAT_2BA)) then
```

This is a function command; it returns a value of true (non-zero) or false (0). The returned value can be consumed by a control structure (as in the example shown) or by a variable, I/O point, and so forth. For more information, see the PAC Control User’s Guide (form 1700).

See Also:

“Enable Communication to PID Loop” on page 572

“i/O Point Communication Enabled?” on page 574
20: String Commands

Append Character to String

String Action

**Function:**
To add a character to the end of a string variable.

**Typical Use:**
To build strings consisting of non-printable or binary characters.

**Details:**
- The character is represented by an ASCII value. (See the ASCII table in the *PAC Control User's Guide*, form 1700.) For example, a space is a character 32, a “1” is a character 49, and an exclamation point (!) is a character 33.
- Appending a value of zero is legal and will append a null byte.
- If the appended value is greater than 255 (hex FF) or less than 0, the value will be truncated to eight bits; for example, –2 becomes hex FE and 257 (hex 101) becomes 1.
- Floats (if used) are automatically rounded to integers before conversion.
- If the string cannot hold any more characters, the character will not be appended.
- Quotes (" ") are used in OptoScript code, but not in standard PAC Control code.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Append</td>
<td>To</td>
</tr>
<tr>
<td>Float Literal</td>
<td>String Variable</td>
</tr>
<tr>
<td>Float Variable</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td></td>
</tr>
</tbody>
</table>

**Action Block Example:**
The following example appends the ASCII code 33 (!, an exclamation mark) to a string; for example, **Hello** would become **Hello!**

### Append Character to String

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Append</td>
<td>Integer 32 Literal</td>
<td>33</td>
</tr>
<tr>
<td>To</td>
<td>String Variable</td>
<td>Hello_String</td>
</tr>
</tbody>
</table>

**Example Result:**

![Image of a PAC Control interface showing string manipulation]
The following example appends an ETX (ASCII character 3) to a string. An ETX or some other terminating character may be required when sending commands to serial devices, such as bar code printers, scales, or single-loop controllers.

### Append Character to String

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Append</td>
<td>Integer 32 Literal</td>
<td>3</td>
</tr>
<tr>
<td>To</td>
<td>String Variable</td>
<td>Command_String</td>
</tr>
</tbody>
</table>

### Example Result:

In this example, the ETX appears as a period (.) at the end of the command.

### OptoScript Example:

In OptoScript, this function is built-in. Instead of using a command, you use the `+=` and `=` operators and a variable or string. (In OptoScript, the string must be in quotes.)

Alternatively, the operator can be followed by the `Chr` keyword and an ASCII code in parentheses (to convert an ASCII code to its text equivalent).

The first example above can be written in OptoScript in either of these ways:

```plaintext
Hello_String += Chr(33);
Hello_String = Hello_String + "!";
```

The OptoScript code for the second example is:

```plaintext
Command_String = Command_String + Chr(3);
```

### Notes:

- For more information, see “String Commands” and “Using OptoScript” in the *PAC Control User’s Guide* (form 1700).
- To clear a string, use `Move String` before using this command. Moving an empty string ("") to a string variable will clear it.

### Dependencies:

The string variable must be wide enough to hold one more character.

### See Also:

“Append String to String” on page 599
Append String to String

String Action

Function: To add a string to the end of another string variable.

Typical Use: To build strings.

Details:
- If the string variable cannot hold all of the appended string, the remaining portion of the string to be appended will be discarded.
- Single characters can be appended (yielding the same result as an Append Character to String). For example, to append a “space,” use the space bar rather than the number 32.
- Quotes (" ") are used in OptoScript code, but not in standard PAC Control code.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Append</td>
<td>To</td>
</tr>
<tr>
<td>String Literal</td>
<td>String Variable</td>
</tr>
</tbody>
</table>

Action Block Example: The following example appends the string world to a string. For example, Hello would become Hello world (note the space before the “w” in “world”).

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Append</td>
<td>String Literal</td>
<td>world</td>
</tr>
<tr>
<td>To</td>
<td>String Variable</td>
<td>Hello_String</td>
</tr>
</tbody>
</table>

OptoScript Example: In OptoScript, this function is built-in. Instead of using a command, you use the += and = operators and a variable or string. (In OptoScript, the string must be in quotes.)

The example above can be written in OptoScript like this:

Hello_String = Hello_String + " world";

Notes:
- For more information, see “String Commands” and “Using OptoScript” in the PAC Control User’s Guide (form 1700).
- In OptoScript, you can append several strings at once, as shown:

  string1 = string2 + string3 + string4;

- To clear a string, use Move String before using this command. Moving an empty string ("" ) to a string variable will clear it.

Dependencies: The string variable must be wide enough to hold the appended string.

See Also: “Append Character to String” on page 597
Compare Strings

String Action

**Function:** To compare two strings to see if they are the same or if one is less than the other.

**Typical Use:** To sort strings.

**Details:**
- Strings are compared character by character according to their ASCII value. See the ASCII table in the “String Commands” in the PAC Control User’s Guide (form 1700). Note that number values are lower than letter values and that all uppercase letter values are lower than all lowercase letter values.
- If the strings are different lengths, they are compared up to the length of the shorter string. If the compared portions are equal, the shorter string is found to be less than the longer one.
- Quotes (" ") are used in OptoScript code, but not in standard PAC Control code.
- The result returned (Put Result in, Argument 2) indicates the relationship between the two strings:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Put Result in</th>
<th>Relationship</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;abcDEF&quot;</td>
<td>&quot;abcDEF&quot;</td>
<td>0</td>
<td>Strings equal</td>
</tr>
<tr>
<td>&quot;abcDEF&quot;</td>
<td>&quot;abcdef&quot;</td>
<td>-1</td>
<td>Compare string is less</td>
</tr>
<tr>
<td>&quot;abcDEF&quot;</td>
<td>&quot;abcdEF&quot;</td>
<td>-1</td>
<td>Compare string is less</td>
</tr>
<tr>
<td>&quot;abcDEF&quot;</td>
<td>&quot;abcDEFG&quot;</td>
<td>-1</td>
<td>Compare string is less</td>
</tr>
<tr>
<td>&quot;abcDEF&quot;</td>
<td>&quot;ABCDEF&quot;</td>
<td>1</td>
<td>Compare string is greater</td>
</tr>
<tr>
<td>&quot;abcDEF&quot;</td>
<td>&quot;AbcDEF&quot;</td>
<td>1</td>
<td>Compare string is greater</td>
</tr>
<tr>
<td>&quot;abcDEF&quot;</td>
<td>&quot;abcDE&quot;</td>
<td>1</td>
<td>Compare string is greater</td>
</tr>
<tr>
<td>&quot;abcDEF&quot;</td>
<td>&quot;aBcDEF&quot;</td>
<td>1</td>
<td>Compare string is greater</td>
</tr>
<tr>
<td>&quot;abcDEF&quot;</td>
<td>&quot;9abcDEF&quot;</td>
<td>1</td>
<td>Compare string is greater</td>
</tr>
<tr>
<td>&quot;abcDEF&quot;</td>
<td>&quot;DEFabc&quot;</td>
<td>1</td>
<td>Compare string is greater</td>
</tr>
</tbody>
</table>

**Examples:**

<table>
<thead>
<tr>
<th>Compare</th>
<th>With</th>
<th>Put Result in</th>
<th>Relationship</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;abcDEF&quot;</td>
<td>&quot;abcDEF&quot;</td>
<td>0</td>
<td>Strings equal</td>
</tr>
<tr>
<td>&quot;abcDEF&quot;</td>
<td>&quot;abcdef&quot;</td>
<td>-1</td>
<td>Compare string is less</td>
</tr>
<tr>
<td>&quot;abcDEF&quot;</td>
<td>&quot;abcdEF&quot;</td>
<td>-1</td>
<td>Compare string is less</td>
</tr>
<tr>
<td>&quot;abcDEF&quot;</td>
<td>&quot;abcDEFG&quot;</td>
<td>-1</td>
<td>Compare string is less</td>
</tr>
<tr>
<td>&quot;abcDEF&quot;</td>
<td>&quot;ABCDEF&quot;</td>
<td>1</td>
<td>Compare string is greater</td>
</tr>
<tr>
<td>&quot;abcDEF&quot;</td>
<td>&quot;AbcDEF&quot;</td>
<td>1</td>
<td>Compare string is greater</td>
</tr>
<tr>
<td>&quot;abcDEF&quot;</td>
<td>&quot;abcDE&quot;</td>
<td>1</td>
<td>Compare string is greater</td>
</tr>
<tr>
<td>&quot;abcDEF&quot;</td>
<td>&quot;aBcDEF&quot;</td>
<td>1</td>
<td>Compare string is greater</td>
</tr>
<tr>
<td>&quot;abcDEF&quot;</td>
<td>&quot;9abcDEF&quot;</td>
<td>1</td>
<td>Compare string is greater</td>
</tr>
<tr>
<td>&quot;abcDEF&quot;</td>
<td>&quot;DEFabc&quot;</td>
<td>1</td>
<td>Compare string is greater</td>
</tr>
</tbody>
</table>

**Arguments:**
- **Argument 0**
  - Compare
  - String Literal
  - String Variable
- **Argument 1**
  - With
  - String Literal
  - String Variable
- **Argument 2**
  - Put Result in
  - Integer 32 Variable

**Action Block Example:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compare</td>
<td>String Variable</td>
<td>Search_Name</td>
</tr>
<tr>
<td>With</td>
<td>String Variable</td>
<td>Current_Name</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Integer 32 Variable</td>
<td>String_Test</td>
</tr>
</tbody>
</table>
**OptoScript**

*Example:*

```optoscript
CompareStrings(Compare, With)

String_Test = CompareStrings(Search_Name, Current_Name);
```

This is a function command; it returns one of the values shown above (-1, 0, or 1). The returned value can be consumed by a variable (as shown in the example) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the *PAC Control User’s Guide* (form 1700).

**Notes:** See “String Commands” in the *PAC Control User’s Guide* (form 1700).

**See Also:** “Test Equal Strings” on page 651
CHAPTER 20: STRING COMMANDS

Convert Float to String

String Action

Function: To convert a float to a formatted string having a specified length and number of digits to the right of the decimal.

Typical Use: To print a float or send it to another device using a specific format or length.

Details:
- **Length** (Argument 1) specifies the final length of the resulting string, including the decimal point. Leading spaces (character 32) are added if required.
- **Decimals** (Argument 2) specifies the number of digits to the right of the decimal point.
- Rounding occurs whenever digits on the right must be dropped.
- Digits to the left of the decimal point are never dropped.
- If the whole number portion (digits to the left of the decimal plus the decimal itself) of the resulting string would be larger than its allocated space, the resulting string will be filled with asterisks to alert you to the problem.
  
  For example, if the value to convert is 123.4567 with a **Length** value of 5 and a **Decimals** value of 2, the space allocated to the whole number portion is only three (5 - 2). Since four characters ("123") are required, the formatted number "123.46" will not fit, so "*****" will be moved to the destination string.
- If the declared width of the string variable is less than the specified length, "*****" will be moved to the destination string.
- Although integers can also be converted, significant rounding errors will occur for values of 1,000,000 or more.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
<th>Argument 3</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Convert</strong></td>
<td><strong>Length</strong></td>
<td><strong>Decimals</strong></td>
<td><strong>Put Result in</strong></td>
</tr>
<tr>
<td>Analog Input</td>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
<td>String Variable</td>
</tr>
<tr>
<td>Analog Output</td>
<td>Float Variable</td>
<td>Integer 32 Variable</td>
<td></td>
</tr>
<tr>
<td>Float Literal</td>
<td>Integer 32 Variable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Float Variable</td>
<td>Integer 32 Literal</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Variable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Action Block Example:
The following example converts a decimal number in variable *MY VALUE* to a string (for example, if *MY VALUE* is 12.3435, the string becomes "12.34"): Convert Float to String

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Convert</strong></td>
<td>Float Variable</td>
<td><em>My_Value</em></td>
</tr>
<tr>
<td><strong>Length</strong></td>
<td>Integer 32 Literal</td>
<td>5</td>
</tr>
<tr>
<td><strong>Decimals</strong></td>
<td>Integer 32 Literal</td>
<td>2</td>
</tr>
<tr>
<td><strong>Put Result in</strong></td>
<td>String Variable</td>
<td><em>Value_as_String</em></td>
</tr>
</tbody>
</table>

OptoScript Example:

```plaintext
FloatToString(Convert, Length, Decimals, Put Result in)
FloatToString(My_Value, 5, 2, Value_as_String);
```

This is a procedure command; it does not return a value.

Notes:
- For more information, see “String Commands” and “Using OptoScript” in the *PAC Control User’s Guide* (form 1700).
- Set decimals to zero to get an integer. Normal rounding will occur.
Dependencies: The string variable must be wide enough to hold the resulting formatted string.

See Also: “Convert String to Float” on page 613
“Convert Number to String” on page 611
“Convert Number to String Field” on page 612
CHAPTER 20: STRING COMMANDS

Convert Hex String to Number

String Action

Function: To convert a hex string value to an integer value.

Typical Use: To accommodate communications where values may be represented by hex strings.

Details:
- Quotes (" ") are used in OptoScript code, but not in standard PAC Control code.
- An empty string results in a value of zero.
- Conversion is not case-sensitive. For example, the strings “FF,” “ff,” “fF,” and “Ff” all convert to a value of 255.
- Legal hex characters are “0” through “9,” “A” through “F,” and “a” through “f.”
- A string containing an illegal character will be converted up to the point just before the illegal character. For example, the strings “AG” and “A 123” will both convert to 10 (the value of “A”).
- Leading spaces in a string convert the result to a zero.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Convert</td>
<td>Put Result in</td>
</tr>
<tr>
<td>String Literal</td>
<td>Float Variable</td>
</tr>
<tr>
<td>String Variable</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

Action Block Example:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Convert</td>
<td>String Variable</td>
<td>String_From_Port</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Integer 32 Variable</td>
<td>Int_Value</td>
</tr>
</tbody>
</table>

Example Result:

OptoScript Example:

```
HexToString(Converter) = HexStringToNumber(String_From_Port);
```

This is a function command; it returns the converted number. The returned value can be consumed by a variable (as shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

Notes:
- If the hex string contains an IEEE float, you must use Convert IEEE Hex String to Number.

See Also:
- “Convert Number to Hex String” on page 610
- “Convert String to Float” on page 613
- “Convert String to Integer 32” on page 615
- “Convert IEEE Hex String to Number” on page 605
Convert IEEE Hex String to Number

String Action

Function: To convert a hex string representing an IEEE float in native IEEE format to a number.

Typical Use: To retrieve the float value previously stored as hex after using Convert Number to Formatted Hex String.

Details:
- Quotes (" ") are used in OptoScript code, but not in standard PAC Control code.
- Use between control engines or other computers that use the IEEE format.
- The eight hex characters are converted to four bytes (IEEE float format).
- The hex string must be in Motorola or Big Endian format (most significant byte on the left, in the least significant address).

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Convert</td>
<td>Put Result in</td>
</tr>
<tr>
<td>String Literal</td>
<td>Float Variable</td>
</tr>
<tr>
<td>String Variable</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

Action Block Example:
The following example converts a hex string into a float value. For example, if STRING_FROM_PORT contains "418E6666" then MY_FLOAT_VALUE becomes 17.8.

<table>
<thead>
<tr>
<th>Convert IEEE Hex String to Number</th>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Convert</td>
<td>String Variable</td>
<td>STRING_FROM_PORT</td>
<td></td>
</tr>
<tr>
<td>Put Result in</td>
<td>Float Variable</td>
<td>MY_FLOAT_VALUE</td>
<td></td>
</tr>
</tbody>
</table>

OptoScript Example:

```plaintext
IEEEHexStringToNumber(Convert)
MY_FLOAT_VALUE = IEEEHexStringToNumber(STRING_FROM_PORT);
```

This is a function command; it returns the converted number. The returned value can be consumed by a variable (as shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User's Guide (form 1700).


See Also: “Convert Hex String to Number” on page 604
Convert Integer 32 to IP Address String

String Action

Function: To convert an integer 32 value to an IP address string.

Typical Use: To convert an IP address stored as an integer into a human-readable string, such as "10.192.54.155"

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Convert</td>
<td>Put Result in</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>String Variable</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td></td>
</tr>
</tbody>
</table>

Action Block

Example:

<table>
<thead>
<tr>
<th>Convert Integer 32 to IP Address String</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argument Name</td>
</tr>
<tr>
<td>----------------</td>
</tr>
<tr>
<td>Convert</td>
</tr>
<tr>
<td>Put Result in</td>
</tr>
</tbody>
</table>

OptoScript Example:

```opto
Int32ToIpAddressString(Convert, Put Result in)
Int32ToIpAddressString(IP_Integer, IP_String);
```

This is a function command; it returns the converted string.


See Also: “Convert IP Address String to Integer 32” on page 607
Convert IP Address String to Integer 32

String Action

Function: To convert an IP address string value to an integer 32 value.

Typical Use: To convert an IP address stored as a string (for example, “10.192.54.155”) to an integer (in this example, 0x0AC0369B).

Details: Quotes (" ") are used in OptoScript code, but not in standard PAC Control code.

Arguments:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Convert</td>
<td>String Variable</td>
<td>IP_String</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Integer 32 Variable</td>
<td>IP_Integer</td>
</tr>
</tbody>
</table>

OptoScript Example:

```
IpAddressStringToInt32(Convert)
```

This is a function command; it returns the converted number. The returned value can be consumed by a variable (as shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).


Error Code:

-45 = String is empty.
-46 = Invalid string.

See Also: “Convert Integer 32 to IP Address String” on page 606 or used in an item such as a Condition block, an OptoScript block, or a mathematical expression.
Convert Number to Formatted Hex String

**String Action**

**Function:** To convert an integer to a formatted hex string having a specified length, or to convert a float to an eight-byte IEEE hex format.

**Typical Uses:**
- To print a hex number or to send it to another device with a fixed length.

**Details:**
- *Length* (Argument 1) specifies the final length of the resulting string. Leading zeros are added if required.
- You must use a *Length* of 8 when converting a float or a negative number.
- To send a float value in native IEEE format, set the value of *Convert* (Argument 1) to 8, and use a float variable or literal. If less than eight characters are used, asterisks appear in *Put Result in* (Argument 2), and error -3 (Buffer overrun or invalid length error) appears in the message queue. Use **Convert IEEE Hex String to Number** to convert the eight hex characters back to a float.
- If the resulting hex string is wider than the specified length, the string is filled with asterisks and an error -3 is reported.
- If the declared width of the string variable is less than the specified length, error -3 (Buffer overrun or invalid length error) appears in the message queue. If the value can be represented by the string width, the value is stored in the variable. Otherwise, the string is filled with asterisks.
- If the declared width is not long enough to represent the value, error -23 (Destination string too short) appears in the message queue, and the string is filled with asterisks.
- Upper case is used for all hex characters; for example, 1,000 decimal is represented as 3E8 rather than 3e8.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Convert</strong></td>
<td><strong>Length</strong></td>
<td><strong>Put Result in</strong></td>
</tr>
<tr>
<td>Analog Input</td>
<td>Integer 32 Literal</td>
<td>String Variable</td>
</tr>
<tr>
<td>Analog Output</td>
<td>Integer 32 Variable</td>
<td></td>
</tr>
<tr>
<td>Float Literal</td>
<td>Integer 32 Literal</td>
<td></td>
</tr>
<tr>
<td>Float Variable</td>
<td>Integer 32 Variable</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Variable</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
<td></td>
</tr>
<tr>
<td>Integer 64 Literal</td>
<td>Integer 64 Variable</td>
<td></td>
</tr>
<tr>
<td>Integer 64 Variable</td>
<td>Integer 64 Variable</td>
<td></td>
</tr>
</tbody>
</table>

**Action Block Example:**

The following example converts a decimal integer to a hex string. If MY ADDRESS has the value 255, the resulting hex string would be "00FF" because Length is 4. If Length had been 2, the hex string would have become "FF."

<table>
<thead>
<tr>
<th>Convert Number to Formatted Hex String</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argument Name</td>
</tr>
<tr>
<td>----------------</td>
</tr>
<tr>
<td>Convert</td>
</tr>
<tr>
<td>Length</td>
</tr>
<tr>
<td>Put Result in</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

**NumberToFormattedHexString**(Convert, Length, Put Result in)

NumberToFormattedHexString (My_Address, 4, Address_as_Hex);

This is a procedure command; it does not return a value.

**Notes:**
- See “String Commands” in the **PAC Control User’s Guide** (form 1700).
- Caution: Do not use a float where an integer would suffice. Floats are not automatically converted to integers with this command.
Queue Errors:  -3 = Buffer overrun or invalid length error. If a float value or negative number is used, the string width must be at least 8.
-23 = Destination string too short. The string width is not long enough to represent the number.

Dependencies:  The string variable must be wide enough to hold the hex string.

See Also:  “Convert Float to String” on page 602
“Convert Number to Hex String” on page 610
“Convert Number to String” on page 611
“Convert Number to String Field” on page 612
CHAPTER 20: STRING COMMANDS

Convert Number to Hex String

String Action

Function: To convert a decimal integer to a hex string.

Typical Uses:
- To send an integer value with a predetermined length to another control engine.
- To print a hex representation of a number or to send it to another device.

Details:
- Does not add leading zeros or spaces.
- If the declared width of the string variable is less than the resulting hex string length, the hex string will be filled with asterisks.
- Upper case is used for all hex characters; for example, 1,000 decimal is represented as 3E8 rather than 3e8.
- A floating point number is first rounded to a whole number, and then converted to a hex string.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Convert</td>
<td>Put Result in</td>
</tr>
<tr>
<td>Analog Input</td>
<td>String Variable</td>
</tr>
<tr>
<td>Analog Output</td>
<td></td>
</tr>
<tr>
<td>Down Timer Variable</td>
<td></td>
</tr>
<tr>
<td>Float Literal</td>
<td></td>
</tr>
<tr>
<td>Float Variable</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td></td>
</tr>
<tr>
<td>Integer 64 Literal</td>
<td></td>
</tr>
<tr>
<td>Integer 64 Variable</td>
<td></td>
</tr>
<tr>
<td>Up Timer Variable</td>
<td></td>
</tr>
</tbody>
</table>

Action Block Example:
The following example converts a number in MY ADDRESS to a hex string (for example, if MY ADDRESS has the value 256, the hex string becomes "100"):

<table>
<thead>
<tr>
<th>Convert Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Convert</td>
<td>Integer 32 Variable</td>
<td>My_Address</td>
</tr>
<tr>
<td>Put Result in</td>
<td>String Variable</td>
<td>Address_as_Hex</td>
</tr>
</tbody>
</table>

OptoScript Example:

```
NumberToHexString(Convert, Put Result in)
NumberToHexString(My_Address, Address_as_Hex);
```

This is a procedure command; it does not return a value.

Notes:
- Use Convert Number to Formatted Hex String when converting floats that require formatting.

Dependencies: The string variable must be wide enough to hold the resulting hex string.

See Also:
- “Convert Float to String” on page 602
- “Convert Number to String” on page 611
- “Convert Number to String Field” on page 612
Convert Number to String

String Action

**Function:**
To convert a decimal number to a string.

**Typical Use:**
To print a number or send it to another device.

**Details:**
- If the declared width of the string variable is less than the resulting string length, the resulting string will be filled with asterisks to alert you to the problem.
- Example: 12n becomes 12n—note no change for integers.
- Floats will have an exponential format.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Convert</strong></td>
<td><strong>Put Result in</strong></td>
</tr>
<tr>
<td>Analog Input</td>
<td>String Variable</td>
</tr>
<tr>
<td>Analog Output</td>
<td></td>
</tr>
<tr>
<td>Float Literal</td>
<td></td>
</tr>
<tr>
<td>Float Variable</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td></td>
</tr>
<tr>
<td>Integer 64 Literal</td>
<td></td>
</tr>
<tr>
<td>Integer 64 Variable</td>
<td></td>
</tr>
</tbody>
</table>

**Action Block Example:**
The following example converts a decimal number in MY_VALUE to a string (for example, if MY_VALUE is 12.34, the string becomes 1.234000e+01; if MY_VALUE is the integer value 1234, the string becomes 1234):

<table>
<thead>
<tr>
<th>Convert</th>
<th>My_Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Float Variable</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Put Result in</th>
<th>Value_as_String</th>
</tr>
</thead>
<tbody>
<tr>
<td>String Variable</td>
<td></td>
</tr>
</tbody>
</table>

**OptoScript Example:**
NumberToString(Convert, Put Result in)
NumberToString(My_Value, Value_as_String);

This is a procedure command; it does not return a value.

**Notes:**
- To avoid scientific notation or to have greater control over format, use Convert Float to String instead.

**Dependencies:**
The string variable must be wide enough to hold the resulting string.

**See Also:**
- "Convert String to Integer 32" on page 615
- "Convert Float to String" on page 602
CHAPTER 20: STRING COMMANDS

Convert Number to String Field

String Action

Function: To convert a number to a string using a specified minimum length.

Typical Use: To fix the length of an integer before sending it to a serial printer or to another device.

Details:
- The resulting string length will be greater than or equal to the length specified in Length (Argument 1).
- If the declared width of the string variable is less than the resulting string length, the resulting string is filled with asterisks.
- A value whose length is less than that specified will have leading spaces added as necessary, up to a maximum equal to the string width.
- A value whose length is equal to or greater than the specified length will be sent as is.
- A floating point value will have an exponential format.
- Examples (Quotes are used in OptoScript code, but not in standard PAC Control code. They are used here for clarity only):
  - 2n6 becomes “2n6”—There are six digits (one leading space in front of the 2).
  - 0 becomes “0”—There are six digits (five leading spaces in front of the 0).
  - 2n678 becomes 2n678—The six-digit specified length is ignored.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Convert</td>
<td>Length</td>
<td>Put Result in</td>
</tr>
<tr>
<td>Analog Input</td>
<td>Integer 32 Literal</td>
<td>String Variable</td>
</tr>
<tr>
<td>Analog Output</td>
<td>Integer 32 Variable</td>
<td></td>
</tr>
<tr>
<td>Float Literal</td>
<td>Integer 32 Variable</td>
<td></td>
</tr>
<tr>
<td>Float Variable</td>
<td>Integer 64 Variable</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 64 Variable</td>
<td></td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 64 Literal</td>
<td></td>
</tr>
<tr>
<td>Integer 64 Literal</td>
<td>Integer 64 Variable</td>
<td></td>
</tr>
</tbody>
</table>

Action Block Example:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Convert</td>
<td>Integer 32 Variable</td>
<td>Value</td>
</tr>
<tr>
<td>Length</td>
<td>Integer 32 Literal</td>
<td>6</td>
</tr>
<tr>
<td>Put Result in</td>
<td>String Variable</td>
<td>Value_as_String</td>
</tr>
</tbody>
</table>

OptoScript Example:

NumberToStringField(Convert, Length, Put Result in)

NumberToStringField(Value, 6, Value_as_String);

This is a procedure command; it does not return a value.

Notes:
- Use Convert Float to String to better control the resulting format, if desired.

Dependencies: The string variable must be wide enough to hold the resulting string.

See Also:
- "Convert Float to String" on page 602
- "Convert Number to String" on page 611
- "Convert Number to Hex String" on page 610
Convert String to Float

String Action

Function: To convert a string to a float value.

Typical Use: To accommodate communications or operator entry, since all characters from these sources are strings.

Details:
- Quotes (" ") are used in OptoScript code, but not in standard PAC Control code.
- Although this command can be used to convert a string to an integer, significant rounding errors will occur for values of 1,000,000 or more.
- Valid, convertible characters are 0 to 9, the decimal point, and "e" (exponent). Spaces are also considered valid, although they are not converted. Note in particular that commas are invalid.
- Strings are analyzed from left to right.
- Spaces divide text blocks within a string.
- If a space appears to the right of a valid text block, the space and all characters to its right will be ignored. For example, "123 4" and "123.0 X" both convert to 123.
- If an invalid character is found, the string will be converted to 0. For example, "X 22.2 4" and "1,234 45" both convert to 0, since the X in the first string and the comma in the second are invalid. Note, however, that "45 1,234" would convert to 45, since the invalid character (" , " ) would be ignored once the valid text block ("45") was found.
- The following are string-to-float conversion examples:

<table>
<thead>
<tr>
<th>String</th>
<th>Float</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;&quot;</td>
<td>0</td>
</tr>
<tr>
<td>&quot;A12&quot;</td>
<td>0</td>
</tr>
<tr>
<td>&quot;123P&quot;</td>
<td>0</td>
</tr>
<tr>
<td>&quot;123 P&quot;</td>
<td>123</td>
</tr>
<tr>
<td>&quot;123.456&quot;</td>
<td>123.456</td>
</tr>
<tr>
<td>&quot;22 33 44&quot;</td>
<td>22</td>
</tr>
<tr>
<td>&quot; 22.11&quot;</td>
<td>22.11</td>
</tr>
<tr>
<td>&quot;1,234.00&quot;</td>
<td>0</td>
</tr>
<tr>
<td>&quot;1234.00&quot;</td>
<td>1234</td>
</tr>
<tr>
<td>&quot;1.23e01&quot;</td>
<td>12.3</td>
</tr>
</tbody>
</table>

Arguments:
- **Argument 0**
  - Convert
  - String Literal
  - String Variable

- **Argument 1**
  - Put Result in
  - Float Variable

Action Block Example:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Convert</td>
<td>String Variable</td>
<td>String_from_Port</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Float Variable</td>
<td>Float_Value</td>
</tr>
</tbody>
</table>
OptoScript  Example:  \texttt{StringToFloat(Convert)}  
\texttt{Float\_Value = StringToFloat(String\_from\_Port);}

This is a function command; it returns the converted float. The returned value can be consumed by a variable (as shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the \textit{PAC Control User's Guide} (form 1700).

Notes:  See “String Commands” in the \textit{PAC Control User's Guide} (form 1700).

See Also:  “Convert Float to String” on page 602  
“Convert String to Integer 32” on page 615
CHAPTER 20: STRING COMMANDS

Convert String to Integer 32

String Action

Function: To convert a string to an integer value.

Typical Use: To accommodate communications or operator entry, since all characters from these sources are strings.

Details:
- Quotes (" ") are used in OptoScript code, but not in standard PAC Control code.
- Valid, convertible characters are 0 to 9. Spaces are also considered valid, although they are not converted. Note in particular that commas are invalid.
- Strings are analyzed from left to right.
- Text that could be read as a float value is truncated to an integer value. For example, "123.6" is truncated to 123. (To round a float rather than truncating it, do not use this command. Instead, use Convert String to Float, and then use Move to move the float to an integer.)
- Spaces divide text blocks within a string.
- If a space appears to the right of a valid text block, the space and all characters to its right are ignored. For example, "123 4" and "123.0 X" both convert to 123.
- If an invalid character is found, the string is used up to that character. For example, "X 22 4" becomes 0, since the first character (X) is invalid. "1,234 45" becomes 1, since the comma is invalid.
- The following are string-to-integer conversion examples:

<table>
<thead>
<tr>
<th>String</th>
<th>Integer</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;&quot;</td>
<td>0</td>
</tr>
<tr>
<td>&quot;A12&quot;</td>
<td>0</td>
</tr>
<tr>
<td>&quot;123P&quot;</td>
<td>123</td>
</tr>
<tr>
<td>&quot;123 P&quot;</td>
<td>123</td>
</tr>
<tr>
<td>&quot;123.456&quot;</td>
<td>123</td>
</tr>
<tr>
<td>&quot;22 33 44&quot;</td>
<td>22</td>
</tr>
<tr>
<td>&quot; 22.51&quot;</td>
<td>22</td>
</tr>
<tr>
<td>&quot;1,234&quot;</td>
<td>1</td>
</tr>
<tr>
<td>&quot;1234.00&quot;</td>
<td>1234</td>
</tr>
</tbody>
</table>

Arguments:  

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Convert</td>
<td>Put Result in</td>
</tr>
<tr>
<td>String Literal</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>String Variable</td>
<td></td>
</tr>
</tbody>
</table>

Action Block Example:

Convert String to Integer 32

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Convert</td>
<td>String Variable</td>
<td>String_from_Port</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Integer 32 Variable</td>
<td>Int_Value</td>
</tr>
</tbody>
</table>

OptoScript Example:

StringTo132 (Convert)

Int_Value = StringTo132(String_from_Port);
This is a function command; it returns the converted integer. The returned value can be consumed by a variable (as shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the *PAC Control User’s Guide* (form 1700).

**Notes:**
- Avoid alpha characters. Stick with 0 to 9.
- If you need to convert a string to an integer 64 for use with a 64-point digital-only I/O unit, use the command *Convert String to Integer 64*.

**See Also:**
- “Convert String to Float” on page 613
- “Convert Number to String” on page 611
Convert String to Integer 64

String Action

Function: To convert a string to an integer 64 value.

Typical Use: Most conversions will be to integer 32 values and use the command Convert String to Integer 32. Use this command to accommodate communications or operator entry strings that must be converted to integer 64 values for use with digital-only 64-point I/O units.

Details:
- Quotes (" ") are used in OptoScript code, but not in standard PAC Control code.
- Valid, convertible characters are 0 to 9. Spaces are also considered valid, although they are not converted. Note in particular that commas are invalid.
- Strings are analyzed from left to right.
- Text that could be read as a float value is truncated to an integer value. For example, "123.6" is truncated to 123. (To round a float rather than truncating it, do not use this command. Instead, use Convert String to Float, and then use Move to move the float to an integer.)
- Spaces divide text blocks within a string.
- If a space appears to the right of a valid text block, the space and all characters to its right are ignored. For example, "123 4" and "123.0 X" both convert to 123.
- If an invalid character is found, the string is used up to that character. For example, "X 22 4" becomes 0, since the first character (X) is invalid. "1,234 45" becomes 1, since the comma is invalid.
- The following are string-to-integer conversion examples:

<table>
<thead>
<tr>
<th>String</th>
<th>Integer</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;&quot;</td>
<td>0</td>
</tr>
<tr>
<td>&quot;A12&quot;</td>
<td>0</td>
</tr>
<tr>
<td>&quot;123P&quot;</td>
<td>123</td>
</tr>
<tr>
<td>&quot;123 P&quot;</td>
<td>123</td>
</tr>
<tr>
<td>&quot;123.456&quot;</td>
<td>123</td>
</tr>
<tr>
<td>&quot;22 33.44&quot;</td>
<td>22</td>
</tr>
<tr>
<td>&quot;22.51&quot;</td>
<td>22</td>
</tr>
<tr>
<td>&quot;1,234&quot;</td>
<td>1234</td>
</tr>
</tbody>
</table>

Arguments:
- **Argument 0**
  - Convert
  - String Literal
  - String Variable

- **Argument 1**
  - Put Result in
  - Integer 64 Variable

Action Block Example:

<table>
<thead>
<tr>
<th>Convert String to Integer 64</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argument Name</td>
</tr>
<tr>
<td>---------------</td>
</tr>
<tr>
<td>Convert</td>
</tr>
<tr>
<td>Put Result in</td>
</tr>
</tbody>
</table>
### StringToInt64 (Convert)

**Example:**

```plaintext
Int_Value = StringToInt64(String_from_Port);
```

This is a function command; it returns the converted integer. The returned value can be consumed by a variable (as shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the *PAC Control User's Guide* (form 1700).

**Notes:**
- Avoid alpha characters. Use characters 0 to 9.

**See Also:**
- "Convert String to Float" on page 613
- "Convert Number to String" on page 611
Convert String to Lower Case

String Action

- **Function:** To change any uppercase letters in a string to lower case.
- **Typical Use:** To simplify string matching by making all characters the same case.
- **Details:** Does not affect numbers, blanks, punctuation, and so forth.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Convert</td>
<td>String Variable</td>
<td>IO_COMMAND</td>
</tr>
</tbody>
</table>

**Action Block Example:**

```
Convert String to Lower Case

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Convert</td>
<td>String Variable</td>
<td>IO_COMMAND</td>
</tr>
</tbody>
</table>
```

**OptoScript Example:**

```optoscrypt
StringToLowerCase(Convert)
```

This is a procedure command; it does not return a value.

**See Also:** "Convert String to Upper Case" on page 620
Convert String to Upper Case

String Action

**Function:** To change any lowercase letters in a string to upper case.

**Typical Use:** To simplify string matching by making all characters the same case.

**Details:** Does not affect numbers, blanks, punctuation, and so forth.

**Arguments:**
- **Argument 0**
  - **Convert**
  - String Variable

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Convert</td>
<td>String Variable</td>
<td>IO_COMMAND</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```plaintext
StringToUpperCase(Convert)
StringToUpperCase(IO_COMMAND);
```

This is a procedure command; it does not return a value.

**See Also:** "Convert String to Lower Case" on page 619
CHAPTER 20: STRING COMMANDS

Find Character in String
String Action

Function: Locate a character within a string. Note that when using the command in an Action Block, you must use the character’s ASCII code for the Find argument (Argument 0).

Typical Use: When parsing strings to locate delimiters and punctuation characters.

Details: • The search is case-sensitive.
• The search begins at the location specified so that multiple occurrences of the same character can be found.
• Put Result in (Argument 3) will contain an integer specifying the position at which the character is located. Values returned will be from 0 (first position in the string) to the string length minus one.

Arguments:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find</td>
<td>Integer 32 Literal</td>
<td>97</td>
</tr>
<tr>
<td>Start at Index</td>
<td>Integer 32 Literal</td>
<td>0</td>
</tr>
<tr>
<td>Of String</td>
<td>String Variable</td>
<td>MSG_RECEIVED</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Integer 32 Variable</td>
<td>POSITION</td>
</tr>
</tbody>
</table>

Action Block Example:

<table>
<thead>
<tr>
<th>Find Character In String</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argument Name</td>
</tr>
<tr>
<td>---------------</td>
</tr>
<tr>
<td>Find</td>
</tr>
<tr>
<td>Start at Index</td>
</tr>
<tr>
<td>Of String</td>
</tr>
<tr>
<td>Put Result in</td>
</tr>
</tbody>
</table>

Example Result:

In this example, the first instance of Find (ASCII 97, which is the letter 'a') was found in position 6.

Note that position 0 was skipped, because the search is based on ASCII which is case-sensitive.

OptoScript Example:

FindCharacterInString (Find, Start at Index, Of String)

POSITION = FindCharacterInString(97, 0, MSG_RECEIVED);

Because the OptoScript compiler can automatically translate a string character, you can also use the following example to search for ASCII code 97 (the letter a). Note that the character must be enclosed in straight single quotes.

POSITION = FindCharacterInString('a', 0, MSG_RECEIVED);

This is a function command; it returns the position at which the character is located in the string.

Notes: • When using an Action Block instruction, you must enter the character’s ASCII code; for example, the letter a (as shown in the Action Block example) is ASCII code 97.
• The first position in the string is referred to as position 0.
When looking for multiple instances of the same character in the string, use the same variable for Start at Index (Argument 1) and Put Result in (Argument 3):

\[
\text{POSITION} = \text{FindCharacterInString}(97, \text{POSITION}, \text{MSG\_RECEIVED});
\]

Then, increment the variable after each find so the same character won't be found repeatedly.

**Error Code:**
- -42 = Invalid limit error. Start at Index value is outside of string width range.
- -58 = Specified character could not be found.

**See Also:** “Find Substring in String” on page 623
Find Substring in String

String Action

Function: Locate a string of characters (substring) within a string.

Typical Use: When parsing strings to locate key words.

Details:
- Quotes (" ") are used in OptoScript code, but not in standard PAC Control code.
- The search is case-sensitive.
- The search begins at the location specified so that multiple occurrences of the same substring can be found.
- Put Result in (Argument 3) will contain either an integer specifying the position at which the substring starts, or an error code. Values returned will be from 0 (first position in the string) to the string length minus one, or a negative error code.
- Strings that are longer than the specified width for the string variable are truncated and lose characters on the right-hand side.

Arguments:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find</td>
<td>String Literal</td>
<td>SHIFT</td>
</tr>
<tr>
<td>Start at Index</td>
<td>Integer 32 Variable</td>
<td>INDEX</td>
</tr>
<tr>
<td>Of String</td>
<td>String Variable</td>
<td>MSG_RECEIVED</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Integer 32 Variable</td>
<td>POSITION</td>
</tr>
</tbody>
</table>

Action Block Example:

Find Substring in String

OptoScript Example:

```
FindSubStringInString( "SHIFT", INDEX, MSG_RECEIVED);
```

This is a function command; it returns the position at which the substring starts within the string. Quotes are required in OptoScript code.

Notes: Check for a possible error returned in Put Result in (Argument 3).

Error Code:
- -42 = Invalid limit error. Start at Index value was negative or greater than the string length.
- -45 = String is empty. Either the string variable searched or the substring is empty.
- -57 = Specified substring was not found.

See Also: “Find Character in String” on page 621
Generate Checksum on String

String Action

Function: Calculate an eight-bit checksum value.

Typical Use: Communication that requires checksum error checking.

Details:
- Checksum type is eight-bit.
- Start Value (Argument 0) is also known as the “seed.” It is usually zero.
- When calculating the checksum one character at a time (or a group of characters at a time), Start Value must be the result of the calculation on the previous character(s).
- On String (Argument 1) can contain as little as one character.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Value</td>
<td>On String</td>
<td>Put Result in</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>String Literal</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

Action Block Example:
```
Generate Checksum on String

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Value</td>
<td>Integer 32 Literal</td>
<td>0</td>
</tr>
<tr>
<td>On String</td>
<td>String Variable</td>
<td>MSG_TO_SEND</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Integer 32 Variable</td>
<td>RESULT</td>
</tr>
</tbody>
</table>
```

OptoScript Example:
```
GenerateChecksumOnString(Start Value, On String)
RESULT = GenerateChecksumOnString(0, MSG_TO_SEND);
```

This is a function command; it returns the checksum. The returned value can be consumed by a variable (as shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

Notes: The method used to calculate the checksum is:

1. Take the numerical sum of the ASCII numerical representation of each character in the string.
2. Divide the result by 256.
3. The integer remainder is the eight-bit checksum.

Alternate checksum methods:

- An 8-bit (one byte) checksum for a string can be appended to a string using the Append Character to String command.
- The checksum for an ASCII string can be appended to the string by using the following standard commands:
  1. Convert Number to Formatted Hex String with Length (Argument 1) set to a value of 2.
  2. Append String to String.
- To calculate the LRC of a string, take the two’s complement of the checksum:
  1. Generate checksum on the string.
  2. Subtract the checksum from 255. This is the one’s complement of the checksum.
  3. Add one to the result. This is the two’s complement of the checksum.

Example: For a string containing only the capital letter "A", the checksum is 65. To calculate the LRC, subtract the checksum (65) from 255, which equals 190. Add one to this result, resulting in an LRC of 191.
See Also:  “Verify Checksum on String” on page 656
**Generate Forward CCITT on String**

**String Action**

**Function:** Calculate a 16-bit CRC value.

**Typical Use:** Communication that requires CRC error checking.

**Details:**
- CRC type is 16-bit forward CCITT.
- *Start Value* (Argument 0) is also known as the “seed.” It is usually zero or -1.
- When calculating the CRC one character at a time (or a group of characters at a time), *Start Value* must be the result of the calculation on the previous character(s).
- *On String* (Argument 1) can contain as little as one character.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Value</td>
<td>On String</td>
<td>Put Result in</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>String Literal</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```
GenerateForwardCcittOnString (Start Value, On String)
```

RESULT = GenerateForwardCcittOnString(0, MSG_TO_SEND);

This is a function command; it returns the forward CCITT. The returned value can be consumed by a variable (as shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the *PAC Control User's Guide* (form 1700).

**Notes:**

The forward CCITT can be appended to the string by using the following commands:

1. Convert Number to Formatted Hex String with Length (Argument 1) set to a value of 4.
2. Get Substring on first two characters of formatted hex string (index 0, length 2). Get Substring on next two characters of formatted hex string (index 2, length 2).
3. Convert Hex String to Number on both substrings.
4. Append Character to String on first substring, then second substring to source string.

**Result Data:**

*Put Result in* (Argument 2) will contain the Forward CCITT that was calculated.

**See Also:**

- “Generate Reverse CCITT on String” on page 628
- “Generate Forward CRC-16 on String” on page 627
- “Generate Reverse CRC-16 on Table (32 bit)” on page 491
Generate Forward CRC-16 on String

String Action

Function: Calculate a 16-bit CRC value.

Typical Use: Communication that requires CRC error checking.

Details:
- CRC type is 16-bit forward.
- \textit{Start Value} (Argument 0) is also known as the "seed." It is usually zero or -1.
- When calculating the CRC one character at a time (or a group of characters at a time), \textit{Start Value} must be the result of the calculation on the previous character(s).
- \textit{On String} (Argument 1) can contain as little as one character.

Arguments:

\begin{center}
<table>
<thead>
<tr>
<th>Argument</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Integer 32 Literal</td>
<td>0</td>
</tr>
<tr>
<td>1</td>
<td>String Variable</td>
<td>MSG_TO_SEND</td>
</tr>
<tr>
<td>2</td>
<td>Integer 32 Variable</td>
<td>RESULT</td>
</tr>
</tbody>
</table>
\end{center}

Action Block Example:

\begin{center}
\textbf{Generate Forward CRC-16 on String}
\end{center}

OptoScript Example:

\begin{center}
\texttt{GenerateForwardCrc16OnString(Start Value, On String)}
\end{center}

RESULT = GenerateForwardCrc16OnString(0, MSG\_TO\_SEND);

This is a function command; it returns the forward CRC. The returned value can be consumed by a variable (as shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the \textit{PAC Control User's Guide} (form 1700).

Notes:
- The CRC can be appended to the string one character at a time using \textit{Append Character to String}. For the first character use \textit{Bit Shift -8} on the CRC and append the result. For the second character simply append the original CRC value.
- The CRC can also be appended to the string by using the following commands:
  1. \textbf{Convert Number to Formatted Hex String} with \textit{Length} (Argument 1) set to a value of 4.
  2. \textbf{Get Substring} on first two characters of formatted hex string (index 0, length 2).
  3. \textbf{Get Substring} on next two characters of formatted hex string (index 2, length 2).
  4. \textbf{Append Hex String to Number} on both substrings.
  5. \textbf{Append Character to String} on first substring, then second substring to source string.

See Also:
- “Generate Reverse CRC-16 on String” on page 629
- “Generate Forward CCITT on String” on page 626
- “Generate Reverse CRC-16 on Table (32 bit)” on page 491
CHAPTER 20: STRING COMMANDS

Generate Reverse CCITT on String

String Action

Function: Calculate a 16-bit CRC value.

Typical Use: Communication that requires CRC error checking.

Details:

- CRC type is 16-bit reverse CCITT.
- Start Value (Argument 0) is also known as the "seed." It is usually zero or -1.
- When calculating the CRC one character at a time (or a group of characters at a time), Start Value must be the result of the calculation on the previous character(s).
- On String (Argument 1) can contain as little as one character.

Arguments:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Value</td>
<td>Integer 32 Literal</td>
<td>0</td>
</tr>
<tr>
<td>On String</td>
<td>String Variable</td>
<td>MSG_TO_SEND</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Integer 32 Variable</td>
<td>RESULT</td>
</tr>
</tbody>
</table>

Action Block Example:

```
Generate Reverse CCITT on String
```

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Value</td>
<td>Integer 32 Literal</td>
<td>0</td>
</tr>
<tr>
<td>On String</td>
<td>String Variable</td>
<td>MSG_TO_SEND</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Integer 32 Variable</td>
<td>RESULT</td>
</tr>
</tbody>
</table>

OptoScript Example:

```
GenerateReverseCcittOnString (Start Value, On String)
RESULT = GenerateReverseCcittOnString(0, MSG_TO_SEND);
```

This is a function command; it returns the reverse CCITT. The returned value can be consumed by a variable (as shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User's Guide (form 1700).

Notes:

- The reverse CCITT can be appended to the string one character at a time using Append Character to String. For the first character use Bit Shift -8 on the CRC and append the result. For the second character simply append the original CRC value.
- The CCITT can also be appended to the string by using the following commands:
  1. Convert Number to Formatted Hex String using an integer and Length (Argument 1) set to a value of 4.
  2. Get Substring on first two characters of formatted hex string (index 0, length 2).
  3. Get Substring on next two characters of formatted hex string (index 2, length 2).
  4. Append Character to String on first substring, then second substring to source string.

See Also:

- "Generate Forward CCITT on String" on page 626
- "Generate Reverse CRC-16 on String" on page 629
- "Generate Reverse CRC-16 on Table (32 bit)" on page 491
Generate Reverse CRC-16 on String

String Action

**Function:** Calculate a 16-bit CRC value.

**Typical Use:** Communication that requires CRC error checking.

**Details:**
- CRC type is 16-bit reverse.
- Start Value (Argument 0) is also known as the “seed.” It is usually zero or -1.
- When calculating the CRC one character at a time (or a group of characters at a time), Start Value must be the result of the calculation on the previous character(s).
- On String (Argument 1) can contain as little as one character.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Value</td>
<td>On String</td>
<td>Put Result in</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>String Variable</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

**Action Block Example:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Value</td>
<td>Integer 32 Literal</td>
<td>0</td>
</tr>
<tr>
<td>On String</td>
<td>String Variable</td>
<td>MSG_TO_SEND</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Integer 32 Variable</td>
<td>RESULT</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```optoscript
GenerateReverseCrc16OnString(Start Value, On String)
RESULT = GenerateReverseCrc16OnString(0, MSG_TO_SEND);
```

This is a function command; it returns the CRC. The returned value can be consumed by a variable (as shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User's Guide (form 1700).

**Notes:**
- The CRC can be appended to the string one character at a time using Append Character to String. For the first character, use Bit Shift -8 on the CRC and append the result. For the second character simply append the original CRC value.
- The CRC can also be appended to the string by using the following commands:
  1. **Convert Number to Formatted Hex String** using an integer and Length (Argument 1) set to a value of 4.
  2. **Get Substring** on first two characters of formatted hex string (index 0, length 2).
  3. **Get Substring** on next two characters of formatted hex string (index 2, length 2).
  4. **Convert Hex String to Number** on both substrings.
  5. **Append Character to String** on first substring, then second substring to source string.

**See Also:**
- “Generate Forward CRC-16 on String” on page 627
- “Generate Reverse CCITT on String” on page 628
- “Generate Reverse CRC-16 on Table (32 bit)” on page 491
Get Nth Character

String Action

Function: To get the decimal ASCII value for a character in a string.

Typical Use: To examine characters in a string one by one, especially when the characters may not be printable ASCII.

Details:
- Quotes (" ") are used in OptoScript code, but not in standard PAC Control code.
- Valid range for Index (Argument 1) is 0 (zero) to the string length minus one.
- A negative result (-12) indicates an error in the value of Index.

Arguments:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>From String</td>
<td>String Literal</td>
<td>ABC</td>
</tr>
<tr>
<td>Index</td>
<td>Integer 32 Variable</td>
<td>INDEX</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Integer 32 Variable</td>
<td>ASCII_VALUE</td>
</tr>
</tbody>
</table>

Action Block Example: The following example gets the decimal ASCII value for a character in the string “ABC”.

If Index (Argument 1) is 0 (zero), the returned value will be 65 (the decimal ASCII value for “A”).

OptoScript Example: `GetNthCharacter(From String, Index)`

ASCII_VALUE = GetNthCharacter("ABC", INDEX);

This is a function command; it returns the ASCII value for a character within a string. Quotes are required in OptoScript code. The returned value can be consumed by a variable (as shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

Notes:
- Use to search a string for a particular character, such as a carriage return (character 13).
- To avoid searching past the end of the string, use Get String Length to determine the end of the string.

Status Codes: -12 = Invalid index.

See Also: "Get Substring" on page 632
"Append Character to String" on page 597
"Get String Length" on page 631
Get String Length

**String Action**

**Function:** To get the length of a string.

**Typical Use:** To determine if a string is empty prior to searching it for a character.

**Details:**
- Quotes (" ") are used in OptoScript code, but not in standard PAC Control code.
- An empty string has a length of zero.
- The length of a string contained in a string variable is not the same as the width of the string variable. Width is the maximum string length the string variable can hold and is set in the PAC Control Configurator; it does not change at run time. String length, on the other hand, may change dynamically as the string is modified at run time.
- Spaces and nulls count as part of the length.
- A string with width 10 containing “Hello” has a length of five.
- A string with width 10 containing “Hello ” has a length of six (five for “Hello” plus one for the trailing space).

**Arguments:**

<table>
<thead>
<tr>
<th>Argument</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Of String</td>
<td>MY_STRING</td>
</tr>
<tr>
<td>1</td>
<td>Put Result in</td>
<td>STRING_LEN</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```optoscript
GetStringLength(Of String)
STRING_LEN = GetStringLength(MY_STRING);
```

This is a function command; it returns the length of the string. The returned value can be consumed by a variable (as in the example shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the *PAC Control User's Guide* (form 1700).

**Notes:**
- Use before Get Nth Character to stay within the string length.

**See Also:** “Get Nth Character” on page 630
Get Substring
String Action

Function: To copy a portion of a string.

Typical Uses: To parse or extract data from a string, to skip leading or trailing characters, or to extract data from strings that may contain starting and ending character sequences generated by barcode readers or scales.

Details:
- Quotes (" ") are used in OptoScript code, but not in standard PAC Control code.
- Valid range for Start At Index (Argument 1) is 0 (zero) to the string length minus one. If it is less than 0 or longer than From String (Argument 0), a null string is copied to the substring.
- If the combination of Start At Index (Argument 1) and Num. Characters (Argument 2) extends beyond the length of the source string, only the available portion of the source string will be returned.
- The following are examples of this command applied to the string MONTUEWEDTHUFRI:

<table>
<thead>
<tr>
<th>Start At</th>
<th>Number of Characters</th>
<th>Substring Returned</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>3</td>
<td>&quot;MON&quot;</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td>&quot;TUE&quot;</td>
</tr>
<tr>
<td>0</td>
<td>4</td>
<td>&quot;MONT&quot;</td>
</tr>
<tr>
<td>13</td>
<td>3</td>
<td>&quot;RI&quot;</td>
</tr>
<tr>
<td>15</td>
<td>5</td>
<td>&quot;&quot;</td>
</tr>
</tbody>
</table>

Arguments:

<table>
<thead>
<tr>
<th>Argument 0 From String</th>
<th>Argument 1 Start at Index</th>
<th>Argument 2 Num. Characters</th>
<th>Argument 3 Put Result in</th>
</tr>
</thead>
<tbody>
<tr>
<td>String Literal</td>
<td>Integer 32 Variable</td>
<td>Integer 32 Literal</td>
<td>String Variable</td>
</tr>
</tbody>
</table>

Action Block Example: The following example gets a single day from the string MONTUEWEDTHUFRI.

OptoScript Example:

```
GetSubstring("MONTUEWEDTHUFRI", INDEX, 3, STRING);
```

This is a procedure command; it does not return a value. Quotes are required in OptoScript code.

Notes:
- You can get text that follows a delimiter (such as a space) within a string:
  Create a loop that first uses Get Nth Character to extract a character, then compares it to the delimiter (character 32 in the case of a space).
  If the character is equal to the delimiter, add 1 to the N argument, and use the new N as Start At Index (Argument 1) above.
  See “Move from String Table Element” on page 634 for a similar example.
See Also: “Get Nth Character” on page 630
Move from String Table Element

String Action

**Function:** To copy a string from a string table.

**Typical Uses:**
- To create a numeric-to-string lookup table, or to retrieve strings from a table for further processing.

**Details:**
- Quotes (" ") are used in OptoScript code, but not in standard PAC Control code.
- Valid range for From Index (Argument 0) is 0 (zero) to the table length minus 1 (that is, size – 1).
- If the string moved from the table is longer than the string variable width of To (Argument 2), it is truncated to fit.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Index</td>
<td>Integer 32 Variable</td>
<td>INDEX</td>
</tr>
<tr>
<td>Of Table</td>
<td>String Table</td>
<td>STRING_TABLE</td>
</tr>
<tr>
<td>To</td>
<td>String Variable</td>
<td>STRING</td>
</tr>
</tbody>
</table>

**Action Block Example:**

The following example performs a numeric-to-string-table lookup. Given the numeric value for the day of week, the command below gets the name of the day of week from a string table. Use Get Day of Week to get the value to use for From Index.

```
OptoScript doesn't use a command; the function is built in. Use the = operator. Remember that quotes are required in OptoScript code.

STRING = STRING_TABLE [INDEX];
```

**Notes:**
- In OptoScript code, simply make an assignment to the string.
- A string table is a good way to correlate a number to a string.
- Use Move to String Table Element or Move to String Table Elements to load the table with data.
Multiple string tables can be used to create small databases of information. For example, one string table could contain a product name and another could contain the product ID code or barcode. It is essential to keep all related information at the same index in each table.

Queue Errors: \(-12 = \) Invalid table index. Index was negative or greater than or equal to the table size.

See Also:
- “Move to String Table Element” on page 637
- “String Equal to String Table Element?” on page 648
- “Get Substring” on page 632
- “Get Length of Table” on page 493
Move String

String Action

Function: To copy the contents of one string to another.

Typical Use: To save, initialize, or clear strings.

Details:
- Quotes (" ") are used in OptoScript code, but not in standard PAC Control code.
- If the width of the destination string variable is less than the width of the source, the remaining portion of the source string (characters on the right) will be discarded.
- The contents of the destination string are replaced with the source string.
- The length of the destination string will become that of the source string unless the declared width of the destination is less than the length of the source, in which case the length of the destination will match its declared width.

Arguments:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move String</td>
<td>String Literal</td>
<td>Hello</td>
</tr>
<tr>
<td>To</td>
<td>String Variable</td>
<td>HELLO_STRING</td>
</tr>
</tbody>
</table>

Action Block Example:
The following example initializes a string variable to Hello:

```
Move String
  Argument Name  | Type       | Name       |
  Move String    | String Literal | Hello     |
  To             | String Variable | HELLO_STRING |
```

The following example clears a string variable:

```
Move String
  Argument Name  | Type       | Name       |
  Move String    | String Literal |          |
  To             | String Variable   | MY_STRING |
```

OptoScript Example:
OptoScript doesn't use a command; the function is built in. Use the = operator. Remember that quotes are required in OptoScript code.

HELLO_STRING = "Hello";
MY_STRING = "";

Notes:
- In OptoScript code, simply make an assignment to the string.

Dependencies: The destination string variable should be wide enough to hold the source string. If it is not, the source string will be truncated.

See Also:
- "Append String to String" on page 599
- "Copy Time to String" on page 666
Move to String Table Element

String Action

**Function:** To put a string into a string table.

**Typical Use:** To load strings into a table for later retrieval.

**Details:**
- Quotes (" ") are used in OptoScript code, but not in standard PAC Control code.
- Valid range for To Index (Argument 1) is 0 (zero) to the table length minus 1 (that is, size – 1).
- Strings with a length greater than the width of the table will be truncated to fit.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0 From</th>
<th>Argument 1 To Index</th>
<th>Argument 2 Of Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>String Literal</td>
<td>Integer 32 Literal</td>
<td>String Table</td>
</tr>
<tr>
<td>String Variable</td>
<td>Integer 32 Variable</td>
<td></td>
</tr>
</tbody>
</table>

**Action Block Example:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>From</td>
<td>String Literal</td>
<td>MON</td>
</tr>
<tr>
<td>To Index</td>
<td>Integer 32 Variable</td>
<td>INDEX</td>
</tr>
<tr>
<td>Of Table</td>
<td>String Table</td>
<td>STRING_TABLE</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

OptoScript doesn’t use a command; the function is built in. Use the = operator. Remember that quotes are required in OptoScript code.

```opto
STRING_TABLE [INDEX] = "MON";
```

**Notes:**
- In OptoScript code, simply make an assignment to the table element.
- Use to log key events or application errors as if the string table were a “virtual line printer.” For example, a string table called EVENT_LOG could be used as a circular buffer to store strings containing the time, the date, and a description such as “12-25-96, 1:00:00, Clogged chimney alarm.” An integer variable would also be required to “remember” the next available index (where the next entry goes).

**Queue Errors:**

-12 = Invalid table index. Index was negative or greater than or equal to the table size.

**See Also:**
- “Move from String Table Element” on page 634
- “Get Length of Table” on page 493
- “Move to String Table Elements” on page 638
Move to String Table Elements

String Action

**Function:** To put a given string into a range of table elements within the same table.

**Typical Use:** To initialize elements within a table to the same string.

**Details:**
- Quotes (" ") are used in OptoScript code, but not in standard PAC Control code.
- Valid range for Start Index (Argument 1) is 0 (zero) to the table length minus 1 (that is, size – 1). However, if you need to set a value to the entire table and don’t know the table’s size, you can use a starting index of 0 and an ending index of -1.
- Strings with a length greater than the width of the table will be truncated to fit.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
<th>Argument 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>From</td>
<td>Start Index</td>
<td>End Index</td>
<td>Of Table</td>
</tr>
<tr>
<td>String Literal</td>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
<td>String Table</td>
</tr>
<tr>
<td>String Variable</td>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
<td>String Table</td>
</tr>
</tbody>
</table>

**Action Block Example:**

```
Move to String Table Element

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>From</td>
<td>String Literal</td>
<td>MON</td>
</tr>
<tr>
<td>Start Index</td>
<td>Integer 32 Literal</td>
<td>0</td>
</tr>
<tr>
<td>End Index</td>
<td>Integer 32 Literal</td>
<td>6</td>
</tr>
<tr>
<td>Of Table</td>
<td>String Table</td>
<td>DAYS</td>
</tr>
</tbody>
</table>
```

**OptoScript Example:**

```
MoveToStrTableElements (From, Start Index, End Index, Of Table)
MoveToStrTableElements("MON", 0, 6, DAYS);
```

This is a procedure command; it does not return a value. Remember that quotes are required in OptoScript code.

**Notes:**
- Compared to other methods such as loops, this command initializes table elements very quickly.

**Queue Errors:**

-12 = Invalid table index. Index was negative or greater than or equal to the table size.

**See Also:**
- “Move from String Table Element” on page 634
- “Get Length of Table” on page 493
- “Move to String Table Element” on page 637
**Pack Float into String**

**String Action**

**Function:** Packs the data bytes of a float value into a string.

*NOTE: This command is designed to create HART argument strings, but it can also be used to pack data bytes of a float value into a single string packed with other types of data.*

**Typical Use:**
To pack float value data into a string along with other types of data to be sent in a single send rather a series of sends.

To unpack data from a string that has been packed with various types of data, see "Unpack String" on page 654.

**Details:**
The arguments are as follows:

- **From Value**: Value to pack into string.
- **To String**: Destination string.
- **Start Index**: Index where the value should be placed in the string.
  - If you specify the index, (and the string is long enough), it will pack the data at the requested location. The string must already contain enough characters; the packed data replaces whatever characters are already there.
  - If you specify -1 as the index, the value is packed and appended to the end of the string.
- **Width**: The number of bytes the value should occupy. Currently, 4 is the only valid value.
- **Endian Type**: The following Endian type examples use 0x12345678 as the source value:
  - 0 - Big Endian (0x12 0x34 0x56 0x78)
  - 1 - Little Endian (0x78 0x56 0x34 0x12)
  - 2 - Modbus Big Endian (0x12 0x34 0x56 0x78)
  - 3 - Modbus Little-Endian (0x56 0x78 0x12 0x34)
- **Put Result in**: Indicates success or failure of the operation.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Value</td>
<td>To String</td>
<td>Start Index</td>
</tr>
<tr>
<td>Float Literal</td>
<td>String Variable</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Float Variable</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Argument 3</th>
<th>Argument 4</th>
<th>Argument 5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width</td>
<td>Endian Type</td>
<td>Put Result in</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Action Block Example:**

<table>
<thead>
<tr>
<th>Pack Float into String</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argument Name</td>
</tr>
<tr>
<td>----------------</td>
</tr>
<tr>
<td>From</td>
</tr>
<tr>
<td>To String</td>
</tr>
<tr>
<td>Start Index</td>
</tr>
<tr>
<td>Width</td>
</tr>
<tr>
<td>Endian Type</td>
</tr>
<tr>
<td>Put Result in</td>
</tr>
</tbody>
</table>
**OptoScript Example:**

PackFloatIntoString(*From Value, To String, Start Index, Width, Endian Type*)

Result = PackFloatIntoString(3.14159, sPack, 1, 4, 1);

- **Notes:**
  - To unpack data from a string that has been packed with various types of data, see "Unpack String" on page 654.

- **Status Codes:**
  - 0 = success
  - -3 = Invalid length
  - -6 = Invalid data field
  - -8 = Invalid data
  - -13 = Overflow
  - -23 = String too short

- **See Also:**
  - "Get HART Unique Address" on page 32
  - "Receive HART Response" on page 38
  - "Send/Receive HART Command" on page 40
  - "Send/Receive HART Command" on page 40
  - "Pack Integer 32 into String" on page 641
  - "Pack Integer 64 into String" on page 643
  - "Pack String into String" on page 645
  - "Unpack String" on page 654
Pack Integer 32 into String

String Action

**Function:** Packs the data bytes of a 32-bit integer value into a string.

*NOTE: This command is designed to create HART argument strings, but it can also be used to pack data bytes of a 32-bit integer value into a single string packed with other types of data.*

**Typical Use:** To pack 32-bit integer value data into a string along with other types of data to be sent in a single send rather than a series of sends.

**Details:** The arguments are as follows:
- **From Value:** Value to pack into string.
- **To String:** Destination string.
- **Start Index:** Index where the value should be placed in the string.
  - If you specify the index, (and the string is long enough), it will pack the data at the requested location. The string must already contain enough characters; the packed data replaces whatever characters are already there.
  - If you specify -1 as the index, the value is packed and appended to the end of the string.
- **Width:** Number of bytes the value should occupy; 1 – 4 are valid.
- **Endian Type:** The following Endian type examples use 0x12345678 as the source value:
  - 0 - Big Endian (0x12 0x34 0x56 0x78)
  - 1 - Little Endian (0x78 0x56 0x34 0x12)
  - 2 - Modbus Big Endian (0x12 0x34 0x56 0x78)
  - 3 - Modbus Little-Endian (0x56 0x78 0x12 0x34)
- **Put Result in:** Indicates success or failure of the operation.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument</th>
<th>Name</th>
<th>Type</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argument 0</td>
<td>From Value</td>
<td>Integer 32 Literal</td>
<td>3</td>
</tr>
<tr>
<td>Argument 1</td>
<td>To String</td>
<td>String Variable</td>
<td>sPack</td>
</tr>
<tr>
<td>Argument 2</td>
<td>Start Index</td>
<td>Integer 32 Literal</td>
<td>1</td>
</tr>
<tr>
<td>Argument 3</td>
<td>Width</td>
<td>Integer 32 Literal</td>
<td>4</td>
</tr>
<tr>
<td>Argument 4</td>
<td>Endian Type</td>
<td>Integer 32 Literal</td>
<td>1</td>
</tr>
<tr>
<td>Argument 5</td>
<td>Put Result in</td>
<td>Integer 32 Variable</td>
<td>Result</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

PackInt32IntoString(From Value, To String, Start Index, Width, Endian Type)

Result = PackInt32IntoString(3, sPack, 1, 4, 1);
This is a function command; it returns a zero (indicating success) or an error (indicating failure). The returned value can be consumed by a variable (as shown in the example) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

Notes: To unpack data from a string that has been packed with various types of data, see “Unpack String” on page 654.

Status Codes:
- 0 = success
- -3 = Invalid length.
- -6 = Invalid data field.
- -8 = Invalid data.
- -13 = Overflow.
- -23 = String too short.

See Also:
- “Get HART Unique Address” on page 32
- “Receive HART Response” on page 38
- “Send/Receive HART Command” on page 40
- “Send/Receive HART Command” on page 40
- “Pack Float into String” on page 639
- “Pack Integer 64 into String” on page 643
- “Pack String into String” on page 645
- “Unpack String” on page 654
Pack Integer 64 into String

String Action

**Function:** Packs the data bytes of a 64-bit integer value into a string.

*NOTE:* This command is designed to create HART argument strings, but it can also be used to pack data bytes of a 64-bit integer value into a single string packed with other types of data.

**Typical Use:** To pack 64-bit integer value data into a string along with other types of data to be sent in a single send rather than a series of sends.

**Details:** The arguments are:

- **From Value:** Value to pack into string.
- **To String:** Destination string. If you specify the index, (and the string is long enough), it will pack the data at the requested location. The string must already contain enough characters; the packed data replaces whatever characters are already there.
- **Start Index:** Index where the value should be placed in the string.
  - If you specify the index, (and the string is long enough), it will pack the data at the requested location. The string must already contain enough characters; the packed data replaces whatever characters are already there.
  - If you specify -1 as the index, the value is packed and appended to the end of the string.
- **Width:** The number of bytes the value should occupy, (1-8 are valid).
- **Endian Type:** The following Endian type examples use 0x12345678 as the source value:
  - 0 - Big Endian (0x12 0x34 0x56 0x78)
  - 1 - Little Endian (0x78 0x56 0x34 0x12)
  - 2 - Modbus Big Endian (0x12 0x34 0x56 0x78)
  - 3 - Modbus Little-Endian (0x56 0x78 0x12 0x34)
- **Put Result in:** Indicates success or failure of the operation.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>From Value</strong></td>
<td><strong>To String</strong></td>
<td><strong>Start Index</strong></td>
</tr>
<tr>
<td>Integer 64 Literal</td>
<td>String Variable</td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td>Integer 64 Variable</td>
<td></td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Argument 3</th>
<th>Argument 4</th>
<th>Argument 5</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Width</strong></td>
<td><strong>Endian Type</strong></td>
<td><strong>Put Result in</strong></td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Action Block Example:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Value</td>
<td>Integer 64 Variable</td>
<td>3</td>
</tr>
<tr>
<td>To String</td>
<td>String Variable</td>
<td>sPack</td>
</tr>
<tr>
<td>Start Index</td>
<td>Integer 32 Variable</td>
<td>1</td>
</tr>
<tr>
<td>Width</td>
<td>Integer 32 Variable</td>
<td>4</td>
</tr>
<tr>
<td>Endian Type</td>
<td>Integer 32 Variable</td>
<td>1</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Integer 32 Variable</td>
<td>Result</td>
</tr>
</tbody>
</table>
OptoScript Example: \texttt{PackInt64IntoString(From Value, To String, Start Index, Width, Endian Type)}

\texttt{Result = PackInt64IntoString(3, sPack, 1, 4, 1);}

This is a function command; it returns a zero (indicating success) or an error (indicating failure). The returned value can be consumed by a variable (as shown in the example) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the \textit{PAC Control User's Guide} (form 1700).

Notes: To unpack data from a string that has been packed with various types of data, see “Unpack String” on page 654.

Status Codes:
0 = success  
-3 = Invalid length.  
-6 = Invalid data field.  
-8 = Invalid data.  
-13 = Overflow.  
-23 = String too short.

See Also: “Get HART Unique Address” on page 32  
“Receive HART Response” on page 38  
“Send/Receive HART Command” on page 40  
“Send/Receive HART Command” on page 40  
“Pack Float into String” on page 639  
“Pack Integer 32 into String” on page 641  
“Pack String into String” on page 645  
“Unpack String” on page 654
Pack String into String

String Action

**Function:**
Packs a string value into another string.

*NOTE: This command is designed to create HART argument strings, but it can also be used to pack a string into a single string along with other types of data.*

**Typical Use:**
To pack a string into another string that is packed with other types of data to be sent in a single send rather a series of sends.

**Details:**
The arguments are:

- **From Value**: Value to pack into string.
- **To String**: Destination string.
- **Start Index**: Index where the value should be placed in the string.
  - If you specify the index, (and the string is long enough), it will pack the data at the requested location. The string must already contain enough characters; the packed data replaces whatever characters are already there.
  - If you specify -1 as the index, the value is packed and appended to the end of the string.
- **Width**: The number of bytes the string should occupy.
- **Data Type**: String data type.
  - 5 - HART-encoded date. 24 bits, MS byte = day, followed by 1-byte month and 1-byte year = current year minus 1900. You give it a date between Jan 1, 1900 and Dec 31, 2155 and it does the conversion for you. The same goes for time: Give it hours, minutes, seconds, and so forth, and it does the math.
  - 6 - HART time (32 bits - Time elapsed since midnight, in 1/32 mSec increments)
  - 7 - Packed ASCII string (6-bit chars packed into 8-bit string, reduces size by 25%)
  - 8 - ASCII string (8-bit characters, simply copies source to destination at specified index and width)
  - 9 - Hex as two-character ASCII (for example, FF, 3E, and so forth.)
- **Put Result in**: Indicates success or failure of the operation.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Value</td>
<td>To String</td>
<td>Start Index</td>
</tr>
<tr>
<td>String Literal</td>
<td>String Variable</td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td>String Variable</td>
<td>String Variable</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Argument 3</th>
<th>Argument 4</th>
<th>Argument 5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width</td>
<td>Data Type</td>
<td>Put Result in</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
<td></td>
</tr>
</tbody>
</table>

**Action Block Example:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Value</td>
<td>String Literal</td>
<td>3</td>
</tr>
<tr>
<td>To String</td>
<td>String Variable</td>
<td>sPack</td>
</tr>
<tr>
<td>Start Index</td>
<td>Integer 32 Variable</td>
<td>1</td>
</tr>
<tr>
<td>Width</td>
<td>Integer 32 Variable</td>
<td>4</td>
</tr>
<tr>
<td>Data Type</td>
<td>Integer 32 Variable</td>
<td>1</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Integer 32 Variable</td>
<td>Result</td>
</tr>
</tbody>
</table>
OptoScript Example: \textbf{PackStringIntoString (From Value, To String, Start Index, Width, Data Type)}

Result = PackStringIntoString(3, sPack, 1, 4, 5);

This is a function command; it returns a zero (indicating success) or an error (indicating failure). The returned value can be consumed by a variable (as shown in the example) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the \textit{PAC Control User's Guide} (form 1700).

Notes: To unpack data from a string that has been packed with various types of data, see "Unpack String" on page 654.

Status Codes:

- 0 = success
- -3 = Invalid length.
- -6 = Invalid data field.
- -8 = Invalid data.
- -13 = Overflow.
- -23 = String too short.

See Also:
- "Get HART Unique Address" on page 32
- "Receive HART Response" on page 38
- "Send/Receive HART Command" on page 40
- "Send/Receive HART Command" on page 40
- "Pack Float into String" on page 639
- "Pack Integer 32 into String" on page 641
- "Pack Integer 64 into String" on page 643
- "Unpack String" on page 654
Set Nth Character

String Action

**Function:** Changes a character within a string.

**Typical Use:** When building communication strings prior to sending.

**Details:**
- The character can be written to any position from 0 up to the current string length minus one.
- Valid range for the character is 0–255.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
<th>Argument 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>To</td>
<td>In String</td>
<td>At Index</td>
<td>Put Status In</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>String Variable</td>
<td>Integer 32 Literal</td>
<td>Float Variable</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td></td>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

**Action Block Example:**

```
Set Nth Character
```

- **Name**
  - To
  - In String
  - At Index
  - Put Status In

- **Type**
  - Integer 32 Literal
  - String Variable
  - Integer 32 Literal
  - Integer 32 Variable

- **Name**
  - 62
  - MSG_RECEIVED
  - POSITION
  - STATUS

**OptoScript Example:**

```
SetNthCharacter(To, In String, At Index)
```

```OptoScript
STATUS = SetNthCharacter(62, MSG_RECEIVED, POSITION);
```

This is a function command; it returns one of the status codes listed below.

**Notes:**
- A status of zero indicates success.
- The string could initially be filled with nulls or spaces up to its declared width to avoid null string errors.

**Status Codes:**

<table>
<thead>
<tr>
<th>Status Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Success</td>
</tr>
<tr>
<td>-42</td>
<td>Invalid index value. The index was negative or greater than the string length, or the character value is outside the range 0-255.</td>
</tr>
<tr>
<td>-45</td>
<td>null/empty string. The string being written to is empty.</td>
</tr>
</tbody>
</table>

**See Also:**
- “Find Character in String” on page 621
- “Get Nth Character” on page 630
String Equal to String Table Element?

String Condition

**Function:**
To compare two strings for equality.

**Typical Use:**
To check passwords or barcodes for an exact match with an entry in a string table.

**Details:**
- Determines if the value of *Is* (Argument 0) is equal to the value defined by *At Index* (Argument 1) and *Of Table* (Argument 2).
  - If the strings are exactly the same, the logic will take the True path.
  - If the strings are not exactly the same, the logic will take the False path.
- This test is case-sensitive. For example, a “T” does not equal a “t.”
- Only an exact match on all characters (including leading or trailing spaces) will return a True.
- Quotes (“") are used in OptoScript code, but not in standard PAC Control code.
- A valid range for *At Index* (Argument 1) is 0 (zero) to the table length (that is, the table size).
- Functionally equivalent to the Test Equal Strings action.

**Examples:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Value at Of Table[At Index]</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Is</em></td>
<td>“OPTO”</td>
<td>True</td>
</tr>
<tr>
<td>“22”</td>
<td>“22”</td>
<td>True</td>
</tr>
<tr>
<td>“OPTO”</td>
<td>“Opto”</td>
<td>False</td>
</tr>
<tr>
<td>“2 2”</td>
<td>“22”</td>
<td>False</td>
</tr>
</tbody>
</table>

**Arguments:**
- **Argument 0**
  - Is
  - String Literal
  - String Variable
- **Argument 1**
  - At Index
  - Integer 32 Literal
  - Integer 32 Variable
- **Argument 2**
  - Of Table
  - String Table

**Condition Block Example:**
The following example compares a new barcode to a string in a string table. This could be done in a loop to see if the new barcode exists in a table.

```
if (NEW_BARCODE == Current_Products[Loop_Index]) then
```

**OptoScript Example:**
OptoScript doesn’t use a command; the function is built in. Use the `==` operator.

```
if (NEW_BARCODE == Current_Products[Loop_Index]) then
```

**Notes:**
- The example shown is only one way to use the `==` operator. For more information on using comparison operators and strings in OptoScript code, see the PAC Control User’s Guide (form 1700).

**Queue Errors:**
-12 = Invalid table index value. Index was negative or greater than or equal to the table size.
See Also: “Test Equal Strings” on page 651
“String Equal?” on page 650
String Equal?

**String Condition**

**Function:** To compare two strings for equality.

**Typical Use:** To check passwords or barcodes for an exact match.

**Details:**
- Determines if strings in *Is* (Argument 0) and *To* (Argument 1) are equal.
  - If the strings are exactly the same, the logic will take the True path.
  - If the strings are not exactly the same, the logic will take the False path.
- This test is case-sensitive. For example, a “T” does not equal a “t.”
- Only an exact match on all characters (including leading or trailing spaces) will return a True.
- Quotes (“”) are used in OptoScript code, but not in standard PAC Control code.
- Functionally equivalent to the Test Equal Strings action.

**Examples:**

<table>
<thead>
<tr>
<th><em>Is</em></th>
<th><em>To</em></th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>“OPTO”</td>
<td>“OPTO”</td>
<td>True</td>
</tr>
<tr>
<td>“22”</td>
<td>“22”</td>
<td>True</td>
</tr>
<tr>
<td>“OPTO”</td>
<td>“Opto”</td>
<td>False</td>
</tr>
<tr>
<td>“2 2”</td>
<td>“22”</td>
<td>False</td>
</tr>
</tbody>
</table>

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Is</em></td>
<td><em>To</em></td>
</tr>
<tr>
<td>String Literal</td>
<td>String Literal</td>
</tr>
<tr>
<td>String Variable</td>
<td>String Variable</td>
</tr>
</tbody>
</table>

**Condition Block Example:**

<table>
<thead>
<tr>
<th>String Equal?</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Is</em></td>
<td>String Variable</td>
<td>NEW_ENTRY</td>
</tr>
<tr>
<td><em>To</em></td>
<td>String Variable</td>
<td>PASSWORD</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```plaintext
if (NEW_ENTRY == PASSWORD) then
```

**Notes:**
- The example shown is only one way to use the `==` operator. For more information on using comparison operators and strings in OptoScript code, see the *PAC Control User’s Guide* (form 1700).
- Use String Equal to String Table Element? to compare with strings in a table.

**See Also:**
- “Test Equal Strings” on page 651
- “String Equal to String Table Element?” on page 648
Test Equal Strings

String Action

**Function:** To compare two strings for equality.

**Typical Use:** To check passwords or barcodes for an exact match.

**Details:**
- Determines if *Compare* (Argument 0) and *With* (Argument 1) are equal, and stores the result in *Put Result in* (Argument 2).
  - If the strings are exactly the same, the result will be a non-zero value (meaning True).
  - If the strings are not exactly the same, the result will be 0 (zero, meaning False).
- NOTE: In programming logic, 0 represents False and any non-zero number represents True.
- This test is case-sensitive. For example, a “T” does not equal a “t.”
- Only an exact match on all characters (including leading or trailing spaces) will return a True.
- Quotes (" ") are used in OptoScript code, but not in standard PAC Control code.
- The result can be sent directly to a digital output if desired.
- This action is functionally equivalent to the String Equal? condition.

**Examples:**

<table>
<thead>
<tr>
<th>Compare</th>
<th>With</th>
<th>Put Result in</th>
</tr>
</thead>
<tbody>
<tr>
<td>OPTO</td>
<td>OPTO</td>
<td>1</td>
</tr>
<tr>
<td>22</td>
<td>22</td>
<td>1</td>
</tr>
<tr>
<td>OPTO</td>
<td>Opto</td>
<td>0</td>
</tr>
<tr>
<td>2 2</td>
<td>22</td>
<td>0</td>
</tr>
</tbody>
</table>

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compare</td>
<td>With</td>
<td>Put Result in</td>
</tr>
<tr>
<td>String Literal</td>
<td>String Literal</td>
<td>Digital Output</td>
</tr>
<tr>
<td>String Variable</td>
<td>String Variable</td>
<td>Float Variable</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

**Action Block Example:**
The following example compares a password variable to a string constant. The resulting value in IS_AUTHORIZED could be used at several points in the program to determine if the user has sufficient authorization.

The following example compares a barcode to a string retrieved from a string table. This instruction would be located in a loop that retrieves each entry from a string table and performs this comparison.
Test Equal Strings

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compare</td>
<td>String Variable</td>
<td>BARCODE</td>
</tr>
<tr>
<td>With</td>
<td>String Variable</td>
<td>BARCODE_FROM_LIST</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Integer 32 Variable</td>
<td>IS_IN_LIST</td>
</tr>
</tbody>
</table>

OptoScript Example:

For an OptoScript equivalent, see the String Equal? command.

Notes:
- Use String Equal to String Table Element? to compare with strings in a table.

See Also:
- “Compare Strings” on page 600
- “String Equal?” on page 650
- “String Equal to String Table Element?” on page 648
Trim String

String Action

**Function:** Trims spaces at the ends of a text string.

**Typical Use:** Use this command to trim the beginning or the ending spaces of a text string, or both.

**Details:** For Option (Argument 1), the possible values are:

1 = Trims leading spaces only
2 = Trims trailing spaces only
3 = Trims both leading and trailing spaces

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>Option</td>
</tr>
<tr>
<td>String Variable</td>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td>String Variable</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

**Action Block Example:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>String Table</td>
<td>MyTextString</td>
</tr>
<tr>
<td>Option</td>
<td>Integer 32 Variable</td>
<td>3</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```
TrimString(String, Option)
```

```
TrimString( MyTextString, 3 );
```

This is a function command; it returns a status code as shown below.

**Notes:**
- If result = 0, the spaces at the ends of the string were trimmed successfully.
- If result < 0, there was an error executing this command.

**See Also:**
- “Append Character to String” on page 597
- “Append String to String” on page 599
**Unpack String**

### String Action

**Function:** Unpacks various types of data from a string that has been packed.

*NOTE: This command is designed to unpack HART argument strings, but it can also be used to unpack various other types of data.*

**Typical Use:** To unpack data back to their original types from a string that was packed with multiple data types.

**Details:** The arguments are:

- **From String:** String to unpack.
- **Start Index:** Index where the value should be retrieved from the string.
- **Width:** The number of bytes the value occupies in the string. When unpacking data from a string, some types imply the number of bytes. For those types, the width will be ignored.
- **To Value:** Destination variable.
- **Data Type:** Use one of the following types:
  - 0 – Auto (type is determined by the destination variable)
  - 1 – Integer 32 Variable
  - 2 – Integer 64 Variable
  - 3 – Float 32
  - 4 – (Reserved for future use)
  - 5 – HART-Encoded Date. For From String (Argument 0), enter the date using numeric format, for example “3/3/14”. It will be converted automatically to the HART format.
  - 6 – HART-Encoded Time. For From String (Argument 0), enter the time military time, for example, “14:27:32”. It will be converted automatically to the HART format.
  - 7 – Packed ASCII Data (6-bit chars packed into 8-bit string, reduces size by 25%)  
  - 8 – String (8-bit chars, simply copies source to destination at specified index and width)
  - 9 – ASCII Hex (as two-char ASCII, e.g. FF, 3E, and so forth.)

- **Endian Type**: The following Endian type examples use 0x12345678 as the source value:
  - 0 - Big Endian (0x12 0x34 0x56 0x78)
  - 1 - Little Endian (0x78 0x56 0x34 0x12)
  - 2 - Modbus Big Endian (0x12 0x34 0x56 0x78)
  - 3 - Modbus Little-Endian (0x56 0x78 0x12 0x34)

- **Put Result in:** Indicates success or failure of the operation.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
<th>Argument 3</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>From String</strong></td>
<td><strong>Start Index</strong></td>
<td><strong>Width</strong></td>
<td><strong>To Value</strong></td>
</tr>
<tr>
<td>String Variable</td>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td></td>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
<td>String Variable</td>
</tr>
</tbody>
</table>

---

### Examples:

- Date – 3 bytes
- Time – 4 bytes
- Single-precision floats, (the only type we currently support) - 4 bytes
- To Value: Destination variable.
CHAPTER 20: STRING COMMANDS

Unpack String

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>From String</td>
<td>String Variable</td>
<td>sString</td>
</tr>
<tr>
<td>Start Index</td>
<td>Integer 32 Variable</td>
<td>1</td>
</tr>
<tr>
<td>Width</td>
<td>Integer 32 Variable</td>
<td>4</td>
</tr>
<tr>
<td>To Value</td>
<td>Integer 32 Variable</td>
<td>nValue</td>
</tr>
<tr>
<td>Data Type</td>
<td>Integer 32 Variable</td>
<td>0</td>
</tr>
<tr>
<td>Endian Type</td>
<td>Integer 32 Variable</td>
<td>0</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Integer 32 Variable</td>
<td>Result</td>
</tr>
</tbody>
</table>

OptoScript Example:

```plaintext
UnpackString(From String, Start Index, Width, To Value, Data Type, Endian Type)
Result = UnpackString(sString, 1, 4, nValue, 0, 0);
```

This is a function command; it returns a zero (indicating success) or an error (indicating failure). The returned value can be consumed by a variable (as shown in the example) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

Status Codes:

- 0 = success
- -3 = Invalid length.
- -6 = Invalid data field.
- -8 = Invalid data.
- -12 = Invalid index.
- -13 = Overflow.
- -23 = String too short.
- -29 = Wrong object type.

See Also:

- “Get HART Unique Address” on page 32
- “Receive HART Response” on page 38
- “Send/Receive HART Command” on page 40
- “Send/Receive HART Command” on page 40
- “Pack Float into String” on page 639
- “Pack Integer 32 into String” on page 641
- “Pack Integer 64 into String” on page 643
- “Pack String into String” on page 645
Verify Checksum on String

Function: To check the validity of a received message.

Typical Use: Ensuring the integrity of the data in a message prior to using it.

Details:
- Checksum type is eight-bit.
- The Start Value is also known as the "seed." It is usually zero.
- All characters except the last byte are included in the verification.
- The last byte must be the checksum.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Value</td>
<td>On String</td>
<td>Put Status in</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>String Literal</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>String Variable</td>
<td></td>
</tr>
</tbody>
</table>

Action Block Example:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Value</td>
<td>Integer 32 Literal</td>
<td>0</td>
</tr>
<tr>
<td>On String</td>
<td>String Variable</td>
<td>RESPONSE_MSG</td>
</tr>
<tr>
<td>Put Status In</td>
<td>Integer 32 Variable</td>
<td>CKSUM_STATUS</td>
</tr>
</tbody>
</table>

OptoScript Example:

```optoscript
VerifyChecksumOnString(Start Value, On String)
CKSUM_STATUS = VerifyChecksumOnString(0, RESPONSE_MSG);
```

This is a function command; it returns one of the status codes listed below.

Status Codes:
- 0 = No error; valid checksum.
- -2 = Invalid checksum; checksum verification failed.
- -44 = String too short or string was empty.

Notes: The checksum used by this command is an 8-bit (one byte) value. The method used to calculate the checksum is:

1. Take the numerical sum of the ASCII numerical representation of each character in the string.
2. Divide the result by 256.
3. The integer remainder is the 8-bit checksum.

See Also: "Generate Checksum on String" on page 624
Verify Forward CCITT on String

String Action

Function:  To check the validity of a received message.

Typical Use:  Ensuring the integrity of the data in a message prior to using it.

Details:  
- CRC type is 16-bit forward CCITT.
- The Start Value is also known as the “seed.” It is usually zero or -1.
- All characters except the last two are included in the verification.
- The last two characters must be the CRC.

Arguments:  

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Value</td>
<td>On String</td>
<td>Put Status In</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>String Literal</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>String Variable</td>
<td></td>
</tr>
</tbody>
</table>

Action Block Example:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Value</td>
<td>Integer 32 Literal</td>
<td>-1</td>
</tr>
<tr>
<td>On String</td>
<td>String Variable</td>
<td>RESPONSE_MSG</td>
</tr>
<tr>
<td>Put Status In</td>
<td>Integer 32 Variable</td>
<td>CRC_STATUS</td>
</tr>
</tbody>
</table>

OptoScript Example:  

```
VerifyForwardCcittOnString(Start Value, On String)
```

CRC_STATUS = VerifyForwardCcittOnString(-1, RESPONSE_MSG);

This is a function command; it returns one of the status codes listed below.

Status Codes:
- 0 = No error; valid checksum.
- -2 = Invalid checksum; checksum verification failed.
- -44 = String too short or string was empty.

See Also:  
- "Verify Reverse CCITT on String" on page 659
- "Generate Forward CCITT on String" on page 626
Verify Forward CRC-16 on String

String Action

Function: To check the validity of a received message.

Typical Use: Ensuring the integrity of the data in a message prior to using it.

Details:
- CRC type is 16-bit forward.
- The Start Value is also known as the “seed.” It is usually zero or -1.
- All characters except the last two are included in the verification.
- The last two characters must be the CRC.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Value</td>
<td>On String</td>
<td>Put Status in</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>String Literal</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Action Block Example:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Value</td>
<td>Integer 32 Literal</td>
<td>-1</td>
</tr>
<tr>
<td>On String</td>
<td>String Variable</td>
<td>RESPONSE_VSS</td>
</tr>
<tr>
<td>Put Status In</td>
<td>Integer 32 Variable</td>
<td>CRC_STATUS</td>
</tr>
</tbody>
</table>

OptoScript Example:

```
VerifyForwardCrc16OnString(Start Value, On String)
CRC_STATUS = VerifyForwardCrc16OnString(-1, RESPONSE_VSS);
```

This is a function command; it returns one of the status codes listed below.

Status Codes:
- 0 = No error; valid checksum.
- -2 = Invalid checksum; checksum verification failed.
- -44 = String too short or string was empty.

See Also:  
- “Verify Reverse CRC-16 on String” on page 660
- “Generate Forward CRC-16 on String” on page 627
Verify Reverse CCITT on String

**String Action**

**Function:** To check the validity of a received message.

**Typical Use:** Ensuring the integrity of the data in a message prior to using it.

**Details:**
- CRC type is 16-bit reverse CCITT.
- The *Start Value* is also known as the "seed." It is usually zero or -1.
- All characters except the last two are included in the verification.
- The last two characters must be the CRC.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Start Value</strong></td>
<td><strong>On String</strong></td>
<td><strong>Put Status in</strong></td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>String Literal</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>String Variable</td>
<td></td>
</tr>
</tbody>
</table>

**Action Block Example:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Value</td>
<td>Integer 32 Literal</td>
<td>-1</td>
</tr>
<tr>
<td>On String</td>
<td>String Variable</td>
<td>RESPONSE_MSG</td>
</tr>
<tr>
<td>Put Status In</td>
<td>Integer 32 Variable</td>
<td>CRC_STATUS</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```
CRC_STATUS = VerifyReverseCcittOnString(-1, RESPONSE_MSG);
```

This is a function command; it returns one of the status codes listed below.

**Status Codes:**
- 0 = No error; valid checksum.
- -2 = Invalid checksum; checksum verification failed.
- -44 = String too short or string was empty.

**See Also:**
- "Verify Forward CCITT on String" on page 657
- "Generate Reverse CCITT on String" on page 628
Verify Reverse CRC-16 on String

Function: To check the validity of a received message.

Typical Use: Ensuring the integrity of the data in a message prior to using it.

Details:
- CRC type is 16-bit reverse.
- The Start Value is also known as the "seed." It is usually zero or -1.
- All characters except the last two are included in the verification.
- The last two characters must be the CRC.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Value</td>
<td>On String</td>
<td>Put Status in</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>String Literal</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>String Variable</td>
<td></td>
</tr>
</tbody>
</table>

Action Block Example:

```
VerifyReverseCrc16OnString(Start Value, On String)
```

```
CRC_STATUS = VerifyReverseCrc16OnString(-1, RESPONSE_MSG);
```

This is a function command; it returns one of the status codes listed below.

Status Codes:
- 0 = No error; valid checksum.
- -2 = Invalid checksum; checksum verification failed.
- -44 = String too short or string was empty.

See Also:
- "Verify Forward CRC-16 on String" on page 658
- "Generate Reverse CRC-16 on String" on page 629
Convert Date & Time to NTP Timestamp

**Time/Date Action**

**Function:**
To take the date and time from an Integer 32 table and convert it to a 64-bit Network Time Protocol (NTP) time stamp, without applying any offset for the time zone in which the controller is located.

*NOTE:* If you are using a SoftPAC controller, we recommend that you allow Windows to handle the clock, even though this can cause this command to not work as expected. See also the notes for "Set Time Zone Configuration" on page 687 and "Synchronize Clock SNTP" on page 690.

**Typical Use:**
Comparing two times using a simple numerical standard. Useful for security logs or any application requiring the NTP standard.

**Details:**
- The table must have at least eight elements which are used as follows: 0 = month, 1 = day of the month, 2 = year, 3 = day of the week, 4 = hours, 5 = minutes, 6 = seconds, 7 = milliseconds. (Day of week can be set to zero.)
- Valid dates are January 1, 2001 through December 31, 2135. You must determine that the values passed are valid.

**Arguments:**
- **Date & Time** Integer 32 Table
- **NTP Timestamp** Integer 64 Variable
- **Put Result in** Integer 32 Variable

**Action Block Example:**

```
Convert Date & Time to NTP Timestamp
```

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date &amp; Time</td>
<td>Integer 32 Table</td>
<td>DateTimeIntTbl</td>
</tr>
<tr>
<td>NTP Timestamp</td>
<td>Integer 64 Variable</td>
<td>Current_NTP_Timestamp</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Integer 32 Variable</td>
<td>nResult</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```
DateTimeToNtpTimestamp (Date&Time, NTP Timestamp)
nResult = DateTimeToNtpTimestamp (DateTimeIntTbl, Current_NTP_Timestamp);
```

This is a function command; it returns the NTP timestamp. The returned value can be consumed by a variable (as shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the *PAC Control User’s Guide* (form 1700).

**Notes:**
- If result = 0, the date and time were retrieved successfully.
- If result < 0, there was an error executing this command.
Status Codes:  
0 = Success  
-3 = Buffer overrun or invalid length. The table must consist of at least eight elements. (See Details above.)  
-69 = Null object passed to command.  

See Also:  "Convert NTP Timestamp to Date & Time" on page 663
Convert NTP Timestamp to Date & Time

**Time/Date Action**

**Function:**
To take a Network Time Protocol (NTP) time stamp, convert it to the date and time without applying any offset for the time zone in which the controller is located, and then place the date and time in an Integer 32 table.

*NOTE:* If you are using a SoftPAC controller, we recommend that you allow Windows to handle the clock, even though this can cause this command to not work as expected. See also the notes for “Set Time Zone Configuration” on page 687 and “Synchronize Clock SNTP” on page 690.

**Typical Use:** Security logs or any other use requiring the NTP standard

**Details:**
- The target table must have at least eight elements, which are used as follows: 0 = month, 1 = day of the month, 2 = year, 3 = day of the week, 4 = hours, 5 = minutes, 6 = seconds, 7 = milliseconds.
- Valid dates are January 1, 2001 through December 31, 2135.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date &amp; Time</td>
<td>Integer 32 Table</td>
<td>DateTimeIntTbl</td>
</tr>
<tr>
<td>NTP Timestamp</td>
<td>Integer 64 Variable</td>
<td>Current_NTP_Timestamp</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Integer 32 Variable</td>
<td>nResult</td>
</tr>
</tbody>
</table>

**Action Block Example:**

```plaintext
Convert NTP Timestamp to Date & Time

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date &amp; Time</td>
<td>Integer 32 Table</td>
<td>DateTimeIntTbl</td>
</tr>
<tr>
<td>NTP Timestamp</td>
<td>Integer 64 Variable</td>
<td>Current_NTP_Timestamp</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Integer 32 Variable</td>
<td>nResult</td>
</tr>
</tbody>
</table>
```

**OptoScript Example:**

```plaintext
NtpTimeStampToDateTIme(Date&Time, NTP Timestamp)

nResult = NtpTimestampToDateTIme(DateTimeIntTbl, Current_NTP_Timestamp);
```

This is a function command; it returns the date and time. The returned value can be consumed by a variable (as shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the [PAC Control User's Guide](form 1700).

**Notes:**
- If result = 0, the date and time were retrieved successfully.
- If result < 0, there was an error executing this command.

**Status Codes:**
- 0 = Success
- -3 = Buffer overrun or invalid length. The table must consist of at least eight elements. (See Details above.)
- -69 = Null object passed to command.

**See Also:** “Convert Date & Time to NTP Timestamp” on page 661
Copy Date to String (DD/MM/YYYY)

Time/Date Action

**Function:**
To read the date from the control engine’s real-time clock/calendar and put it into a string variable in the standard European format dd/mm/yyyy, where dd = day (01–31), mm = month (01–12), and yyyy = year (2000–2099).

**Typical Use:**
To date stamp an event in a PAC Control program.

**Details:**
- If the current date is March 1, 2002, this action would use the string “01/03/2002” as To (Argument 0).
- The destination string should have a minimum width of ten.

**Arguments:**
- **Argument 0**
  - **To**
    - String Variable

**Action Block Example:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>To</td>
<td>String Variable</td>
<td>DATE_STRING</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```
DateToStringDDMMYYYY (To)  
DateToStringDDMMYYYY (DATE_STRING);
```

This is a procedure command; it does not return a value.

**Notes:**
- This is a one-time read of the date. If the date changes, you will need to execute the command again to get the current date.
- If the destination string is too short, none of the source string is copied.

**Queue Error:**
-44 = String too short.

**See Also:**
- “Copy Date to String (MM/DD/YYYY)” on page 665
- “Copy Time to String” on page 666
- “Set Date” on page 680
- “Set Time” on page 686
Copy Date to String (MM/DD/YYYY)

**Time/Date Action**

**Function:** To read the date from the control engine’s real-time clock/calendar and put it into a string variable in the standard United States format mm/dd/yyyy, where mm = month (01–12), dd = day (01–31), and yyyy = year (2000-2099).

**Typical Use:** To date stamp an event in a PAC Control program.

**Details:**
- If the current date is March 1, 2002, this action would use the string “03/01/2002” as To (Argument 0).
- The destination string should have a minimum width of ten.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>To</td>
<td>String Variable</td>
<td>DATE_STRING</td>
</tr>
</tbody>
</table>

**Action Block Example:**

```
Copy Date to String (MM/DD/YYYY)
```

**OptoScript Example:**

```
DateStringMMDDYYYY (To)
```

```
DateStringMMDDYYYY (DATE_STRING);
```

This is a procedure command; it does not return a value.

**Notes:** This is a one-time read of the date. If the date changes, you will need to execute the command again to get the current date.

**Queue Error:** -44 = String too short.

**See Also:**
- “Copy Date to String (DD/MM/YYYY)” on page 664
- “Copy Time to String” on page 666
- “Set Date” on page 680
- “Set Time” on page 686
Copy Time to String

Time/Date Action

Function: To read the time from the control engine’s real-time clock/calendar and put it into a string variable in the format hh:mm:ss, where hh = hours (00–23), mm = minutes (00–59), and ss = seconds (00–59).

Typical Use: To time stamp an event in a PAC Control program.

Details:
- Time is in 24-hour format. For example, 8 a.m. = 08:00:00, 1 p.m. = 13:00:00, and 11:59:00 p.m. = 23:59:00.
- If the current time is 2:35 p.m., this action would use the string “14:35:00” as To (Argument 0).
- The destination string should have a minimum width of eight.

Arguments:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>To</td>
<td>String Variable</td>
<td>TIME_STRING</td>
</tr>
</tbody>
</table>

Action Block Example:

<table>
<thead>
<tr>
<th>Copy Time to String</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argument Name</td>
</tr>
<tr>
<td>To</td>
</tr>
<tr>
<td>Type</td>
</tr>
<tr>
<td>String Variable</td>
</tr>
<tr>
<td>Name</td>
</tr>
<tr>
<td>TIME_STRING</td>
</tr>
</tbody>
</table>

OptoScript Example:

```optoscript
TimeToString('To')
TimeToString(TIME_STRING);
```

This is a procedure command; it does not return a value.

Notes:
- This is a one-time read of the time. If the time changes, you will need to execute the command again to get the current time.
- Put this command in a small program loop that executes frequently to ensure that the string always contains the current time.

Queue Error: -44 = String too short.

See Also:
- “Copy Date to String (MM/DD/YYYY)” on page 665
- “Copy Date to String (MM/DD/YYYY)” on page 665
- “Set Date” on page 680
- “Set Time” on page 686
Get Date & Time

Time/Date Action

**Function:** To read the date and time from a control engine's real-time clock/calendar atomically (in a single transaction) and put each element an integer table.

**Typical Use:** This command assures that the date and time are retrieved on the same date.

**Details:**
- Reading the date and time separately could result in the following situation:
  At 11:59:59 PM, a system operator reads the date—for example, April 1, 2011. Next, the operator reads the time, which now reads 00:00:02. The operator then stores the date and time, which reads as April 1, 2011 at 00:00:02. However, the actual date is now April 2, so the timestamp is a complete day behind. This error can also occur if you read the time first; reading atomically (in a single transaction) ensures you get a snapshot of the exact date and time you asked for.
- The table must have at least eight elements which are used as follows: 0 = month, 1 = day of the month, 2 = year, 3 = day of the week, 4 = hours, 5 = minutes, 6 = seconds, 7 = milliseconds.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Put Result in</td>
</tr>
<tr>
<td>Integer 32 Table</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

**Action Block Example:**

```
Get DateTime
```

**OptoScript Example:**

```
Get DateTime (Table)

nResult = Get DateTime (DateTimeStrTbl);
```

This is a function command; it returns the number of characters available to be received. The returned value can be consumed by a variable (as shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

**Notes:**
- If result = 0, the date and time were retrieved successfully.
- If result < 0, there was an error executing this command.

**Status Codes:**
- 0 = Success
- -3 = Buffer overrun or invalid length. The table must consist of at least eight elements. (See Details above.)
- -29 = Wrong object type. Must be an Integer 32 Table.

**See Also:**
- “Copy Date to String (DD/MM/YYYY)” on page 664
- “Copy Date to String (MM/DD/YYYY)” on page 665
- “Copy Time to String” on page 666
- “Set Date” on page 680
- “Set Time” on page 686
Get Day

Time/Date Action

Function: To read the day of the month (1 through 31) from the control engine’s real-time clock/calendar and put it into a numeric variable.

Typical Use: To trigger an event in a PAC Control program based on the day of the month.

Details: • The destination variable can be an integer or a float, although an integer is preferred.
• If the current date is March 2, 2002, this action would use the value 2 as Put In (Argument 0).

Arguments: Argument 0
Put in
Float Variable
Integer 32 Variable

Action Block Example:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Put In</td>
<td>Integer 32 Variable</td>
<td>Day_of_Month</td>
</tr>
</tbody>
</table>

OptoScript Example: GetDay()

Day_of_Month = GetDay();

This is a function command; it returns the numerical day of the month. The returned value can be consumed by a variable (as shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

Notes: • This is a one-time read of the day of the month. If the date changes, you will need to execute this command again to get the current day of the month.
• To detect the start of a new day, use Get Day, and put the result into a variable called DAY_OF_MONTH. Do this once in the Powerup chart and then continually in another chart. In this other chart, move DAY_OF_MONTH to LAST_DAY_OF_MONTH just before executing Get Day, then compare DAY_OF_MONTH with LAST_DAY_OF_MONTH using Not Equal? When they are not equal, midnight has just occurred.
• If you need to read more than one element of time from the controller (for example, seconds, minutes, and hours), use “Get Date & Time” on page 667. It’s easier and more accurate than getting individual elements separately.

See Also:
“Get Day of Week” on page 669
“Get Hours” on page 670
“Get Minutes” on page 672
“Get Month” on page 673
“Get Seconds” on page 674
“Get Year” on page 679

“Set Day” on page 681
“Set Hours” on page 682
“Set Minutes” on page 683
“Set Month” on page 684
“Set Seconds” on page 685
“Set Year” on page 689
Get Day of Week

Time/Date Action

Function: To read the number of the day of the week (0 through 6) from the control engine’s real-time clock/calendar and put it into a numeric variable.

Typical Use: To trigger an event in a PAC Control program based on the day of the week.

Details:
- The destination variable can be an integer or a float, although an integer is preferred.
- Days are numbered as follows:
  - 0 = Sunday
  - 1 = Monday
  - 2 = Tuesday
  - 3 = Wednesday
  - 4 = Thursday
  - 5 = Friday
  - 6 = Saturday
- If the current day is a Wednesday, this action would put a 3 in Put In (Argument 0).

Arguments:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argument 0</td>
<td>Put In</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

OptoScript Example: `GetDayOfWeek()`

```
Day_of_Week = GetDayOfWeek();
```

This is a function command; it returns a number indicating the day of the week. The returned value can be consumed by a variable (as shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

Notes:
- This is a one-time read of the day of the week. If the day changes, you will need to execute this command again to get the current day of the week.
- It is advisable to use this action once in the Powerup chart and once after midnight rollover thereafter. See notes for Get Day.
- If you need to read more than one element of time from the controller (for example, seconds, minutes, and hours), use “Get Date & Time” on page 667. It’s easier and more accurate than getting individual elements separately.

See Also:
- “Get Day” on page 668
- “Get Hours” on page 670
- “Get Minutes” on page 672
- “Get Month” on page 673
- “Get Seconds” on page 674
- “Get Year” on page 679
- “Set Day” on page 681
- “Set Hours” on page 682
- “Set Minutes” on page 683
- “Set Month” on page 684
- “Set Seconds” on page 685
- “Set Year” on page 689
Get Hours

Time/Date Action

Function: To read the hour (0 through 23) from the control engine’s real-time clock/calendar and put it into a numeric variable.

Typical Use: To trigger an event in a PAC Control program based on the hour of the day, or to log an event.

Details:
- The destination variable can be an integer or a float, although an integer is preferred.
- Time is in 24-hour format. For example, 8 a.m. = 08:00:00, 1 p.m. = 13:00:00, and 11:59:00 p.m. = 23:59:00.
- If the current time is 2:35 p.m. (14:35:00), this action would use the value 14 for Put In (Argument 0).

Arguments:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Put In</td>
<td>Integer 32 Variable</td>
<td>HOURS</td>
</tr>
</tbody>
</table>

Action Block Example:

```
Get Hours
```

OptoScript Example:

```
GetHours()
HOURS = GetHours();
```

Notes:
- This is a one-time read of the hour. If the hour changes, you will need to execute this command again to get the current hour.
- Put this command in a small program loop that executes frequently to ensure that the variable always contains the current hour.
- If you need to read more than one element of time from the controller (for example, seconds, minutes, and hours), use “Get Date & Time” on page 667. It’s easier and more accurate than getting individual elements separately.

See Also:
- “Get Day” on page 668
- “Get Day of Week” on page 669
- “Get Minutes” on page 672
- “Get Month” on page 673
- “Get Seconds” on page 674
- “Get Year” on page 679
- “Set Day” on page 681
- “Set Hours” on page 682
- “Set Minutes” on page 683
- “Set Month” on page 684
- “Set Seconds” on page 685
- “Set Year” on page 689
Get Julian Day

Time/Date Action

Function: Gets the number of days starting with January 1 up to and including today's date.

Typical Use: Wherever Julian dates are required.

Details: Value returned will be from 1 to 366. For example, January 1 will always be Julian day 1. December 31 will be Julian day 365 (or 366 in a leap year).

Arguments: Argument 0
Put in
Integer 32 Variable

Action Block Example:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Put In</td>
<td>Integer 32 Variable</td>
<td>Todays_Julian_Day</td>
</tr>
</tbody>
</table>

OptoScript Example:

GetJulianDay()

Todays_Julian_Day = GetJulianDay();

This is a function command; it returns the number of the current day, computed since the beginning of the year. The returned value can be consumed by a variable (as shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User's Guide (form 1700).

See Also: “Copy Date to String (MM/DD/YYYY)” on page 665
Get Minutes

Time/Date Action

**Function:** To read the minute (0 through 59) from the control engine’s real-time clock/calendar and put it into a numeric variable.

**Typical Use:** To trigger an event in a PAC Control program based on minutes past the hour, or to log an event.

**Details:**
- The destination variable can be an integer or a float, although an integer is preferred.
- Time is in 24-hour format. For example, 8 a.m. = 08:00:00, 1 p.m. = 13:00:00, and 11:59:00 p.m. = 23:59:00.
- If the current time is 2:35 p.m. (14:35:00), this action would use the value 35 for *Put In* (Argument 0).

**Arguments:**

- **Put in**
  - Float Variable
  - Integer 32 Variable

**Action Block Example:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Put In</td>
<td>Integer 32 Variable</td>
<td>MINUTES</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```optoscript
GetMinutes();
```

This is a function command; it returns the current minute (0 through 59) from the control engine’s real-time clock. The returned value can be consumed by a variable (as shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the *PAC Control User’s Guide* (form 1700).

**Notes:**
- This is a one-time read of the minutes. If the minute changes, you will need to execute this command again to get the current minute value.
- Put this command in a small program loop that executes frequently to ensure that the variable always contains the current minute value.
- If you need to read more than one element of time from the controller (for example, seconds, minutes, and hours), use “Get Date & Time” on page 667. It’s easier and more accurate than getting individual elements separately.

**See Also:**

- “Get Day” on page 668
- “Get Day of Week” on page 669
- “Get Hours” on page 670
- “Get Month” on page 673
- “Get Seconds” on page 674
- “Get Year” on page 679
- “Set Day” on page 681
- “Set Hours” on page 682
- “Set Minutes” on page 683
- “Set Month” on page 684
- “Set Seconds” on page 685
- “Set Year” on page 689
Get Month

Time/Date Action

Function: To read the month value (1 through 12) from the control engine’s real-time clock/calendar and put it into a numeric variable.

Typical Use: To determine when to begin and end Daylight Savings Time.

Details:
- The destination variable can be an integer or a float, although an integer is preferred.
- If the current date is March 2, 2002, this action would use the value 3 for Put In (Argument 0).

Arguments:
- **Argument 0**
  - **Put in**
    - Float Variable
    - Integer 32 Variable

Action Block Example:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Put In</td>
<td>Integer 32 Variable</td>
<td>MONTH</td>
</tr>
</tbody>
</table>

OptoScript Example: `GetMonth();`

MONTH = GetMonth();

This is a function command; it returns a value representing the current month (1 through 12). The returned value can be consumed by a variable (as shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

Notes:
- This is a one-time read of the month. If the month changes, you will need to execute this command again to get the value of the current month.
- Put this command in a small program loop that executes frequently to ensure that the variable always contains the current month value.
- If you need to read more than one element of time from the controller (for example, seconds, minutes, and hours), use “Get Date & Time” on page 667. It’s easier and more accurate than getting individual elements separately.

See Also:
- “Get Day” on page 668
- “Get Day of Week” on page 669
- “Get Hours” on page 670
- “Get Minutes” on page 672
- “Get Seconds” on page 674
- “Get Year” on page 679
- “Set Day” on page 681
- “Set Hours” on page 682
- “Set Minutes” on page 683
- “Set Month” on page 684
- “Set Seconds” on page 685
- “Set Year” on page 689
Get Seconds

**Time/Date Action**

**Function:** To read the seconds (0 through 59) from the control engine’s real-time clock/calendar and put it into a numeric variable.

**Typical Use:** To use seconds information in a PAC Control program.

**Details:**
- The destination variable can be an integer or a float, although an integer is preferred.
- If the current time is 08:51:26, this action would use the value 26 for Put In (Argument 0).

**Arguments:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Put In</td>
<td>Float Variable</td>
<td>SECONDS</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Action Block Example:**

```
Get Seconds
```

**OptoScript Example:**

```OptoScript
GetSeconds();
SECONDS = GetSeconds();
```

This is a function command; it returns the second (0 through 59) from the control engine’s real-time clock. The returned value can be consumed by a variable (as in the example shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

**Notes:**
- This is a one-time read of the second. If the second changes, you will need to execute this command again to get the value of the current second.
- Put this command in a small program loop that executes frequently to ensure that the variable always contains the current seconds value.
- If you need to read more than one element of time from the controller (for example, seconds, minutes, and hours), use “Get Date & Time” on page 667. It’s easier and more accurate than getting individual elements separately.

**See Also:**
- “Get Seconds Since Midnight” on page 675
- “Get Day” on page 668
- “Get Day of Week” on page 669
- “Get Hours” on page 670
- “Get Minutes” on page 672
- “Get Month” on page 673
- “Get Year” on page 679
- “Set Day” on page 681
- “Set Hours” on page 682
- “Set Minutes” on page 683
- “Set Month” on page 684
- “Set Seconds” on page 685
- “Set Year” on page 689
Get Seconds Since Midnight

Time/Date Action

**Function:** Gets the number of seconds since midnight.

**Typical Use:** In place of timers to determine time between events or to time stamp an event with a number rather than a string.

**Details:** Value returned is an integer from 0 to 86,399.

**Arguments:**
- **Argument 0**
  - **Put in**
    - Float Variable
    - Integer 32 Variable

**Action Block Example:**

```
<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Put In</td>
<td>Integer 32 Variable</td>
<td>TIME_IN_SECONDS</td>
</tr>
</tbody>
</table>
```

**Example Results:**

![Image of GetSecondsSinceMidnight result]

**OptoScript Example:**

```
GetSecondsSinceMidnight()
```

This is a function command; it returns the number of seconds since midnight. The returned value can be consumed by a variable (as in the example shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

**Notes:** To find elapsed time in HOURS, MINUTES, SECONDS since midnight using standard commands:

- Move the seconds to an integer 32 variable: TEMP_VAR
- Divide TEMP_VAR by: 3600 and move to: HOURS
- Modulo TEMP_VAR by: 3600 and move to: TEMP_VAR
- Divide TEMP_VAR by: 60 and move to: MINUTES
- Modulo TEMP_VAR by: 60 and move to: SECONDS.

To find the same thing using OptoScript code:

```
TEMP_VAR = GetSecondsSinceMidnight();
HOURS = TEMP_VAR / 3600;
MINUTES = (TEMP_VAR % 3600 / 60;
SECONDS = (TEMP_VAR % 3600) % 60;
```

**See Also:** “Get Seconds” on page 674
Get System Time

Function: Gets the number of seconds since the control engine has been turned on.

Typical Use: Accumulate “up-time.”

Details: Value returned is an integer.

Arguments: Argument 0  
Put in  
Float Variable  
Integer 32 Variable

Action Block Example:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Put In</td>
<td>Integer 32 Variable</td>
<td>TIME_IN SECONDS</td>
</tr>
</tbody>
</table>

OptoScript Example:

```plaintext
GetSystemTime();
TIME_IN SECONDS = GetSystemTime();
```

This is a function command; it returns the number of seconds since the control engine was last turned on. The returned value can be consumed by a variable (as in the example shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

See Also: “Get Seconds Since Midnight” on page 675
Get Time Zone Description

Time/Date Action

Function:  Get one of the controller’s currently-set time zone descriptions as a string.

NOTE: If you are using a SoftPAC controller, we recommend that you allow Windows to handle the clock, even though this can cause this command to not work as expected. See also the notes for “Set Time Zone Configuration” on page 687 and “Synchronize Clock SNTP” on page 690.

Typical Use:  Display the name of the controller’s time zone(s).

Details:  
- Configuration (Argument 0) is an integer that specifies which time zone description should be returned. Valid values for Configuration are:
  0 - Currently-active time zone
  1 - Controller’s first time zone
  2 - Controller’s second time zone
- Description (Argument 1) is a pointer to a string where the description should be placed
- If everything is OK, a string containing the specified time zone description is stored in Put Result in (Argument 2), and the code for success (0) is returned. Otherwise, the string is emptied, and an error code is returned.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration</td>
<td>Description</td>
<td>Put Result in</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>String Variable</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

Action Block Example:

Get Time Zone Description

OptoScript Example:

GetTimeZoneDescription(Configuration, Description)

Time_Zone_Description = GetTimeZoneDescription(0, StrDescription);

This is a function command; it returns the specified time zone description. The returned value can be consumed by a variable (as in the example shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

Notes:  If the destination string is too short, only as much as will fit in the string is copied, and a -23 error code is returned.

Status Codes:  
0 = Success
-6 = Invalid data field. Something other than 0, 1, or 2 was used in Configuration (Argument 0).
-23 = String too short.

See Also:  “Set Time Zone Configuration” on page 687
“Get Minutes” on page 672
“Synchronize Clock SNTP” on page 690
Get Time Zone Offset

Time/Date Action

Function:  Get the offset, in seconds from UTC (Coordinated Universal Time), of one of the controller’s currently-set time zones.

NOTE: If you are using a SoftPAC controller, we recommend that you allow Windows to handle the clock, even though this can cause this command to not work as expected. See also the notes for “Set Time Zone Configuration” on page 687 and “Synchronize Clock SNTP” on page 690.

Typical Use:  Convert between local time and UTC.

Details:
- Configuration (Argument 0) is an integer that specifies which time zone offset should be returned. Valid values for Configuration are:
  - 0 - Currently-active time zone
  - 1 - Controller’s first time zone
  - 2 - Controller’s second time zone
- If everything is OK, the signed offset (in seconds) of the specified time zone from UTC is returned.

Arguments:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration</td>
<td>Integer 32 Literal</td>
<td>0</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Integer 32 Variable</td>
<td>OFFSET</td>
</tr>
</tbody>
</table>

Action Block Example:

```
Get Time Zone Offset
```

OptoScript Example:

```
GetTimeZoneOffset(Configuration)
OFFSET = GetTimeZoneOffset(0);
```

This is a function command; it returns the signed offset, in seconds, of the specified time zone from UTC. The returned value can be consumed by a variable (as shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

Status Codes:

-1 = Error

See Also:
- “Set Time Zone Configuration” on page 687
- “Get Time Zone Description” on page 677
- “Synchronize Clock SNTP” on page 690
**Get Year**

**Time/Date Action**

**Function:** To read the year value (2000 through 2099) from the control engine's real-time clock/calendar and put it into a numeric variable.

**Typical Use:** To use year information in a PAC Control program.

**Details:**
- The destination variable can be an integer or a float, although an integer is preferred.
- If the current date is March 2, 2002, this action would use the value 2002 for *Put In* (Argument 0).

**Arguments:**
- **Argument 0**
  - **Put in**
    - Float Variable
    - Integer 32 Variable

**Action Block Example:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Put in</td>
<td>Integer 32</td>
<td>YEAR</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```plaintext
GetYear();
YEAR = GetYear();
```

This is a function command; it returns the four digits of the year (2000 through 2099). The returned value can be consumed by a variable (as in the example shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the *PAC Control User's Guide* (form 1700).

**Notes:**
- If you need to read more than one element of time from the controller (for example, seconds, minutes, and hours), use “Get Date & Time” on page 667. It's easier and more accurate than getting individual elements separately.
- This is a one-time read of the year. If the year changes, you will need to execute this command again to get the value of the current year.
- Put this command in a small program loop that executes frequently to ensure that the variable always contains the current year value.

**See Also:**

- “Get Day” on page 668
- “Get Day of Week” on page 669
- “Get Hours” on page 670
- “Get Minutes” on page 672
- “Get Month” on page 673
- “Get Seconds” on page 674
- “Get Year” on page 679
- “Set Day” on page 681
- “Set Hours” on page 682
- “Set Minutes” on page 683
- “Set Month” on page 684
- “Set Seconds” on page 685
- “Set Year” on page 689
Set Date

Function: To set the date in the control engine’s real-time clock/calendar to the value contained in a string variable or string literal, using the standard United States format mm/dd/yyyy, where mm = month (01–12), dd = day (01–31), and yyyy = year (2000–2099).

Typical Use: To set the date from a PAC Control program.

Details:
- Uses the standard
- If the desired date to set is March 1, 2002, To (Argument 0) should contain the string “03/01/2002”.
- Executing this command would set the control engine’s real-time clock/calendar to March 1, 2002.
- Updates day of week also.
- All erroneous date strings are ignored.

Arguments:
- Argument 0
  - To
  - String Literal
  - String Variable

Action Block Example:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>To</td>
<td>String Variable</td>
<td>US_DATE_STRING</td>
</tr>
</tbody>
</table>

OptoScript Example:

```
SetDate(To)
SetDate(US_DATE_STRING);
```

This is a procedure command; it does not return a value.

Notes:
- An easier way to update the time and date on the control engine is to click the Sync to PC’s Time/Date button when inspecting the control engine in PAC Control Debug mode or in PAC Terminal.
- To change the date, use an integer variable as a change trigger. Set the trigger variable True after the date string has the desired value. When the trigger is True, the program executes this command, then sets the trigger variable False.
- The control engine’s real-time clock/calendar will automatically increment the time and date after they are set.
- Do not issue this command continuously.

See Also:
- "Copy Date to String (DD/MM/YYYY)" on page 664
- "Copy Date to String (MM/DD/YYYY)" on page 665
- "Copy Time to String" on page 666
Set Day

Time/Date Action

Function: To set the day of the month (1 through 31) in the control engine’s real-time clock/calendar.

Typical Use: To set the day of the month from a PAC Control program.

Details:
- To (Argument 0) can be an integer or a float, although an integer is preferred.
- If the desired day of the month is March 2, 2017, To should be 2.
- Executing this command would then set the day of the month in the control engine’s real-time clock/calendar.
- Updates day of week also.
- All erroneous day values are ignored.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
</tr>
</thead>
<tbody>
<tr>
<td>To</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Float Literal</td>
</tr>
<tr>
<td>Float Variable</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

Action Block Example:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>To</td>
<td>Integer 32 Variable</td>
<td>DAY_OF_MONTH</td>
</tr>
</tbody>
</table>

OptoScript Example:

Set Day (To)

Set Day (DAY_OF_MONTH);

This is a procedure command; it does not return a value.

Note: Do not issue this command continuously.

See Also:

- “Get Day” on page 668
- “Get Day of Week” on page 669
- “Get Hours” on page 670
- “Get Minutes” on page 672
- “Get Month” on page 673
- “Get Seconds” on page 674
- “Get Year” on page 679

- “Set Hours” on page 682
- “Set Minutes” on page 683
- “Set Month” on page 684
- “Set Seconds” on page 685
- “Set Year” on page 689
Set Hours
Time/Date Action

Function: To set the hours value (0 through 23) in the control engine’s real-time clock/calendar.

Typical Use: To set the hours value from a PAC Control program.

Details:
- To (Argument 0) can be an integer or a float, although an integer is preferred.
- Time is in 24-hour format. For example, 8 a.m. = 08:00:00, 1 p.m. = 13:00:00, and 11:59:00 p.m. = 23:59:00.
- If the desired hour is 2 p.m. (14:00:00), To should be 14.
- Executing this command would set the hours value in the control engine’s real-time clock/calendar.
- The control engine’s real-time clock/calendar will automatically increment the time and date after they are set.
- All erroneous hour values are ignored.

Arguments:

Argument 0
- To
- Float Literal
- Float Variable
- Integer 32 Literal
- Integer 32 Variable

Action Block Example:

Set Hours

OptoScript Example:

SetHours (To)

This is a procedure command; it does not return a value.

Note: Do not issue this command continuously.

See Also:

“Get Day” on page 668
“Get Day of Week” on page 669
“Get Hours” on page 670
“Get Minutes” on page 672
“Get Month” on page 673
“Get Seconds” on page 674
“Get Year” on page 679

“Set Day” on page 681
“Set Minutes” on page 683
“Set Month” on page 684
“Set Seconds” on page 685
“Set Year” on page 689
## Set Minutes

**Time/Date Action**

<table>
<thead>
<tr>
<th>Function:</th>
<th>To set the minutes value (0 through 59) in the control engine’s real-time clock/calendar.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Typical Use:</td>
<td>To set the minutes value from a PAC Control program.</td>
</tr>
<tr>
<td>Detail:</td>
<td>• To (Argument 0) can be an integer or a float, although an integer is preferred.</td>
</tr>
<tr>
<td></td>
<td>• Time is in 24-hour format. For example, 8 a.m. = 08:00:00, 1 p.m. = 13:00:00, and 11:59:00 p.m. = 23:59:00.</td>
</tr>
<tr>
<td></td>
<td>• If the desired time is 2:35 p.m. (14:35:00), To should be 35.</td>
</tr>
<tr>
<td></td>
<td>• Executing this command would set the minutes value in the control engine’s real-time clock/calendar.</td>
</tr>
<tr>
<td></td>
<td>• The control engine’s real-time clock/calendar will automatically increment the time and date after they are set.</td>
</tr>
<tr>
<td></td>
<td>• All erroneous values for minutes are ignored.</td>
</tr>
</tbody>
</table>

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
</tr>
</thead>
<tbody>
<tr>
<td>To</td>
</tr>
<tr>
<td>Float Literal</td>
</tr>
<tr>
<td>Float Variable</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

**Action Block Example:**

```
SetMinutes
```

**OptoScript Example:**

```
SetMinutes (MINUTES);
```

**Note:**

This is a procedure command; it does not return a value.

**See Also:**

- “Get Day” on page 668
- “Get Day of Week” on page 669
- “Get Hours” on page 670
- “Get Month” on page 673
- “Get Seconds” on page 674
- “Get Year” on page 679
- “Set Hours” on page 682
- “Set Day” on page 681
- “Set Month” on page 684
- “Set Seconds” on page 685
- “Set Year” on page 689
**Set Month**

**Time/Date Action**

**Function:** To set the month value (1 through 12) in the control engine’s real-time clock/calendar.

**Typical Use:** To set the month from a PAC Control program.

**Details:**
- To (Argument 0) can be an integer or a float, although an integer is preferred.
- If the desired month is March, To should be 3.
- Executing this command would set the month in the control engine’s real-time clock/calendar.
- The control engine’s real-time clock/calendar will automatically increment the time and date after they are set.
- All erroneous month values are ignored.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument 0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Float Literal</td>
</tr>
<tr>
<td>Float Variable</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```pascal
SetMonth(MONTH);
```

This is a procedure command; it does not return a value.

**Note:** Do not issue this command continuously.

**See Also:**
- “Get Day” on page 668
- “Get Day of Week” on page 669
- “Get Hours” on page 670
- “Get Month” on page 673
- “Get Seconds” on page 674
- “Get Year” on page 679
- “Set Hours” on page 682
- “Set Day” on page 681
- “Set Minutes” on page 683
- “Set Seconds” on page 685
- “Set Year” on page 689
Set Seconds

**Time/Date Action**

**Function:** To set the seconds value (0 through 59) in the control engine’s real-time clock/calendar.

**Typical Use:** To set the seconds from a PAC Control program.

**Details:**
- `To` (Argument 0) can be an integer or a float, although an integer is preferred.
- Time is in 24-hour format. For example, 8 a.m. = 08:00:00, 1 p.m. = 13:00:00, and 11:59:00 p.m. = 23:59:00.
- If the desired time is 2:35:26 p.m., then `To` should be 26.
- Executing this command would set the seconds value in the control engine’s real-time clock/calendar.
- The control engine’s real-time clock/calendar will automatically increment the time and date after they are set.
- All erroneous values for seconds are ignored.

**Arguments:**

**Argument 0**
- `To`
  - Float Literal
  - Float Variable
  - Integer 32 Literal
  - Integer 32 Variable

**Action Block Example:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>To</code></td>
<td>Integer 32 Variable</td>
<td>SECONDS</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```opto
SetSeconds (To);
```

This is a procedure command; it does not return a value.

**Note:** Do not issue this command continuously.

**See Also:**
- “Get Day” on page 668
- “Get Day of Week” on page 669
- “Get Hours” on page 670
- “Get Minutes” on page 672
- “Get Month” on page 673
- “Get Seconds” on page 674
- “Get Year” on page 679
- “Set Hours” on page 682
- “Set Day” on page 681
- “Set Minutes” on page 683
- “Set Month” on page 684
- “Set Year” on page 689
Set Time

Time/Date Action

**Function:** To set the time in the control engine’s real-time clock/calendar from a string variable.

**Typical Use:** To set the time from a PAC Control program.

**Details:**
- *From* (Argument 0) can be a constant or string variable, although a string variable is preferred.
- Time is in 24-hour format. For example, 8 a.m. = 08:00:00, 1 p.m. = 13:00:00, and 11:59:00 p.m. = 23:59:00.
- If the desired time is 2:35:00 p.m., *From* should be the string “14:35:00.”
- Executing this command would set the time value in the control engine’s real-time clock/calendar.
- The control engine’s real-time clock/calendar will automatically increment the time and date after they are set.
- All erroneous time strings are ignored.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>To</td>
<td>String Literal</td>
<td></td>
</tr>
<tr>
<td>To</td>
<td>String Variable</td>
<td>TIME_STRING</td>
</tr>
</tbody>
</table>

**Action Block Example:**

Set Time

**OptoScript Example:**

```
SetTime(TIME_STRING);
```

This is a procedure command; it does not return a value.

**Notes:**
- To change the time, use an integer variable as a change trigger. Set the trigger variable True after the time string has the desired value. When the trigger is True, the program executes this command, then sets the trigger variable False.
- The control engine’s real-time clock/calendar will automatically increment the time and date after they are set.
- Do not issue this command continuously.

**See Also:**
- “Copy Date to String (DD/MM/YYYY)” on page 664
- “Copy Date to String (MM/DD/YYYY)” on page 665
- “Copy Time to String” on page 666
- “Set Date” on page 680
Set Time Zone Configuration

Function:  To set the time zone information for the controller to your local time.

NOTE: If you are using a SoftPAC controller, this command is not recommended because it can contend with the Windows built-in clock synchronization functionality. See Notes below.

Typical Use:  To tell the controller the local time zone and when it takes effect, and (if applicable) when Daylight Savings Time takes effect.

Details:
- A string containing time zone data is passed. The existing time zone in the controller is replaced with a time zone code (indicating its deviation from UTC), and its effective month, week, day of week, and time.
- When Synchronize Clock SNTP is also used, use this command first.
- The syntax is:
  With Daylight Savings Time:
  TZ1,Mo1,Day1,Ord1,Time1/TZ2,Mo2,Day2,Ord2,Time2
  Example: PST1,11,0,1,0200/PDT,3,0,2,0200
  Without Daylight Savings Time:
  TZ1,Mo1,Day1,Ord1,Time1
  Example: PST1,11,0,1,0200

where:
- TZ1 is a 3-5 letter abbreviation of the desired time zone
  (For time zone abbreviations, see "C: Time Zone Abbreviations" on page 795.)
- Mo1 is the month the time zone begins, (1-12)
- Day1 is the day of the week the time zone begins, (0-6 = Su-Sa)
- Ord1 is the ordinal of the day the time zone begins, (values must be from 1 to 5, with 5 meaning the last occurrence of the specified day within the month).
- Time1 is the time of day the time zone begins.
- (Optional) The second set of time zone data is used to change back and forth between the first and second time zones (for example, from Standard to Daylight Savings Time).

For example, PST1,11,0,1,0200 means:
  PST1 Pacific Standard Time
  11 November
  0 Sunday
  1 1st Occurrence (in this case, 1st Sunday of a possible 5 Sundays in a month)
  0200 Start time = 2:00AM

The order of the time zones is not important, but the data for each zone must be in the specified order.

- If the command is successful, the passed time zone data is written as specified, and the code for success (0) is returned. Otherwise, a single time zone of UTC is written, and an Invalid String error (-46) is returned.
- This command sets the time zone in the controller’s battery-backed RAM, so it stays set unless the time zone is deliberately changed or cleared, or the battery dies.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration</td>
<td>Put Result in</td>
</tr>
<tr>
<td>String Literal</td>
<td>Integer 32 Variable</td>
</tr>
<tr>
<td>String Variable</td>
<td></td>
</tr>
</tbody>
</table>

Action Block Example:

Set Time Zone Configuration

1 These arguments are required and must be valid values (even if you aren’t using Daylight Savings Time).
CHAPTER 21: TIME/DATE COMMANDS

Example:

SetTimeZoneConfiguration(Configuration)

STATUS = SetTimeZoneConfiguration(StrTimeZone);

Example to set times for Standard and Daylight Saving Time:

STATUS = SetTimeZoneConfiguration("PST7,11,0,1,0200/PDT,3,0,2,0200");

To clear settings that were set previously, pass an empty string:

STATUS = SetTimeZoneConfiguration("");

This is a function command; it returns one of the status codes listed below. The returned value can be consumed by a variable (as in the example shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

Notes:  
- Put this command before Synchronize Clock SNTP when you use it. Otherwise, Synchronize Clock SNTP will set the controller to Coordinated Universal Time.
- If you are using a SoftPAC controller, this command is not recommended. Attempting to use this command without disabling the Windows time handling logic can cause your computer’s clock to malfunction. However, if you understand the risks, you can choose to let SoftPAC handle synchronizing the PC’s clock by using the Synchronize Clock SNTP command. (This is considered an advanced topic that is not covered in this document.)

Status Codes:

0 = Success
-6 = Invalid data field.
-46 = Invalid string.
-606 Redundant Mode Bad. This can be caused by attempting to use this command on a backup redundant controller. This command is only allowed on the active controller.

See Also:  
“Get Minutes” on page 672
“Get Time Zone Description” on page 677
“Synchronize Clock SNTP” on page 690
Set Year

Time/Date Action

Function: To set the year value (2000 through 2099) in the control engine’s real-time clock/calendar.

Typical Use: To set the year from a PAC Control program.

Details:
- To (Argument 0) can be an integer or a float, although an integer is preferred.
- Executing this command would set the year (2000 through 2099) in the control engine’s real-time clock/calendar.
- The control engine’s real-time clock/calendar will automatically increment the time and date after they are set.
- All erroneous year values are ignored.

Arguments:

<table>
<thead>
<tr>
<th>Argument</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>To</td>
<td>Integer 32 Variable</td>
<td>YEAR</td>
</tr>
</tbody>
</table>

Example:

OptoScript Example: `SetYear(To)`

SetYear (YEAR);

This is a procedure command; it does not return a value.

Notes:
- The control engine’s real-time clock/calendar will automatically increment the time and date after they are set.
- Do not issue this command continuously.

See Also:

“Get Day” on page 668
“Get Day of Week” on page 669
“Get Hours” on page 670
“Get Minutes” on page 672
“Get Month” on page 673
“Get Seconds” on page 674
“Get Year” on page 679

“Set Hours” on page 682
“Set Day” on page 681
“Set Minutes” on page 683
“Set Month” on page 684
“Set Seconds” on page 685
Synchronize Clock SNTP

Function: Synchronize the controller’s clock with an external Network Time Protocol (NTP) server.

NOTE: If you are using a SoftPAC controller, this command is not recommended because it can contend with the Windows built-in clock synchronization functionality. See Notes below.

Typical Use: To make sure the controller clock is accurate whenever the command is applied.

Details:
- Server URL (Argument 1) is the URL of the time server you want to use, such as UDP port 123. For example, udp://time.nist.gov:123.
- If everything is OK, the date and time are both set and a 0 (zero—the code for success) is stored in Put Result in (Argument 2). If there is an error, a negative-number status code (listed below) is returned.

Arguments:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Timeout (Seconds)</td>
<td>Float Literal</td>
<td>nTimeout</td>
</tr>
<tr>
<td>Server URL</td>
<td>String Literal</td>
<td>StrServerURL</td>
</tr>
<tr>
<td>Put Result in</td>
<td>Integer 32 Variable</td>
<td>nResult</td>
</tr>
</tbody>
</table>

OptoScript Example:

SynchronizeClockSNTP (Timeout (Seconds), Server URL)

nResult = SynchronizeClockSNTP (nTimeout, StrServerURL);

This is a function command; it sets the date and time with the NTP server and returns the status code for success (0) or one of the other status codes listed below. The returned value can be consumed by a variable (as shown) or used in an item such as a Condition block, an OptoScript block, or a mathematical expression. For more information, see the PAC Control User’s Guide (form 1700).

Notes:
- Normally syncs within one minute.
- Uses SNTP (Simple NTP) to sync the clock.
- If you are using a SoftPAC controller, this command is not recommended. Attempting to use this command without disabling the Windows time handling logic can cause your computer’s clock to malfunction. However, if you understand the risks, you can choose to let SoftPAC handle synchronizing the PC’s clock by using the Synchronize Clock SNTP command. This is considered an advanced topic that is not covered in this document.

Status Codes:
- 0 = Success
- -17 = Port or object is already locked.
- -39 = Receive timeout.
- -46 = Invalid string.
- -47 = Open failed. Handle has already been opened.
- -49 = No more connections are available. Maximum number of connections already in use.
-50 = Open connection timeout. Could not establish connection within the timeout period. Make sure that the controller is configured with a DNS and gateway for the network.

-58 = Character not found.

-443 = Could not receive on socket. The NTP server hasn’t responded within the time configured in Timeout (Seconds) (Argument 0). Try increasing the timeout value or try a different Server URL (in case there’s a problem with the time server pool itself).

-454 = Unable to connect to DNS server. Check the DNS and gateway configuration.

See Also:

“Set Time Zone Configuration” on page 687
“Get Minutes” on page 672
“Get Time Zone Description” on page 677
## 22: Timing Commands

### Continue Timer

**Function:** To continue a paused timer variable.

**Typical Use:** Used with Pause Timer command to track total on/off (up/down, forward/reverse) time.

**Details:** The timer variable must have been paused with the Pause Time command. It continues from the value at which it was paused.

**Arguments:**

- **Argument 0**
  - Timer
    - Down Timer Variable
    - Up Timer Variable

**Action Block Example:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Timer</td>
<td>Down Timer Variable</td>
<td>OVEN_TIMER</td>
</tr>
</tbody>
</table>

**OptoScript Example:**

```
ContinueTimer(Timer)
ContinueTimer(OVEN_TIMER);
```

This is a procedure command; it does not return a value.

**Note:**

- A timer stores elapsed time in units of seconds (with a resolution in milliseconds). Up timers count up from zero; down timers start from a value you set, and then and count down to zero. Timers can range from 0.001 to $4.611686 \times 10^{15}$ seconds.
- If the timer is running, this command has no effect.

**See Also:**

- “Start Off-Pulse” on page 193
- “Stop Timer” on page 702
- “Pause Timer” on page 698
- “Set Down Timer Preset Value” on page 699
- “Set Up Timer Target Value” on page 700
CHAPTER 22: TIMING COMMANDS

Delay (mSec)

Timing Action

Function:  To slow the execution of program logic and to release the remaining time of a chart’s time slice.

Typical Use:  To cause a chart to give up the remaining time of its time slice.

Details:  Units are in milliseconds.

Arguments:  Argument 0

[Value]
Integer 32 Literal
Integer 32 Variable

Action Block Example:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>(none)</td>
<td>Integer 32 Literal</td>
<td>i</td>
</tr>
</tbody>
</table>

OptoScript Example:  DelayMsec(Argument 0)

DelayMsec(1);

This is a procedure command; it does not return a value.

Notes:

- A timer stores elapsed time in units of seconds (with a resolution in milliseconds). Up timers count up from zero; down timers start from a value you set, and then and count down to zero. Timers can range from 0.001 to 4.611686 x 10^15 seconds.
- For readability, use Delay (Sec) for delays longer than 10 seconds.
- When high accuracy is needed, reduce the number of charts running concurrently.
- If you use a delay of zero, PAC Control will ignore the delay command.

Queue Errors:  -8 = Value less than zero.

See Also:

“Delay (Sec)” on page 695
“Start Off-Pulse” on page 193
“Stop Timer” on page 702
“Pause Timer” on page 698
“Continue Timer” on page 693
Delay (Sec)

Timing Action

Function: To slow the execution of program logic and to release the remaining time of a chart’s time slice.

Typical Use: To cause a chart to give up the remaining time of its time slice.

Details: Units are in seconds with millisecond resolution.

Arguments: 

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>(none)</td>
<td>Float Literal</td>
<td>10.525</td>
</tr>
</tbody>
</table>

Action Block Example:

```
Delay (Sec)
```

OptoScript Example:

```
DelaySec (Argument 0)
```

This is a procedure command; it does not return a value.

Notes:

- A timer stores elapsed time in units of seconds (with a resolution in milliseconds). Up timers count up from zero; down timers start from a value you set, and then and count down to zero. Timers can range from 0.001 to 4.611686 x 10^{15} seconds.
- Use Delay (mSec) for delays shorter than 10 seconds.
- When high accuracy is needed, reduce the number of charts running concurrently.
- If you use a delay of zero, PAC Control will ignore the delay command.

Queue Errors: -8 = Value less than zero.

See Also: “Delay (mSec)” on page 694
Down Timer Expired?

Timing Condition

Function: To check if a down timer has expired (reached zero).

Typical Use: Used to measure a time interval with good precision. Better than time delay commands for delays within looping charts.

Details: When a down timer has reached zero, it is considered expired.

Arguments: Argument 0

Condition Block Example:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Down Timer</td>
<td>Down Timer Variable</td>
<td>OVEN_TIMER</td>
</tr>
</tbody>
</table>

OptoScript Example:

```OptoScript
HasDownTimerExpired(Down Timer)
if (HasDownTimerExpired(OVEN_TIMER)) then
```

This is a function command; it returns a value of true (non-zero) or false (0). The returned value can be consumed by a control structure (as in the example shown) or by a variable, I/O point, and so forth. For more information, see the PAC Control User’s Guide (form 1700).

Notes:

- A timer stores elapsed time in units of seconds (with a resolution in milliseconds). Up timers count up from zero; down timers start from a value you set, and then and count down to zero. Timers can range from 0.001 to $4.611686 \times 10^{15}$ seconds.
- See “Timing Commands” in the PAC Control User’s Guide (form 1700) for more information on using timer commands.

See Also:  
"Start Off-Pulse" on page 193  
"Stop Timer" on page 702  
"Continue Timer" on page 693  
"Pause Timer" on page 698  
"Set Down Timer Preset Value" on page 699  
"Delay (Sec)" on page 695  
"Delay (mSec)" on page 694
Get & Restart Timer

Function: Retrieves a timer variable and restarts it.

Typical Use: By combining a read and start into one transaction, this command provides more accurate sequential timing.

Details: If you do a separate read and start, there could be a task switch between the time you read the timer and the time you restart it resulting in a delay in which no timing would be performed. With this command, the timer is instantly restarted as soon as the current time is retrieved.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Timer</td>
<td>Put In</td>
</tr>
<tr>
<td>Down Timer Variable</td>
<td>Float Variable</td>
</tr>
<tr>
<td>Up Timer Variable</td>
<td>Integer 32 Variable</td>
</tr>
</tbody>
</table>

Action Block Example:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Timer</td>
<td>Down Timer Variable</td>
<td>Down_Timer</td>
</tr>
<tr>
<td>Put In</td>
<td>Integer 32 Variable</td>
<td>nResult</td>
</tr>
</tbody>
</table>

OptoScript Example:

```opto
GetRestartTimer(Timer)
```

 ```opto
nResult = GetRestartTimer(Down_Timer);
```

This is a function command; it returns the value of the timer before it was restarted.

Notes:
- A timer stores elapsed time in units of seconds (with a resolution in milliseconds). Up timers count up from zero; down timers start from a value you set, and then and count down to zero. Timers can range from 0.001 to $4.611686 \times 10^{15}$ seconds.
- See “Timing Commands” in the PAC Control User’s Guide (form 1700) for more information on using timers.

See Also:
- “Delay (Sec)” on page 695
- “Start Off-Pulse” on page 193
- “Stop Timer” on page 702
- “Pause Timer” on page 698
- “Continue Timer” on page 693
CHAPTER 22: TIMING COMMANDS

Pause Timer

Timing Action

Function: To pause a timer variable.

Typical Use: Used with the Continue Timer command to trade on or off time of a variable or I/O point.

Details:
- The timer must have been started with either the Start Timer or Move commands.
- To start a paused timer again from the value at which it was paused, use the command Continue Timer.

Arguments:
- Argument 0
  - Timer
    - Down Timer Variable
    - Up Timer Variable

Action Block Example:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Timer</td>
<td>Down Timer Variable</td>
<td>OVEN_TIMER</td>
</tr>
</tbody>
</table>

OptoScript Example:

```
PauseTimer(Timer)
PauseTimer(OVEN_TIMER);
```

This is a procedure command; it does not return a value.

Notes:
- A timer stores elapsed time in units of seconds (with a resolution in milliseconds). Up timers count up from zero; down timers start from a value you set, and then and count down to zero. Timers can range from 0.001 to $4.611686 \times 10^{15}$ seconds.
- See “Timing Commands” in the PAC Control User’s Guide (form 1700) for more information on using timers.

See Also:
- “Start Off-Pulse” on page 193
- “Stop Timer” on page 702
- “Continue Timer” on page 693
- “Set Down Timer Preset Value” on page 699
- “Set Up Timer Target Value” on page 700
CHAPTER 22: TIMING COMMANDS

Set Down Timer Preset Value

Timing Action

Function: To set the value from which a down timer counts down.

Typical Use: To initialize a down timer.

Details:
- This command sets the value from which a down timer counts down, but it does not start the timer. To start the timer counting down, use the command Start Timer.
- The preset value will be persistent between calls to Start Timer.
- Argument 0 must be a positive number in seconds.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Value</td>
<td>Down Timer</td>
</tr>
<tr>
<td>Float Literal</td>
<td>Down Timer Variable</td>
</tr>
</tbody>
</table>

Action Block Example:

```
Set Down Timer Preset Value
```

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Value</td>
<td>Float Literal</td>
<td>60.0</td>
</tr>
<tr>
<td>Down Timer</td>
<td>Down Timer Variable</td>
<td>OVEN_TIMER</td>
</tr>
</tbody>
</table>

OptoScript Example:

```
SetDownTimerPreset(Target Value, Down Timer)
```

```
SetDownTimerPreset(60.0, OVEN_TIMER);
```

This is a procedure command; it does not return a value.

Notes:
- A timer stores elapsed time in units of seconds (with a resolution in milliseconds). Up timers count up from zero; down timers start from a value you set, and then and count down to zero. Timers can range from 0.001 to 4.611686 x 10\(^{15}\) seconds.
- See “Timing Commands” in the PAC Control User’s Guide (form 1700) for more information on using timers.
- To set the preset value and start the timer in one step, use the Move command to move the preset value to the timer. The timer will immediately start counting down from the value moved to it. Using Move overwrites any preset value previously set, so subsequent Start Timer commands will start from the value most recently moved.

See Also:
- “Start Off-Pulse” on page 193
- “Stop Timer” on page 702
- “Continue Timer” on page 693
- “Pause Timer” on page 698
- “Down Timer Expired?” on page 696
## Set Up Timer Target Value

### Timing Action

**Function:** To set the target value of an up timer.

**Typical Use:** To initialize an up timer.

**Details:**
- This command sets the target value but does not start the timer. You must start the timer using the `Start Timer` command.
- Up timers do not stop timing when they reach their target value. Use the `Up Timer Target Time Reached?` command to determine if the target time has been reached.
- The target value must be a positive number in seconds.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Value</td>
<td>Float Literal</td>
<td>60.0</td>
</tr>
<tr>
<td>Up Timer</td>
<td>Up Timer Variable</td>
<td>OVEN_TIMER</td>
</tr>
</tbody>
</table>

**Action Block Example:**

```plaintext
Set Up Timer Target Value (Target Value, Up Timer)
```

**OptoScript Example:**

```plaintext
SetUpTimerTarget(60.0, OVEN_TIMER);
```

**Notes:**
- A timer stores elapsed time in units of seconds (with a resolution in milliseconds). Up timers count up from zero; down timers start from a value you set, and then and count down to zero. Timers can range from 0.001 to 4.611686 \times 10^{15} seconds.
- See “Timing Commands” in the *PAC Control User’s Guide* (form 1700) for more information on timers.
- To set the target value and start the timer in one step, use the `Move` command to move the target value to the timer. The timer will immediately start from zero. Using the Move command overwrites any target value previously set.

**See Also:**
- “Start Off-Pulse” on page 193
- “Stop Timer” on page 702
- “Continue Timer” on page 693
- “Pause Timer” on page 698
- “Up Timer Target Time Reached?” on page 704
Start Timer

Function: To start a timer variable.

Typical Use: To start an up timer or a down timer. To measure time elapsed since an event occurred.

Details:
- Use this command to start an up timer. Up timer variables start from 0 and count up.
- Also use this command to start a down timer. Down timer variables start from their preset value and count down to 0. Since the default preset value for a down timer is zero, nothing will happen if you start the timer without first using the Set Down Timer Preset Value command.

Arguments:
- **Argument 0**
  - Timer
    - Down Timer Variable
    - Up Timer Variable

Action Block Example:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Timer</td>
<td>Down Timer Variable</td>
<td>Oven_Timer</td>
</tr>
</tbody>
</table>

OptoScript Example:

```optoscript
StartTimer(Timer)
```

StartTimer(Oven_Timer);

This is a procedure command; it does not return a value.

Notes:
- A timer stores elapsed time in units of seconds (with a resolution in milliseconds). Up timers count up from zero; down timers start from a value you set, and then and count down to zero. Timers can range from 0.001 to 4.611686 x 10<sup>15</sup> seconds.
- See "Timing Commands" in the PAC Control User’s Guide (form 1700) for more information on timers.
- To set the target value (for an up timer) or the preset value (for a down timer) and start the timer at the same time, use the Move command.
- Start Timer always starts up timers from zero and down timers from their preset value. To restart a timer from the value where it was paused, use the command Continue Timer instead.

See Also:
- “Stop Timer” on page 702
- “Continue Timer” on page 693
- “Pause Timer” on page 698
- “Set Down Timer Preset Value” on page 699
- “Set Up Timer Target Value” on page 700
**Stop Timer**

**Timing Action**

**Function:** To stop a timer variable.

**Typical Use:** To stop timing an event.

**Details:**
- Once an up timer or a down timer has been stopped, its value is zero. If you stop a timer and move the value to a variable, you will always get 0.0.
- To store the timer’s value at the time it was stopped, or to be able to continue a timer, use the command `Pause Timer` instead.

**Arguments:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Timer</td>
<td>Down Timer Variable</td>
<td>OVEN_TIMER</td>
</tr>
</tbody>
</table>

**Action Block Example:**

```
Stop Timer
```

**OptoScript Example:**

```
StopTimer(OVEN_TIMER);
```

This is a procedure command; it does not return a value.

**Notes:**

- A timer stores elapsed time in units of seconds (with a resolution in milliseconds). Up timers count up from zero; down timers start from a value you set, and then and count down to zero. Timers can range from 0.001 to 4.611686 x 10^{15} seconds.
- See “Timing Commands” in the *PAC Control User’s Guide* (form 1700) for more information on timers.

**See Also:**

- "Start Off-Pulse" on page 193
- "Continue Timer" on page 693
- "Pause Timer" on page 698
- "Set Down Timer Preset Value" on page 699
- "Set Up Timer Target Value" on page 700
Timer Expired?

Timing Condition

Function: To determine if the specified timer has reached its target value. For down timers, the target value is zero. For up timers, it is the value set by the command Set Up Timer Target Value.

Typical Use: To determine if it is time to take an appropriate action.

Details: If the specified timer has reached its target value, the logic will take the True path. If the specified timer has not reached its target value, the logic will take the False path.

Arguments:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is</td>
<td>Down Timer Variable</td>
<td>EGG_TIMER</td>
</tr>
</tbody>
</table>

Condition Block Example:

<table>
<thead>
<tr>
<th>Timer Expired?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argument Name</td>
</tr>
<tr>
<td>---------------</td>
</tr>
<tr>
<td>Is</td>
</tr>
</tbody>
</table>

OptoScript Example:

```optoscrit
HasTimerExpired(EGG_TIMER)
```

if (HasTimerExpired(EGG_TIMER)) then

This is a function command; it returns a non-zero (True) if the timer has expired, 0 (False) if not. The returned value can be consumed by a control structure (as in the example shown) or by a variable, I/O point, and so forth. For more information, see the PAC Control User’s Guide (form 1700).

Notes:

- A timer stores elapsed time in units of seconds (with a resolution in milliseconds). Up timers count up from zero; down timers start from a value you set, and then and count down to zero. Timers can range from 0.001 to 4.611686 x 10^15 seconds.
- See “Timing Commands” in the PAC Control User’s Guide (form 1700) for more information on using timers.
- This command can be used the same as Down Timer Expired? and Up Timer Target Time Reached?

See Also:

“Set Up Timer Target Value” on page 700
“Set Down Timer Preset Value” on page 699
“Start Off-Pulse” on page 193
“Up Timer Target Time Reached?” on page 704
“Down Timer Expired?” on page 696
Up Timer Target Time Reached?

Timing Condition

Function: To check if an up timer has reached its target time.

Typical Use: Used to go to the next step in a sequential process.

Details: • Up timers do not stop timing when they reach their target value.

• Use the Set Up Timer Target Value command to set the target time.

Arguments: Argument 0
Up Timer
Up Timer Variable

Condition Block
Example: HasUpTimerReachedTargetTime (Up Timer)
if (HasUpTimerReachedTargetTime (OVEN_TIMER)) then

OptoScript Example: This is a function command; it returns a value of true (non-zero) or false (0). The returned value can be consumed by a control structure (as in the example shown) or by a variable, I/O point, and so forth. For more information, see the PAC Control User’s Guide (form 1700).

Notes: • A timer stores elapsed time in units of seconds (with a resolution in milliseconds). Up timers count up from zero; down timers start from a value you set, and then and count down to zero. Timers can range from 0.001 to 4.611686 x 10^15 seconds.

• See “Timing Commands” in the PAC Control User’s Guide (form 1700) for more information on using timers.

See Also: “Start Off-Pulse” on page 193
“Stop Timer” on page 702
“Continue Timer” on page 693
“Pause Timer” on page 698
“Set Up Timer Target Value” on page 700
# A: High-Speed Digital Function Support

Use the following table to determine whether a brain supports high-speed digital functions and the commands used with those functions. High-speed functions include high-speed counting, quadrature counting, on-pulse and off-pulse measurement, and frequency and period measurement.

<table>
<thead>
<tr>
<th>Part number</th>
<th>High-Speed Digital Function Support?</th>
</tr>
</thead>
<tbody>
<tr>
<td>mistic bricks</td>
<td></td>
</tr>
<tr>
<td>B100</td>
<td>yes</td>
</tr>
<tr>
<td>E1</td>
<td>yes</td>
</tr>
<tr>
<td>G4D16R</td>
<td>yes</td>
</tr>
<tr>
<td>G4D32RS</td>
<td>no</td>
</tr>
</tbody>
</table>

serial B3000 mistic

<table>
<thead>
<tr>
<th>Part number</th>
<th>High-Speed Digital Function Support?</th>
</tr>
</thead>
<tbody>
<tr>
<td>B3000</td>
<td>yes</td>
</tr>
<tr>
<td>SNAP-BRS</td>
<td>no</td>
</tr>
<tr>
<td>EIO</td>
<td></td>
</tr>
<tr>
<td>SNAP-B3000-ENET</td>
<td>yes</td>
</tr>
<tr>
<td>SNAP-ENET-D64</td>
<td>no</td>
</tr>
<tr>
<td>SNAP-ENET-RTC</td>
<td>yes</td>
</tr>
<tr>
<td>SNAP-ENET-S64</td>
<td>no</td>
</tr>
</tbody>
</table>

UI0

<table>
<thead>
<tr>
<th>Part number</th>
<th>High-Speed Digital Function Support?</th>
</tr>
</thead>
<tbody>
<tr>
<td>SNAP-UP1-ADS</td>
<td>yes</td>
</tr>
<tr>
<td>SNAP-UP1-D64</td>
<td>no</td>
</tr>
<tr>
<td>SNAP-UP1-M64</td>
<td>no</td>
</tr>
</tbody>
</table>
This section provides information for using the Points per Module argument in the following commands:

- “IVAL Move Numeric Table to I/O Unit Ex” on page 277
- “Move I/O Unit to Numeric Table Ex” on page 281
- “Move Numeric Table to I/O Unit Ex” on page 286

For examples of table index offsets, see “Table Index Offsets” below.

For the length of the table required for values of Points per Module, see “Length of Table Required” on page 710.

### TABLE INDEX OFFSETS

The following tables show the table index offsets for values received and written from high-density analog modules. Each table shows offsets for a different Points per Module value.

<table>
<thead>
<tr>
<th>Module Position</th>
<th>Channel of Module</th>
<th>Index Offset</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>1</td>
<td>3</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
<tr>
<td>15</td>
<td>1</td>
<td>15</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Module Position</th>
<th>Channel of Module</th>
<th>Index Offset</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>3</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>4</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>5</td>
</tr>
<tr>
<td>3</td>
<td>1</td>
<td>6</td>
</tr>
<tr>
<td>3</td>
<td>2</td>
<td>7</td>
</tr>
<tr>
<td>4</td>
<td>1</td>
<td>8</td>
</tr>
<tr>
<td>Module Position</td>
<td>Channel of Module</td>
<td>Index Offset</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>4</td>
<td>2</td>
<td>9</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>1</td>
<td>30</td>
</tr>
<tr>
<td>15</td>
<td>2</td>
<td>31</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Module Position</th>
<th>Channel of Module</th>
<th>Index Offset</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>2</td>
<td>1</td>
</tr>
<tr>
<td>0</td>
<td>3</td>
<td>2</td>
</tr>
<tr>
<td>0</td>
<td>4</td>
<td>3</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>4</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>5</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>6</td>
</tr>
<tr>
<td>1</td>
<td>4</td>
<td>7</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>8</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>9</td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>10</td>
</tr>
<tr>
<td>2</td>
<td>4</td>
<td>11</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>1</td>
<td>60</td>
</tr>
<tr>
<td>15</td>
<td>2</td>
<td>61</td>
</tr>
<tr>
<td>15</td>
<td>3</td>
<td>62</td>
</tr>
<tr>
<td>15</td>
<td>4</td>
<td>63</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Module Position</th>
<th>Channel of Module</th>
<th>Index Offset</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>2</td>
<td>1</td>
</tr>
<tr>
<td>0</td>
<td>3</td>
<td>2</td>
</tr>
<tr>
<td>0</td>
<td>4</td>
<td>3</td>
</tr>
<tr>
<td>0</td>
<td>5</td>
<td>4</td>
</tr>
<tr>
<td>0</td>
<td>6</td>
<td>5</td>
</tr>
<tr>
<td>0</td>
<td>7</td>
<td>6</td>
</tr>
<tr>
<td>0</td>
<td>8</td>
<td>7</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>8</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>9</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>10</td>
</tr>
<tr>
<td>1</td>
<td>4</td>
<td>11</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>4</td>
<td>124</td>
</tr>
<tr>
<td>15</td>
<td>5</td>
<td>125</td>
</tr>
<tr>
<td>15</td>
<td>6</td>
<td>126</td>
</tr>
<tr>
<td>15</td>
<td>7</td>
<td>127</td>
</tr>
<tr>
<td>Module Position</td>
<td>Channel of Module</td>
<td>Index Offset</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>2</td>
<td>1</td>
</tr>
<tr>
<td>0</td>
<td>3</td>
<td>2</td>
</tr>
<tr>
<td>0</td>
<td>4</td>
<td>3</td>
</tr>
<tr>
<td>0</td>
<td>5</td>
<td>4</td>
</tr>
<tr>
<td>0</td>
<td>6</td>
<td>5</td>
</tr>
<tr>
<td>0</td>
<td>7</td>
<td>6</td>
</tr>
<tr>
<td>0</td>
<td>8</td>
<td>7</td>
</tr>
<tr>
<td>0</td>
<td>9</td>
<td>8</td>
</tr>
<tr>
<td>0</td>
<td>10</td>
<td>9</td>
</tr>
<tr>
<td>0</td>
<td>11</td>
<td>10</td>
</tr>
<tr>
<td>0</td>
<td>12</td>
<td>11</td>
</tr>
<tr>
<td>0</td>
<td>13</td>
<td>12</td>
</tr>
<tr>
<td>0</td>
<td>14</td>
<td>13</td>
</tr>
<tr>
<td>0</td>
<td>15</td>
<td>14</td>
</tr>
<tr>
<td>0</td>
<td>16</td>
<td>15</td>
</tr>
<tr>
<td>0</td>
<td>17</td>
<td>16</td>
</tr>
<tr>
<td>0</td>
<td>18</td>
<td>17</td>
</tr>
<tr>
<td>0</td>
<td>19</td>
<td>18</td>
</tr>
<tr>
<td>0</td>
<td>20</td>
<td>19</td>
</tr>
<tr>
<td>0</td>
<td>21</td>
<td>20</td>
</tr>
<tr>
<td>0</td>
<td>22</td>
<td>21</td>
</tr>
<tr>
<td>0</td>
<td>23</td>
<td>22</td>
</tr>
<tr>
<td>0</td>
<td>24</td>
<td>23</td>
</tr>
<tr>
<td>0</td>
<td>25</td>
<td>24</td>
</tr>
<tr>
<td>0</td>
<td>26</td>
<td>25</td>
</tr>
<tr>
<td>0</td>
<td>27</td>
<td>26</td>
</tr>
<tr>
<td>0</td>
<td>28</td>
<td>27</td>
</tr>
<tr>
<td>0</td>
<td>29</td>
<td>28</td>
</tr>
<tr>
<td>0</td>
<td>30</td>
<td>29</td>
</tr>
<tr>
<td>0</td>
<td>31</td>
<td>30</td>
</tr>
<tr>
<td>0</td>
<td>32</td>
<td>31</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
<tr>
<td>15</td>
<td>1</td>
<td>480</td>
</tr>
<tr>
<td>15</td>
<td>2</td>
<td>481</td>
</tr>
<tr>
<td>15</td>
<td>3</td>
<td>482</td>
</tr>
<tr>
<td>15</td>
<td>4</td>
<td>483</td>
</tr>
<tr>
<td>15</td>
<td>5</td>
<td>484</td>
</tr>
<tr>
<td>15</td>
<td>6</td>
<td>485</td>
</tr>
<tr>
<td>15</td>
<td>7</td>
<td>486</td>
</tr>
<tr>
<td>15</td>
<td>8</td>
<td>487</td>
</tr>
</tbody>
</table>
### APPENDIX B: TABLE INDEX OFFSET EXAMPLES

LENGTH OF TABLE REQUIRED

This table shows the length of the table required for different PPM (points per module) values.

<table>
<thead>
<tr>
<th>Module Position</th>
<th>Channel of Module</th>
<th>Index Offset</th>
</tr>
</thead>
<tbody>
<tr>
<td>15</td>
<td>9</td>
<td>488</td>
</tr>
<tr>
<td>15</td>
<td>10</td>
<td>489</td>
</tr>
<tr>
<td>15</td>
<td>11</td>
<td>490</td>
</tr>
<tr>
<td>15</td>
<td>12</td>
<td>491</td>
</tr>
<tr>
<td>15</td>
<td>13</td>
<td>492</td>
</tr>
<tr>
<td>15</td>
<td>14</td>
<td>493</td>
</tr>
<tr>
<td>15</td>
<td>15</td>
<td>494</td>
</tr>
<tr>
<td>15</td>
<td>16</td>
<td>495</td>
</tr>
<tr>
<td>15</td>
<td>17</td>
<td>496</td>
</tr>
<tr>
<td>15</td>
<td>18</td>
<td>497</td>
</tr>
<tr>
<td>15</td>
<td>19</td>
<td>498</td>
</tr>
<tr>
<td>15</td>
<td>20</td>
<td>499</td>
</tr>
<tr>
<td>15</td>
<td>21</td>
<td>500</td>
</tr>
<tr>
<td>15</td>
<td>22</td>
<td>501</td>
</tr>
<tr>
<td>15</td>
<td>23</td>
<td>502</td>
</tr>
<tr>
<td>15</td>
<td>24</td>
<td>503</td>
</tr>
<tr>
<td>15</td>
<td>25</td>
<td>504</td>
</tr>
<tr>
<td>15</td>
<td>26</td>
<td>505</td>
</tr>
<tr>
<td>15</td>
<td>27</td>
<td>506</td>
</tr>
<tr>
<td>15</td>
<td>28</td>
<td>507</td>
</tr>
<tr>
<td>15</td>
<td>29</td>
<td>508</td>
</tr>
<tr>
<td>15</td>
<td>30</td>
<td>509</td>
</tr>
<tr>
<td>15</td>
<td>31</td>
<td>510</td>
</tr>
<tr>
<td>15</td>
<td>32</td>
<td>511</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>PPM</th>
<th>Number of Elements from Starting Index Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>16</td>
</tr>
<tr>
<td>2</td>
<td>32</td>
</tr>
<tr>
<td>3</td>
<td>48</td>
</tr>
<tr>
<td>4</td>
<td>64</td>
</tr>
<tr>
<td>5</td>
<td>80</td>
</tr>
<tr>
<td>6</td>
<td>96</td>
</tr>
<tr>
<td>7</td>
<td>112</td>
</tr>
<tr>
<td>8</td>
<td>128</td>
</tr>
<tr>
<td>9</td>
<td>144</td>
</tr>
<tr>
<td>10</td>
<td>160</td>
</tr>
<tr>
<td>11</td>
<td>176</td>
</tr>
<tr>
<td>PPM</td>
<td>Number of Elements from Starting Index Required</td>
</tr>
<tr>
<td>-----</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>12</td>
<td>192</td>
</tr>
<tr>
<td>13</td>
<td>208</td>
</tr>
<tr>
<td>14</td>
<td>224</td>
</tr>
<tr>
<td>15</td>
<td>240</td>
</tr>
<tr>
<td>16</td>
<td>256</td>
</tr>
<tr>
<td>17</td>
<td>272</td>
</tr>
<tr>
<td>18</td>
<td>288</td>
</tr>
<tr>
<td>19</td>
<td>304</td>
</tr>
<tr>
<td>20</td>
<td>320</td>
</tr>
<tr>
<td>21</td>
<td>336</td>
</tr>
<tr>
<td>22</td>
<td>352</td>
</tr>
<tr>
<td>23</td>
<td>368</td>
</tr>
<tr>
<td>24</td>
<td>384</td>
</tr>
<tr>
<td>25</td>
<td>400</td>
</tr>
<tr>
<td>26</td>
<td>416</td>
</tr>
<tr>
<td>27</td>
<td>432</td>
</tr>
<tr>
<td>28</td>
<td>448</td>
</tr>
<tr>
<td>29</td>
<td>464</td>
</tr>
<tr>
<td>30</td>
<td>480</td>
</tr>
<tr>
<td>31</td>
<td>496</td>
</tr>
<tr>
<td>32</td>
<td>512</td>
</tr>
</tbody>
</table>
C: Deprecated Commands

Deprecated commands are commands that are functional; however, they’ve been replaced by newer commands for developing new strategies.

Deprecated commands are visible in the drop-down list in PAC Control’s Add Instruction dialog box, but the command’s name is appended with the text: [DEPRECATED]. This gives you a clear indication that you might want to select the deprecated command’s replacement.

This chapter provides documentation for deprecated commands.
Clear Receive Buffer

Obsolete. Use “Clear Communication Receive Buffer” on page 69.
IVAL Set Digital Binary

Function: Writes to the internal value (IVAL) of all 16 digital outputs on the specified I/O unit.

Typical Use: Simulation, testing, and certification where either there are no I/O units or communication to the I/O units is disabled.

Details: The program will use IVALs exclusively when communication to the specified I/O unit is disabled. This command allows the IVAL to be modified as if it were being changed by real I/O.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>On Mask</td>
<td>Off Mask</td>
<td>On I/O Unit</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
<td>B100</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
<td>B3000 (Digital)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>On Mask</td>
<td>Integer 32 Variable</td>
<td>PUMPS_ON_MASK</td>
</tr>
<tr>
<td>Off Mask</td>
<td>Integer 32 Literal</td>
<td>0</td>
</tr>
<tr>
<td>On I/O Unit</td>
<td>B3000 (Digital)</td>
<td>PUMP_CTRL</td>
</tr>
</tbody>
</table>

OptoScript Example:

```optoscript
IvalSetDigitalBinary(On Mask, Off Mask, On I/O Unit)
```

Ival SetDigitalBinary(PUMPS_ON_MASK, 0, PUMP_CTRL);

This is a procedure command; it does not return a value.

See Also:

"Disable Communication to All I/O Units" on page 564
"Disable Communication to I/O Unit" on page 565
IVAL Set Digital-64 I/O Unit from MOMO Masks

**Deprecated**

*NOTE: This command has been deprecated. It is still functional, however if you are developing a new strategy, use “IVAL Set I/O Unit from MOMO Masks” on page 583 instead.*

**Function:**
Writes to the internal values (IVALs) of all points on a digital 64 I/O unit.

**Typical Use:**
For simulation and testing, to assign specific values from a must-on, must-off mask to points.

**Details:**
- The program will use IVALS exclusively when communication to the I/O unit is disabled. This command allows the IVALS to be modified as if they were being changed by real I/O.
- This command is 64 times faster than using Turn On or Turn Off 64 times. It updates the IVALS for all 64 points. It affects only selected output points and does not affect input points.
- To turn on a point, set the respective bit in the 64-bit data field of Must On Mask (Argument 0) to a value of 1.
- To turn off a point, set the respective bit in the 64-bit data field of Must Off Mask (Argument 1) to a value of 1.
- To leave a point unaffected, set its bits to a value of 0 in both Must On Mask and Must Off Mask. Check for conflicts; if the same bit is set to 1 in both masks, the point is turned off.
- The least significant bit corresponds to point zero.
- If a specific point is disabled or if the entire I/O unit is disabled, only the internal values (IVALs) are written.

**Arguments:**
- **Argument 0**
  - Must On Mask
  - Type
    - Integer 32 Literal
    - Integer 32 Variable
    - Integer 64 Literal
    - Integer 64 Variable

- **Argument 1**
  - Must Off Mask
  - Type
    - Integer 32 Literal
    - Integer 32 Variable
    - Integer 64 Literal
    - Integer 64 Variable

- **Argument 2**
  - Digital-64 I/O Unit
  - Type
    - SNAP-ENET-D64
    - SNAP-UP1-D64

**Standard Example:**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Must On Mask</td>
<td>Integer 64 Literal</td>
<td>0x06000000000000000000000000</td>
</tr>
<tr>
<td>Must Off Mask</td>
<td>Integer 64 Literal</td>
<td>0xB0F240010308A020</td>
</tr>
<tr>
<td>Digital-64 I/O Unit</td>
<td>SNAP-UP1-D64</td>
<td>PUMP_CTRL_UNIT</td>
</tr>
</tbody>
</table>

The effect of this command is illustrated below:

<table>
<thead>
<tr>
<th>Point Number</th>
<th>63</th>
<th>62</th>
<th>61</th>
<th>60</th>
<th>59</th>
<th>58</th>
<th>57</th>
<th>56</th>
<th>&gt; &gt; &gt;</th>
<th>7</th>
<th>6</th>
<th>5</th>
<th>4</th>
<th>3</th>
<th>2</th>
<th>1</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Must-on</strong></td>
<td>Binary</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>&gt; &gt; &gt;</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>Hex</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>&gt; &gt; &gt;</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td><strong>Must-off</strong></td>
<td>Binary</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>&gt; &gt; &gt;</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>Hex</td>
<td>B</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>&gt; &gt; &gt;</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

To save space, the example shows only the first eight points and the last eight points on the rack. For the points shown, points 58, 57, 7, 6, and 1 will be turned on. Points 63, 61, 60, and 5 will be turned off. Other points shown are not changed.

**OptoScript Example:**

```opto
IvalSetDigital64IoUnitFromMomo (Must On Mask, Must Off Mask, Digital-64 I/O Unit)
IvalSetDigital64IoUnitFromMomo (0x06000000000000000000000000, 0xB0F240010308A020, PUMP_CTRL_UNIT);
```
This is a procedure command; it does not return a value. (Note that Integer 64 literals in OptoScript code take an `i64` suffix.)

**Notes:** Primarily used to write to inputs.

**See Also:**
- “Disable Communication to All I/O Units” on page 564
- “Disable Communication to I/O Unit” on page 565
- “IVAL Set Mixed I/O Unit from MOMO Masks” on page 720,
- “IVAL Set Mixed 64 I/O Unit from MOMO Masks” on page 718
IVAL Set Mixed 64 I/O Unit from MOMO Masks

Function:
Writes to the internal values (IVALs) of all digital points on a mixed 64 I/O unit (an I/O unit with a SNAP-UP1-M64 brain).

Typical Use:
For simulation and testing, to assign specific values from a must-on, must-off mask to digital points.

Details:
- The program will use IVALs exclusively when communication to the I/O unit is disabled. This command allows the IVALs to be modified as if they were being changed by real I/O.
- This command is 64 times faster than using Turn On or Turn Off 64 times. It updates the IVALs for all 64 points. It affects only selected output points and does not affect input points.
- To turn on a point, set the respective bit in the 64-bit data field of Must On Mask (Argument 0) to a value of 1.
- To turn off a point, set the respective bit in the 64-bit data field of Must Off Mask (Argument 1) to a value of 1.
- To leave a point unaffected, set its bits to a value of 0 in both Must On Mask and Must Off Mask. Check for conflicts; if the same bit is set to 1 in both masks, the point is turned off.
- The least significant bit corresponds to point zero.
- If a specific point is disabled or if the entire I/O unit is disabled, only the internal values (IVALs) are written.

Arguments:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Must On Mask</td>
<td>Integer 64 Literal</td>
<td>0x060003C0000000C2</td>
</tr>
<tr>
<td>Must Off Mask</td>
<td>Integer 64 Literal</td>
<td>0xB0F24010308A020</td>
</tr>
<tr>
<td>Mixed 64 I/O Unit</td>
<td>SNAP-UP1-M64</td>
<td>PUMP_CTRL_UNIT</td>
</tr>
</tbody>
</table>

Standard Example:

The effect of this command is illustrated below:

| Point Number | 63 | 62 | 61 | 60 | 59 | 58 | 57 | 56 | >> | 7 | 6 | 5 | 4 | 3 | 2 | 1 | 0 |
|--------------|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|
| Must-on      | Binary | 0 | 0 | 0 | 0 | 1 | 1 | 0 | >> | 1 | 1 | 0 | 0 | 0 | 0 | 1 | 0 |
|              | Hex   | 0 | | | | | 6 | | >> | C | | 2 | |
| Must-off     | Binary | 1 | 0 | 1 | 1 | 0 | 0 | 0 | >> | 0 | 0 | 1 | 0 | 0 | 0 | 0 | 0 |
|              | Hex   | B | | | | | 0 | | >> | 2 | | 0 | |

To save space, the example shows only the first eight points and the last eight points on the rack. For the points shown, points 58, 57, 7, 6, and 1 will be turned on. Points 63, 61, 60, and 5 will be turned off. Other points shown are not changed.

OptoScript Example:

IVALSetMixed64IoUnitFromMomo (Must On Mask, Must Off Mask, Mixed 64 I/O Unit)
IVALSetMixed64IoUnitFromMomo (0x060003C0000000C2i64, 0xB0F240010308A020i64, PUMP_CTRL_UNIT);
This is a procedure command; it does not return a value. (Note that Integer 64 literals in OptoScript code take an \textit{i64} suffix.)

**Notes:** Primarily used to write to inputs.

**See Also:**
- “Disable Communication to All I/O Units” on page 564
- “Disable Communication to I/O Unit” on page 565
- “IVAL Set Mixed I/O Unit from MOMO Masks” on page 720
- “IVAL Set Digital-64 I/O Unit from MOMO Masks” on page 716
IVAL Set Mixed I/O Unit from MOMO Masks

Function: Writes to the internal values (IVAls) of all digital points on a mixed I/O unit.

Typical Use: For simulation and testing, to assign specific values from a must-on, must-off mask to digital points.

Details:
- The program will use IVAls exclusively when communication to the I/O unit is disabled. This command allows the IVAls to be modified as if they were being changed by real I/O.
- This command is 64 times faster than using Turn On or Turn Off 64 times. It updates the IVAls for all 64 points. It affects only selected output points and does not affect input points.
- To turn on a point, set the respective bit in the 64-bit data field of Must On Mask (Argument 0) to a value of 1.
- To turn off a point, set the respective bit in the 64-bit data field of Must Off Mask (Argument 1) to a value of 1.
- To leave a point unaffected, set its bits to a value of 0 in both Must On Mask and Must Off Mask. Check for conflicts; if the same bit is set to 1 in both masks, the point is turned off.
- The least significant bit corresponds to point zero.
- If a specific point is disabled or if the entire I/O unit is disabled, only the internal values (IVAls) are written.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Must On Mask</td>
<td>Must Off Mask</td>
<td>Mixed I/O Unit</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
<td>SNAP-B3000-ENET</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
<td>SNAP-ENET-RTC</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-UP1-ADS</td>
</tr>
</tbody>
</table>

The effect of this command is illustrated below:

| Point Number | 31 | 30 | 29 | 28 | 27 | 26 | 25 | 24 | > > > | 7 | 6 | 5 | 4 | 3 | 2 | 1 | 0 |
|--------------|----|----|----|----|----|----|----|----|-------|----|----|----|----|----|----|----|----|----|----|----|
| Must-on Bitmask | Binary | 0 | 0 | 0 | 0 | 1 | 1 | 0 | > > > | 1 | 1 | 0 | 0 | 0 | 0 | 1 | 0 |
| | Hex | 0 | | | | 6 | | | > > > | C | | | | | | | |
| Must-off Bitmask | Binary | 1 | 0 | 1 | 1 | 0 | 0 | 0 | > > > | 0 | 0 | 1 | 0 | 0 | 0 | 0 | 0 |
| | Hex | B | | | | | | | | | | | | | | | |

To save space, the example shows only the first eight and the last eight digital points on the rack. For the points shown, points 26, 25, 7, 6, and 1 will be turned on. Points 31, 29, 28, and 5 will be turned off. Other points shown are not changed.

OptoScript Example:

```optoscript
IvalSetMixedIoUnitFromMomo (Must On Mask, Must Off Mask, Mixed I/O Unit)
IvalSetMixedIoUnitFromMomo (PUMPS_ON_MASK, 0xB001A020, PUMP_CTRL_UNIT);
```
This is a procedure command; it does not return a value.

Notes: Primarily used to write to inputs.

See Also: “Disable Communication to All I/O Units” on page 564
“Disable Communication to I/O Unit” on page 565
“IVAL Set Digital-64 I/O Unit from MOMO Masks” on page 716
“IVAL Set Mixed 64 I/O Unit from MOMO Masks” on page 718
IVAL Set Simple 64 I/O Unit from MOMO Masks

NOTE: This command has been deprecated. It is still functional, however if you are developing a new strategy, use "IVAL Set I/O Unit from MOMO Masks" on page 583 instead.

Function:
Writes to the internal values (IVALs) of all digital points on a SNAP Simple 64-point I/O unit (an I/O unit with a SNAP-ENET-S64 brain).

Typical Use:
For simulation and testing, to assign specific values from a must-on, must-off mask to digital points.

Details:
- The program will use IVALs exclusively when communication to the I/O unit is disabled. This command allows the IVALs to be modified as if they were being changed by real I/O.
- This command is 64 times faster than using Turn On or Turn Off 64 times. It updates the IVALs for all 64 points. It affects only selected output points and does not affect input points.
- To turn on a point, set the respective bit in the 64-bit data field of Must On Mask (Argument 0) to a value of 1.
- To turn off a point, set the respective bit in the 64-bit data field of Must Off Mask (Argument 1) to a value of 1.
- To leave a point unaffected, set its bits to a value of 0 in both Must On Mask and Must Off Mask. Check for conflicts; if the same bit is set to 1 in both masks, the point is turned off.
- The least significant bit corresponds to point zero.
- If a specific point is disabled or if the entire I/O unit is disabled, only the internal values (IVALs) are written.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Must On Mask</td>
<td>Integer 64 Literal</td>
<td>0x060003C000000C2</td>
</tr>
<tr>
<td>Must Off Mask</td>
<td>Integer 64 Literal</td>
<td>0xB0F240010308A020</td>
</tr>
<tr>
<td>Simple 64 I/O Unit</td>
<td>SNAP-ENET-S64</td>
<td>PUMP_CTRL_UNIT</td>
</tr>
</tbody>
</table>

The effect of this command is illustrated below:

To save space, the example shows only the first eight points and the last eight points on the rack. For the points shown, points 58, 57, 7, 6, and 1 will be turned on. Points 63, 61, 60, and 5 will be turned off. Other points shown are not changed.
**OptoScript Example:**  
\[
\text{IvalSetSimple64IoUnitFromMomo(\text{Must On Mask, Must Off Mask, Simple 64 I/O Unit})}
\]

\[
\text{IvalSetSimple64IoUnitFromMomo(0x060003C0000000C2i64, 0xB0F240010308A020i64, PUMP_CLRL_UNIT);
}
\]

This is a procedure command; it does not return a value. (Note that Integer 64 literals in OptoScript code take an \textit{i64} suffix.)

**Notes:** Primarily used to write to inputs.

**See Also:**  
"Disable Communication to All I/O Units" on page 564  
"Disable Communication to I/O Unit" on page 565  
"IVAL Set Digital-64 I/O Unit from MOMO Masks" on page 716  
"IVAL Set Mixed 64 I/O Unit from MOMO Masks" on page 718
Set Digital I/O Unit from MOMO Masks

Deprecated

NOTE: This command has been deprecated. It is still functional, however if you are developing a new strategy, use “Set I/O Unit from MOMO Masks” on page 292 instead.

Function: For 16-channel mistic digital I/O units only. To control multiple digital output points on the same I/O unit simultaneously with a single command.

Typical Use: To efficiently control a selected group of digital outputs with one command.

Details:

- This command uses bits 0 through 15, because mistic digital I/O units have 16 points.
- This command is 16 times faster than using Turn On or Turn Off 16 times.
- Updates the IVALs and XVALs for all 16 points. Affects only selected output points. Does not affect input points.
- Uses only the lowest (least significant) 16 bits of the integer. The least significant bit corresponds to point zero.
- To turn on a point, set the respective bit in the 32-bit data field of Must On Mask (Argument 0) to a value of 1.
- To turn off a point, set the respective bit in the 32-bit data field of Must Off Mask (Argument 1) to a value of 1.
- To leave a point unaffected, set its bits to a value of 0 in both Must On Mask and Must Off Mask. Check for conflicts; if the same bit is set to 1 in both masks, the point is turned off.
- If a specific point is disabled or if the entire I/O unit is disabled, only the internal values (IVALs) are written.

Arguments:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Must On Mask</td>
<td>Integer 32 Variable</td>
<td>PUMPS_ON_MASK</td>
</tr>
<tr>
<td>Must Off Mask</td>
<td>Integer 32 Literal</td>
<td>3840</td>
</tr>
<tr>
<td>Digital I/O Unit</td>
<td>B3000 (Digital)</td>
<td>PUMP_CTRL</td>
</tr>
</tbody>
</table>

Standard Example:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Must On Mask</td>
<td>Integer 32 Variable</td>
<td>PUMPS_ON_MASK</td>
</tr>
<tr>
<td>Must Off Mask</td>
<td>Integer 32 Literal</td>
<td>3840</td>
</tr>
<tr>
<td>Digital I/O Unit</td>
<td>B3000 (Digital)</td>
<td>PUMP_CTRL</td>
</tr>
</tbody>
</table>

The effect of this command is illustrated below:

<table>
<thead>
<tr>
<th>Point Number</th>
<th>15</th>
<th>14</th>
<th>13</th>
<th>12</th>
<th>11</th>
<th>10</th>
<th>9</th>
<th>8</th>
<th>7</th>
<th>6</th>
<th>5</th>
<th>4</th>
<th>3</th>
<th>2</th>
<th>1</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Must-on</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bitmask</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Binary</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Hex</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Must-off</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bitmask</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Binary</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Hex</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The effect of this command is illustrated below:
In this example, points 4, 5, 6, and 7 will be turned on. Points 8, 9, 10, and 11 will be turned off. Points 0, 1, 2, 3, 12, 13, 14, and 15 are not changed.

**OptoScript Example:**

```
SetDigitalIoUnitFromMomo(Must On Mask, Must Off Mask, Digital I/O Unit)
SetDigitalIoUnitFromMomo(PUMPS_ON_MASK, 3840, PUMP_CTRL);
```

This is a procedure command; it does not return a value.

**Notes:**

- For a 64-point digital-only rack, use the command `Set I/O Unit from MOMO Masks`.
- Use `Bit Set` or `Bit Clear` to change individual bits in an integer variable.
Set Digital-64 I/O Unit from MOMO Masks

Deprecated

NOTE: This command has been deprecated. It is still functional, however if you are developing a new strategy, use “Set I/O Unit from MOMO Masks” on page 292 instead.

Function: To control multiple digital output points on the same 64-point digital-only I/O unit simultaneously with a single command.

Typical Use: To efficiently control all digital outputs on a 64-point digital rack with one command.

Details: • This command is 64 times faster than using Turn On or Turn Off 64 times.
  • Updates the IVALs and XVALs for all 64 points. Affects only selected output points. Does not affect input points.
  • To turn on a point, set the respective bit in the 64-bit data field of Must On Mask (Argument 0) to a value of 1.
  • To turn off a point, set the respective bit in the 64-bit data field of Must Off Mask (Argument 1) to a value of 1.
  • To leave a point unaffected, set its bits to a value of 0 in both Must On Mask and Must Off Mask. Check for conflicts; if the same bit is set to 1 in both masks, the point is turned off.
  • The least significant bit corresponds to point zero.
  • If a specific point is disabled or if the entire I/O unit is disabled, only the internal values (IVALs) are written.

Arguments:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argument 0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Must On Mask</td>
<td>Integer 64 Literal</td>
<td>0x060003C0000000C2</td>
</tr>
<tr>
<td>Must Off Mask</td>
<td>Integer 64 Literal</td>
<td>0xB0F240010308A020</td>
</tr>
<tr>
<td>Digital-64 I/O Unit</td>
<td></td>
<td>SNAP-UP1-D64 Unit</td>
</tr>
</tbody>
</table>

Standard Example:

The effect of this command is illustrated below:

| Point Number | 63 | 62 | 61 | 60 | 59 | 58 | 57 | 56 | > > | 7 | 6 | 5 | 4 | 3 | 2 | 1 | 0 |
|--------------|----|----|----|----|----|----|----|----|-----|---|---|---|---|---|---|---|---|---|
| Must-on      |     |    |    |    |    |    |    |    |     | 1 | 1 | 0 | 0 | 0 | 0 | 1 | 0 |
| Must-off     | 1   | 0  | 1  | 0  | 0  | 0  | 0  | 0  | > > | 0 | 0 | 1 | 0 | 0 | 0 | 0 | 0 |

To save space, the example shows only the first eight points and the last eight points on the rack. For the points shown, points 58, 57, 7, 6, and 1 will be turned on. Points 63, 61, 60, and 5 will be turned off. Other points shown are not changed.
Example:

```optoscript
SetDigital64IoUnitFromMomo(0x060003C000000C2i64, 0xB0F240010308A020i64, PUMP_CTRL_UNIT);
```

This is a procedure command; it does not return a value. (Note that Integer 64 literals in OptoScript code take an \texttt{i64} suffix.)

**Notes:**
Use Bit Set or Bit Clear to change individual bits in an integer variable.

**See Also:**
“Get I/O Unit as Binary Value” on page 265
Set Mixed 64 I/O Unit from MOMO Masks

Function: To control multiple digital output points on the same 64-point mixed I/O unit simultaneously with a single command (applies to I/O units with a SNAP-UP1-M64 brain only).

Typical Use: To efficiently control all digital outputs on a mixed 64-point rack with one command.

Details:
- This command is 64 times faster than using Turn On or Turn Off 64 times.
- Updates the IVALs and XVALs for all 64 points. Affects only selected output points. Does not affect input points.
- To turn on a point, set the respective bit in the 64-bit data field of Must On Mask (Argument 0) to a value of 1.
- To turn off a point, set the respective bit in the 64-bit data field of Must Off Mask (Argument 1) to a value of 1.
- To leave a point unaffected, set its bits to a value of 0 in both Must On Mask and Must Off Mask. Check for conflicts; if the same bit is set to 1 in both masks, the point is turned off.
- The least significant bit corresponds to point zero.
- If a specific point is disabled or if the entire I/O unit is disabled, only the internal values (IVALs) are written.

Arguments:

<table>
<thead>
<tr>
<th>Argument 0</th>
<th>Argument 1</th>
<th>Argument 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Must On Mask</td>
<td>Must Off Mask</td>
<td>Mixed 64 I/O Unit</td>
</tr>
<tr>
<td>Integer 32 Literal</td>
<td>Integer 32 Literal</td>
<td>SNAP-UP1-M64</td>
</tr>
<tr>
<td>Integer 32 Variable</td>
<td>Integer 32 Variable</td>
<td></td>
</tr>
<tr>
<td>Integer 64 Literal</td>
<td>Integer 64 Literal</td>
<td></td>
</tr>
<tr>
<td>Integer 64 Variable</td>
<td>Integer 64 Variable</td>
<td></td>
</tr>
</tbody>
</table>

Standard Example:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Must On Mask</td>
<td>Integer 64 Literal</td>
<td>0x060003C0000000C2</td>
</tr>
<tr>
<td>Must Off Mask</td>
<td>Integer 64 Literal</td>
<td>0x80F240010308A020</td>
</tr>
<tr>
<td>Mixed 64 I/O Unit</td>
<td>SNAP-UP1-M64</td>
<td>PUMP_CTRL_UNIT</td>
</tr>
</tbody>
</table>

The effect of this command is illustrated below:

| Point Number | 63 | 62 | 61 | 60 | 59 | 58 | 57 | 56 | >> | 7 | 6 | 5 | 4 | 3 | 2 | 1 | 0 |
|--------------|----|----|----|----|----|----|----|----|----|---|---|---|---|---|---|---|---|---|
| Must-on Bitmask | Binary | 0 | 0 | 0 | 0 | 1 | 1 | 0 | >> | 1 | 1 | 0 | 0 | 0 | 0 | 1 | 0 |
|               | Hex | 0 | 0 | 1 | 6 | >> | C | 2 |    |    |    |    |    |    |    |    |    |
| Must-off Bitmask | Binary | 1 | 0 | 1 | 1 | 0 | 0 | 0 | >> | 0 | 0 | 1 | 0 | 0 | 0 | 0 | 0 |
|               | Hex | B | 0 | >> | 2 |    |    |    |    |    |    |    |    |    |    |    |    |    |

To save space, the example shows only the first eight points and the last eight points on the rack. For the points shown, points 58, 57, 7, 6, and 1 will be turned on. Points 63, 61, 60, and 5 will be turned off. Other points shown are not changed.

NOTE: This command has been deprecated. It is still functional, however if you are developing a new strategy, use “Set I/O Unit from MOMO Masks” on page 292 instead.
**OptoScript**

SetMixed64IoUnitFromMomo *(Must On Mask, Must Off Mask, Mixed 64 I/O Unit)*

SetMixed64IoUnitFromMomo(0x060003C0000000C2i64, 0xB0F240010308A020i64, PUMP_CTRL_UNIT);

This is a procedure command; it does not return a value. (Note that Integer 64 literals in OptoScript code take an _i64_ suffix.)

**Notes:**
Use Bit Set or Bit Clear to change individual bits in an integer variable.

**See Also:** "Get I/O Unit as Binary Value" on page 265
Set Mixed I/O Unit from MOMO Masks

NOTE: This command has been deprecated. It is still functional, however if you are developing a new strategy, use “Set I/O Unit from MOMO Masks” on page 292 instead.

Function: To control multiple digital output points on the same mixed I/O unit simultaneously with a single command.

Typical Use: To efficiently control all digital outputs on a mixed I/O rack with one command.

Details:
- This command is 32 times faster than using Turn On or Turn Off 32 times.
- Updates the IVALs and XVALs for all 32 digital points. Affects only selected digital output points. Does not affect digital input points.
- To turn on a point, set the respective bit in the 32-bit data field of Must On Mask (Argument 0) to a value of 1.
- To turn off a point, set the respective bit in the 32-bit data field of Must Off Mask (Argument 1) to a value of 1.
- If a specific point is disabled or if the entire I/O unit is disabled, only the internal values (IVALs) are written.

Arguments:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Must On Mask</td>
<td>Integer 32 Variable</td>
<td>PUMPS_ON_MASK</td>
</tr>
<tr>
<td>Must Off Mask</td>
<td>Integer 32 Literal</td>
<td>0xB001A020</td>
</tr>
<tr>
<td>Mixed I/O Unit</td>
<td>SNAP-UP1-ADS</td>
<td>PUMP_CTRL_UNIT</td>
</tr>
</tbody>
</table>

The effect of this command is illustrated below:

To save space, the example shows only the first eight and the last eight digital points on the rack. For the points shown, points 26, 25, 7, 6, and 1 will be turned on. Points 31, 29, 28, and 5 will be turned off. Other points shown are not changed.

OptoScript Example:

```
SetMixedIoUnitFromMomo (Must On Mask, Must Off Mask, Mixed I/O Unit)
SetMixedIoUnitFromMomo (PUMPS_ON_MASK, 0xB001A020, PUMP_CTRL_UNIT);
```

This is a procedure command; it does not return a value.
Notes: Use Bit Set or Bit Clear to change individual bits in an integer variable.

See Also: “Get I/O Unit as Binary Value” on page 265
“Set I/O Unit from MOMO Masks” on page 292
APPENDIX C: DEPRECATED COMMANDS

Set Simple 64 I/O Unit from MOMO Masks

Deprecated

NOTE: This command has been deprecated. It is still functional, however if you are developing a new strategy, use “Set I/O Unit from MOMO Masks” on page 292 instead.

Function: To control multiple digital output points on the same 64-point I/O unit simultaneously with a single command (applies to I/O units with a SNAP-ENET-64 brain only).

Typical Use: To efficiently control all digital outputs on a SNAP Simple I/O 64-point rack with one command.

Details:
- This command is 64 times faster than using Turn On or Turn Off 64 times.
- Updates the IVALs and XVALs for all 64 points. Affects only selected output points. Does not affect input points.
- To turn on a point, set the respective bit in the 64-bit data field of Must On Mask (Argument 0) to a value of 1.
- To turn off a point, set the respective bit in the 64-bit data field of Must Off Mask (Argument 1) to a value of 1.
- To leave a point unaffected, set its bits to a value of 0 in both Must On Mask and Must Off Mask. Check for conflicts; if the same bit is set to 1 in both masks, the point is turned off.
- The least significant bit corresponds to point zero.
- If a specific point is disabled or if the entire I/O unit is disabled, only the internal values (IVALs) are written.

Arguments:

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Must On Mask</td>
<td>Integer 64</td>
<td>0x060003C0000000C2</td>
</tr>
<tr>
<td>Must Off Mask</td>
<td>Integer 64</td>
<td>0xB0F240010308A020</td>
</tr>
<tr>
<td>Simple 64 I/O Unit</td>
<td>SNAP-ENET-64</td>
<td>PUMP_CTRL_UNIT</td>
</tr>
</tbody>
</table>

Standard Example:

The effect of this command is illustrated below:

<table>
<thead>
<tr>
<th>Point Number</th>
<th>63</th>
<th>62</th>
<th>61</th>
<th>60</th>
<th>59</th>
<th>58</th>
<th>57</th>
<th>56</th>
<th>7</th>
<th>6</th>
<th>5</th>
<th>4</th>
<th>3</th>
<th>2</th>
<th>1</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Must-on Bitmask</td>
<td>Binary</td>
<td>0 0 0 0 0 1 1 0</td>
<td>&gt;&gt;&gt;</td>
<td>1 1 0 0 0 0 1 0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Hex</td>
<td>0 6</td>
<td>&gt;&gt;&gt;</td>
<td>C 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Must-off Bitmask</td>
<td>Binary</td>
<td>1 0 1 1 0 0 0 0</td>
<td>&gt;&gt;&gt;</td>
<td>0 0 1 0 0 0 0 0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Hex</td>
<td>B 0</td>
<td>&gt;&gt;&gt;</td>
<td>2 0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

To save space, the example shows only the first eight points and the last eight points on the rack. For the points shown, points 58, 57, 7, 6, and 1 will be turned on. Points 63, 61, 60, and 5 will be turned off. Other points shown are not changed.
**OptoScript Example:**  
`SetSimple64IoUnitFromMomo(Must On Mask, Must Off Mask, Simple 64 I/O Unit)`

`SetSimple64IoUnitFromMomo(0x060003C0000000C2i64, 0xB0F240010308A020i64, PUMP_CTRL_UNIT);`

This is a procedure command; it does not return a value. (Note that Integer 64 literals in OptoScript code take an `i64` suffix.)

**Notes:** Use Bit Set or Bit Clear to change individual bits in an integer variable.

**See Also:** "Get I/O Unit as Binary Value" on page 265
Index

A
Absolute Value, 447
Accept Incoming Communication, 67
Add, 448
Add Message to Queue, 199
Add User Error to Queue, 200
Add User I/O Unit Error to Queue, 201
AND, 353
AND?, 355
Append Character to String, 597
Append String to String, 599
Arccosine, 449
Arcsine, 450
Arctangent, 451

B
Bit AND, 357
Bit AND?, 359
Bit Change, 360
Bit Clear, 361
Bit Copy, 362
Bit NOT, 364
Bit NOT?, 366
Bit Off in Numeric Table Element?, 368
Bit Off?, 369
Bit On in Numeric Table Element?, 370
Bit On?, 371
Bit OR, 372
Bit OR?, 374
Bit Rotate, 375
Bit Set, 376
Bit Shift, 377
Bit Test, 379
Bit XOR, 380
Bit XOR?, 382

C
Calculate & Set Analog Gain, 23
Calculate & Set Analog Offset, 25
Calculate Strategy CRC, 135
Call Chart, 51
Calling Chart Running?, 53
Calling Chart Stopped?, 54
Calling Chart Suspended?, 55
Caused a Chart Error?, 203
Caused an I/O Unit Error?, 204
Chart Running?, 56
Chart Stopped?, 57
Chart Suspended?, 58
Clamp Float Table Element, 452
Clamp Float Variable, 453
Clamp Integer 32 Table Element, 454
Clamp Integer 32 Variable, 455
Clear All Errors, 206
Clear All Latches, 153
Clear Communication Receive Buffer, 69
Clear Counter, 155
Clear HDD Module Off-Latches, 223
Clear HDD Module On-Latches, 225
Clear I/O Unit Configured Flag, 263
Clear I/O-Latch, 156
Clear On-Latch, 157
Clear Pointer, 549
Clear Pointer Table Element, 550
Close Communication, 70
Comment (Block), 483
Comment (OptoControl Conversion Issue), 484
Comment (Single Line), 485
Communication Open?, 71
Communication to All I/O Points Enabled?, 561
Communication to All I/O Units Enabled?, 562
Compare Strings, 600
Complement, 456
Continue Calling Chart, 59
Continue Chart, 60
Continue Timer, 693
Convert Date & Time to NTP Timestamp, 661
Convert Float to String, 602
Convert Hex String to Number, 604
Convert IEEE Hex String to Number, 605
Convert Integer 32 to IP Address String, 606
Convert IP Address String to Integer 32, 607
Convert NTP Timestamp to Date & Time, 663
Convert Number to Formatted Hex String, 608
Convert Number to Hex String, 610
Convert Number to String, 611
Convert Number to String Field, 612
Convert String to Float, 613
Convert String to Integer 32, 615
Convert String to Integer 64, 617
Convert String to Lower Case, 620
Convert String to Upper Case, 620
Copy Current Error to String, 207
Copy Date to String (DD/MM/YYYY), 664
Copy Date to String (MM/DD/YYYY), 665
Copy Time to String, 666
Cosine, 457

D
Decrement Variable, 459
Delay (mSec), 694
Delay (Sec), 695
Disable Communication to All I/O Points, 563
Disable Communication to All I/O Units, 564
Disable Communication to I/O Unit, 565
Disable Communication to PID Loop, 567
Disable Communication to Point, 568
Disable I/O Unit Causing Current Error, 208
Divide, 460
Down Timer Expired?, 696

E
Enable Communication to All I/O Points, 569
Enable Communication to All I/O Units, 570
Enable Communication to I/O Unit, 571
Enable Communication to PID Loop, 572
Enable Communication to Point, 573
Enable I/O Unit Causing Current Error, 209
Equal to Numeric Table Element?, 384
Equal?, 386
Erase Files in Permanent Storage, 136
Error on I/O Unit?, 210
Error?, 211

F
Find Character in String, 621
Find Substring in String, 623
Flag Lock, 486
Flag Unlock, 488
Flip Flop JK, 388
Float to Int32 Bits, 389
Float Valid?, 490

G
Generate Checksum on String, 624
Generate Forward CCITT on String, 626
Generate Forward CRC-16 on String, 627
Generate N Pulses, 158
Generate Random Number, 461
Generate Reverse CCITT on String, 628
Generate Reverse CRC-16 on String, 629
Generate Reverse CRC-16 on Table (32 bit), 491
Get & Clear All HDD Module Off-Latches, 227
Get & Clear All HDD Module On-Latches, 229
Get & Clear Analog Maximum Value, 26
Get & Clear Analog Minimum Value, 27
Get & Clear Analog Totalizer Value, 28
Get & Clear Counter, 160
Get & Clear HDD Module Counter, 231
Get & Clear HDD Module Counters, 233
Get & Clear HDD Module Off-Latches, 235
Get & Clear HDD Module On-Latches, 237
Get & Clear Off-Latch, 162
Get & Clear On-Latch, 163
Get & Restart Off-Pulse Measurement, 164
Get & Restart Off-Time Totalizer, 165
Get & Restart On-Pulse Measurement, 166
Get & Restart On-Time Totalizer, 167
Get & Restart Period, 168
Get & Restart Timer, 697
Get All HDD Module Off-Latches, 239
Get All HDD Module On-Latches, 241
Get All HDD Module States, 243
Get Analog Maximum Value, 29
Get Analog Minimum Value, 30
Get Analog Totalizer Value, 31
Get Available File Space, 137
Get Available File Space Ex, 138
Get Chart Status, 61
Get Communication Handle Value, 72
Get Control Engine Address, 140
Get Control Engine Type, 141
Get Counter, 169
Get Date & Time, 667
Get Day, 668
Get Day of Week, 669
Get End-Of-Message Terminator, 73
Get Error Code of Current Error, 212
Get Error Count, 213
Get Firmware Version, 142, 143, 146
Get Frequency, 170
Get HART Unique Address, 32
Get HDD Module Counters, 245
Get HDD Module Off-Latches, 247
Get HDD Module On-Latches, 249
Get HDD Module States, 251
Get High Bits of Integer 64, 390
Get Hours, 670
Get I/O Unit as Binary Value, 265
Get I/O Unit as Binary Value 64, 267
Get I/O Unit Event Message State, 299
Get I/O Unit Event Message Text, 301
Get I/O Unit Scratch Pad Bits, 325
Get I/O Unit Scratch Pad Float Element, 327
Get I/O Unit Scratch Pad Float Table, 329
Get I/O Unit Scratch Pad Integer 32 Table, 333
Get I/O Unit Scratch Pad String Element, 335
Get I/O Unit Scratch Pad String Table, 337
Get ID of Block Causing Current Error, 214
Get Julian Day, 671
Get Length of Table, 493
Get Line Causing Current Error, 215
Get Low Bits of Integer 64, 391
Get Minutes, 672
Get Month, 673
Get Name of Chart Causing Current Error, 216
Get Name of I/O Unit Causing Current Error, 217
Get Nth Character, 630
Get Number of Characters Waiting, 74
Get Off-Latch, 171, 269
Get Off-Pulse Measurement, 172
Get Off-Pulse Measurement Complete Status, 173
Get Off-Time Totalizer, 174
Get On-Latch, 175
Get On-Pulse Measurement, 176
Get On-Pulse Measurement Complete Status, 177
Get On-Time Totalizer, 178
Get Period, 179
Get Period Measurement Complete Status, 180
Get PID Configuration Flags, 507
Get PID Current Input, 509
Get PID Current Setpoint, 510
Get PID Feed Forward, 511
Get PID Feed Forward Gain, 512
Get PID Forced Output When Input Over Range, 513
Get PID Forced Output When Input Under Range, 514
Get PID Gain, 515
Get PID Input, 516
Get PID Input High Range, 517
Get PID Input Low Range, 518
Get PID Max Output Change, 519
Get PID Max Output Change, 520
Get PID Mode, 521
Get PID Output, 522
Get PID Output High Clamp, 523
Get PID Output Low Clamp, 524
Get PID Scan Time, 525
Get PID Setpoint, 526
Get PID Status Flags, 527
Get PID Tune Derivative, 528
Get PIDTune Integral, 529
Get Pointer From Name, 551
Get Seconds, 674
Get Seconds Since Midnight, 675
Get Severity of Current Error, 218
Get String Length, 631
Get Substring, 632
Get System Time, 676
Get Target Address State, 271
Get Time Zone Description, 677
Get Time Zone Offset, 678
Get Type From Name, 494
Get Value From Name, 496
Get Year, 679
Greater Than Numeric Table Element?, 392
Greater Than or Equal to Numeric Table Element?, 394
Greater Than or Equal?, 396
Greater?, 398
HTTP Get, 76
HTTP Post Calculate Content Length, 79
HTTP Post from String Table, 80
Hyperbolic Cosine, 462
Hyperbolic Sine, 463
Hyperbolic Tangent, 464
I/O Point Communication Enabled?, 574
I/O Unit Communication Enabled?, 575
I/O Unit Ready?, 273
Increment Variable, 465
Int32 to Float Bits, 400
IVAL Move Numeric Table to I/O Unit, 275
IVAL Move Numeric Table to I/O Unit Ex, 277
IVAL Set Analog Filter Value, 577
IVAL Set Analog Maximum Value, 578
IVAL Set Analog Minimum Value, 579
IVAL Set Analog Point, 580
IVAL Set Counter, 581
IVAL Set Digital Binary, 715
IVAL Set Digital-64 I/O Unit from MOMO Masks, 716
IVAL Set Frequency, 582
IVAL Set I/O Unit from MOMO Masks, 583
IVAL Set Mixed 64 I/O Unit from MOMO Masks, 718
IVAL Set Mixed I/O Unit from MOMO Masks, 720
IVAL Set Off-Latch, 585
IVAL Set Off-Pulse, 586
IVAL Set Off-Totalizer, 587
IVAL Set On-Latch, 588
IVAL Set On-Pulse, 589
IVAL Set On-Totalizer, 590
IVAL Set Period, 591
IVAL Set Simple 64 I/O Unit from MOMO Masks, 722
IVAL Set TPO Percent, 592
IVAL Set TPO Period, 593
IVAL Turn Off, 594
IVAL Turn On, 595

L
Less Than Numeric Table Element?, 401
Less Than or Equal to Numeric Table Element?, 403
Less Than or Equal?, 405
Less?, 407
Listen for Incoming Communication, 83
Load Files From Permanent Storage, 147

M
Make Integer 64, 409
Maximum, 466
Minimum, 467
Modulo, 468
Move, 498
Move 32 Bits, 410
Move from Numeric Table Element, 500
Move from Pointer Table Element, 552
Move from String Table Element, 634
Move I/O Unit to Numeric Table, 279
Move I/O Unit to Numeric Table Ex, 281
Move Numeric Table Element to Numeric Table, 501
Move Numeric Table to I/O Unit, 284
Move Numeric Table to I/O Unit Ex, 286
Move Numeric Table to Numeric Table, 502
Move String, 636
Move to Numeric Table Element, 503
Move to Numeric Table Elements, 505
Move to Pointer, 553
Move to Pointer Table Element, 556
Move to String Table Element, 637
Move to String Table Elements, 638
Multiply, 469

N
Natural Log, 470
NOT, 411
Not Equal to Numeric Table Element?, 413
Not Equal?, 415
NOT?, 417
Numeric Table Element Bit Clear, 418
Numeric Table Element Bit Set, 419
Numeric Table Element Bit Test, 420

O
Off?, 183
Off-Latch Set?, 184
On?, 185
On-Latch Set?, 186
Open Outgoing Communication, 85
OR, 421
OR?, 423

P
Pack Float into String, 639
Pack Integer 32 into String, 641
Pack Integer 64 into String, 643
Pack String into String, 645
Pause Timer, 698
PID Loop Communication Enabled?, 596
Pointer Equal to Null?, 559
Pointer Table Element Equal to Null?, 560
Power, 473

R
Raise e to Power, 472
Raise to Power, 473
Ramp Analog Output, 34
Read Number from I/O Unit Memory Map, 307
Read Numeric Table from I/O Unit Memory Map, 309
Read String from I/O Unit Memory Map, 311
Read String Table from I/O Unit Memory Map, 313
Receive Character, 87
Receive HART Burst Response, 36
Receive HART Response, 38
Receive N Characters, 89
Receive Numeric Table, 91
Receive Numeric Table Ex, 93
S

Save Files To Permanent Storage, 149
Seed Random Number, 475
Send Communication Handle Command, 105
Send Email, 112
Send Email with Attachments, 115
Send/Receive HART Command, 40
Set All Target Address States, 288
Set Analog Filter Weight, 42
Set Analog Gain, 43
Set Analog Load Cell Fast Settle Level, 44
Set Analog Load Cell Filter Weight, 46
Set Analog Offset, 47
Set Analog Totalizer Rate, 48
Set Analog TPO Period, 50
Set Communication Handle Value, 118
Set Date, 680
Set Day, 681
Set Digital I/O Unit from MOMO Masks, 724
Set Digital-64 I/O Unit from MOMO Masks, 726
Set Down Timer Preset Value, 699
Set End-Of-Message Terminator, 119
Set HDD Module from MOMO Masks, 253
Set Hours, 682
Set I/O Unit Configured Flag, 290
Set I/O Unit Event Message State, 303
Set I/O Unit Event Message Text, 305
Set I/O Unit from MOMO Masks, 292
Set I/O Unit Scratch Pad Bits from MOMO Mask, 339
Set I/O Unit Scratch Pad Float Element, 341
Set I/O Unit Scratch Pad Float Table, 343
Set I/O Unit Scratch Pad Integer 32 Element, 345
Set I/O Unit Scratch Pad Integer 32 Table, 347
Set I/O Unit Scratch Pad String Element, 349
Set I/O Unit Scratch Pad String Table, 351
Set Minutes, 683
Set Mixed 64 I/O Unit from MOMO Masks, 728
Set Mixed I/O Unit from MOMO Masks, 730
Set Month, 684
Set Nth Character, 647
Set PID Configuration Flags, 530
Set PID Feed Forward, 531
Set PID Feed Forward Gain, 532
Set PID Forced Output When Input Over Range, 533
Set PID Forced Output When Input Under Range, 534
Set PID Gain, 535
Set PID Input, 536
Set PID Input High Range, 537
Set PID Input Low Range, 538
Set PID Max Output Change, 539
Set PID Min Output Change, 540
Set PID Mode, 541
Set PID Output, 542
Set PID Output High Clamp, 543
Set PID Output Low Clamp, 544
Set PID Scan Time, 545
Set PID Setpoint, 546
Set PID Tune Derivative, 547
Set PID Tune Integral, 548
Set Seconds, 685
Set Simple 64 I/O Unit from MOMO Masks, 732
Set Target Address State, 294
Set Time, 686
Set TimeZone Configuration, 687
Set TPO Percent, 187
Set TPO Period, 181, 182, 188
Set Up Timer Target Value, 700
Set Variable False, 424
Set Variable True, 425
Set Year, 689
Shift Numeric Table Elements, 506
Sine, 476
Square Root, 478
Start Alternate Host Task, 150
Start Chart, 63
Start Continuous Square Wave, 190
Start Counter, 192
Start Off-Pulse, 193
Start On-Pulse, 194
Start Timer, 701
Stop Chart, 64
Stop Chart on Error, 220
Stop Counter, 195
Stop Timer, 702
String Equal to String Table Element?, 648
String Equal?, 650
Subtract, 479
Suspend Chart, 65
Suspend Chart on Error, 221
Synchronize Clock SNTP, 690

T

Tangent, 480
Test Equal, 426
Test Equal Strings, 651
Test Greater, 428
Test Greater or Equal, 430
Test Less, 432
Test Less or Equal, 434
Test Not Equal, 436
Test Within Limits, 438
Timer Expired?, 703
Transfer N Characters, 120
Transmit Character, 122
Transmit NewLine, 124
Transmit Numeric Table, 125
Transmit PointerTable, 127
Transmit String, 129
Transmit String Table, 131
Transmit/Receive String, 133
Trim String, 653
Truncate, 481
Turn Off, 196
Turn Off HDD Module Point, 255
Turn On, 197
Turn On HDD Module Point, 257

U
Unpack String, 654
Up Timer Target Time Reached?, 704

V
Variable False?, 439
Variable True?, 440
Verify Checksum on String, 656
Verify Forward CCITT on String, 657
Verify Forward CRC-16 on String, 658
Verify Reverse CCITT on String, 659
Verify Reverse CRC-16 on String, 660

W
Within Limits?, 441
Write I/O Unit Configuration to EEPROM, 296
Write Number to I/O Unit Memory Map, 316
Write Numeric Table to I/O Unit Memory Map, 318
Write String Table to I/O Unit Memory Map, 320
Write String to I/O Unit Memory Map, 322

X
XOR, 443
XOR?, 445